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CONTACTING VEEAM SOFTWARE 
At Veeam Software we value the feedback from our customers. It is important not only to help you 
quickly with your technical issues, but it is our mission to listen to your input, and build products that 
incorporate your suggestions.  

Customer Support 
Should you have a technical concern, suggestion or question, please visit our Customer Center Portal 
at www.veeam.com/support.html to open a case, search our knowledge base, reference 
documentation, manage your license or obtain the latest product release.  

Company Contacts 
For the most up to date information about company contacts and offices location, please visit 
www.veeam.com/contacts.html. 

Online Support 
If you have any questions about Veeam Backup & Replication, you can use the following resources: 

 Full documentation set: www.veeam.com/backup-replication-resources.html 

 Community forum at forums.veeam.com 

  

https://www.veeam.com/support.html
http://www.veeam.com/contacts.html
http://www.veeam.com/backup-replication-resources.html
http://forums.veeam.com/
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ABOUT THIS GUIDE 
This user guide provides information about main features, installation and use of Veeam Backup & 
Replication in VMware vSphere environments. The document applies to version 9.0 and all 
subsequent versions until it is replaced with a new edition. 

Intended Audience 

The user guide is intended for anyone who wants to use Veeam Backup & Replication. It is primarily 
aimed at VMware administrators, consultants, analysts and any other IT professionals using the 
product. 

Document Revision History 

Revision # Date Change Summary 

Revision 1 1/12/2016 Initial version of the document for the Veeam Backup & 
Replication 9.0. 

Revision 2 2/9/2016 Updated sections: Data Recovery, Backup Copy, Replication, 
Planning and Preparation; minor changes in the document. 

Revision 3 3/28/2016 

Information pertaining to Update 1 added: 

 Information about unattended installation of Updates 
added: Installing Updates in Unattended Mode.  

 Information about automatic console update added: 
Updating Console Automatically.  

 Information about supported backup chains reviewed: 
Health Check for Backup Files.  

 Information about the location of XML files describing 
roles for VMs reviewed: Creating XML Files with VM 
Roles Description. 

 Detailed description of the tape parallel processing 
added: Tape Parallel Processing. 

 Information about space required on scale-out backup 
repositories reviewed: Backup File Placement. 
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OVERVIEW 
Veeam Backup & Replication provides a set of features for building and maintaining a flexible backup 
infrastructure, performing data protection tasks (such as VM backup, replication, copying backup 
files), and carrying out disaster recovery procedures. This section contains a high-level overview of 
Veeam Backup & Replication, its architecture, features, data protection and disaster recovery concepts 
necessary to understand Veeam Backup & Replication background operations and processes. 

Solution Architecture 
Veeam Backup & Replication is a modular solution that lets you build a scalable backup infrastructure 
for environments of different sizes and configuration. The installation package of 
Veeam Backup & Replication includes a set of components that you can use to configure the backup 
infrastructure. Some components are mandatory and provide core functionality; some components 
are optional and can be installed to provide additional functionality for your business and deployment 
needs. You can co-install Veeam Backup & Replication components on the same machine, physical or 
virtual, or you can set them up separately for a more scalable approach. 
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Components 
The Veeam backup infrastructure comprises a set of components. Some components can be deployed 
with the help of the setup file. Other components can be deployed via the 
Veeam Backup & Replication console. 

Backup Server 

The backup server is a Windows-based physical or virtual machine on which 
Veeam Backup & Replication is installed. It is the core component in the backup infrastructure that fills 
the role of the “configuration and control center”. The backup server performs all types of 
administrative activities: 

 Coordinates backup, replication, recovery verification and restore tasks 

 Controls job scheduling and resource allocation 

 Is used to set up and manage backup infrastructure components as well as specify global 
settings for the backup infrastructure 

In addition to its primary functions, a newly deployed backup server also performs the roles of the 
default backup proxy and the backup repository (it manages data handling and data storing tasks). 

The backup server uses the following services and components: 

 Veeam Backup Service is a Windows service that coordinates all operations performed by 
Veeam Backup & Replication such as backup, replication, recovery verification and restore 
tasks. The Veeam Backup Service runs under the Local System account or account that has the 
Local Administrator permissions on the backup server. 

 Veeam Backup & Replication Console provides the application user interface and allows 
user access to the application's functionality. 

 Veeam Guest Catalog Service is a Windows service that manages guest OS file system 
indexing for VMs and replicates system index data files to enable search through guest OS 
files. Index data is stored in the Veeam Backup Catalog — a folder on the backup server. The 
Veeam Guest Catalog Service running on the backup server works in conjunction with search 
components installed on Veeam Backup Enterprise Manager and (optionally) a dedicated 
Microsoft Search Server. 

 Veeam Backup SQL Database is used by Veeam Backup Service and Veeam Guest Catalog 
Service to store data about the backup infrastructure, jobs, sessions and so on. The database 
instance can be located on a SQL Server installed either locally (on the same machine where 
the backup server is running) or remotely. 

 Veeam Backup PowerShell Snap-In is an extension for Microsoft Windows PowerShell 2.0. 
Veeam Backup PowerShell adds a set of cmdlets to allow users to perform backup, replication 
and recovery tasks through the command-line interface of PowerShell or run custom scripts 
to fully automate operation of Veeam Backup & Replication. 

 Backup Proxy Services. In addition to dedicated services, the backup server runs a set of 
data mover services (for details, see Backup Proxy). 

 Mount server is a component required for browsing the VM guest file system and restoring 
VM guest OS files and application items to the original location. 
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Backup & Replication Console 

The Veeam Backup & Replication console is a separate client-side component that provides access to 
the backup server. The console is installed locally on the backup server by default. You can also use it 
in a standalone mode — install the console on a dedicated machine and access 
Veeam Backup & Replication remotely over the network. The console lets you log in to 
Veeam Backup & Replication and perform all kind of data protection and disaster recovery operations 
as if you work on the backup server. 

To log in to Veeam Backup & Replication via the console, the user must be added to the Local Users 
group on the backup server or a group of domain users who have access to the backup server. The 
user can perform the scope of operations permitted by his or her role in Veeam Backup & Replication. 
For more information, see Assigning Roles to Users. 

You can install as many remote consoles as you need so that multiple users can access 
Veeam Backup & Replication simultaneously. Veeam Backup & Replication prevents concurrent 
modifications on the backup server. If several users are working with Veeam Backup & Replication at 
the same time, the user who saves the changes first has the priority. Others users will be prompted to 
reload the wizard or window to get the most recent information about the changes in the 
configuration database. 

If you have multiple backup servers in the infrastructure, you can connect to any of them from the 
same console. For convenience, you can save several shortcuts for these connections. 

To make users' work as uninterrupted as possible, the remote console maintains the session for 5 
minutes if the connection is lost. If the connection is re-established within this period, you can 
continue working without re-logging to the console. 

When you install a remote console on a machine, Veeam Backup & Replication installs the following 
components: 

 Veeam Backup PowerShell Snap-In 

 Veeam Explorer for Microsoft Active Directory 

 Veeam Explorer for Microsoft Exchange 

 Veeam Explorer for Oracle 

 Veeam Explorer for Microsoft SQL 

 Veeam Explorer for Microsoft SharePoint 

 Mount server 

The console does not have a direct access to the backup infrastructure components and configuration 
database. Such data as user credentials, passwords, roles and permissions are stored on the backup 
server side. To access this data, the console needs to connect to the backup server and query this 
information periodically during the work session.  



 

14   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

 

Requirements and Limitations for Remote Console 

The machine on which you install the Veeam Backup & Replication console must meet the following 
requirements: 

 The remote console can be installed on a Microsoft Windows machine (physical or virtual). 

 If you install the console remotely, you can deploy it outside NAT. However, the backup server 
must be behind NAT. The opposite type of deployment is not supported: if the backup server 
is deployed outside NAT and the remote console is deployed behind NAT, you will not be 
able to connect to the backup server. 

The Veeam Backup & Replication console has the following limitations: 

 You cannot perform restore from the configuration backup via the remote console. 

 The machines on which the remote console is installed are not added to the list of managed 
servers automatically. For this reason, you cannot perform some operations, for example, 
import backup files that reside on the remote console machine or assign roles of backup 
infrastructure components to this machine. To perform these operations, you must add the 
remote console machine as a managed server to Veeam Backup & Replication. For more 
information, see Managing Servers. 
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Backup Proxy 

When Veeam Backup & Replication is initially installed, the backup server coordinates all job activities 
and handles data traffic itself. That is, when you run a backup, replication, VM copy, VM migration job 
or perform restore operations, VM data is moved from source to target through the backup server. 
This scenario is acceptable for virtual environments where few backup jobs are performed; in large-
scale environments, however, the workload on the backup server will be significant. 

To take the workload off the backup server, Veeam Backup & Replication uses backup proxies. A 
backup proxy is an architecture component that sits between data source and target and is used to 
process jobs and deliver backup traffic. In particular, the backup proxy tasks include retrieving VM 
data from the production storage, compressing and sending it to the backup repository (for example, 
if you run a backup job) or another backup proxy (for example, if you run a replication job). As the data 
handling task is assigned to the backup proxy, the backup server becomes the “point of control” for 
dispatching jobs to proxy servers. 

The role of a backup proxy can be assigned to a dedicated Windows server (physical or virtual) in your 
virtual environment. You can deploy backup proxies both in the primary site and in remote sites. To 
optimize performance of several concurrent jobs, you can use a number of backup proxies. In this 
case, Veeam Backup & Replication will distribute the backup workload between available backup 
proxies. 

Use of backup proxies lets you easily scale your backup infrastructure up and down based on your 
demands. Backup proxies run light-weight services that take a few seconds to deploy. Deployment is 
fully automated — Veeam Backup & Replication installs the necessary components on a Windows-
based server when you add it to the product console. As soon as you assign the role of a backup proxy 
to the added server, Veeam Backup & Replication starts the required services on it. 

The primary role of the backup proxy is to provide an optimal route for backup traffic and enable 
efficient data transfer. Therefore, when deploying a backup proxy, you need to analyze the connection 
between the backup proxy and storage with which it is working. Depending on the type of 
connection, the backup proxy can be configured in one of the following ways (starting from the most 
efficient): 

 A machine used as a backup proxy should have direct access to the storage on which VMs 
reside or the storage where VM data is written. This way, the backup proxy will retrieve data 
directly from the datastore, bypassing LAN. 

 The backup proxy can be a VM with HotAdd access to VM disks on the datastore. This type of 
proxy also enables LAN-free data transfer. 

 If neither of the above scenarios is possible, you can assign the role of the backup proxy to a 
machine on the network closer to the source or the target storage with which the proxy will 
be working. In this case, VM data will be transported over LAN using NBD protocol. 

Depending on the type of backup proxy and your backup architecture, the backup proxy can use one 
of the following data transport modes: Direct storage access, Virtual appliance or Network. If the VM 
disks are located on the storage system and the storage system is added to the 
Veeam Backup & Replication console, the backup proxy can also use the Backup from Storage 
Snapshots mode.  

You can explicitly select the transport mode or let Veeam Backup & Replication replication 
automatically choose the mode. For details, see Transport Modes and Backup from Storage Snapshots. 
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The backup proxy uses the following services and components: 

 Veeam Installer Service is an auxiliary service that is installed and started on any Windows 
server once it is added to the list of managed servers in the Veeam Backup & Replication 
console. This service analyses the system, installs and upgrades necessary components and 
services depending on the role selected for the server. 

 Veeam Transport is responsible for deploying and coordinating executable modules that act 
as "data movers" and perform main job activities on behalf of Veeam Backup & Replication, 
such as communicating with VMware Tools, copying VM files, performing data deduplication 
and compression and so on. 
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Guest Interaction Proxy 

To interact with the VM guest OS during the backup or replication job, Veeam Backup & Replication 
needs to deploy a runtime process in each VM. Guest OS interaction is performed if you enable the 
following options in the job: 

 Application-aware processing 

 Guest file system indexing 

 Transaction logs processing 

Previously, the runtime process on all VMs was deployed by the backup server. This could cause the 
following problems: 

 The load on the backup server was high. 

 If a connection between two sites was slow, the job performance decreased. 

 If the backup server had no network connection to VMs, application-aware processing tasks 
were not accomplished for these VMs. 

 

Starting from Veeam Backup & Replication 9.0, the task of deploying the runtime process in a 
Microsoft Windows VM is performed by the guest interaction proxy. The guest interaction proxy is a 
backup infrastructure component that sits between the backup server and processed VM. The guest 
interaction proxy deploys the runtime process in the VM and sends commands from the backup server 
to the VM. 

The guest interaction proxy allows you to communicate with the VM guest OS even if the backup 
server and processed VM run in different networks. As the task of runtime process deployment is 
assigned to the guest interaction proxy, the backup server only has to coordinate job activities. 

Important! 

 

The guest interaction proxy deploys the runtime process only in Microsoft Windows VMs. In VMs 
with another guest OS, the runtime process is deployed by the backup server. 
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You can use multiple guest interaction proxies to improve performance. Multiple guest interaction 
proxies will deploy runtime processes in VMs faster compared to the same operation performed by 
one guest interaction proxy. 

In a backup infrastructure with multiple remote sites, you can deploy a guest interaction proxy in each 
site. This can reduce load on the backup server and produce less traffic between the backup server 
and remote site. The backup server will only have to send commands to the guest interaction proxies. 

Requirements for Guest Interaction Proxy 

To perform the role of guest interaction proxy, the machine must meet the following requirements: 

 It must be a Microsoft Windows machine (physical or virtual). 

 You must add it to the Veeam Backup & Replication console as a managed server. 

 It must have either a LAN or VIX connection to the VM that will be processed. You do not have 
to set up both connections — only one connection is required. For more information about 
setting up a connection to the VM, see https://www.veeam.com/kb1788. 

The guest interaction proxy role can be performed by any machine that meets the requirements, 
including backup proxy, backup repository, WAN accelerator or backup server. 

Note: 

 

The guest interaction proxy functionality is available in the Enterprise and Enterprise Plus Editions of 
Veeam Backup & Replication. 

Guest Interaction Proxy Selection 

When you add a Microsoft Windows machine to the backup infrastructure, 
Veeam Backup & Replication deploys the Data Mover Service on it. The Data Mover Service includes 
the components responsible for runtime process deployment during guest OS interaction. 

To assign a guest interaction proxy for the job, you must select a Microsoft Windows machine that will 
perform the role of the guest interaction proxy at the Guest Processing step of the backup or 
replication job wizard. You can assign the guest interaction proxy manually, or let 
Veeam Backup & Replication do it automatically. Veeam Backup & Replication uses the following 
priority rules to select the guest interaction proxy: 

1. A machine in the same network as the protected VM that does not perform the backup server 
role. 

2. A machine in the same network as the protected VM that performs the backup server role. 

3. A machine in another network that does not perform the backup server role. 

4. A machine in another network that performs the backup server role. 

https://www.veeam.com/kb1788
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If Veeam Backup & Replication finds several available machines of equal priority, it selects the less 
loaded machine. The load is defined by the number of tasks that the machine already performs. 

 
Failover from Guest Interaction Proxy to Backup Server 

If the guest interaction proxy fails to connect to a Microsoft Windows VM, the guest interaction proxy 
will not be able to access the VM and deploy a runtime process in it. In this case, the backup server will 
take over the role of guest interaction proxy and deploy the runtime process in the VM.  
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Backup Repository 

A backup repository is a storage location where you can keep backup files, VM copies and metadata 
for replicated VMs. You can configure the following types of backup repositories in the backup 
infrastructure:  

 Simple backup repositories 

 Scale-out backup repositories 

 Backup repositories with rotated drives 

Simple Backup Repository 

A backup repository is a location used by Veeam Backup & Replication jobs to store backup files, 
copies of VMs and metadata for replicated VMs. Technically, a backup repository is a folder on the 
backup storage. By assigning different repositories to jobs and limiting the number of parallel jobs for 
each one, you can balance the load across your backup infrastructure. 

You can configure one of the following types of backup repositories: 

 Microsoft Windows server with local or directly attached storage. The storage can be a 
local disk, directly attached disk-based storage (such as a USB hard drive), or iSCSI/FC SAN 
LUN in case the server is connected into the SAN fabric. 
On a Windows repository, Veeam Backup & Replication deploys Veeam Data Mover Service 
(when you add a Windows-based server to the product console, Veeam Backup & Replication 
installs a set of components including the Data Mover Service on that server). When any job 
addresses the repository, the Data Mover Service on the repository establishes a connection 
with the source-side Data Mover Service on the backup proxy, enabling efficient data transfer 
over LAN or WAN. 
Windows repositories can be configured to function as vPower NFS Servers. In this case, 
Veeam Backup & Replication will run the Veeam vPower NFS Service directly on the backup 
repository (namely, on the managing Windows server to which storage is attached) and 
provide ESX(i) hosts with transparent access to backed up VM images stored on the 
repository. For more information, see Veeam vPower NFS Service. 

 Linux server with local, directly attached storage or mounted NFS. The storage can be a 
local disk, directly attached disk-based storage (such as a USB hard drive), NFS share, or 
iSCSI/FC SAN LUN in case the server is connected into the SAN fabric. 

When any task addresses a Linux repository, Veeam Backup & Replication deploys and starts 
the Veeam Data Mover Service on the repository. The Data Mover Service establishes a 
connection with the source-side Data Mover Service on the backup proxy, enabling efficient 
data transfer over LAN or WAN. 

 CIFS (SMB) share. SMB share cannot host Veeam Data Mover Services. For this reason, data 
to the SMB share is written from the gateway server. By default, this role performs a backup 
proxy that is used by the job for data transport.  

However, if you plan to move VM data to an offsite SMB repository over a WAN link, it is 
recommended that you deploy an additional gateway server in the remote site, closer to the 
SMB repository. Veeam Backup & Replication will deploy a Veeam Data Mover Service on this 
gateway server, which will improve data transfer performance. 
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 Deduplicating storage appliance. Veeam Backup & Replication supports the following 
deduplicating storage appliances: 

– EMC Data Domain 

– ExaGrid 

– HPE StoreOnce 

For more information, see Support for Deduplicating Storage Systems. 

Scale-Out Backup Repository 

You can configure a scale-out backup repository in the backup infrastructure.  

The scale-out backup repository is a logical entity. It groups several simple backup repositories, or 
extents. When you configure the scale-out backup repository, you actually create a pool of storage 
devices and systems, summarizing their capacity.  

You can expand the scale-out backup repository at any moment. For example, if backup data grows 
and the backup repository reaches the storage limit, you can add a new storage system to the scale-
out backup repository. The free space on this storage system will be added to the capacity of the 
scale-out backup repository. As a result, you will not have to move backups to a backup repository of a 
larger size. 

To deploy a scale-out backup repository, you must configure a number of simple backup repositories 
and include them into the scale-out backup repository as extents. You can mix backup repositories of 
different types in one scale-out backup repository: 

 Microsoft Windows backup repositories 

 Linux backup repositories 

 Shared folders 

 Deduplicating storage appliances 

For example, you can add a Microsoft Windows server and deduplicating storage appliance to the 
same scale-out backup repository.  

You can use the scale-out backup repository for the following types of jobs and tasks: 

 Backup jobs. 

 Backup copy jobs. You can copy backups that reside on scale-out backup repositories and 
store backup copies on scale-out backup repositories. 

 VeeamZIP tasks. 

Backup files stored on the scale-out repository can be used for all types of restores, replication from 
backup and backup copy jobs. You can verify such backups with SureBackup jobs. The scale-out 
backup repository can be used as a staging backup repository for restore from tape media. Files 
restored from the tape media are placed to the extents according to data placement policy configured 
for the scale-out backup repository. For more information, see Backup File Placement. 
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Limitations for Scale-out Backup Repositories 

The scale-out backup repository has the following limitations: 

 The scale-out backup repository functionality is available only in Enterprise and Enterprise 
Plus editions of Veeam Backup & Replication.  

If you configure a scale-out backup repository and then downgrade to the Standard license, 
you will not be able to run jobs targeted at the scale-out backup repository. However, you will 
be able to perform restore from the scale-out backup repository. 

 You cannot use the scale-out backup repository as a target for the following types of jobs: 

– Configuration backup job 

– Replication jobs 

– VM copy jobs 

– Endpoint backup jobs 

 You cannot add a backup repository as an extent to the scale-out backup repository if any job 
of unsupported type is targeted at this backup repository or if the backup repository contains 
data produced by jobs of unsupported types (for example, replica metadata). To add such 
backup repository as an extent, you must first target unsupported jobs to another backup 
repository and remove the job data from the backup repository. 

 You cannot use a scale-out backup repository as a cloud repository. You cannot add a cloud 
repository as an extent to the scale-out backup repository.  

 If a backup repository is added as an extent to the scale-out backup repository, you cannot 
use it as a regular backup repository. 

 You cannot add a scale-out backup repository as an extent to another scale-out backup 
repository. 

 You cannot add a backup repository as an extent if this backup repository is already added as 
an extent to another scale-out backup repository. 

 You cannot add a backup repository on which some activity is being performed (for example, 
a backup job or restore task) as an extent to the scale-out backup repository. 

 If you use Enterprise Edition of Veeam Backup & Replication, you can create 1 scale-out 
backup repository with 3 extents for this scale-out backup repository. Enterprise Plus Edition 
has no limitations on the number of scale-out backup repositories or extents. 
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Extents 

The scale-out backup repository can comprise one or more extents. The extent is a standard backup 
repository configured in the backup infrastructure. You can add any simple backup repository, except 
the cloud repository, as an extent to the scale-out backup repository. 

The backup repository added to the scale-out backup repository ceases to exist as a simple backup 
repository. You cannot target jobs to this backup repository. Instead, you have to target jobs at the 
configured scale-out backup repository. 

On every extent, Veeam Backup & Replication creates the definition.erm file. This file contains a 
description of the scale-out backup repository and information about its extents.  

Extents inherit most configuration settings from the underlying backup repositories. The following 
settings are inherited:  

 Number of tasks that can be performed simultaneously 

 Read and write data rate limit 

 Data decompression settings 

 Block alignment settings 

The following settings are not inherited: 

 Rotated drive settings. Rotated drive settings are ignored and cannot be configured at the 
level of the scale-out backup repository. 

 Per-VM backup file settings. Per-VM settings can be configured at the level of the scale-out 
backup repository. 

Limitations, specific for certain types of backup repositories, apply to extents. For example, if you add 
EMC Data Domain as an extent to the scale-out backup repository, you will not be able to create a 
backup chain longer than 60 points on this scale-out backup repository. 

Extents of the scale-out backup repository should be located in the same site. Technically, you can add 
extents that reside in different sites to the scale-out backup repository. However, in this case 
Veeam Backup & Replication will have to access VM backup files on storage devices in different 
locations, and the backup performance will degrade. 
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Backup File Placement 

Veeam Backup & Replication stores backup files on all extents of the scale-out backup repository. 

When you configure a scale-out backup repository, you must set the backup file placement policy for 
it. The backup file placement policy describes how backup files are distributed between extents. You 
can choose one of two policies: 

 Data locality — all backup files that belong to the same backup chain are stored on the same 
extent of the scale-out backup repository.  

The Data locality policy does not put any limitations to backup chains. A new backup chain 
may be stored on the same extent or another extent. For example, if you create an active full 
backup, Veeam Backup & Replication may store the full backup file to another extent, and all 
dependent incremental backup files will be stored together with this full backup file.  

However, if you use a deduplicating storage appliance as an extent to the scale-out backup 
repository, Veeam Backup & Replication will attempt to place a new full backup to the extent 
where the full backup from the previous backup chain resides. Such behavior will help 
increase the data deduplication ratio. 

 Performance — full backup files and incremental backup files that belong to the same 
backup chain are stored on different extents of the scale-out backup repository. If necessary, 
you can explicitly specify on which extents full backup files and incremental backup files must 
be stored. 

The Performance policy can improve performance of transform operations if you use raw data 
devices as extents. When Veeam Backup & Replication performs transform operations, it 
needs to access a number of backup files on the backup repository. If these files are located 
on different storages, the I/O load on the storages hosting backup files will be lower. 

If you set the Performance policy, you must make sure that the network connection between 
extents is fast and reliable. You must also make sure all extents are online when the backup 
job, backup copy job or a restore task starts. If any extent hosting backup files in the current 
backup chain is not available, the backup chain will be broken, and 
Veeam Backup & Replication will not be able to complete the task. To avoid data loss in this 
situation, you can enable the Perform full backup when required extent is offline option 
for the scale-out backup repository. With this option enabled, Veeam Backup & Replication 
will create a full backup instead of incremental backup if some files are missing from the 
backup chain. 

The backup file placement policy is not strict. If the necessary extent is not accessible, 
Veeam Backup & Replication will disregard the policy limitations and attempt to place the backup file 
to the extent that has enough free space for the backup file. 

For example, you have set the Performance policy for the scale-out backup repository and specified 
that full backup files must be stored on Extent 1 and incremental backup files must be stored on Extent 
2. If before an incremental backup job session Extent 2 goes offline, the new incremental backup file 
will be placed to Extent 1.  
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Extent Selection 

To select an extent for backup file placement, Veeam Backup & Replication checks the following 
conditions: 

1. Availability of extents on which backup files reside. If some extent with backup files from the 
current backup chain is not accessible, Veeam Backup & Replication will trigger a full backup 
instead of incremental (if this option is enabled). For more information, see Adding Backup 
Repository Extents. 

2. Backup placement policy set for the scale-out backup repository. 

3. Load control settings — maximum number of tasks that the extent can process 
simultaneously. 

4. Amount of free space available on the extent — the backup file is placed to the extent with 
the most amount of free space. 

5. Availability of files from the current backup chain — extents that host incremental backup 
files from the current backup chain (or current VM) have a higher priority than extents that do 
not host such files. 

At the beginning of the job session, Veeam Backup & Replication estimates how much space the 
backup file requires and checks the amount of free space on extents. Veeam Backup & Replication 
assumes that the following amount of space is required for backup files: 

 For per-VM backup chains: the size of the full backup file is equal to 50% of source VM data. 
The size of an incremental backup file is equal to 10% of source VM data. 

This mechanism is also applied to backup files created with backup copy jobs. 

 For single file backup chains: the size of the full backup file is equal to 50% of source data for 
all VMs in the job. For the first incremental job session, the size of an incremental backup file 
is equal to 10% the full backup file. For subsequent incremental job sessions, the size of an 
inctemental backup file is equal to 100% of the previous incremental backup file. 
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Extent Selection for Backup Repositories with Performance Policy 

If you set the Performance policy for the scale-out backup repository, Veeam Backup & Replication 
always stores full backup files and incremental backup files that belong to the same backup chain on 
different extents. To choose the extent to which a backup file can be stored, 
Veeam Backup & Replication applies this policy and policies mentioned above.  

For example, a scale-out backup repository has 2 extents that have 100 GB and 200 GB of free space. 
You set the Performance policy for the scale-out backup repository and define that all types of backup 
files (full and incremental) can be placed on both extents.  

When a backup job runs, Veeam Backup & Replication picks the target extent in the following manner: 

1. During the first job session, Veeam Backup & Replication checks to which extent a full backup 
file can be stored. As both extents can host the full backup file, Veeam Backup & Replication 
checks which extent has more free space, and picks the extent that has 200 GB of free space. 

2. During incremental job session, Veeam Backup & Replication checks to which extent an 
incremental backup file can be stored. As both extents can host the incremental backup file, 
Veeam Backup & Replication picks the extent that does not store the full backup file — the 
extent that has 100 GB of free space. 
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Service Actions with Scale-Out Backup Repositories 

You can perform service actions with extents of scale-out backup repositories:  

 Put extents to the Maintenance mode 

 Evacuate backups from extents 

Maintenance Mode 
In some cases, you may want to perform service actions with extents of the scale-out backup 
repository. For example, you need to upgrade the backup repository server and add more memory to 
it. Or you want to replace a storage device backing the extent and need to relocate backup files. 
Before you start service actions, you must put the extent to the Maintenance mode.  

An extent in the Maintenance mode operates with the limited functionality: 

 Veeam Backup & Replication does not start new tasks targeted at this extent. 

 You cannot restore VM data from backup files residing on the extent. You also cannot restore 
VM data from backup files residing on other extents if a part of the backup chain resides on 
the extent in the Maintenance mode. 

When you switch the Maintenance mode, Veeam Backup & Replication launches the Repository 
Maintenance job. The Repository Maintenance job checks the status of jobs and tasks targeted at the 
extent and puts the extent to one of the following modes: 

 If no tasks using the extent are currently running, the job puts the extent to the Maintenance 
mode immediately. 

 If the extent is busy with any task, for example, a backup job, the job puts the extent to the 
Maintenance pending state and waits for the task to complete. When the task is complete, the 
extent is put to the Maintenance mode.  

Backup Files Evacuation 
If you want to exclude an extent from the scale-out backup repository, you first need to evacuate 
backup files from this extent. When you evacuate backups, Veeam Backup & Replication moves 
backup files from the extent to other extents that belong to the same scale-out backup repository. As 
a result, the backup chains remain consistent and you can work with them in a usual way. 

The extent must be put to the Maintenance mode before you evacuate backups from it. If the extent is 
in the normal operational mode, the Evacuate option will not be available for this extent. 

When selecting the target extent for evacuated files, Veeam Backup & Replication attempts to keep to 
the backup placement settings specified for remaining extents. For example, you have 3 extents in the 
scale-out backup repository with the following backup file placement settings: 

 On Extent 1, full backup files are stored. 

 On Extent 2 and Extent 3, incremental backup files are stored. 

If you evacuate backup files from Extent 2, Veeam Backup & Replication will relocate them to Extent 3. 
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Backup Repositories with Rotated Drives 

You can configure a backup repository to use rotated drives. This scenario can be helpful if you want 
to store backups on several external hard drives (for example, USB or eSATA) and plan to regularly 
swap these drives between different locations.  

To use rotated drives, you must enable the This repository is backed up by rotated hard drives 
option in the advanced settings of the backup repository. When this option is enabled, 
Veeam Backup & Replication recognizes the backup target as a backup repository with rotated drives 
and uses a specific algorithm to make sure that the backup chain created on these drives is not 
broken. 

Microsoft Windows Backup Repository 

The backup job targeted at a backup repository with rotated drives is performed in the following way: 

1. Veeam Backup & Replication creates a regular backup chain on the currently attached drive.  

2. When a new job session starts, Veeam Backup & Replication checks if the backup chain on the 
currently attached drive is consistent. The consistent backup chain must contain a full backup 
and all incremental backups that have been produced by the job. This requirement applies to 
all types of backup chains: forever forward incremental, forward incremental and reverse 
incremental. 

If external drives have been swapped, and the full backup or any incremental backups are 
missing from the currently attached drive, Veeam Backup & Replication behaves in the 
following way: 

– [For backup jobs] Veeam Backup & Replication starts the backup chain anew. It 
creates a new full backup file on the drive, and this full backup is used as a starting 
point for subsequent incremental backups. 

– [For backup copy jobs] Veeam Backup & Replication creates a new incremental 
backup and adds it to the backup chain. The latest incremental backup existing in 
the backup chain is used as a starting point for the new incremental backup. 

3. [For external drives attached to Microsoft Windows servers] Veeam Backup & Replication 
checks the retention policy set for the job. If some backup files in the backup chain are 
outdated, Veeam Backup & Replication removes them from the backup chain.  

4. When you swap drives again, Veeam Backup & Replication behaves in the following way: 

– [For backup jobs] Veeam Backup & Replication checks the backup chain for 
consistency and creates a new full backup. 

– [For backup copy jobs] Veeam Backup & Replication creates a new incremental 
backup and adds it to the backup chain. The latest incremental backup existing in 
the backup chain is used as a starting point for the new incremental backup. 

When you specify retention settings for a job targeted at a backup repository with rotated drives, you 
must define the total number of restore points that you want to retain on all drives in the set. For 
example, if you set retention to 14, the job will keep the total of 14 restore points across all drives. 
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Drive letters for external drives may change when you add new volumes or storage hardware such as 
CD-ROM on the server. On Microsoft Windows backup repositories, Veeam Backup & Replication can 
keep track of drives and detect them even if the drive letter changes.  

To detect a drive correctly, Veeam Backup & Replication must have a record about it in the 
configuration database. Consider the following requirements: 

 When you insert a drive for the first time, the drive is not registered in the configuration 
database. Such drive must have the same letter as the one specified in the Path to folder 
field in the backup repository settings. For more information, see Configuring Path and Load 
Control Settings. 

If the drive has some other letter, Veeam Backup & Replication will not be able to detect and 
use it. 

  When you insert a drive that has already been used and has some restore points on it, the 
drive is already registered in the configuration database. Veeam Backup & Replication will be 
able to detect and use it, even if the drive letter changes. 
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Linux and Shared Folder Backup Repository 

If you use a Linux server or CIFS share as a backup repository with rotated drives, 
Veeam Backup & Replication employs a “cropped” mechanism of work with rotated drives. If 
Veeam Backup & Replication fails to detect previous restore points on the drive, it simply creates a full 
backup and starts a new backup chain. Information about restore points that were previously created 
is removed from the configuration database. Actual backup files remain on drives. 

For this reason, the retention policy set for the job may not work as expected. 

 

Limitations for Backup Repositories with Rotated Drives 

Backup repositories with rotated drives have the following limitations: 

1. You cannot store archive full backups (GFS backups) created with backup copy jobs on 
backup repositories with rotated drives. 

2. You cannot store per-VM backup files on backup repositories with rotated drives. 
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Support for Deduplicating Storage Systems 

For disk-to-disk backups, you can use a deduplicating storage system as a target. 
Veeam Backup & Replication supports the following deduplicating storage appliances: 

 EMC Data Domain 

 ExaGrid 

 HPE StoreOnce 

EMC Data Domain 

You can use EMC Data Domain storage systems with Data Domain Boost (DD Boost) as backup 
repositories.  

The DD Boost technology offers a set of features for advanced data processing: 

 Distributed Segment Processing 

 Advanced Load Balancing and Link Failover 

 Virtual Synthetics 

 Managed File Replication 

Veeam Backup & Replication supports Distributed Segment Processing, Advanced Load Balancing, 
Link Failover and Virtual Synthetics. Managed File Replication is not supported. 

In addition to these technologies, Veeam Backup & Replication supports in-flight data encryption and 
per storage unit streams. 

Distributed Segment Processing 

Distributed Segment Processing lets EMC Data Domain “distribute” the deduplication process and 
perform a part of data deduplication operations on the backup proxy side. 

Without Distributed Segment Processing, EMC Data Domain performs deduplication on the EMC Data 
Domain storage system. The backup proxy sends unfiltered data blocks to EMC Data Domain over the 
network. Data segmentation, filtering and compression operations are performed on the target side, 
before data is written to disk. 

With Distributed Segment Processing, operations on data segmentation, filtering and compression are 
performed on the backup proxy side. The backup proxy sends only unique data blocks to EMC Data 
Domain. As a result, the load on the network reduces and the network throughput improves. 

Advanced Load Balancing and Link Failover 

Advanced Load Balancing and Link Failover allow you to balance data transfer load and route VM data 
traffic to a working link in case of network outage problems. 

Without Advanced Load Balancing, every backup server connects to Data Domain on a dedicated 
Ethernet link. Such configuration does not provide an ability to balance the data transfer load across 
the links. If a network error occurs during the data transfer process, the backup job fails and needs to 
be restarted. 

Advanced Load Balancing allows you to aggregate several Ethernet links into one interface group. As 
a result, EMC Data Domain automatically balances the traffic load coming from several backup servers 
united in one group. If some link in the group goes down, EMC Data Domain automatically performs 
link failover, and the backup traffic is routed to a working link.  
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Virtual Synthetics 

Veeam Backup & Replication supports Virtual Synthetic Fulls by EMC Data Domain. Virtual Synthetic 
Fulls let you synthesize a full backup on the target backup storage without physically copying data 
from source datastores. To construct a full backup file, EMC Data Domain uses pointers to existing 
data segments on the target backup storage. Virtual Synthetic Fulls reduce the workload on the 
network and backup infrastructure components and increase the backup job performance. 

In-Flight Data Encryption 

Veeam Backup & Replication supports in-flight encryption introduced in EMC Data Domain Boost 3.0. 
If necessary, you can enable data encryption at the backup repository level. 
Veeam Backup & Replication will leverage the EMC Data Domain technology to encrypt data 
transported between the EMC DD Boost library and EMC Data Domain system. For more information, 
see Configuring Simple Backup Repositories. 

Per Storage Unit Streams 

Veeam Backup & Replication supports per storage unit streams on EMC Data Domain. The maximum 
number of parallel tasks that can be targeted at the backup repository (the Limit maximum 
concurrent tasks to N setting) is applied to the storage unit, not the whole EMC Data Domain system. 
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How EMC Data Domain Works 
To support the EMC DD Boost technology, Veeam Backup & Replication leverages two EMC Data 
Domain components: 

 DD Boost library. The DD Boost library is a component of the EMC Data Domain system. The 
DD Boost library is embedded into the Veeam Data Mover Service setup. When you add a 
Microsoft Windows server to the backup infrastructure, the DD Boost Library is automatically 
installed on the added server together with the Data Mover Service. 

 DD Boost server. The DD Boost server is a target-side component running on the OS of the 
EMC Data Domain storage system. 

To communicate with EMC Data Domain, Veeam Backup & Replication uses the DD Boost library 
deployed on a gateway server. The gateway server is a backup infrastructure component that 
“bridges” the backup server and EMC Data Domain storage system. The gateway server must meet the 
following requirements: 

 The server must run Microsoft Windows OS. 

 The server must be added to the backup infrastructure. 

 The server must have access to the backup server and EMC Data Domain appliance. 

You define what gateway server to use when you assign a backup repository role to EMC Data 
Domain. You can define the gateway server explicitly or instruct Veeam Backup & Replication to select 
it automatically.  

 If you define the gateway server explicitly, Veeam Backup & Replication uses the selected 
server as a gateway server. 

 If you choose to select the gateway server automatically, Veeam Backup & Replication uses 
any Microsoft Windows server, that is added to the backup infrastructure and has access to 
EMC Data Domain, as a gateway server. 

The gateway server is picked at random and per job session. Veeam Backup & Replication 
may use one gateway server for one job session and another gateway server for another job 
session. 

For EMC Data Domain storage systems working over Fibre Channel, you must explicitly define the 
gateway server that will communicate with EMC Data Domain. As a gateway server, you must use a 
Microsoft Windows server that is added to the backup infrastructure and has access to EMC Data 
Domain over Fibre Channel. 
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Supported Protocols 
Veeam Backup & Replication supports EMC Data Domain storage systems working over the following 
protocols: 

 TCP/IP protocol: Veeam Backup & Replication communicates with the EMC Data Domain 
server by sending commands over the network.  

 Fibre Channel protocol: Veeam Backup & Replication communicates with the EMC Data 
Domain Fibre Channel server by sending SCSI commands over Fibre Channel.  

Limitations for EMC Data Domain 
If you plan to use EMC Data Domain as a backup repository, mind the following limitations: 

 Use of EMC Data Domain with DD Boost does not guarantee improvement of job 
performance; it reduces the load on the network and improves the network throughput. 

 EMC Data Domain requires at least 1 Gbps network and 0% of packets data loss between the 
gateway server and EMC Data Domain storage appliance. In the opposite case, stable work of 
EMC Data Domain cannot be guaranteed. 

 EMC Data Domain does not support the reverse incremental backup method. Do not enable 
this option for backup jobs targeted at this type of backup repository. 

 When you create a backup job targeted at EMC Data Domain, Veeam Backup & Replication 
will offer you to switch to optimized job settings and use the 4 MB size of data block for VM 
data processing. It is recommended that you use optimized job settings. Large data blocks 
produce a smaller metadata table that requires less memory and CPU resources to process. 

 The length of forward incremental and forever forward incremental backup chains (chains 
that contain one full backup and a set of subsequent incremental backups) cannot be greater 
than 60 restore points. To overcome this limitation, schedule full backups (active or synthetic) 
to split the backup chain into shorter series. For example, to perform backups at 30-minute 
intervals 24 hours a day, you must schedule synthetic fulls every day. In this scenario, intervals 
immediately after midnight may be skipped due to duration of synthetic processing. For 
more information, see How Synthetic Full Backup Works. 

 If you connect to EMC Data Domain over Fibre Channel, you must explicitly define a gateway 
server to communicate with EMC Data Domain. As a gateway server, you must use a Microsoft 
Windows server that is added to the backup infrastructure and has access to the EMC Data 
Domain storage appliance over Fibre Channel. 

For more information about work with EMC Data Domain, see https://www.veeam.com/kb1956.  

  

https://www.veeam.com/kb1956
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ExaGrid 

You can use ExaGrid appliances as backup repositories.  

ExaGrid uses post-process deduplication. Data deduplication is performed on the target storage 
system. After VM data is written to disk, ExaGrid analyses bytes in the newly transferred data portions. 
ExaGrid compares versions of data over time and stores only the differences to disk. 

ExaGrid deduplicates data at the storage level. Identical data blocks are detected throughout the 
whole storage system, which increases the deduplication ratio.  

Veeam Backup & Replication works with ExaGrid appliances as with a Linux backup repository. To 
communicate with ExaGrid, Veeam Backup & Replication uses two Data Mover Services that are 
responsible for data processing and transfer: 

 Data Mover Service on the backup proxy 

 Data Mover service on the ExaGrid appliance 

 

Limitations for ExaGrid 
ExaGrid appliances achieve a lower deduplication ratio when a backup job uses multi-task processing. 
Processing a single task at a time within each backup job results in the best deduplication ratio. If you 
decide to use ExaGrid as a backup repository, all tasks executed within a backup job should be 
processed sequentially, one by one. To do this, you must limit the maximum concurrent tasks to 1 in 
the settings of ExaGrid backup repositories. 

The ExaGrid appliance can handle many concurrent backup jobs, with one of the highest ingest rates 
in the market. To accomplish the maximum ingest and shortest backup time, you need to configure 
multiple backup jobs, each targeted at its own backup repository. Then schedule these jobs to run 
concurrently. 
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HPE StoreOnce 

You can use HPE StoreOnce storage appliances as backup repositories. Depending on the storage 
configuration and type of the backup target, HPE StoreOnce can work in the following ways: 

 Perform source-side deduplication 

 Perform target-side deduplication 

 Work in the shared folder mode 

Source-Side Data Deduplication 
HPE StoreOnce performs source-side deduplication if the backup target meets the following 
requirements: 

1. You have a Catalyst license installed on HPE StoreOnce. 

2. You use a Catalyst store as a backup repository.  

3. The Catalyst store is configured to work in the Low Bandwidth mode (Primary and Secondary 
Transfer Policy).  

4. You add the HPE StoreOnce Catalyst as a deduplicating storage appliance, not as a shared 
folder to the backup infrastructure. 

To deduplicate data on the source side, HPE StoreOnce uses the HPE StoreOnce Catalyst agent. The 
HPE StoreOnce Catalyst agent is a component of the HPE StoreOnce Catalyst software. It is installed on 
the gateway server communicating with the HPE StoreOnce appliance. 

HPE StoreOnce deduplicates data on the source side, before writing it to target: 

1. During the backup job session, HPE StoreOnce analyzes data incoming to the HPE StoreOnce 
appliance in chunks and computes a hash value for every data chunk. Hash values are stored 
in an index on disk. 

2. The HPE StoreOnce Catalyst agent calculates hash values for data chunks in a new data flow 
and sends these hash values to target.  

3. HPE StoreOnce identifies which data blocks are already saved on disk and communicates this 
information to the HPE StoreOnce Catalyst agent. The HPE StoreOnce Catalyst agent sends 
only unique data blocks to target.  

As a result, the load on the network reduces, the backup job performance improves, and you can save 
on disk space. 
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Target-Side Data Deduplication 
HPE StoreOnce performs target-side deduplication if the backup target is configured in the following 
way: 

 For a Catalyst store:  

– The Catalyst store works in the High Bandwidth mode (Primary or Secondary 
Transfer Policy is set to High Bandwidth).  

– The Catalyst license is installed on the HPE StoreOnce (required). 

– The Catalyst store is added as a backup repository to the backup infrastructure. 

 For a CIFS store:  

– The Catalyst license is not required. 

– The CIFS store is added as a backup repository to the backup infrastructure. 

For more information about work with CIFS stores, see Shared Folder Mode. 

HPE StoreOnce deduplicates data on the target side, after the data is transported to HPE StoreOnce: 

1. HPE StoreOnce analyzes data incoming to the HPE StoreOnce appliance in chunks and 
creates a hash value for every data chunk. Hash values are stored in an index on the target 
side.  

2. HPE StoreOnce analyzes VM data transported to target and replaces identical data chunks 
with references to data chunks that are already saved on disk.  

As a result, only new data chunks are written to disk, which helps save on disk space. 

 

Shared Folder Mode 
If you do not have an HPE StoreOnce Catalyst license, you can add the HPE StoreOnce appliance as a 
shared folder backup repository. In this mode, HPE StoreOnce will perform target-side deduplication. 

If you work with HPE StoreOnce in the shared folder mode, the performance of backup jobs and 
transform operations is lower (in comparison with the integration mode, when HPE StoreOnce is 
added as a deduplicating storage appliance). 
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How HPE StoreOnce Works 
To work with HP StoreOnce, Veeam Backup & Replication leverages the HPE StoreOnce Catalyst 
technology and two HPE StoreOnce components: 

 HPE StoreOnce Catalyst agent. The HPE StoreOnce Catalyst agent is a component of the 
HPE StoreOnce Catalyst software. The HPE StoreOnce Catalyst agent is embedded into the 
Veeam Data Mover Service setup. When you add a Microsoft Windows server to the backup 
infrastructure, the HPE StoreOnce Catalyst agent is automatically installed on the added 
server together with the Data Mover Service. 

 HPE StoreOnce appliance. The HPE StoreOnce appliance is an HPE StoreOnce storage 
system on which Catalyst stores are created. 

Veeam Backup & Replication uses two Data Mover Services: 

 Data Mover Service on the backup proxy 

 Data Mover Service on the gateway server 

The gateway server is a backup infrastructure component that “bridges” the backup server and HPE 
StoreOnce appliance. The gateway server must meet the following requirements: 

 The server must run Microsoft Windows OS. 

 The server must be added to the backup infrastructure. 

 The server must have access to the backup server and HPE StoreOnce appliance. 

The gateway server is selected when you assign a backup repository role to the HPE StoreOnce 
appliance. You can define the gateway server explicitly or instruct Veeam Backup & Replication to 
select it automatically: 

 If you define the gateway server explicitly, Veeam Backup & Replication uses this server and 
the data mover service on this server to communicate with the HPE StoreOnce appliance. 

 If you let Veeam Backup & Replication select the gateway server 
automatically, Veeam Backup & Replication uses any Microsoft Windows server that has 
access to the HPE StoreOnce appliance as a gateway server. 

The gateway server is picked at random and per-session. Veeam Backup & Replication may use one 
server for one job session and another server for another job session. 

For HPE StoreOnce storage systems working over Fibre Channel, you must explicitly define the 
gateway server to communicate with HPE StoreOnce. As a gateway server, you must use a Microsoft 
Windows server that is added to the backup infrastructure and has access to HPE StoreOnce over Fibre 
Channel. 

Tip: 

 

For work with HP StoreOnce, Veeam Backup & Replication uses the Catalyst agent installed on the 
gateway proxy. If you want to reduce the load on the network between the source and target side, 
assign the gateway server role to a machine on the source side, closer to the backup proxy. 
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Limitations for HPE StoreOnce 
If you plan to use HPE StoreOnce as a backup repository, mind the following limitations. Limitations 
apply only if you use HPE StoreOnce in the integration mode, not the shared folder mode. 

 Backup files on HPE StoreOnce are locked exclusively by a job or task. If you start several tasks 
at a time, Veeam Backup & Replication will perform a task with a higher priority and will skip 
or terminate a task with a lower priority. 

 In Veeam Backup & Replication, tasks have the following priority levels (starting with the top 
priority): backup job > backup copy > restore. For example, if the backup and backup copy 
jobs start simultaneously, Veeam Backup & Replication will terminate the backup copy task. If 
a file is locked with the backup job, you will not be able to restore VM data from this file. 

 When you create a backup job targeted at HPE StoreOnce, Veeam Backup & Replication will 
offer you to switch to optimized job settings and use the 4 MB size of data block for VM data 
processing. It is recommended that you use optimized job settings. Large data blocks 
produce a smaller metadata table that requires less memory and CPU resources to process. 

 The HPE StoreOnce backup repository always works in the Use per-VM backup files mode. 
For more information, see Per-VM Backup Files. 

 The length of backup chains (chains that contain one full backup and a set of subsequent 
incremental backups) on HPE StoreOnce cannot be greater than 7 restore points. The 
recommended backup job schedule is the following: not more than 1 incremental backup 
once a day, not fewer than one full backup (active or synthetic) once a week. 

 HPE StoreOnce does not support the reverse incremental backup method.  

 The HPE StoreOnce backup repository does not support the Defragment and compact full 
backup file option (for backup and backup copy jobs). 

 You cannot perfom quick migration for Microsoft Hyper-V VMs started with Instant VM 
Recovery from the backup that resides on the HP StoreOnce backup repository. 

 You cannot use the HP StoreOnce backup repository as a target for Veeam Endpoint backup 
jobs. Backup copy jobs, however, can be targeted at the HP StoreOnce backup repository. 

 You cannot use the HPE StoreOnce backup repository as a source or target for file copy jobs. 

 You cannot use the HPE StoreOnce backup repository as a cloud repository. 
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Mount Server 

The mount server is required if you perform restore VM guest OS files and application items to the 
original location. The mount server lets you route VM traffic by an optimal way, reduce load on the 
network and speed up the restore process. 

When you perform file-level restore or application item restore, Veeam Backup & Replication needs to 
mount the content of the backup file to a staging server. The staging server must be located in the 
same site as the backup repository where backup files are stored. If the staging server is located in 
some other site, Veeam Backup & Replication may route data traffic in a non-optimal way.  

For example, if the backup server is located in the local site while the source host and backup 
repository are located in the remote site, during restore to original location 
Veeam Backup & Replication will route data traffic in the following way: 

1. From the remote site to the local site — to mount the content of the backup file to the 
staging server. 

2. From the local site to the remote site — to restore files or application items. 

 

To prevent VM data from traveling between sites, Veeam Backup & Replication uses the mount server. 
The mount server acts as a "mount point" for backups on the backup repository. When you restore 
files or application items to the original location, Veeam Backup & Replication mounts the content of 
the backup file to the mount server (or the original VM for restore to the Microsoft SQL Server and 
Oracle VMs) and copies files or items to their destination via this mount server or VM. For more 
information about possible mount points, see File-Level Restore Scenarios. 

The mount server is created for every backup repository and associated with it. When you configure a 
backup repository, you define which server you want to use as a mount server for this backup 
repository. By default, Veeam Backup & Replication assigns the mount server role to the following 
machines: 

 Backup repository. For Microsoft Windows backup repositories, the mount server role is 
assigned to the backup repository server itself.  

 Backup server. For Linux, shared folder backup repositories and deduplicating storage 
appliances, the mount server role is assigned to the backup server.  

 Veeam Backup & Replication console. The mount server role is also assigned to a machine 
on which the Veeam Backup & Replication console is installed. Note that this type of mount 
server is not registered in the Veeam Backup & Replication configuration database. 

For scale-out backup repositories, you must define the mount server for every extent. 
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If you do not want to use default mount servers, you can assign the mount server role to any Microsoft 
Windows machine in the backup infrastructure. It is recommended that you configure at least one 
mount server in each site and associate this mount server with the backup repository residing in this 
site. The mount server and backup repository must be located as close to each other as possible. In 
this case, you will be able to keep the VM traffic in one site. 

 

Services and Components 

On the mount server machine, Veeam Backup & Replication installs the Veeam Mount Service. The 
Veeam Mount Service requires .NET 4.5.2. If .NET 4.5.2 is not installed on the machine, 
Veeam Backup & Replication will install it automatically. 

Requirements to Mount Server 

The machine to which you assign the mount server role must meet the following requirements: 

 The mount server role can be assigned to a Microsoft Windows machine (physical or virtual). 

 The mount server must have access to the backup repository with which it is associated and 
to the original VM (VM to which you restore files or application items). For restore from 
storage snapshots, the mount server must also have access to the ESX(i) host on which the 
temporary VM is registered. 
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Veeam Backup Enterprise Manager 

Veeam Backup Enterprise Manager is an optional component intended for distributed enterprise 
environments with multiple backup servers. Veeam Backup Enterprise Manager federates backup 
servers and offers a consolidated view of these servers through a web browser interface. You can 
centrally control and manage all jobs through a single "pane of glass", edit and clone jobs, monitor job 
state and get reporting data across all backup servers. Veeam Backup Enterprise Manager also enables 
you to search for VM guest OS files in all current and archived backups across your backup 
infrastructure, and restore these files in one click. 

Veeam Backup Enterprise Manager can be installed on a physical or virtual machine. You can deploy it 
on the backup server or use a dedicated machine. 

Veeam Backup Enterprise Manager uses the following services and components: 

 Veeam Backup Enterprise Manager coordinates all operations of Veeam Backup Enterprise 
Manager, aggregates data from multiple backup servers and provides control over these 
servers. 

 Veeam Enterprise Manager Enterprise SQL Database is used by Veeam Backup Enterprise 
Manager for storing data. The database instance can be located on a SQL Server installed 
either locally (on the same machine as Veeam Backup Enterprise Manager Server) or 
remotely. 

 Veeam Guest Catalog Service replicates and consolidates VM guest OS file system indexing 
data from backup servers added to Veeam Backup Enterprise Manager. Index data is stored in 
Veeam Backup Enterprise Manager Catalog (a folder on the Veeam Backup Enterprise 
Manager Server) and is used to search for VM guest OS files in backups created by 
Veeam Backup & Replication. 

Veeam Backup Search 

In Veeam Backup & Replication, search for guest OS files in backups is performed with Veeam Backup 
Enterprise Manager. However, if you frequently need to search through a great number of backups, it 
is recommended to install Veeam Backup Search from the installation package on a machine running 
Microsoft Search Server. Veeam Backup Search is an optional component in the backup infrastructure 
that is used for the purpose of search performance optimization. 

The Veeam Backup Search server runs the MOSS Integration Service that invokes updates of index 
databases on Microsoft Search Server. The service also sends search queries to Microsoft Search Server 
which processes them and returns necessary search results to Veeam Backup Enterprise Manager. 
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Deployment Scenarios 
Veeam Backup & Replication can be used in virtual environments of any size and complexity. The 
architecture of the solution supports onsite and offsite data protection, operations across remote sites 
and geographically dispersed locations. Veeam Backup & Replication provides flexible scalability and 
easily adapts to the needs of your virtual environment. 

Before installing Veeam Backup & Replication, familiarize yourself with common deployment scenarios 
and carefully plan your backup infrastructure layout. 

Simple Deployment 

In a simple deployment scenario, one instance of Veeam Backup & Replication is installed on a 
physical or virtual Windows-based machine. This installation is referred to as a backup server. 

Simple deployment implies that the backup server performs the following roles: 

 It functions as a management point, coordinates all jobs, controls their scheduling and 
performs other administrative activities. 

 It acts as the default backup proxy for handling job processing and transferring backup traffic. 
All services necessary for the backup proxy functionality are installed on the backup server 
locally. 

 It is used as the default backup repository. During installation, Veeam Backup & Replication 
checks volumes of the machine on which you install the product and identifies a volume with 
the greatest amount of free disk space. On this volume, Veeam Backup & Replication creates 
the Backup folder that is used as the default backup repository. 

 It is used as a mount server and guest interaction proxy. 

 

If you plan to back up and replicate only a small number of VMs or evaluate 
Veeam Backup & Replication, this configuration is enough to get you started. 
Veeam Backup & Replication is ready for use right out of the box — as soon as it is installed, you can 
start using the solution to perform backup and replication operations. To balance the load of backing 
up and replicating your VMs, you can schedule jobs at different times. 

Note: 

 

If you decide to use simple deployment scenario, it is recommended that you install 
Veeam Backup & Replication on a VM, which will enable you to use the Virtual appliance transport 
mode, allowing for LAN-free data transfer. For details, see Transport Modes.  
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The drawback of a simple deployment scenario is that all data is handled and stored on the backup 
server locally. For medium-size or large-scale environments, the capacity of a single backup server 
may not be enough. To take the load off the backup server and balance it throughout your backup 
infrastructure, we recommend that you use the advanced deployment scenario. For details, see 
Advanced Deployment. 

Advanced Deployment 

In large-scale virtual environments with a large number of jobs, the load on the backup server is 
heavy. In this case, it is recommended that you use the advanced deployment scenario that moves the 
backup workload to dedicated backup infrastructure components. The backup server here functions 
as a "manager" for deploying and maintaining backup infrastructure components. 

The advanced deployment includes the following components: 

 Virtual infrastructure servers — VMware vSphere hosts used as source and target for backup, 
replication and VM copy. 

 Backups server — a configuration and control center of the backup infrastructure. 

 Backup proxy — a “data mover” component used to retrieve VM data from the source 
datastore, process it and deliver to the target. 

 Backup repository — a location used to store backup files, VM copies and auxiliary replica 
files.  

 Dedicated mount servers — component required for VM guest OS files and application items 
restore to the original location.  

 Dedicated guest interaction proxies — components used to deploy the runtime process in 
Microsoft Windows VMs. 
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With the advanced deployment scenario, you can easily meet your current and future data protection 
requirements. You can expand your backup infrastructure horizontally in a matter of minutes to match 
the amount of data you want to process and available network throughput. Instead of growing the 
number of backup servers or constantly tuning job scheduling, you can install multiple backup 
infrastructure components and distribute the backup workload among them. The installation process 
is fully automated, which simplifies deployment and maintenance of the backup infrastructure in your 
virtual environment. 

In virtual environments with several proxies, Veeam Backup & Replication dynamically distributes 
backup traffic among these proxies. A job can be explicitly mapped to a specific proxy. Alternatively, 
you can let Veeam Backup & Replication choose the most suitable proxy. In this case, 
Veeam Backup & Replication will check settings of available proxies and select the most appropriate 
one for the job. The proxy server to be used should have access to the source and target hosts as well 
as to the backup repository to which files will be written. 

The advanced deployment scenario can be a good choice for backing up and replicating offsite. You 
can deploy a backup proxy in the production site and another one in the DR site, closer to the backup 
repository. When a job is performed, backup proxies on both sides establish a stable connection, so 
this architecture also allows for efficient transport of data over a slow network connection or WAN. 

To regulate backup load, you can specify the maximum number of concurrent tasks per proxy and set 
up throttling rules to limit proxy bandwidth. The maximum number of concurrent tasks can also be 
specified for a backup repository in addition to the value of the combined data rate for it. 

Another advantage of the advanced deployment scenario is that it contributes to high availability — 
jobs can migrate between proxies if one of them becomes overloaded or unavailable. 

  



 

46   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Distributed Deployment 

The distributed deployment scenario is recommended for large geographically dispersed virtual 
environments with multiple backup servers installed across different sites. These backup servers are 
federated under Veeam Backup Enterprise Manager — an optional component that provides 
centralized management and reporting for these servers through a web interface. 

 

Veeam Backup Enterprise Manager collects data from backup servers and enables you to run backup 
and replication jobs across the entire backup infrastructure through a single "pane of glass", edit them 
and clone jobs using a single job as a template. It also provides reporting data for various areas (for 
example, all jobs performed within the last 24 hours or 7 days, all VMs engaged in these jobs and so 
on). Using indexing data consolidated on one server, Veeam Backup Enterprise Manager provides 
advanced capabilities to search for VM guest OS files in VM backups created on all backup servers 
(even if they are stored in repositories on different sites), and recover them in a single click. Search for 
VM guest OS files is enabled through Veeam Backup Enterprise Manager itself; to streamline the 
search process, you can optionally deploy a Veeam Backup Search server in your backup 
infrastructure. 

With flexible delegation options and security roles, IT administrators can delegate the necessary file 
restore or VM restore rights to authorized personnel in the organization – for example, allow database 
administrators to restore Oracle or SQL server VMs. 

If you use Veeam Backup Enterprise Manager in your backup infrastructure, you do not need to install 
licenses on every backup server you deploy. Instead, you can install one license on the Veeam Backup 
Enterprise Manager server and it will be applied to all servers across your backup infrastructure. This 
approach simplifies tracking license usage and license updates across multiple backup servers. 

In addition, VMware administrators will benefit from Veeam plug-in for vSphere Web Client that can 
be installed using Veeam Backup Enterprise Manager. They can analyze cumulative information on 
used and available storage space view and statistics on processed VMs, review success, warning, 
failure counts for all jobs, easily identify unprotected VMs and perform capacity planning for 
repositories, all directly from vSphere. 
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Resource Scheduling 
With its built-in mechanism of resource scheduling, Veeam Backup & Replication is capable to 
automatically select and use optimal resources to run configured jobs. Resource scheduling is 
performed by the Veeam Backup Service running on the backup server. When a job starts, it 
communicates with the service to inform it about the resources it needs. The service analyzes job 
settings, parameters specified for backup infrastructure components, current load on the 
components, and automatically allocates optimal resources to the job. 

For resource scheduling, Veeam Backup Service uses a number of settings and features: 

Network Traffic Throttling and Multithreaded Data Transfer 

To limit the impact of Veeam Backup & Replication jobs on network performance, you can throttle 
network traffic for jobs. Network traffic throttling prevents jobs from utilizing the entire bandwidth 
available in your environment and makes sure that enough traffic is provided for other critical network 
operations. It is especially recommended that you throttle network traffic if you perform offsite 
backup or replicate VMs to a DR site over slow WAN links. 

In Veeam Backup & Replication, network traffic throttling is implemented through rules that apply to 
backup proxies, so you do not have to make any changes to your network infrastructure. 

Network traffic throttling rules are enforced globally, at the level of the backup server. Every throttling 
rule limits the maximum throughput of traffic going between two backup proxies (in case of 
replication), between a backup proxy and a repository (in case of backup to a repository), or between 
a backup proxy and gateway server (in case of backup to an SMB share). 

Rules are set for a pair of IP address ranges (the range can include a single IP address) and are applied 
to the source backup proxy and the target server (backup proxy, repository or gateway server) 
between which data is transferred over the network. 

Throttling rules are checked against backup infrastructure components between which VM data is 
transferred over the network: more specifically, on which Veeam Data Mover Services engaged in the 
job are started. In case of backup, replication or VM copy jobs, throttling rules are checked against the 
following components: 

 On the source side: backup proxies, either dedicated or the default one — backup server. 

 On the target side:  

• For backup jobs: Windows- or Linux-based backup repository or a gateway server 
(in case you use a CIFS share as a backup repository). 

• For replication jobs: backup proxy. 

 If replication is performed using WAN accelerators, the throttling rule is checked against the 
source and target WAN accelerators.  

In case of backup copying jobs, throttling rules are checked against the following components: 

 If you copy backup files over the direct path, the throttling rule is checked against the 
Windows- or Linux-based backup repository or a gateway server (in case you use a CIFS share 
as a backup repository).  

 If you copy backup files via WAN accelerators, the throttling rule is checked against the 
source and target WAN accelerators.  
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When a new job starts, Veeam Backup & Replication checks network traffic throttling rules against the 
pair of backup proxies assigned for the job — the backup proxy on the source side and the server 
(backup proxy, backup repository or gateway server) on the target side. If the source and target IP 
addresses fall into specified IP ranges, the rule will be applied. For example, if for a network traffic 
throttling rule you specify 192.168.0.1 – 192.168.0.255 as the source range and 172.16.0.1 – 
172.16.0.255 as the target range, and the backup proxy on the source side has IP address 192.168.0.12, 
while the target backup proxy has IP address 172.16.0.31, the rule will be applied. The network traffic 
going from source to target will be throttled. 

 

Note: 

 

Throttling rules are reversible — they function in two directions. If the IP address of the server on the 
source side falls into the target IP range, and the IP address of the server on the target side falls into 
the source IP range, the rule will be applied in any case.  

The backup server equally splits available bandwidth between all jobs that use backup proxies to 
which a network throttling rule applies. For example, if you run one job that uses a pair of proxies to 
which the rule applies, the job will get the entire bandwidth allowed by the rule. If you run two jobs at 
a time, the allowed bandwidth will be equally split between them. As soon as one of the jobs 
completes, the bandwidth assigned to it will be freed, and the remaining job will use the entire 
bandwidth allowed by the rule. 
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Throttling rules can be scheduled to only be active during specific time intervals (for example, during 
business hours). This way, you will minimize the impact of job performance spikes on the production 
network. Alternatively, you can select to apply throttling rules regardless of the time. 

In addition to traffic throttling, Veeam Backup & Replication offers another possibility for network 
traffic management — management of data transfer connections. Normally, within one backup 
session Veeam Backup & Replication opens five parallel TCP/IP connections to transfer data from 
source to target. Multithreaded data transfer increases the transfer speed but can place additional 
load on the network. If required, you can disable multithreaded data transfer and limit the number of 
connections per session to one. 

Note: 

 

Veeam Backup & Replication performs a CRC check for the TCP traffic going between the source and 
the target. When you perform backup, replication or VM copy operations, 
Veeam Backup & Replication calculates checksums for data blocks going from the source. On the 
target, it re-calculates checksums for received data blocks and compares them to the checksums 
created on the source. If the CRC check fails, Veeam Backup & Replication automatically re-sends 
data blocks without any impact on the job. 

Limiting the Number of Concurrent Tasks 

To avoid overload of backup proxies and backup repositories, Veeam Backup & Replication allows you 
to limit the number of concurrent tasks performed on a backup proxy or targeted at a backup 
repository. 

Before processing a new task, Veeam Backup & Replication detects what backup infrastructure 
components (backup proxies and repositories) will be involved. When a new job starts, 
Veeam Backup & Replication analyzes the list of VMs that the job includes, and creates a separate task 
for each disk of every VM to be processed. Tasks in the job can be processed in parallel (that is, VMs 
and VM disks within a single job can be processed simultaneously), optimizing your backup 
infrastructure performance and increasing the efficiency of resource usage.  

Note: 

 

To use this capability, proxy server(s) should meet system requirements – each task requires a single 
CPU core, so for two tasks to be processed in parallel, 2 cores is the recommended minimum. Parallel 
VM processing must also be enabled in Veeam Backup & Replication options. 

Task limiting is performed by the Veeam Backup Service that is aware of all backup proxies and 
backup repositories connected to it, and settings specified for these backup proxies and repositories 
(namely, the number of allowed concurrent tasks). When a job starts, it informs the Veeam Backup 
service about its task list and polls the service about allocated resources to its tasks at a 10 second 
interval after that. Before a new task targeted at a specific backup proxy or repository starts, the 
Veeam Backup Service checks the current workload (the number of tasks currently working with the 
proxy or repository) and the number of allowed tasks per this component. If this number is exceeded, 
a new task will not start until one of the currently running tasks is finished. 
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Limiting Combined Data Rate for Backup Repositories 

Veeam Backup & Replication can limit the speed with which Veeam Backup & Replication must read 
and write data to/from the backup repository. The data read and write speed is controlled with the 
Limit combined data rate to <N> MB/s setting that you can specify in the properties of the backup 
repository. 

 

The Veeam Backup Service is aware of combined data rate settings configured for all backup 
repositories in the backup infrastructure. When a job targeted at some backup repository is 
performed, the Veeam Backup Service informs the Veeam Data Mover Service running on this backup 
repository about the allowed read/write speed specified for this repository so that the Veeam Data 
Mover Service can limit the read/write speed to the specified value. 

If the backup repository is used by a number of tasks simultaneously, Veeam Backup & Replication 
splits the allowed read/write speed rate between these tasks equally. Note that the specified limit 
defines the allowed read speed and the allowed write speed at the same time.  

For example, you have set the Limit combined data rate to setting to 8 MB/s and started two backup 
jobs. Each job processes one VM with one VM disk. In this case, Veeam Backup & Replication will create 
2 tasks and target them at the backup repository. The data write rate will be split between these 2 
tasks equally: 4 MB/s for one task and 4 MB/s for the other task. 

If at this moment you start some job reading data from the same backup repository, for example, a 
backup copy job, Veeam Backup & Replication will assign the read speed rate equal to 8 MB/s to this 
job. If you start 2 backup copy jobs at the same time, Veeam Backup & Replication will split the read 
speed rate between these 2 jobs equally: 4 MB/s for one backup copy job and 4 MB/s for the other 
backup copy job. 
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Detecting Performance Bottlenecks 

As any backup application handles a great amount of data, it is important to make sure the data flow 
is efficient and all resources engaged in the backup process are optimally used. 
Veeam Backup & Replication provides advanced statistics about the data flow efficiency and lets you 
identify bottlenecks in the data transmission process.  

Veeam Backup & Replication processes VM data in cycles. Every cycle includes a number of stages: 

 Reading VM data blocks from the source 

 Processing VM data on the backup proxy 

 Transmitting data over the network  

 Writing data to the target 

When one data processing cycle is over, the next cycle begins. VM data therefore goes over the “data 
pipe”. 

 

To evaluate the data pipe efficiency, Veeam Backup & Replication analyzes performance of all 
components in the data flow working as the cohesive system and evaluates key factors on the source 
and target sides. In the data pipe, the following points, or components, are considered:  

1. Source — the source disk reader component responsible for retrieving data from the source 
storage. 

2. Proxy — the backup proxy component responsible for processing VM data. 

3. [For backup copy and replication jobs working via WAN accelerators] Source WAN 
accelerator — the WAN accelerator deployed on the source side. 

4. Network — the network queue writer component responsible for getting processed VM data 
from the backup proxy and sending it over the network to the backup repository or another 
backup proxy. 

5. [For backup copy and replication jobs working via WAN accelerators] Target WAN 
Accelerator — the WAN accelerator deployed on the target side. 

6. Target — the target disk writer component (backup storage or replica datastore). 

The resource usage level for the four points is evaluated in percent. This percent rate defines the 
amount of time for which components are busy during the job. An efficient data flow assumes that 
there is no latency at any point of the data pipe and all its components work for approximately equal 
amount of time.  
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If any of the components operates inefficiently, there may appear a bottleneck in the data path. The 
insufficient component will work 100% of time while the others will be idling, waiting for data to be 
transferred. As a result, the whole data flow will slow down to the level of the slowest point in the data 
path and the overall time of data processing will increase. 

To identify a bottleneck in the data path, Veeam Backup & Replication detects the component with 
the maximum workload: that is, the component that works for the most time of the job. For example, 
you use a low-speed storage device as the backup repository. Even if VM data is retrieved from SAN 
storage on the source side and transmitted over a high-speed link, VM data flow will still be impaired 
at the backup repository. The backup repository will be trying to consume transferred data at the rate 
that exceeds its capacity and the other components will stay idle. As a result, the backup repository 
will be working 100% of job time, while other components may be employed, for example, for 60% 
only. In terms of Veeam Backup & Replication, such data path will be considered insufficient. 

The bottleneck statistics for a job is displayed in the job session data. The bottleneck statistics does 
not necessarily mean that you have a problem in your backup infrastructure; it simply informs you 
about the weakest component in the data path. However, if you feel that the job performance is low, 
you may try taking some measures to resolve the bottleneck. For instance, in the case described 
above, you can limit the number of concurrent tasks for the backup repository.  
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Data Processing Modes 

Veeam Backup & Replication can process VMs in the job and VM disks in parallel or sequentially. The 
data processing mode is a global setting: it takes effect for all jobs configured on the backup server.  

Parallel Data Processing 

By default, Veeam Backup & Replication works in the parallel data processing mode. If a job includes 
several VMs or VMs in the job have several disks, VMs and VM disks are processed concurrently.  

Parallel data processing optimizes the backup infrastructure performance and increases efficiency of 
resource usage. It also reduces the time of VM snapshots being open and mitigates the risk of long 
snapshot commit. 

 

If you choose to process VM data in parallel, check task limitation settings for components in your 
backup infrastructure and make sure that these components have sufficient compute resources to 
support parallel processing.  

Task limitation settings define the number of tasks that the backup infrastructure component can 
perform concurrently, or at the same moment. The maximum number of concurrent tasks that a 
backup proxy or repository can perform depends on the number of CPU cores available on this 
backup proxy or backup repository. It is strongly recommended that you assign task limitation 
settings using the following rule: 1 task = 1 CPU core. For example, if a backup proxy has 4 CPU cores, 
it is recommended that you limit the number of concurrent tasks for this backup proxy to 4. 

Task limits specified for backup proxies and backup repositories influence the job performance. For 
example, you add a VM with 4 disks to a job and target this job at the backup proxy that can process 
maximum 2 tasks concurrently. In this case, Veeam Backup & Replication will create 4 tasks (1 task per 
each VM disk) and start processing 2 tasks in parallel. The other 2 tasks will be pending. 
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For more information, see Limiting Data Ingestion Rate for Backup Repositories.  

Note: 

 

When you limit the number of tasks for the backup repository, you should also consider the storage 
throughput. If the storage system is not able to keep up with the number of tasks that you have 
assigned, it will be the limiting factor. It is recommended that you test components and resources of 
your backup infrastructure to define the workload that they can handle. 
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Subsequent Data Processing 

If you do not want to use parallel data processing, you can disable it. In this case, 
Veeam Backup & Replication will process VMs and VM disks in the job one by one, sequentially.  

Even if you disable parallel data processing, backup proxies and backup repositories can still process 
tasks from different jobs in parallel. For example: 

1. You set up the backup proxy to process 2 tasks simultaneously. 

2. You configure 2 backup jobs, each processing 1 VM with 1 disk.  

When you start backup jobs, Veeam Backup & Replication will create 2 tasks and assign these tasks to 
the backup proxy. The backup proxy will perform these tasks in parallel. 
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Backup 
Unlike traditional backup tools designed to work with physical machines, Veeam Backup & Replication 
is built specifically for virtual environments. It operates at the virtualization layer and uses an image-
based approach for VM backup. To retrieve VM data, no agent software needs to be installed inside 
the guest OS. Instead, Veeam Backup & Replication leverages ESX snapshot capabilities. When a new 
backup session starts, a snapshot is taken to create a cohesive point-in-time copy of a VM including its 
configuration, OS, applications, associated data, system state and so on. Veeam Backup & Replication 
uses this point-in-time copy to retrieve VM data. Image-based backups can be used for different types 
of recovery, including full VM recovery, VM file recovery, Instant VM Recovery, file-level recovery and 
other. 

Use of the image-based approach allows Veeam Backup & Replication to overcome shortfalls and 
limitations of traditional backup (such as, the necessity to provide guest OS credentials for every VM, 
significant resource overhead on the VM and hypervisor during the backup process, management 
overhead and so on). It also helps streamline recovery verification and the restore process — to 
recover a single VM, there is no need to perform multiple restore operations. 
Veeam Backup & Replication uses a cohesive VM image from the backup to restore a VM to the 
required state without the necessity for manual reconfiguration and adjustment. 

In Veeam Backup & Replication, backup is a job-driven process where one backup job can be used to 
process one or more VMs. A job is a configuration unit of the backup activity. Essentially, the job 
defines when, what, how and where to back up. It indicates what VMs should be processed, what 
components should be used for retrieving and processing VM data, what backup options should be 
enabled and where to save the resulting backup file. Jobs can be started manually by the user or 
scheduled to run automatically. 

The resulting backup file stores compressed and deduplicated VM data. All backup files created by the 
job are located in a dedicated job folder on a backup repository. Veeam Backup & Replication creates 
and maintains the following types of backup files: 

 Full backup (.vbk) to store copies of full VM images 

 Backup increment (.vib or .vrb) to store incremental changes to VM images 

 Backup metadata (.vbm) to provide information on the backup job, VMs in the backup, 
number and structure of backup files, restore points, and so on. The metadata file facilitates 
import of backups or mapping of backup jobs to existing backups. 

To back up VMs, you can use one of three available methods:  

 Forever forward incremental backup 

 Forward incremental backup  

 Reverse incremental backup 

Regardless of the method you use, the first run of a job creates a full backup of VM image. Subsequent 
job runs are incremental — Veeam Backup & Replication copies only those data blocks that have 
changed since the last backup job run. To keep track of changed data blocks, 
Veeam Backup & Replication uses different approaches, including VMware’s Changed Block Tracking 
(CBT) technology. 
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Transport Modes 
Job efficiency and time required for job completion greatly depends on the transport mode. The 
transport mode is a method that is used by the Veeam Data Mover Service to retrieve VM data from 
the source and write VM data to the target.  

For data retrieval, Veeam Backup & Replication offers the following modes (starting from the most 
efficient): 

 Direct storage access 

 Virtual appliance 

 Network 

The Veeam Data Mover Service responsible for data retrieval runs on a backup proxy. 
Correspondingly, the transport mode can be defined in the settings of the backup proxy that performs 
the job.  

When configuring backup proxy settings, you can manually select a transport mode, or let 
Veeam Backup & Replication select the most appropriate mode automatically. If you use automatic 
mode selection, Veeam Backup & Replication will scan backup proxy configuration and its connection 
to the VMware vSphere infrastructure to choose the optimal transport mode. If several transport 
modes are available for the same backup proxy, Veeam Backup & Replication will choose the mode in 
the following order: Direct storage access > Virtual appliance > Network. 

The selected transported mode is used for data retrieval. For writing data to the target, 
Veeam Backup & Replication picks the transport mode automatically, based on the configuration of 
the backup proxy and transport mode limitations. 

For all transport modes, Veeam Backup & Replication leverages VMware vStorage APIs for Data 
Protection (VADP). VADP can be used for VMware vSphere starting from version 4. 

Applicability and efficiency of each transport mode primarily depends on the type of datastore used 
by the source host — local or shared, and on the backup proxy type — physical or virtual. The table 
below shows recommendations for installing the backup proxy, depending on the storage type and 
desired transport mode. 

Production Storage 
Type 

Direct Storage Access Virtual Appliance Network Mode 

Fiber Channel (FC) 
SAN 

Install a backup proxy 
on a physical server 
with a direct FC access 
to the SAN. 

Install a backup proxy 
on a VM running on an 
ESX(i) host connected 
to the storage device. 

This mode is not 
recommended on 1 Gb 
Ethernet but works well 
with 10 Gb Ethernet.  

Install a backup proxy 
on any machine on the 
storage network. 

iSCSI SAN 
Install a backup proxy 
on a physical or virtual 
machine. 

NFS Storage 
Install a backup proxy 
on a physical or virtual 
machine. 

Local Storage Not supported 
Install a backup proxy 
on a VM on every ESX(i) 
host. 

Install a backup proxy 
on any machine in the 
storage network. 
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Direct Storage Access 

In the Direct storage access mode, Veeam Backup & Replication reads/writes data directly from/to the 
storage system where VM data or backups are located. This mode comprises two transport modes: 

 Direct SAN access 

 Direct NFS access 

Direct SAN Access 

The Direct SAN access transport mode is recommended for VMs whose disks are located on shared 
VMFS SAN LUNs that are connected to ESX(i) hosts via FC or iSCSI.  

In the Direct SAN access transport mode, Veeam Backup & Replication leverages VMware VADP to 
transport VM data directly from and to FC and iSCSI storage over the SAN. VM data travels over the 
SAN, bypassing ESX(i) hosts and the LAN. The Direct SAN access transport method provides the fastest 
data transfer speed and produces no load on the production network. 

The Direct SAN access transport mode can be used for all operations where the backup proxy is 
engaged: 

 Backup 

 Replication 

 VM copy 

 Quick migration 

 Full VM restore 

 VM disk restore 

 Replica failback 

Requirements for the Direct SAN Access Mode 

To use the Direct SAN access transport mode, make sure that the following requirements are met: 

1. The backup proxy using the Direct SAN access transport mode must have a direct access to 
the production storage via a hardware or software HBA. If a direct SAN connection is not 
configured or not available when a job or task starts, the job or task will fail. 

2. SAN storage volumes presented as VMware datastores must be exposed to the OS of the 
backup proxy that works in the Direct SAN access transport mode.  

The volumes must be visible in Disk Management but must not be initialized by the OS. 
Otherwise, the VMFS filesystem will be overwritten with NTFS, and volumes will become 
unrecognizable by ESX(i) hosts. To prevent volumes initialization, 
Veeam Backup & Replication automatically sets the SAN Policy within each proxy to Offline 
Shared. 

3. [For restore operations] The backup proxy must have write access to LUNs where VM disks are 
located. 
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Limitations for the Direct SAN Access Mode 

1. The Direct SAN access transport mode is not supported for VMs residing on vSAN. You can 
use Virtual Appliance and Network transport modes to process such VMs. For details on vSAN 
restrictions, see VDDK 5.5 Release Notes. 

2. The Direct SAN access transport mode cannot be used if at least one VM disk is located on a 
VVol. 

3. Veeam Backup & Replication uses the Direct SAN access transport mode to read and write VM 
data only during the first session of the replication job. During subsequent replication job 
sessions, Veeam Backup & Replication will use the Virtual Appliance or Network transport 
mode on the target side. The source side proxy will keep reading VM data from the source 
datastore in the Direct SAN access transport mode.  

Veeam Backup & Replication writes VM data to the target datastore in the Direct SAN access 
transport mode only if disks of a VM replica are thick-provisioned. If disks are thin-
provisioned, Veeam Backup & Replication will write VM data in the Network or Virtual 
Appliance mode. By default, Veeam Backup & Replication replicates VM disks in the thin 
format. To write VM data to the target datastore in the Direct SAN access transport mode, 
select to convert VM disks to the thick format at the Destination step of the replication job 
wizard. 

4. The Direct SAN access transport mode can be used to restore only thick VM disks. 

5. The Direct SAN access transport mode cannot be used for incremental restore due to VMware 
limitations. Either disable CBT for VM virtual disks for the duration of the restore process or 
select another transport mode for incremental restore. 

For VMware vSphere 5.5 and later 

IDE and SATA disks can be processed in the Direct SAN access transport mode. 

For VMware vSphere 5.1 and earlier 

 IDE disks can be backed up in the Direct SAN access transport mode. Restore of IDE disks in 
the Direct SAN access transport mode is not supported. 

 If a VM disk fails to be processed in the Direct SAN access transport mode, 
Veeam Backup & Replication does not fail over to the Network mode. 

 If a VM has some disks that cannot be processed in the Direct SAN access transport mode, 
Veeam Backup & Replication uses the Network mode for VM disks processing. 

  

https://www.vmware.com/support/developer/vddk/vddk-550-releasenotes.html
http://pubs.vmware.com/vsphere-51/index.jsp?topic=%2Fcom.vmware.vddk.pg.doc%2FvddkBkupVadp.9.5.html
http://pubs.vmware.com/vsphere-51/index.jsp?topic=%2Fcom.vmware.vddk.pg.doc%2FvddkBkupVadp.9.5.html
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Data Backup in Direct SAN Access Mode 

To retrieve VM data blocks from a SAN LUN during backup, the backup proxy uses metadata about the 
layout of VM disks on the SAN. 

Data backup in the Direct SAN access transport mode includes the following steps: 

1. The backup proxy sends a request to the ESX(i) host to locate the necessary VM on the 
datastore. 

2. The ESX(i) host locates the VM. 

3. The ESX(i) host retrieves metadata about the layout of VM disks on the storage (physical 
addresses of data blocks). 

4. The ESX(i) host sends metadata to the backup proxy. 

5. The backup proxy uses metadata to copy VM data blocks directly from the storage via the 
SAN. 

6. The backup proxy processes copied data blocks and sends them to the target. 
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Data Restore in Direct SAN Access Mode 

Data restore in the Direct SAN access transport mode includes the following steps: 

1. The backup proxy retrieves data blocks from the backup repository or a datastore in the 
target site. 

2. The backup proxy sends a request to the ESX(i) host in the source site to restore data to a 
necessary datastore. 

3. The ESX(i) host in the source site allocates space on the datastore.  

4. Data blocks are written to the datastore. 

 

The Direct SAN access transport mode can be used to restore VMs only with thick disks. Before VM 
data is restored, the ESX(i) host needs to allocate space for the restored VM disk on the datastore: 

 When thick disks are restored, the ESX(i) host allocates space on disk before writing VM data. 

 When thin disks are restored, the ESX(i) host attempts to allocate space on the fly, as requests 
for data blocks restore are received. 

As a result, restore of thin disks involves extra allocation overhead if compared to restore of thick disks, 
which results in decreased performance. 

To restore VMs with thin disks, you can use the Virtual appliance mode or the Network mode. If you 
plan to process a VM that has both thin and thick disks, you can select the Direct SAN access transport 
mode and choose to failover to the Network mode if SAN becomes inaccessible. In this case, 
Veeam Backup & Replication will use the Direct SAN access transport mode to restore thick disks and 
the Network transport mode to restore thin disks. Alternatively, you can restore all VM disks as thick. 

Disk Restore Format 

In the Direct SAN access mode, Veeam Backup & Replication restores thick disks in the Thick Eager 
Zeroed format. The disk allocation takes a little longer than allocation of the disk in the Thick Lazy 
Zeroed format (used in Veeam Backup & Replication 8.0) as data remaining on the physical device is 
zeroed out when the virtual disk is created. However, the restore process itself is much faster — 
Veeam Backup & Replication does not need to address the VMware vCenter Server to zero out data on 
disk. 

If necessary, you can instruct Veeam Backup & Replication to restore disks in the Thick Lazy Zeroed 
format. For more information, contact the Veeam Support Team. 
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Direct NFS Access 

The Direct NFS access is a recommended transport mode for VMs whose disks are located on NFS 
datastores.  

The Direct NFS access mode provides an alternative to the Network mode. When 
Veeam Backup & Replication processes VM data in the Network mode, it uses VMware VDDK to 
communicate with the ESX(i) host. This produces additional load on the ESX(i) host. 

 

In the Direct NFS access mode, Veeam Backup & Replication bypasses the ESX(i) host and reads/writes 
data directly from/to NFS datastores. To do this, Veeam Backup & Replication deploys its native NFS 
client on the backup proxy and uses it for VM data transport. VM data still travels over the LAN but 
there is no load on the ESX(i) host. 
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The Direct NFS access mode can be used for all operations where the backup proxy is engaged: 

 Backup  

 Replication 

 Quick migration 

 VM copy 

 Full VM restore 

 VM disk restore 

 Replica failback 

Requirements for the Direct NFS Access Mode 

 The backup proxy used for VM data processing must have access to the NFS datastore(s) 
where VM disks are located. For more information, see Backup Proxy for Direct NFS Access 
Mode. 

 If NFS volumes are mounted on the ESX(i) host under names, not IP addresses, the volume 
names must be resolved by DNS from the backup proxy. 

Limitations for Direct NFS Access Mode 

1. Veeam Backup & Replication cannot parse delta disks in the Direct NFS access mode. For this 
reason, the Direct NFS access mode has the following limitations: 

 The Direct NFS access mode cannot be used for VMs that have at least one 
snapshot. 

 Veeam Backup & Replication uses the Direct NFS transport mode to read and 
write VM data only during the first session of the replication job. During 
subsequent replication job sessions, the VM replica will already have one or 
more snapshots. For this reason, Veeam Backup & Replication will use another 
transport mode to write VM data to the datastore on the target side. The 
source side proxy will keep reading VM data from the source datastore in the 
Direct NFS transport mode.  

2. If you enable the Enable VMware tools quiescence option in the job settings, 
Veeam Backup & Replication will not use the Direct NFS transport mode to process running 
Microsoft Windows VMs that have VMware Tools installed. 

3. If a VM has some disks that cannot be processed in the Direct NFS access mode, 
Veeam Backup & Replication processes these VM disks in the Network transport mode. 
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Backup Proxy for Direct NFS Access Mode 

Veeam Backup & Replication deploys its NFS agent on every backup proxy when you assign the 
backup proxy role to a Microsoft Windows server (physical or virtual). To instruct the backup proxy to 
use the Direct NFS access mode, you must choose the Automatic selection or Direct storage access 
option in the backup proxy settings. 

 

To read and write data in the Direct NFS transport mode, the backup proxy must meet the following 
requirements: 

1. The backup proxy must have access to the NFS datastore. 

2. The backup proxy must have ReadOnly/Write permissions and root access to the NFS 
datastore.  

If you have several backup proxies that can process VM data in the Direct NFS transport mode, 
Veeam Backup & Replication selects the first proxy from the list of available proxies. The priority is 
given to backup proxies in the local network. 

Veeam Backup & Replication checks what NFS datastores are accessible by backup proxies and what 
permissions backup proxies have on NFS datastores during the host discovery process. The host 
discovery process rescans Microsoft Windows servers to which the backup proxy role is assigned. The 
host discovery process is started automatically by schedule, or you can start it manually. The host 
discovery process is also triggered automatically when you change the transport mode settings and 
assign the Direct storage access transport mode to the backup proxy.  
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Data Backup in Direct NFS Access Mode 

Data backup in the Direct NFS access transport mode is performed in the following way: 

1. The backup proxy sends a request to the ESX(i) host to locate a VM on the NFS datastore.  

2. The ESX(i) host locates the VM. 

3. The ESX(i) host retrieves metadata about the layout of VM disks on the storage (physical 
addresses of data blocks).  

4. The ESX(i) host sends metadata to the backup proxy.  

5. The backup proxy uses metadata to copy VM data blocks directly from the NFS datastore over 
the LAN.  

6. The backup proxy processes copied data blocks and sends them to the target over the LAN. 
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Data Restore in Direct NFS Access Mode 

Data restore in the Direct NFS access transport mode is performed in the following way: 

1. The backup proxy retrieves data blocks from the backup repository or a datastore in the 
target site.  

2. The backup proxy sends a request to the ESX(i) host to restore data to an NFS datastore.  

3. The ESX(i) host allocates space on the NFS datastore.  

4. Data blocks obtained from the backup proxy are written to the NFS datastore over the LAN. 
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Virtual Appliance 

The Virtual appliance mode is not so efficient as the Direct storage access mode but provides better 
performance than the Network mode. The Virtual appliance mode is recommended if the role of a 
backup proxy is assigned to a VM. 

In the Virtual appliance mode, Veeam Backup & Replication uses the VMware SCSI HotAdd capability 
that allows attaching devices to a VM while the VM is running. During backup, replication or restore 
disks of the processed VM are attached to the backup proxy. VM data is retrieved or written directly 
from/to the datastore, instead of going through the network.  

The Virtual appliance transport mode can be used for all operations where the backup proxy is 
engaged: 

 Backup  

 Replication 

 VM copy 

 Quick migration 

 Full VM restore 

 VM disk restore 

 Replica failback 

Requirements for the Virtual Appliance mode 

To use the Virtual Appliance transport mode, make sure that the following requirements are met: 

1. The role of a backup proxy must be assigned to a VM.  

2. The ESX(i) host on which the backup proxy is deployed must have access to the datastore 
hosting disks of VMs that you plan to process.  

3. The backup server and backup proxy must have the latest version of VMware Tools installed. 

Limitations for the Virtual Appliance mode 

1. If you use VMware vSphere version 5.1 and earlier, the maximum size of a VM virtual disk be 
processed must not exceed 1.98 TB. 

2. If you plan to process VMs whose disks are located on a VMFS 3 datastore, you must format 
the datastore with a proper block size to be able to mount large VM virtual disks to the 
backup proxy or helper VM: 

 1 MB block size — 256 GB maximum file size 

 2 MB block size — 512 GB maximum file size 

 4 MB block size — 1024 GB maximum file size 

 8 MB block size — 2048 GB maximum file size 

This limitation does not apply to VMFS-5 volumes that always have 1 MB file block size. 

3. Backup and restore of IDE disks in the Virtual appliance mode is not supported. 

4. Backup and restore of SATA disks in the Virtual appliance mode is supported if you use 
VMware vSphere 6.0 and later. 
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Data Backup and Restore in Virtual Appliance Mode 

The process of data retrieval in the Virtual appliance transport mode includes the following steps: 

1. The backup proxy sends a request to the ESX(i) host to locate the necessary VM on the 
datastore. 

2. The ESX(i) host locates the VM. 

3. Veeam Backup & Replication triggers VMware vSphere to create a VM snapshot. 

4. VM disks are attached (hot-added) to the backup proxy.  

5. Veeam Backup & Replication reads data directly from disks attached to the backup proxy. 

6. When the VM processing is complete, VM disks are detached from the backup proxy and the 
VM snapshot is deleted. 

 

The process of data restore in the Virtual appliance mode works in a similar manner. VM disks from the 
backup are attached to the backup proxy and Veeam Backup & Replication transports VM data to the 
target datastore. After the restore process is finished, VM disks are detached from the backup proxy. 

Virtual Appliance Mode for VMs on VSAN 

To transport data of VMs residing on VSAN in the Virtual appliance mode, you must assign the backup 
proxy role to a VM. The VM must reside on any of ESXi hosts connected to a VSAN cluster. 
Veeam Backup & Replication will retrieve data of processed VMs via the I/O stack of the ESX(i) host on 
which the backup proxy is deployed. 

If you have several backup proxies on ESXi hosts in a VSAN cluster, Veeam Backup & Replication 
chooses the most appropriate backup proxy to reduce the backup traffic on the VSAN cluster network. 
To choose a backup proxy, Veeam Backup & Replication checks HDDs directly attached to every ESXi 
host and calculates the amount of VM data on these HDDs. The preference is given to the ESXi host 
that has a direct access to an HDD with the maximum amount of VM data. This approach helps reduce 
workload on the ESXi I/O stack during data transport. 
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Network Mode 

The Network mode can be used with any infrastructure configuration. In this mode, data is retrieved 
via the ESX(i) host over the LAN using the Network Block Device protocol (NBD). 

The Network mode is not a recommended data transport mode because of low data transfer speed 
over the LAN. To take the load off the LAN, Veeam Backup & Replication provides two alternative 
modes: Direct Storage Access and Virtual Appliance. The Network mode is the only applicable mode 
when the backup proxy role is assigned to a physical machine and the host uses local storage.  

 

The process of data retrieval in Network mode includes the following steps: 

1. The backup proxy sends a request to the ESX(i) host to locate the necessary VM on the 
datastore. 

2. The ESX(i) host locates the VM on the datastore.  

3. VM data blocks are copied from the production storage and sent to the backup proxy over 
the LAN. 

4. The backup proxy sends the data to target. 

Veeam Backup & Replication processes VM disks one by one or in parallel, depending on selected data 
processing settings. If VM disks are located on different storages (for example, on the SAN and local 
storage), Veeam Backup & Replication uses different transport modes to process VM disks. In such 
scenario, it is strongly recommended that you select the Failover to network mode if primary 
transport modes fail or are unavailable option when configuring the mode settings for the backup 
proxy. 
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Failover to Network Mode 

You can instruct Veeam Backup & Replication to switch to the Network transport mode and transfer 
VM data over the LAN if the primary transport mode — Direct storage access or Virtual appliance — 
cannot be used for some reason. This option is enabled by default to ensure that jobs and tasks can be 
completed successfully in any situation.  

Note that data transport over the LAN puts additional load on your production network and may 
potentially affect performance if you accomplish data protection and disaster recovery tasks in 
business hours. 
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Backup Architecture 
The backup infrastructure in a VMware vSphere environment comprises the following components: 

 One or more source hosts with associated datastores 

 One or more backup proxy servers 

 One or more backup repositories 

 One or more guest interaction proxies (optional) 

The source host and the repository produce two terminal points between which VM data is moved. 
Backup data is collected, transformed and transferred with the help of Veeam Data Mover Services. 
Veeam Backup & Replication uses two-service architecture — one Veeam Data Mover Service controls 
interaction with the source host during data transfer and the other one controls interaction with the 
backup repository. The Veeam Data Mover Services communicate with each other and maintain a 
stable connection. All backup infrastructure components engaged in the job make up a data pipe. VM 
data is moved over this data pipe block by block, so that processing of a single VM includes multiple 
processing cycles. 

When a new backup session starts, Veeam Backup & Replication performs the following actions: 

1. Veeam Backup & Replication deploys the runtime process on VM guest OSes via the guest 
interaction proxy (for Microsoft Windows VMs) or backup server (for VMs with other OSes). 

2. The target-side Veeam Data Mover Service obtains the job instructions and communicates 
with the source-side Veeam Data Mover Service to begin data collection. 

3. The source-side Veeam Data Mover Service copies VM data from the snapshot using one of 
VMware transport modes, as prescribed by the backup proxy server settings. While copying, 
the source-side Veeam Data Mover Service performs additional processing — it consolidates 
the content of virtual disks by filtering out overlapping snapshot blocks, zero data blocks and 
blocks of swap files. During incremental job runs, the Veeam Data Mover Service retrieves 
only those data blocks that have changed since the previous job run. Copied blocks of data 
are compressed and moved from the source-side Veeam Data Mover Service to the target-
side Data Mover Service. 

4. The target-side Veeam Data Mover Service deduplicates similar blocks of data and writes 
the result to the backup file in the backup repository. 

Veeam Backup & Replication supports a number of backup scenarios that depend on the type of 
repository you use and its location. For details, see Backup Repository. 
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Onsite Backup 

To back up to an onsite Windows or Linux repository, you need to deploy a backup proxy on a server 
that has access to the source datastore, and point the backup job to this proxy. In this scenario, the 
source-side Veeam Data Mover Service is started on the proxy server, and the target-side Veeam Data 
Mover Service is started on the Windows or Linux repository server. Backup data is sent from the 
backup proxy to the repository over LAN. 

 

To back up to an onsite SMB share, you need a Microsoft Windows gateway server that has access to 
the SMB share. This can be either the backup server or another Windows server added to the 
Veeam Backup & Replication console. 

You can use one Windows server as the backup proxy and gateway server for SMB. In this scenario, 
Veeam Backup & Replication starts the source-side and target-side Veeam Data Mover Services on the 
same server. Backup data is sent from the proxy to the target SMB share over LAN. 
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Offsite Backup 

The common requirement for offsite backup is that one Veeam Data Mover Service runs in the 
production site (closer to the source datastore) and the other Veeam Data Mover Service runs in the 
remote target site (closer to the repository). During backup, Veeam Data Mover Services maintain a 
stable connection, which allows for uninterrupted operation over WAN or slow links. 

To perform offsite backup to a Windows or Linux repository, you need to deploy a backup proxy in the 
production site (closer to the source datastore). In this scenario, the source-side Veeam Data Mover 
Service is started on the proxy server and the target-side Veeam Data Mover Service is started on the 
Windows or Linux repository server. Backup data is sent from the proxy to the repository over WAN. 

 

To back up VMs to an offsite SMB share, you should deploy a backup proxy in the source site and an 
additional Microsoft Windows gateway server in the remote site. The SMB repository should be 
configured to point to the target-side gateway server. During backup the source-side Veeam Data 
Mover Service runs on the source proxy in the production site and the target-side Veeam Data Mover 
Service runs on the target gateway server in the remote site. Backup data is transferred between the 
backup proxy and the gateway server over WAN.  
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Backup Methods 
Veeam Backup & Replication provides three methods for creating backup chains: 

 Forever forward incremental backup 

 Forward incremental backup 

 Reverse incremental backup 

Forever Forward Incremental Backup 

The forever forward incremental backup method produces a backup chain that consists of the first full 
backup and a set of forward incremental backups following it. 

Veeam Backup & Replication creates a forever forward incremental backup chain in the following way: 

1. During the first run of a backup job, Veeam Backup & Replication creates a full backup file 
(VBK) on the backup repository.  

2. During subsequent backup job sessions, Veeam Backup & Replication copies only VM data 
blocks that have changed since the last performed backup (full or incremental) and saves 
these blocks as an incremental backup file (VIB) in the backup chain. 

After adding a new restore point to the backup chain, Veeam Backup & Replication checks the 
retention policy set for the job. If Veeam Backup & Replication detects an outdated restore 
point, it transforms the backup chain to make room for the most recent restore point. For 
more information, see Retention Policy for Forever Forward Incremental Backup. 
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To use this backup method, you must select the following options in the backup job settings: 

1. Select the Incremental backup mode. 

2. Do not enable synthetic full backups and/or active full backups. If you enable synthetic 
and/or active full backups, Veeam Backup & Replication will produce a forward incremental 
backup chain. 
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Forward Incremental Backup 

The forward incremental backup method produces a backup chain that consists of the first full backup 
and a set of forward incremental backups following it. Additionally, the forward incremental backup 
chain contains synthetic full and/or active full backups that “split” the backup chain into shorter series. 

Veeam Backup & Replication creates a forward incremental backup chain in the following way: 

1. During the first run of a backup job, Veeam Backup & Replication creates a full backup file 
(VBK) on the backup repository.  

2. During subsequent backup job sessions, Veeam Backup & Replication copies only VM data 
blocks that have changed since the last performed backup (full or incremental) and saves 
these blocks as an incremental backup file (VIB) in the backup chain. 

3. On a day when the synthetic full or active full backup is scheduled, 
Veeam Backup & Replication creates a full backup file (VBK) and adds it to the backup chain. 
Incremental restore points produced after this full backup file use it as a new starting point. 

After adding a new restore point to the backup chain, Veeam Backup & Replication checks the 
retention policy set for the job. If Veeam Backup & Replication detects an outdated restore 
point, it attempts to remove this point from the backup chain. For more information, see 
Retention for Forward Incremental Backup. 
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The forward incremental backup with synthetic full backup enabled is a default method for backup 
chain creation. To use the forward incremental backup method, you can leave the default settings or 
select the following options in the backup job settings: 

1. Select the Incremental backup mode. 

2. Enable synthetic full backups and/or active full backups. If the synthetic full backup and/or 
active full backups are not enabled, Veeam Backup & Replication will produce a forever 
forward incremental backup chain. 
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Reverse Incremental Backup 

The reverse incremental backup method produces a backup chain that consists of the last full backup 
and a set of reverse incremental backups preceding it. 

Veeam Backup & Replication creates a reverse incremental backup chain in the following way: 

1. During the first run of a backup job, Veeam Backup & Replication creates a full backup file 
(VBK) on the backup repository.  

2. During subsequent backup job sessions, Veeam Backup & Replication copies only VM data 
blocks that have changed since the last performed backup. Veeam Backup & Replication 
“injects” copied data blocks into the full backup file to rebuild it to the most recent state of 
the VM. Additionally, Veeam Backup & Replication creates a reverse incremental backup file 
(VRB) containing data blocks that are replaced when the full backup file is rebuilt, and adds 
this reverse incremental backup before the full backup in the backup chain. 

After adding a new restore point to the backup chain, Veeam Backup & Replication checks the 
retention policy set for the job. If Veeam Backup & Replication detects an outdated restore 
point, it removes this point from the backup chain. For more information, see Retention for 
Reverse Incremental Backup. 

 

As a result, the most recent restore point in the backup chain is always a full backup, and it gets 
updated after every successful backup job session. 

The reverse incremental backup method enables you to immediately restore a VM to the most recent 
state without extra processing because the most recent restore point is a full backup file. If you need 
to restore a VM to a particular point in time, Veeam Backup & Replication applies the required VRB files 
to the VBK file to get to the required restore point. 
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To use the reverse incremental backup method, you must select the Reverse incremental option in 
the backup job settings. 
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Active and Synthetic Full Backups 

To let you get the most out of incremental backup, Veeam Backup & Replication lets you create active 
full backups and schedule creation of synthetic full backups on specific days. 

Active Full Backup 

In some cases, you need to regularly create a full backup. For example, your corporate backup policy 
may require that you create a full backup on weekend and run incremental backup on work days. To 
let you conform to these requirements, Veeam Backup & Replication offers the ability to periodically 
perform active full backups.  

The active full backup produces a full backup of a VM, just as if you run the backup job for the first 
time. Veeam Backup & Replication retrieves data for the whole VM from the source, compresses and 
deduplicates it and stores it to the full backup file — VBK.  

The active full backup resets the chain of increments: all subsequent increments use the latest active 
full backup as a new starting point. A previously used full backup file remains on disk until it is 
automatically deleted according to the backup retention policy. 

 

You can create active full backups manually or schedule a backup job to create active full backups 
with a certain periodicity. 

 To create an active full backup manually, use the Active Full command from the shortcut 
menu of a corresponding backup job. 

 To schedule active full backups, specify scheduling settings in the Advanced section of a 
corresponding backup job. You can schedule active full backups to run weekly, for example, 
every Saturday, or monthly, for example, every fourth Sunday of a month. 
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Synthetic Full Backup 

In some situations, running active full backups periodically may not be an option. Full backups are 
very resource-intensive and consume considerable amount of network bandwidth. As an alternative, 
you can create synthetic full backups. 

In terms of data, the synthetic full backup is identical to a regular full backup. The synthetic full backup 
is a .vbk file that contains data of the whole VM. The difference between these two backup types lies in 
the way how VM data is retrieved: 

 When you perform full backup, Veeam Backup & Replication retrieves VM data from the 
source datastore (volume) where the VM resides, compresses and deduplicates it and writes it 
to the VBK file on the backup repository. 

 When you perform synthetic full backup, Veeam Backup & Replication does not retrieve VM 
data from the source datastore (volume). Instead, it “synthesizes” a full backup from data you 
already have on the backup repository. Veeam Backup & Replication accesses the previous 
full backup file and a chain of subsequent increments on the backup repository, consolidates 
VM data from these files and writes consolidated data into a new full backup file. As a result, 
the created synthetic full backup file contains the same data you would have if you created a 
full backup in a regular manner.  

Veeam Backup & Replication treats a synthetic full backup as a regular full backup. As well as any other 
full backup, the synthetic full backup resets the chain of increments. All subsequent increments use 
the created synthetic full backup as a new starting point. A previously used full backup file remains on 
disk until it is automatically deleted according to the backup retention policy. 

The synthetic full backup has a number of advantages:  

 The synthetic full backup does not use network resources: it is created from backup files you 
already have on disk.  

 The synthetic full backup imposes less load on the production environment: it is created right 
on the backup repository. 

With Veeam Backup & Replication, you can schedule creation of synthetic full backups on specific 
days.  
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How Synthetic Full Backup Works 

To create a synthetic full backup, Veeam Backup & Replication performs the following steps: 

1. On the day when synthetic full backup is scheduled, Veeam Backup & Replication triggers a 
new backup job session. During this session, Veeam Backup & Replication first performs 
incremental backup in a regular manner and adds a new incremental restore point to the 
backup chain.  

VM data for this incremental restore point is retrieved from the production storage. 
Incremental backup helps Veeam Backup & Replication ensure that the synthetic full backup 
scheduled on this day includes the latest changes of the source VM in the production 
environment.  

 

2. At the end of the backup job session, the Veeam Data Mover Service on the backup 
repository builds a new synthetic full backup using restore points that are already available in 
the backup chain, including the newly created incremental restore point. 

 

3. When the synthetic full backup is created, the Veeam Data Mover Service deletes the 
incremental restore point created at the beginning of the job session.  

As a result, you have a backup chain that consists of a full backup, set of incremental restore 
points and synthetic full backup. 
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4. Every next job session will create a new incremental restore point starting from the synthetic 
full backup until the day on which synthetic full backup is scheduled. On this day, 
Veeam Backup & Replication will create a new synthetic full backup.  

 

Veeam Backup & Replication automatically triggers a backup job session to create a synthetic full 
backup, even if a regular backup job session is not scheduled on this day. If a regular backup job is 
scheduled together with a synthetic full backup, Veeam Backup & Replication will produce only one 
backup file — a synthetic full backup that will reflect the latest state of the source VM. An incremental 
restore point that should have been created by the backup job schedule will not be added to the 
backup chain. 

Veeam Backup & Replication creates a synthetic full backup only once a day on which it is scheduled. If 
you run the backup job again on the same day, Veeam Backup & Replication will perform incremental 
backup in a regular manner. 

Transforming Incremental Backup Chains into Reverse Incremental Backup Chains  

If you select to create synthetic full backups, you can additionally choose to transform a previous 
forward incremental backup chain into a reverse incremental backup chain. In this case, 
Veeam Backup & Replication will transform the latest backup chain consisting of the .vbk and .vib files 
into reverse incremental backups - .vrb files.  

The transform option lets you dramatically reduce the amount of space required to store backups. 
Instead of two full backups — the regular full backup and the synthetic full backup — you will have 
only one synthetic full backup on disk. Note, however, that the transform process takes more time 
than simply creating a periodic synthetic full backup.  

For example, you have configured a backup job to perform daily forward incremental backups and 
scheduled synthetic fulls on Thursday. Additionally, you have selected to transform the incremental 
backup chain into the reverse incremental backup sequence. The backup job starts on Sunday. In this 
case, Veeam Backup & Replication will perform backup in the following way: 

1. On Sunday, Veeam Backup & Replication will create a full backup; Monday through 
Wednesday Veeam Backup & Replication will create incremental backups and add them to 
the backup chain. 

2. On Thursday, Veeam Backup & Replication will first create an incremental backup in a regular 
manner and add it to the backup chain. 

3. After that, Veeam Backup & Replication will transform the incremental backup chain into the 
reverse incremental chain. As a result, you have a full backup “created” on Thursday and a set 
of reversed increments Sunday through Wednesday. 

4. When you run the backup job next time, Veeam Backup & Replication will add a new 
incremental backup to the chain; the synthetic full backup will be used as a starting point.  
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Veeam Backup & Replication always transforms only the latest incremental backup chain. For example, 
you have a backup chain that consists of one full backup file and set of increments. In the middle of 
the chain, you create an active full backup. When you run a transformation task, 
Veeam Backup & Replication will transform the most recent active full backup plus increments that 
follow it. All backups that precede the active full backup will stay intact. 

Note: 

 

The transform process is accounted for as an active backup repository task. Make sure you properly 
plan use of backup repository resources when you schedule backup jobs. 
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Switching Between Backup Methods 

With Veeam Backup & Replication, you can easily switch between backup methods. 
Veeam Backup & Replication will not transform the previously created chain. Instead, it will create a 
new chain next to the existing one in the following manner: 

 If you switch from the reverse incremental method to the forward incremental method, 
Veeam Backup & Replication will create a set of incremental backups next to the reverse 
incremental chain. The full backup in the reverse incremental chain will be used as a starting 
point for produced increments. 

 If you switch from the forward incremental method to the reverse incremental method, 
Veeam Backup & Replication will first create a full backup next to the incremental backup 
chain. At every new job cycle, Veeam Backup & Replication will transform this full backup and 
add reverse incremental backups to the chain. 
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Retention Policy 
Every successful run of a job creates a new restore point that lets you return your data to an earlier 
point in time. When you define retention policy, you specify how many restore points you want to 
keep and thus how ‘far’ you want to be able to roll back. Once the specified number is exceeded, the 
earliest restore point will be automatically removed. So if the retention policy is set to three and you 
already have three restore points, the fourth successful run of a job will delete the restore point 
created at the first job run. 

Note: 

 

When the allowed number of restore points in the backup chain is exceeded, 
Veeam Backup & Replication deletes the whole backup file, not separate VMs from it. For more 
information, see Removing Restore Points from the Backup Chain.  

Veeam Backup & Replication handles restore points in different ways for forward forever-incremental, 
incremental and reverse incremental backup chains. 

Retention Policy for Forever Forward Incremental Backup  

If the number of restore points in forever forward incremental backup chains exceeds the retention 
policy settings, Veeam Backup & Replication transforms the backup chain to make room for the most 
recent restore point. The transformation process is performed in the following way: 

1. Veeam Backup & Replication adds a new restore point to the backup chain and detects that 
the number of allowed restore points is exceeded. 

Veeam Backup & Replication re-builds the full backup file to include changes of the 
incremental backup following the full backup. To do this, Veeam Backup & Replication injects 
data blocks from the first incremental backup in the chain into the full backup. As a result, the 
full backup ‘moves’ one step forward in the backup chain. 

 

2. The first incremental backup is removed from the backup chain as redundant. Its data has 
already been injected into the full backup and the full backup file contains the same data as 
this incremental restore point. 
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For example, you want to keep 7 restore points in the backup chain. The backup job starts on Sunday 
and runs daily. In this case, Veeam Backup & Replication will create the backup chain in the following 
way: 

1. During the first backup job session on Sunday, Veeam Backup & Replication creates the first 
restore point — a full backup.  

2. Monday through Saturday Veeam Backup & Replication adds six incremental backups to the 
chain.  

 

3. The next Sunday, Veeam Backup & Replication adds a new incremental backup to the backup 
chain.  

4. Veeam Backup & Replication detects that the number of allowed restore points is exceeded, 
and starts the transform process: 

a. Veeam Backup & Replication merges data blocks from the incremental backup 
copied on Monday into the full backup copied on Sunday. This way, the full 
backup file ‘moves’ one step forward — from Sunday to Monday.  

 

b. The incremental backup copied on Monday becomes redundant and is 
removed from the chain.  

 

As a result, you have a chain of a full backup as of Monday and six incremental backups Tuesday 
through Sunday. 



 

88   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Retention for Forward Incremental Backup 

To be able to restore from a forward incremental backup, you need to have a full backup and a chain 
of subsequent increments on disk. If you delete a full backup, the whole chain of increments will 
become useless. In a similar manner, if you delete any increment before the restore point to which you 
want to roll back, you won’t be able to restore your data (since later increments depend on earlier 
increments). 

For this reason, if you select forward incremental backup, in some days there will be more restore 
points on disk than specified by your retention policy. Veeam Backup & Replication will remove the 
full backup chain only after the last increment in the chain meets your retention policy (which will 
happen once the retention policy reaches the next full backup). 

For example, the retention policy is set to three restore points. A full backup is performed on Sunday, 
incremental backups are performed Monday through Saturday and a synthetic full backup is 
scheduled on Thursday. Although the retention policy is already breached on Wednesday, the full 
backup is not deleted because without it the chain of increments would be useless, leaving you 
without any restore point at all. Veeam Backup & Replication will wait for the next full backup and two 
increments to be created, and only then delete the whole previous chain consisting of the full backup 
and increment, which will happen on Saturday. 
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Retention for Reverse Incremental Backup 

In case of reverse incremental backup, Veeam Backup & Replication immediately deletes the earliest 
reverse increment as soon as it meets the retention policy. For example, if the retention policy is set to 
three restore points, two latest reverse increments and a full backup will be retained. 
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Retention Policy for Deleted VMs 

In some situations, after you configure and run backup jobs in Veeam Backup & Replication, you may 
want to change something in your virtual environment or even in your backup strategy. For example, 
you may remove some VMs from the virtual infrastructure or move them to another location. You may 
also exclude some VMs from jobs that have already been run for some time.  

By default, when you remove a VM protected by Veeam Backup & Replication from the virtual 
infrastructure or exclude it from a job, its backup files still remain on the backup repository. To avoid 
keeping redundant data on disk, you can select to control retention policy for deleted VMs. 

 

The retention policy for deleted VMs is an option in the backup job settings. To use this option, you 
need to select the Remove deleted VMs data after <N> days check box and specify the desired 
period of time for which data for deleted VMs must be retained on the backup repository.  

With this option enabled, Veeam Backup & Replication will check the list of VMs included in the job 
when a job starts. If a VM is no longer available, for example, it was deleted or moved to another 
location, Veeam Backup & Replication will keep its data in the backup file for the specified period only. 
As soon as the specified retention period is over, data of the deleted VM will be removed from backup 
files on the backup repository. 

Important! 

 

Retention policy for deleted VMs is applied only to reverse incremental backup chains and forward 
incremental backup chains for which synthetic full backups with subsequent transform is enabled. 
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Removing Restore Points from the Backup Chain 

To keep up with the retention policy, Veeam Backup & Replication deletes the whole backup file from 
the backup chain, not data for separate VMs from the backup file. For this reason, in some situations a 
certain VM may have fewer restore points in the backup chain than it is specified in the retention 
policy settings. This can happen if a backup job processes a number of VMs or VM containers and 
some VMs or VM containers fail to be processed in some job sessions.  

Removing Restore Points from Reverse Incremental Chains 

In case of a reverse incremental backup chain, Veeam Backup & Replication immediately deletes a 
redundant restore point when the allowed number of restore points is exceeded. For more 
information, see Retention for Reverse Incremental Backup. 

For example, a backup job processes two VMs: VM1 and VM2. According to the retention policy 
settings, the backup chain must contain 5 restore points. The backup job has already had 5 job 
sessions and VMs have been processed in the following way: 

VM1 has been successfully backed up 5 times and has 5 restore points 

 VM2 has failed to be processed in two job sessions and therefore has 3 restore points 

 

After that, Veeam Backup & Replication runs a new backup job session in which VM1 and VM2 are 
successfully processed. When a new restore point is added to the chain, Veeam Backup & Replication 
removes the earliest restore point because the number of restore points in the backup chain has 
exceeded 5. As a result, you will have 5 restore points for VM1 and 4 restore points for VM2.  
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Removing Restore Points from Forward Incremental Chains 

In case of a forward incremental backup chain, Veeam Backup & Replication does not remove a restore 
point immediately. Instead, Veeam Backup & Replication waits for a new full backup (synthetic or 
active) to be created and a new backup chain to be started. As soon as the last incremental restore 
point in the "old" backup chain is marked as redundant, Veeam Backup & Replication removes the 
whole "old" backup chain from the backup repository. For more information, see Retention for 
Incremental Backup. 

For example, a backup job processes two VMs: VM1 and VM2. According to the retention policy 
settings, the backup chain must contain 3 restore points. The backup job has already had 5 job 
sessions and VMs have been processed in the following way: 

 VM1 has been successfully backed up 3 times and has 3 restore points 

 VM2 has failed to be processed in 2 job sessions and has 1 valid restore point 

When a new restore point is added to the backup chain, Veeam Backup & Replication will not remove 
the earliest restore point from the backup chain. Veeam Backup & Replication will wait until a new full 
backup and 2 incremental backups are added to the backup chain. After that, the whole outdated 
backup chain will be removed from the backup repository. Restore points in the "new" backup chain, 
at the same time, may contain data for both VMs or for one VM only: Veeam Backup & Replication 
regards backup files as restore points, not separate VMs in these files.  
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Per-VM Backup Files 
By default, the backup job writes VM data to the backup repository in one write stream and stores 
data of all VMs to the same backup file. Such behavior can cause problems if the target storage device 
is able to write data in multiple streams simultaneously. In this situation, the backup repository may 
become a bottleneck in the data flow though its resources will not be used to the full. 

 

You can instruct Veeam Backup & Replication to create per-VM backup files on the backup repository. 
In this case, the job will use a separate write stream for every VM in the job and store its data to a 
separate backup file. As a result, resources of the storage device will be used more efficiently, and the 
job performance may increase.  

 

To create per-VM backup files, you must enable the Use per-VM backup files option at the level of 
the backup repository. It is recommended that you enable this option for deduplicating storage 
appliances that support multiple write streams. The option is also enabled for scale-out backup 
repositories by default.  
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If you decide to create separate backup files for VMs in the job, make sure that you enable parallel data 
processing. If parallel data processing is disabled, Veeam Backup & Replication will process VMs and 
VM disks sequentially, one by one. You should also balance the number of tasks on backup proxies 
and backup repository to avoid the situation when some backup infrastructure resources remain idle 
while others are overloaded. It is recommended that you use all available slots of the backup 
repository. To do this, you must disable the Limit maximum concurrent tasks to N option in the 
backup repository settings. For more information, see Limiting the Number of Concurrent Tasks. 

 



 

95   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Note: 

 

In case of per-VM backup chains, synthetic operations (synthetic full backup, backup files merge and 
transform) work in parallel for every VM in the backup. The number of parallel operations is limited 
by the number of concurrent tasks that can be performed on the backup repository. 

Enabling Per-VM Backup Files Option for Existing Backup Repositories 

You can enable or disable the Use per-VM backup files option for existing backup repositories to 
which backup jobs are already targeted. The new setting will not have any effect on previously 
created backup files on the backup repository. It will affect new backup files created after the setting is 
changed.  

Veeam Backup & Replication applies the new setting starting from the next active full backup. You can 
create an active full backup manually or wait for Veeam Backup & Replication to automatically create 
active full backup (if active full backups are scheduled). Synthetic full backups do not affect the Use 
per-VM backup files setting. 

Limitations for Per-VM Backup Files Option 

The Use per-VM backup files option cannot be enabled for backup repositories with rotated drives. 
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Retention for Per-VM Backup Files 

If you enable the Use per-VM backup files option for the backup repository, 
Veeam Backup & Replication creates a separate backup chain for every VM added to the job. Backup 
files are stored together in the folder of the backup job on the backup repository. The job produces 
one metadata file. This file stores information about all created backup files and backup chains. 

Veeam Backup & Replication regards all backup files that are created during one backup job session as 
one restore point. When Veeam Backup & Replication needs to remove earlier restore points by 
retention policy, it removes backup files for all VMs that were created during one job session.  

For example, you have added 3 VMs to the job, set the retention setting to 5 restore points and run 
the job 5 times. The job will produce 15 backup files, 5 per each VM in the job. On the 6th job session, 
the job will remove from the backup chain 3 backup files — the earliest restore points for every VM. 

 

If the job backs up some VMs during the job session and does not manage to back up others, 
Veeam Backup & Replication will still regard that the restore point is valid. When the earliest restore 
point gets outdated, Veeam Backup & Replication will remove backup files for all VMs at once, even 
though backup chains for some VMs may contain fewer backup files than you expect. 

The rules of restore points deletion for regular backup chains also apply to per-VM backup chains. For 
more information, see Removing Restore Points from the Backup Chain. 

For example, you have added 3 VMs to the job and set retention policy to 5. The backup job session 
ran in the following way: 

1. During the first three job sessions, Veeam Backup & Replication backed up all VMs. 

2. During the 4th and 5th job sessions, VM1 and VM2 were successfully backed up, and VM3 
failed. 
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During the 6th job session, Veeam Backup & Replication will delete the earliest restore point for all 
VMs. As a result, the VM1 and VM2 will have 5 restore points and VM3 will have 3 restore points. 
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Changed Block Tracking 
To perform incremental backup, Veeam Backup & Replication needs to know which data blocks have 
changed since the previous job run. 

For VMware VMs with hardware version 7 or later, Veeam Backup & Replication employs VMware 
vSphere Changed Block Tracking (CBT) — a native VMware feature. Instead of scanning VMFS, 
Veeam Backup & Replication queries CBT on vSphere through VADP and gets the list of blocks that 
have changed since the last run of this particular job. Use of CBT increases the speed and efficiency of 
block-level incremental backups. CBT is enabled by default; if necessary, you can disable it in the 
settings of a specific backup job. 

 

In some situations, Veeam Backup & Replication cannot leverage VMware vSphere CBT due to VMware 
limitations. Whenever Veeam Backup & Replication cannot leverage VMware vSphere CBT (for 
example, if your VMs run an earlier version of virtual hardware or CBT is disabled at the ESX host level), 
it fails over to Veeam’s proprietary filtering mechanism. Instead of tracking changed blocks of data, 
Veeam Backup & Replication filters out unchanged data blocks. During backup, 
Veeam Backup & Replication consolidates virtual disk content, scans through the VM image and 
calculates a checksum for every data block. Checksums are stored as metadata to backup files next to 
VM data. When incremental backup is run, Veeam Backup & Replication opens all backup files in the 
chain of previous full and incremental backups, reads metadata from these files and compares it with 
checksums calculated for a VM in its current state. If a match is found (which means the block already 
exists in the backup), the corresponding block is filtered out. 
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Data Compression and Deduplication 
Veeam Backup & Replication provides mechanisms of data compression and deduplication. Data 
compression and deduplication let you decrease traffic going over the network and disk space 
required for storing backup files and VM replicas.  

Data Compression 
Data compression decreases the size of created backups but affects duration of the backup procedure. 
Veeam Backup & Replication allows you to select one of the following compression levels: 

• None compression level is recommended if you use plan to store backup files and VM replica 
files on storage devices that support hardware compression and deduplication. 

• Dedupe-friendly is an optimized compression level for very low CPU usage. You can select 
this compression level if you want to decrease the load on the backup proxy. 

• Optimal is the recommended compression level. It provides the best ratio between size of 
the backup file and time of the backup procedure. 

• High compression level provides additional 10% compression ratio over the Optimal level at 
the cost of about 10x higher CPU usage. 

• Extreme compression provides the smallest size of the backup file but reduces the backup 
performance. We recommend that you run backup proxies on computers with modern multi-
core CPUs (6 cores recommended) if you intend to use the extreme compression level. 

Deduplication 
You can enable data deduplication if you add to the backup or replication job several VMs that have 
great amount of free space on their logical disks or VMs that have similar data blocks — for example, 
VMs that were created from the same template. Veeam Backup & Replication does not store zero byte 
blocks or space that has been pre-allocated but not used. With data deduplication, identical blocks or 
blocks of free space are eliminated, which decreases the size of the created backup file. 

Depending on the type of storage you select as a backup target, Veeam Backup & Replication uses 
data blocks of different size to process VMs, which optimizes the size of a backup file and job 
performance. You can choose one of the following storage optimization options: 

 The Local target (16 TB + backup files) option is recommended for backup jobs that can 
produce very large full backup files — larger than 16 TB. With this option selected, 
Veeam Backup & Replication uses data block size of 4096 KB. 

If you select to use data blocks of small size to dedupicate a large backup file, the backup file 
will be cut into a great number of data blocks. As a result, Veeam Backup & Replication will 
produce a very large deduplication metadata table which can potentially overgrow memory 
and CPU resources of your backup repository. For backup files over 16 TB, it is recommended 
to choose the Local target (16 TB + backup size) option. With this option selected, Veeam 
Backup & Replication will use data blocks of 4 MB. Large data blocks produce a smaller 
metadata table that requires less memory and CPU resources to process. Note, however, that 
this storage optimization option will provide the lowest deduplication ratio and the largest 
size of incremental backup files. 

Note: 

 

If you upgrade to Veeam Backup & Replication 9.0 from the previous product version, this option will 
be displayed as Local target (legacy 8MB block size) in the list and will still use blocks size of 8 MB. 
It is recommended that you switch to an option that uses a smaller block size and create an active full 
backup to apply the new setting. 
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 The Local target option is recommended for backup to SAN, DAS or local storage. With this 
option selected, Veeam Backup & Replication uses data block size of 1024 KB. 

 The SAN identifies larger blocks of data and therefore can process large amounts of data at a 
time. This option provides the fastest backup job performance but reduces the deduplication 
ratio, because with larger data blocks it is less likely to find identical blocks. 

 The LAN target option is recommended for backup to NAS and onsite backup. With this 
option selected, Veeam Backup & Replication uses data block size of 512 KB. This option 
provides a better deduplication ratio and reduces the size of a backup file because of reduced 
data block sizes. 

 The WAN target option is recommended if you are planning to use WAN for offsite backup. 
With this option selected, Veeam Backup & Replication uses data block size of 256 KB. This 
results in the maximum deduplication ratio and the smallest size of backup files, allowing you 
to reduce the amount of traffic over the WAN connection. 
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Changing Data Compression Settings 

You can change compression and deduplication settings for existing backup jobs. New settings will 
not have any effect on previously created backup files in the backup chain. They will be applied to 
new backup files created after the settings were changed.  

 To apply new deduplication settings, you must create an active full backup after you change 
deduplication settings. Veeam Backup & Replication will use the new block size for the active 
full backup and subsequent backup files in the backup chain. 

 Compression settings are changed on the fly. You do not need to create a new full backup to 
use new settings — Veeam Backup & Replication will automatically apply the new 
compression level to newly created backup files.  

However, if you use the reverse incremental backup method, the newly created backup files 
will contain a mixture of data blocks compressed at different levels. For example, you have a 
backup job that uses the reverse incremental backup method and the Optimal level of 
compression. After several job sessions, you change the compression level to High. In the 
reverse incremental backup chains, the full backup file is rebuilt with every job session to 
include new data blocks. As a result, the full backup file will contain a mixture of data blocks: 
data blocks compressed at the Optimal level and data blocks compressed at the High level.  

If you want the newly created backup file to contain data blocks compressed at one level, you 
can create an active full backup. Veeam Backup & Replication will retrieve data for the whole 
VM image from the production infrastructure and compress it at the new compression level. 
All subsequent backup files in the backup chain will also use the new compression level. 
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Data Exclusion 
When you configure a backup or replication job, you can define what data you want to back up and 
replicate and exclude data that you do not need. Data exclusion helps reduce the size of the VM 
backup or replica and decrease the load on the network.  

You can exclude data at the VM level and at the VM guest OS level. 

At the VM level: 

 VMs added as part of the container 

 VM disks 

 VM templates (only for backup) 

At the VM guest OS level: 

• Swap files on the VM guest OS 

• Deleted file blocks on the VM guest OS (BitLooker) 

• Files and folders on the VM guest OS 

Note: 

 

To reduce the size of the backup file, Veeam Backup & Replication automatically excludes VM log 
files from processing. 

VMs and VM Disks 

When you configure a backup or replication job, you can exclude the following objects from 
processing: 

 VMs added as a part of a VM container 

 Individual VM disks 

 [For backup jobs] VM templates 
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VMs as Part of Container 

If you want to back up or replicate a VM container that holds several VMs but want to skip some VMs, 
you can exclude specific VMs from the job processing. This option will help you reduce the size of the 
resulting backup or replica and increase the job performance. 

You can define which VMs you want to skip at the Virtual Machines step of the backup or replication 
job wizard. 
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Individual VM Disks 

You can choose what VM disks you want to back up or replicate: 

 All VM disks 

 0:0 disks (which are commonly the VM system disks) 

 Specific IDE, SCSI or SATA disks 

For example, you may want to back up or replicate only the system disk instead of creating a backup 
or replica of a full VM. VM disks exclusion reduces the size of the backup or replica. 

You can define which VM disks you want to back up or replicate at the Virtual Machines step of the 
backup or replication job wizard. You can specify disk processing settings granularly for every VM in 
the job or for the whole VM container. In the latter case, Veeam Backup & Replication will apply the 
configured rule to all VMs in this container.  

You can additionally instruct Veeam Backup & Replication to modify the configuration file of the VM. 
When you start a VM from the backup or fail over to the VM replica, you will be able to use such VM 
immediately. You will not have to edit its configuration file and remove excluded disks from it. 
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VM Templates 

You can include VM templates in the backup. Backing up VM templates provides additional safety of 
your production environment but requires additional space on the backup repository. 

Veeam Backup & Replication allows you to include a VM template only in the full backup and omit it in 
incremental backups. Note that Veeam Backup & Replication always uses the Network transport mode 
to copy VM templates data. 

You can define how Veeam Backup & Replication must process VM templates at the Virtual Machines 
steps of the wizard.  
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Deleted File Blocks (BitLooker) 

By default, Veeam Backup & Replication does not copy "dirty" data blocks (blocks that are marked as 
deleted on the VM guest OS) to the target location. This option lets you reduce the size of the VM 
backup or replica and increase the job performance. 

If you do not want to exclude deleted file blocks from backups or replicas, you can disable the Exclude 
deleted file blocks option in the backup or replication job settings. 

Note: 

 

If you enable or disable the Exclude deleted file blocks setting for the existing job, 
Veeam Backup & Replication will apply the new setting from the next job session. 
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With this option enabled, Veeam Backup & Replication performs the following operations during the 
job session: 

1.  Veeam Backup & Replication accesses the MFT file on the VM guest OS to identify deleted file 
blocks, and zeros out these blocks.  

2. Veeam Backup & Replication processes and transports data blocks of the VM image in the 
following manner: 

 If a data block of the VM image contains only the deleted file blocks, 
Veeam Backup & Replication does not read this data block from the source 
datastore. 

 If a data block of the VM image contains zeroed out blocks and other data, 
Veeam Backup & Replication copies this block to the target. Due to data 
compression, data blocks that are marked as deleted are compressed, and the size 
of the resulting backup or replica file reduces. 

 

Limitations for Deleted File Blocks Exclusion 

Veeam Backup & Replication can exclude deleted file blocks only on the VM guest OS with Microsoft 
NTFS. 
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Swap Files 

You can instruct Veeam Backup & Replication to exclude pagefile.sys and hiberfil.sys files 
from backups or replicas of Microsoft Windows VMs.  

 hiberfil.sys is a system file created by the OS for correct work of the hibernate mode. 

 pagefile.sys is a swap file. Swap files are dynamic in nature and can change intensively 
between job sessions, even if a VM itself does not change much. 

To exclude these files, you must enable the Exclude swap file blocks option in the job settings. 
Veeam Backup & Replication will identify data blocks of these files and exclude them from processing. 
As a result, the size of incremental backups and replicas will be smaller. 

 

When you exclude pagefile.sys and hiberfil.sys files, Veeam Backup & Replication performs 
the following operations during the job session: 

1.  Veeam Backup & Replication accesses the MFT file on the VM guest OS to identify data blocks 
of pagefile.sys and hiberfil.sys files and zeros them out.  

2. Veeam Backup & Replication processes and transports data blocks of the VM image in the 
following manner: 

 If a data block of the VM image contains only blocks of these files, 
Veeam Backup & Replication does not copy this data block to the target. 

 If a data block of the VM image contains blocks of these files and other data, 
Veeam Backup & Replication copies this block to the target. 
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Limitations for Swap Files Exclusion 

Veeam Backup & Replication can exclude blocks of pagefile.sys and hiberfil.sys files only on 
the VM guest OS with Microsoft Windows NTFS. 

VM Guest OS Files 

If you do not want to back up or replicate some files and folders on the VM guest OS, you can exclude 
them from the backup or replica. Files exclusion reduces the size of the backup or replica but may 
affect the job performance. 

You can specify file exclusion settings granularly for every VM in the job or for the whole VM container. 
In the latter case, Veeam Backup & Replication will apply the configured rule to all VMs in this 
container.  

To define which VM guest OS files must and must not be processed, you can use the following 
options: 

 Disable file exclusion. Veeam Backup & Replication will back up or replicate the whole 
content of the VM guest file system. 

 Exclude specific files and folders from the backup or replica. Veeam Backup & Replication will 
back up or replicate all files and folders except the specified ones. 

 Include only specific files and folders in the backup or replica. Veeam Backup & Replication 
will back up or replicate only the specified files and folders. 

To form a list of exclusions or inclusions, you can use the following methods: 

 Specify a full path to a folder on the VM guest OS, for example, C:\Documents\. 

 Specify a full path to a file on the VM guest OS, for example: 
C:\Documents\MyReport.docx. 

If a path is not full, Veeam Backup & Replication will expand it relatively the root directory on 
the computer volume and attempt to detect such files on all computer volumes. For example, 
you have C, D and E disks on the VM. In the list of exclusions, you specify Document.docx. 
Veeam Backup & Replication will scan the whole file system and exclude the following files (if 
any): C:\Document.docx, D:\Document.docx, E:\Document.docx. If there is a 
C:\MyDocuments\Document.docx file, it will not be excluded — this file is not located in 
the root directory. 

 Use environmental variables, for example, %TEMP%, %windir%. Environment variables must 
be defined for the user account that you use to connect to the VM guest OS and under which 
the runtime process is started. For example, you connect to the VM guest OS under the 
Administrator account. If you want to use the %windir% variable in the list of exclusions or 
inclusions, you must make sure that the %windir% variable is added to the list of user 
variables for Administrator on the VM guest OS. 

 Use file masks. You can use the following characters for masks: 

– (*) — a substitution for one or more characters in the file name or path. Can be 
used for any sequence of characters (including no characters). For example, *.pdf. 

– (?) – a substitution of one character in the file name or path. For example, 
repor?.pdf 

– (;) – mask separator, for example, report.*;reports.*. 
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In the table below, mask stands for any sequence of characters. 

Mask format Affects paths/files 

*mask* All paths that contain the given sequence. 

mask 

 

If the asterisk character (*) is not specified at 
the beginning of the mask, the mask will be 
applied to all volumes on the VM guest OS, and 
Veeam Backup & Replication will 
include/exclude files or folders in the root 
folder on the volume: A:\mask, B:\mask, 
…, Z:\mask.  

mask* 

If the asterisk character (*) is not specified at 
the beginning of the mask, the mask will be 
applied to all volumes on the VM guest OS, and 
Veeam Backup & Replication will 
include/exclude files and folders in the root 
folder on the volume: A:\mask*, 
B:\mask*, …, Z:\mask*. 

<drive_letter>:\*mask* All paths on the specified volume that contain 
the given sequence. 

*mask1*;*mask2*;*mask3* 
All paths that contain at least one of the given 
character sequences: *mask1* or *mask2* 
or *mask3*. 

Mind the following: 

 If you use file masks for file exclusion, Veeam Backup & Replication will need to scan the VM 
guest file system, and the time of VM disk processing will increase.  

 The number of entries in the list of exclusions or inclusions must not exceed a few hundreds. 
The number of entries in the list influences the job performance — the more files are 
included or excuded from the backup or replica, the more time Veeam Backup & Replication 
requires to process these files. 

 It is recommended that you do not exclude system files without the necessity. 
Veeam Backup & Replication does not perform any checks to verify the VM image integrity. 

 Exclusion of small files (less than 2 KB in size) is ineffective and will not reduce the size of the 
backup file significantly. 
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Requirements for VM Guest Files Exclusion 

VM guest OS files exclusion has the following limitations: 

 File exclusion works only on the Microsoft Windows NTFS file system.  

 Veeam Backup & Replication can exclude files and folders only on running VMs. Application-
aware processing must be enabled for the job and must be performed successfully. If 
application-aware processing fails and the job is set to ignore its failure, the VM will be 
backed up or replicated but VM guest OS files and folders will not be excluded. 

 Veeam Backup & Replication supports both basic and dynamic disks. Volumes on the 
dynamic disks must not be split — spanned, striped and other types of split volumes are not 
supported. 
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How VM Guest OS File Exclusion Works 

When you exclude VM guest OS files from the backup or replica, Veeam Backup & Replication 
performs the following operations: 

1. Veeam Backup & Replication checks the job settings to identify what VM guest OS files must 
be excluded. 

2. Veeam Backup & Replication opens the MFT file from the VM guest file system in the memory 
cache on the backup proxy, and marks data blocks of excluded files as deleted. 

3. When Veeam Backup & Replication copies VM data to the target, it reads data both from the 
VM snapshot and memory cache on the backup proxy. On the target, 
Veeam Backup & Replication creates a "merged" version of VM disks that do not contain 
excluded VM guest OS files. Due to data compression, data blocks that are marked as deleted 
are compressed, and the size of the resulting backup or replica file reduces. 

 

 

During the job session with file exclude, Veeam Backup & Replication makes changes to processed VM 
disks at the NTFS level using the cache on the backup proxy. However, these changes are not visible to 
the CBT mechanism. For this reason, Veeam Backup & Replication saves information about excluded 
data blocks in the backup file and replica metadata. During the next job session with use of CBT, 
Veeam Backup & Replication retrieves a list of data blocks that were excluded during the previous job 
session from the backup file or replica metadata and analyzes what data needs to be processed during 
the current job session. To do this, Veeam Backup & Replication regards the following data: 

 Data blocks that are marked as new with CBT 

 Data blocks that were excluded during the previous job session 

 Data blocks that must be excluded during the current job session 
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Transaction Consistency 
When you back up or replicate a running VM, you need to quiesce, or ‘freeze’ the VM to bring its file 
system and application data to a consistent state. If the VM is not quiesced, 
Veeam Backup & Replication will produce a crash-consistent backup or replica. The crash consistent 
backup or replica does not preserve data integrity of open files and transactional applications on the 
VM. Restore from a crash-consistent backup or replica is essentially equivalent to booting the VM after 
it was manually reset.  

A crash-consistent backup or replica may be sufficient for VMs that run applications with low quantity 
of transactions. If you process VMs with highly transactional applications, you should instruct 
Veeam Backup & Replication to quiesce the VM and create a transactionally consistent backup or 
replica. Restore from transactionally consistent backups or replicas guarantees safety of application 
data. 

Veeam Backup & Replication offers two options for creating transactionally consistent backups and 
replicas:  

 Application-aware processing (based on Microsoft VSS). This option is recommended for VMs 
running applications that support Microsoft VSS. 

 VMware Tools quiescence. This option is recommended for VMs running applications that do 
not support Microsoft VSS, for example, Linux VMs. 
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VMware Tools Quiescence 

To create transactionally consistent backups and replicas for VMs that do not support Microsoft VSS 
(for example, Linux VMs), you must enable VMware Tools quiescence for the job. In this case, 
Veeam Backup & Replication will use the VMware Tools to freeze the file system and application data 
on the VM before backup or replication. 

VMware Tools quiescence is enabled at the job level for all VMs added to the job. By default, this 
option is disabled. 

 

Veeam Backup & Replication uses different methods of VMware Tools quiescence for different 
versions of VMware vSphere: 

 For VMware vSphere 3.5 and earlier, Veeam Backup & Replication uses the VMware 
FileSystem Sync Driver 

 For VMware vSphere 3.5 U2 and later, Veeam Backup & Replication uses the VMware VSS 
component in VMware Tools 

VMware FileSystem Sync Driver 

To quiesce VMs on VMware vSphere earlier than 3.5 U2, Veeam Backup & Replication uses the VMware 
FileSystem Sync Driver (vmsync) driver. The driver holds incoming I/O and flushes all dirty data to disk 
before a VM snapshot is created. As a result, the VM file system and application on the VM are 
quiesced and prepared for backup or replication. 

However, under heavy I/O load, a delay in I/O can become too long. The delay in I/O can cause a 
problem for highly transactional applications. If write operations from these applications get delayed 
for a long period of time, the applications on the VM may stop responding. 
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VMware VSS Component 

Starting from vSphere 3.5 U2, VMware Tools support Microsoft VSS. To use the VMware VSS 
component in VMware Tools, the VM must run one of the following OSes: 

 Microsoft Windows Server 2003 32-bit or 64-bit 

 Microsoft Windows Vista 32-bit or 64-bit 

 Microsoft Windows 7 32-bit or 64-bit 

 Microsoft Windows Server 2008 32-bit or 64-bit 

 Microsoft Windows Server 2012 

 Microsoft Windows Server 2012 R2 

Supported quiescence features differ depending on the type of the VM guest OS: 

 For VMs running Windows Vista and Windows 7, the VMware VSS component does not use 
application writers. As a result, the created VSS snapshots are file-system consistent. 

 For VMs running Microsoft Windows Server 2003, the VMware VSS component uses 
application VSS writers. As a result, the created VSS snapshots are application-consistent.  

 For VMs running Microsoft Windows Server 2008 or Microsoft Windows Server 2012, the 
VMware VSS component may or may not use application writers, depending on the VM 
platform and state. The created VSS snapshots can be file-system or application-consistent. 

For more information about VMware Tools quiescence, see VMware documentation: 
http://pubs.vmware.com/vsphere-55/topic/com.vmware.vddk.pg.doc/vddkBkupVadp.9.6.html.  

  

http://pubs.vmware.com/vsphere-55/topic/com.vmware.vddk.pg.doc/vddkBkupVadp.9.6.html
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Choice of Method for VM Quiescence 

Application-aware processing is the recommended option for VMs running applications that support 
Microsoft VSS — Microsoft Exchange, Microsoft Active Directory and other. If you cannot use 
application-aware processing (for example, you cannot access the VM over the network and deploy 
Veeam's runtime process on it, or you want to process a Linux VM and want the backup or replica to 
be consistent at the application and file system level), you should enable VMware Tools quiescence. 
VMware Tools quiescence will put applications on the VM to a consistent state before the VM 
snapshot is created. 

If you use VMware Tools quiescence, Veeam Backup & Replication will quiesce the VM but will not 
perform application-specific actions required for proper backup and restore of VMs running highly 
transactional applications. Application-specific steps include the following tasks: 

 Applying application-specific settings to prepare applications for VSS-aware restore at the 
next VM startup 

 Truncating transaction logs after successful backup or replication. 

Enabling Both Quiescence Options 

You can enable both options for VM quiescence. Such scenario is recommended if you add Microsoft 
Windows and Linux VMs to the same job. In this case, all VMs will be processed in a transactionally 
consistent manner — either with application-aware processing or VMware Tools quiescence. 

In such scenario, Veeam Backup & Replication will process VMs in the job in the following way: 

1. Veeam Backup & Replication will first attempt to use application-aware processing to prepare 
VMs for backup or replication. If Veeam Backup & Replication manages to quiesce all VMs in 
the job with application-aware processing, it will not use VMware Tools quiescence. 

2. If some VMs cannot be quiesced with application-aware processing or application-aware 
processing is disabled for some VMs in the job (the Disable application processing is set for 
VMs in the job settings), Veeam Backup & Replication will use VMware Tools quiescence to 
prepare these VMs for backup or replication. 
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To enable both options: 

1. At the Storage step of the wizard (for backup) or Job Settings step of the wizard (for 
replication), click Advanced. 

2. On the vSphere tab of the Advanced Settings window, select Enable VMware Tools 
quiescence. 

 

3. At the Guest Processing step of the wizard, select the Enable application-aware 
processing check box. 
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4. When configuring advanced option for individual VMs, select Try application processing, 
but ignore failures. You can also select the Disable application processing option for VMs 
that you want to process with VMware Tools quiescence. 

 

Note: 

 

If you enable application-aware processing and VMware Tools quiescence but do not select the 
Ignore application processing failures option, Veeam Backup & Replication only use only 
application-aware processing for the job.  
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Guest Processing 
If you back up or replicate running VMs, you can enable guest processing options. Guest processing 
options are advanced tasks that require Veeam Backup & Replication to communicate with the VM 
guest OS. Veeam Backup & Replication offers the following guest processing options: 

 Application-aware processing. You can create transactionally consistent backups and replicas 
of VMs running applications that support Microsoft VSS. Application-aware processing 
guarantees that you can restore VMs without data loss. 

 Pre-freeze and post-thaw scripts. You can use pre-freeze and post-thaw scripts to quiesce 
VMs running applications that do not support Microsoft VSS. 

 Transaction log truncation. You can set the backup or replication job to truncate transaction 
logs on the VM guest OS after the VM is successfully processed. 

 Transaction logs backup for Microsoft SQL Server and Oracle. You can set up the backup job 
to back up transaction logs from Microsoft SQL Server and Oracle VMs. 

 VM guest file system indexing. You can set up the backup job to create a catalog of files and 
folders on the VM guest OS. The catalog lets you search for VM guest OS files and 1-click 
restore in Veeam Backup Enterprise Manager. 

VM guest file system indexing is optional. If you do not enable this option in the backup job 
settings, you will still be able to perform 1-click restore from the backup created with such 
backup job. For more information, see 
https://helpcenter.veeam.com/backup/em/preparing_for_file_browsing.html. 

 VM guest OS files exclusion. You can exclude/include individual files and folders from/to 
backup or replicas. 

  

https://helpcenter.veeam.com/backup/em/preparing_for_file_browsing.html
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Runtime Coordination Process 

To perform guest processing tasks, Veeam Backup & Replication does not deploy persistent agents 
inside VMs. Instead, it uses a runtime coordination process. The runtime process is non-persistent — it 
is deployed on every VM added to the job when the job starts and removed as soon as the job finishes. 
Use of the runtime process helps avoid agent-related drawbacks such as pre-installing, 
troubleshooting and updating. 

Veeam Backup & Replication can deploy the runtime process on VMs in two ways: 

 For VMs running Microsoft Windows, the runtime process is deployed via guest interaction 
proxies. 

 For VMs running OSes other than Microsoft Windows, for example, Linux, the runtime process 
is deployed from the backup server. 

The backup server or guest interaction proxy must have either a LAN or VIX connection to the VM that 
will be processed. You do not have to set up both connections — only one connection is required. For 
more information about setting up a connection to the VM, see https://www.veeam.com/kb1788. 

Note: 

 

If there are no guest interaction proxies or guest interaction proxies fail for some reason, 
Veeam Backup & Replication will deploy the runtime process on Microsoft Windows VMs from the 
backup server. 

When you start a job with guest processing tasks enabled, Veeam Backup & Replication performs the 
following operations: 

1. Veeam Backup & Replication defines the machine(s) that will perform the guest interaction 
proxy role. 

2. Veeam Backup & Replication obtains IP addresses from VMware Tools installed on VMs. If 
Veeam Backup & Replication fails to connect to the VM guest OS over the network, it obtains 
IP addresses via VIX. 

Veeam Backup & Replication deploys the runtime process on VMs: 

 [For Microsoft Windows VMs] The guest interaction proxy connects to VMs and 
deploys the runtime process on them. 

 [For VMs running other OSes] The backup server connects to VMs and deploys the 
runtime process on them. 

3. The job session proceeds as usual. 

4. When the job session completes, Veeam Backup & Replication deletes the runtime process on 
VMs. 

https://www.veeam.com/kb1788
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If a network connection breaks during the job session, Veeam Backup & Replication makes attempts to 
re-establish the connection: 

 If a network connection between the backup server/guest interaction proxy and VM guest OS 
breaks, Veeam Backup & Replication makes one attempt to reconnect. 

 If a network connection between the backup server and guest interaction proxy breaks, 
Veeam Backup & Replication makes 10 attempts to reconnect. 

If attempts are unsuccessful, guest processing tasks fail. The job proceeds with the scenario defined in 
the job settings. For example, if you have instructed a backup job to try application processing but 
ignore failures, Veeam Backup & Replication will not perform guest processing tasks but will proceed 
with the VM backup. 
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Application-Aware Processing 

To create transactionally consistent backups or replicas of VMs that run VSS-aware applications such 
as Microsoft Active Directory, Microsoft SQL Server, Microsoft Exchange or Oracle, you must enable 
application-aware processing for the job.  

Application-aware processing is Veeam's proprietary technology based on Microsoft VSS. Microsoft 
VSS is responsible for quiescing applications on the VM and creating a consistent view of application 
data on the VM guest OS. Use of Microsoft VSS ensures that there are no unfinished database 
transactions or incomplete application files when Veeam Backup & Replication triggers the VM 
snapshot and starts copying VM data to the target. For more information about Microsoft VSS, see 
https://technet.microsoft.com/en-us/library/cc785914(v=ws.10).aspx.  

Application-aware processing is supported for Microsoft Windows 2003 and later. To use application-
aware processing, you must have VMware Tools and the latest updates installed on the VM guest OS. 

Note: 

 

To process VMs running applications that do not support Microsoft VSS (for example, MySQL that 
does not have VSS writers), you can use VMware Tools quiescence with pre-freeze and post-thaw 
scripts. For more information, see VMware Tools Quiescence and Pre-Freeze and Post-Thaw Scripts. 

  

https://technet.microsoft.com/en-us/library/cc785914(v=ws.10).aspx
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How Application-Aware Processing Works 

If you enable application-aware processing for the job, Veeam Backup & Replication performs the 
following operation as a part of the backup or replication process: 

1. Veeam Backup & Replication deploys the runtime process on the VM and detects if the VM 
runs VSS-aware applications.  

2. Veeam Backup & Replication collects information about applications installed on VMs; this 
information is required for VSS-aware restore. 

3. Veeam Backup & Replication prepares applications for VSS-aware restore (VSS-aware restore 
is performed when the VM is started after you restore it from the backup or fail over to a VM 
replica). 

4. Microsoft VSS communicates with applications and quiesces I/O activities at a specific point in 
time. 

5. Veeam Backup & Replication acts as a VSS requestor and triggers a VM VSS snapshot. 

6. Microsoft VSS resumes quiesced I/O activities on the VM guest OS. 

7. Veeam Backup & Replication triggers a snapshotof the VM.  

8. The job session proceeds as usual. 

9. If you have instructed Veeam Backup & Replication to truncate transaction logs, 
Veeam Backup & Replication truncates transaction logs on the VM guest OS after the backup 
or replica are successfully created. 
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Persistent VSS Snapshots 

During application-aware processing, Veeam Backup & Replication uses a VSS writer for a 
corresponding application to freeze application data and bring it to a consistent state. 

According to Microsoft limitations, the application freeze cannot take longer than 60 seconds (20 
seconds for Microsoft Exchange). If the Microsoft VSS writer does not manage to freeze application 
data within this period of time, a VSS processing timeout occurs, and Veeam Backup & Replication fails 
to create a transactionally consistent backup of the VM. The VSS processing timeout is a common 
problem for highly transactional applications such as Microsoft Exchange. 

To overcome this limitation, Veeam Backup & Replication uses the persistent VSS snapshots 
technology for backup of Microsoft Exchange VMs. If Microsoft Exchange fails to be frozen within the 
allowed period of time, Veeam Backup & Replication automatically fails over to the persistent VSS 
snapshot mechanism.  

Backup of Microsoft Exchange VMs is performed in the following way: 

1. Veeam Backup & Replication triggers the Microsoft VSS framework to prepare Microsoft 
Exchange on the VM for backup.  

2. The Microsoft VSS writer attempts to quiesce Microsoft Exchange.  

3. If the Microsoft VSS writer fails to quiesce Microsoft Exchange within the allowed period of 
time, the control is passed to the native Veeam VSS writer. The Veeam VSS writer holds the 
freeze operation for the necessary amount of time. 

4. After Microsoft Exchange data is brought to a consistent state, the control is passed to the 
Microsoft VSS provider. The Microsoft VSS framework creates a persistent VSS snapshot for 
VM disks except the system VM disk.  

5. The job session proceeds as usual. 

6. After the backup operation is complete, Veeam Backup & Replication triggers Microsoft VSS 
to remove the persistent VSS snapshot on the production VM. The persistent VSS snapshot 
holding consistent application data inside the created VM backup remains. 

During full VM restore, Veeam Backup & Replication recovers data from the backup and reverts VM 
disks to the persistent VSS snapshot inside the backup. As a result, the Microsoft Exchange VM is 
restored from the backup in a consistent state without data loss. 
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Limitations for Persistent VSS Snapshot Technology 

Veeam Backup & Replication uses the persistent VSS snapshot technology if the VM meets the 
following requirements: 

1. The VM runs Microsoft Exchange 2010, Microsoft Exchange 2013 or Microsoft Exchange 2016. 

2. The VM does not perform the role of a domain controller. 

3. Microsoft Exchange databases and log files are located on a non-system disk of the VM. 
During backup, Veeam Backup & Replication does not trigger a persistent VSS snapshot for 
system VM disks. As a result, system disks are restored in a crash-consistent, not 
transactionally consistent state. 
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Pre-Freeze and Post-Thaw Scripts 

If you back up or replicate VMs running applications that do not support Microsoft VSS, you can 
instruct Veeam Backup & Replication to run custom scripts for VMs. For example, the pre-freeze script 
may quiesce the file system and application data on the VM guest OS to bring the VM to a 
consistent state before Veeam Backup & Replication triggers a VM snapshot. After the VM snapshot 
is created, the post-thaw script may bring the VM and applications to their initial state. 

You can use pre-freeze and post-thaw scripts for the following types of jobs: 

 Backup job

 Replication job 

 VM copy job 

Pre-freeze and post-thaw scripts can be used for Microsoft Windows and Linux VMs. 

 For Microsoft Windows VMs, Veeam Backup & Replication supports scripts in the EXE, BAT and
CMD file format.

 For Linux VMs, Veeam Backup & Replication supports scripts in the SH file format.

Scripts must be created beforehand. You must specify paths to them in the job settings. Script 
execution settings can be configured per VM or per container, depending on the objects included in 
the job.  

When the job starts, Veeam Backup & Replication uploads scripts to the VM guest OS and executes 
them.  

 Scripts for Microsoft Windows VMs are uploaded over the network or VIX, if
Veeam Backup & Replication fails to connect to the VM guest OS over the network.

 Scripts for Linux VMs are uploaded over SSH. 

The script is considered to be executed successfully if "0" is returned.  

The default time period for script execution is 10 minutes. If the script fails to execute before the 
timeout expires, Veeam Backup & Replication displays an error message in the job session and error or 
warning messages issued during script execution. 
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Limitations for Pre-Freeze and Post-Thaw Scripts 

Veeam Backup & Replication has the following limitations for pre-freeze and post-thaw scripts: 

1. You cannot stop a job when the pre-freeze or post-thaw script is executed. If the script hangs 
up, Veeam Backup & Replication waits for 10 minutes and terminates the job. 

2. If you want to run several scripts that depend on each other, you must upload them to the 
VM guest OS manually. For example, you have script1.bat that sequentially starts script2.bat, 
script2.bat and script3.bat. In this case, you must specify a path to script1.bat in the job 
properties and upload script2.bat, script2.bat and script3.bat to the VM guest OS. 
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Transaction Log Truncation 

If you back up or replicate virtualized database systems that use transaction logs, for example, 
Microsoft Exchange or Microsoft SQL Server, you can instruct Veeam Backup & Replication to truncate 
transaction logs so that logs do not overflow the storage space on the VM. 
Veeam Backup & Replication provides the following options of transaction logs handling: 

 Truncate logs 

 Do not truncate logs 

 Back up logs periodically 

 

Truncate Logs 

You can instruct Veeam Backup & Replication to truncate logs after a backup or VM replica is 
successfully created. With this option selected, Veeam Backup & Replication behaves in the following 
way: 

 If the job completes successfully, Veeam Backup & Replication produces a backup file or VM 
replica and truncates transaction logs on the original VM. As a result, you have the backup file 
or replica that contains a VM image at a specific point in time.  

In this scenario, you can recover a database to the point in time when the backup file or 
replica was created. As transaction logs on the VM are truncated, you cannot use them to get 
the restored database to some point in time between job sessions. 

 If the backup or replication job fails, Veeam Backup & Replication does not truncate 
transaction logs on the VM. In this scenario, you can restore a VM from the most recent 
backup or replica restore point and use database system tools to apply transaction logs and 
get the database system to the necessary point in time after the restore point. 
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Do not Truncate Logs 

You can choose not to truncate transaction logs on the VM. This option is recommended if together 
with Veeam Backup & Replication you use another backup tool.  

For example, you can use Veeam Backup & Replication to create a VM image backup and instruct the 
native Microsoft SQL Server log backup job to back up transaction logs. If you truncate transaction 
logs with Veeam Backup & Replication, the chain of transaction logs will be broken, and the Microsoft 
SQL Server log backup job will not be able to produce a consistent log backup. 

With this option selected, Veeam Backup & Replication produces a backup file or VM replica and does 
not trigger transaction log truncation. As a result, you have a backup file or VM replica that contains a 
VM image captured at a specific point in time, and transaction logs on the VM. You can use transaction 
logs to restore the VM to any point in time between job sessions. To do this, you must recover the VM 
from the backup file or perform replica failover and use database system tools to apply transaction 
logs and get the database system to the necessary point in time. 

Back Up Logs Periodically 

This option can be used if you back up Microsoft SQL Server VMs and Oracle VMs.  

You can choose to back up transaction logs with Veeam Backup & Replication. With this option 
selected, Veeam Backup & Replication creates a backup of a VM and additionally copies transaction 
logs and saves them to the backup repository next to the VM backup. After that, transaction logs on 
the VM are truncated.  

In this scenario, you can use transaction logs to restore the VM to any point in time between backup 
job sessions. To do that, you must recover the VM from the backup file and use Veeam Explorer for 
Microsoft SQL Server or Veeam Explorer for Oracle to perform transaction log replay and get the 
database system to a necessary point in time.  
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Copy-Only Backup 

Some organizations prefer to back up Microsoft SQL Server databases and transaction logs with native 
Microsoft SQL Server tools or 3rd party backup tools. To restore database systems in a proper way, 
database administrators must be sure that they have database backups and a sequence of transaction 
log backups associated with these backups at hand. 

If you use native Microsoft SQL Server tools or 3rd party backup tools and also want to back up 
Microsoft SQL Server VMs with Veeam Backup & Replication, you must enable the Perform copy only 
option in the job settings. 

The Perform copy only option indicates that a chain of database backups is created with native 
Microsoft SQL Server means or by a 3rd party tool, and instructs Veeam to preserve this chain (backup 
history). Veeam Backup & Replication backs up the Microsoft SQL Server VM using the VSS_BS_COPY 
method for snapshot creation. The VSS_BS_COPY method produces a copy-only backup — the backup 
that is independent of the existing chain of database backups. The copy-only backup does not 
influence the backup history — it does not change the last database modification date and time for 
the database (unlike non-copy only backups).  

Important! 

 

Veeam Backup & Replication does not truncate transaction logs after copy-only backup. For this 
reason, if you instruct the backup job to perform copy-only backup, you cannot specify transaction 
log handing settings for this job. 
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Microsoft SQL Server Logs Backup and Restore 

To protect Microsoft SQL Server VMs, you can instruct the backup job to create image-level VM 
backups and periodically back up database transaction logs. If Microsoft SQL Server fails, you can 
restore the Microsoft SQL Server VM from the necessary restore point of the image-level backup. After 
that, you can use Veeam Explorer for Microsoft SQL Server to apply transaction logs and get databases 
on the Microsoft SQL Server to the necessary state between backups. 

Requirements for Transaction Log Backup 

 Veeam Backup & Replication supports transaction log backups for the following systems: 

– Microsoft SQL Server 2005 

– Microsoft SQL Server 2008 

– Microsoft SQL Server 2008 R2 

– Microsoft SQL Server 2012 

– Microsoft SQL Server 2014 

 The database whose logs you want to back up must use the Full or Bulk-logged recovery 
model. In this case, all changes of the Microsoft SQL Server state will be written to transaction 
logs, and you will be able to replay transaction logs to restore the Microsoft SQL Server. You 
can use the Microsoft SQL Server Management Studio to switch to one of these models. For 
more information, see http://msdn.microsoft.com/en-us/library/ms189275.aspx.  

  

http://msdn.microsoft.com/en-us/library/ms189275.aspx
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Transaction Log Backup Jobs 

To back up transaction logs, you must create a backup job, add Microsoft SQL Server VM(s) to it and 
specify advanced settings for transaction logs backup in the job settings. The resulting job will 
comprise two jobs:  

 Parent backup job — the backup job that creates an image-level backup of the Microsoft SQL 
Server VM. The parent backup job is named <job_name>, for example, Daily Job. You can 
configure the parent job in the Veeam Backup & Replication console just like any other 
backup job.  

 Child job — a transaction log backup job. To form a name of the child job, 
Veeam Backup & Replication adds a suffix to the name of the parent backup job: 
<parent_job_name> + SQL Backup, for example, Daily Job SQL Backup. 
Veeam Backup & Replication automatically creates the child job if it detects a backup job that 
is scheduled to back up at least one Microsoft SQL Server VM, and transaction log backup is 
enabled for this job. Session data of the transaction log backup job is stored in the 
configuration database and displayed in the Veeam Backup & Replication console. 

The parent job runs in a regular manner — it starts by schedule or is started manually by the user. The 
transaction log backup job is triggered by the parent backup job. This sequence ensures that the VM 
(and the database) restore point is present when it comes to transaction log replay.  

Sessions of Transaction Log Backup Jobs 

The transaction log backup job runs permanently in the background, shipping transaction logs to the 
backup repository at a specific time interval (by default, every 15 minutes). A sequence of time 
intervals between sessions of the parent backup job makes up a session of the transaction log backup 
job. 

The transaction log backup session starts and stops in the following way: 

 The initial session starts when the parent backup job schedule is enabled. After that, the 
session starts with every new session of the parent backup job. 

 The session ends before the next session of the parent backup job, and/or when this parent 
backup job is disabled.  

 When the session ends, Veeam Backup & Replication stops the runtime process and uninstalls 
it from the VM guest OS. When a new session starts, the runtime process is deployed again. 
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How Microsoft SQL Server Logs Backup Works 

To perform transaction log backup, Veeam Backup & Replication installs the Veeam Guest SQL Log 
Shipper runtime component on the VM guest OS.  
 
The component works during the transaction log backup job session. It collects information about 
databases that require transaction logs backup. It also detects whether it is possible to ship logs 
directly on the backup repository or Veeam Backup & Replication must use the log shipping server. 
When the transaction log backup job session ends, the component is stopped and removed from the 
VM guest OS. When a new session starts, the component is installed on the VM guest OS again. 

The transaction logs backup is performed in the following way: 

1. Veeam Backup & Replication launches the parent backup job by schedule.  

2. The parent backup job creates an image-level backup of a Microsoft SQL Server VM and 
stores it on backup repository.  

3. A new session of the transaction log backup starts. Veeam Backup & Replication accesses the 
VM (directly or via the guest interaction proxy) and installs the runtime components for guest 
processing, database information collection and transaction log handing on the VM guest OS. 

The runtime component copies transaction log files from the log archive destination (set by 
the Microsoft SQL Server administrator) to a temporary folder on the VM guest file system. 

4. Veeam Backup & Replication detects what databases currently exist on the Microsoft SQL 
Server and maps this data with the information kept in the configuration database. This 
periodic mapping reveals the databases for which Veeam Backup & Replication must process 
transaction logs during this time interval. 

5. Veeam Backup & Replication transports transaction log backup copies from the temporary 
folder on the Microsoft SQL Server VM to the backup repository, either directly or via the log 
shipping server, and saves them as VLB files. As soon as copies of transaction log backups are 
saved on the backup repository, transaction log backups in the temporary folder on the 
Microsoft SQL Server VM are removed. 

The session of the transaction log backup job remains working until the next start of the parent 
backup job. When a new session of the parent job starts, the transaction log backup job stops the 
current session and then starts a new session, performing steps 1-5. 

Transaction logs that for some reason were not processed during the log backup interval remain in 
the temporary folder and are processed during the next log backup interval. To detect these 
remaining logs, Veeam Backup & Replication enumerates log files in the temporary folder. 

Note: 

 

If a new session of the transaction log backup starts and the parent backup job has not created a new 
restore point yet, the transaction log backup job will remain in the idle state, waiting for a new 
restore point to be created. 
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Retention for Transaction Log Backups 

Transaction log backups are stored in files of the proprietary Veeam format — VBL. 
Veeam Backup & Replication keeps transaction log backups together with the VM image-level backup. 
The target location of VBL files depend on the type of the backup repository: 

 If you store the VM image-level backup on a simple backup repository, 
Veeam Backup & Replication writes transaction log backups to the same folder where files of 
the image-level backup reside. 

 If you store the VM image-level backup on a scale-out backup repository, 
Veeam Backup & Replication writes transaction log backups to the extent where the latest 
incremental backup file of the VM image-level backup is stored. 

Veeam Backup & Replication removes transaction log backups by retention. You can choose one of 
the following retention methods: 

 Retain logs according to the image-level backup 

 Retain logs for the specified number of days 
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Retain Logs with Image-Level Backup 

By default, Veeam Backup & Replication retains transaction log backups together with the 
corresponding image-level backup of the Microsoft SQL Server VM. When 
Veeam Backup & Replication removes a restore point of the image-level backup from the backup 
chain, it also removes a chain of transaction logs relating to this image-level backup.  

This method allows you to have both the image-level backup and necessary transaction log backups 
at hand. If you need to recover a database to some state, you can restore the Microsoft SQL Server VM 
from the necessary restore point and perform transaction log replay to bring the database to the 
desired state. 

 

Retain Logs for a Number of Days 

You can instruct Veeam Backup & Replication to keep transaction logs only for a specific period of 
time. This retention setting can be used, for example, if you want to save on storage space and plan to 
retain transaction log backups for the last few days. In this case, you will be able to restore the 
database only to one of the most recent states.  

If you select this retention method, you must make sure that retention policies for the image-level 
backup and transaction log backup are consistent. The restore point of the image-level backup must 
always be preserved. If a backup of the database itself is missing, you will not be able to perform 
transaction log replay. 
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Log Shipping Servers 

For every Microsoft SQL Server VM whose transaction logs you want to back up, 
Veeam Backup & Replication defines how to ship logs to the backup repository. Transaction logs can 
be shipped in the following ways: 

 Directly from the VM guest OS to the backup repository. This method is recommended — it 
does not involve additional resources and puts less load on the VM guest OS. 

 Via log shipping servers. If it is not possible to establish a direct connection between the VM 
guest OS and backup repository, you can instruct Veeam Backup & Replication to use a log 
shipping server.  

A log shipping server is a Microsoft Windows server added to the backup infrastructure. You can 
explicitly define what servers you want to use for log shipping or instruct Veeam Backup & Replication 
to automatically choose an optimal log shipping server. Veeam Backup & Replication chooses the log 
shipping server based on two criteria: possible data transfer method(s) and location of the Microsoft 
SQL Server VMs and log shipping server. 

Data Transfer Methods 

Log shipping servers can transport data in two ways: 

 Over the network. In this scenario, Veeam Backup & Replication obtains files from the VM 
guest OS and transfers them over the network.  

To offload the VM guest OS, logs are created one by one (not simultaneously). One log 
creation request is issued for every DB. 

 Using VIX. In this scenario, Veeam Backup & Replication obtains transaction logs from the VM 
guest OS over the VIX, bypassing the network. 

For each Microsoft SQL Server instance one log creation request is created for all DBs 
(grouped by instance).  

The priority method is log shipping over the network. 

Location of Log Shipping Server and VMs 

When choosing a log shipping server for the job, Veeam Backup & Replication considers the location 
of the Microsoft SQL Server VM and log shipping server. Veeam Backup & Replication uses the 
following priority rules to select the log shipping server: 

1. Log shipping server is located on the same ESX(i) host as the Microsoft SQL Server VM. 

2. Log shipping server and Microsoft SQL Server VM are located in the same network. 

3. Log shipping server and Microsoft SQL Server VM are located in different networks (the 
production infrastructure is isolated from the backup infrastructure).  

That is, when choosing a log shipping server, Veeam Backup & Replication will give the top priority to 
a Microsoft Windows VM that is located on the same ESX(i) host as the Microsoft SQL Server VM and 
that has a network connection to the Microsoft SQL Server VM. 

Log shipping servers are assigned per job session. When a new job session starts, 
Veeam Backup & Replication detects log shipping servers anew. Veeam Backup & Replication can also 
re-detect available servers during the job session. If a log shipping server becomes unavailable for 
some reason, Veeam Backup & Replication will fail over to another log shipping server. 

Important! 

 

If you do not want to use some servers for transaction logs transport, you can manually define what 
server Veeam Backup & Replication must use as a log shipping server in the job settings. It is 
recommended that you assign the log shipping server role to a number of servers for availability 
purposes. 
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Transaction Log Backup Statistics 

You can view the statistics of the transaction log backup job in the History view or in the Backup & 
Replication view in Veeam Backup & Replication. 

In the statistics window, you can examine the overall statistics for the transaction log backup job, as 
well as view per-VM information.  

 

In the upper part of the statistics window, Veeam Backup & Replication displays information about the 
transaction log backup job for all VMs included in the parent backup job.  

The Last period (all VMs) section contains statistics data for the selected session of the backup job. 
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In the Databases column, you can view the following information: 

 Protected — number of databases that were backed up at least once during the last session 

 Unprotected — number of databases that failed to be backed up during the last session 

 Excluded — databases excluded from processing. Databases may be excluded for the 
following reasons: database status is Offline, database recovery model is set to Simple, 
database is read-only, database was deleted after the latest full backup, database is added to 
the list of exclusions. For more information, see https://www.veeam.com/kb1051.  

Note: 

 

Unprotected databases do not comprise Excluded databases, as they have different reasons for being 
non-processed. 

In the RPO column, you can view the following information: 

 SLA value — how many log backup intervals completed in time with successful log backup 
(calculated as percentage of total number of intervals) 

 Misses — how many intervals were missed (number of intervals) 

 Max delay — difference between the configured log backup interval and time actually 
required for log backup. If exceeded, a warning is issued. 

In the Status column, the following information is displayed (per job): number of VMs processed 
successfully, with warnings or with errors. 

The Latest session section displays the following information for the latest log processing interval for 
the selected VM: 

 Duration — duration of log shipment from the VM guest OS to the backup repository since 
the current log processing interval has started  

 Bottleneck — operation with the greatest duration in the last completed interval. The 
operation may have the following bottlenecks: 

Display Name Slowing-down Operation 

Log backup Saving BAK files to a temporary location on VM guest OS 

Network Uploading log files to the log shipping server 

Target Saving files to the target repository 

 Read — amount of data read from the temporary folder on VM guest OS 

 Transferred — amount of data transferred to the target repository 

The Last period section displays the following statistics of log backups per VM for the latest session of 
the transaction log backup job: 

 The RPO column displays statistics on log processing interval (calculated as described above) 

 The Sessions column includes statistics of log backups per VM, calculated as follows: 

– Success — number of intervals when all database logs were backed up 
successfully 

– Warning — number of sequential intervals with failed log processing (if not 
more than 4 intervals in a sequence) 

– Errors — number of sequential intervals with failed log processing (more than 4 
intervals in a sequence) 
 
 
 

https://www.veeam.com/kb1051
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 The Duration column includes the following information: 

– Average — average duration of log data transfer (through all intervals in the 
session) 

– Max — maximal duration of log data transfer (through all intervals in the session) 

– Sync interval — duration of periodic intervals specified for log backup in the parent 
job settings (default is 15 min) 

 The Log size column displays the following information: 

– Average — average amount of data read from the VM guest OS through all 
intervals 

– Max — maximal amount of data read from the VM guest OS over all 15-min 
intervals 

– Total — total amount of data written to the backup repository 

Note: 

 

Statistics on transaction log processing is updated periodically, simultaneously for the parent backup 
job and transaction log backup job. 
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Support for AlwaysOn Availability Groups 

AlwaysOn Availability Groups allow you to increase fault tolerance between active and hot-standby 
databases without involving shared physical disks, which is quite important for virtualization of 
Microsoft SQL Servers. Veeam Backup & Replication supports AlwaysOn Availability Groups for 
virtualized Microsoft SQL Server 2012 and later. 

Image-level Backup of Microsoft SQL Server VMs 

During image-level backup of a Microsoft SQL Server VM, Veeam Backup & Replication requests and 
analyzes information about databases that are included in the AlwaysOn Availability Groups. 
Depending on the retrieved information, Veeam Backup & Replication creates a VSS snapshot with or 
without COPY_ONLY flag. The VSS_BS_COPY flag for VSS snapshot is triggered if the VM represents a 
secondary node for at least one AlwaysOn Availability Group.  

Veeam Backup & Replication also detects to what cluster the database belongs. If the backup job does 
not include all VMs from the cluster, a warning message will be issued.  

Retrieved information is saved for further log identification. 

Transaction Log Backup 

Transaction log backup can be performed only for those databases that were successfully backed up, 
either on the primary or on the secondary node of AlwaysOn Availability Group.  

The transaction logs processing interval may be the same or may differ through VMs included in 
AlwaysOn Availability Group. If the interval is different, Veeam Backup & Replication will use minimal 
value (by default, 15 minutes).  

At each log processing interval, Veeam Backup & Replication chooses the AlwaysOn Availability Group 
node for which transaction logs will be backed up.  

Logs are backed up from one node of the AlwaysOn Availability Group. To become a subject for log 
backup, the node must meet the following criteria: 

 Required Veeam Backup & Replication components can be installed on this node (the VM 
must be running). 

 If there are any logs remaining in the temporary folder on the node of AlwaysOn Availability 
Group, this means these logs were not backed up to the backup repository during the 
previous session of the transaction log backup job, so this AlwaysOn Availability Group node 
must be processed first. 

 Databases in the AlwaysOn Availability Group(s) for this node were successfully backed up for 
the last two processing intervals. 

 Veeam Backup & Replication can establish a network connection to the node (or VIX 
connection, if connection over network cannot be established). 

 The VM is in the list of preferred nodes for backup retrieved from the Microsoft SQL Server. If 
there are no preferred nodes, any node can be chosen. 
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Oracle Logs Backup and Restore 

Veeam Backup & Replication supports backup of Oracle database transaction logs and restore of 
Oracle databases.  

Database transaction logs are created by the Oracle system. The Oracle database can run in one of the 
following logging modes: 

 ARCHIVELOG turned on — logs are saved and can be used for recovery purposes. 

 ARCHIVELOG turned off — no transaction logs are saved. This mode is not recommended as it 
does not provide for proper disaster recovery. 

With ARCHIVELOG turned on, the Oracle system stores database transaction logs to a certain location 
on the VM guest OS, as specified by the database administrator. Veeam Backup & Replication allows 
you to set up the following ways of log handling: 

 Instruct the backup job to collect log files from the Oracle VM and ship them to the backup 
repository where they are stored next to image-level backups of the Oracle VM. 

 Skip log processing — log files remain untouched on the Oracle VM and are preserved within 
the image-level backup.  

If you enable application-aware processing for an Oracle VM, during the job session 
Veeam Backup & Replication installs a runtime process on this VM to collect information about the 
database and process transaction logs according to job settings. Application-specific settings are 
configured at the Guest Processing step of the backup job wizard — you can specify how logs should 
be backed up and\or truncated for Oracle databases.  

Requirements for Transaction Log Backup 

 Veeam Backup & Replication supports transaction logs backup and restore for Oracle 
database version 11 and later. The Oracle database may run on a Microsoft Windows VM or 
Linux VM. 

 Automatic Storage Management (ASM) is supported for Oracle 11 and later. 

 Oracle Express Databases are supported if running on Microsoft Windows machines only. 

 The database must run in the ARCHIVELOG mode. 
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Transaction Log Backup Jobs 

To back up transaction logs, you must create a backup job, add Oracle VM(s) to it and specify 
advanced settings for transaction logs backup in the job settings. The resulting job will comprise two 
jobs:  

 Parent backup job — the backup job that creates an image-level backup of the Oracle VM. 
The parent backup job is named <job_name>, for example, Daily Job. You can configure the 
parent job in the Veeam Backup & Replication console just like any other backup job.  

 Child job — a transaction log backup job. To form a name of the child job, 
Veeam Backup & Replication adds a suffix to the name of the parent backup job: 
<parent_job_name> + Oracle Backup, for example, Daily Job Oracle Backup. 
Veeam Backup & Replication automatically creates the child job if it detects a backup job that 
is scheduled to back up at least one Oracle VM, and transaction log backup is enabled for this 
job. Session data of the transaction log backup job is stored in the configuration database 
and displayed in the Veeam Backup & Replication console. 

The parent job runs in a regular manner — it starts by schedule or is started manually by the user. The 
transaction log backup job is triggered by the parent backup job. This sequence ensures that the VM 
(and the database) restore point is present when it comes to transaction log replay.  

Sessions of Transaction Log Backup Jobs 

The transaction log backup job runs permanently in the background, shipping transaction logs to the 
backup repository at a specific time interval (by default, every 15 minutes). A sequence of time 
intervals between sessions of the parent backup job makes up a session of the transaction log backup 
job. 

The transaction log backup session starts and stops in the following way: 

 The initial session starts when the parent backup job schedule is enabled. After that, the 
session starts with every new session of the parent backup job. 

 The session ends before the next session of the parent backup job, and/or when this parent 
backup job is disabled.  

 When the session ends, Veeam Backup & Replication stops the runtime process and uninstalls 
it from the VM guest OS. When a new session starts, the runtime process is deployed again. 
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How Oracle Transaction Log Backup Works 

The transaction logs backup for Oracle VMs is performed in the following way: 

1. Veeam Backup & Replication launches the parent backup job by schedule.  

2. The parent backup job creates an image-level backup of the Oracle VM and stores this backup 
to the backup repository. 

3. A new session of the transaction log backup starts. Veeam Backup & Replication accesses the 
VM guest OS to perform guest processing, collect database information and handle 
transaction log.  

If Oracle runs on a Microsoft Windows server, Veeam Backup & Replication accesses the VM 
guest OS via a guest interaction proxy. You can instruct Veeam Backup & Replication to select 
the guest interaction proxy automatically or assign it explicitly.  

By default, Veeam Backup & Replication accesses the VM guest OS over the network: 

 For Linux VM guest OS — using SSH. 

 For Microsoft Windows VM guest OS — using RPC. 

 If a network connection cannot be established, Veeam Backup & Replication 
accesses the VM guest OS using VIX. 

4. Veeam Backup & Replication deploys the runtime process in the VM guest OS. The runtime 
process scans the Oracle system and collects information about databases whose logs must 
be processed, including: 

 List of all databases 

 Database state — a database is on or off, in which logging mode it runs 

 Paths to all database files (configuration logs and so on) and other data required for 
backup 

Veeam Backup & Replication also detects whether it is possible to store logs on the backup 
repository through a direct access or a log shipping server is required.  

The runtime process copies transaction log files from the log archive destination (set by the 
Oracle administrator) to a temporary folder on the VM guest file system. 

5. Veeam Backup & Replication maps information about the Oracle system collected at step 4 
with information kept in the configuration database. This periodic mapping helps reveal 
databases for which Veeam Backup & Replication must ship transaction logs to the backup 
repository during this time interval.  

6. Transaction log backup files are transferred from the temporary location on the Oracle VM to 
the backup repository, either directly or via the log shipping server. The source-side Veeam 
Data Mover compresses log data to be transferred according to its built-in settings. On the 
backup repository side, data is compressed according to the parent backup job settings. 

If in the backup job settings you have specified that you want to delete archived transaction 
log backups from the VM guest OS, Veeam Backup & Replication will delete them from the 
temporary folder on the Oracle VM.  

Transaction logs that for some reason were not processed during the log backup interval remain in 
the temporary folder and are processed during the next log backup interval. To detect these 
remaining logs, Veeam Backup & Replication enumerates log files in the temporary folder. 

Note: 

 

If a new session of the transaction log backup starts and the parent backup job has not created a new 
restore point yet, the transaction log backup job will remain in the idle state, waiting for a new 
restore point to be created. 
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Retention for Transaction Log Backup 

Transaction log backups are stored in files of the proprietary Veeam format — VBL. 
Veeam Backup & Replication keeps transaction log backups together with the VM image-level backup. 
The target location of VBL files depend on the type of the backup repository: 

 If you store the VM image-level backup on a simple backup repository, 
Veeam Backup & Replication writes transaction log backups to the same folder where files of 
the image-level backup reside. 

 If you store the VM image-level backup on a scale-out backup repository, 
Veeam Backup & Replication writes transaction log backups to the extent where the latest 
incremental backup file of the VM image-level backup is stored. 

Veeam Backup & Replication removes transaction log backups by retention. You can choose one of 
the following retention methods: 

 Retain logs according to the image-level backup 

 Retain logs for the specified number of days 
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Retain Logs with Image-Level Backup 

By default, Veeam Backup & Replication retains transaction log backups together with the 
corresponding image-level backup of the Oracle VM. When Veeam Backup & Replication removes a 
restore point of the image-level backup from the backup chain, it also removes a chain of transaction 
logs relating to this image-level backup.  

This method allows you to have both the image-level backup and necessary transaction log backups 
at hand. If you need to recover a database to some state, you can restore the Oracle VM from the 
necessary restore point and perform transaction log replay to bring the database to the desired state. 

 

Retain Logs for a Number of Days 

You can instruct Veeam Backup & Replication to keep transaction logs only for a specific period of 
time. This retention setting can be used, for example, if you want to save on storage space and plan to 
retain transaction log backups for the last few days. In this case, you will be able to restore the 
database only to one of the most recent states.  

If you select this retention method, you must make sure that retention policies for the image-level 
backup and transaction log backup are consistent. The restore point of the image-level backup must 
always be preserved. If a backup of the database itself is missing, you will not be able to perform 
transaction log replay. 
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Log Shipping Servers 

For every Oracle VM whose transaction logs you want to back up, Veeam Backup & Replication defines 
how to ship logs to the backup repository. Transaction logs can be transported in the following ways: 

 Directly from the VM guest OS to the backup repository. This method is recommended — it 
does not involve additional resources and puts less load on the VM guest OS.  

 Via log shipping servers. If it is not possible to establish a direct connection between the VM 
guest OS and backup repository, you can configure Veeam Backup & Replication to use a log 
shipping server.  

A log shipping server is a Microsoft Windows or Linux server added to the backup infrastructure. You 
can explicitly defile what servers you want to use for log shipping or instruct 
Veeam Backup & Replication to automatically choose an optimal log shipping server. 
Veeam Backup & Replication chooses the log shipping server based on two criteria: possible data 
transfer method(s) and location of the Oracle VM and log shipping server. 

Data Transfer Methods 

Log shipping servers can transport data in two ways: 

 Over the network. In this scenario, Veeam Backup & Replication obtains files from the VM 
guest OS and transfers them over the network.  

 Using VIX. In this scenario, Veeam Backup & Replication obtains transaction logs from the VM 
guest OS over the VIX, bypassing the network. 

The priority method is log shipping over the network. 

Location of Log Shipping Server and VMs 

When choosing a log shipping server for the job, Veeam Backup & Replication considers the location 
of the Oracle VM and log shipping server. Veeam Backup & Replication uses the following priority rules 
to select the log shipping server: 

1. Log shipping server is located on the same ESX(i) host as the Oracle VM. 

2. Log shipping server and Oracle VM are located in the same network. 

3. Log shipping server and Oracle VM are located in different networks (the production 
infrastructure is isolated from the backup infrastructure).  

That is, when choosing a log shipping server, Veeam Backup & Replication will give the top priority to 
a VM that is located on the same ESX(i) host as the Oracle VM and that has a network connection to 
the Oracle VM 

Log shipping servers are assigned per job session. When a new job session starts, 
Veeam Backup & Replication detects log shipping servers anew. Veeam Backup & Replication can also 
re-detect available servers during the job session. If a log shipping server becomes unavailable for 
some reason, Veeam Backup & Replication will fail over to another log shipping server. 

Important! 

 

If you do not want to use some servers for transaction logs transport, you can manually define what 
server Veeam Backup & Replication must use as a log shipping server in the job settings. It is 
recommended that you assign the log shipping server role to a number of servers for availability 
purposes.  
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VM Guest File System Indexing 

You can instruct Veeam Backup & Replication to create an index of files and folders on the VM guest 
OS during backup. Guest file indexing allows you to search for VM guest OS files inside VM backups 
and perform 1-click restore in Veeam Backup Enterprise Manager. 

VM guest OS file indexing is enabled at the job level. You can specify granular indexing settings for 
every VM in the job. 

Note: 

 

VM guest file system indexing is optional. If you do not enable this option in the backup job settings, 
you will still be able to perform 1-click restore from the backup created with such backup job. For 
more information, see https://helpcenter.veeam.com/backup/em/preparing_for_file_browsing.html. 

 

Requirements for VM Guest OS Indexing 

 Veeam Backup & Replication supports file indexing for VMs running Microsoft Windows and 
Linux OS.  

 Linux VMs must have the mlocate tool installed (a standard tool for majority of Linux 
distributions). 

  

https://helpcenter.veeam.com/backup/em/preparing_for_file_browsing.html
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Veeam Backup Catalog 

For VM guest OS file indexing, Veeam Backup & Replication uses the Veeam Guest Catalog Service. In 
the backup infrastructure, the Veeam Guest Catalog Service is installed on two types of servers: 
backup server and Veeam Backup Enterprise Manager server.  

 The Veeam Guest Catalog Service on the backup server works as a local catalog service. It 
collects indexing data for backup jobs and stores this data in the Veeam Backup Catalog 
folder. By default, the indexing data is stored in the C:\VBRCatalog folder on the backup 
server. 

 The Veeam Guest Catalog Service on Veeam Backup Enterprise Manager works as a global, 
federal catalog service. It communicates with Veeam Guest Catalog Services on backup 
servers connected to Veeam Backup Enterprise Manager and performs the following tasks: 

– Replicates indexing data from backup servers to create a global catalog for the 
whole backup infrastructure. By default, the Veeam Backup Catalog folder is 
located in the C:\VBRCatalog folder on the Veeam Backup Enterprise 
Manager server. 

– Maintains indexing data retention. 

– Lets you search for VM guest OS files in current and archived backup file. 
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How VM Guest OS Indexing Works 

When you run a backup job with the file indexing option enabled, Veeam Backup & Replication 
performs the following operations: 

1. When the backup job starts, Veeam Backup & Replication connects to the VM whose file 
system must be indexed and deploys a runtime process inside this VM. The runtime process is 
responsible for coordinating indexing activities inside the VM.  

2. The runtime process starts indexing the VM file system. The indexing procedure is carried out 
in parallel with the backup procedure. If indexing takes long, Veeam Backup & Replication will 
not wait for the indexing procedure to complete. It will start copying VM data and continue 
file indexing inside the VM. 

If you have enabled application-aware processing for the VM, Veeam Backup & Replication 
performs indexing using the VSS snapshot, not the VM guest OS itself. As a result, the created 
file index exactly reflects the state of the backed up VM. 

3. When file indexing is complete, the runtime process collects indexing data and writes it to the 
GuestIndexData.zip file. The GuestIndexData.zip file is stored to a temporary folder on the 
backup server.  

4. When the backup job completes, Veeam Backup & Replication notifies the local Veeam Guest 
Catalog Service, and the service saves indexing data in the Veeam Catalog folder on the 
backup server. 

5. During the next catalog replication session, the global Veeam Guest Catalog Service 
replicates data from the backup server to the Veeam Catalog folder on the Veeam Backup 
Enterprise Manager server.  
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Job Scheduling 
You can start backup jobs manually or schedule them to start automatically at specific time. 
Veeam Backup & Replication lets you configure the following settings for the job:  

 Scheduling settings: time when the job must be launched and frequency of backup job 
sessions. 

 Job retry settings: number of automatic retries for failed jobs and time interval between job 
retries. 

 Backup window settings. 

Automatic Startup Schedule 

To run a job on periodically without the user intervention, you can schedule it to start automatically. 
The Veeam Backup Service running on the backup server continuously checks configuration settings 
of all jobs configured on the backup server and starts them according to their schedule. 

Veeam Backup & Replication lets you configure the following scheduling settings for jobs: 

 You can schedule the job to run at specific time every day or on selected days.  

 You can schedule the job to run periodically at specific time intervals.  

 You can schedule the job to run continuously.  

 You can chain jobs. 

Jobs Started at Specific Time 

You can schedule the job to start at specific time daily, on specific week days or monthly on selected 
days.  

This type of schedule requires you to define the exact time when the job must be launched. For 
example, you can configure the job to start daily at 10:00 PM or once a month, every first Sunday at 
12:00 AM. 

 

 

Jobs Started at Specific Time Intervals 

You can schedule the job to start periodically throughout a day at a specific time interval. The time 
interval between job sessions can be defined in minutes or hours. For example, you can configure the 
job to start every 30 minutes or every 2 hours.  

For periodically run jobs, reference time is midnight (12:00 AM). Veeam Backup & Replication always 
starts counting defined intervals from 12:00 AM, and the first session of the job is performed at 12:00 
AM. For example, if you configure the job to run with a 4-hour interval, the job will start at 12:00 AM, 
4:00 AM, 8:00 AM, 12:00 PM, 4:00 PM and so on. 
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If necessary, you can specify an offset periodically run jobs. The offset is an exact time within an hour 
when the job must start. For example, you can configure the job to start with a 4-hour interval and 
specify offset equal to 15 minutes. In this case, the job will start at 12.15 AM, 4:15 AM, 8:15 AM, 12:15 
PM, 4:15 PM and so on. 

 

If a session of a periodically run job does not fit into the specified time interval and overlaps the next 
planned job session, Veeam Backup & Replication starts the next backup job session at the nearest 
scheduled interval.  

For example, you have set up the job to run with a 4-hour interval. The first job session started at 12:00 
AM, took 5 hours and completed at 5:00 AM. In this case, Veeam Backup & Replication will start a new 
job session at 8:00 AM. 

 

Jobs Run Continuously 

You can schedule the job to run continuously — that is, in a non-stop manner. A new session of a 
continuously running job starts as soon as the previous job session completes. Continuously run jobs 
can help you implement near-continuous data protection (near-CDP) for the most critical applications 
installed on VMs.  
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Chained Jobs 

In the common practice, data protection jobs configured in the virtual environment start one after 
another: when job A finishes, job B starts and so on.  

You can create a chain of jobs using scheduling settings. To do this, you must define the start time for 
the first job in the chain. For other jobs in the chain, you must select the After this job option in 
scheduling settings and choose the preceding job from the list.  

Job chaining is not limited to jobs of specific type only. You can create a chain of jobs of different 
types. For example, you can: 

1. Set a backup job as the first job in the chain. 

2. Configure a SureBackup job and chain with the backup job. In this case, 
Veeam Backup & Replication will automatically verify a backup file created with the backup 
job once the backup job completes. 

Note: 

 

If you start the initial job manually, Veeam Backup & Replication will offer you to start jobs chained to 
it as well. Click Yes to start the whole job chain or No to start only the first job in the chain. 
If you start the initial job manually and chain to it a job while the initial job is running, the chained 
job will not start when the initial job completes. 

 

Recommendations on Job Chaining 

You should use job chaining wisely. Job chaining removes guesswork from job scheduling but has a 
number of drawbacks: 

1. You cannot predict precisely how much time a job will require and when the job chained to it 
will start. Depending on the situation, the job schedule may shift and some operations may 
even not be performed as planned.  

For example, you configure 2 jobs: 

 Job 1 is scheduled to start at 10:00 PM daily and typically takes 1 hour. 

 Job 2 is scheduled to start after Job 1 daily. Synthetic full backup is scheduled 
on Saturday. 

Imagine that Job 1 starts on Sunday and runs for 2.5 hours instead of 1 hour. Job 2 will then 
start after midnight on Monday, and the synthetic full backup planned on Saturday will not 
be created. 

2. Errors in job sessions may cause the job schedule to shift. For example, if the first job in the 
chain fails, Veeam Backup & Replication will attempt to retry it, and chained jobs will be 
deferred. 

3. Load on backup infrastructure resources may be not balanced. Some slots on backup proxies 
and backup repositories may be available but will not be used since jobs are queued to run 
one by one. And if you use a backup repository that supports multiple I/O streams, its 
resources will not be used to the full.  

Instead of job chaining, you can schedule jobs to run simultaneously and balance the load on backup 
infrastructure components. To do this, you should enable parallel data processing and limit the 
number of concurrent tasks on backup proxies and backup repositories. For more information, see 
Limiting the Number of Concurrent Tasks and Data Processing Modes. 
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Automatic Job Retry 

You can instruct Veeam Backup & Replication to retry a job for a certain number of times if the initial 
job pass fails. By default, Veeam Backup & Replication automatically retries a failed job for 3 times 
within one job session. If necessary, however, you can change the number of retries in the job settings.  

Veeam Backup & Replication retries a job only if the previous job session has failed and one or several 
VMs in the job have not been processed. Veeam Backup & Replication does not perform a retry if a job 
session has finished with the Success or Warning status. During the job retry, 
Veeam Backup & Replication processes only those VMs that have failed. 

Veeam Backup & Replication creates only one backup file within one job session. If a job processes 
several VMs and some of them fail to be processed during the first job pass, 
Veeam Backup & Replication will create a backup file containing data for those VMs that have been 
successfully processed. At the job retry, Veeam Backup & Replication will attempt to process failed 
VMs. In case of success, Veeam Backup & Replication will write data of the processed VMs to the 
backup file that was created at the previous job pass. 

In some situations, Veeam Backup & Replication may fail to process VMs during all job retries. In this 
case, failed VMs will be processed within the next job session. Their data will be written to the backup 
file created within the current job session. 

Important! 

 

Veeam Backup & Replication does not perform automatic retry for jobs started manually.  

For example, you have configured a job for two VMs: VM1 and VM2. The job uses the forward 
incremental method. 

During the first job session, Veeam Backup & Replication successfully processed VM1 and created a full 
backup file for it. VM2 has failed to be processed during all 3 job retries. In this case, 
Veeam Backup & Replication will attempt to process the failed VM2 within the next job session. Data 
for VM2 will be written to the backup file created within this job session, which will be an incremental 
backup. As a result, at the end of the second backup job session you will have two files: 

 Full backup file containing a full restore point for VM1 

 Incremental backup file containing a full restore point for VM2 and an incremental restore 
point for VM1 
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Backup Window 

If necessary, you can specify a backup window for data protection jobs. The backup window is a 
period of time on week days when jobs are permitted to run. If the job exceeds the allowed window, it 
is automatically terminated.  

The backup window can be helpful if you do not want data protection jobs to produce unwanted 
overhead for the production environment or do not want jobs to overlap the production hours. In this 
case, you can define the time interval during which the job must not run. 

Important! 

 

The backup window affects only the data transport process. Transform operations can be performed 
on the target repository outside the backup window. 
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Backup Window for Periodically Run Jobs 

If you define the backup window for the job that runs periodically at specific time intervals, 
Veeam Backup & Replication will immediately start the job after the denied window is over. All 
subsequent backup job session will be performed by the specified settings. 

For example, you have configured a job to run with a 4-hour interval with an offset of 15 minutes. The 
allowed backup window for the job is 7:00 PM to 8:00 AM. Veeam Backup & Replication will run this 
job in the following way: 

1. The first run of the job will take place at 12:15 AM (midnight is a reference time for 
periodically run jobs). 

2. The next job session will take place at 4:15 AM. The job session at 8:15 AM will not be 
performed as it falls into the denied period of the backup window. 

3. The next job session will take place immediately after the denied period is over: at 7:15 PM.  

4. After that, Veeam Backup & Replication will run the job by the defined schedule: at 8:15 PM, 
12:15 AM and so on. 
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Manual Job Launch 

Even if you have specified scheduling settings for a job, you can still start it manually at any moment.  

When you start a job manually, Veeam Backup & Replication starts a regular job session that produces 
a new restore point in the backup chain on the backup repository. You can start the job manually if 
you need to capture VM data at a specific point in time and do not want to re-configure scheduling 
settings in the job. For example, you can start the job to create a VM backup before you install new 
software on a VM or enable a new feature. 

To start and stop jobs configured on the backup server, you can use the Start and Stop buttons on 
the ribbon or corresponding commands in the shortcut menu. 
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Stop of Job Sessions 

If you have started a job that processes several VMs but the workload appears to be greater than you 
expected or there is not enough time to finish the job session, you can stop the job execution. 

A job session can be stopped in two ways: 

 You can use the Immediately option. In this scenario, Veeam Backup & Replication 
terminates the job session and does not create a new restore point for VMs that are currently 
processed. 

 You can use the Gracefully option. In this scenario, Veeam Backup & Replication creates a 
restore point for the VMs that are currently processed and then terminates the job session. 

Immediate Stop of the Job 

The Immediately stop option terminates the job session immediately. The job finishes with the 
following results: 

 VMs that Veeam Backup & Replication has succeeded to process by the time you stop the job 
will have new restore points. 

 VMs that Veeam Backup & Replication is currently processing and VMs that 
Veeam Backup & Replication has not started to process will not have new restore points.  

When you stop the job session, Veeam Backup & Replication performs the following operations: 

1. If a snapshot for a VM has already been created, Veeam Backup & Replication instructs 
VMware vSphere to remove the snapshot.  

2. Veeam Backup & Replication terminates all job processes and tasks. The job is finished with 
the Failed error. 

All restore points created with the previous job sessions remain untouched. You can use them for 
restore operations. 

 

Graceful Stop of the Job 

The Gracefully stop option terminates the job session after creating restore points for the VMs that 
are currently processed. The job finishes with the following results: 

 VMs that Veeam Backup & Replication has succeeded to process and VMs that are currently 
processed will have new restore points. 

 VMs that Veeam Backup & Replication has not started to process will not have new restore 
points. 

You can use the Gracefully stop option for the following types of jobs: 

 Backup jobs 

 VM copy jobs 

 Replication jobs 
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You cannot use the Gracefully stop option for following types of jobs: 

 File copy jobs 

 Backup copy jobs 

 Quick migration job (during quick migration, Veeam Backup & Replication processes all VMs 
in one task) 

 Restore operations (during restore, Veeam Backup & Replication processes all VMs in one 
task) 

VMs added to the job are processed in the order defined in the job settings. Information about the 
VMs that have already been processed and the VMs that are currently processed is displayed in the job 
details. 

If you click Gracefully before Veeam Backup & Replication starts processing the first VM in the job, the 
job will be finished with the Failed error. In the job details you will see the message Operation was 
canceled by user. 
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VeeamZIP 
With Veeam Backup & Replication, you can quickly perform backup of one or several VMs with 
VeeamZIP. 

VeeamZIP is similar to full VM backup. The VeeamZIP job always produces a full backup file (VBK) that 
acts as an independent restore point. You can store the backup file to a backup repository, to a local 
folder on the backup server or to a network share.  

When you perform backup with VeeamZIP, you do not have to configure a backup job and schedule it. 
Instead, you can start the backup process for selected VMs immediately. This type of backup requires 
minimum settings — you should only select the backup destination, choose the necessary 
compression level and enable or disable application-aware processing if necessary. 

Backup files produced with VeeamZIP jobs are displayed in the Backup & Replication view, under the 
Backups > Disk (VeeamZIP) node. To restore VM data from the VeeamZIP file, you can right-click it in 
the Backup & Replication view and select the necessary restore option. You can also double-click the 
necessary VeeamZIP file on the machine where Veeam Backup & Replication is installed. 

 

To view the progress or results of the VeeamZIP job session, you can use the History view. For more 
information, see Viewing Real-Time Statistics.  
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Quick Backup 
Quick backup lets you perform on-demand incremental backup for VMs. You can use quick backup if 
you want to produce an additional restore point for one or more VMs in a backup job and do not want 
to configure a new job or modify the existing one. Quick backup can be run for both incremental and 
reverse incremental backup chains. 

Quick backup is an incremental backup task: Veeam Backup & Replication copies only changed data 
for selected VMs and saves this data to a new restore point in the backup chain. Similar to incremental 
backup, quick backup can only be run for VMs that have been successfully backed up at least once and 
has a full restore point. If there is no full restore point for a VM, quick backup cannot be not performed. 

 

To perform quick backup, Veeam Backup & Replication uses an existing backup job. When you start a 
quick backup task for a VM, Veeam Backup & Replication verifies that a backup job processing this VM 
exists on the backup server. If such job is detected, Veeam Backup & Replication triggers a job and 
creates an incremental restore point for the VM. If a backup job for the VM does not exist, quick 
backup is terminated. 

You can run quick backup for one VM or more VMs at once. If you start quick backup for several VMs 
and these VMs are processed by different backup jobs, Veeam Backup & Replication triggers a set of 
backup jobs. Each triggered job creates a separate restore point and stores this restore point in a 
corresponding backup chain.  

In some cases, a VM may be processed by several backup jobs on the backup server. In this case, 
Veeam Backup & Replication starts the job that has created the most recent restore point for the VM. 

For example, VM01 is processed by 2 jobs: 

 Backup job 1 created the most recent restore point on Monday 

 Backup job 2 created the most recent restore point on Tuesday 

When you start quick backup for VM01, Veeam Backup & Replication will trigger Backup job 2 to create 
a new incremental restore point. 

Note: 

 

If the quick backup task overlaps the scheduled backup job, the backup job waits for the quick 
backup task to complete. 

Limitations for Quick Backup 

Quick backup is not supported for separate vCloud Director VMs as vCD job process vApps as integral 
units. 
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Retention Policy for Quick Backups 

When you perform quick backup, Veeam Backup & Replication creates a partial incremental restore 
point. Unlike a regular incremental restore point that contains data for all VMs in a job, a partial 
incremental restore points contains data only for specific VM(s).  

A partial restore point is not regarded a full-fledged restore point in the backup chain. From the 
retention policy perspective, a partial restore point is grouped with a regular restore point following it. 
When Veeam Backup & Replication needs to delete a partial restore point by retention, it waits for the 
next regular restore point to expire, and deletes two restore points at once. 
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Health Check for Backup Files 
You can instruct Veeam Backup & Replication to periodically perform a health check for the latest 
restore point in the latest backup chain. During the health check, Veeam Backup & Replication 
performs CRC and hash checks for metadata and data blocks of VM disks in the backup file to verify 
their integrity. The health check helps Veeam Backup & Replication make sure that the restore point is 
consistent, and you will be able to restore data from this restore point. 

Veeam Backup & Replication always verifies only the latest point of the backup chain (or the restore 
point preceding the latest one if the latest restore point is incomplete).  

The health check can be performed for forever forward incremental, forward incremental and reverse 
incremental backup chains. The health check is not performed during the backup job session that 
transforms restore points in the backup chain into rollbacks (if you have enabled the Transform 
previous backup chains into rollback option in the job properties). 

To run the health check periodically, you must enable the Perform backup files health check option 
in the backup job settings and define the health check schedule. By default, the health check is 
performed on the last Friday of every month. You can change the health check schedule and instruct 
Veeam Backup & Replication to perform it weekly or monthly on specific days. 

Note: 

 

Veeam Backup & Replication performs the health check once a day on which the health check 
operation is scheduled. If another backup job session runs on the same day, 
Veeam Backup & Replication will not perform the heath check during this job session. 
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How Health Check Works 

The health check is performed in the following way: 

1. When Veeam Backup & Replication saves a new restore point to the backup repository, it 
calculates CRC values for backup metadata and hash values for data blocks of VM disk in the 
backup file and saves these values in the metadata of the backup file, together with VM data. 

2. At the end of the backup job session, Veeam Backup & Replication performs the health check 
for the latest restore point in the backup chain (restore point created with the current backup 
job session — the session during which the health check is performed). If the latest restore 
point in the backup chain is incomplete, Veeam Backup & Replication checks the restore 
point preceding the latest one.  

Veeam Backup & Replication calculates CRC values for backup metadata and hash values for 
VM disks data blocks in the backup file and compares them with the CRC and hash values that 
are already stored in the backup file. 

3. If the health check detects corrupted data, Veeam Backup & Replication completes the 
backup job with the Error status and starts the health check retry process. The health check 
retry starts as a separate backup job session. 

Depending on the revealed data corruption, Veeam Backup & Replication performs the following 
actions: 

 If the health check has detected corrupted backup metadata in the full backup file, 
Veeam Backup & Replication marks the backup chain starting from this full restore point 
as corrupted in the configuration database. During the heath check retry, 
Veeam Backup & Replication transports data blocks of the whole VM image from the 
source datastore, creates a new full backup file on the backup repository and saves 
transported data blocks to it.  

 If the health check has detected corrupted backup metadata in the incremental backup 
file, Veeam Backup & Replication removes information about this incremental restore 
point and subsequent incremental restore points from the configuration database. 
During the heath check retry, Veeam Backup & Replication transports incremental data 
relatively the latest valid restore point in the backup chain from the source datastore, 
creates a new incremental backup file on the backup repository and saves transported 
data blocks to it. 

 If the heath check has detected corrupted VM disk blocks in the full or incremental 
backup file, Veeam Backup & Replication marks the restore point that includes the 
corrupted data blocks and subsequent incremental restore points as corrupted in the 
configuration database. During the health check, Veeam Backup & Replication transports 
valid data blocks from the source datastore and stores these data blocks to the latest 
restore point that has been created with the current backup job session (session that has 
triggered the health check retry). 

The heath check itself is started during the backup job session or the job retry session if the backup 
job session has failed. If the attempts are not successful, Veeam Backup & Replication will perform the 
health check during the last job retry in any case. 

The number of health check retries is equal to the number of job retries specified in the job settings. 
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Compact of Full Backup File 
If you use a forever forward incremental or reverse incremental backup method, the backup job 
constantly transforms the full backup file in the backup chain to meet retention policy settings. The 
transformation process, however, has a side effect. In the long run, the full backup file grows large and 
gets badly fragmented. The file data occurs to be written to non-contiguous clusters on disk, and 
operations of reading and writing data from and to the backup file slow down. 

To resolve the fragmentation problem, you can instruct Veeam Backup & Replication to compact the 
full backup file periodically. During the file compact operation, Veeam Backup & Replication creates a 
new empty file and copies to it data blocks from the full backup file. As a result, the full backup file 
gets defragmented and the speed of reading and writing from and to the file increases.  

To compact the full backup file periodically, you must enable the Defragment and compact full 
backup file option in the backup job settings and define the compact operation schedule. By default, 
the compact operation is performed on the last Saturday of every month. You can change the 
compact operation schedule and instruct Veeam Backup & Replication to perform it weekly or 
monthly on specific days. 

 

Removal of Deleted VMs Data 
During the compact operation, Veeam Backup & Replication does not simply copy all data blocks from 
the VBK file to the newly created file. It copies only data blocks of VMs whose information is stored in 
the configuration database. For example, if the VM is removed from the backup job, its data is not 
copied to the new full backup file. This approach helps reduce the size of the full backup file and 
remove unnecessary data from it. 
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VM Data Take Out 
If the full backup file contains data for a VM that has only one restore point and this restore point is 
older than 2 days, during the compact operation Veeam Backup & Replication will extract data for this 
VM from the full backup file and write this data to a separate full backup file. Such backup will be 
displayed under the Backups > Disk (imported) node in the Backup & Replication view.  

The mechanism works if the following conditions are met: 

– The Remove deleted VMs data option is not enabled in the backup job settings. 

– The Use per-VM backup files option is not enabled in the backup repository settings. 

Important! 

 

The take out mechanism is not supported for reverse incremental backup chains and forward 
incremental backup chains that have been transformed to reverse increments. 

Limitations for Full Backup File Compact 
The full backup file compact has the following limitations:  

 The Defragment and compact full backup file option can be enabled only for backup jobs 
for which active full and synthetic full backups are not scheduled. 

 The backup repository must have enough space to store a file of the full backup size. During 
the compact process, Veeam Backup & Replication creates auxiliary files that exist on the 
backup repository until the end of the compact operation. 
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Data Recovery 
Veeam Backup & Replication offers a number of recovery options for various disaster recovery 
scenarios: 

 Instant VM Recovery enables you to instantly start a VM directly from a backup file 

 Full VM recovery enables you to recover a VM from a backup file to its original or another 
location 

 VM file recovery enables you to recover separate VM files (virtual disks, configuration files and 
so on) 

 Virtual drive restore enables you to recover a specific hard drive of a VM from the backup file, 
and attach it to the original VM or to a new VM 

 Windows file-level recovery enables you to recover individual Windows guest OS files (from 
FAT, NTFS and ReFS file systems) 

 Multi-OS file-level recovery enables you to recover files from 15 different guest OS file 
systems 

Veeam Backup & Replication uses the same image-level backup for all data recovery operations. You 
can restore VMs, VM files and drives, application objects and individual guest OS files to the most 
recent state or to any available restore point. 
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Instant VM Recovery 
With instant VM recovery, you can immediately restore a VM into your production environment by 
running it directly from the backup file. Instant VM recovery helps improve recovery time objectives 
(RTO), minimize disruption and downtime of production VMs. It is like having a "temporary spare" for a 
VM: users remain productive while you can troubleshoot an issue with the failed VM.  

When instant VM recovery is performed, Veeam Backup & Replication uses the Veeam vPower 
technology to mount a VM image to an ESX(i) host directly from a compressed and deduplicated 
backup file. Since there is no need to extract the VM from the backup file and copy it to production 
storage, you can restart a VM from any restore point (incremental or full) in a matter of minutes. 

The archived image of the VM remains in read-only state to avoid unexpected modifications. By 
default, all changes to virtual disks that take place while the VM is running, are logged to auxiliary redo 
logs residing on the NFS server (backup server or backup repository). These changes are discarded as 
soon as a restored VM is removed, or merged with the original VM data when VM recovery is finalized. 

To improve I/O performance for a restored VM, you can redirect VM changes to a specific datastore. In 
this case, instead of using redo logs, Veeam Backup & Replication will trigger a snapshot and put it to 
the Veeam IR directory on the selected datastore, together with metadata files holding changes to the 
VM image. Redirecting VM changes improves recovery performance but makes Storage vMotion not 
possible for ESX 4.x and earlier. As a result, you will not be able to use Storage vMotion to finalize 
Instant VM Recovery. 

To finalize instant VM recovery, you can do one of the following: 

 Use Storage vMotion to quickly migrate the restored VM to the production storage without 
any downtime. In this case, original VM data will be pulled from the NFS datastore to the 
production storage and consolidated with VM changes while the VM is still running. Storage 
vMotion, however, can only be used if you select to keep VM changes on the NFS datastore 
without redirecting them. Please note that Storage vMotion is only available with select 
VMware licenses. 

 Use replication or VM copy functionality of Veeam Backup & Replication. In this case, you can 
create a copy of a VM and fail over to it during the next maintenance window. In contrast to 
Storage vMotion, this approach requires you to schedule some downtime while you clone or 
replicate the VM, power it off and then power the cloned copy or replica on. 

 Use Quick Migration. In this case, Veeam Backup & Replication will perform a two-stage 
migration procedure — instead of pulling data from the vPower NFS datastore, it will restore 
the VM from the backup file on the production server, then move all changes and consolidate 
them with the VM data. For details, see Quick Migration. 

In many respects, instant VM recovery gives results similar to failover of a VM replica. Both features can 
be used for tier-1 applications with little tolerance for business interruption and downtime. However, 
when you perform replica failover, you do not have dependencies on the backup server. And, unlike 
instant VM recovery that provides only limited I/O throughput, replication guarantees full I/O 
performance. 

Beside disaster recovery matters, instant VM recovery can also be used for testing purposes. Instead of 
extracting VM images to production storage to perform regular DR testing, you can run a VM directly 
from the backup file, boot it and make sure the VM guest OS and applications are functioning 
properly. 
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Full VM Recovery 
With Veeam Backup & Replication, you can restore an entire VM from a backup file to the latest state 
or to any good-to-know point in time if the primary VM fails. 

In contrast to instant VM recovery, full VM restore requires you to fully extract the VM image to the 
production storage. Though full VM restore takes more resources and time to complete, you do not 
need to perform extra steps to finalize the recovery process. Veeam Backup & Replication pulls the VM 
data from the backup repository to the selected storage, registers the VM on the chosen ESX host and, 
if necessary, powers it on. Full VM recovery enables full disk I/O performance while Instant VM 
recovery provides a “temporary spare” for a VM as the vPower NFS throughput is limited. 

To perform full VM recovery, Veeam Backup & Replication uses one of the following transport modes: 

 If the backup proxy is connected directly into the SAN fabric or has access to NFS datastores, 
Veeam Backup & Replication uses the Direct storage access transport mode. Veeam Data 
Mover Services deployed on the backup repository and backup proxy retrieve VM data from 
the backup file and put it directly to the necessary datastore.  

Veeam Backup & Replication can restore only thick VM disks using the Direct storage access 
transport mode. For thin VM disks restore, Veeam Backup & Replication will use the Virtual 
appliance or Network transport modes. Alternatively, you can instruct 
Veeam Backup & Replication to restore VM disks as thick. 

 If the backup proxy is virtualized and resides on the ESX(i) host to which the VM must be 
restored, Veeam Backup & Replication uses the Virtual appliance transport mode. The Virtual 
appliance mode utilizes VMware ESX(i) capabilities of HotAdding disks to the VM and thus 
eliminates the need to transfer the backup data across the network. Veeam Data Mover 
Services deployed on the backup repository and backup proxy retrieve VM data from the 
backup file and put it directly to the necessary datastore via the ESX(i) I/O stack. 

 If the Direct storage access and Virtual appliance transport modes cannot be used, 
Veeam Backup & Replication uses the Network transport mode. 

For more information, see Transport Modes.  

A VM can be restored to its original location or to a new location. When you restore a VM to its original 
location, the primary VM is automatically turned off and deleted before the restore. This type of 
restore ensures the quickest recovery and minimizes the number of mistakes which can be potentially 
caused by changes in VM settings. 

When you restore a VM to a new location, you need to specify new VM settings such as the new VM 
name, the host and datastore where the VM will reside, disk format (thin or thick provisioned) and 
network properties. Veeam Backup & Replication will change the VM configuration file and store the 
VM data to the location of your choice. 



 

171   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

VM File Recovery 
Veeam Backup & Replication can help you to restore specific VM files (.vmdk, .vmx and others) if any of 
these files are deleted or the datastore is corrupted. This option provides a great alternative to full VM 
restore, for example, when your VM configuration file is missing and you need to restore it. Instead of 
restoring the whole VM image to the production storage, you can restore the specific VM file only. 

When you perform VM file restore, VM files are restored from regular image-level backups. Veeam 
Data Mover Services deployed on the backup repository and the backup proxy retrieve VM data from 
the backup file and send it to the original VM location, or to a new location specified by the user. 
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Virtual Drive Recovery 
Another data recovery option provided by Veeam Backup & Replication is restore of a specific hard 
drive of a VM. If a VM hard drive becomes corrupted for some reason (for example, with a virus), you 
can restore it from the image-based backup to any good-to-know point in time. The recovered hard 
drive can be attached to the original VM to replace a corrupted drive, or connected to any other VM. 
With the virtual drive restore, you can preserve the format of a recovered drive or convert the drive to 
the thin or thick format on the fly. 
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Guest OS File Recovery 
You can use IFLR (Instant File-Level Restore) to recover individual VM guest OS files and folders from 
VM backups and replicas. IFLR does not require you to extract the VM image to a staging location or 
start the VM prior to restore. You can restore files and folders directly from a regular image-level 
backup or replica to the necessary point in time. 

IFLR works with any VM guest OS file system. Veeam Backup & Replication offers different tools and 
methods for different file systems: 

 For file-level restore from Microsoft Windows VMs with NTFS, FAT and ReFS file systems, you 
can use the File-Level Restore wizard. For more information, see Restore from FAT, NTFS or 
ReFS. 

 For file-level restore from Linux, Solaris, BSD, Novell Storage Services, Unix, Mac and other file 
systems, you can use the multi-OS File-Level Restore wizard. For more information, see 
Restore from Linux, Unix and Other File Systems. 

 For file-level restore from file systems not supported by file-level restore wizards, you can 
leverage the Instant VM Recovery functionality. For more information, see Restore from Other 
File Systems. 

 

Restore from FAT, NTFS or ReFS 

To restore individual files and folders from FAT, NTFS and ReFS file systems, you can use the File-Level 
Restore wizard. 

When you perform file-level restore, Veeam Backup & Replication performs the following operations: 

1. Veeam Backup & Replication mounts disks of the VM from the backup or replica to the 
backup server or machine on which the Veeam Backup & Replication console is installed, 
under the C:\veeamflr\<vmname> folder.  

For accessing VM disks content, Veeam Backup & Replication uses a separate program — 
Virtual Disk Driver (VDK) that is provided with the product. VM disks are not physically 
extracted from the backup file or VM replica. Veeam Backup & Replication emulates their 
presence on the backup server or Veeam Backup & Replication console. The backup file or VM 
replica itself remains in the read-only state. 

2. Veeam Backup & Replication launches the Veeam Backup Browser where mounted VM disks 
are displayed. You can browse the VM guest file system in the Veeam Backup Browser.  

3. If you restore files to the original location, Veeam Backup & Replication creates an additional 
mount point on the mount server associated with the backup repository on which the 
backup file resides. The mount server is typically located close to the backup repository. The 
second mount point lets Veeam Backup & Replication route for VM data in an optimal way 
and reduce load on the network. 

As a result, restored files data travels in the following way: 

 In the restore to original scenario — from the mount server to the original location. 
The first mount point here is used only for browsing the VM guest file system. 

 In the restore to new location scenario — from the backup server or 
Veeam Backup & Replication console to the specified new location. 

4. When the restore process is finished or the Veeam Backup Browser is closed by timeout, 
Veeam Backup & Replication removes mount points from the backup server or machine on 
which the Veeam Backup & Replication console is installed and from the mount server (if the 
second mount was used). 
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Depending on the restore scenario, Veeam Backup & Replication may create mount points on 
different backup infrastructure components. For more information, see File-Level Restore Scenarios. 
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File-Level Restore Scenarios 

You can use different scenarios for file-level restore: 

 Restore files from backups 

 Restore files from replicas 

 Restore files from storage snapshots 

 Restore files for work with Veeam Explorers 

 Restore files from Veeam Backup Enterprise Manager 

In different restore scenarios, Veeam Backup & Replication uses different servers as mount points. 

Restoring Files from Backups 

When you restore files from backups that reside on the backup repository, 
Veeam Backup & Replication uses the following mount points: 

1. Veeam Backup & Replication mounts disks of the VM from the backup file to the machine 
where the restore process is launched. This can be the backup server or machine on which 
the Veeam Backup & Replication console is installed. This mount point allows you to browse 
the VM file system. 

2. If you restore files to the original location, Veeam Backup & Replication creates an additional 
mount point on the mount server associated with the backup repository on which the 
backup file resides. The second mount lets you keep the VM traffic in one site and reduce load 
on the network. 

 

If you restore files to a new location (perform the Copy to operation), Veeam Backup & Replication 
does not create the second mount point. It simply copies files to the destination from the backup 
server or Veeam Backup & Replication console machine. 

Note: 

 

Backup files on HPE StoreOnce are locked exclusively by a restore task. For this reason, 
Veeam Backup & Replication uses only one mount point on the backup server or 
Veeam Backup & Replication console machine for backups on HPE StoreOnce. 
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Restoring Files from Replicas 

When you restore files from a VM replica, Veeam Backup & Replication uses the following mount 
points: 

1. Veeam Backup & Replication mounts disks of the VM replica to the machine where the restore 
process is launched. This can be the backup server or machine on which the 
Veeam Backup & Replication console is installed. This mount point allows you to browse the 
VM file system. 

2. If you start the restore process from the Veeam Backup & Replication console and restore files 
to the original location, Veeam Backup & Replication creates an additional mount point on 
the backup server.  

 

If you start the restore process on the backup server or restore files to a new location (perform the 
Copy to operation), Veeam Backup & Replication does not create the second mount point. It simply 
copies files to the destination from the backup server or Veeam Backup & Replication console 
machine. 
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Restoring Files from Storage Snapshots 

When you restore files from storage snapshots, Veeam Backup & Replication uses one mount point on 
the backup server or Veeam Backup & Replication console machine. 

 

Restoring Files for Veeam Explorers 

Veeam Backup & Replication can perform file-level restore as a preparatory step for application items 
restore. However, the database files may be huge and require a lot of network resources. For this 
reason, if you restore application items from Microsoft SQL and Oracle VMs, 
Veeam Backup & Replication can mount the content of the backup file directly to the original VM. 

For restore from backups of Microsoft SQL Server VMs or Oracle VMs, Veeam Backup & Replication 
creates an additional mount point on the original VM. 

 To create a mount point on Microsoft Windows VMs, Veeam Backup & Replication uses the 
iSCSI initiator. 

 To create a mount point on Linux VMs (for Oracle running on Linux), 
Veeam Backup & Replication uses fuse. 
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Restoring Files from Veeam Backup Enterprise Manager 

When you restore files from the backup file that was created without VM guest OS file indexing, 
Veeam Backup & Replication uses the following mount points: 

1. Veeam Backup & Replication mounts disks of the VM from the backup file to the backup 
server.  

2. If you restore files to the original location, Veeam Backup & Replication creates an additional 
mount point on the mount server associated with the backup repository on which the 
backup file resides. The second mount lets you keep the VM traffic in one site and reduce load 
on the network. 

 

If you select to download files, Veeam Backup & Replication does not create the second mount point. 
It simply copies files to the destination from the backup server. 

When you restore files from the backup file that was created with VM guest OS file indexing, 
Veeam Backup & Replication mounts disks on the backup server and uses indexes to build the file 
system tree of the VM guest OS. 
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Restore from Linux, Unix and Other File Systems 

To restore individual files and folders from file systems other than Microsoft Windows, you can use the 
multi-OS File-Level Restore wizard.  

To restore files from VM guest OS, Veeam Backup & Replication uses a proxy appliance. The proxy 
appliance is a helper VM running a stripped down Linux kernel that has a minimal set of components. 
The appliance is quite small — around 42 MB. It requires 1024 MB RAM and takes around 10 seconds 
to boot. 

When you perform file-level restore, Veeam Backup & Replication performs the following operations: 

1. Veeam Backup & Replication deploys a proxy appliance on the ESX(i) host in the virtual 
infrastructure. 

2. Veeam Backup & Replication mounts disks of the VM from the backup or replica to the proxy 
appliance. The backup file or VM replica itself remains in the read-only state on the backup 
repository or datastore. 

3. Veeam Backup & Replication launches the Veeam Backup Browser where mounted VM disks 
are displayed. You can browse the VM guest file system in the Veeam Backup Browser and 
restore files or folders to the original VM or to another location. Alternatively, you can enable 
an FTP server on the virtual appliance and allow VM owners to restore files themselves. 

4. When the restore process is finished or the Veeam Backup Browser is closed by timeout, 
Veeam Backup & Replication unmounts the content of the backup file or replica from the 
proxy appliance and unregisters the proxy appliance on the ESX(i) host. 
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Restore from Other File Systems 

With the vPower technology, Veeam extends IFLR to any file system, not just Microsoft Windows FAT, 
NTFS, ReFS and file systems supported by the multi-OS File-Level Restore wizard. 

To restore files and folders from file systems not supported by file-level restore wizards, you must 
perform the following actions: 

1. Use Instant VM Recovery to publish the VM from the backup file on the ESX(i) host in the 
virtual infrastructure. Do not start the recovered VM. 

2. Mount the disks of the restored VM to any VM that can read the file system of the original VM.  

3. Restore files or folders using native file management tools. Alternatively, you can mount the 
VM disks to a Microsoft Windows VM and use file management tools such as Portlock 
Explorer. 
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Quick Rollback 
When you restore a full VM or VM hard disk to the original location, you can instruct 
Veeam Backup & Replication to perform quick rollback — incremental data restore. Instead of 
restoring an entire VM or VM disk from a backup file, Veeam Backup & Replication will recover only 
those data blocks that are necessary to revert the VM or VM disk to an earlier point in time. Quick 
rollback significantly reduces the recovery time and has little impact on the production environment. 

To perform quick rollback, Veeam Backup & Replication uses the VMware Changed Block Tracking 
technology. Veeam Backup & Replication queries VMware Sphere to get CBT information for the 
current VM state and compares it with the CBT information in a backup file. This way, 
Veeam Backup & Replication detects what data blocks must be transported back to rebuild the VM or 
VM disk to an earlier point in time. 

It is recommended that you use quick rollback if you restore a VM or VM disk after a problem that has 
occurred at the level of the VM guest OS: for example, there has been an application error or a user has 
accidentally deleted a file on the VM guest OS. Do not use quick rollback if the problem has occurred 
at the VM hardware level, storage level or due to a power loss. 

Requirements for Quick Rollback 
To use incremental restore, make sure that the following requirements are met: 

1. VM or VM disk is restored to its original location. 

2. CBT is enabled for the VM disk or all disks of a VM you plan to restore. 

3. The backup file from which you plan to restore a VM or a VM disk is created with the 
Changed block tracking option enabled. 

Limitations for Quick RollBack 
1. Use VM guest OS file exclusion and Quick Rollback wisely. If you exclude specific files and 

folders from the VM guest OS during backup and use Quick Rollback to restore the VM or VM 
disk from such backup, Veeam Backup & Replication will restore only the content of the 
backup file; the excluded data will not be restored. For example, if you exclude C:\Folder 
from the backup, data for this folder will not be backed up and will not be available in the 
resulting backup file. After some time, data in C:\Folder may change but the folder will still 
not be backed up (since the job excludes this folder). For this reason, when you perform 
Quick Rollback, Veeam Backup & Replication will restore all data that have changed except 
the excluded C:\Folder. 

2. Incremental restore can be performed in the Direct NFS access, Virtual Appliance, Network 
transport mode. The Direct SAN access transport mode cannot be used for the incremental 
restore due to VMware limitations. 

3. You cannot run two incremental restore sessions subsequently. After you perform 
incremental restore for a VM, the CBT on the original VM is reset. You must perform at least 
one incremental backup to be able to perform incremental restore again. 

During the backup job session after quick rollback, Veeam Backup & Replication will read all 
data of the original VM since the CBT on the original VM is reset. 

http://pubs.vmware.com/vsphere-51/index.jsp?topic=%2Fcom.vmware.vddk.pg.doc%2FvddkBkupVadp.9.5.html
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Storage Profile Restore 
During backup, Veeam Backup & Replication preserves information about the storage profile 
associated with the VM, and stores this information to the backup file or replica metadata. When you 
restore the VM to its original location, Veeam Backup & Replication also restores information about the 
VM storage profile. The restored VM gets automatically associated with the original storage profile. 

Veeam Backup & Replication restores the storage profile when you perform the following operations: 

 Full VM restore 

 VM failback 

Veeam Backup & Replication restores the storage profile only if you restore the VM to the original 
location. If you restore the VM to a new location, Veeam Backup & Replication does not preserve the 
storage profile for the VM. 

In some cases, the original storage profile may be changed or missing by the time when you restore 
the VM. For example, the storage profile may be deleted, the original VM in the production 
environment may be associated with another storage profile and so on. In such situation, 
Veeam Backup & Replication displays a warning and lets you choose one of the following scenarios: 

 Associate the VM with the current storage profile — the restored VM will be associated with 
the profile with which the original VM in the production environment is currently associated. 

 Associate the VM with the default storage profile — the restored VM will be associated with 
the profile that is set as default for the target datastore. 

 Associate the VM with the profile stored in the backup file — the restored VM will be 
associated with the profile that was assigned to the original VM at the moment of backup, 
and whose information is stored in the backup file. 
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Replication 
To ensure efficient and reliable data protection in your virtual environment, 
Veeam Backup & Replication complements image-based backup with image-based replication. 
Replication is the process of copying a VM from its primary location (source host) to a destination 
location (redundant target host). Veeam Backup & Replication creates an exact copy of the VM 
(replica), registers it on the target host and maintains it in sync with the original VM. 

Replication provides the best recovery time objective (RTO) and recovery point objective (RPO) values, 
as you actually have a copy of your VM in a ready-to-start state. That is why replication is commonly 
recommended for the most critical VMs (which run tier 1 applications) that need minimum RTOs. 
Veeam Backup & Replication provides means to perform both onsite replication for high availability 
(HA) scenarios and remote (offsite) replication for disaster recovery (DR) scenarios. To facilitate 
replication over WAN or slow connections, Veeam Backup & Replication optimizes traffic transmission 
— it filters out unnecessary data blocks (such as, duplicate data blocks, zero data blocks or blocks of 
swap files) and compresses replica traffic. Veeam Backup & Replication also allows you to apply 
network throttling rules to prevent replication jobs from consuming the entire bandwidth available in 
your environment. 

Replication is a job-driven process with one replication job used to process one or more VMs. You can 
start the job manually every time you need to copy VM data or, if you want to run replication 
unattended, create a schedule to start the job automatically. Scheduling options for replication jobs 
are similar to those for backup jobs.  

In many respects, replication of VMware VMs works similarly to forward incremental backup. During 
the first run of a replication job, Veeam Backup & Replication copies the original VM running on the 
source host and creates its full replica on the target host. Unlike backup files, replica virtual disks are 
stored uncompressed in their native format. All subsequent replication job runs are incremental (that 
is, Veeam Backup & Replication copies only those data blocks that have changed since the last 
replication cycle). 

For every replica, Veeam Backup & Replication creates and maintains a configurable number of restore 
points. If the original VM fails for any reason, you can temporary or permanently fail over to a replica 
and thus restore critical services with minimum downtime. If the latest state of a replica is not usable 
(for example, if corrupted data was replicated from source to target), you can select previous restore 
point to fail over to. Veeam Backup & Replication utilizes VMware ESX snapshot capabilities to create 
and manage replica restore points. A new incremental run of the replication job takes a regular 
snapshot of a replica. Blocks of data that have changed since the last job run are written to the 
snapshot delta file and the snapshot delta file acts as a restore point. 

VMware replica restore points are stored in a native VMware format next to replica virtual disk files, 
which allows Veeam Backup & Replication to accelerate failover operations. To restore a replica in the 
required state, there is no need to apply rollback files. Instead, Veeam Backup & Replication uses 
native VMware mechanism of reverting to a snapshot. 

As well as for backup jobs, for replication jobs you can define a retention period. 
Veeam Backup & Replication will keep only the specified number of points, removing any snapshots 
that breach the retention policy.  
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Replication Components 
The following infrastructure components are engaged in the replication process: 

 Backup server 

 Source host and target host with associated datastores 

 One or two backup proxies 

 Backup repository 

 [Optional] WAN accelerators 

 Backup Server 
The backup server is the configuration, administration and management core of the replication 
infrastructure. During the replication process, the backup server coordinates replication tasks, controls 
resource allocation and replica job scheduling. 

Source and Target Hosts 
The source host and the target host produce two terminal points between which replicated VM data is 
moved. The role of a target can be assigned to a single ESX(i) host or to an ESX(i) cluster. Assigning a 
cluster as a target ensures uninterrupted replication in case one of the cluster hosts fails. 

Backup Proxies 
To collect, transform and transport VM data during the VM replication process, Veeam Backup & 
Replication uses Veeam Data Mover Services. Data Mover Services communicate with each other and 
maintain a stable connection. 

For every replication job, Veeam Backup & Replication requires three Data Mover Services: 

 Source-side Data Mover Service hosted on the backup proxy 

 Target-side Data Mover Service hosted on the backup proxy 

 Data Mover Service hosted on the backup repository 

During replication, the source-side Data Mover Service interacts with the source host and the target-
side Data Mover Service interacts with the target host. The Data Mover Service hosted on the 
repository works with replica metadata files. 

To streamline the replication process, you can deploy a backup proxy on a VM. The virtual backup 
proxy must be registered on an ESX(i) host that has a direct connection to the target datastore. In this 
case, the backup proxy will be able to use the Virtual appliance transport mode for writing replica data 
to target. For more information, see Transport Modes. 

During the first run of a replication job, Veeam Backup & Replication creates a replica with empty 
virtual disks on the target datastore. If the Virtual appliance mode can be used, replica virtual disks are 
mounted to the backup proxy and populated through the ESX host I/O stack. This results in increased 
writing speed and fail-safe replication to ESX targets. 

If the backup proxy is deployed on a physical server or the Virtual appliance mode cannot be used for 
other reasons, Veeam Backup & Replication uses the Network transport mode to populate replica disk 
files. 

Backup Repository 
The backup repository stores replica metadata. The backup repository must be deployed in the source 
site, as close to the source host as possible. When you perform incremental replication, the source-
side Data Mover Service communicates with the Data Mover Service on the backup repository to 
obtain replica metadata and quickly detect changed blocks of data between two replica states.  
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WAN Accelerators 
WAN accelerators are optional components in the replication infrastructure. You can use WAN 
accelerators if you replicate VMs over a slow connection or over the WAN.  

In the replication process, WAN accelerators are responsible for global data caching and 
deduplication. To use WAN acceleration, you must deploy two WAN accelerators in the following 
manner: 

 The source WAN accelerator must be deployed in the source side, close to the backup proxy 
running the source-side Data Mover Service. 

 The target WAN accelerator must be deployed in the target side, close to the backup proxy 
running the target-side Data Mover Service. 
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Replication Process 
All replication infrastructure components engaged in replication make up a data pipe. VM data is 
moved over this data pipe block by block, with multiple processing cycles.  

The replication process is performed in the following way: 

1. The source-side Data Mover Service communicates with the target-side Data Mover Service to 
begin data collection. 

2. The source-side Data Mover Service accesses the VM image and copies VM data using one of 
VMware transport modes, as prescribed by the backup proxy server settings. During 
incremental job runs, the Veeam Data Mover Service retrieves only those data blocks that 
have changed since the previous job run. 
While copying data, the source-side Data Mover Service performs additional processing — it 
consolidates the content of virtual disks by filtering out overlapping snapshot blocks, zero 
data blocks and blocks of swap files.  

3. In cases when VMware CBT is not available, the source-side Veeam Data Mover Service 
interacts with the Veeam Data Mover Service hosted on the repository to obtain replica 
metadata. The source-side Veeam Data Mover Service uses this metadata to detect blocks 
that have changed since the previous job run. 

4. Copied blocks of data are compressed and moved from the source-side Data Mover Service to 
the target-side Data Mover Service. 

5. The target-side Data Mover Service decompresses replica data and writes the result to the 
destination datastore. 
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Replication Scenarios 
Veeam Backup & Replication supports a number of replication scenarios that depend on the location 
of the target host and the data transport path. 

 Onsite replication 

 Offsite replication 

Onsite Replication 

If the source host and the target host are located in the same site, you can perform onsite replication.  

Onsite replication requires the following replication infrastructure components: 

1. Backup proxy. In the onsite replication scenario, the source-side Data Mover Service and the 
target-side Data Mover Service are started on the same backup proxy. The backup proxy must 
have access to the backup server, source host, target host and backup repository holding 
replica metadata. 

2. Backup repository for storing replica metadata. 

In the onsite replication scenario, Veeam Backup & Replication does not perform data compression. 
Replication traffic is transferred uncompressed between the two Data Mover Services started on the 
same backup proxy. 
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Offsite Replication 

If the source host is located in the primary site and the target host is located in the DR site, you can 
perform offsite replication. 

Offsite replication can run over two data paths: 

 Direct data path 

 Via a pair of WAN accelerators 

Note: 

 

When planning for offsite replication, consider advanced possibilities to reduce the amount of 
replication traffic and streamline replica configuration. These include replica seeding, replica 
mapping, network mapping and re-IP. 

Replication Over Direct Data Path 

The common requirement for offsite replication is that one Data Mover Service runs in the production 
site, closer to the source host, and another Data Mover Service runs in the remote DR site, closer to the 
target host. During backup, the Data Mover Services maintain a stable connection, which allows for 
uninterrupted operation over the WAN or slow links. For more information, see Resume on WAN 
Disconnect. 

Offsite replication over a direct path requires the following backup infrastructure components: 

1. At least one backup proxy in the source site. The backup proxy must have access to the 
backup server, source host, backup proxy in the target site and backup repository holding 
replica metadata. 

2. At least one backup proxy in the target site. The backup proxy must have access to the 
backup server, target host and backup proxy in the source site. 

3. Backup repository for storing replica metadata. The backup repository must be located in the 
source site, closer to the backup proxy, and must have access to it. 

In the offsite replication scenario, Veeam Backup & Replication uses data compression. The Data 
Mover Service on the source backup proxy compresses VM data blocks and sends them to the target 
backup proxy in the compressed format. The Data Mover Service on the target backup proxy 
uncompressed VM data and stores it to a datastore in a native VMware format. 
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Replication via WAN Accelerators 

If you have a weak WAN link, you can replicate VM data via a pair of WAN accelerators. WAN 
accelerators provide advanced technologies to optimize VM data transfer: 

 Global data caching and deduplication 

 Resume on disconnect for uninterrupted data transfer 

WAN accelerators add a new layer in the backup infrastructure — a layer between the source-side 
Data Mover Service and the target-side Data Mover Service. The data flow goes from the source 
backup proxy via a pair of WAN accelerators to the target backup proxy that, finally, destinies VM data 
to the target host. 

Offsite replication over WAN accelerators requires the following backup infrastructure components: 

1. A pair of WAN accelerators at each end of a WAN link: 

 Source WAN accelerator in the source site. The source WAN accelerator must 
have access to the backup server, source backup proxy and to the target WAN 
accelerator. 

 Target WAN accelerator in the target site. The target WAN accelerator must 
have access to the backup server, source WAN accelerator and target backup 
proxy. 

2. At least one backup proxy in the source site. The backup proxy must have access to the 
backup server, source host, source WAN accelerator and the backup repository holding 
replica metadata. 

3. At least one backup proxy in the target site. The backup proxy must have access to the 
backup server, target host and target WAN accelerator. 

4. Backup repository for storing replica metadata. The backup repository must be located in the 
source site, closer to the backup proxy, and must have access to it. 

In the offsite replication scenario via WAN accelerators, Veeam Backup & Replication uses data 
compression. VM data blocks are compressed on the source WAN accelerator, transported to the 
target site in the compressed format and decompressed on the target WAN accelerator. 
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Advanced Replication Technologies 
To minimize the workload on the production infrastructure and reduce data traffic, you can use the 
following advanced replication technologies: 

 Remote replica from backup can help you minimize use of compute, storage and network 
resources of the production infrastructure. 

 Replica seeding and replica mapping can help you minimize the amount of traffic going to 
the DR site over the WAN or slow links. 

Remote Replica from Backup 

Disaster recovery plans often require that you back up and replicate the same VM for DR and HA 
purposes. Normally, this doubles the workload on the virtual infrastructure. You need to create two 
VM snapshots, independently from one another, and transfer VM data from the production site twice. 

You can reduce the workload on the production environment by using the remote replica from 
backup option. This option can be used for onsite and offsite replication scenarios. 

When you perform remote replication from backup, Veeam Backup & Replication does not address 
hosts and storage in the production environment to read VM data. As a source of data, it uses a 
backup chain that already exists on the backup repository. As a result, you do not need to create a VM 
snapshot for replication and transport the same data twice. You retrieve VM data only during the 
backup job, and the replication job re-uses this data to build VM replica restore points. 

Although replica from backup might resemble replica seeding, there is difference between these 
options: 

 Replica seeding uses the backup file only during the first run of a replication job. To further 
build VM replica restore points, the replication job addresses the production environment 
and reads VM data from the source storage. 

 Remote replica from backup uses a backup chain on the backup repository as the only source 
of data. When building a new VM replica restore point, Veeam Backup & Replication always 
reads data from the latest restore point in the backup chain, either full or incremental. The 
backup chain on the backup repository may be created with a backup job or a backup copy 
job.  

Limitations for Remote Replica from Backup 

Backups that you plan to use as a data source must be created with a backup job configured on the 
same backup server where you configure the replication job.  
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How Remote Replica from Backup Works 

Remote replica from backup is performed with a regular replication job. When you set up a replication 
job, you define a backup repository with VM backups as a source of data. If the backups for this VM are 
available in different backup repositories, you can select several backup repositories as a source. In 
this case, Veeam Backup & Replication will look for the latest VM restore point across these backup 
repositories. 

For example, you have configured two backup jobs that process the same VM, and targeted these jobs 
at two different backup repositories. The backup jobs have created the following backup files: 

 Backup job 1 has created 2 restore points on the Backup repository 1: full backup file on 
Sunday and incremental backup file on Tuesday. 

 Backup Job 2 has created 1 restore point on the Backup repository 2: full backup file on 
Monday. 

The replication job is configured to retrieve VM data from backups and scheduled to run daily. In this 
case, the replication job will retrieve VM data from backups in the following way: 

1. On Sunday, the replication job will retrieve VM data from the full backup file on the Backup 
repository 1. 

2. On Monday, the replication job will retrieve VM data from the full backup file on the Backup 
repository 2. 

3. On Tuesday, the replication job will retrieve VM data from the incremental backup file on the 
Backup repository 1. 

 

In some situations, a new restore point on the backup repository may not been created by the time a 
replication job starts. In this case, Veeam Backup & Replication displays a warning notifying that the 
latest restore point has already been replicated. The replication job session is finished with the 
Warning status.  
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Note: 

 

When you replicate a VM over a production network, Veeam Backup & Replication retrieves VM data 
as of the latest VM state. When you replicate a VM from backup, Veeam Backup & Replication 
retrieves VM data as of the point in time when the backup was created. The VM replica restore point 
has the same timestamp as a corresponding VM backup restore point, not the time when the replica 
job session is run. 

Replica Seeding 

If you replicate a VM to a remote DR site, you can use replica seeding. Replica seeding helps 
significantly minimize the amount of traffic going from the production site to the DR site over WAN or 
slow LAN links. 

With replica seeding, you do not have to transfer all of VM data from the source host to the target host 
across the sites when you perform initial replication. Instead, you can use a VM backup created with 
Veeam Backup & Replication as a replica “seed”. When the replication job starts, Veeam Backup & 
Replication will use the seed to build a VM replica. 

Replica seeding includes the following steps: 

1. As a preparatory step for replica seeding, you need to create a backup of a VM that you plan 
to replicate.  

2. The created backup should then be copied from the backup repository in the production site 
to the backup repository in the DR site. After the backup is copied to the backup repository in 
the DR site, you will need to perform rescan of this repository, as described in the Managing 
Backup Repositories section. 

3. When you create a replication job, you should point it to the backup repository in the DR site. 
During the first run of a replication job, Veeam Backup & Replication accesses the repository 
where the replica seed is located, and restores the VM from the backup. The restored VM is 
registered on the replication target host in the DR site. Files of the restored VM are placed to 
the location you specify as the replica destination datastore. 
Virtual disks of a replica restored from the backup preserve their format (that is, if the original 
VM used thin provisioned disks, virtual disks of the VM replica are restored as thin 
provisioned). 

4. Next, Veeam Backup & Replication synchronizes the restored VM with the latest state of the 
original VM. After successful synchronization, in the Backup & Replication view of Veeam 
Backup & Replication, under Replicas node you will see a VM replica with two restore points. 
One point will contain the state of the VM from the backup file; the other point will contain 
the latest state of the original VM you want to replicate. 

5. During all subsequent runs of the replication job, Veeam Backup & Replication transfers only 
incremental changes in a regular manner. 



 

193   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

 

Replica seeding dramatically reduces traffic sent over WAN or slow connections because 
Veeam Backup & Replication does not send the full contents of the VM image. Instead, it transmits 
only differential data blocks.  

Tip: 

 

If you add new VMs to an already existing replication job, you can enable replica seeding settings for 
these VMs. In this case, the newly added VMs will be seeded from the selected backups at the next 
pass of the replication job. VMs that have already been processed by the job by the time you add 
new VMs will be processed in a regular manner. 
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Replica Mapping 

If a replica for the VM that you plan to replicate already exists in the DR site, you can map the original 
VM in the production site to this VM. For example, you can map the original VM to a VM replica 
created with another replication job or restore a VM from the backup on the target host in the DR site 
and map the original VM to it. You can also use replica mapping if you need to reconfigure or recreate 
replication jobs, for example, split one replication job into several jobs. 

Replication to a mapped VM is performed in the following way: 

1. During the first run, the replication job calculates the differences between the original and 
mapped VM. Instead of copying and transferring all data of the original VM, the replication 
job transfers only incremental changes to synchronize the state of the mapped VM with the 
state of the original VM.  

After successful synchronization, in the Backup & Replication view of 
Veeam Backup & Replication, under Replicas node you will see a VM replica with 2 restore 
points:  

 One restore point will contain the latest state of the mapped VM.  

 The other restore point will contain the latest state of the original VM on the source 
host. 

2. All subsequent runs of the replication job will be performed in a regular manner: 
Veeam Backup & Replication will transfer only incremental changes to the target host. 

 

Note: 

 

If a VM replica to which the original VM is mapped has any snapshots, these snapshots will be 
removed during the run of the replication job. 
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Network Mapping and Re-IP 
If you use different network and IP schemes in the production and DR site, in the common case you 
would need to change the network configuration of a VM replica before starting it. To eliminate the 
need for manual replica reconfiguration and ensure minimum failover downtime, 
Veeam Backup & Replication offers possibilities of network mapping and automatic IP address 
transformation. 

With Veeam Backup & Replication, a replicated VM uses the same network configuration as the 
original VM. If the network in your DR site does not match the production network, you can create a 
network mapping table for the replication job. The table maps source networks to target networks. 

During every job run, Veeam Backup & Replication checks the network configuration of the original 
VM against the mapping table. If the original VM network matches a source network in the table, 
Veeam Backup & Replication updates the replica configuration file to replace the source network with 
the target one. The VM replica is then re-registered (for legacy VM replicas, not snapshot VM replicas). 
Thus, network settings of a VM replica are always kept up to date with the DR site requirements. In 
case you choose to fail over to the VM replica, it will be connected to the correct network. 

For Windows-based VMs, Veeam Backup & Replication also automates reconfiguration of VM IP 
addresses. If the IP addressing scheme in the production site differs from the DR site scheme, you can 
create a number of Re-IP rules for the replication job. 

When you fail over to the replica, Veeam Backup & Replication checks if any of the specified Re-IP rules 
apply to the replica. If a rule applies, Veeam Backup & Replication mounts VM disks of the replica to 
the backup server and changes its IP address configuration via the Microsoft Windows registry. The 
whole operation takes less than a second. If failover is undone for any reason or if you fail back to the 
original location, replica IP address is changed back to the pre-failover state. 

Important! 

 

Replica re-IP works only if you perform replica failover using Veeam Backup & Replication. If you 
power on a VM replica in some other way, for example, manually using vSphere Client, re-IP rules will 
not be applied to it.  
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Replica Failover and Failback 
In case of software or hardware malfunction, you can quickly recover a corrupted VM by failing over to 
its replica. When you perform failover, a replicated VM takes over the role of the original VM. You can 
fail over to the latest state of a replica or to any of its good known restore points. 

In Veeam Backup & Replication, failover is a temporary intermediate step that should be further 
finalized. Veeam Backup & Replication offers the following options for different disaster recovery 
scenarios: 

 You can perform permanent failover to leave the workload on the target host and let the 
replica VM act as the original VM. Permanent failover is suitable if the source and target hosts 
are nearly equal in terms of resources and are located on the same HA site. 

 You can perform failback to recover the original VM on the source host or in a new location. 
Failback is used in case you failed over to a DR site that is not intended for continuous 
operations and would like to move the operations back to the production site when the 
consequences of a disaster are eliminated. 

Veeam Backup & Replication supports failover and failback operations for one VM and for several VMs. 
In case one or several hosts fail, you can use batch processing to restore operations with minimum 
downtime. 
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Replica Failover 

Failover is a process of switching from the original VM on the source host to its VM replica on the 
target host. 

During failover, Veeam Backup & Replication recovers a fully functional VM to the required restore 
point on the target host. As a result, you have a VM up and running within a couple of seconds, and 
your users can access services and applications they need with minimum disruption. 

When you perform failover, the state of the original VM on the source host is not affected in any way. If 
you need to test the VM replica and its restore points for recoverability, you can perform failover while 
the original VM is running. After all necessary tests, you can undo failover and get back to the normal 
mode of operation. 

It is recommended that you always use Veeam Backup & Replication to perform failover operations. 
Avoid powering on a replica manually — this may disrupt further replication operations or cause loss 
of important data.  

The failover operation is performed in the following way: 

1. Veeam Backup & Replication rolls back the VM replica to the required restore point. To do 
this, it reverts the VM replica to the necessary snapshot in the replica chain. 

2. Veeam Backup & Replication powers on the VM replica. The state of the VM replica is changed 
from Normal to Failover. If you perform failover for testing or DR simulation purposes, and the 
original VM still exists and is running, the original VM remains powered on. 

3. Veeam Backup & Replication temporarily puts replication activities for the original VM on 
hold (until the VM replica is returned to the Normal state). 

4. All changes made to the VM replica while it is running in the Failover state are written to the 
delta file of the snapshot, or restore point, to which you have selected to roll back.  

 

In Veeam Backup & Replication, the actual failover is considered a temporary stage that should be 
further finalized. While the replica is in the Failover state, you can undo failover, perform failback or 
perform permanent failover. In a disaster recovery scenario, after you test the VM replica and make 
sure the VM runs stable, you should take another step to perform permanent failover. 
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Permanent Failover 

To finalize the failover process, you can permanently fail over to the VM replica. 

When you perform permanent failover, you “commit" failover. You can perform this operation if you 
want to permanently switch from the original VM to a VM replica and use this replica as the original 
VM. As a result of permanent failover, the VM replica ceases to exist as a replica and takes on the role 
of the original VM. 

The permanent failover scenario is acceptable if the original VM and VM replica are located in the 
same site and are nearly equal in terms of resources. In this case, users will not experience any latency 
in ongoing operations. 

The permanent failover operation is performed in the following way: 

1. Veeam Backup & Replication removes snapshots (restore points) of the VM replica from the 
snapshot chain and deletes associated files from the datastore. Changes that were written to 
the snapshot delta file are committed to the VM replica disk files to bring the VM replica to 
the most recent state. 

2. Veeam Backup & Replication removes the VM replica from the list of replicas in the 
Veeam Backup & Replication console. 

3. To protect the VM replica from corruption after permanent failover is complete, 
Veeam Backup & Replication reconfigures the replication job and adds the original VM to the 
list of exclusions. When the replication job starts, the original VM is skipped from processing. 
As a result, no data is written to the working VM replica. 
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Undo Failover 

To revert a VM replica to its pre-failover state, you can undo failover. 

When you undo failover, you switch back from the VM replica to the original VM. 
Veeam Backup & Replication discards all changes made to the VM replica while it was in the Failover 
state. You can use the undo failover scenario if you have failed over to the VM replica for testing and 
troubleshooting purposes and want to get back to the normal operation mode. 

The undo failover operation is performed in the following way: 

1. Veeam Backup & Replication reverts the VM replica to its pre-failover state. To do this, 
Veeam Backup & Replication powers off the VM replica and gets it back to the state of the 
latest snapshot in the snapshot chain. Changes that were written to the snapshot delta file 
while the VM replica was in the Failover state are discarded. 

2. The state of the VM replica gets back to Normal, and Veeam Backup & Replication resumes 
replication activities for the original VM on the source host. 
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Failover Plan 

If you have a number of VMs running interdependent applications, you need to failover them one by 
one, as a group. To do this automatically, you can prepare a failover plan.  

In a failover plan, you set the order in which VMs must be processed and time delays for VMs. The time 
delay is an interval of time for which Veeam Backup & Replication must wait before starting the 
failover operation for the next VM in the list. It helps to ensure that some VMs, such as a DNS server, 
are already running at the time the dependent VMs start. The time delay is set for every VM in the 
failover plan except the last VM in the list.  

The failover plan must be created in advance. In case the primary VM group goes offline, you can start 
the corresponding failover plan manually. When you start the procedure, you can choose to fail over 
to the latest state or select the point in time to which VM replicas must be started. 
Veeam Backup & Replication will look for the closest restore points to this point in time and use them 
to start VM replicas. 

The failover process is performed in the following way:  

1. For each VM, Veeam Backup & Replication detects its replica. The VMs whose replicas are 
already in Failover or Failback state are skipped from processing. 

2. The replica VMs are started in the order they appear in the failover plan within the set time 
intervals. 

 

  



 

201   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Limitations for Failover Plans 

The maximum number of VMs that can be started simultaneously when you run a failover plan is 10. If 
you have added more VMs to the failover plan and scheduled them to start simultaneously, 
Veeam Backup & Replication will wait for the first VMs in the list to fail over and then start the failover 
operation for subsequent VMs. This limitation helps reduce the workload on the production 
infrastructure and backup server. 

For example, if you have added 14 VMs to the failover plan and scheduled them to start at the same 
time, Veeam Backup & Replication will start the failover operation for the first 10 VMs in the list. After 
the 1st VM is processed, Veeam Backup & Replication will start the failover operation for the 11th VM in 
the list, then for the 12th VM and so on. 

Finalizing Failover Plans 

Failover is a temporary intermediate step that needs to be finalized. The finalizing options for a group 
failover are similar to a regular failover: undoing failover, permanent failover or failback.  

If you decide to commit failover or failback, you need to process every VM individually. Although you 
can undo failover for the whole group using the undo failover plan option. 

Undoing the failover switches the replica back to the primary VM discarding all changes that were 
made to the replica while it was running. When you undo group failover, Veeam Backup & Replication 
uses the list of VMs that were failed over during the last failover plan session and switches them back 
to the primary VMs. If some of the VMs were already failed back, for example manually by the user, 
they are skipped from processing. 

Veeam Backup & Replication starts the undo failover operation for a group of 5 VMs at the same time. 
The time interval between the operation starts is 10 seconds. For example, if you have added 10 VMs 
to the failover plan, Veeam Backup & Replication will undo failover for the first 5 VMs in the list, then 
will wait for 10 seconds and undo failover for the remaining 5 VMs in the list. Time intervals between 
the operation starts help Veeam Backup & Replication reduce the workload on the production 
environment and backup server. 

  



 

202   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Planned Failover 

If you know that your primary VMs are about to go offline, you can proactively switch the workload to 
their replicas. A planned failover is smooth manual switching from a primary VM to its replica with 
minimum interrupting in operation. You can use the planned failover, for example, if you plan to 
perform datacenter migration, maintenance or software upgrade of the primary VMs. You can also 
perform planned failover if you have an advance notice of a disaster approaching that will require 
taking the primary servers offline. 

When you start the planned failover, Veeam Backup & Replication performs the following steps: 

1. The failover process triggers the replication job to perform an incremental replication run and 
copy the un-replicated changes to the replica. 

2. The VM is powered off. 

3. The failover process triggers the replication job to perform another incremental replication 
run and copy the portion of last-minute changes to the replica. The replica becomes fully 
synchronized with the source VM. 

4. The VM is failed over to its replica.  

5. The VM replica is powered on. 

 

As the procedure is designed to transfer the current workload to the replica, it does not suggest 
selecting a restore point to switch. 

During the planned failover, Veeam Backup & Replication creates 2 helper restore points that are not 
deleted afterwards. These restore points will appear in the list of restore points for this VM; you can 
use them later to roll back to the necessary VM replica state. 

When your primary host is online again, you can switch back to it. The finalizing options for a planned 
failover are similar to those of an unplanned failover: undoing failover, permanent failover or failback.  

Note: 

 

During planned failover, Veeam Backup & Replication always retrieves VM data from the production 
infrastructure, even if the replication job uses the backup as a data source. This approach helps 
Veeam Backup & Replication synchronize the VM replica to the latest state of the production VM. 
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Limitations for Planned Failover 

If you start planned failover for several VMs that are replicated with one replication job, these VMs will 
be processed one by one, not in parallel. 

Replica Failback 

If you want to resume operation of a production VM, you can fail back to it from a VM replica. When 
you perform failback, you get back from the VM replica to the original VM, shift your I/O and processes 
from the target host to the production host and return to the normal operation mode.  

If you managed to restore operation of the source host, you can switch from the VM replica to the 
original VM on the source host. If the source host is not available, you can restore the original VM to a 
new location and switch back to it. Veeam Backup & Replication offers three failback options: 

 You can fail back to a VM in the original location on the source host. 

 You can fail back to a VM that has been restored up-front from the backup in a new location. 

 You can fail back to an entirely new location by transferring all VM replica files to the selected 
destination. 

The first two options help you decrease recovery time and use of the network traffic: 
Veeam Backup & Replication needs to transfer only differences between the original VM and VM 
replica. The third option can be used if there is no way to use the original VM or restore the VM from 
the backup before performing failback. 

If you fail back to an existing original VM, Veeam Backup & Replication performs the following 
operations: 

1. If the original VM is running, Veeam Backup & Replication powers it off. 

2. Veeam Backup & Replication creates a working failback snapshot on the original VM. 

3. Veeam Backup & Replication calculates the difference between disks of the original VM and 
disks of the VM replica in the Failover state. Difference calculation helps 
Veeam Backup & Replication understand what data needs to be transported to the original 
VM to synchronize it with the VM replica. 

4. Veeam Backup & Replication transports changed data to the original VM. Transported data is 
written to the delta file of the working failback snapshot on the original VM.  

5. Veeam Backup & Replication powers off the VM replica. The VM replica remains powered off 
until you commit failback or undo failback. 

6. Veeam Backup & Replication creates a failback protective snapshot for the VM replica. The 
snapshot acts as a new restore point and saves the pre-failback state of the VM replica. You 
can use this snapshot to return to the pre-failback state of the VM replica afterwards. 

7. Veeam Backup & Replication calculates the difference between the VM replica and the 
original VM once again and transports changed data to the original VM. A new 
synchronization cycle lets Veeam Backup & Replication copy a portion of last-minute changes 
made on the VM replica while the failback process was being performed. 

8. Veeam Backup & Replication removes the working failback snapshot on the original VM. 
Changes written to the snapshot delta file are committed to the original VM disks. 

9. The state of the VM replica is changed from Failover to Failback. Veeam Backup & Replication 
temporarily puts replication activities for the original VM on hold. 

10. If you have selected to power on the original VM after failback, Veeam Backup & Replication 
powers on the restored original VM on the target host. 
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If you fail back to an entirely new location, Veeam Backup & Replication performs the following 
operations: 

1. Veeam Backup & Replication transports all VM replica files and stores them on the target 
datastore. 

2. Veeam Backup & Replication registers a new VM on the target host. 

3. If you have selected to power on the original VM after failback, Veeam Backup & Replication 
powers on the restored original VM on the target host. 

In Veeam Backup & Replication, failback is considered a temporary stage that should be further 
finalized. After you test the recovered original VM and make sure it is working without problems, you 
should commit failback. You also have an option to undo failback and return the VM replica back to 
the Failover state. 

Failback on VSAN 

Due to specifics of VSAN data storage organization, Veeam Backup & Replication cannot get the 
difference between disks of a VM replica located on VSAN and disks of the original VM in a regular 
manner. Veeam Backup & Replication needs to read VM disks data anew in every failback process 
phase. As a result, failback for VMs replicas on VSAN slightly differs from the regular failback course. 

Before Veeam Backup & Replication starts the failback process, it checks the location of VM replica 
disks. If at least one disk is located on VSAN, Veeam Backup & Replication performs failback in the 
following way: 

1. Veeam Backup & Replication creates a working failback snapshot for the original VM.  

2. For every VM disk, Veeam Backup & Replication performs the following actions: 

a. If you fail back to the original VM location, Veeam Backup & Replication calculates the 
difference between the VM replica disk and the original VM disk. To do this, 
Veeam Backup & Replication reads the whole amount of disk data from VSAN, and 
transfers only changed data to the original VM side. 

b. If you fail back to a new location, Veeam Backup & Replication transfers the whole disk 
without calculating the difference.  

3. The VM replica is powered off.  



 

205   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

4. Veeam Backup & Replication creates a protective failback snapshot for the VM replica. Using 
the protective failback snapshot, Veeam Backup & Replication detects what changes took 
place on the VM replica while VM disk data was being transported. As well as before, 
Veeam Backup & Replication reads the whole amount of VM disks data but transports only 
those data blocks that have changed since the VM disks transfer.  

The rest of the failback process does not differ from the regular failback process. 

Commit Failback 

To confirm failback and finalize recovery of the original VM, you need to commit failback.  

When you commit failback, you confirm that you want to get back to the original VM. 
Veeam Backup & Replication gets back to the normal operation mode and resumes replication 
activities for the original VM to which you failed back. 

The commit failback operation is performed in the following way: 

1. Veeam Backup & Replication changes the state of the replica from Failback to Normal.  

2. Further operations depend on the location to which the VM is failed back: 

 If the VM replica is failed back to a new location, Veeam Backup & Replication 
additionally reconfigures the replication job and adds the former original VM to the 
list of exclusions. The VM restored in the new location takes the role of the original 
VM and is included into the replication job instead of the excluded VM. When the 
replication job starts, Veeam Backup & Replication will process the newly restored 
VM instead of the former original VM. 

 If the VM replica is failed back to the original location, the replication job is not 
reconfigured. When the replication job starts, Veeam Backup & Replication will 
process the original VM in the normal operation mode. 

During failback commit, the failback protective snapshot that saves the pre-failback state of a VM 
replica is not deleted. Veeam Backup & Replication uses this snapshot as an additional restore point 
for VM replica. With the pre-failback snapshot, Veeam Backup & Replication needs to transfer fewer 
changes and therefore puts less load on the network when replication activities are resumed. 
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Undo Failback 

If the original VM is not working as expected after the failback operation, you can undo failback and 
get back to the VM replica. 

The undo failback operation is performed in the following way: 

1. Veeam Backup & Replication deletes the protective failback snapshot on the VM replica. 
Changes that were made while the VM replica was in the Failback state are discarded.  

2. Veeam Backup & Replication powers on the VM replica and changes the VM replica state from 
Failback to Failover. 
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VM Copy 
With Veeam Backup & Replication, you can run a VM copy job to create an independent fully-
functioning copy of a VM or VM container on the selected storage. VM copying can be helpful if you 
want to move your datacenter, create a test lab and so on. 

The produced copy of a VM is stored uncompressed, in a native VMware vSphere format, so it can be 
started right away. Although VM copy is similar to replication in many respects, there are several 
important differences. 

 VM copy is a single-use process (that is, every run of a VM copy job mirrors a VM in its latest 
state). Due to their nature, VM copy jobs do not support incremental runs. 

 Veeam Backup & Replication does not create and maintain restore points for VM copies. If you 
schedule to run a VM copy job periodically, every new run will overwrite the existing copy. 

 With the VM copy job, all VM disks are copied as thick, while replication allows you to 
preserve the format of disks or convert the disk format on the fly. 

 There are no failover or failback possibilities for a VM copy. 

VM copy jobs use the same infrastructure components as backup jobs (for details, see Backup 
Architecture). In addition to available scenarios, you can also copy VMs to a target folder on any server 
or host connected to the backup server. 
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File Copy 
You can copy files and folders between and within servers connected to the backup server. For 
example, you can copy files from ESX(i) hosts to Microsoft Windows servers, Microsoft Windows 
servers to ESX(i) hosts, or directly from ESX(i) to ESX(i). File copying is the simplest and fastest way to 
move VMs and templates between datastores or deliver ISO files to ESX(i) hosts. 

For file copying operations, Veeam Backup & Replication offers a Windows Explorer-like user interface 
familiar to a Microsoft Windows user. You can copy files manually or schedule file copy jobs to run 
automatically by the defined schedule. 
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Quick Migration 
Veeam Quick Migration enables you to promptly migrate one or more VMs between ESX(i) hosts and 
datastores. Veeam Backup & Replication allows migration of VMs in any state with minimum 
disruption to business operations and end user access to services. You can use Quick Migration as a 
self-contained capability, solely for VM migration, or combine it with Instant VM Recovery. 

Veeam Backup & Replication analyzes your virtual environment, its configuration, the state of VMs and 
selects the most appropriate relocation method. Whenever possible, Veeam Backup & Replication 
coordinates its operations with vCenter Server and uses native VMware vCenter migration 
mechanisms: vMotion and Storage vMotion. When VMware vCenter migration methods cannot be 
used (for example, if your VMware vSphere license does not provide support for vMotion and Storage 
vMotion, or you need to migrate VMs from one standalone ESX(i) host to another), 
Veeam Backup & Replication uses its proprietary SmartSwitch technology to relocate VMs. 

Veeam Quick Migration provides means for fast background migration of VMs ensuring continuous 
uptime of your virtual environment. Quick Migration supports hot VM migration (with SmartSwitch) 
and cold VM migration (with cold switch). Both methods provide for no data loss during migration. 

Migration of a VM is performed in several stages: 

1. Veeam Backup & Replication copies VM configuration (.vmx) to the target host and registers 
the VM. 

2. Veeam Backup & Replication triggers a VM snapshot and copies VM disk content to the new 
destination. 

3. VM state and changes made after snapshot creation are moved to a new location. 
Veeam Backup & Replication uses different approaches to move the VM state between hosts 
with compatible and non-compatible CPUs. 

 If you move a VM between two hosts with compatible CPUs, 
Veeam Backup & Replication uses SmartSwitch. Veeam Backup & Replication 
suspends the VM to move its state file and changes made after snapshot creation. 
The VM is then resumed on the new host. This method ensures minimum possible 
VM downtime during migration. 

 If you move a VM between two hosts with non-compatible CPUs, 
Veeam Backup & Replication stops the VM, moves changes made after snapshot 
creation, and then starts the VM on the new host. 

Integration with Instant VM Recovery  
When you restore a VM using Instant VM Recovery, Veeam Backup & Replication starts the VM directly 
from a compressed and deduplicated backup file. To finalize recovery of a VM, you still need to move 
it to a new location. Moving the VM with VMware Storage vMotion or hot replication may require a lot 
of time and resources, or it may cause loss of valuable data. 

Veeam Quick Migration was designed to complement Instant VM Recovery. Instead of pulling data 
from vPower NFS datastore, Quick Migration registers the VM on the target host, restores the VM 
contents from the backup file located in the backup repository and synchronizes the VM restored from 
backup with the running VM. 
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Quick Migration Architecture 
Quick Migration architecture in a VMware vSphere environment comprises the following components: 

 Source host and target host with associated datastores 

 One or two backup proxy servers 

Similar to backup, Quick Migration uses two-service architecture: the source-side Veeam Data Mover 
Service interacts with the source host, and the target-side Veeam Data Mover Service interacts with 
the target host. To perform onsite migration, you can deploy one backup proxy for data processing 
and transfer. This backup proxy must have access to the source host and to the target host at the same 
time. In this scenario, the source-side Data Mover Service and the target-side Data Mover service are 
started on the same backup proxy. 

 

The common requirement for offsite migration is that one Data Mover Service runs in the production 
site (closer to the source host and datastore), and the other Data Mover Service runs in the remote 
target site (closer to the target host and datastore). During backup, the Data Mover Services maintain 
a stable connection, which allows for uninterrupted operation over WAN or slow links. 

For offsite migration, you need to deploy at least one local backup proxy in each site: a source backup 
proxy in the production site, and a target backup proxy in the remote target site. 
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SureBackup Recovery Verification 
SureBackup is Veeam’s technology that lets you test VM backups and make sure that you can recover 
data from them. Veeam Backup & Replication performs “live” verification of the VM backup: it 
automatically boots the VM from the backup in the isolated environment, performs tests for the VM, 
powers the VM off and creates a report about the recovery verification results. You can verify the latest 
restore point of the backup or any other restore point. 

Important! 

 

The recovery verification functionality is available in the Enterprise and Enterprise Plus Editions of 
Veeam Backup & Replication. If you use the Standard Edition, you can manually verify VM backups 
with Instant VM Recovery. For more information, see Manual Recovery Verification.  
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How SureBackup Works 
For SureBackup, Veeam Backup & Replication uses a regular image-based backup. During recovery 
verification, Veeam Backup & Replication performs the following actions: 

1. Veeam Backup & Replication publishes VMs from the application group and the verified VM in 
the isolated environment — virtual lab. VMs are started directly from compressed and 
deduplicated backup files that reside on the backup repository. To achieve this, 
Veeam Backup & Replication utilizes the Veeam vPower NFS Service.  

2. Veeam Backup & Replication performs a number of tests against VMs in the application group 
and verified VM: heartbeat test, ping test and application test. 

3. If the SureBackup job is configured to validate backup files, Veeam Backup & Replication 
performs a CRC check for the backup file from which the verified VM is started and, optionally, 
for backup files from which VMs in the application group are started. The backup file 
validation is performed after all verification tests are complete. 

4. When the recovery verification process is over, Veeam Backup & Replication unpublishes VMs 
and creates a report on their state. The report is sent to the backup administrator by email. 

 

During verification, a backed up VM image remains in read-only state. All changes that take place 
when the VM is running are written to redo log files that are stored on a datastore in the production 
environment. When the recovery process is complete, the redo logs are removed. 

Note: 

 

When Veeam Backup & Replication verifies VMs earlier than VMware vSphere 5.5 in the virtual lab, it 
sets VM disks to independent non-persistent. Changes made to VMs are written to redo logs. 

VDDK for VMware vSphere 6.0 does not support independent disks. For this reason, 
Veeam Backup & Replication takes a snapshot of the verified VM when the SureBackup job starts, and 
writes changes made to the VM to the delta file. By default, Veeam Backup & Replication deletes the 
snapshot when the SureBackup job completes.  

The snapshot commit process may take much time. If you do not want to commit the snapshot, you 
can create the HKEY_LOCAL_MACHINE\SOFTWARE\Veeam\Veeam Backup and 
Replication\SureBackup\RemoveVmSnapshot (REG_DWORD) registry key and set its value to 1. In this 
case, Veeam Backup & Replication will not delete the created VM snapshot, and the SureBackup job 
performance may improve. For more information, contact Veeam Support Team. 

To perform recovery verification, you need to create the following objects: 

1. Application group. During recovery verification, the verified VM is not started alone: it is 
started in a group of VMs on which it is dependent. The application group enables full 
functionality of applications running inside the VM and lets you run these applications just 
like in the production environment.  

2. Virtual lab. The virtual lab is the isolated virtual environment in which the verified VM and 
VMs from the application group are started and tested. 

3. SureBackup job. The SureBackup job is a task to perform recovery verification. You can run 
the SureBackup job manually or schedule it to run automatically by schedule. 
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Veeam vPower NFS Service 
To verify VM backups with SureBackup, Veeam Backup & Replication uses the vPower technology. The 
vPower technology enables the following features: 

 Recovery verification 

 Instant VM Recovery 

 Universal Application-Item Recovery (U-AIR) 

 Om-Demand Sandbox 

The key construct of the vPower technology is the vPower NFS Service. The vPower NFS Service is a 
Microsoft Windows service that runs on a Microsoft Windows machine and enables this machine to act 
as an NFS server.  

On the vPower NFS server, Veeam Backup & Replication creates a special directory — the vPower NFS 
datastore. When you start a VM from the backup, Veeam Backup & Replication "publishes" VMDK files 
of the VM from the backup on the vPower NFS datastore. Technically, Veeam Backup & Replication 
emulates the presence of VMDK files on the vPower NFS datastore — the VMDK files themselves are 
still located in the backup file on the backup repository.  

The vPower NFS datastore is then mounted to the ESX(i) host. As a result, the ESX(i) host can "see" 
backed up VM images via the vPower NFS datastore and work with them as with regular VMDK files. 
The emulated VMDK files function as pointers to the real VMDK files in the backup on the backup 
repository. 

vPower NFS Server Location 
If you store backups on a Microsoft Windows backup repository, it is strongly recommended that you 
enable the vPower NFS server on this backup repository. In this case, Veeam Backup & Replication will 
be able to set up a direct connection between the backup repository and ESX(i) to which the vPower 
NFS datastore is mounted. 

The Veeam vPower NFS service can also run on any Microsoft Windows server in the backup 
infrastructure, including the backup server itself. However, in this case the recovery verification 
performance may decrease. The connection between the ESX(i) host and backup repository will be 
split into two parts:  

1. From ESX(i) host to the vPower NFS server 

2. From the vPower NFS server to the backup repository 
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vPower-Specific Settings 
To establish a connection between the ESX(i) host and vPower NFS server, you must make sure that 
the ESX(i) host has a proper network interface configuration and can access the vPower NFS server. 

When connecting to the vPower NFS server, the ESX(i) host uses a VMkernel interface. For this reason, 
the ESX(i) host must have a VMkernel interface. Otherwise, Veeam Backup & Replication will fail to 
mount the vPower NFS datastore on the ESX(i) host. 

By default, VMkernel interfaces are not available for non-ESXi versions of VMware vSphere hosts. You 
will have to add them manually. 

 If the vPower NFS server and ESX host are located in the same network, the ESX host must 
have a VMkernel interface in the same IP network as the vPower NFS server. 

 If the vPower NFS server and ESX host are located in different networks and use a router for 
network access, in addition to creating a new VMkernel interface, you will have to manually 
specify routing settings in the IP routing table on the ESX host. 

Tip: 

 

To check if an ESX host can access the vPower NFS server, you can use the vmkping utility on the ESX 
host. The vmkping utility is similar to the ping tool. The only difference is that ICMP packets are sent 
via the VMkernel interface rather than the service console interface. 
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Backup Recovery Verification Tests 
To verify a VM, you can run predefined tests or perform your own tests against this VM. The 
predefined tests include the following ones:  

1. Heartbeat test. When the VM starts, Veeam Backup & Replication performs a heartbeat test. 
It waits for a heartbeat signal from VMware Tools installed inside the VM to determine that 
the VM guest OS is running. If the signal comes regularly at specific time intervals, the test is 
passed.  

2. Ping test. Veeam Backup & Replication sends ping requests to the VM from the backup server 
and checks if the VM can respond to them. If the VM responds to ping requests, the test is 
passed. 

3. Application test. Veeam Backup & Replication waits for applications inside the VM to start 
and runs a script that checks application-specific network ports. For example, to verify a 
domain controller, Veeam Backup & Replication probes port 389 for a response. If the 
response is received, the test is passed. 

Note: 

 

To run the heartbeat and ping tests, you must have VMware Tools installed inside the VM. If VMware 
Tools are not installed, these tests will be skipped. 

Backup File Validation 
In addition to recovery verification tests, Veeam Backup & Replication allows you to perform backup 
file validation. For backup file validation, Veeam Backup & Replication performs a CRC check for 
backup files of VMs verified by the SureBackup job. You can also validate backup files for VMs from the 
application group with this test. 

To validate the backup file, Veeam Backup & Replication uses the checksum algorithm. When 
Veeam Backup & Replication creates a backup file for a VM, it calculates a checksum for every data 
block in the backup file and stores this data in the backup file, together with VM data. During the 
backup file validation test, Veeam Backup & Replication de-compresses the backup file, re-calculates 
checksums for data blocks in the uncompressed backup file and compares them with initial checksum 
values. If the results match, the test is passed.  

The backup file validation test is started after recovery verification tests. As soon as 
Veeam Backup & Replication completes all "live" verification for all VMs in the SureBackup job, it 
unpublishes VMs and starts the backup file validation test. 
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The result of the backup file validation test impacts the state of the SureBackup job session. If the 
validation tests are completed successfully but the backup validation is not passed, 
Veeam Backup & Replication marks the SureBackup job session with the Warning or Error status. 
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Application Group 
In most cases, a VM works not alone but in cooperation with other services and components. To verify 
such VM, you first need to start all services and components on which this VM is dependent. To this 
aim, Veeam Backup & Replication uses the application group.  

The application group creates the “surroundings” for the verified VM. The application group contains 
one or several VMs on which the verified VM is dependent. These VMs run applications and services 
that must be started to enable fully functional work of the verified VM. Typically, the application group 
contains at least a domain controller, DNS server and DHCP server. 

When you set up an application group, you specify a role of every VM, its boot priority and boot delay. 
Additionally, you can specify what tests must be performed to verify VMs in the application group.  

When a SureBackup job is launched, Veeam Backup & Replication first starts in the virtual lab VMs from 
the application group in the required order and performs necessary tests against them. This way, 
Veeam Backup & Replication creates the necessary environment for the verified VM. Only after all VMs 
from the application group are started and tested, Veeam Backup & Replication starts the verified VM 
in the virtual lab. 

For example, if you want to verify a Microsoft Exchange Server, you need to test its functionality in 
cooperation with the domain controller and DNS server. Subsequently, you must add to the 
application group a virtualized domain controller and DNS server. When Veeam Backup & Replication 
runs a SureBackup job, it will first start and verify the domain controller and DNS server in the virtual 
lab to make verification of the Microsoft Exchange Server possible. 

Note: 

 

All VMs added to the application group must belong to the same platform — VMware or Hyper-V. 
Mixed application groups are not supported.  
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Virtual Lab 
The virtual lab is an isolated virtual environment in which Veeam Backup & Replication verifies VMs. In 
the virtual lab, Veeam Backup & Replication starts VMs from the application group and the verified VM. 
The virtual lab is used not only for the SureBackup verification procedure, but also for U-AIR and On-
Demand Sandbox. 

The virtual lab does not require that you provision extra resources for it. You can deploy the virtual lab 
on any ESX(i) host in your virtual environment. 

The virtual lab is fully fenced off from the production environment. The network configuration of the 
virtual lab mirrors the network configuration of the production environment. For example, if verified 
VMs and VMs from the application group are located in two logical networks in the production 
environment, the virtual lab will also have two networks. The networks in the virtual lab will be 
mapped to corresponding production networks.  

VMs in isolated networks have the same IP addresses as in the production network. This lets VMs in 
the virtual lab function just as if they function in the production environment.  
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Proxy Appliance 

To enable communication between the production environment and isolated networks in the virtual 
lab, Veeam Backup & Replication uses a proxy appliance. The proxy appliance is an auxiliary Linux-
based VM that is deployed on the ESX(i) host where the virtual lab is created. The proxy appliance VM 
is assigned an IP address from the production network and placed to the dedicated virtual lab folder 
and resource pool on the ESX(i) host. 

The proxy appliance is connected to the production network and to the isolated network and so has 
visibility of the production environment and virtual lab. In essence, the proxy appliance acts as a 
gateway between the two networks — it routes requests from the production environment to VMs in 
the virtual lab.  

To connect to isolated networks, the proxy appliance uses network adapters. 
Veeam Backup & Replication adds to the proxy appliance one network adapter per every isolated 
network. For example, if there are two networks in the virtual lab, Veeam Backup & Replication will 
add two network adapters to the proxy appliance. The network adapter gets an IP address from the 
isolated network. Typically, this IP address is the same as the IP address of the default gateway in the 
corresponding production network. 

The proxy appliance is an optional component for recovery verification. Technically, you can create a 
virtual lab without the proxy appliance. However, in this case, you will not be able to perform 
automatic recovery verification of VMs. VMs will be simply started from backups in the virtual lab; you 
will have to access them using the VM console and perform necessary tests manually. 
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IP Masquerading 

To let the traffic into the virtual lab, Veeam Backup & Replication uses masquerade IP addressing. 

Every VM in the virtual lab has a masquerade IP address, along with the IP address from the 
production network. The masquerade IP address resembles the IP address in the production network. 
For example, if the IP address of a VM is 172.16.1.13, the masquerade IP address may be 172.18.1.13. 

The masquerade IP address is an "entry point" to the VM in the virtual lab from the production 
environment. When you want to access a specific VM in the virtual lab, Veeam Backup & Replication 
addresses it by its masquerade IP address.  

 

The rules that route requests to VMs in the virtual lab are specified in the routing table on the server 
from which you want to access VMs in the virtual lab. The routing table can be updated on the 
following servers: 

 Backup server. Veeam Backup & Replication automatically creates the necessary static routes 
in the routing table on the backup server at the moment you launch a SureBackup job and 
Veeam Backup & Replication starts the virtual lab.  

 Client machine. If you want to provide your users with access to VMs in the virtual lab, you 
need to manually update routing tables on their machines and add new static routes. For 
more information, see Static IP Mapping. 

The added static route destines the masquerade network traffic to the proxy appliance. The proxy 
appliance acts as a NAT device: it resolves the masquerade IP address, replaces it with “real” IP address 
of the VM from the production network and then directs the request to the necessary VM in the virtual 
lab. The static route is non-persistent: when you power off the virtual lab, the route is removed from 
the routing table on the backup server or client machine.  
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For example, when trying to access a VM with IP address 172.16.10.10 in the isolated network, 
Veeam Backup & Replication sends a request to the masquerade IP address 172.18.10.10. According to 
the routing rule added to the IP routing table, all requests are first sent to the next hop — the proxy 
appliance. The proxy appliance performs address translation, substitutes the masquerade IP address 
with the IP address in the isolated network, and forwards the request to the necessary VM in the 
isolated network — in this example, to 172.16.10.10. 
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Static IP Mapping 

Sometimes it is necessary to provide many clients with access to a restored VM, which is especially the 
case for user-directed application item-level recovery. For example, you may want to provide users 
with access to the Microsoft Exchange Server started in the virtual lab via web-based access (like 
Outlook Web Access). Technically, you may update the routing table on every client machine; 
however, this will demand a lot of administrative effort. 

For such situations, Veeam Backup & Replication lets you get access to a VM in the virtual lab directly 
from the production environment. To access to a VM in the virtual lab, you must reserve a static IP 
address in the pool of production IP addresses and map this IP address to the IP address of a VM in the 
virtual lab.  

The static IP address is assigned to the proxy appliance network adapter connected to the production 
network. IP traffic directed to the specified static IP address is routed by the proxy appliance to the VM 
in the isolated network. 

 

 For example, for a VM with IP address 192.168.1.20 in the isolated network, you can reserve IP address 
192.168.1.99 (a free IP address from the production network). As a result, you will be able to use IP 
address 192.168.1.99 to access the VM in the virtual lab from the production side. 

You can also register an alias record in the production DNS server for the reserved IP address. For 
example, you can register backup.exchange.local as an alias for the IP address 192.168.1.99, and users 
will be able to access Microsoft Exchange Server by this alias. 
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Virtual Lab Configuration 

For SureBackup recovery verification, Veeam Backup & Replication offers two types of the virtual lab 
configuration: 

 Basic single-host virtual lab 

 Advanced single-host virtual lab 

Note: 

 

You can also verify VM backups in Advanced Multi-Host virtual labs with DVS. This scenario can be 
helpful if you want to test VM backups and VM replicas in the same virtual lab or want to add verified 
VM backups and replicas to the same SureBackup job. 
For more information, see Advanced Multi-Host Virtual Labs. 

Basic Single-Host Virtual Labs 

The basic single-host virtual lab can be used if all VMs that you want to verify, VMs from the 
application group and the backup server are connected to the same network. 

For the basic single-host virtual lab, Veeam Backup & Replication creates one virtual network that is 
mapped to the corresponding production network. Veeam Backup & Replication automatically adds a 
number of new objects on the ESX(i) host where the virtual lab is created: 

 A resource pool 

 A VM folder 

 A standard vSwitch 

The vSwitch is only used by the VMs started in the virtual lab. There is no routing outside the virtual 
lab to other networks. 

Veeam Backup & Replication automatically configures all settings for the basic single-host virtual lab. 
The proxy appliance is also created and configured automatically on the ESX(i) host where the virtual 
lab is created.  
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Advanced Single-Host Virtual Labs 

The advanced single-host virtual lab can be used if VMs that you want to verify and/or VMs from the 
application group are connected to different networks. 

In the advanced single-host virtual lab, Veeam Backup & Replication creates several virtual networks 
for the virtual lab. The number of virtual networks corresponds to the number of production networks 
to which verified VMs are connected. Networks in the virtual lab are mapped to production networks. 

Veeam Backup & Replication automatically adds a number of new VMware objects on the ESX(i) host 
where the virtual lab is created: 

 A resource pool  

 A VM folder 

 A standard vSwitch 

The vSwitch is only used by the VMs started in the virtual lab. There is no routing outside the virtual 
lab to other networks. 

When you create an advanced single-host virtual lab, Veeam Backup & Replication configures basic 
settings for networks that are created in the virtual lab. You need to review these settings and 
manually adjust them. 
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SureBackup Job 
A SureBackup job is a task for recovery verification. The SureBackup job aggregates all settings and 
policies of the recovery verification task, such as application group and virtual lab to be used, VM 
backups that must be verified in the virtual lab and so on. The SureBackup job can be run manually or 
scheduled to be performed automatically. 

When a SureBackup job runs, Veeam Backup & Replication first creates an environment for VM 
backups verification: 

1. Veeam Backup & Replication starts the virtual lab.  

2. In the virtual lab, it starts VMs from the application group in the required order. VMs from the 
application group remain running until the verified VMs are booted from backups and tested. 
If Veeam Backup & Replication does not find a valid restore point for any of VMs from the 
application group, the SureBackup job fails. 

3. When the virtual lab is ready, Veeam Backup & Replication starts verified VMs from the 
necessary restore point, tests and, depending on the job settings, verifies them one by one or 
creates several streams and tests a number of VMs simultaneously. If 
Veeam Backup & Replication does not find a valid restore point for any of verified VMs, 
verification of this VM fails, but the job continues to run. 

By default, you can start and test up to three VMs at the same time. You can also increase the number 
of VMs to be started and tested simultaneously. Keep in mind that if these VMs are resource 
demanding, performance of the SureBackup job as well as performance of the ESX(i) host on which 
the virtual lab resides may decrease. 

Once the verification process is complete, VMs from the application group are powered off. 
Optionally, you can leave the VMs from the application group running to perform manual testing or 
enable user-directed application item-level recovery. 

In some cases, the SureBackup job schedule may overlap the schedule of the backup job linked to it. 
The backup file may be locked by the backup job and the SureBackup job will be unable to verify such 
backup. In this situation, Veeam Backup & Replication will not start the SureBackup job until the 
corresponding backup job is over.  

To overcome the situation of job overlapping, you may chain the backup and SureBackup jobs or 
define the timeout period for the SureBackup job. For more information, see Specifying Job Schedule. 

Note: 

 

VMs from the application group and verified VMs must belong to the same platform — VMware or 
Hyper-V. Mixed scenarios are not supported.  
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SureBackup Job Processing 

The recovery verification process includes the following steps: 

1. Getting virtual lab configuration. Veeam Backup & Replication gets information about 
configuration of the virtual lab where verified VMs must be started. 

2. Starting virtual lab routing engine. Veeam Backup & Replication starts a proxy appliance 
used as a gateway to provide access to the virtual lab. 

3. Publishing. Veeam Backup & Replication creates a vPower NFS datastore with a VM backup 
and registers it on the selected ESX server. Veeam Backup & Replication does not deploy the 
whole VM from the backup file, it deploys VM configuration files only. Virtual disks are 
deployed per force and per required data blocks. 

4. Reconfiguring. Veeam Backup & Replication updates configuration files for VMs that must be 
started in the isolated network. 

5. Registering. Veeam Backup & Replication registers the verified VM on the selected ESX(i) 
host. 

6. Configuring DC. If a verified VM has the Domain Controller or Global Catalog role, the VM is 
reconfigured. 

7. Powering on. Veeam Backup & Replication powers on the verified VM in the isolated 
network. 

8. Performing heartbeat test. Veeam Backup & Replication checks whether the VMware Tools 
heartbeat signal (green or yellow) is coming from the VM or not. If the VM has no VMware 
Tools, the test is not performed, and a notification is written to the session details. 

9. Running ping tests. Veeam Backup & Replication checks if the VM responds to the ping 
requests or not. If the VM has no NICs and mapped networks for them and/or has no VMware 
Tools installed, the ping test is not performed, and a notification is written to the session 
details. 

10. Application initialization. Veeam Backup & Replication waits for the applications installed in 
the VM, for example, Microsoft SQL Server, to start. The application initialization period is 
defined in settings of the SureBackup job and by default equals to 120 sec. Depending on the 
software installed in a VM, the application initialization process may require more time than 
specified in the job settings. If applications installed in a VM are not initialized within the 
specified period of time, test scripts can be completed with errors. If such an error situation 
occurs, you need to increase the Application initialization timeout value and start the job 
once again. 

11. Running test scripts. Veeam Backup & Replication runs scripts to test whether the 
application installed in the VM is working correctly or not. If the VM has no VMware Tools 
installed and/or there are no NICs and mapped networks for them, 
Veeam Backup & Replication skips tests that use the %vm_ip% and %vm_fqdn% variables as 
the IP address and fully qualified domain name of the VM cannot be determined.  

Test results are written to the job session details. To define whether the script has completed 
successfully or not, Veeam Backup & Replication uses return codes. If the return code is equal 
to 0, the script is considered to complete successfully. Other values in the return code mean 
that the script has failed. 

12. Powering off. After all tests have been performed, Veeam Backup & Replication powers off 
the verified VM. 

13. Unregistering. Veeam Backup & Replication unregisters the verified VM on the selected 
ESX(i) host. 
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14. Clearing redo logs. Veeam Backup & Replication deletes redo logs from the datastore in the 
production environment. Redo logs store changes made to the VM while it is running from 
the backup file. 

15. Unpublishing. Veeam Backup & Replication unpublishes the content of the backup file on 
the ESX(i) host. 

16. Running backup validation test. After a VM has been verified, powered off and 
unpublished, Veeam Backup & Replication runs a CRC check to verify the VM backup at the 
file level and make sure that this file is not corrupted. 

17. Stopping virtual lab engine. Veeam Backup & Replication powers off the proxy appliance in 
the virtual lab. 

18. Deleting network routes. Veeam Backup & Replication deletes added network routes from 
the routing table on the backup server. 

Stabilization Algorithm 
To be able to perform tests for a verified VM without errors, Veeam Backup & Replication needs to 
know that the VM is ready for testing. To determine this, Veeam Backup & Replication waits for the VM 
to reach a stabilization point: that is, waits for the VM to boot completely and report it is ready for 
tests. After the stabilization point has been established, Veeam Backup & Replication can start 
performing heartbeat tests, ping tests and running test scripts against the VM.  

Veeam Backup & Replication establishes the stabilization point with the help of VMware parameters 
that it gets from the VM. Depending on the VM configuration, it uses one of three algorithms to do 
that: 

 Stabilization by IP. This algorithm is used if the VM has VMware Tools installed, there are 
NICs and mapped networks for these NICs. In this case, Veeam Backup & Replication waits for 
an IP address of the VM for mapped networks that is sent by VMware Tools running in the VM. 
The sent IP address must be valid and must not change for a specific period of time. For more 
information, see Recovery Verification Tests. 

 Stabilization by heartbeat. This algorithm is used if the VM has VMware Tools installed but 
there are no vNICs and mapped networks for them. In this case, Veeam Backup & Replication 
waits for a green or yellow heartbeat signal from the VM. The signal is sent by VMware Tools 
running in the VM. 

 Stabilization by Maximum allowed boot time. This algorithm is used if the VM has neither 
VMware Tools installed, nor NICs and mapped networks for them. In this case, 
Veeam Backup & Replication simply waits for the time specified in the Maximum allowed 
boot time field, which is considered to be a stabilization period for the VM. Once this time 
interval is exceeded, Veeam Backup & Replication considers that the VM is successfully 
booted and is ready for testing. 

When the stabilization point has been established, Veeam Backup & Replication runs ping, heartbeat 
tests and performs test scripts against the verified VM. 

The stabilization process cannot exceed the time specified in the Maximum allowed boot time field. 
If the stabilization point cannot be determined within the Maximum allowed boot time, the recovery 
verification process is finished with the timeout error. For this reason, you should be careful when 
specifying this value — typically, the VM started by the SureBackup job requires more time to boot if 
compared to a regular VM startup. When such an error situation occurs, you need to increase the 
Maximum allowed boot time value and start the job again. 
Once the stabilization point has been established, Veeam Backup & Replication runs ping, heartbeat 
tests and performs test scripts against the verified VM. 
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Manual Recovery Verification 
Beside automatic recovery verification, you can perform manual verification of VM backups. Manual 
verification can be performed with all editions of Veeam Backup & Replication. 

 To perform a VM boot test, you can perform Instant VM Recovery to start the VM. Power on 
the VM but do not connect the VM to the production network to avoid conflicts with the 
original VM. 

 To perform the application recovery test, you must first create an isolated network. After that, 
you can perform Instant VM Recovery to start the VM. At the Network step of the wizard, 
select to connect the VM to the created isolated network. The same procedure must be 
performed for all VMs that run applications on which the verified VM is dependent such as 
domain controller and DNS. All VMs must be connected to the same isolated network and 
started in the correct order: for example, DNS > domain controller > verified VM. 
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SureReplica Recovery Verification 
To guarantee recoverability of your data, Veeam Backup & Replication complements the SureBackup 
recovery verification technology with SureReplica.  

SureReplica is in many respects similar to the SureBackup recovery verification. It lets you validate 
your DR environment without impacting the production infrastructure. You can automatically verify 
every created restore point of every VM replica and ensure that they are functioning as expected.  

The SureReplica technology is not limited only to VM replica verification. Just like SureBackup, it 
provides the following capabilities: 

 SureReplica: automated VM replica verification 

 On-Demand Sandbox: an isolated environment for testing VM replicas, training and 
troubleshooting 

 U-AIR: recovery of individual items from applications running on VM replicas 

Important! 

 

The recovery verification functionality is available in the Enterprise and Enterprise Plus Editions of 
Veeam Backup & Replication. If you use the Standard Edition, you can manually verify VM backups 
with Instant VM Recovery. For more information, see Manual Recovery Verification.  
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How SureReplica Works 
SureReplica is Veeam’s technology that lets you test a VM replica for recoverability. To ensure that the 
VM replica is functioning properly, Veeam Backup & Replication performs its “live” verification. 
Veeam Backup & Replication automatically boots the VM replica from the necessary restore point in 
the isolated environment, performs tests against the VM replica, powers it off and creates a report on 
the VM replica state. 

The SureReplica technology does not require the vPower engine. A VM replica is essentially an exact 
copy of a VM with a set of restore points. The VM replica data is stored in the raw uncompressed 
format native to VMware. Therefore, to start a VM replica in the virtual lab, you do not need to present 
its data via the vPower NFS datastore to the ESX(i) host. Veeam Backup & Replication simply re-
configures the VM replica settings for recovery verification, connects the VM replica to the isolated 
virtual lab and powers it on.  

As there is no need to publish the VM from the backup file, the SureReplica processing is typically 
faster than SureBackup. Subsequently, the U-AIR and On-Demand Sandbox operations are faster, too. 

During VM replica verification, Veeam Backup & Replication performs the following actions: 

1. Veeam Backup & Replication triggers a VMware snapshot for a VM replica. The snapshot 
protects the VM replica from changes while it is running. All changes made to the VM replica 
are written to the delta file. 

2. Veeam Backup & Replication starts the VM replica in the virtual lab.  

3. Veeam Backup & Replication performs tests against the verified VM replica.  

4. When the verification process is over, Veeam Backup & Replication removes the delta file of 
the VM replica snapshot, powers off the VM replica and creates a report on its state. The 
report is sent to the backup administrator by email.  

 

Note: 

 

Veeam Backup & Replication verifies only VM replicas in the Normal state. If a VM replica is in the 
Failover or Failback state, the verification process fails. 
When Veeam Backup & Replication verifies the VM replica, it puts the VM replica to the SureBackup 
state. You cannot perform failback and failover operations for a VM replica in the SureBackup state 
until recovery verification or the U-AIR process is over and the VM replica returns to the Normal state. 
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To perform VM replica verification, you need to create the following objects: 

1. Application group. During recovery verification, the VM replica is not started alone: it is 
started together with VMs on which the VM replica is dependent. Starting a VM replica in 
conjunction with other VMs enables full functionality of applications running inside the VM 
replica and lets you run these applications just like in the production environment.  

2. Virtual lab. The virtual lab is the isolated virtual environment in which the VM replica and VMs 
from the application group are started and tested. 

3. SureBackup job. The SureBackup job is a task for VM replica verification process. You can run 
the SureBackup job manually or schedule it to run automatically by schedule.  
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Replica Recovery Verification Tests 
To verify a VM replica, Veeam Backup & Replication performs the same tests as for VM backup 
verification, except the backup validation test. You can run predefined tests or perform your own tests 
against VMs. The predefined tests include the following ones:  

 Heartbeat test 

 Ping test 

 Application test 

For more information, see Backup Recovery Verification Tests 
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Application Group 
Veeam Backup & Replication supports mixed application groups. You can add to the same application 
groups both VMs from backups and VMs from replicas. Keep in mind that all VMs from the application 
group must belong to the same platform — VMware or Hyper-V, and must have at least one valid 
restore point created by the time the SureBackup job starts. 

For more information, see Application Group. 
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Virtual Lab Configuration 
Veeam Backup & Replication offers three types of the virtual lab configuration for VM replica 
verification: 

 Basic single-host virtual lab 

 Advanced single-host virtual lab 

 Advanced multi-host virtual lab 

Basic Single-Host Virtual Labs 

The basic single-host virtual lab configuration can be used if your DR site is configured in the following 
way: 

 All VM replicas that you want to verify are registered on the same ESX(i) host.  

 All VM replicas that you want to verify are connected to the same network. 

Important! 

 

For this configuration type, the virtual lab must be created on the same ESX(i) host where VMs 
replicas are located. If you create the virtual lab on some other ESX(i) host, the SureBackup job will 
fail.  

For the basic single-host virtual lab, Veeam Backup & Replication creates one virtual network that is 
mapped to the production network. Additionally, Veeam Backup & Replication automatically adds a 
number of new VMware objects on the ESX(i) host where the virtual lab is created: 

 A resource pool  

 A VM folder 

 A standard vSwitch 

The vSwitch is only used by the VMs started in the virtual lab. There is no routing outside the virtual 
lab to other networks.  
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Veeam Backup & Replication automatically configures all settings for the basic single-host virtual lab. 
The proxy appliance is also created and configured automatically and placed to the virtual lab folder 
and resource pool on the ESX(i) host.  
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Advanced Single-Host Virtual Labs 

The advanced single-host virtual lab configuration can be used if your virtual environment is 
configured in the following way: 

 All VM replicas that you want to verify are located on the same ESX(i) host. 

 VM replicas you want to verify are connected to different networks. 

Important! 

 

For this configuration type, the virtual lab must be created on the same ESX(i) host where VMs 
replicas are located. If you create the virtual lab on some other ESX(i) host, the SureBackup job will 
fail.  

In the advanced single-host virtual lab, Veeam Backup & Replication creates several virtual networks. 
The number of virtual networks corresponds to the number of production networks to which verified 
VM replicas are connected. Networks in the virtual lab are mapped to corresponding production 
networks. 

Veeam Backup & Replication automatically adds a number of new VMware objects on the ESX(i) host 
where the virtual lab is created: 

 A resource pool  

 A VM folder 

 A standard vSwitch 

The vSwitch is only used by the VMs started in the virtual lab. There is no routing outside the virtual 
lab to other networks.  

When you create an advanced single-host virtual lab, Veeam Backup & Replication configures basic 
settings for networks that are created in the virtual lab. You need to review these settings and 
manually adjust them. 
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Limitations of Single-Host Virtual Labs 

If VM replicas are located on different hosts, you cannot use the single-host virtual lab configuration 
(basic or advanced). A single-host virtual lab uses standard vSwitches that have specific configuration 
limitations.  

When you create or edit a virtual lab, Veeam Backup & Replication creates a new port group for each 
isolated network in the virtual lab. All VMs in the isolated network are added to this port group. Such 
configuration helps differentiate the traffic passing through the standard vSwitch to the isolated 
network in the virtual lab.  

However, the standard vSwitch has a restriction: it is “limited” to one ESX(i) host. A standard vSwitch is 
configured on a specific ESX(i) host. The configuration of the standard vSwitch, such as information 
about port groups, resides on the ESX(i) host where the vSwitch is configured. Other ESX(i) hosts in the 
virtual environment do not have access to this information. 

 

For this reason, the single-host configuration can only be used if all VM replicas are registered on the 
same ESX(i) host. If attempt to verify VM replicas registered on different ESX(i) hosts in the single-host 
virtual lab, VMs from different port groups will not be able to “see” each other and communicate with 
each other.  

To overcome this limitation and verify VM replicas that are registered on different ESX(i) hosts, you can 
use advanced multi-host virtual labs. 
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Advanced Multi-Host Virtual Labs 

The advanced multi-host virtual lab configuration can be used if your DR site is configured in the 
following way: 

 VM replicas that you want to verify are located on different ESX(i) hosts. 

 VM replicas that you want to verify are connected to one or several networks. 

The advanced multi-host virtual lab leverages the VMware Distributed vSwitch (DVS) technology. For 
more information, see http://www.vmware.com/products/datacenter-
virtualization/vsphere/distributed-switch.html.  

 

When you configure an advanced multi-host virtual lab, you must select an ESX(i) host on which the 
proxy server will be created and a DVS on which Veeam Backup & Replication will create isolated 
network(s). Veeam Backup & Replication does not offer an option to automatically configure the DVS. 
The DVS must be pre-configured in your virtual environment. It is strongly recommended that you use  

Important! 

 

DVS is limited to one datacenter. For this reason, all verified VM replicas and VM replicas from the 
application group must belong to the same datacenter. If VM replicas belong to different 
datacenters, you will be able to start them in the virtual lab but Veeam Backup & Replication will not 
be able to automatically verify them. 

  

http://www.vmware.com/products/datacenter-virtualization/vsphere/distributed-switch.html
http://www.vmware.com/products/datacenter-virtualization/vsphere/distributed-switch.html
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Isolated Networks on DVS 

For every isolated network in the virtual lab, Veeam Backup & Replication adds a new DVS port group 
to the DVS. The added port group is named after the isolated network. 

The port groups created on the DVS must be isolated from the production environment. To isolate 
port groups, you can use one of the following methods: 

1. Connect DVS uplinks to the isolated network. You can link the DVS that you plan to use for 
recovery verification to an external isolated network using uplink adapters. This operation 
must be performed manually by the backup administrator.  

 

2. Use VLAN tagging. This method can be used only if your router supports VLAN ID tagging. 
When you specify settings for isolated networks in the New Virtual Lab wizard, you can 
define different VLAN IDs for different isolated networks. Setting VLAN IDs restricts 
communication of VM replicas in the isolated network from the production environment.  

Important! 

 

If the router does not support VLAN ID tagging or the virtual lab is configured incorrectly, VM replicas 
will be started in the virtual lab but Veeam Backup & Replication will not be able to automatically 
verify them. 
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Port Groups and VLAN IDs 

You need to be extremely careful when specifying port group and VLAN ID settings for the advanced 
multi-host virtual lab. 

Port Groups in Advanced Multi-Host Virtual Labs 

For the advanced multi-host virtual lab, Veeam Backup & Replication uses an existing DVS that was 
configured by the backup administrator beforehand. Veeam Backup & Replication creates a number of 
new port groups on the DVS, one per isolated network in the virtual lab.  

When Veeam Backup & Replication creates a new port group, it performs a check for the DVS selected 
for the virtual lab: 

 If a port group with the specified name already exists, Veeam Backup & Replication starts 
using it for the virtual lab. However, in this case, Veeam Backup & Replication will not be the 
owner of this port group.  

 If a port group with the specified name does not exist, Veeam Backup & Replication creates it 
and becomes the owner of the created port group. 

When a virtual lab is removed, Veeam Backup & Replication checks the ownership of the port group:  

 If Veeam Backup & Replication is not the owner of the port group, the port group remains on 
the DVS. Veeam Backup & Replication simply stops using it.  

 If Veeam Backup & Replication is the owner of the port group, Veeam Backup & Replication 
removes this port group from the DVS.  

Several virtual labs can use the same port group. For this reason, you should be extremely careful 
when removing virtual labs. If Veeam Backup & Replication is the owner of the virtual lab and the port 
group is removed, other virtual labs using this port group may fail to start.  
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VLAN IDs in Advanced Multi-Host Virtual Labs 

A DVS port group has VLAN ID settings. If you select an existing port group for the virtual lab, you 
must specify its VLAN ID in the virtual lab settings.  

 If VLAN ID settings are specified correctly, Veeam Backup & Replication will be able to 
configure the virtual lab and verify VM replicas in it.  

 If VLAN ID settings are specified not correctly, Veeam Backup & Replication will report an error 
informing that the selected port group exists but cannot be used due to incorrect VLAN ID 
settings. 



 

242   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

SureBackup Job for VM Replicas 
You can verify VM replicas with the SureBackup job. The SureBackup job aggregates all settings and 
policies of a recovery verification task, such as application group and virtual lab to be used, VM 
replicas that must be verified in the virtual lab and so on. The SureBackup job can be run manually or 
scheduled to be performed automatically. 

When a SureBackup job runs, Veeam Backup & Replication first creates an environment for VM replica 
verification: 

1. Veeam Backup & Replication starts the virtual lab.  

2. In the virtual lab, it starts VMs from the application group in the required order. VMs from the 
application group remain running until the verified VM replicas are booted and tested. If 
Veeam Backup & Replication does not find a successful VM replica or backup for any of VMs 
from the application group, the SureBackup job will fail. 

When the virtual lab is ready, Veeam Backup & Replication starts VM replicas from the necessary 
restore point, tests and, depending on the specified settings, verifies them one by one or creates 
several streams and tests VM replicas simultaneously. If Veeam Backup & Replication does not find a 
successful restore point for any of verified VM replicas, verification of this VM replica fails, but the job 
continues to run. 

By default, you can start and test up to three VM replicas at the same time. You can also increase the 
number of VMs to be started and tested simultaneously. Keep in mind that if these VMs are resource 
demanding, performance of the SureBackup job may decrease. 

When the verification process is complete, VMs from the application group are powered off. 
Optionally, you can leave the VMs from the application group running to perform manual testing or 
enable user-directed application item-level recovery. 

In some cases, the SureBackup job schedule may overlap the schedule of the replication job linked to 
it. The VM replica files may be locked by the replication job and the SureBackup job will be unable to 
verify such replica. In this situation, Veeam Backup & Replication will not start the SureBackup job until 
the replication job is over.  

To overcome the situation of job overlapping, you may chain the replication and SureBackup jobs or 
define the timeout period for the SureBackup job. For more information, see Specifying Job Schedule.  

Note: 

 

You can mix VM backups and replicas in the recovery verification job. For example, the application 
group may contain VMs that will be started from backup files and the job linked to the recovery 
verification job may be a replication job. Veeam Backup & Replication supports any type of a mixed 
scenario. Note that VMs that you verify with a SureBackup job must belong to the same platform — 
VMware or Hyper-V. 
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SureBackup Job for VM Replicas Processing 

The recovery verification process for VM replicas includes the following steps: 

1. Getting virtual lab configuration. Veeam Backup & Replication gets information about 
configuration of the virtual lab where verified VM replicas must be started. 

2. Starting virtual lab routing engine. Veeam Backup & Replication starts a proxy appliance. 
The proxy appliance is used as a gateway that provides access to VM replicas the virtual lab. 

3. Publishing. Veeam Backup & Replication triggers a protective VMware snapshot for the 
verified VM replica. 

4. Reconfiguring. Veeam Backup & Replication updates configuration files of the VM replica to 
connect the VM replica to the isolated network in the virtual lab. 

5. Configuring DC. If the VM replica has the Domain Controller or Global Catalog role, the VM 
replica is reconfigured. 

6. Powering on. Veeam Backup & Replication powers on the VM replica in the isolated network. 

7. Heartbeat test. Veeam Backup & Replication checks whether the green or yellow VMware 
Tools heartbeat signal is coming from the VM replica or not. If the VM replica has no VMware 
Tools, the test is not performed and a notification is written to the session details. 

8. Running ping tests. Veeam Backup & Replication checks if the VM replica responds to the 
ping requests or not. If the VM replica has no NICs and mapped networks for them and/or has 
no VMware Tools installed, the ping test is not performed and a notification is written to the 
session details. 

9. Application initialization. Veeam Backup & Replication waits for applications installed in the 
VM replica, for example, Microsoft SQL Server, to start. The application initialization period is 
defined in the properties of the SureBackup job and by default is equal to 120 sec. Depending 
on the software installed in a VM, the application initialization process may require more time 
than specified in the SureBackup job settings. If applications installed in a VM are not 
initialized within the specified period of time, test scripts can be completed with errors. If 
such error situation occurs, you need to increase the Application initialization timeout value 
and start the job once again. 

10. Running test scripts. Veeam Backup & Replication runs scripts to test whether the 
application installed in the VM replica is working correctly or not. If the VM replica has no 
VMware Tools installed and/or there are no NICs and mapped networks for them, 
Veeam Backup & Replication skips tests that use variables %vm_ip% and %vm_fqdn%, as the 
IP address of the VM cannot be determined. Test results are written to the session details. To 
define whether the script has completed successfully or not, Veeam Backup & Replication 
uses return codes. If the return code is equal to 0, the script is considered to complete 
successfully. Other values in the return code mean that the script has failed. 

11. Powering off. After all tests have been performed, Veeam Backup & Replication powers off 
the verified VM replica. 

12. Unpublishing. Veeam Backup & Replication deletes the protective VMware snapshot and 
rollbacks all changes made to the VM replica while it was running in the virtual lab. 

13. Stopping virtual lab engine. Veeam Backup & Replication powers off the proxy appliance in 
the virtual lab. 
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Stabilization Algorithm 
To perform tests for a VM replica without errors, Veeam Backup & Replication needs to know that the 
VM replica is ready for testing. To determine this, Veeam Backup & Replication waits for the VM replica 
to reach a "stabilization point": — the moment when the VM replica booteds and reports it is ready for 
tests. After the stabilization point has been reached, Veeam Backup & Replication can start heartbeat 
tests, ping tests and test scripts against the VM replica. 

Veeam Backup & Replication establishes the stabilization point with the help of VMware parameters 
that it gets from the VM replica. Depending on the VM replica configuration, it uses one of the three 
algorithms: 

 Stabilization by IP. This algorithm is used if the VM replica has VMware Tools installed, there 
are NICs and mapped networks for these NICs. In this case,Veeam Backup & Replication waits 
for an IP address of the VM replica for mapped networks that is sent by VMware Tools running 
in the VM replica. The sent IP address must be valid and must not change for a specific period 
of time. 

 Stabilization by heartbeat. This algorithm is used if the VM replica has VMware Tools installed 
but there are no NICs and mapped networks for them. In this case, 
Veeam Backup & Replication waits for the green or yellow heartbeat signal from VMware 
Tools installed inside the VM replica.  

 Stabilization by Maximum allowed boot time. This algorithm is used if the VM replica has 
neither VMware Tools installed, nor NICs and mapped networks for them. In this case, 
Veeam Backup & Replication will simply wait for the time specified in the Maximum allowed 
boot time field, which is considered to be a stabilization period for the VM replica. Once this 
time interval is exceeded, Veeam Backup & Replication considers that the VM replica is 
successfully booted and is ready for testing. 

Once the stabilization point has been established, Veeam Backup & Replication runs ping, heartbeat 
tests and test scripts against the verified VM replica. 

The stabilization process cannot exceed the value specified in the Maximum allowed boot time field. 
If the stabilization point cannot be determined within the Maximum allowed boot time, the recovery 
verification process will be finished with the timeout error. For this reason, you should be careful when 
specifying this value. Typically, a VM replica started by a recovery verification job requires more time 
to boot that a VM started regularly. When such error situation occurs, you need to increase the 
Maximum allowed boot time value and start the job again. 
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On-Demand Sandbox 
If you need to perform tests for production VMs, you can use an On-Demand SandboxTM. The On-
Demand Sandbox is an isolated virtual environment where you can start one or more VMs from 
backups, VM replicas or VMs from storage snapshots. You can use the On-Demand Sandbox to 
perform the following tasks: 

 Troubleshoot problems with VMs 

 Test software patches and upgrades 

 Install new software and so on 

The On-Demand Sandbox uses a virtual lab — an isolated environment that is fully fenced off from the 
production environment. VMs started in the virtual lab remain in the read-only state. All changes 
made to VMs are written to redo logs (for VM backups and storage snapshots) or saved to delta files 
(for VM replicas). Redo logs and delta files are deleted after you finish working with the On-Demand 
Sandbox and power it off. 

To create the On-Demand Sandbox, you must configure the following objects:  

 Virtual lab in which VMs will be started. For more information, see Virtual Lab. 

 Application group. The application group must include all VMs and/or VM replicas that you 
want to start in the On-Demand Sandbox. This can be one VM or a group of VMs that work 
together. For more information, see Application Group. 

 SureBackup job. The virtual lab and application group must be linked to this job. For more 
information, see SureBackup Job. 
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On-Demand Sandbox for Storage Snapshots 
In the On-Demand Sandbox, you can start VMs from snapshots existing on the production storage 
array. You can use the On-Demand Sandbox to test VMs, troubleshoot issues, perform training and so 
on. 

Veeam Backup & Replication offers the On-Demand Sandbox functionality for the following storage 
systems: 

 EMC VNX(e) 

 NetApp, including secondary NetApp arrays — NetApp SnapMirror and NetApp SnapVault 

 HPE 3PAR StoreServ 

 HPE StoreVirtual P4000 series and HPE StoreVirtual VSA (Virtual Storage Appliance) 

Configuration of the On-Demand Sandbox in which VMs from storage snapshots are started is similar 
to configuration of the regular On-Demand Sandbox. To start a VM from the storage snapshot in the 
isolated environment, you must configure the following objects: 

 Virtual lab. The virtual lab must mirror the networking scheme of the production 
environment. You can configure a new virtual lab or use an existing virtual lab. Any type of 
the virtual lab configuration is supported: basic single-host, advanced single-host or 
advanced multi-host. For more information, see Virtual Lab. 

 Application group. The application group must contain one or several VMs that you want to 
start in the On-Demand Sandbox. You can select VMs from volumes or LUNs on the storage 
system. During the SureBackup job, Veeam Backup & Replication will detect the latest 
snapshot for this volume or LUN and start the VM from this snapshot. For more information, 
see Application Group. 

 SureBackup job. You must link the application group with VMs and virtual lab to the 
SureBackup job. For more information, see SureBackup Job. 
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How On-Demand Sandbox for Storage Snapshots Works 
To start a VM from the storage snapshot in the On-Demand Sandbox, Veeam Backup & Replication 
needs to present this storage snapshot to an ESX(i) host as a datastore. To do this, 
Veeam Backup & Replication performs the following actions: 

1. Veeam Backup & Replication detects the latest storage snapshot for the VM whose disks are 
located on the storage system. 

2. Veeam Backup & Replication triggers the storage system to create a copy of the storage 
snapshot. The snapshot copy helps protect the storage snapshot from changes. 

To create a snapshot copy, Veeam Backup & Replication uses the same technology as for 
Veeam Explorer from Storage Snapshots. The technology choice depends on licenses 
installed on the storage system. For more information, see Veeam Explorer for Storage 
Snapshots. 

3. The snapshot copy is presented as a new datastore to the ESX(i) host on which the virtual lab 
is registered. 

4. Veeam Backup & Replication performs regular operations required for On-Demand Sandbox: 
reconfigures the VMX file, starts the VM, performs necessary tests for it and so on. For more 
information, see SureBackup Job Processing. 

5. After you finish working with VMs and power off the On-Demand Sandbox, 
Veeam Backup & Replication performs cleanup operations: powers off the VM and the proxy 
appliance in the virtual lab, unmounts the datastore from the ESX(i) host and triggers the 
storage system to remove the snapshot copy.  
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Number of Mounted NFS Datastores 
You can add to the application group several VMs that reside on different storage snapshots. In this 
case, Veeam Backup & Replication will trigger several snapshot copies (one per each storage snapshot) 
and present the equal number of datastores to the ESX(i) host.  

The number of NFS datastores that can be mounted to the ESX(i) host is limited by VMware vSphere. If 
number of snapshot copies is great, Veeam Backup & Replication may fail to present all of them as 
datastores to the ESX(i) host. In this case, VMs in the application group will not be started and the 
SureBackup job will fail. For more information about limitations, see 
http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId
=2239.  

To overcome this situation, Veeam Backup & Replication offers the mechanism of the snapshot copy 
re-mounting: 

1. If Veeam Backup & Replication detects that there is not enough resources to mount a 
datastore, it displays a warning and offers you to free up resources on the ESX(i) host. 

2. During the next 20 minutes, Veeam Backup & Replication attempts to mount the datastore 
with the time interval of 2 minutes.  

3. If resources are freed and Veeam Backup & Replication manages to mount the datastore, VMs 
in the application group are started and the SureBackup job continues to run. If resources on 
the ESX(i) hosts are not freed within 20 minutes, the SureBackup job fails. 

Limitations for On-Demand Sandbox for Storage Snapshots 
On-Demand Sandbox for storage snapshots has the following limitation: 

If a VM has several disks that are located on different datastores (and snapshots), 
Veeam Backup & Replication will register a temporary VM only with those disks that are located on the 
storage snapshot from which you added the VM. Other VM disks will be excluded from the VMX 
configuration file of the temporary VM. 

http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=2239
http://kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalId=2239
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Mixed Scenarios 
You can start VMs from different sources in the On-Demand Sandbox: 

 VM backups 

 VM replicas 

 VMs from storage snapshots 

For example, you can add VMs from backups and VMs from storage snapshots to the same application 
group and link a replication job to the SureBackup job. 

You cannot link jobs that trigger snapshots on storage arrays to the SureBackup job. This option is not 
supported. 

Type of Job/Object SureBackup SureReplica SureSnap 

Application group    

Linked job    
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Storage Systems Support 
You can take advantages of storage snapshots to build your data protection and disaster recovery 
plan. Veeam Backup & Replication integrates with the storage system and offers two technologies that 
will help you decrease impact from backup and replication operations on your production 
environment and significantly improve RPOs: 

 Backup from Storage Snapshots: you can use storage snapshots to create backups and 
replicas of VMware VMs residing on storage volumes. Backup from Storage Snapshots speeds 
up backup and replication operations and reduces the impact of VMware snapshot removal 
on the production environment. 

 Veeam Explorer for Storage Snapshots: you can restore data of VMware VM directly from 
storage snapshots. Veeam Explorer for Storage Snapshots automates the process of VM data 
recovery and reduces recovery time in 10 times or more. 

For NetApp storage systems, Veeam Backup & Replication offers two more possibilities: 

 You can back up VMs from storage snapshots on NetApp SnapMirror or SnapVault. 

 You can schedule creation of application-consistent snapshots with backup jobs. 

Tip: 

 

You can also start VMs whose disks are located on supported storage systems in the On-Demand 
Sandbox for testing, training, troubleshooting and so on. For more information, see On-Demand 
Sandbox for Storage Snapshots. 
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Backup from Storage Snapshots 
Backup from Storage Snapshots lets you speed up backup and replication for VMware VMs whose 
disks are located on the storage volumes. Backup from Storage Snapshots leverages storage 
snapshots for VM data processing. As a result, impact of backup and replication activities on the 
production environment reduces and RPOs improves. 

Note: 

 

The Backup from Storage Snapshots functionality is available only in the Enterprise Plus edition of 
Veeam Backup & Replication.  

Limitations for Backup from Storage Snapshots 
Backup from Storage Snapshots does not support vRDM disks. Such disks are skipped during Backup 
from Storage Snapshots. 

VM Data Processing 

Backup from Storage Snapshots introduces a different mode of data processing for VMware VMs 
whose disks are located on storage volumes or LUNs.  

Regular VM Data Processing 

In the regular processing course, Veeam Backup & Replication uses a VMware snapshot as a source of 
data for backup and replication. The VMware snapshot “freezes” the VM state and data at a specific 
point in time. As a result, the VM data is brought to a consistent state suitable for backup. 

During regular VM data processing, Veeam Backup & Replication performs the following actions: 

1. Veeam Backup & Replication triggers a VMware snapshot for a VM. VM disks are put to the 
read-only state and every virtual disk of the VM receives a delta file named like vmname-
00001.vmdk.  

2. Veeam Backup & Replication copies VM data from read-only disks of the VM. All changes that 
the user makes to the VM while backup or replication is performed are written to delta files.  

3. When VM processing is finished, the VMware snapshot is committed. VM disks resume writes, 
and data from delta files is merged to the VM disks. After data is merged, the VMware 
snapshot is removed. 

 

Regular VM data processing may take long. If backup or replication is performed for a VM running a 
highly transactional application, the delta file may grow very large. As a result, the snapshot commit 
process will take much time, and the VM may even freeze during this process. To overcome this 
situation, you can use Backup from Storage Snapshots. 
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Backup from Storage Snapshots 

Backup from Storage Snapshots lets you speed up backup and replication operations. For Backup 
from Storage Snapshots, Veeam Backup & Replication complements the VMware snapshot technology 
with snapshots on storage systems and uses storage snapshots as a source of data for backup and 
replication. 

During Backup from Storage Snapshots, Veeam Backup & Replication performs the following actions: 

1. Veeam Backup & Replication triggers a VMware snapshot for VMs whose disks are located on 
storage volumes or LUNs.  

2. Veeam Backup & Replication triggers a storage snapshot of the volume or LUN holding the 
VM itself and the created VMware snapshot.  

3. The VMware snapshot on the original storage volume is deleted immediately after the 
storage snapshot is created. To copy VM data, Veeam Backup & Replication accesses the 
‘cloned’ VMware snapshot on the storage snapshot.  

4. When VM processing is finished, the storage snapshot capturing the VMware snapshot is 
removed. 

As a result, the VMware snapshot exists for a very short time — for several seconds. Delta files do not 
grow large and the time of VMware snapshot commit decreases up in several times. 
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How Backup from Storage Snapshots Works 

To use Backup from Storage Snapshots, you must select the Enable backup from storage snapshots 
check box in the backup or replication job settings. 

 

When you run a job with Backup from Storage Snapshots enabled, Veeam Backup & Replication 
performs the following actions: 

1. When a backup or replication job starts, Veeam Backup & Replication analyzes which VMs in 
the job have their disks on storage volumes or LUNs, and triggers vCenter Server to create 
VMware snapshots for these VMs.  

2. Veeam Backup & Replication issues a command to the storage system to create a snapshot of 
the storage volume or LUN that holds VM disks and VMware VM snapshots. 

3. Veeam Backup & Replication gets Changed Block Tracking information for VMs on storage 
volumes or LUNs.  

4. Veeam Backup & Replication triggers vCenter Server to remove VMware VM snapshots on the 
production storage system. The “cloned” VMware VM snapshots still remain on the created 
storage snapshots.  

5. Veeam Backup & Replication checks the backup infrastructure and detects if there is a backup 
proxy that has a direct connection to the storage system. Veeam Backup & Replication 
mounts the storage snapshot as a new volume to this backup proxy. 

6. Veeam Backup & Replication reads and transports VM data blocks via the backup proxy to the 
backup repository. For incremental backup or replication, Veeam Backup & Replication uses 
obtained CBT data to retrieve only changed data blocks from the storage snapshot. 

7. When VM data processing is finished, Veeam Backup & Replication unmounts the storage 
snapshot from the backup proxy and issues a command to the storage system to remove the 
storage snapshot. 
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Mixed Job Scenarios 
Backup from Storage Snapshots is used only for those VMs whose disks are located on storage 
volumes. As backup and replication jobs typically contain a number of VMs that may reside on 
different types of storage, Veeam Backup & Replication processes data in mixed jobs in the following 
way: 

 If a job includes a number of VMs whose disks reside on different types of storage, 
Veeam Backup & Replication will use Backup from Storage Snapshots only for VMs with disks 
on storage volumes. Other VMs will be processed in a regular manner. 

 If a VM has several disks, some on the storage volumes or LUNs and some on another type of 
storage, Veeam Backup & Replication will not use Backup from Storage Snapshots to such VM. 
All disks of such VM will be processed in a regular manner.  

During a job, Veeam Backup & Replication processes VMs residing on different storage in different 
ways.  

1. Veeam Backup & Replication first triggers VMware VM snapshots and storage snapshots for 
VMs on storage volumes. 

2. After the storage snapshot has been created, Veeam Backup & Replication triggers VMware 
snapshots for other VMs. These VMs are processed in a regular manner further on, in parallel 
with VMs whose disks are located on storage volumes. 
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Backup from NetApp SnapMirror and SnapVault 

If the primary NetApp storage array is associated with a secondary array — NetApp SnapMirror and/or 
SnapVault, you can use the secondary storage array as a data source during backup. Backup from 
Storage Snapshots on NetApp SnapMirror or SnapVault reduces impact on the production storage. 
During backup, operations on VM data reading are performed on the side of NetApp SnapMirror or 
SnapVault, and the primary NetApp storage array is not affected. 

To back up VMs from storage snapshots on NetApp SnapMirror and SnapVault, you must configure 
the backup job to build a snapshot chain on the secondary storage array and instruct 
Veeam Backup & Replication to use the created snapshots as a data source. 
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How Backup from NetApp SnapMirror or SnapVault Works 

Backup from Storage Snapshots on NetApp SnapMirror or SnapVault is similar to Backup from Storage 
Snapshots on the primary NetApp storage array.  

1. Veeam Backup & Replication triggers a VMware snapshot for a VM whose disks are located on 
the primary NetApp storage array.  

2. Veeam Backup & Replication instructs NetApp to create an application-consistent storage 
snapshot on the primary NetApp storage array. The created snapshots holds the VMware VM 
snapshot. The VMware VM snapshot on the primary NetApp storage array is then deleted. 

3. The storage snapshot is transported from the primary NetApp storage array to NetApp 
SnapMirror or SnapVault. 

4. Veeam Backup & Replication checks if there is a backup proxy that has a direct connection to 
the NetApp SnapMirror or SnapVault. The transported storage snapshot is mounted to this 
backup proxy. 

5. The backup job retrieves VM data from the mounted storage snapshot. 

6. When the job finishes processing the VM, Veeam Backup & Replication instructs NetApp to 
delete a snapshot on the primary storage array. The transported snapshot on the secondary 
storage remains in the snapshot chain until it is removed by the retention policy. 
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Failover to Backup from Primary NetApp Storage Array 

In some cases, Veeam Backup & Replication may fail to back up VM data from storage snapshots on 
secondary storage arrays. This can happen, for example, if Veeam Backup & Replication cannot 
connect to NetApp SnapMirror or SnapVault or a license required for volume or LUN export is not 
installed on NetApp SnapMirror or SnapVault. 

To overcome this situation, you can instruct the backup job to fail over to the Backup from Storage 
Snapshots on the primary NetApp storage array. In this case, Veeam Backup & Replication will create a 
storage snapshot on the primary NetApp storage array and attempt to transport it to the secondary 
NetApp storage array. If the transport process fails, Veeam Backup & Replication will retrieve VM data 
from the created snapshot on the primary NetApp storage array. 
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Limitation on Number of VMs per Snapshot 

By default, during Backup from storage snapshots Veeam Backup & Replication creates VM snapshots 
for all VMs that reside on the same volume or LUN, and then triggers a storage snapshot for this 
volume or LUN. If the number of VMs on the volume or LUN is great, VM snapshot creation may take a 
lot of time. To speed up the backup or replication job processing, you can limit the number of VMs per 
storage snapshot. 

To limit the number of storage snapshots, you must enable the Limit processed VM count per 
storage snapshot to option and specify the number of VMs per snapshot in the job properties. 

 

With the limitation option enabled, Veeam Backup & Replication processes VMs in several cycles: 

1. Veeam Backup & Replication divides VMs into several groups.  

2. Veeam Backup & Replication triggers VM snapshots for VMs in the first group. 

3. Veeam Backup & Replication triggers a storage snapshot for the volume or LUN where VMs 
reside. 

4. Veeam Backup & Replication deletes VM snapshots for VMs in the first group. 

5. Veeam Backup & Replication copies data of VMs in the first group from the storage snapshot. 

6. Veeam Backup & Replication removes the storage snapshot. 

7. Steps 2-6 are repeated for every remaining group of VMs. 

For example, you add to the job 15 VMs whose disks are located on the same volume and set the 
Limit processed VM count per storage snapshot to option to 10. Veeam Backup & Replication will 
divide all VMs into 2 groups — a group of 10 VMs and group of 5 VMs. Then it will perform the data 
processing cycle for the first group of VMs. When VM data processing is over, 
Veeam Backup & Replication will start processing the second group of VMs. 
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Veeam Explorer for Storage Snapshots 
Veeam Explorer for Storage Snapshots is a technology in Veeam Backup & Replication that lets you 
restore VMware VM data directly from storage snapshots. Veeam Explorer for Storage Snapshots 
automates the process of data recovery for VMs residing on storage volumes, eliminates intermediate 
restore and manual operations. As a result, you can restore necessary VM data from storage snapshots 
in seconds. 

Restore options with Veeam Explorer for Storage Snapshots include the following ones:  

 Instant VM Recovery 

 VM guest OS files restore (Microsoft Windows, Linux, FreeBSD and other) 

 Restore of Microsoft Active Directory objects 

 Restore of Microsoft Exchange objects 

 Restore of Microsoft SharePoint objects 

 Restore of Microsoft SQL Server databases 

 Restore of Oracle databases 

Traditional Restore vs. Restore from Storage Snapshots 

Many organizations use storage snapshots for data protection. Storage snapshots allow for very low 
RPO: they have minimal impact on storage performance and can be created in seconds. 
Administrators can schedule snapshots to be created several times a day or even every hour. 

In virtual environments, restore from storage snapshots can be difficult. Storage snapshots are created 
per-volume; a volume typically holds data for several VMs. For this reason, restore from storage 
snapshots is not a simple rollback operation — it is a multi-task process. When an administrator 
restores a VM from the storage snapshot manually, he/she needs to perform the following actions: 

1. Present a storage snapshot to an ESX(i) host. 

2. Perform an HBA rescan. 

3. Mount the storage snapshot to the ESX(i) host. 

4. Browse the storage snapshot to locate VM files (VMDK). 

5. Add the VM to the inventory or copy VM files to another VMFS datastore. 

6. Power on the VM. 

7. Perform restore operations. 

8. Perform cleanup operations after VM data restore is completed. 

As a result, the restore process takes much time. If you need to restore guest OS files and application 
objects from a VM on the storage snapshot, the procedure will be even more complicated.  

Veeam Explorer for Storage Snapshots fully automates operations of mounting storage snapshots to 
ESX(i) hosts. You only need to select an ESX(i) host to which the storage snapshot will be mounted, 
and Veeam Explorer for Storage Snapshots will perform all other operations automatically. 

Veeam Explorer for Storage Snapshots does not convert storage snapshots into backups. It uses them 
“as is” and lets you restore VM data directly from native storage system snapshots. You do not have to 
to install any agents or perform additional configuration actions.  

  



 

260   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

How Restore from Storage Snapshots Works 

For restore operations, Veeam Backup & Replication uses a copy of the volume snapshot, not the 
volume snapshot itself.  

The volume snapshot copy is a read-write clone of the volume snapshot. The volume snapshot copy 
protects the VMFS volume metadata integrity on the volume snapshot. During file-level restore and 
Instant VM Recovery, the ESX(i) host to which the volume snapshot is mounted updates VMFS 
metadata on the volume snapshot. Use of the volume snapshot copy helps protect the volume 
snapshot from these changes.  

When you restore VM data from storage snapshots, Veeam Backup & Replication performs the 
following actions: 

1. The user starts the restore process for some VM on the storage snapshot.  

2. Veeam Backup & Replication triggers the storage system to create a copy or a clone of this 
storage snapshot.  

 If you restore several VMs from one storage snapshot, Veeam Backup & Replication 
does not create several snapshot copies. Instead, it uses one snapshot copy for 
restore. 

 If you start several restore operations (for example, Instant VM Recovery and VM 
guest OS restore) for the same VM from the storage snapshot, 
Veeam Backup & Replication creates several snapshot copies and works with them 
during restore. 

3. The user selects an ESX(i) host in the virtual environment, and the created snapshot copy is 
presented to this ESX(i) host as a new volume. The ESX(i) host is added to the list of Allowed 
Servers for the snapshot copy. As a result, the ESX(i) host has access to the snapshot copy and 
can read and write data to/from it. 

4. Veeam Backup & Replication makes sure that the IP address of the storage system is in the list 
of static targets on the ESX(i) host.  

5. The storage system issues an HBA re-scan command to the vCenter Server. Once rescan is 
finished, the snapshot copy appears in the discovered targets list on the ESX(i) host. After 
that, the storage system performs re-signature for storage volumes. 

6. The user performs necessary restore operations in the Veeam Backup & Replication console. 

7. After restore is completed, Veeam Backup & Replication issues a command to the storage 
system. The storage system deletes the snapshot copy from the ESX(i) host and performs 
cleanup operations. 
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Limitations for Restore from Storage Snapshots 
Restore from storage snapshots has the following limitation: 

[For Instant VM Recovery] If a VM has several disks that are located on different datastores (and 
snapshots), Veeam Backup & Replication will register a temporary VM only with those disks that are 
located on the storage snapshot from which you started the restore process. Other VM disks will be 
excluded from the VMX configuration file of the temporary VM. 
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Application-Consistent Snapshots (NetApp) 
During Backup from Storage Snapshots, Veeam Backup & Replication triggers NetApp to create 
temporary volume or LUN snapshots. Veeam Backup & Replication uses these snapshots as a data 
source for backup. Temporary storage snapshots created with Veeam Backup & Replication are 
application-consistent: they hold VM data in a consistent state and guarantee proper restore of 
application and services.  

You can use volume and LUN snapshots created with Veeam Backup & Replication to build a snapshot 
chain on the primary NetApp storage system, NetApp SnapVault and NetApp SnapMirror. 

To create application-consistent snapshots on NetApp storage systems, you must configure a backup 
job of the necessary type. Veeam Backup & Replication lets you configure two types of jobs: 

 Jobs creating storage snapshot only 

 Jobs creating backups on backup repositories and storage snapshots in secondary 
destinations 

Storage Snapshot Only Jobs 

The Storage Snapshot Only job is similar to scheduling automatic snapshot creation via the NetApp 
management console.  

When the backup job runs, Veeam Backup & Replication does not create Veeam backup files on the 
backup repository. It only triggers storage snapshots by the schedule defined in the job settings. This 
type of job let you create scheduled storage snapshots in the following destinations: 

 On the primary NetApp storage array where VM disks are located. 

 In the secondary destination — NetApp SnapMirror or SnapVault. 
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Storage Snapshots in Secondary Destination Jobs 

You can configure a backup job to create regular backup files on the backup repository and, 
additionally, populate a snapshot chain on NetApp storage systems with storage snapshots. 
Veeam Backup & Replication lets you create application-consistent storage snapshots in the following 
secondary destinations: 

 Primary NetApp storage array where VM disks are located 

 NetApp SnapMirror 

 NetApp SnapVault 

The backup job of this type is performed in the following way: 

1. Veeam Backup & Replication triggers vCenter Server to create a VMware snapshot for a VM. 

2. Veeam Backup & Replication instructs the NetApp storage system to create a temporary 
snapshot of a volume or LUN capturing VM disks and VMware VM snapshot. The VMware VM 
snapshot on the primary NetApp storage array is then deleted. 

3. Veeam Backup & Replication uses the temporary storage snapshot as a data source for 
backup and replication. 

4. After the backup or replication job is finished, the temporary volume snapshot is copied to 
the NetApp storage system and published as a new snapshot in the snapshot chain. 

5. After snapshot transport, Veeam Backup & Replication performs cleanup operations and 
removes the temporary snapshot on the primary NetApp storage array. 
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Requirements and Limitations 
Backup from Storage Snapshots and Veeam Explorer for Storage Snapshots have a set of limitations 
and requirements to storage systems. 

 EMC VNX/VNXe 

 NetApp 

Requirements and Limitations for EMC VNX/VNXe 

If you plan to perform backup and restore from EMC VNX/VNXe storage snapshots, consider the 
following limitations: 

EMC VNX Block 

 Veeam Backup & Replication supports LUNs that reside on Storage Pools.  

 To take LUN snapshots, Veeam Backup & Replication uses the VNX snapshot technology. 
Make sure that you have a license that covers the VNX snapshot technology. The SnapView 
snapshot technology is not supported. 

EMC VNX File 

 A read-only checkpoint can have only 1 writable snapshot. If a read-ony checkpoint already 
has a writable snapshot, Veeam Backup & Replication uses this writable snapshot for restore. 

 Writable snapshots are not detected by the storage rescan process and are not displayed in 
the storage system hierarchy. 

EMC VNXe 

 Veeam Backup & Replication does not support EMC VNXe Gen 1 OS (2.x.x). EMC VNXe Gen 2 
OS (3.x.x) is supported. 

 In EMC VNXe, you cannot export more than one storage snapshot for a LUN or LUN group at a 
time. If you start several tasks simultaneously, a task with a higher priority will terminate a 
task with a lower priority. In Veeam Backup & Replication, tasks have the following priority 
levels (starting with the top priority): restore task > backup job > rescan task. 

For example: 

– If a storage snapshot is used by a restore task and you start a backup job, the 
backup job will fail or fail over to a regular processing mode (in case failover is 
enabled in the job settings). 

– If a storage snapshot is used by a backup job and storage rescan starts at the same 
time, the rescan process will fail. 

– If a storage snapshot is used by a backup job and you start another backup job, the 
second backup job will wait for the first backup job to complete. 

EMC VNX(e) Working over NFS 

 VMs that you plan to back up or replicate must not have VMware snapshots. VMs with 
VMware snapshots will be skipped from Backup from Storage Snapshots. 

 If you enable the Enable VMware tools quiescence option in the job settings, 
Veeam Backup & Replication will not use Backup from Storage Snapshots to process running 
Microsoft Windows VMs that have VMware Tools installed. 
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Requirements and Limitations for NetApp 

Depending on the protocol type and operating mode of the NetApp storage system, 
Veeam Backup & Replication uses different technologies to perform the following operations: 

 Storage system rescan 

 Backup from Storage Snapshots 

 Restore from Storage Snapshots 

You may have to install additional NetApp licenses. You need to install one license, even if several 
technologies can be used for snapshot clone creation. 

Rescan of NetApp Storage System 

cDot 

Storage Type FlexClone SnapRestore No License 

Primary Storage System 

iSCSI/FC Possible (preferred) Possible Not possible 

NFS Possible Possible Possible 

Secondary Storage System: NetApp SnapMirror and SnapVault 

iSCSI/FC Possible Not possible Not possible 

NFS Possible Possible Possible 
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Backup from Storage Snapshots 

7-Mode 

Storage Type Traditional LUN Cloning (no 
license) FlexClone 

FC/iSCSI Possible Recommended 

NFS Not needed Not needed 

cDot 

Storage Type FlexClone SnapRestore No License 

Primary Storage System 

iSCSI/FC Possible (preferred) Possible Not possible 

NFS Possible Possible Possible 

Secondary Storage System: NetApp SnapMirror and SnapVault 

iSCSI/FC Possible (mandatory) Not possible Not possible 

NFS Possible Possible Possible 

Traditional LUN Cloning 

For NetApp storage systems that do not have the FlexClone license installed, 
Veeam Backup & Replication uses the NetApp traditional LUN cloning technology. Traditional LUN 
clones are created via a backing snapshot.  

1. Veeam Backup & Replication creates a backing snapshot for the LUN holding VM data. The 
backing snapshot is a snapshot of a volume where the LUN is located. The backing snapshot 
acts as a helper, or medium, for the LUN clone. It contains a momentarily image of the LUN 
and captures the exact state of a LUN at the necessary point in time. 

2. After that, Veeam Backup & Replication creates a LUN clone.  

The LUN clone bases on the backing snapshot and shares its data with the backing snapshot. 
Veeam Backup & Replication cannot delete the backing snapshot before the LUN clone is removed. 
Deletion of the backing snapshot will corrupt the LUN clone. 
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In case of traditional LUN cloning, backing snapshots created by Veeam Backup & Replication may be 
locked and may fail to be deleted automatically with cleanup operations. This can happen, for 
example, if you schedule the NetApp storage system to create daily volume snapshots, and the 
scheduled operation begins before Veeam Backup & Replication deletes the backing snapshot that 
was used for the backup or replication procedure.  

In this situation, the created backing snapshot will become a part of the snapshot chain. The 
scheduled snapshot and all subsequent snapshots will reference this snapshot, and 
Veeam Backup & Replication will be unable to remove it. As a result, your retention policy for 
scheduled snapshots may be disrupted. 

To avoid this situation, it is recommended that you install the FlexClone license on your NetApp 
storage system. In this case, Veeam Backup & Replication will use the FlexClone technology for LUN 
cloning. 

 

FlexClone 

The FlexClone technology lets you create a transparent, space-efficient copy of a LUN. FlexClones are 
created in seconds and require little space on the storage. Unlike traditional LUN clones, FlexClones 
are independent and do not cause any problems with volume snapshot deletion. 

For Backup from Storage Snapshots, Veeam Backup & Replication creates a FlexClone in the following 
way: 

1. Veeam Backup & Replication triggers NetApp to create a temporary snapshot of a volume 
hosting the LUN to capture the momentary state of this LUN.  

2. After that, Veeam Backup & Replication creates a LUN clone.  

This temporary volume snapshot is used as a base for a FlexClone. However, the base snapshot is not 
tied to the FlexClone as a backing snapshot in traditional LUN cloning. Veeam Backup & Replication 
can delete it without any impact for the FlexClone at any time. 
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NFS Protocol 

If the NetApp storage system operates over NFS, you do not have to install any additional licenses to 
use Backup from Storage Snapshots.  

For Backup from Storage Snapshots, Veeam Backup & Replication creates a snapshot of a volume on 
which the NFS share with VM data resides. The created volume snapshot is used as a source of data. 
Veeam Backup & Replication starts its native NFS agent on the backup proxy and uses it to read data 
from the “cloned” NFS share on the volume snapshot. 
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Restore from Storage Snapshots 

7-Mode 

Storage Type 
Traditional LUN 
Cloning 
(no license) 

FlexClone SnapRestore NDMP 

Only one license is required 

FC/iSCSI Possible Recommended Not possible Not possible 

NFS Not possible Recommended 

Limited usage. 
Veeam Backup & 
Replication 
transports all data 
before Instant VM 
Recovery, file-
level restore or 
application item 
restore starts.*** 

Limited usage. 
Veeam Backup & 
Replication 
transports all data 
before Instant VM 
Recovery, file-
level restore or 
application item 
restore starts.*** 

FC/iSCSI 
SnapMirror Not used Mandatory Not possible Not possible 

FC/iSCSI 
SnapVault Used for restore Mandatory (used 

for rescan*) Not possible Not possible 

NFS SnapMirror Not possible Recommended 

Limited usage. 
Veeam Backup & 
Replication 
transports all data 
before Instant VM 
Recovery, file-
level restore or 
application item 
restore starts.*** 

Limited usage. 
Veeam Backup & 
Replication 
transports all data 
before Instant VM 
Recovery, file-
level restore or 
application item 
restore starts.*** 

Several licenses are used 

NFS SnapVault Not possible 

For file-level 
restore and 
application item 
restore, 
Veeam Backup & 
Replication can 
use FlexClone**. 
For VM restore, 
Veeam Backup & 
Replication can 
use SnapRestore 
or NDMP (check 
columns on the 
right). 

Limited usage. 
Veeam Backup & 
Replication 
transports all data 
before Instant VM 
Recovery, file-
level restore or 
application item 
restore starts.*** 

Limited usage. 
Veeam Backup & 
Replication 
transports all data 
before Instant VM 
Recovery, file-
level restore or 
application item 
restore starts.*** 

* Not used for restore operations due to NetApp SnapVault limitations. 

** Can be used only for file-level restore. To enable restore, you must create the registry key 
NetApp7mUseFlexCloneForTargetSnapVaultRestore=1. For more information, contact Veeam Support 
Team. 
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*** Veeam Backup & Replication copies VM files from the /vol/volname/VMFolder/ folder from the 
snapshot to the /vol/vvolname/Veeam_Restore_VMname/VMFolder/ folder, and restore wizards work 
with copied files. 

cDot 

Storage Type FlexClone SnapRestore No License 

Primary Storage System 

iSCSI/FC Possible (preferred) Possible Not possible 

NFS Possible Possible Not possible 

Secondary Storage System: NetApp SnapMirror and SnapVault 

iSCSI/FC Possible (mandatory) Not possible Not possible 

NFS Possible (mandatory) Not possible Not possible 

Traditional LUN Cloning 

For NetApp storage systems that do not have the FlexClone license installed, 
Veeam Backup & Replication uses the NetApp traditional LUN cloning technology. 

During restore from storage snapshots, Veeam Backup & Replication creates a LUN clone using a 
storage snapshot from which you want to restore data as a backing copy. The LUN clone is then 
mounted to the ESXi host, and you can restore the necessary VM data from it using the 
Veeam Backup & Replication console.  
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FlexClone 

For NetApp storage systems that have the FlexClone license installed, Veeam Backup & Replication 
uses the NetApp FlexClone technology for restore from storage snapshots. 

During restore from storage snapshots, Veeam Backup & Replication creates FlexClone of a LUN using 
a storage snapshot from which you want to restore data as a base copy. The FlexClone is then 
mounted to the ESXi host, and you can restore the necessary VM data from it using the 
Veeam Backup & Replication console.  

 

SnapRestore 

For NetApp storage systems that have the SnapRestore license installed, Veeam Backup & Replication 
uses the NetApp SnapRestore technology for restore from storage snapshots. 

When you restore data from storage snapshot, Veeam Backup & Replication triggers NetApp to create 
a clone of a LUN via SnapRestore. To do this, NetApp restores LUN data to a new location on the 
volume where the original LUN is located. As a result, you have a read-write copy of the LUN holding 
VM data and can use it for restore operations. 
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NFS Protocol 

When you perform restore from storage snapshot on NetApp storage systems working over the NFS 
protocol, Veeam Backup & Replication triggers NetApp to clone an NFS share that holds VM data. 
NetApp creates a copy of the NFS share and places this copy on the same volume where the original 
NFS share is located. This copy is used as a data source restore operations. 

After the copy of the NFS share is created, Veeam Backup & Replication mounts the NFS share copy to 
the ESX(i) host as a new datastore.You can restore VM data from the mounted NFS share copy. 

If you have several VMs that reside on the same storage snapshot, Veeam Backup & Replication will 
create only one NFS datastore per snapshot. During restore, VMs from the same snapshot are copied 
to the same folder on the volume where the original NFS share is located. The folder is presented as a 
datastore to the ESX(i) host when you start the restore process for the first VM on the storage 
snapshot. The folder is unmounted from the ESX(i) host after you finish the restore process for the last 
VM on the storage snapshot. 

Veeam Backup & Replication uses different technologies to create a clone of the NFS share.  

7-mode: 

If the NetApp storage system operates in the 7-mode, you must have a FlexClone or SnapRestore 
license installed or the NDMP protocol enabled. 

Veeam Backup & Replication uses the following technologies for LUN clone creation: 

 If you have a FlexClone license installed, Veeam Backup & Replication uses the FlexClone 
technology. 

 If you have a SnapRestore license installed, Veeam Backup & Replication uses the SnapRestore 
technology. 

If neither FlexClone nor SnapRestore license is installed, Veeam Backup & Replication uses the NDMP 
protocol. If the NDMP protocol is not enabled, VM data restore will fail. 

Important! 

 

[For Instant VM Recovery] Veeam Backup & Replication performs actual Instant VM Recovery only if 
the FlexClone license is installed. If the SnapRestore license is installed or the NDMP protocol is 
enabled, Veeam Backup & Replication performs full VM restore instead of Instant VM Recovery, which 
takes more time.  
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C-mode: 

If the NetApp storage system operates in the C-mode, you must have a FlexClone or SnapRestore 
license installed. 

 If you have a FlexClone license installed, Veeam Backup & Replication uses the FlexClone 
technology. 

 If you have a SnapRestore license installed, Veeam Backup & Replication uses the SnapRestore 
technology. 

If neither FlexClone nor SnapRestore license is installed, Veeam Backup & Replication will fail to 
perform Restore from Storage Snapshots. 

 

Restore from SnapVault 
7-mode: 

If the NetApp storage system operates in the 7-mode, you must have a FlexClone or SnapRestore 
license installed or the NDMP protocol enabled. 

 If you have a SnapRestore license installed, Veeam Backup & Replication uses the SnapRestore 
technology. 

 If a SnapRestore license is not installed, Veeam Backup & Replication uses the NDMP protocol. 
If the NDMP protocol is not enabled, VM data restore will fail. 

Important! 

 

[For Instant VM Recovery] If you restore data from SnapVault, Veeam Backup & Replication performs 
full VM restore instead of Instant VM Recovery, which takes more time. 

 

C-mode: 

If the NetApp storage system operates in the C-mode, you must have a FlexClone license installed. In 
the opposite case, VM data restore will fail. 
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User Permissions 

The user account that you plan to use for work with the NetApp storage system must have the 
following permissions: 

7-Mode 

 login-http-admin 

 api-system-* 

 api-license-* (api-license-list-info) 

 api-volume-* 

 api-net-* 

 api-options-* 

 api-vfiler-* 

 api-qtree-* 

 api-nfs-* 

 api-snapshot-* 

 api-lun-* 

 api-iscsi-* 

 api-feature-* 

 api-registry-* 

 cli-options 

 api-fcp-* 

 api-file-* 

 api-igroup-* 

 api-clone-* 

 api-snapvault-* 

 api-snapmirror-* 

 api-cf-* 
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cDot 

Command/Directory Access/Query Level 

DEFAULT readonly 

cluster readonly 

fcp readonly 

file readonly 

igroup readonly 

iscsi readonly 

network readonly 

node readonly 

security readonly 

security login readonly 

set readonly 

snapmirror all 

system readonly 

version readonly 

qtree readonly 

lun all 

nfs all 

snapshot all 

volume all 

vserver all 
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vCloud Director Support 
Backup and restore of vCloud Director vApps and VMs has always been a hot topic. Up to now backup 
tools offered no option of backup in the vCloud Director environment. The only way was to perform 
backup at the level of the underlying vCenter Server. For restore, the administrators would first need 
to restore VMs to the vCenter Server level and then bring them to vCloud Director through import. 

Veeam Backup & Replication provides support for vCloud Director. It uses vCloud Director API to help 
you back up vApps and VMs and restore them directly to the vCloud Director hierarchy.  

The main entity with which Veeam Backup & Replication works during backup is a vApp. A vApp is a 
virtual system that contains one or more individual VMs along with parameters that define operational 
details — vApp metadata. When Veeam Backup & Replication performs backup of VMs, it captures not 
only data of VMs being a part of vApps, but also vApp metadata. As a result, you can restore vCloud 
Director objects back to the vCloud Director hierarchy and do not need to perform any additional 
actions on import and VM configuration. 
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Backup and Restore of vApps 
Veeam Backup & Replication provides you with an option to back up vCloud Director vApps and 
restore them back to the vCloud Director hierarchy. 

 In terms of vCloud Director, a vApp is a coherent system that contains one or more VMs. Every vApp is 
described with a set of operational details, or vApp metadata, that include the following ones: 

 vApp owner settings 

 Access rights settings 

 vApp network settings: information about organization networks to which the vApp is 
connected 

 Lease settings and so on 

When Veeam Backup & Replication performs backup of a vApp, it backs up all VMs being a part of this 
vApp along with the vApp metadata. Backup of the vApp is performed with the vCD backup job. The 
vCD backup job may contain one or several vApps. If necessary, you can exclude specific VMs and VM 
disks from the backup when configuring a vCD backup job. 

Veeam Backup & Replication offers the following restore options for backed up vApps: 

 Restoring vApps to vCloud Director 

 Restore of separate VMs being a part of the vApp to vCloud Director 

Note: 

 

Just like vCloud Director, Veeam Backup & Replication treats a vApp as a coherent system. For this 
reason, it is recommended that you add entire vApps, not separate VMs from the vApp, to the vCD 
backup job. If you do not want to back up specific VMs in the vApp, you can use exclusion settings in 
the vCD job.  
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Backup of vCloud Director VMs 
Veeam Backup & Replication lets you perform backup for vApps and VMs, as well as VM containers in 
vCloud Director such as Organization vDC, Organization and even the vCloud Director instance.  

When Veeam Backup & Replication performs backup of vApps and VMs, it additionally captures vApp 
metadata.  

vApp metadata includes: 

 General information about the vApp where VMs reside, such as: vApp name, description, VMs 
descriptions 

 Information about vApp networks and organization networks to which the vApp is 
connected 

 VMs startup options 

 User information 

 Lease 

 Quota 

 Storage template and so on 

vApp metadata is stored together with the VM content. Capturing vApp metadata is extremely 
important for restore: without it, you will not be able to restore vApps and VMs back to vCloud 
Director. 

Data to Back Up 

With Veeam Backup & Replication, you can back up regular VMs and linked clone VMs. 

Backup of Regular VMs 

When you perform backup of regular VMs, Veeam Backup & Replication captures and stores to the 
backup file the following data: 

 VM disk content 

 vApp metadata 

 VM metadata 

 

  



 

279   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Backup of Linked Clone VMs 

When you perform backup of linked clone VMs, Veeam Backup & Replication captures and stores to 
the backup file the following data: 

 Content of the template to which the VM is linked 

 Content of the VM user disk — delta disk 

 vApp metadata 

 VM metadata 

 

During full backup of linked clone VMs, Veeam Backup & Replication consolidates data of the VM 
template and delta disk and saves it as a regular VM disk in the backup file. Data merging guarantees 
proper VM restore: even if a VM template is lost by the time of recovery, you will still be able to restore 
the linked clone VM from the backup.  

During incremental backup, Veeam Backup & Replication saves only changed data of the delta file.  

vCD Backup Jobs 

For VMs managed by vCloud Director, Veeam Backup & Replication offers a special type of the backup 
job — vCD backup job. vCD backup jobs have been specifically developed to process vCloud Director 
objects, ensure their proper restore and support of vCloud-specific features.  

You should always use vCD backup jobs to back up VMs managed by vCloud Director. If you back up 
VMs managed by vCloud Director using a regular backup job, Veeam Backup & Replication will 
perform backup at the level of the underlying vCenter Server and will not capture vApp metadata. As 
a result, you will not be able to restore a fully-functioning VM to vCloud Director.  



 

280   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Restore of vCloud Director VMs 
Veeam Backup & Replication enables full-fledged restore of VMs to vCloud Director. You can restore 
separate VMs to vApps, as well as VM data. 

For restore, Veeam Backup & Replication uses VM metadata saved to a backup file and restores specific 
VM attributes. As a result, you get a fully-functioning VM in vCloud Director, do not need to import the 
restored VM to vCloud Director and adjust the settings manually.  

Backed up objects can be restored to the same vCloud Director hierarchy or to a different vCloud 
Director environment. Restore options include: 

 Instant VM recovery 

 Full restore for vApps and VMs 

 Restore of VM disks  

 Restore of VM files 

 Guest OS file-level restore for VMs 

Restoring Regular VMs to vCloud Director 

If you restore regular VMs back to the vCloud Director hierarchy, the restore process includes the 
following steps: 

1. Veeam Backup & Replication uses the captured vApp metadata to define the vApp settings 
and VM initial location in the vCloud Director hierarchy.  

2. Veeam Backup & Replication restores VMs from the backup file to their initial location or to 
other location. Additionally, Veeam Backup & Replication restores all VM settings. 
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Restoring Linked Clone VMs to vCloud Director 

Veeam Backup & Replication lets you restore linked clone VMs – VMs that were deployed from a VM 
template using the fast provisioning technology. There are several mechanisms for processing linked 
clone VMs. 

Restore of Existing VMs 

If you are restoring a vCD linked clone VM that exists in the vCloud Director hierarchy, the restore 
process includes the following steps: 

1. Veeam Backup & Replication uses the captured vApp metadata to define the initial settings of 
the VM. 

2. Veeam Backup & Replication calculates a signature for the consolidated VM disk in the 
backup file (containing the VM template data and data of the delta file) and the signature for 
the VM existing in vCloud Director. Veeam Backup & Replication then compares the disk 
signatures to define what data blocks have changed. 

3. Veeam Backup & Replication restores only changed data blocks from the backup file and 
writes them to the user delta file. 
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Restore of Deleted VMs 

If you are restoring a VM that no longer exists in vCloud Director hierarchy, the restore process 
includes the following steps:  

1. Veeam Backup & Replication uses vCloud Director to create a new linked clone VM from the 
VM template that the user selects. The new VM has a blank user delta file. 

2. Veeam Backup & Replication calculates a signature for the consolidated VM disk in the 
backup file (containing the VM template data and data of the delta file) and the signature for 
the created VM in vCloud Director. Veeam Backup & Replication then compares the disk 
signatures to define what data blocks need to be restored. 

3. Veeam Backup & Replication restores only those data blocks that need to be restored from 
the backup file and writes them to the blank user delta file. 

By default, Veeam Backup & Replication links the VM to the same VM template that was used by the 
initial VM. During restore, Veeam Backup & Replication checks the settings of the VM template to 
which the restored VM is linked: verifies connection settings, makes sure the disk size coincide and so 
on. 
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Restore of Linked Clone VMs as Regular VMs 

In some cases, Veeam Backup & Replication can restore a VM from a backup file as a regular VM. This 
type of restore is accomplished in the following situations: 

• You have intentionally chosen to restore a linked clone VM as a regular VM. 

• You are restoring a VM to the Organization vDC which has the fast provisioning option 
disabled. 

• A VM template to which the restored VM should be linked is not accessible in the location to 
which the VM is restored. 

In this case, Veeam Backup & Replication uses the same algorithm as for restore of full VMs in the 
virtual environment. It retrieves the data of the consolidated VM disk from the backup file and restores 
the VM in the vCloud Director hierarchy. 
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Backup Copy 
The main backup purpose is to protect your data against disasters and VM failures. However, having 
just one backup does not provide the necessary level of safety. Your primary backup may get 
destroyed along with your production data, leaving you with no backup to restore from.  

Backup experts advise that to build a successful data protection and disaster recovery plan, you must 
follow the 3-2-1 rule:  

 3: You must have at least three copies of your data: the original production data and two 
backups. 

 2: You must use at least two different types of media to store the copies of your data, for 
example, local disk and cloud. 

 1: You must keep at least one backup offsite, for example, in the cloud or in a remote site. 

Thus, you must have at least two backups and they must be in different locations. If a disaster takes 
out your production data and local backup, you can still recover from your offsite backup.  

To help you adopt the 3-2-1 rule, Veeam Backup & Replication offers backup copy capabilities. Backup 
copy allows you to create several instances of the same backup data in different locations, whether 
onsite or offsite. Backup copies have the same format as those created by backup jobs and you can 
recover your data from them when you need it.  

Backup copy is a job-driven process. Veeam Backup & Replication fully automates the backup copy 
process and lets you specify retention settings to maintain the desired number of restore points, as 
well as full backups for archival purposes. 
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Backup Copying Process 
The backup copy job copies VM data per VM at the block level. That is, the backup copy job does not 
copy the whole VBK, VIB or VRB file from the source backup repository to the target backup repository. 
Instead, it works with data of separate VMs stored in these files. 

When the backup copying process starts, Veeam Backup & Replication accesses VM backup files in the 
source backup repository, retrieves data blocks for a specific VM from the backup file, copies them to 
the target backup repository and composes copied blocks into a backup file in the target backup 
repository. Therefore, the backup copying process does not affect virtual infrastructure resources, 
does not require an additional snapshot of a VM and does not produce any load on VMs whose 
backups are copied.  

In the target backup repository, the backup copy job creates a chain of restore points using the 
incremental backup method. The target backup repository always contains only one active 
incremental backup chain. Restore points in the chain are rotated according to the specified retention 
policy. For more information, see Retention Policy for Backup Copy Jobs.  

The backup chain on the target backup repository is created in the following manner: 

1. The first synchronization interval of the backup copy job always produces a full backup file. 
The full backup file is created in the following way: 

a. From the backup chain on the source backup repository, 
Veeam Backup & Replication copies data blocks that are necessary to build a full 
backup of a VM as of the most recent state. Data blocks can be copied from one or 
several backup files in the chain. If the backup chain on the source backup 
repository was created using the reverse incremental backup method, 
Veeam Backup & Replication simply copies data blocks of the latest full backup. 

 

If the backup chain on the source backup repository was created using the forward 
incremental backup method, Veeam Backup & Replication copies data blocks from 
the first full backup and a set of incremental backups to form a full backup of a VM 
as of the most recent state. 

 
 

b. On the target backup repository, Veeam Backup & Replication writes all copied data 
blocks to the same full backup file. 
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2. At every next synchronization interval, when a new restore point appears on the source 
backup repository, Veeam Backup & Replication copies incremental changes from this most 
recent restore point and transfers them to the target backup repository. On the target backup 
repository, Veeam Backup & Replication writes the copied data blocks to the incremental 
backup file. 

 

The backup copy job can be created for one VM or several VMs. If the backup copy job is created for 
several VMs, you can define the order in which the VMs should be processed. By default, 
Veeam Backup & Replication processes VMs in the job in parallel, starting from the first VM in the order 
list. If any VM cannot be processed for some reason, for example, in case a new restore point for this 
VM is not yet available, Veeam Backup & Replication will pass to the next VM. Once this VM is 
processed, Veeam Backup & Replication will attempt to copy the unprocessed VM once again.  

Note: 

 

If necessary, you can disable parallel data processing for backup copy jobs using the registry key. For 
more information, contact the Veeam Support Team. 

If you do not enable the Use per-VM backup files option for the target backup repository, 
Veeam Backup & Replication creates one backup file on the target backup repository and stores to it 
data for all VMs processed by the job. If the Use per-VM backup files option is enabled, data of every 
VM in the job is stored to separate backup files on the target backup repository. 

To minimize the amount of traffic going over the network, Veeam Backup & Replication uses the data 
compression and deduplication technologies. For more information, see Compression and 
Deduplication.  
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Restore Point Selection 

Veeam Backup & Replication does not necessarily use a backup created by one job and one backup 
repository as a source of data. It can copy VM data from backups created by different jobs and even 
from different backup repositories. When you set up a backup copy job, you only define what VM(s) 
you want to process. During the backup copy job, Veeam Backup & Replication searches for the most 
recent restore point in all available backup repositories, copies data blocks from it and saves them to a 
backup file on the target backup repository.  

 

You can specify a search scope for the backup copy job: that is, define in which backup repositories 
Veeam Backup & Replication should search for restore points. In this case, Veeam Backup & Replication 
will skip all other backup repositories from searching. 

Veeam Backup & Replication always copies the most recent restore point from the source backup 
repository. Even when backup copying is performed for the first time and the source backup 
repository already contains a chain of restore points, Veeam Backup & Replication will only copy a 
restore point containing data as of the most recent VM state. For more information, see Backup 
Copying Process. 

Veeam Backup & Replication identifies new restore points using the following rule: 

Time of restore point creation >= current time – synchronization interval 

For example, you have set the synchronization interval to 24 hours. Today’s date and time are 
7/1/2013, 12:00 PM and the restore point was created 23 hours ago, on 6/30/2013 at 1:00 PM. In this 
case, Veeam Backup & Replication will copy this new restore point, because: 

6/30/2013, 1:00 PM >= 7/1/2013, 12:00 PM – 24 hours 

The rule above is applied to all synchronization intervals, both the first one, copying a full backup file, 
and subsequent ones, copying incremental restore points. After you create a backup copy job and the 
first synchronization interval starts, Veeam Backup & Replication checks if there is some restore point 
falling into the necessary search scope on the source backup repository. If there is no restore point 
matching this condition, Veeam Backup & Replication will not copy data from the source backup 
repository. Instead, it will wait for the new restore point to appear on the source backup repository. 
Only after that Veeam Backup & Replication will copy the first, full restore point, to the target 
repository. This mechanism helps ensure that the backup chain produced by the backup copy job 
contains only the most recent VM data. 
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The backup copy job has the following limitations: 

 Veeam Backup & Replication does not copy restore points from the target backup repository. 

 Veeam Backup & Replication does not copy restore points from imported backups. 

 Veeam Backup & Replication does not copy restore points that have already been copied by 
the same backup copy job to the target backup repository. 

 Veeam Backup & Replication does not copy incomplete restore points. 

 Veeam Backup & Replication does not copy restore points that are locked by the backup 
transformation process (merge, transform). 

 [For target backup repositories with the Use per-VM backup files option disabled] 
Veeam Backup & Replication does not copy restore points if the block size of the restore point 
on the source backup repository differs from the block size of restore points on the target 
backup repository. 
The data block size for restore points on the target backup repository is set at the first 
synchronization cycle of the backup copy job. This size is taken from the corresponding 
settings of the primary backup job — the backup job that creates the backup chain on the 
source backup repository. If after the first synchronization cycle you add to the backup copy 
job new sources that use a different data block size, Veeam Backup & Replication will detect 
such restore points and display the Restore point is located in backup file with different block 
sizе message. 

[For target backup repositories with the Use per-VM backup files option enabled] One 
backup copy job can process VMs with different block sizes. However, the block size for one 
VM must always stay the same.  

For example, you have 2 source backups: Backup1 contains VM1 and Backup2 contains VM2. 
The block size for Backup1 is 1024 MB and block size for Backup2 is 512 MB. The Use-per VM 
backup files option is enabled for the target backup repository. In this case, one backup copy 
job will successfully process VMs from Backup1 and Backup2. However, if you change the 
block size for VM1 to 256 MB and create Backup3, the backup copy job will not be able to 
copy VM data from such backup. 

 If you select a backup job as a source for the backup copy job, Veeam Backup & Replication 
will only copy restore points created by this very backup job. Veeam Backup & Replication will 
not perform search in other backup repositories. 

Tip: 

 

You can configure several backup copy jobs to copy one restore point from the source backup 
repository to different target locations. 
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Data Transport Path 

To transport data from the source backup repository to the target backup repository, the backup copy 
job uses one of the following paths:  

 Direct transport path: Veeam Backup & Replication transports data directly from the source 
backup repository to the target backup repository. This type of data transport is 
recommended for copying backups to onsite backup repositories or offsite backup 
repositories over fast connections. 

When Veeam Backup & Replication transports VM data over the direct data path, it uses 
Veeam Data Mover Services on the following backup infrastructure components: 

– In case of Microsoft Windows and Linux repositories: Veeam Backup & Replication 
uses the source Veeam Data Mover Service on the source backup repository and 
target Veeam Data Mover Service on the target backup repository.  

 

– In case of CIFS share: if you have instructed Veeam Backup & Replication to 
automatically select the gateway server, Veeam Backup & Replication will use the 
Data Mover Services deployed on the backup server. If you have explicitly defined 
the gateway server, Veeam Backup & Replication will use the source Veeam Data 
Mover Service on the gateway server in the source site and target Veeam Data 
Mover Service on the gateway server on the target site. 
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 Through built-in WAN accelerators: Veeam Backup & Replication transports data through a 
pair of WAN accelerators: one deployed on the source side and the other one deployed on 
the target side. WAN accelerators remove redundant blocks before transferring VM data and 
thus significantly reduce the amount of traffic going over the network. This type of data 
transport is recommended for copying backups offsite over slow connections or WAN.  

When Veeam Backup & Replication transports VM data via WAN accelerators, it uses Veeam 
Data Mover Services on the following backup infrastructure components: 

– In case of Microsoft Windows and Linux repositories: Veeam Backup & Replication 
uses the source Veeam Data Mover Service on the source backup repository and 
target Veeam Data Mover Service on the target backup repository.  

– In case of CIFS share: if you have instructed Veeam Backup & Replication to 
automatically select the gateway server, Veeam Backup & Replication will use the 
Data Mover Services deployed the source and/or target WAN accelerator. If you 
have explicitly defined the gateway server, Veeam Backup & Replication will use the 
source Veeam Data Mover Service on the gateway server in the source site and 
target Veeam Data Mover Service on the gateway server on the target site. 

 

Important! 

 

The WAN acceleration technology is available only in the Enterprise Plus edition of 
Veeam Backup & Replication. For more information, see WAN Acceleration.  
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Backup Copy Job 
The backup copy job is a separate task that needs to be set apart from the backup job.  

The aim of the backup copy job is to copy a VM restore point from the source backup repository to the 
target backup repository. Every backup copy job creates its own folder on the target backup 
repository and stores to it all copied restore points. The folder has the same name as the backup copy 
job.  

The backup copy job runs continuously and has several phases: 

 Idle state. For the most time, the backup copy job remains in the idle state, waiting for a new 
restore point to appear on the source backup repository. 

 Synchronization process. The synchronization phase starts at a specific time interval. You 
can define any interval needed in minutes, in hours, in days.  
At the beginning of a new interval, Veeam Backup & Replication checks if a new restore point 
is available on the source backup repository: 

– If a new restore point is found, the backup copy job starts the synchronization 
process and copies the latest VM restore point from the source backup 
repository to the target backup repository.  

– If a new restore point is not found or is locked by the source backup job, the 
backup copy job is back to the idle state. 

 Transform operations. After the backup copying task or at the end of the synchronization 
interval, Veeam Backup & Replication can perform a number of additional transform 
operations on the target backup repository. Transform operations include three tasks: 

– Transforming a backup chain. When a new VM restore point is copied to the 
target backup repository, Veeam Backup & Replication checks the retention 
policy settings for the backup copy job. If the limit in restore points is 
exceeded, Veeam Backup & Replication transforms the backup chain to make 
room for a new restore point. For more information, see Retention Policy for 
Backup Copy Jobs.  
After the transform process, Veeam Backup & Replication can perform 
additional operations: remove data for deleted VMs from the backup chain and 
compact a full backup file.  

– Removing deleted VMs from restore points. In the backup copy job settings, 
you can select to maintain retention policy for deleted VMs. In this case, 
Veeam Backup & Replication will check the list of VMs included in the job and 
remove data for deleted VMs from the backup chain on the target backup 
repository. For more information, see Specifying Advanced Settings. 

– Compacting a full backup file. In the backup copy job settings, you can select 
to periodically compact a full backup file to reduce its size and increase the 
speed of read and write operations. For more information, see Compacting Full 
Backup File.  

 Post-job activities. In the properties of the backup copy job, you can select to perform post-
job activities, such as execution of custom scripts or sending job results by email. Post-job 
activities are performed after all transform operations are completed. 
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The synchronization process and transform operations make up a separate session of the backup copy 
job.  

 

Disabling Backup Copy Job 
A backup copy job can be disabled for some time. The disabled backup copy job does not monitor 
source backup repositories and does not copy restore points to the target backup repository. 

The instance of the disabled backup copy job still remains in the Veeam Backup & Replication 
database and in the product console. You can enable the disable job at any time. 

Synchronization Intervals 

When creating a backup copy job, you should specify its synchronization interval. 

The synchronization interval is a time span in which the backup copy job must copy a VM restore 
point from the source backup repository to the target backup repository. When a new synchronization 
interval starts, Veeam Backup & Replication checks if a new restore point is available on the source 
backup repository. In case a new restore point is found, Veeam Backup & Replication copies it from the 
source backup repository to the target backup repository. Note that the duration of the 
synchronization interval affects the restore point selection process. For more information, see Restore 
Point Selection.  

You can specify the synchronization interval in minutes, hours or days.  

Minutely and Hourly Synchronization Intervals 

If you set the synchronization interval in minutes or hours, Veeam Backup & Replication runs the 
backup copy process in cycles, one following another. When one synchronization interval is over, 
Veeam Backup & Replication starts a new synchronization interval.  

For example, if you set the synchronization interval to 4 hours and start the backup copy job at 12 PM, 
Veeam Backup & Replication will create new synchronization intervals at 12 PM, 4 PM, 8 PM and so on. 
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Daily Synchronization Intervals 

If you set the synchronization interval to one or several days, Veeam Backup & Replication requires 
that you define the start time for the synchronization interval. This start time acts as a milestone, or 
control point for the backup copy process. When the specified point in time occurs, 
Veeam Backup & Replication starts a new synchronization interval.  

For example, if you set the synchronization interval to 1 day and specify to start a new interval at 12 
PM, Veeam Backup & Replication will force a new synchronization interval at 12 PM daily.  

 

In some cases, the start time of the backup copy job and the start time of the synchronization interval 
start may not coincide. For example, when configuring a backup copy job, you may set the start time 
of the synchronization interval to 12 PM; the backup copy job itself may be launched at 12 AM. In this 
case, the first synchronization interval will be started immediately after you launch the job and will be 
run for a shorter period of time: in our example, for 12 hours only instead of one day. All subsequent 
synchronization intervals will be created and run as usual. 
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Backup Copy Window 

If necessary, you can specify a window for the backup copy job. The backup copy window is a period 
of time when the backup copy job is allowed to transport data between source and target backup 
repositories. The backup copy window can be helpful if you do not want the backup copy job to 
produce unwanted overhead for the production environment or do not want the job to overlap the 
production hours. In this case, you can define the time interval in which the job must not transfer VM 
backup data. 

The backup copy window affects only the data transport process; transform operations performed on 
the target repository are not affected by the backup copy window. The backup copy job behavior 
during the ‘prohibited’ period of time depends on the length of the synchronization interval: 

 If the synchronization interval is greater than the 'prohibited period’, the backup copy job will 
simply put on hold the backup copying operations and wait for allowed hours. The backup 
copy job is put to the Idle state and remains in this state for the whole "prohibited period". 

 If the synchronization interval is smaller than the ‘prohibited period’, 
Veeam Backup & Replication will finish all backup copy job sessions that must run during the 
‘prohibited period’ with the Failed status. During the first synchronization interval on allowed 
hours, Veeam Backup & Replication will copy the restore point to the target backup 
repository. The copied restore point will contain all data for the ‘prohibited period’. That is, it 
will aggregate all data that has changed between the latest restore point on the target 
backup repository and latest restore point on the source backup repository.  

 

For example, you have set the synchronization interval to 2 hours and defined the backup copy 
window from 8 PM to 8 AM. Without the backup copy window, Veeam Backup & Replication would 
transport 6 restore points to the target backup repository between 8 AM and 8 PM. With the backup 
window, the backup copy job will not copy data from 8 AM to 8 PM. At 8 PM, however, a new 
synchronization interval will start. Veeam Backup & Replication will transport one restore points from 
the source backup repository. This restore point will contain VM data for those 6 restore points that 
might have been copied during the ‘prohibited period’ plus one that must be created within this new 
synchronization interval.  
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Automatic Job Retries 

Veeam Backup & Replication automatically retries several operations that are performed within a 
backup copy job sessions.  

Job Tasks Retry 

By default, Veeam Backup & Replication automatically retries a failed backup copy task 5 times within 
one backup copy job session. A new task is started immediately after the previous one, without any 
interval.  

The backup copy task is retried only if the previous task has failed and a restore point has not been 
copied to the target backup repository. Veeam Backup & Replication does not perform a retry if a task 
has finished with the Success status. 

The backup copy task is retried during the same synchronization interval only. If a restore point fails to 
be copied during all retries in the current synchronization interval, Veeam Backup & Replication marks 
the synchronization task as failed and waits for the expiration of the synchronization interval. After 
that, Veeam Backup & Replication performs the necessary transform operations and starts a new 
synchronization interval. 

A backup copy job can process several VMs. If only some VMs are successfully processed by the 
backup copy task, Veeam Backup & Replication creates a restore point holding data for these VMs on 
the target backup repository. Veeam Backup & Replication will attempt to process restore points for all 
VMs during the next synchronization cycle. 

Note: 

 

Some errors from WAN accelerators can block backup copy job retries. For example, if there is no 
space in the global cache on the target WAN accelerator, Veeam Backup & Replication put backup 
copying operations on hold and wait for the expiration of the synchronization interval.  

Transform Retry 

After the backup copying task, Veeam Backup & Replication performs a number of additional 
transform operations on the target backup repository if necessary. These operations include the 
backup chain transform, removing of deleted VMs from restore points and compacting a full backup 
file. For more information, see Backup Copy Job.  

Veeam Backup & Replication may fail to perform transform operations for some reason: for example, if 
the backup file on the target backup repository is locked by the file-level restore session. By default, 
Veeam Backup & Replication automatically retries transform operations for 5 times. The first interval 
between retries is 1 minute; the interval doubles with every new attempt. If 
Veeam Backup & Replication fails to perform transform operations during all retries in this 
synchronization interval, the job is put to the idle state, waiting for the new synchronization interval to 
begin.  

Virtual Infrastructure Access Retry 

At the beginning of every synchronization interval, Veeam Backup & Replication accesses the virtual 
infrastructure to make up a list of VMs processed by the job. 

Veeam Backup & Replication may fail to access the virtual infrastructure for some reason: for example, 
in case the vCenter Server is not responding. By default, Veeam Backup & Replication automatically 
retries access operations for 5 times with a 5 minute interval. 
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Handling Backup Copy Job Issues 

Being a scheduled activity, the backup copy job may fail to run as expected. 
Veeam Backup & Replication automatically handles some issues that can occur with the backup copy 
job. 

Short Synchronization Intervals 

In some cases, Veeam Backup & Replication may fail to transport the restore point within the 
synchronization interval of the backup copy job. This can happen, for example, if the synchronization 
interval is too short and is not sufficient for the amount of data to be copied.  

Veeam Backup & Replication handles this situation differently for the first and subsequent 
synchronization intervals. 

 The first synchronization interval always produces a full backup file — the starting point in 
the backup chain. If Veeam Backup & Replication fails to copy data for the full backup file 
during the first synchronization interval, it marks the job session as finished with the Warning 
status. During the next synchronization interval, Veeam Backup & Replication attempts to 
copy data for the full backup file in the following manner: 

1. When a new synchronization interval begins, the restore point that was previously 
copied no longer corresponds to the restore point selection rules. That is, the time 
of the restore point creation falls out of the search scope. For this reason, 
Veeam Backup & Replication waits for a new restore point to appear on the source 
backup repository. 

2. When a new restore point appears on the source backup repository, 
Veeam Backup & Replication detects what data blocks still need to be copied to 
make up a full backup file on the target backup repository, and copies these data 
blocks. 
 
This process continues until there is a full backup file on the target backup 
repository. 

 At subsequent synchronization intervals, Veeam Backup & Replication copies incremental 
restore points. If Veeam Backup & Replication fails to transport an incremental restore point, it 
marks the synchronization task as failed. Veeam Backup & Replication waits for the expiration 
of the synchronization interval; after that, Veeam Backup & Replication marks the job session 
as finished with the Error status.  

Veeam Backup & Replication does not mark the backup copy job session with the Error status in the 
following cases: 

 The source backup job has not started during the synchronization interval of the backup copy 
job (that is, the backup copy job has nothing to copy to the target backup repository). 

 A task in the backup copy job processes a VM template, and the source backup job is set to 
exclude the VM template during incremental backup jobs sessions. 
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Simultaneous Use of Backup Files 

In some cases, the source backup job and backup copy job may overlap. Such situation can occur, for 
example, if the source backup job needs to transform the source backup chain. 

If a specific task in the backup copy job locks the source backup chain to read VM data from it, and the 
source backup job that needs to write data to this backup chain starts at this moment (for example, for 
reverse incremental backup), the task in the backup copy job is put on hold. The backup copy job can 
continue processing other tasks that use other sources (for example, backup files created by other 
backup jobs). After the source backup job releases the backup chain, the backup copy job resumes 
processing VMs in this backup chain. 

Change of the Synchronization Interval Start Time 

If you have selected to run a backup copy job with a daily synchronization interval, you must define 
the start time of the synchronization interval. However, you may want to change the start time 
afterwards. After the start time change, Veeam Backup & Replication behaves in the following manner: 

1. Veeam Backup & Replication finishes the current synchronization interval running according 
to the 'old' start time value as usual. 

2. After the current synchronization interval is over, Veeam Backup & Replication immediately 
starts the synchronization interval, not waiting for the 'new' start time point to come. At that, 
Veeam Backup & Replication “stretches” the started interval: the interval lasts for the time 
remaining till the new start time plus the time of the synchronization interval itself.  

3. All subsequent synchronization intervals are created and started in a regular manner by the 
new schedule.  

For example, when you first created a backup copy job, you set a daily synchronization interval with 
the start time at 8 AM. After that, you changed the start time to 10 AM. In this case, 
Veeam Backup & Replication will first finish the synchronization interval that is currently running — 
that is, the synchronization interval that was started at 8 AM — as usual. After that, it will immediately 
start a new synchronization interval. This interval will run for 26 hours — from 8 AM of the current day 
until 10 AM of the next day. All subsequent synchronization intervals will be started at 10 AM every 
day. 

The first synchronization interval that is run after the start time change is typically longer than a 
regular one. This happens because of the synchronization interval “stretch” mentioned above. To start 
the synchronization process right away, you can use the Sync Now option after you change the start 
time value. In this case, Veeam Backup & Replication will behave in the following manner: 

1. When you start the synchronization process manually, Veeam Backup & Replication forcibly 
finishes the current synchronization interval and begins a new synchronization interval 
according to the new start time value. This synchronization interval lasts until a new 
synchronization interval by the new schedule must be started. 

2. All subsequent synchronization intervals are created and started in a regular manner.  

As a result, the first synchronization interval after the start time change will begin immediately. 

For example, when you first created a backup copy job, you set a daily synchronization interval with 
the start time at 8 AM. After that, you changed the start time to 10 AM. On the start time change, you 
started the manual synchronization process at 1 PM. In this case, Veeam Backup & Replication will 
finish the current synchronization interval — that is, the synchronization interval that was started at 8 
AM — immediately at 1 PM. After that, it will start a new synchronization interval. This interval will run 
for 21 hours — from 1 PM of the current day until 10 AM of the next day. All subsequent 
synchronization intervals will be started at 10 AM every day. 
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Retention Policy for Backup Copy Jobs 
The backup copy job has its own retention policy settings. The retention policy of a backup copy job 
does not depend on retention policy settings specified for the source backup job. The retention policy 
of a backup copy job defines for how long Veeam Backup & Replication must retain copied restore 
points on the target backup repository. 

Veeam Backup & Replication offers two retention policy schemes for backup copy jobs:  

 Simple Retention Policy 

 GFS Retention Policy 

Simple Retention Policy 

A simple retention policy scheme is intended for short-time archiving. When you specify retention 
policy settings for a simple scheme, you define how many restore points you want to retain on the 
target backup repository. 

With the simple retention policy scheme, Veeam Backup & Replication creates a chain of restore points 
that subsequently follow one another. The first restore point in the chain is always a full backup (also 
known as recent full backup). All other restore points in the chain are incremental backups. By default, 
Veeam Backup & Replication keeps 7 restore points on the target backup repository. 

 

To maintain a desired number of restore points in the backup chain, Veeam Backup & Replication uses 
the following rotation scheme: 

1. During the first synchronization interval, Veeam Backup & Replication copies the first restore 
point — full backup — to the target backup repository. 

2. During every next synchronization interval, Veeam Backup & Replication adds a new restore 
point — incremental backup — to the backup chain on the target backup repository. This 
happens until the number of restore points in the backup chain reaches the number specified 
in the retention policy settings. 

3. After the new restore point is added, the allowed number of restore point is exceeded. 
Veeam Backup & Replication transforms the backup chain to make room for the most recent 
restore point. 
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The backup chain transformation is performed in the following way: 

1. Veeam Backup & Replication re-builds the full backup file to include changes from the 
incremental backup following the full backup. More specifically, Veeam Backup & Replication 
injects data blocks from the first incremental backup in the chain into the full backup. This 
way, the full backup ‘moves’ one step forward in the backup chain. 

 

2. The first incremental backup is removed from the chain as redundant. Its data has already 
been injected into the full backup, and so the full backup file contains the same data as this 
incremental backup. 

 

For example, you want the backup copy job to keep 7 restore points. The synchronization interval is 1 
day; the backup copy job starts on Sunday.  

1. During the first synchronization interval on Sunday, Veeam Backup & Replication creates the 
first restore point — a full backup. Monday through Saturday Veeam Backup & Replication 
adds six incremental backups to the chain.  

2. The next Sunday, Veeam Backup & Replication adds a new incremental backup to the backup 
chain. The number of allowed restore point in the backup chain is exceeded.  
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For this reason, Veeam Backup & Replication transforms the backup chain in the following way: 

1. Veeam Backup & Replication merges data blocks from the incremental backup copied on 
Monday into the full backup copied on Sunday. This way, the full backup file ‘moves’ one step 
forward — from Sunday to Monday.  

 

2. The incremental backup copied on Monday becomes redundant and is removed from the 
chain.  

As a result, you have a chain of a full backup as of Monday and six incremental backups 
Tuesday through Sunday. 

 

Note: 

 

The minimum number of restore points that you can keep with the simple retention policy scheme is 
2. This setting ensures that during the transform process at least 1 restore point remains untouched 
in case of failures. 
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GFS Retention Policy 

In most cases, simple backup retention policy is not enough. You cannot store an unlimited number of 
restore points on the target backup repository forever — it is not rational and is resource consuming. 
If you want to retain VM data for longer periods of time, you can enable the GFS retention policy 
scheme for the backup copy job. 

The GFS, or Grandfather-Father-Son retention policy is a backup rotation scheme intended for long-
term archiving. It lets you keep backups of VMs for an entire year and requires minimum amount of 
storage space. 

GFS is a tiered retention policy scheme. It uses a number of cycles to retain backups for different 
periods of time: 

 Regular backup cycle 

 Weekly backup cycle 

 Monthly backup cycle 

 Quarterly backup cycle 

 Yearly backup cycle 

In the GFS retention policy scheme, weekly backups are known as ‘sons’, monthly backups are known 
as ‘fathers’ and yearly backup are known as ‘grandfathers’. Additionally, Veeam Backup & Replication 
maintains quarterly backups. Weekly, quarterly and yearly backups are also called archive backups. 

Important! 

 

You cannot enable GFS retention settings if you use a backup repository with rotated drives as the 
target backup repository.  
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Methods for Archive Backups Creation 

You can instruct Veeam Backup & Replication to create archive full backups with the following 
methods: 

 Synthetic full method — Veeam Backup & Replication synthesizes archive full backups using 
restore points on the target backup repository. For more information, see Synthetic Full 
Method for Archive Backups. 

 Active full method — Veeam Backup & Replication copies VM data for archive full backups 
from the source backup repository. For more information, see Active Full Method for Archive 
Backups. 

Synthetic Full Method for Archive Backups 

The synthetic full backup is the default method to create archive full backups. 
Veeam Backup & Replication does not copy VM data for archive full backups from the source backup 
repository — it synthesizes archive full backups from backup files that are already stored on the target 
backup repository. This approach helps reduce load on the network and production environment. 

The synthetic full method is not recommended if you use a deduplicating storage appliance as a 
target backup repository. For more information, see Active Full Method for Archive Backups. 
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Active Full Method for Archive Backups 

You can instruct Veeam Backup & Replication to create archive full backups (backups retained by the 
GFS scheme) with the active full backup method. The active full backup method is recommended if 
you use a deduplicating storage appliance as the target backup repository. Active full backup helps 
improve the backup copy job performance and reduce the load on the target backup repository. 

By default, Veeam Backup & Replication uses the synthetic backup method to create archive full 
backups. However, synthesizing archive full backups can cause problems with storage performance 
on deduplicating storage appliances. Deduplicating storage appliances are optimized for sequential 
data access. The synthetic backup creation, however, takes random I/O operations — 
Veeam Backup & Replication reads data from existing backup files and writes data to the synthesized 
archive full backup file. As a result, the storage performance can degrade.  

In addition, VM backups reside on the target backup repository in the deduplicated and compressed 
state. Before creating synthetic full backups, Veeam Backup & Replication needs to rehydrate and 
uncompress data blocks of backups, which requires additional time and resources.  

To optimize the backup copy job performance on deduplicating storage appliances, you can enable 
the Read the entire restore point from source instead of synthesizing it from increments check 
box in the backup copy job settings. Veeam Backup & Replication will copy data for the archive full 
backup from restore points on the source backup repository, transport it to the target backup 
repository over the network and write it to the archive full backup file. The load on the network will be 
higher but the performance of the deduplicating storage appliance will increase. 

Note: 

 

The active full backup method does not always copy the most recent restore point from the source 
backup repository. If the necessary recent restore point has not been created by the time the GFS 
task must start, Veeam Backup & Replication will copy the latest available restore point from the 
source backup repository. If data transfer does not fit the synchronization interval will be extended. 
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Switching Between Synthetic and Active Full Modes 

In some cases, you may want to change the algorithm of archive full backup creation. You can: 

 Switch from the synthetic to the active full mode 

 Switch from the active full to the synthetic mode 

Switching from Synthetic to Active Full Method 
After you switch from the synthetic to the active method of archive backup creation, 
Veeam Backup & Replication does not perform synthetic transform operations for some time. 
Veeam Backup & Replication works in the following way:  

1. Veeam Backup & Replication adds new incremental restore points to the backup chain and 
keeps existing restore points until a new active full backup is created.  

 

2. After the new active full backup is created, Veeam Backup & Replication checks the retention 
policy set for the job. If some archive full backups are outdated, Veeam Backup & Replication 
removes them from the backup chain.  

 

3. Veeam Backup & Replication keeps adding new incremental restore points to the backup 
chain. When the number of restore points in the new backup chain is equal to the number 
allowed by retention, Veeam Backup & Replication removes incremental restore points that 
precede the new active full backup. 

 

After this, Veeam Backup & Replication uses the new method to create the backup chain in a regular 
manner. 
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Switching from Active Full to Synthetic Method 
Scenario 1. The backup chain starts with the recent full backup file and contains archive full 
backups.  

After you switch from the active full to the synthetic algorithm of archive backup creation, 
Veeam Backup & Replication works in the following way:  

1. During the first synchronization interval after the switch, Veeam Backup & Replication adds a 
new incremental restore point to the backup chain.  

 

2. During the second synchronization interval, Veeam Backup & Replication adds the second 
incremental restore point to the backup chain and builds a recent full backup out of the latest 
archive full and first incremental restore point in the backup chain.  

 

3. After that Veeam Backup & Replication uses the new algorithm to create the backup chain in 
a regular manner.  
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During every new synchronization interval, Veeam Backup & Replication checks retention settings for 
the job. Depending on the case, Veeam Backup & Replication deletes outdated restore points in the 
following manner: 

1. Case 1. The existing backup chain (backup chain created before the switch) does not contain 
archive full backups created by the GFS schedule.  

When the number of restore points in the new backup chain is equal to the number allowed 
by the retention policy, Veeam Backup & Replication removes restore points from the backup 
chain created before the switch.  

 

2. Case 2. The existing backup chain (backup chain created before the switch) contains archive 
full backups created by the GFS schedule. 

When the number of restore points in the new backup chain is equal to the number allowed 
by the retention policy, Veeam Backup & Replication starts merging restore points in the 
existing backup chain until it reaches to the archive full backup. The archive full backup is 
then set aside as a GFS restore point, and Veeam Backup & Replication keeps working 
according to the Case 1. 

For example, you instruct the backup copy job to create weekly full backups on Tuesday in 
the active full backup method. Then you switch to the synthetic full backup method. After the 
switch, Veeam Backup & Replication creates a new recent full backup and adds incremental 
backups to it. When the number of restore points in the new backup chain is equal to the 
number allowed by the retention policy, Veeam Backup & Replication starts merging the 
recent full backup in the existing backup chain created before the switch. When 
Veeam Backup & Replication reaches the weekly backup created on Tuesday, it sets this 
weekly backup aside and retains it on the backup repository. After that, 
Veeam Backup & Replication removes restore points from the existing backup chain. 
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Scenario 2. The backup chain starts with the archive full backup.  

After you switch from the active full to the synthetic method of archive backup creation, 
Veeam Backup & Replication works in the following way:  

1. During the first synchronization interval after the switch, Veeam Backup & Replication adds a 
new incremental restore point to the backup chain.  

 

2. During the second synchronization interval, Veeam Backup & Replication adds a second 
incremental restore point to the backup chain and builds the recent full backup out of the 
latest archive full and the first incremental restore point in the backup chain.  

 

3. After that Veeam Backup & Replication uses the new algorithm to create the backup chain in 
a regular manner. During every new synchronization interval, Veeam Backup & Replication 
checks retention settings for the job and, if incremental restore points between the archive 
full backup and recent full backups are outdated, they are removed from the backup chain. 

  

Scenario 3. The backup chain does not contain archive full backup files.  

In this case, Veeam Backup & Replication works by the standard archive full backup scheme. For more 
information, see GFS Retention Policy. 
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GFS Cycles 

Veeam Backup & Replication uses a number of cycles to retain backups for different periods of time 
according to the GFS retention scheme: 

 Regular backup cycle 

 Weekly backup cycle 

 Monthly backup cycle 

 Quarterly backup cycle 

 Yearly backup cycle 

Regular Backup Cycle 

The regular backup cycle is based on the simple retention policy scheme. When you specify retention 
policy settings, you define how many restore points you want to retain in the backup chain. 

Veeam Backup & Replication runs the regular backup cycle in the following way: 

1. During the first synchronization interval, Veeam Backup & Replication creates the first restore 
point — a full backup.  

2. The next synchronization intervals add incremental backups to the backup chain.  

As a result, the regular backup cycle produces a chain of a full backup and set of incremental backups 
on the target backup repository.  

For example, you have selected to retain 7 restore points. The synchronization interval is 1 day, the 
backup copy job starts on Sunday. Veeam Backup & Replication will create a full backup on Sunday 
and add 6 incremental backups Monday through Saturday. 
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Weekly Backup Cycle 

In the GFS scheme, the weekly backup is created during the weekly backup cycle. 

Weekly backup cycles always produce full backup files that contain data of the whole VM image as of 
specific date. When you define retention policy settings for the weekly backup cycle, you specify how 
many weekly backups you want to retain per month and define the week day on which the weekly full 
backup must be created. 

Veeam Backup & Replication creates weekly full backups for synthetic and active full backup methods 
in different ways: 

 Synthetic weekly full backups 

 Active weekly full backups 

Synthetic Weekly Full Backups 
Veeam Backup & Replication does not use a separate task to create weekly full backups. 
Veeam Backup & Replication re-uses a full backup created in the regular backup cycle and propagates 
this full backup to the weekly tier.  

Veeam Backup & Replication creates a weekly full backup in the following way: 

1. Veeam Backup & Replication creates a chain of backups in the regular backup cycle. The chain 
consists of a full backup and set of subsequent incremental backups. 

For example, you have selected to keep 7 restore points. The synchronization interval is 1 day, 
the backup copy job starts on Sunday. During the week, Veeam Backup & Replication creates 
a backup chain on the target backup repository. The backup chain consists of a full backup 
copied on Sunday and a set of incremental backups copied Monday through Saturday. 

 

2. With every new synchronization interval, Veeam Backup & Replication transforms the backup 
chain and moves the full backup forward. This procedure repeats until the full backup file 
reaches the day when the weekly backup is scheduled. 

3. During the synchronization interval on this day, Veeam Backup & Replication transforms the 
backup chain and creates a weekly full backup at the same time. This process is performed in 
the following way: 

a. Veeam Backup & Replication adds a new restore point to the backup chain.  

b. As the allowed number of restore points is exceeded, Veeam Backup & Replication 
transforms the backup chain. The transformation process slightly differs from a 
regular one. Veeam Backup & Replication does not inject data from the incremental 
backup to the full backup. Instead, it copies data from full and incremental backups 
and stores them to a new full backup file, next to the primary backup file. 
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4. The incremental backup from which data was copied is removed as obsolete.  

 

5. The primary full backup file remains on the target backup repository. 
Veeam Backup & Replication sets it aside and marks it as a weekly full backup. The weekly 
backup is no longer used in the backup chain.  

6. The newly created full backup file remains in the backup chain and is used as a starting point 
for incremental backups created by the regular backup cycle.  

 

For example, weekly backup is scheduled on Monday. Veeam Backup & Replication will keep 
transforming the backup chain until the full backup file reaches Monday. During the next 
synchronization interval, Veeam Backup & Replication will transform the backup chain. To do that, it 
will copy data from the Monday full backup and Tuesday incremental backup to a new full backup file 
and store it next to the primary full backup file. 

As a result, on the target backup repository you will have a full backup created on Monday and a 
backup chain that includes a full backup as of Tuesday and a chain of increments Wednesday through 
Monday. The full backup as of Monday will be marked as a weekly backup and set aside. The full 
backup as of Tuesday will be used as a new starting point in the backup chain. 
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Active Weekly Full Backups 
Veeam Backup & Replication copies VM data from the source backup repository and saves them to the 
full backup file on the target backup repository. The created full backup file is marked as a weekly 
backup. The weekly backup is set aside and is not used in the backup chain. 

Retention Policy for Weekly Backups 
Veeam Backup & Replication repeats the weekly backup cycle until the number of weekly backups 
allowed by the retention policy is exceeded. After that, Veeam Backup & Replication removes the 
earliest weekly full backup from the target backup repository to make room for the most recent 
weekly full backup. 

When deleting obsolete weekly full backups, Veeam Backup & Replication considers weekly intervals, 
not separate backup files. For this reason, in some situations the target backup repository may contain 
a greater number of weekly full backups than specified in the GFS retention policy scheme. 

For example, you have selected to retain 4 weekly full backups. The weekly backup is scheduled on 
Sunday. Right after the first weekly full backup is created, you change the weekly backup schedule 
and schedule the weekly backup on Thursday. As a result, during the first week 
Veeam Backup & Replication will create two weekly backups. At the end of the month you will have 5 
weekly backups on the target backup repository: 

 One weekly backup created on Sunday 

 Four weekly backups created on Thursday 

On the 5th week, Veeam Backup & Replication will add a new weekly backup to the target backup 
repository. At the same time, it will remove all backups that were created on the first week – Sunday 
backup and Thursday backup.  

 

Important! 

 

The full backup can be marked as weekly, monthly, quarterly and/or yearly. When transforming 
weekly, monthly, quarterly and yearly backup chains, Veeam Backup & Replication checks flags set 
for the full backup file. If the full backup file belongs to some other retention policy tier and must be 
retained on the target backup repository, such backup file will not be removed. 
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Restore Point Selection for Weekly Backup (Synthetic Method) 
Typically, when a weekly full backup is created, Veeam Backup & Replication takes a full backup as of 
this day and marks it as a weekly backup. In some cases, however, Veeam Backup & Replication may 
fail to find a full backup on the day when the weekly backup is scheduled. In this situation, 
Veeam Backup & Replication will use the nearest full backup file created within the next 
synchronization interval. 

For example, you have set the synchronization interval to 1 week and started the backup copy job on 
Sunday. As a result, a new restore point is created every Sunday. When Veeam Backup & Replication 
transforms the backup chain, the full backup moves from the previous Sunday to the next Sunday. 

Imagine the weekly backup is scheduled on Wednesday. As all backups are created on Sunday, 
Veeam Backup & Replication will not find a full backup as of Wednesday. For this reason, it will use the 
full backup from the next synchronization interval — a full backup as of Sunday. 
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Monthly, Quarterly and Yearly Backup Cycles 

Monthly, quarterly and yearly backup cycles use the same algorithms as the weekly backup cycle. 
When you define retention policy settings for these backup cycles, you specify how many backups you 
want to retain in the specified time interval and define the week day on which the monthly, quarterly 
or yearly backup must be created.  

Veeam Backup & Replication repeats the monthly, quarterly or yearly backup cycle until the number of 
backups allowed by the retention policy is exceeded. After that, Veeam Backup & Replication removes 
the earliest full backup from the target backup repository to make room for the most recent monthly, 
quarterly or yearly backup. 

Concurrent Archive Full Schedule 
If you schedule a monthly, quarterly or yearly full backup on the same day when the weekly full 
backup is scheduled, Veeam Backup & Replication will create only one archive full backup — the 
weekly backup. The monthly, quarterly or yearly GFS backup will not be created. 

The created archive full backup will be marked as weekly and, at the same time, monthly, quarterly or 
yearly backup. In the Veeam Backup & Replication console, you will see all GFS flags assigned to the 
backup. In the file system, however, the file will be visible as having only one GFS flag — the flag of 
the highest GFS tier. For example, if you schedule weekly and yearly backup on the same day, the 
backup file will be marked as yearly in the file system. 

If the synchronization interval is less than 1 day, Veeam Backup & Replication creates the archive full 
backup during the synchronization interval when the weekly full backup is scheduled.  

For example, you have scheduled the weekly full backup at 10:00 AM on Sunday. The monthly full 
backup is also scheduled on Sunday. The synchronization interval is set to 3 hours starting at 12:00 
AM. That is, synchronization intervals take place at 12:00 AM, 3:00 AM, 6:00 AM, 9:00 AM and so on. 

In this case, Veeam Backup & Replication will not create the monthly full backup during the first 
synchronization interval on Sunday — 12:00 to 3:00 AM. It will wait for the synchronization interval 
when the weekly full backup must be created — 9:00 AM to 12:00 AM. During this interval, 
Veeam Backup & Replication will create an archive full backup and assign the weekly and monthly 
flags to it. 



 

314   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Health Check for Backup Files 
You can instruct Veeam Backup & Replication to perform a health check for backup files created with 
backup copy jobs periodically. During the health check, Veeam Backup & Replication runs a CRC test 
against backup files on the target backup repository. The health check helps 
Veeam Backup & Replication make sure that backup files are consistent, and you will be able to restore 
data from these files.  

The health check is started at the beginning of every synchronization interval, before backup data is 
transported to the target backup repository. Veeam Backup & Replication always verifies only the 
most recent restore point of the backup created with the backup copy job.  

The health check is performed in the following way: 

1. When a new restore point is copied from the source backup repository, 
Veeam Backup & Replication calculates checksums for data blocks in the backup file and 
saves the checksums in the backup file, together with VM backup data.  

2. When a new synchronization interval starts, Veeam Backup & Replication performs a health 
check for the most recent restore point in the backup chain. Veeam Backup & Replication 
calculates checksums for data blocks in the backup file on the target backup repository and 
compares them with the checksums that are already stored in the backup file. 

3. If the health check detects corrupted data, during the current synchronization interval, 
Veeam Backup & Replication transports valid data blocks from the source backup repository 
and stores them to the newly copied restore point on the target backup repository. As a 
result, you get a valid restore point from which you can restore VM data. 

4. Veeam Backup & Replication displays information about the health check result in the job 
session statistics. 
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To run the health check periodically, you must enable the Perform backup files health check option 
in the backup copy job settings and define the health check schedule. By default, the health check is 
performed on the last Sunday of every month. You can change the health check schedule and instruct 
Veeam Backup & Replication to perform it weekly or monthly on specific days. 

Note: 

 

If the backup copy job uses WAN accelerators, Veeam Backup & Replication attempts to find data 
blocks in the global cache not to transfer data over the network. For more information, see WAN 
Acceleration. 
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Compact of Full Backup File 
The backup copy job constantly transforms the full backup file in the backup chain to meet retention 
policy settings. The transformation process, however, has a side effect. In the long run, the full backup 
file grows large and gets badly fragmented. The file data occurs to be written to non-contiguous 
clusters on disk, and operations of reading and writing data from and to the backup file slow down.  

To resolve the fragmentation problem, you can instruct Veeam Backup & Replication to compact the 
full backup file periodically. During the file compact operation, Veeam Backup & Replication creates a 
new empty VBK file and copies to it all data blocks from the full backup file. As a result, the full backup 
file gets defragmented, its size reduces and the speed of reading and writing from and to the file 
increases. 

To compact the full backup file periodically, you must enable the Defragment and compact full 
backup file option in the backup copy job settings and define the compact operation schedule. By 
default, the compact operation is performed on the last Saturday of every month. You can change the 
compact operation schedule and instruct Veeam Backup & Replication to perform it weekly or 
monthly on specific days. 
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Limitations for Full Backup File Compact 
The full backup file compact has the following limitations:  

 The Defragment and compact full backup file option can be enabled only for the simple 
retention policy scheme. 

 The target backup repository must have enough space to store a file of the full backup size. 
During the compact process, Veeam Backup & Replication creates an auxiliary VBK file that 
exists on the backup repository until the end of the compact operation. 

 If the full backup file contains data for a VM that has only one restore point and this restore 
point is older than 2 days, during the compact operation Veeam Backup & Replication will not 
copy data for such VM to the newly created full backup file. Veeam Backup & Replication will 
extract data for this VM from the full backup file and write this data to a separate backup file. 
The file will be displayed under the Backups > Disk (imported) node in the Backup & 
Replication view. This mechanism helps remove data for VMs that are no longer processed 
with the backup copy job from the full backup file and reduce the size of the full backup file.  

The mechanism works if the following conditions are met: 

– The Remove deleted VMs data option is not enabled in the backup copy job 
settings. 

– The Use per-VM backup files option is not enabled in the settings of the target 
backup repository. 
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Mapping Backup Copy Jobs 
If you plan to copy VM restore points over the WAN and slow connections, you can use backup 
mapping.  

A backup copy job with a mapped backup is performed in the following way: 

1. Veeam Backup & Replication accesses a full backup file to which you mapped the backup 
copy job. This backup file is used as a seed for further backup copying process. 

2. Data processing during all subsequent synchronization intervals is performed in a regular 
manner. Veeam Backup & Replication copies only incremental changes and stores them as 
new restore points next to the full backup file.  

 

Unlike a regular backup copy job that uses a dedicated folder on the target backup repository, a 
mapped backup copy job stores copied restore points to the same folder where the backup file used 
as a seed resides. 

Limitations for Backup Copy Job Mapping 
1. The backup copy job can be mapped to a backup file if the backup chain is created with the 

incremental backup method. You cannot map to a backup file if the backup chain is created 
with the reverse incremental backup method or contains both incremental and reverse 
incremental restore points (for example, if the backup chain was transformed). To overcome 
this limitation, you can configure an auxiliary backup copy job that will produce a "seed" for 
job mapping. For more information, see Creating a Seed for the Backup Copy Job. 

2. If the initial backup file that you plan to use as a "seed" is encrypted, you must enable 
encryption for the backup copy job, too. In terms of Veeam Backup & Replication, the 
encryption setting applies to the whole backup chain. If the full backup is already encrypted, 
subsequent incremental backups must also be encrypted.  

The password that you use for the backup copy job can be different from the password used 
for the initial backup job. 
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Creating a Seed for the Backup Copy Job 

If the backup chain is created with the reverse incremental backup method or contains both 
incremental and reverse incremental restore points, you can use a workaround scenario. You can 
configure an auxiliary backup copy job in addition to the initial backup copy job. The auxiliary backup 
copy job will produce a full backup file and you will be able to use this full backup file as a "seed" for 
backup copy job mapping. 

To create a "seed" for the backup copy job: 

1. Create a new, auxiliary, backup copy job. The created backup copy job must copy backups of 
VMs processed by the initial backup copy job. Target the created auxiliary backup copy job to 
some backup repository on the source side. This backup repository will be used as an 
intermediate one. 

2. Run the auxiliary backup copy job to create a full backup file (VBK) on the intermediate 
backup repository.  

3. Move the created VBK file and VBM file from the intermediate backup repository to the 
backup repository on the target side. 

4. Perform repository rescan to populate the backup repository on the target side.  

If the initial backup file was encrypted, you will need to enter a password to unlock the full 
backup file before you point the backup copy job to it. In the opposite case, 
Veeam Backup & Replication will not display the full backup file in the list of backups on the 
backup repository. For more information, see Importing Encrypted Backups. 

5. Edit settings of the initial backup copy job: point the initial backup copy job to the full backup 
file that you have created and moved to the target backup repository.  

6. Click Sync Now to start a new synchronization interval. 

As a result, Veeam Backup & Replication will use the backup file that you have created and moved to 
the target backup repository as a "seed", or starting point, for the backup chain produced by the initial 
backup copy job. When a new restore point for the VM is available on the source backup repository, 
Veeam Backup & Replication will transfer only incremental changes and store them next to the "seed". 
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When you configure an auxiliary backup copy job, make sure that its synchronization interval covers 
the whole chain of restore points on the backup repository from which you plan to copy backup files. 
The length of the synchronization interval has an impact on the algorithm of restore point selection. 
Veeam Backup & Replication copies only those restore points that match the following criterion:  

Time of restore point creation >= current time – synchronization interval 

That is, if you have a backup chain whose earliest restore point is 1 week old, you need to set the 
synchronization interval to one week. If you set the synchronization interval to a smaller time span, for 
example, 1 day, all restore points that are older than 1 day will fall out of the search scope and 
Veeam Backup & Replication will not transfer their data. For more information, see Restore Point 
Selection. 
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WAN Acceleration 
Offsite backup and replication always involves moving large volumes of data between remote sites. 
The most common problems that backup administrators encounter during are the following ones: 

 Insufficient network bandwidth to support VM data traffic 

 Transmission of redundant data 

To solve these problems, Veeam Backup & Replication offers the WAN acceleration technology that 
helps optimize data transfer over the WAN.  

The WAN acceleration technology is specific for remote jobs: backup copy jobs and replication jobs. 
Being a built-in feature, Veeam’s WAN acceleration does not add complexity and cost to the backup 
infrastructure.  

Note: 

 

WAN acceleration is available is specific editions of Veeam Backup & Replication. For more 
information, see https://www.veeam.com/backup-version-standard-enterprise-editions-
comparison.html. 

https://www.veeam.com/backup-version-standard-enterprise-editions-comparison.html
https://www.veeam.com/backup-version-standard-enterprise-editions-comparison.html
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Global Data Deduplication 
The goal of WAN acceleration is to send less data over the network. To reduce the amount of data 
going over the WAN, Veeam Backup & Replication uses the global data deduplication mechanism.  

1. When you first run a remote job, Veeam Backup & Replication analyzes data blocks going 
over WAN.  

2. With every new cycle of a remote job, Veeam Backup & Replication uses the data redundancy 
algorithm to find duplicate data blocks in copied files. Veeam Backup & Replication analyzes 
data blocks in files on the source side and compares them with those that have been 
previously transferred over the WAN. If an identical data block is found, Veeam Backup & 
Replication deduplicates it.  

Veeam Backup & Replication uses three sources for data deduplication: 

 VM disks. Veeam Backup & Replication analyses data blocks within the same VM disk. If 
identical blocks are found, duplicates are eliminated.  
For example, in case of a virtualized Microsoft Exchange server, the same email is typically 
stored in sender’s Outbox folder of the sender and recipient’s Inbox folder, which results in 
duplicate data blocks. When a remote job runs, Veeam Backup & Replication detects such VM 
data blocks and performs deduplication. 

 Previous restore points for the processed VM on the target repository. Veeam Backup & 
Replication analyses data in the restore point that is about to be copied and the restore 
point(s) that are already stored on the target side. If an identical block is found on the target 
side, Veeam Backup & Replication eliminates the redundant data block in the copied restore 
point.  

 Global cache. Veeam Backup & Replication creates a global cache holding data blocks that 
repeatedly go over the WAN. In a new job session, Veeam Backup & Replication analyzes data 
blocks to be sent and compares them with data blocks stored in the global cache. If an 
identical data block is already available in the global cache, its duplicate on the source side is 
eliminated and not sent over the WAN. 

As a result, only unique data blocks go over the WAN. Data blocks that have already been sent are not 
sent. This way, Veeam Backup & Replication eliminates transfer of redundant data over the WAN. 

Note: 

 

Veeam Backup & Replication deduplicates data blocks within one VM disk and in restore points for 
one VM only. Deduplication between VM disks and restore points of different VMs is performed 
indirectly, via the global cache. For more information, see WAN Global Cache.  
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WAN Accelerators 
To enable WAN acceleration and data deduplication technologies, you must deploy a pair of WAN 
accelerators in your backup infrastructure.  

 One WAN accelerator is deployed on the source site, closer to the source backup repository or 
source host.  

 The other WAN accelerator is deployed on the target site, closer to the target backup 
repository or target host.  

Technically, WAN accelerators add a new layer in the backup infrastructure — between the Veeam 
Data Mover Service on the source side and the Veeam Data Mover Service on the target side. 

 

WAN accelerators are dedicated components responsible for global data caching and data 
deduplication. On each WAN accelerator, Veeam Backup & Replication installs the Veeam WAN 
Accelerator Service responsible for WAN acceleration tasks.  

On each WAN accelerator Veeam Backup & Replication creates the VeeamWAN folder containing the 
following data:  

 The VeeamWAN folder on the source WAN accelerator stores files with digests required for 
global deduplication. For more information, see How WAN Acceleration Works. 

 The VeeamWAN folder on the target WAN accelerator stores global cache data. 

To create a WAN accelerator, you need to assign the WAN accelerator role to a specific machine. You 
can use any 64-bit Windows-based machine in your environment, either physical or virtual. You can 
even assign the WAN accelerator role to the existing backup proxies and backup repositories.  

The machine that will perform the WAN accelerator role must have enough free disk space to store 
digest or global cache data. For more information, see WAN Accelerator Sizing. 
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WAN Accelerator Sizing 

To ensure correct work of remote jobs via WAN accelerators, you must provide enough free space for 
service data on the source and target WAN accelerators. 

Source WAN Accelerator 

When you run a remote job via WAN accelerators, Veeam Backup & Replication analyses data blocks 
going to target and calculates digests for these data blocks. Digests data is stored on the source WAN 
accelerator, in the VeeamWAN folder on the disk with the most amount of free disk space.  

It is strongly recommended that you provide enough disk space on the source WAN accelerator to 
store digest data. The amount of required space depends on the capacity of source VM disks. For 1 TB 
of VM disks capacity, you must provide 20 GB of disk space. For example, if you plan to process 10 VMs 
whose capacity is 2 TB, you must allocate 40 GB of disk space for digest data on the source WAN 
accelerator. 

Note: 

 

Global cache is stored only on the target WAN accelerator. You do not have to provide space for 
global cache on the source WAN accelerator. 

Target WAN Accelerator 

Global cache is stored on the target WAN accelerator, in the VeeamWAN folder on the disk with the 
most amount of free disk space. The size of global cache is specified in the properties of the target 
WAN accelerator.  

You must provide enough free space for global cache data. It is recommended that you provide 10 GB 
per every type of OS on VMs that you plan to process. By default, Veeam Backup & Replication 
allocates 100 GB for the global cache size. 

For example, you want to process the following VMs: 

 1 VM that runs Microsoft Windows 7 

 3 VMs that run Microsoft Windows 2008 R2 

 2 VMs that run Microsoft Windows 2012 R2  

There are 3 types of OSes so you must allocate 30 GB for the global cache on the target WAN 
accelerator. 
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In some cases, Veeam Backup & Replication may require more space on the target WAN accelerator 
than specified in the WAN accelerator properties. This can happen if digest data on the source WAN 
accelerator are missing or cannot be used. For example: 

1. You have performed the Clear Cache operation on the source WAN accelerator and it no 
longer contains digest data. For more information, see Clearing Global Cache. 

2. Veeam Backup & Replication has attempted to resume operation of backup data transfer but 
the backup file was not prepared for the operation in a proper way. The digest data must be 
re-calculated. 

In such situations, the target WAN accelerator will have to calculate digest data on its own, which will 
require additional space.  

For safety reasons, it is recommended that you provide additional 20 GB of free per 1 TB of source VM 
data on the target WAN accelerator. This amount of space is required for digest data recalculation. If 
you do not provide this amount of space and a situation when Veeam Backup & Replication needs to 
recalculate digest data occurs, the remote job will work in the limited mode. 
Veeam Backup & Replication will not deduplicate data against the previous restore points copied to 
target. For more information, see Global Data Deduplication. 

For example: 

 You have allocated 100 GB for global cache on the target WAN accelerator. 

 The size of VMs to be processed is 2 TB. 

In this case, the total size of space that you must allocate for global cache on the target WAN 
accelerator is: 

100 GB + 40 GB = 140 GB 
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Many-to-One WAN Acceleration Scenario 

Global cache size is calculated per 1 source WAN accelerator working with the target WAN accelerator. 
If you plan to use several source WAN accelerators with 1 target WAN accelerator, you must increase 
the size of the global cache proportionally. The global cache size is calculated by the following 
formula: 

Total Target WAN Accelerator Cache Size = (# of Source WAN Accelerators) * (Size Configured in the Target 
WAN Accelerator Properties) + 20 GB per 1 TB of Source Data 

For example: 

 You have 4 source WAN accelerators in the source side working with 1 target WAN 
accelerator in the DR site.  

 The global cache size configured in properties of the target WAN accelerator is 100 GB.  

 The size of VMs to be processed is 2 TB. 

In this case, the total size of space that you must allocate for the global cache on the target WAN 
accelerator is: 

4*100 GB + 40 GB = 440 GB 
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WAN Global Cache 
From the technical point of view, the global cache is a folder on the target WAN accelerator. By 
default, global cache data is stored in the VeeamWAN folder on the disk with the most amount of 
space available. However, you can define any folder of your choice when you configure the target 
WAN accelerator. 

By default, the size of the global cache is 100 GB. You can increase the size or decrease it if necessary. 
The more space you allocate, the more repeating data blocks will be written to the global cache and 
the more efficient WAN acceleration will be. It is recommended that you allocate at least 40 GB to the 
global cache storage.  

The global cache size is specified per source WAN accelerator. That is, if you plan to use one target 
WAN accelerator with several source WAN accelerators, the specified amount of space will be 
allocated for every source WAN accelerator that will be working with the target WAN accelerator and 
the size of the global cache will increase proportionally. For more information, see WAN Accelerator 
Sizing. 

The WAN global cache is a “library” that holds data blocks repeatedly going from the source side to 
the target side. The global cache is populated at the first cycle of a remote job. The priority is given to 
data blocks of Windows-based OSes, other OSes like Linux/Unix and standard applications such as 
Microsoft Exchange Server. 

Veeam Backup & Replication constantly maintains the global cache in the actual state. To do that, it 
continuously monitors data blocks going over the WAN and data blocks in the global cache. 

 If some new data block is constantly sent over the WAN, it is added to the global cache.  

 If some data block in the global cache is not sent over the WAN and are not re-used for some 
period of time, it is removed from the global cache to make room for new data blocks. 

Veeam Backup & Replication also performs periodic consistency checks. If some data block in the 
global cache gets corrupted, Veeam Backup & Replication removes it from the global cache. 

The efficiency of the WAN acceleration increases with every new synchronization interval in the 
backup copy job. During the first synchronization interval in the backup copy job, the WAN 
acceleration level is minimal. Veeam Backup & Replication populates the global cache. With every new 
job cycle, Veeam Backup & Replication updates the global cache to include the most “popular” data 
blocks and the WAN acceleration efficiency increases.  

Note: 

 

You can populate the global cache before you run the remote job for the first time. In this case, 
Veeam Backup & Replication will use the global cache starting from the first session of the remote 
job, and the WAN traffic will be minimal. For more information, see Population of Global Cache. 
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Many to One WAN Acceleration 

The WAN global cache can be used by several source WAN accelerators simultaneously. For example, 
if you have several remote/branch offices, you can configure several source WAN accelerators in 
remote sites and one target WAN accelerator in the head office. 

In this case, the global cache will hold cache data for separate source WAN accelerators. The cache 
data for every source WAN accelerator will be stored in a dedicated subfolder in the global cache 
folder.  

 

When one target WAN accelerator is used by several source WAN accelerators, Veeam Backup & 
Replication can copy data blocks between global cache subfolders created for them.  

For example, you have two backup copy jobs: Job 1 and Job 2. The Job 1 uses the source WAN 
accelerator Source 1 and the target WAN accelerator Target 3. The Job 2 uses the source WAN 
accelerator Source 2 and the same target WAN accelerator Target 3. In the global cache folder, Veeam 
Backup & Replication will create two subfolders: Source 1 and Source 2.  

Imagine that the Job 1 processes a VM running Microsoft Windows 2008 R2 and it has been running 
for some time. In the global cache, there is already data for this type of OS.  

Now imagine that Job 2 should also process a VM running Microsoft Windows 2008 R2. When you start 
the Job 2 for the first time, in its global cache subfolder there is no data for this type of OS. In such 
situation, Veeam Backup & Replication will simply copy the necessary data block from the Source 1 
cache folder to the Source 2 cache folder and will not transport this data block over the WAN.  

Note: 

 

Beside using global cache of other WAN accelerator, Veeam Backup & Replication also utilizes 
backup files residing on the backup repository. For example, if the backup repository contains a 
backup file created with a backup job and the backup copy job starts copying a backup of a VM of 
the same type, Veeam Backup & Replication will populate global cache on the WAN accelerator from 
the backup file not to transfer redundant data over the WAN. 
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Population of Global Cache 

You can manually pre-populate the global cache to avoid the situation when the cache remains 
empty. As a result, by the time a remote job starts, the global cache will contain data blocks that can 
be used for data deduplication.  

Population of the global cache can be helpful in the following scenarios: 

 First run of a remote job. When you run a first session of a remote job, the global cache is 
empty, and the whole amount of VM data needs to be transferred over the WAN. It is 
recommended that you populate the global cache before you start a remote job for the first 
time. 

 Global cache corruption. If the global cache gets corrupted for some reason, Veeam Backup & 
Replication needs to perform at least one remote job session to replace corrupted data blocks 
with valid data blocks. In this situation, you can clean the global cache and populate it with 
valid data before a remote job begins.  

Limitations for the Global Cache Population 
The global cache population task has the following limitations: 

1. Veeam Backup & Replication does not use encrypted backups for global cache population. 

2. You can start the global cache population task for the target WAN accelerator that is not 
currently used by any remote job. 

3. If the global cache population task is currently running, the corresponding target WAN 
accelerator is locked. You cannot start any remote job using this target WAN accelerator. 

4. [For global cache corruption scenario] You must clean the global cache before you populate 
it with valid data. If the global cache contains data blocks, Veeam Backup & Replication will 
fail to perform the population task. 
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How Global Cache Population Works 

Global cache population is a manual operation performed by the user. When you run the global cache 
population task, Veeam Backup & Replication creates a ‘default cache’ on the target WAN accelerator. 
The default cache is used as a basic, universal cache for every new remote job. 

 To populate the default cache, Veeam Backup & Replication uses backup files stored in backup 
repositories as a source of data. Veeam Backup & Replication writes only data blocks for OSes to the 
default cache. Application data blocks are not written to the cache. 

The procedure of global cache population includes the following steps: 

1. The user starts the global cache population tasks and selects backup repositories from which 
data blocks should be retrieved. 

2. Veeam Backup & Replication scans backup repositories and makes up a list of OSes whose 
data blocks are available in backup files. 

3. Veeam Backup & Replication copies data blocks from backup repositories and populates the 
default cache with these data blocks. 

When a remote job starts, Veeam Backup & Replication renames the default cache to a folder for the 
source WAN accelerator engaged in the job. As a result, Veeam Backup & Replication can use data 
blocks in this folder for deduplication starting from the very first session of a remote job. 

 

In many-to-one WAN accelerator deployment scenarios, the global cache may have folders for other 
source WAN accelerators, and these folders may contain data blocks for some OSes. If the global cache 
already contains some data, the procedure of global cache population includes the following steps: 

1. The user starts the global cache population tasks and selects backup repositories from which 
data blocks should be retrieved. 

2. Veeam Backup & Replication scans backup repositories and makes up a list of OSes whose 
data blocks are available in backup files. 

3. Veeam Backup & Replication scans folders for other source WAN accelerators in the global 
cache and makes up a list of OSes whose data blocks are available there.  

4. The list of OSes in the global cache is compared to the list of OSes in backup repositories. This 
way, Veeam Backup & Replication detects data blocks for which OSes are missing in the 
global cache.  
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5. In the global cache, Veeam Backup & Replication detects a folder with the maximum amount 
of data. This folder is used as a basis for the default cache. 

6. Veeam Backup & Replication copies data blocks only for missing OSes from backup 
repositories and populates the default cache with these blocks. Data blocks for OSes available 
in folders for other source WAN accelerators are not copied to the default cache during the 
population task. Veeam Backup & Replication copies these data blocks on the fly, when a 
remote job runs. For more information, see Many to One WAN Acceleration. 
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How WAN Acceleration Works 
When you create a remote job, you can select to use WAN acceleration in its properties.  

The procedure of data copying with WAN acceleration enabled is performed in the following way: 

1. [For backup copy job] Veeam Backup & Replication uncompresses the backup file to analyze 
its content.  

2. The Veeam WAN Accelerator Service on the source WAN accelerator analyzes data blocks of 
the file to be transferred and creates a file with digests for these data blocks. The created file 
with digests is stored to the VeeamWAN folder on the source WAN accelerator. 

3. Veeam Backup & Replication compresses the backup file data (for backup copy) or VM data 
(for replication) and copies it to the target side.  

At this point, Veeam Backup & Replication can perform deduplication within the VM itself — 
that is, deduplicate identical data blocks in every VM disk. 

4. During the data transfer process, the Veeam WAN Accelerator Service on the target WAN 
accelerator populates the global cache storage with data blocks from the copied file.  

5. During the next job cycle, the Veeam WAN Accelerator Service on the source WAN accelerator 
analyzes data blocks in the file that should be transferred this time and creates digests for 
these data blocks. 

6. The Veeam WAN Accelerator Service compares the created digests with the digests that have 
been previously stored to the VeeamWAN folder on the source WAN accelerator. If duplicate 
data blocks are found, the actual data block in the backup file is not copied over the WAN. 
Instead, it is taken from the global cache and written to the restore point in the backup copy 
folder or on the target data volume. 

7. Additionally, Veeam Backup & Replication analyzes restore points that have been previously 
copied to the target side. If duplicates are found, Veeam Backup & Replication does not copy 
such blocks over the WAN but takes them from the previously copied restore points.  

As a result, Veeam Backup & Replication copies only new data blocks to the target side and uses data 
blocks that are already stored in the global cache or in restore points on the target backup repository. 

If the target WAN accelerator is used by several jobs, the target backup repository may already contain 
data blocks of the necessary VM type. In this situation, Veeam Backup & Replication will copy the 
required data blocks to the global cache before the copying process starts and use these data blocks 
further on. For more information, see Many to One WAN Acceleration. 
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Data Block Verification 
During the VM copy process, Veeam Backup & Replication performs a CRC check for the VM traffic 
going between the source and target WAN accelerators. The CRC check helps ensure that the correct 
VM data goes to the target side and no corrupted data blocks are written to the global cache or to 
backup files in the target backup repository.  

The check is performed in the following way: 

1. Before sending a data block to the target side, Veeam Backup & Replication calculates a 
checksum for the copied data block.  

2. Once the data block is copied over the WAN and before it is written to the global cache or to 
the target backup repository, Veeam Backup & Replication re-calculates the checksum for this 
data block on the target side.  

3. The source and target checksums are compared. If the checksums do not coincide, the target 
WAN accelerator sends a request to the source WAN accelerator for the correct data block. 
The source WAN accelerator re-sends the necessary data blocks to the target WAN accelerator 
as is and the re-sent data block is written to the global cache or to the backup file on the 
target backup repository on the fly. 
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Data Transport on WAN Disconnect 
If you replicate VMs over WAN accelerators and a WAN connection drops during VM data transfer, 
Veeam Backup & Replication does not finish the job with a failed status. Instead, it automatically 
resumes the data transfer process from the point when the connection was lost. The resume on 
disconnect capability improves the reliability of offsite replication, reduces the backup window and 
minimizes the load on the WAN link. 

After a WAN connection is resumed, Veeam Backup & Replication starts a new data transfer cycle. Data 
transported with every new transport cycle is written to a new working snapshot of a VM replica. As 
the WAN connection may drop several times, Veeam Backup & Replication can create a number of 
working snapshots.  

Not to keep long snapshot chains, Veeam Backup & Replication merges earlier snapshots and 
maintains only two working snapshots for the VM replica. When all VM data is transferred to the target 
host, the two working snapshots are also merged to create one fully functional VM restore point.  

 

 If the WAN link is weak and drops constantly, Veeam Backup & Replication may fail to transport VM 
data by the time a new replication job session starts. In this case, during a new replication job session 
Veeam Backup & Replication attempts to transfer VM data that have changed since the last replication 
job session and VM data that were not transferred during the previous replication job session. 
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Resume on Disconnect 
Veeam Backup & Replication can handle a situation of an unstable network during the backup and 
replication jobs. If a network connection drops for a short period of time during the data transport 
process, Veeam Backup & Replication automatically resumes the dropped network connection. The 
data transfer process starts from the point when the connection was lost. The resume on disconnect 
capability improves the reliability of remote data transfer, reduces the backup window and minimizes 
the network load. 

Veeam Backup & Replication automatically re-establishes a connection between the following backup 
infrastructure components engaged in the data transfer process: 

 Backup server 

 Backup proxies 

 [For replication jobs] Backup repository storing VM replica metadata 

Resume on disconnect works only for dropped network connections. Veeam Backup & Replication 
attempts to resume the connection with an interval of 15 seconds during 30 minutes. If the problem 
has any other nature, Veeam Backup & Replication retries the job in a regular manner.  

 

Veeam Backup & Replication does not create a new restore point on resume: VM data is written to the 
same restore point that was created for the current job session. When resuming the data transfer 
process, Veeam Backup & Replication regards VM disks, not the whole VM.  

For example, a VM has two disks: disk A and disk B. Before the connection dropped, 
Veeam Backup & Replication managed to transfer 20 GB of disk A and did not start transferring disk B. 
After the connection is re-established, Veeam Backup & Replication will start transferring the data for 
disk A from the 20 GB point; data of the whole disk B will be transferred anew. 
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Data Encryption 
Data security is an important part of the backup strategy. You must protect your information from 
unauthorized access, especially if you back up sensitive VM data to offsite locations or archive it to 
tape. To keep your data safe, you can use data encryption. 

Data encryption transforms data to an unreadable, scrambled format with the help of a cryptographic 
algorithm and a secret key. If encrypted data is intercepted, it cannot be unlocked and read by the 
eavesdropper. Only intended recipients who know the secret key can reverse encrypted information 
back to a readable format.  

In Veeam Backup & Replication, encryption works at the following levels: 

 Backup job 

 Backup copy job 

 VeeamZIP 

 Tapes in media pools 

Veeam Backup & Replication uses the block cypher encryption algorithm. Encryption works at the 
source side (unless you run a backup copy job via WAN accelerators). Veeam Backup & Replication 
reads VM or file data, encodes data blocks, transfers them to the target side in the encrypted format 
and stores the data to a file on the backup repository or archives the data to tape. Data decryption is 
also performed on the source side: Veeam Backup & Replication transfers encrypted data back to the 
source side and decrypts it there.  

 

Beside the job-level encryption, Veeam Backup & Replication allows you to encrypt network traffic 
going between the primary site and the disaster recovery site. Network traffic encryption is configured 
as part of global network traffic rules that are set for backup infrastructure components. For network 
traffic encryption, Veeam Backup & Replication uses the 256-bit Advanced Encryption Standard (AES). 

Important! 

 

Data encryption has a negative effect on the deduplication ratio if you use a deduplicating storage 
appliance as a target. Veeam Backup & Replication uses different encryption keys for every job 
session. For this reason, encrypted data blocks sent to the deduplicating storage appliances appear 
as different though they may contain duplicate data. If you want to achieve a higher deduplication 
ratio, you can disable data encryption. 



 

337   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Encryption Standards 
Veeam Backup & Replication uses the following industry-standard data encryption algorithms: 

Data Encryption 
 To encrypt data blocks in backup files and files archived to tape, Veeam Backup & Replication 

uses the 256-bit AES with a 256-bit key length in the CBC-mode. For more information, see 
http://csrc.nist.gov/publications/fips/fips197/fips-197.pdf. 

 To generate a key based on a password, Veeam Backup & Replication uses the Password-
Based Key Derivation Function, PKCS #5 version 2.0. Veeam Backup & Replication uses 10,000 
HMAC-SHA1 iterations and a 512-bit salt. For more information, see 
http://csrc.nist.gov/publications/nistpubs/800-132/nist-sp800-132.pdf. 

Enterprise Manager Keys 
 To generate Enterprise Manager keys required for data restore without a password, Veeam 

Backup & Replication uses the RSA algorithm with a 4096-bit key length.  

 To generate a request for data restore from a backup server, Veeam Backup & Replication 
uses the RSA algorithm with a 2048-bit key length. 

For more information, see http://www.emc.com/emc-plus/rsa-labs/standards-initiatives/pkcs-rsa-
cryptography-standard.htm.  

Encryption Libraries 
For Microsoft Windows-based repositories, Veeam Backup & Replication uses the Windows Crypto API 
complying with the Federal Information Processing Standards (FIPS 140). For more information, see 
http://csrc.nist.gov/groups/STM/cmvp/standards.html.  

Veeam Backup & Replication uses the following cryptographic service providers: 

 Microsoft Base Cryptographic Provider: http://msdn.microsoft.com/en-
us/library/windows/desktop/aa386980(v=vs.85).aspx  

 Microsoft Enhanced RSA and AES Cryptographic Provider: http://msdn.microsoft.com/en-
us/library/windows/desktop/aa386979(v=vs.85).aspx  

 Microsoft Enhanced Cryptographic Provider: http://msdn.microsoft.com/en-
us/library/windows/desktop/aa386986(v=vs.85).aspx 

For Linux-based repositories, Veeam Backup & Replication uses a statically linked OpenSSL encryption 
library, without the FIPS 140 support. For more information, see http://www.openssl.org/.  

http://csrc.nist.gov/publications/fips/fips197/fips-197.pdf
http://csrc.nist.gov/publications/nistpubs/800-132/nist-sp800-132.pdf
http://www.emc.com/emc-plus/rsa-labs/standards-initiatives/pkcs-rsa-cryptography-standard.htm
http://www.emc.com/emc-plus/rsa-labs/standards-initiatives/pkcs-rsa-cryptography-standard.htm
http://csrc.nist.gov/groups/STM/cmvp/standards.html
http://msdn.microsoft.com/en-us/library/windows/desktop/aa386980(v=vs.85).aspx
http://msdn.microsoft.com/en-us/library/windows/desktop/aa386980(v=vs.85).aspx
http://msdn.microsoft.com/en-us/library/windows/desktop/aa386980(v=vs.85).aspx
http://msdn.microsoft.com/en-us/library/windows/desktop/aa386980(v=vs.85).aspx
http://msdn.microsoft.com/en-us/library/windows/desktop/aa386980(v=vs.85).aspx
http://msdn.microsoft.com/en-us/library/windows/desktop/aa386986(v=vs.85).aspx
http://msdn.microsoft.com/en-us/library/windows/desktop/aa386986(v=vs.85).aspx
http://www.openssl.org/
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Encryption Algorithms 
To encrypt data in backups and files, Veeam Backup & Replication employs a symmetric key 
encryption algorithm. 

The symmetric, or single-key encryption algorithm, uses a single, common secret key to encrypt and 
decrypt data. Before data is sent to target side, it is encoded with a secret key. To restore encrypted 
data, you must have the same secret key. Users who do not have the secret key cannot decrypt data 
and get access to it. 
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Veeam Backup & Replication relies on a hierarchical encryption scheme. Each layer in the hierarchy 
encrypts the layer below with a key of specific type. 
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Encryption Keys 

An encryption key is a string of random characters that is used to bring data to a scrambled format 
and back to unscrambled. Encryption keys encode and decode initial data blocks or underlying keys in 
the key hierarchy. 

Veeam Backup & Replication uses 8 types of keys:  

 3 service keys generated by Veeam Backup & Replication:  

• Session key 

• Metakey 

• Storage key 

 1 key generated based on a user password: a user key. 

 A pair of keys used for data recovery without a password — Enterprise Manager keys. 

 A pair of keys used for identity verification of the backup server — backup server keys.  

Session Keys and Metakeys 

The session key is the lowest layer in the encryption key hierarchy. When Veeam Backup & Replication 
encrypts data, it first encodes every data block in a file with a session key. For session keys, Veeam 
Backup & Replication uses the AES algorithm with a 256-bit key length in the CBC-mode.  

Veeam Backup & Replication generates a new session key for every job session. For example, if you 
have created an encrypted backup job and run 3 job sessions, Veeam Backup & Replication will 
produce 3 backup files that will be encrypted with 3 different session keys: 

 Full backup file encrypted with session key 1 

 Incremental backup file encrypted with session key 2 

 Incremental backup file encrypted with session key 3 

 

The session key is used to encrypt only data blocks in backup files or files archived to tape. To encrypt 
backup metadata, Veeam Backup & Replication applies a separate key — metakey. Use of a metakey 
for metadata raises the security level of encrypted backups. 

For every job session, Veeam Backup & Replication generates a new metakey. For example, if you have 
run 3 job sessions, Veeam Backup & Replication will encrypt metadata with 3 metakeys. 
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In the encryption process, session keys and metakeys are encrypted with keys of a higher layer — 
storage keys. Cryptograms of session keys and metakeys are stored to the resulting file next to 
encrypted data blocks. Metakeys are additionally kept in the Veeam Backup & Replication database. 

Storage Keys 

Backup files in the backup chain often need to be transformed, for example, in case you create a 
reverse incremental backup chain. When Veeam Backup & Replication transforms a full backup file, it 
writes data blocks from several restore points to the full backup file. As a result, the full backup file 
contains data blocks that are encrypted in different job sessions with different session keys.  

To restore data from such “composed” backup file, Veeam Backup & Replication would require a 
bunch of session keys. For example, if the backup chain contains restore points for 2 months, Veeam 
Backup & Replication would have to keep session keys for a 2-month period. 

 

In such situation, storing and handling session keys would be resource consuming and complicated. 
To facilitate the encryption process, Veeam Backup & Replication introduces another type of service 
key — a storage key. 

For storage keys, Veeam Backup & Replication uses the AES algorithm. A storage key is directly 
associated with one restore point in the backup chain. The storage key is used to encrypt the 
following keys in the encryption hierarchy: 

 All session keys for all data blocks in one restore point 

 Metakey encrypting backup metadata 

 

During the restore process, Veeam Backup & Replication uses one storage key to decrypt all session 
keys for one restore point, no matter how many session keys were used to encrypt data blocks in this 
restore point. As a result, Veeam Backup & Replication does not need to keep the session keys history 
in the Veeam Backup & Replication database. Instead, it requires only one storage key to restore data 
from one file. 

In the encryption process, storage keys are encrypted with keys of a higher layer — user keys and 
optionally a public Enterprise Manager key. Cryptograms of storage keys are stored to the resulting file 
next to encrypted data blocks, and cryptograms of session keys and metakeys.  

Storage keys are also kept in the Veeam Backup & Replication database. To maintain a set of valid 
storage keys in the database, Veeam Backup & Replication uses retention policy settings specified for 
the job. When some restore point is removed from the backup chain by retention, the storage key 
corresponding to this restore point is also removed from the Veeam Backup & Replication database. 
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User Keys 

When you enable encryption for a job, you must define a password to protect data processed by this 
job, and define a hint for the password. The password and the hint are saved in the job settings. Based 
on this password, Veeam Backup & Replication generates a user key.  

The user key protects data at the job level. In the encryption hierarchy, the user key encrypts storage 
keys for all restore points in the backup chain.  

 

During the encryption process, Veeam Backup & Replication saves a hint for the password to the 
encrypted file. When you decrypt a file, Veeam Backup & Replication displays a hint for the password 
that you must provide. After you enter a password, Veeam Backup & Replication derives a user key 
from the password and uses it to unlock the storage key for the encrypted file. 

According to the security best practices, you must change passwords for encrypted jobs regularly. 
When you change a password for the job, Veeam Backup & Replication creates a new user key and 
uses it to encrypt new restore points in the backup chain. 

Important! 

 

You must always remember passwords set for jobs or save these passwords in a safe place. If you lose 
or forget the password, you can restore data from a backup file by issuing a request to Veeam 
Backup Enterprise Manager. For more information, see How Decryption Without Password Works. 

  



 

343   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Enterprise Manager Keys 

In some cases, a password required for data decryption may be lost or forgotten, or a user who knows 
the password may leave your organization. As a result, you cannot recover data from backups or tapes 
encrypted with this password, and encrypted data becomes unusable.  

Veeam Backup & Replication offers you a way to restore encrypted data even if you do not have a 
password. For this purpose, Veeam Backup & Replication employs an additional pair of keys in the 
encryption process — Enterprise Manager keys. 

Enterprise Manager keys is a pair of matching RSA keys: a public key and a private key. The public 
Enterprise Manager key is used to encrypt data, while the private Enterprise Manager key is used to 
decrypt data encrypted with the public key.  

 

In the encryption process, Enterprise Manager keys perform a role similar to the user key: the public 
Enterprise Manager key encrypts storage keys and the private Enterprise Manager key decrypts them. 
Technically, Enterprise Manager keys offer an alternative to the user key. When you create an 
encrypted backup file or archive encrypted data to tape, Veeam Backup & Replication encrypts 
storage keys with two types of keys simultaneously: 

 User key 

 Public Enterprise Manager key 

 

When you decrypt a file and the password is lost, Veeam Backup & Replication cannot derive the user 
key from the password. In this situation, you can send a request to Veeam Backup Enterprise Manager. 
Veeam Backup Enterprise Manager will employ the private Enterprise Manager key instead of the user 
key to unlock storage keys and decrypt the file content. For more information, see How Decryption 
Without Password Works. 
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Enterprise Manager keys take part in the encryption process if the following two conditions are met: 

1. You have Veeam Backup & Replication Enterprise or Enterprise Plus Edition. 

2. You have Veeam Backup Enterprise Manager installed and your backup servers are connected 
to Veeam Backup Enterprise Manager. 

Enterprise Manager keys make up a pair of matching keys – a keyset. Enterprise Manager keysets are 
created and managed on the Veeam Backup Enterprise Manager server. During installation of Veeam 
Backup Enterprise Manager, the setup automatically generates a new keyset containing a public 
Enterprise Manager key and a private Enterprise Manager key. You can use Veeam Backup Enterprise 
Manager to create new Enterprise Manager keysets, activate them, import and export keysets and 
specify retention for their lifetime.  

The public Enterprise Manager key is made publicly available to backup servers. When you connect 
backup servers to Veeam Backup Enterprise Manager, the public Enterprise Manager key is 
automatically propagated to these backup servers.  

 

Veeam Backup Enterprise Manager acts as a manager for public Enterprise Manager keys but does not 
store these keys. After the public Enterprise Manager key is propagated to the backup server, it is kept 
in the Veeam Backup & Replication database.  

Private Enterprise Manager keys, on the contrary, are not distributed anywhere: they are kept only on 
Veeam Backup Enterprise Manager.  
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Backup Server Keys 

Eavesdroppers may potentially use Veeam Backup Enterprise Manager to unlock files encrypted with 
Veeam Backup & Replication. If the eavesdropper intercepts an encrypted file, s/he may generate a 
request for file unlocking and send such request to Veeam Backup Enterprise Manager Administrators. 
Having received a response from Veeam Backup Enterprise Manager, the eavesdropper will be able 
unlock the encrypted file without a password.  

To protect you against the “man-in-the-middle” attack, Veeam Backup & Replication uses backup 
server keys. Backup server keys are a pair of RSA keys, public and private, that are generated on the 
backup server.  

 The public backup server key is sent to Veeam Backup Enterprise Manager to which the 
backup server is connected, and saved in the Veeam Backup Enterprise Manager database. 

 The private backup server key is kept on the backup server in the Veeam Backup & 
Replication database. 

Backup server keys are used to authenticate the identity of the request sender. When the backup 
server generates a request to unlock a file, it adds a signature encrypted with the private backup 
server key to this request.  

When Veeam Backup Enterprise Manager processes the request, it uses the public backup server key 
to decrypt the signature and identify the request sender. If the backup server used for request 
generation is not added to Veeam Backup Enterprise Manager, Veeam Backup Enterprise Manager will 
not find a matching public key in its database. As a result, Veeam Backup Enterprise Manager will not 
be able to identify the sender and the storage key decryption process will fail. 
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How Data Encryption Works 

Data encryption is performed as part of backup, backup copy or archiving to tape processes. 
Encryption works at the source side, before data is transported to the target. As a result, encryption 
keys are not passed to the target side, which helps avoid data interception. 

Note: 

 

The procedure below describes the encryption process for backup, backup copy jobs and VeeamZIP 
tasks. For more information about encrypting data on tapes, see Tape Encryption. 

The encryption process includes the following steps: 

1. When you create a new job, you enable the encryption option for the job and enter a 
password to protect data at the job level.  

2. Veeam Backup & Replication generates a user key based on the entered password. 

3. When you start an encrypted job, Veeam Backup & Replication creates a storage key and 
stores this key to the Veeam Backup & Replication database.  

4. Veeam Backup & Replication creates a session key and a metakey. The metakey is stored to 
the Veeam Backup & Replication database. 

Veeam Backup & Replication processes job data in the following way:  

a. The session key encrypts data blocks in the backup file. The metakey encrypts 
backup metadata. 

b. The storage key encrypts the session key and the metakey. 

c. The user key encrypts the storage key. 

d. If you use Enterprise or Enterprise Plus Edition of Veeam Backup & Replication and 
the backup server is connected to Veeam Backup Enterprise Manager, the 
Enterprise Manager key also encrypts the storage key. 

5. Encrypted data blocks are passed to the target. The cryptograms of the public Enterprise 
Manager key (if used), user key, storage key, session key and metakey are stored to the 
resulting file next to encrypted data blocks.  
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If you use Enterprise or Enterprise Plus Edition of Veeam Backup & Replication and the backup 
server is connected to Veeam Backup Enterprise Manager, Veeam Backup & Replication saves 
two cryptograms of the storage key to the resulting file: one encrypted with the user key (c) 
and one encrypted with the Enterprise Manager key (d). Saving the cryptogram twice helps 
Veeam Backup & Replication decrypt the file even if a password is lost or forgotten. For more 
information, see How Decryption Without Password Works.  
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How Data Decryption Works 

When you restore data from an encrypted backup file, Veeam Backup & Replication performs data 
decryption automatically in the background or requires you to provide a password. 

 If encryption keys required to unlock the backup file are available in the 
Veeam Backup & Replication database, you do not need to enter the password. 
Veeam Backup & Replication uses keys from the database to unlock the backup file. Data 
decryption is performed in the background, and data restore does not differ from that from 
an unencrypted one. 

Automatic data decryption is performed if the following conditions are met: 

1. You encrypt and decrypt the backup file on the same backup server using the same 
Veeam Backup & Replication database. 

2. [For backup file] The backup is not removed from the Veeam Backup & Replication 
console. 

 If encryption keys are not available in the Veeam Backup & Replication database, you need to 
provide a password to unlock the encrypted file. 

Data decryption is performed at the source side, after data is transported back from the target side. As 
a result, encryption keys are not passed to the target side, which helps avoid data interception. 

Note: 

 

The procedure below describes the decryption process for backup, backup copy jobs and VeeamZIP 
tasks. For more information about decrypting tape data, see Tape Encryption. 

The decryption process includes the following steps. Note that steps 1 and 2 are required only if you 
decrypt the file on the backup server other than the backup server where the file was encrypted. 

1. You import the file to the backup server. Veeam Backup & Replication notifies you that the 
imported file is encrypted and requires a password.  

2. You specify a password for the imported file. If the password has changed once or several 
times, you need to specify the password in the following manner: 

 If you select a .vbm file for import, you must specify the latest password that was 
used to encrypt files in the backup chain. 

 If you select a full backup file for import, you must specify the whole set of 
passwords that were used to encrypt files in the backup chain.  

3. Veeam Backup & Replication reads the entered password and generates the user key based 
on this password. With the user key available, Veeam Backup & Replication performs 
decryption in the following way: 

a. Veeam Backup & Replication applies the user key to decrypt the storage key.  

b. The storage key, in its turn, unlocks underlying session keys and a metakey. 

c. Session keys decrypt data blocks in the encrypted file. 

After the encrypted file is unlocked, you can work with it as usual. 
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If you have lost or forgotten a password for an encrypted file, you can issue a request to Veeam 
Backup Enterprise Manager and restore data from an encrypted file using Enterprise Manager keys. 
For more information, see Enterprise Manager Keys and How Decryption Without Password Works. 
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How Decryption Without Password Works 

When you import an encrypted backup file or tape media to the backup server, you need to enter a 
password to decrypt data. In some cases, however, a password can be lost or forgotten. Veeam Backup 
& Replication offers a way to restore data from encrypted backups or tapes even if a password is not 
available.  

You can restore of data from encrypted backups or tapes without a password only if your backup 
infrastructure meets the following conditions: 

1. You use Enterprise or Enterprise Plus Edition of Veeam Backup & Replication. 

2. The backup servers on which you encrypted data is added to Veeam Backup Enterprise 
Manager.  

3. The backup server on which you generate a request for data decryption is added to Veeam 
Backup Enterprise Manager. 

If the backup server on which you encrypt data is added to Veeam Backup Enterprise Manager, Veeam 
Backup & Replication employs the public Enterprise Manager key in the encryption process. To 
decrypt backups or tapes encrypted with the public Enterprise Manager key, you can apply a 
matching private Enterprise Manager key, instead of a password. The private Enterprise Manager key 
unlocks the underlying storage keys and lets you access the content of an encrypted file.  

The restore process is accomplished with the help of two wizards that run on two servers:  

1. The Encryption Key Restore wizard on the backup server. 

2. The Password Recovery wizard on the Veeam Backup Enterprise Manager server. 

The restore process includes the next steps: 

1. You start the Encryption Key Restore wizard on the backup server to issue a request for data 
recovery.  

2. The Encryption Key Restore wizard generates a request to Veeam Backup Enterprise 
Manager. The request has the format of a text document and contains cryptograms of 
storage keys that must be decrypted, together with information about the public Enterprise 
Manager key that was used to encrypt data. At the end of the request, the backup server adds 
a signature encrypted with a private backup server key. 

3. You send the request to the Veeam Backup Enterprise Manager Administrator, for example, 
via email. 

4. The Veeam Backup Enterprise Manager Administrator starts the Password Recovery wizard 
on Veeam Backup Enterprise Manager and inserts the text of the request to the wizard.  

5. Veeam Backup Enterprise Manager finds a matching public backup server key in Veeam 
Backup Enterprise Manager database and decrypts the signature with this key.  

6. Veeam Backup Enterprise Manager decrypts storage keys with the private Enterprise Manager 
key available on Veeam Backup Enterprise Manager, and generates a response in the 
Password Recovery wizard. The response has the format of a text document and contains 
decrypted storage keys. 

7. The Veeam Backup Enterprise Manager Administrator sends the response to you, for 
example, via email. 

8. You input the request to the Encryption Key Restore wizard. Veeam Backup & Replication 
processes the response, retrieves the decrypted storage keys and uses them to unlock 
encrypted backups or tapes and retrieve their content. 
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Important! 

 

You can recover data only if Veeam Backup Enterprise Manager has a private Enterprise Manager key 
matching the public Enterprise Manager key that was used for data encryption. If a matching private 
Enterprise Manager key is not found in the Veeam Backup Enterprise Manager database, the 
Password Recovery wizard will fail. In such situation, you can import a necessary private Enterprise 
Manager key via the import procedure. For more information, see Exporting and Importing Enterprise 
Manager Keys in Veeam Backup Enterprise Manager User Guide.  
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Encrypted Objects 
The encryption algorithm works at the job level and media pool level. You can enable encryption for 
the following types of jobs: 

 Backup job 

 Backup copy job  

 Backup to tape job 

 VeeamZIP 

 Tape encryption 

Backup Job Encryption 

Encryption for a backup job is configured in the advanced job settings. You should enable the 
encryption option and specify a password to protect data in backup files produced by the backup job. 

 

The backup job processing with encryption enabled includes the following steps: 

1. You enable encryption for a backup job and specify a password.  

2. Veeam Backup & Replication generates the necessary keys to protect backup data.  

3. Veeam Backup & Replication encrypts data blocks on the backup proxy, either the dedicated 
or default one, and transfers them to the backup repository already encrypted. 

4. On the backup repository, encrypted data blocks are stored to a resulting backup file. 
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Restore of an encrypted backup file includes the following steps: 

1. You import a backup file and define a password to decrypt the backup file. If the password 
has changed once or several times, you need to specify the password in the following 
manner: 

 If you import an incremental backup file, you need to specify the latest password 
that was used to encrypt files in the backup chain. 

 If you import a full backup file, you need to specify the whole set of passwords that 
were used to encrypt files in the backup chain. 

2. Veeam Backup & Replication uses the provided password(s) to generate user key(s) and 
unlock the subsequent keys for backup file decryption.  

3. Veeam Backup & Replication retrieves data blocks from the backup file, sends them to the 
source side and decrypts them on the backup proxy, either the dedicated or default one.  
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Backup Copy Job Encryption 

Encryption for a backup copy job is configured in the advanced job settings. You should enable the 
encryption option and specify a password to protect data in backup files produced by the backup 
copy job. 

 

The workflow of the encrypted backup copy job depends on the path for data transfer:  

 Direct data path 

 Data path via WAN accelerators 
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Direct Data Path 

If you use a direct data path to transfer backups to the target backup repository, the encrypted backup 
copy job includes the following steps: 

1. You enable encryption for a backup copy job and specify a password.  

2. Veeam Backup & Replication generates the necessary keys to protect backup files produced 
by the backup copy job.  

3. Veeam Backup & Replication encrypts data blocks on the source side and transfers them to 
the target backup repository.  

4. On the target backup repository, encrypted data blocks are stored to a resulting backup file. 

 

An encrypted backup copy job may use an encrypted backup file as a source. In this situation, Veeam 
Backup & Replication does not perform double encryption. The backup copy job includes the 
following steps: 

1. Veeam Backup & Replication decrypts data blocks of the encrypted source backup file. For the 
decryption process, it uses the storage key and metakeys stored in the Veeam Backup & 
Replication database.  

2. Veeam Backup & Replication generates the necessary keys to protect backup files produced 
by the backup copy job.  

3. Veeam Backup & Replication encrypts data blocks on the source side using these keys and 
transfers encrypted data blocks to the target backup repository.  

4. On the target backup repository, encrypted data blocks are stored to a resulting backup file. 
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The restore process for backups produced by backup copy jobs does not differ from that for backup 
jobs. 

Via WAN Accelerators 

WAN accelerators require reading data on the target side to perform such operations as global data 
deduplication, backup health check and so on. For this reason, if you use WAN accelerators for backup 
copy jobs, the encryption process is performed on the target side.  

The backup copy job processing via WAN accelerators includes the following steps: 

1. You enable encryption for a backup copy job and specify a password.  

2. Veeam Backup & Replication generates necessary keys to protect backup files produced by 
the backup copy job.  

3. Data blocks are passed to the target backup repository in the unencrypted format. 

4. Received data blocks are encrypted on the target site and stored to a resulting backup file on 
the target backup repository. 
 

 

The restore process in this case does not differ from that for backup jobs. Veeam Backup & Replication 
retrieves data blocks from the backup file on the target backup repository, sends them to the source 
side and decrypts them on the source side. 
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When transporting data between WAN accelerators that face external networks, Veeam Backup & 
Replication encrypts the network traffic by default. For network traffic encryption, Veeam Backup & 
Replication uses the 256-bit Advanced Encryption Standard (AES). For more information, see Enabling 
Network Data Encryption. 

VeeamZIP Encryption 

If you want to create an encrypted VeeamZIP file, you should enable the encryption option and 
specify a password in VeeamZIP task options. 

 

Data processing during VeeamZIP file creation and restore from a VeeamZIP file does not differ from 
that of a backup job. 
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Tape Encryption 

Veeam Backup & Replication supports two types of encryption for tape media: 

 Hardware level: library- and driver-managed encryption mechanisms provided by the tape 
vendor 

 Software level: the encryption mechanism provided by Veeam Backup & Replication 

Hardware encryption has a higher priority. If hardware encryption is enabled for the tape media, 
Veeam Backup & Replication automatically disables its software encryption mechanism for such tape 
libraries. The Veeam encryption mechanism can only be used if hardware encryption is disabled at the 
tape device level or not supported. 

To use the Veeam encryption mechanism, you need to enable encryption at the level of media pool. In 
this case, Veeam Backup & Replication will encrypt data for all jobs that use tapes from the this media 
pool. Encryption is supported for both types of tape jobs: 

 Backup to tape jobs 

 File to tape jobs 

 

Encryption of data on tapes includes the following steps: 

1. You enable encryption for a media pool and specify a password. 

2. You select the media pool as a target for a backup to tape or file to tape job. 

3. Veeam Backup & Replication generates the necessary keys to protect data archived to tape.  

4. During the backup to tape or file to tape job, the key is passed to the target side. In case of 
hardware encryption, Veeam Backup & Replication passes the key to the tape device, and the 
tape device uses its mechanism to encrypt data on tapes. In case of software encryption, 
Veeam Backup & Replication passes the keys to the tape server, and encrypts data when it is 
archived to tape. 
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Backup to tape jobs allow double encryption. The backup to tape job uses a backup file as a source of 
data. If the backup file is encrypted with the initial backup job and the encryption option is enabled 
for the backup to tape job, too, the resulting backup file will be encrypted twice. To decrypt such 
backup file, you will need to subsequently enter two passwords:  

 Password for a backup to tape job  

 Password for the media pool 
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Restore of encrypted data from tape includes the following steps: 

1. You insert tape with encrypted data into the tape drive and perform tape catalogization. The 
catalogization operations lets Veeam Backup & Replication understand what data is written 
to tape.  

2. You provide a password to decrypt data archived to tape.  

3. Veeam Backup & Replication uses the provided password to generate a user key and unlock 
the subsequent keys for data decryption.  

4. Veeam Backup & Replication retrieves data blocks from encrypted files on tapes and decrypts 
them. 
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Encryption Best Practices 
To guarantee the flawless process of data encryption and decryption, consider the following advice. 

Password 
1. Use strong passwords that are hard to crack or guess. Consider the following 

recommendations: 

a. The password must be at least 8 characters long. 

b. The password must contain uppercase and lowercase characters. 

c. The password must be a mixture of alphabetic, numeric and punctuation 
characters. 

d. The password must significantly differ from the password you used previously. 

e. The password must not contain any real information related to you, for example, 
date of birth, your pet’s name, your logon name and so on. 

2. Provide a meaningful hint for the password that will help you recall the password. The hint 
for the password is displayed when you import an encrypted file or tape to the backup server 
and attempt to unlock it. 

3. Keep passwords in the safe place. If you lose or forget your password, you will not be able to 
recover data from backups or tapes encrypted with this password, unless you use Enterprise 
Manager keys in the encryption process. 

4. Change passwords for encrypted jobs regularly. Use of different passwords helps increase the 
encryption security level.  

Data recovery without a password and Enterprise Manager keys 
1. If you use Enterprise or Enterprise Plus Edition of Veeam Backup & Replication, connect 

backup servers to Veeam Backup Enterprise Manager. In this case, Veeam Backup & 
Replication will employ Enterprise Manager keys in the encryption process, which will let you 
to recover data from encrypted backups and tapes even if the password is lost or forgotten. 
For more information, see Decrypting Data Without Password. 

2. Create and activate new Enterprise Manager keysets regularly. When you activate a keyset, 
the public Enterprise Manager key is automatically propagated to backup servers connected 
to Veeam Backup Enterprise Manager and used for encrypted jobs on these servers.  

3. Create backup copies of Enterprise Manager keysets and keep them in a safe place. If your 
installation of Veeam Backup Enterprise Manager goes down for some reason, you will lose 
private Enterprise Manager keys. As a result, you will not be able to use the Veeam Backup 
Enterprise Manager functionality to recover data from backups and tapes without a 
password. For more information, see Decrypting Data Without Password. 
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Tape Device Support 
Veeam provides native tape support that is fully integrated into Veeam Backup & Replication. You can 
administrate all operations on tapes from your Veeam console. 

Long-term archiving and compliance are listed as primary reasons for using tape. Tape appears to be 
one of the most widely used media for offsite backup. Using backup to tape, you can implement the 
‘3-2-1’ backup approach (3 copies, 2 types of media, 1 offsite location) considered as a best practice for 
data protection and disaster recovery. Veeam Backup & Replication offers support for tape devices and 
allows you to archive your data to tape and restore it from tape whenever needed. 

Storing data to tapes provides you with the same data managing options as disk repositories. In 
particular, you can store full and incremental backups, apply user-defined retention settings to the 
archived data, select restore points and so on. Compared to disk storage, tape archive requires more 
time to retrieve files for restore if the tapes are stored offsite. 
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Supported Devices and Configuration 
Veeam Backup & Replication supports the following devices: 

 Linear Tape-Open tape libraries starting from 3 generation (LTO3) or later. 

 Physical libraries and standalone drives, virtual tape libraries. 

 Partitions of the physical or virtual tape libraries presented to the Veeam backup server. 

Note: 

 

If you plan to run both Veeam Backup & Replication and 3rd party tape-recording software (for 
example, in your evaluation lab), consider that Veeam Backup & Replication by default will 
periodically lock the drive to perform rescan, preventing other software from recording. 

Industry Format  
Veeam Backup & Replication uses the MTF (Microsoft Tape Format) industry format to write data to 
tape. 

 Note: 

 

Veeam Backup & Replication does not support using WORM (Write Once Read Many) tapes. 

Data Block Size 
Drives use hardware dependent block sizes to read/write the tape data. To provide compatibility 
between managed drives, Veeam Backup & Replication sets a uniform block size to: 

 all drives in one library  

 all standalone drives connected to one tape server. 

The uniform block size is selected by comparing available sizes supported by drives. 
Veeam Backup & Replication uses the maximum size available that is supported by all drives within 
library/tape server. 

 Note: 

 

If you plan to restore data from tapes on a 3rd party device, check that this device supports the block 
size used by Veeam Backup & Replication to write the tapes. 

Supported Connection Types 
You can connect the tape device directly or remotely. 

 Direct connection: 

• Fibre Channel (FC) 

• Serial Attached SCSI (SAS) 

• SCSI 

 Remote connection:  

• iSCSI 

Unknown Medium Changers 
Veeam supports medium changers that have no Windows drivers available. Such devices must be 
connected over SCSI. Make sure that such device is recognized as the unknown medium changer in 
the Microsoft Device Manager list. 

It is recommended that you use tape devices with original equipment manufacturer (OEM) drivers. 
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System Requirements and Limitation 
Veeam Backup & Replication has the following requirements and limitations to tape devices: 

 If multiple driver installation modes are supported for your storage device, make sure the 
driver is installed in the mode that allows for multiple open handles from a host to a drive to 
exist at the same time. 

 VMware does not support tape drives connected directly to ESX(i) 4.x and later. For more 
information, see VMware vSphere Release Notes. 

For more details and recommendations on configuring vendor-supported tape drives and media 
changers on ESX/ESXi, refer to VMware documentation at http://kb.vmware.com/kb/1016407. 

https://www.vmware.com/support/vsphere5/doc/vsphere-esx-vcenter-server-50-release-notes.html
http://kb.vmware.com/kb/1016407
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Tape Device Deployment 
Tape devices are connected to Veeam Backup & Replication via a tape server. As a tape server, you can 
use any Microsoft Windows server managed by Veeam Backup & Replication. In small installations, you 
can connect the tape device or devices to the Veeam backup server and assign the role of the tape 
server to it. The tape connected devices are recognized by the Veeam Backup & Replication 
automatically. 

Tape traffic loads the tape server a lot. Using the Veeam backup server as the tape server may be 
sufficient for small environments with low traffic workloads. However, if you plan to back up data to 
tape intensely, consider allocating a dedicated tape server to offload the Veeam backup server. You 
can also reconnect your tape device to a dedicated tape server. After the tape device is reconnected, 
the tape infrastructure appears in Veeam Backup & Replication unchanged. 

Using a separate tape server is useful in the following cases: 

 To balance the traffic load in installations with intense data transferring,  

 To configure remote data archiving: you can connect the tape devices to any tape server 
accessible by Veeam Backup & Replication by network. 

 To deploy a number of tape servers managed by one Veeam backup server. 

With Veeam Backup & Replication, the data transfer during archiving and restore processes is enabled 
with Veeam Data Mover services. The Data Movers run on tape servers and other components of 
backup infrastructure. They receive tasks from the Veeam backup server and communicate to each 
other to transfer the data. 

The Data Movers are light-weight services that take a few seconds to deploy. Deployment is fully 
automated: when you assign a tape server role to a server, Veeam Backup & Replication installs the 
necessary components on this server and starts the required services on it. 

You can connect the tape device to the tape server directly over Fibre Channel (FC), Serial Attached 
SCSI (SAS), SCSI or remotely with iSCSI (you can use Microsoft iSCSI initiator to establish the 
connection). 

 

Veeam Backup & Replication allows deploying a number of tape servers. You can connect one or 
several tape devices to one tape server. However, you cannot connect one tape server to several 
Veeam backup servers simultaneously. 
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Tip: 

 

You can easily reconnect a tape server to another Veeam backup server without reconfiguring the 
tape device. Veeam backup server will recognize the library settings automatically. After 
reconnecting the tape library, you must configure backup to tape or file to tape jobs anew or copy 
the Veeam Backup & Replication database configuration file on the new Veeam backup server. For 
more information, see Performing Configuration Backup and Restore. 

Upgrading Existing Tape Installations 
If you have used Veeam Backup & Replication v7 to work with tape media, the 
Veeam Backup & Replication database has information about previously connected tape devices. 
During upgrade, Veeam Backup & Replication will automatically reconfigure the tape device 
connection and assign the role of the tape server to the Veeam backup server. 
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Tape Environment 
To administrate tape backup and restore procedures, you must add the tape server to your 
Veeam Backup & Replication console. Adding the tape server to the backup infrastructure makes 
possible to transfer data between disk storages and the tape archive. 

 

The tape backup and restore process involves the following components: 

Veeam Backup Server 
The Veeam backup server is the server running Veeam Backup & Replication. It is the core component 
in the backup infrastructure. The Veeam backup server tasks include the following operations: 

 Recognizing all tape devices that are connected to it and is able to manage all drives, slots 
and tapes. 

 Administering tape archiving: scheduling and triggering tape jobs and initiating restore tasks. 

 Communicating with the Veeam backup database. 

Tape Device 
When connected to the Veeam backup server, tape devices provide reading and writing capabilities, 
while all administration is performed by the Veeam backup server. You can connect multiple tape 
devices. 

Tape Servers 
To connect to the tape devices, Veeam Backup & Replication uses tape servers. 

The tape server is a backup infrastructure component transferring data between data source and tape 
device. The tape server runs Veeam Data Mover service that creates a communication point over 
which the data between the tape device and backup repositories or file servers is transferred. 

The tape server deployment is fully automated: to create a tape server, you must assign the tape 
server role to a necessary server in the backup infrastructure. You can create a dedicated tape server 
or assign the tape server role to the Veeam backup server. 
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Veeam Backup Database 
Veeam Backup & Replication catalogs information about all archived data and stores this information 
in the Veeam backup database. 

The registered tapes stays in the database until you remove the information about them. You can 
always view details for each tape, for example, information about backups written to it, even if the 
tape is not inserted in the library. 

The catalog lets quickly detect location of the required items on tape. The catalog correlates the 
archived files and their restore points to the names of the corresponding tapes, both online or offline, 
and the names of the media sets within which the data was written. When you start restore, 
Veeam Backup & Replication prompts for the tapes you need to bring online. As a result, you can 
restore data from tape much quicker when necessary. 

Veeam Backup & Replication uses the following catalogs for storing the tape-related data: 

 Tape Catalog stores information about files/folders archived to tape media with file to tape 
jobs, as well as backup files produced by backup to tape jobs. The content of the Tape 
Catalog can be examined in the Files view. 

 Backup Catalog stores information about VMs whose backups are archived to tape media 
with backup to tape jobs. The content of the Backup Catalog can be examined under the 
Backups > Tape node in the Backup & Replication view. 

Backup Repositories and File Servers 
When retrieving data to back up, or restoring data to disk, Veeam Backup & Replication can connect to 
any machine that has been added as a managed server to the Veeam Backup & Replication console.  

Storing devices include the following types: 

 Windows server, including physical boxes 

 Linux server, including physical boxes 

 Deduplicating storage appliances (only for backup to tape jobs) 

 NAS devices (by specifying the SMB path to the share). 
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Media Pools 
Media pools are logical containers created in Veeam Backup & Replication to organize and 
administrate tapes. Veeam Backup & Replication works only with tapes that are placed to one of 
media pools. To introduce tapes to Veeam Backup & Replication, you need to run importing 
procedure against all new tapes you load to your tape devices. Importing registers tapes in the Veeam 
Backup database after which Veeam Backup & Replication places tapes to one of the media pools. 

Veeam Backup & Replication has a number of service media pools that are used for automatic tape 
administration. For example, all newly introduced tapes are placed to the Free media pool. To write 
data to tapes, you need to manually create at least one custom media pool. To run GFS backups, you 
need to create a GFS media pool. 

All Veeam media pools are global. They span tapes that belong to multiple libraries. In a global media 
pool, you can move tapes between the libraries without need to catalog them. For example, if you 
need to restore data from tapes, you can insert the tapes into any tape library in the pool. 

 

Note: 

 

Mind the hardware encryption. If the tapes are encrypted by native hardware means of a tape library, 
you cannot read them at tape device with another encryption standard or with hardware encryption 
turned off. 

Service Media Pools 

Service media pools are used to automatically sort tapes and manage their free capacity for writing 
data. Service media pools are automatically created by Veeam Backup & Replication. The following 
predefined media pools are available: 

 Free — a media pool containing empty tapes. You can use this media pool to replenish 
custom pools with new tapes when needed. 

 Unrecognized — a media pool containing tapes that were loaded to tape device. They need 
further identification by user that can be done by running the inventory or catalog job. 

 Imported — a media pool containing non-empty tapes. These include tapes identified by the 
tape catalog job. 

 Retired — a media pool containing retired tapes that reached the maximal number of re-
writes. This media pool may also contain tapes with some mechanical breakdown. 

You cannot create, modify or delete service media pools. 
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Custom Media Pools 

Custom media pools are target destinations for tape jobs except GFS tape jobs. The custom media 
pools manage empty (or available for overwriting) tapes to allow the tape jobs write data. You can 
create as many custom media pools as you need. One media pool can be target for unlimited number 
of tape jobs. The GFS jobs require GFS media pools. For more information, see GFS Media Pools. 

For each custom media pool, you can configure rules. Such rules are further applied to every tape that 
belongs to this media pool. 

You can apply the following rules: 

 Configure tape replenishment: you can allocate some particular tapes or let the media pool 
take a free tape when required. 

 Create media sets: media sets allow you to create sets of tapes with data for a particular time 
period. 

 Set the data retention period: this setting lets you choose the period for which the data on 
tapes will be protected from overwriting. 

 Enable parallel processing: you can allow the media pool to use multiple tape drives 
simultaneously for writing data to tape. With parallel processing enabled, the media pool can 
process simultaneously several tape jobs or split the data within one tape job across tape 
drives.  

 Encrypt the data written to tapes. 

 Export tapes to vault. 

A tape allocated to a custom media pool will always be tied to its media pool. When you bring a tape 
with expired data online, Veeam Backup & Replication places it automatically to the media pool where 
the tape was written. 

 

Note: 

 

You can manually move tapes to other media pools, however keep in mind that the tapes will be 
marked as free. 
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GFS Media Pools 

The GFS media pools are special media pools that store data to tape according to the GFS, or 
Grandfather-Father-Son rotation scheme which is the most common way for the long-term data 
archiving. 

GFS media pool keeps four predefined media sets for storing the VM backups with a tiered retention 
policy scheme: 

 Weekly 

 Monthly 

 Quarterly 

 Yearly. 

You can disable any media set or sets if you do not need them. 

To one GFS media pool, you can add multiple tape GFS jobs. 

 

Note: 

 

You can set only one type of media pools as the target for one tape job. The tape job targeted to a 
GFS media pool produces only full backups by the GFS schedule. Thus, GFS media pool cannot be 
used for incremental backup. If you want to have both GFS and simple retention backups for some 
VMs, create a tape job and a GFS tape job for such VMs. 
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Tape Library Failover 

A custom or a GFS media pool can fail over to another tape library in certain cases. Failover is available 
in media pools that use multiple libraries. One tape library is always set as primary, and is generally 
used for processing data. The media pool can switch to the next library in the following cases: 

• The tape library is offline. 

• The tape library has no free tapes. 

• The tape library has no free drives. 

The libraries are failed over to by the user-defined order. 

On the next backup session, Veeam will try to switch back to the primary library. If it is still not 
available, the media pool fails over to the next library as defined. 

 

Media Sets 

Media set is a set of tapes used for continuously writing backup data. Media set is one of parameters in 
media pool configuration. 

A new media set always starts with a free tape. Within one media set, the new data block is appended 
to a previous one on a tape. Veeam Backup & Replication stores information about all tapes that 
belong to each media set. You can view the list of names or barcodes of tapes that are associated with 
a particular media set. 

Media sets are used to explicitly distinguish data recorded to particular sets of tapes. You can choose 
between the following configuration options: 

 Creating a new media set for each backup session. In this case, 
Veeam Backup & Replication will produce a separate set of tapes for each tape backup 
session. 

 Starting a new media set for a certain period of time, for example, each week. As a result, 
you will have a separate set of tapes containing all backups that have been written to tape 
during a week. 

 Always continuing one media set. Use this option if you do not need to split your tape 
archives into separate sets of tapes. 
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When planning media sets configuration, you should balance between convenient viewing of data 
and efficiency of using the tapes. Media sets help create distinct packs of tapes, which will be 
convenient, for example, if you need to bring certain tapes from an offsite storage location to restore 
data. However, it may use the tapes ineffectively as the new media sets always require a new tape. 
This option is helpful when you have a lot of backups stored offsite. 

Always continuing one media set option is most efficient in terms of tape capacity usage, for the new 
data would be written to the same tape until it is full. However, in this case the data will be split across 
tapes and you may require a larger number of tapes to get a particular backup set for restore. This 
option is usually used in environments where the tapes are not exported from libraries. 

 

In some cases, Veeam forcibly starts a new media set, even if media pool settings do not instruct 
Veeam to do so. It happens when a job starts, but the tape that was planned for writing data cannot 
be used. In this situation, Veeam takes a new tape, and starts a new media set on it. For example, the 
situation may be as following: 

1. The required tape is offline. 

If you bring such tape online before the tape job starts, it will be used as planned. 

2. The required tape is hardware or software protected. 

3. In library failover on the following events: library is offline and all drives are busy. When a tape 
library is failed over on these events, Veeam Backup & Replication starts a new media set even 
if the global media pools are configured to always continue one media set. 

Note that if a new media set is started, scheduled or forced, the previous media set cannot be 
resumed. 
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Backup Sets 

When a tape job runs, it analyzes disk storage and spots files that match the tape job parameters. The 
tape job queues the files and writes them to tape. The set of files that are archived to tape within one 
tape job session is a backup set. 

Depending on size and number of archived files, a backup set may require different amounts of tape 
space. For example, if the amount of data is large, it may take several tapes. 
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Media Vaults 
Media vaults are logical containers that help you to additionally organize offline tapes. When the 
tapes are recorded and moved offsite, you need to have easy ways to manage data on such tapes. For 
example, you may need to view the archived files, the retention period for it, or get clear 
understanding of physical location of particular tapes in case you have several offsite storing 
locations. Media vaults visualize information about tapes. 

The vaults are created by user and allow the user to virtually move the offline tapes to a vault, 
grouping them by any criteria. For example, if you have a number of offsite storages for physical tapes, 
you can create a media vault for each of them. When you transport the physical tapes to the offsite 
storage, you can accordingly move the offline tapes to a vault in your Veeam backup console 
mirroring the physical storage. This will allow you to have convenient representation of the list of 
tapes in each of your physical storages. 

Tapes can be moved to a vault automatically if you instruct media pools to move tapes to a selected 
vault after the tapes go offline. You can also move the tapes from one media vault to another. Tapes 
will not be shown in their vault when you bring them online. The tapes that have been moved to a 
vault stay visible in their media pools and under the Offline node. When you remove a tape from the 
Veeam backup server, it is automatically deleted from the vault. 

Media vaults provide detailed information on each tape that belongs to it. The major information that 
you can view is, though not limited by, the following: 

 What tapes are stored in a particular offsite location. 

 Which tapes are expired and can be overwritten. 

 Which tapes comprise a particular media set that you need to bring for restore. 

You can create a media vault for each of your physical storing locations and move data entries about 
the tapes accordingly to them mirroring the physical storages. 

One media vault is not limited to one original location of tapes: one media vault can accumulate tapes 
produced by different devices and belonging to several media pools. 
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Tape Protection 
Tape protection is a software option that prohibits overwriting, erasing or appending data to 
protected tape. You can protect individual tapes that, for example, contain particularly valuable data. 

Tape protection overrides retention settings of the media pool. The retention of other tapes in the 
media pool is not modified. You can remove the protection at any time. The tape will return to the 
retention period set by the media pool. Note that if the media pool retention expired during the time 
the tape was protected, the tape will be queued for overwriting. 

You can set protection for any tape, online or offline, that contains data. If the offline tape is in a media 
vault, the media vault will inherit its retention setting automatically. 

 

When the tapes are protected, the following operations are prohibited for them: 

 Appending data to tapes 

 Erasing tapes 

 Marking tapes as free 

 Removing tapes from catalog. 

To perform these operations, you need to switch the protection off first. 
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Tape Data Retention 
Data retention period is a period of time when data written to tapes is protected from overwriting.  

Retention period is set by user for media pool and is applied to all tapes in this media pool. To set the 
retention policy, you can choose between the following options: 

 Never overwrite data 

 Define a particular time period to protect data 

 Not to protect data at all. 

During the retention period, Veeam Backup & Replication will not overwrite data on tape. If a tape 
contains several backup sets, it will expire when the backup set with the longest retention period 
expires. 

 

You can change the retention at any time. When you change the retention policy, you can select if this 
modification works for tapes that will be written after you apply this change or also to tapes that are 
already recorded. In the latter case, the retention settings of the recorded tapes will change 
immediately and will be applied to tapes that are both online and offline. 

Note: 

 

If you choose to set a shorter retention period and apply the retention settings to all tapes, some of 
your tapes may immediately become outdated. Such tapes will be queued for overwriting. Be careful 
when applying a new retention policy in order not to lose any data you need, or use the protection 
option. For more information, see Tape Protection. 

Tape Retention and Disk Retention 
For forward incremental and reverse incremental backup chains, you must always set the retention 
period for the tape archive not less than the retention period for backups on disk. The tape jobs 
analyze the existing tape archives and synchronize them with disk backups. If you have some restore 
points on disk and the tape archive misses them (for example, if the media pool retention allowed 
overwriting of these tapes), the tape job will re-write all missing restore points. For details, see 
Retention Policy. 

For example, there are 14 backup files on the backup repository that are kept for 14 days. The backup 
to tape job archives files once a week. The retention policy for the media pool is set to 7 days. In this 
case, Veeam Backup & Replication will first write 14 backup files from the backup repository to tape. 
After a 7-day interval, Veeam Backup & Replication will start recording the whole set of backup files 
from the backup repository to tape anew, overwriting backup files on tape with their copies from the 
backup repository. 

When a forever forward incremental backup chain is the source, you can set the retention period that 
is shorter than on disk. The virtual full will be automatically enabled to periodically write a synthesized 
full backup to tape. However, keep in mind that the tape job must always have the original full backup 
in the tape archive. When the original full backup is removed from the catalog (for example, when the 
retention allows overwriting the tape), the tape job will re-backup the source full from disk. If the 
virtual full is scheduled on this day, the tape job will write the full from disk and the virtual full within 
one backup set. 
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If you do not want to keep the original full on tape, you can choose to keep only the latest backup 
chain. Such chain contains one virtual full backup and subsequent increments. In this case, the tape 
retention period must be not shorter then the virtual full cycle. For example, if the virtual full is created 
once a week, set the retention to not less than one week. For details, see Virtual Full Backup. To 
shorten the backup chain on tape, select the Process latest full backup chain only option in the 
advanced settings of the tape job. 
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Managing Outdated Tapes 
The tapes containing outdated data are handled in the following way: 

 If the expired tape is online, it will be overwritten next time a tape job requires a free tape. 
The expired tape can be used only by the same media pool unless you erase the tape 
manually or move it to another media pool. The tapes are rewritten by the FIFO method. 

 If the expired tape is offline, you can re-load it back to the library. Tapes that were written in 
particular media pool will be automatically placed to the same media pool unless you move 
the tape to another media pool or erase the tape manually. 
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Virtual Full Backup 
Virtual full helps you optimize archiving forever incremental backup chains to tape.  

The virtual full creates a periodic synthesized full VM backup on tape. It does not require additional 
repository disk space: it is synthesized directly on tape on the fly, when the tape job runs. To build 
such full backup, Veeam Backup & Replication uses backup files that are already stored in the backup 
repository. 

Virtual full backups can be created for jobs that produce forever incremental backup chains: 

 Backup jobs with forever forward incremental backup method 

 Backup copy jobs 

 Endpoint backups 

Note: 

 

The source backup job configuration must not have scheduled synthetic or active full backups. If it 
does, the virtual full will be disabled even if configured in the tape job. 

The virtual full is created automatically once a week if the source job produces a forever forward 
incremental backup chain. You can choose the day of week when the virtual full is created, however, 
you cannot disable it or create the virtual full less often than once a week. 

When the tape job archives the forever incremental backup chain, it copies the full backup once. After 
that it copies only the increments and creates a virtual full regularly. The virtual full splits forever 
incremental backup chain into shorter series of backup files. As a result, each series contains one full 
backup and a set of increments following this full backup. 

For storing such ‘split’ series of backup files, you need fewer tapes, if compared to storing long forever 
incremental backup chains. Restore will also require fewer tapes: you will need to load only those 
tapes to the tape device that contain the short series of backup files. 
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How Virtual Full Backup Works 

To create a virtual full backup, Veeam Backup & Replication uses a small temporary file of the VSB 
(Veeam Synthetic Backup) format. The VSB file does not contain backup data; it contains pointers to 
data blocks inside files in the backup chain on disk. 

To synthesize the full backup file, Veeam Backup & Replication uses the backup chain produced by the 
source job on disk. This chain includes the most recent full backup and the subsequent increments (up 
to the day on which the virtual full is scheduled). 

Thus, the virtual full is created so that it represents a VM state as of a particular day of week. This day is 
specified as the virtual full schedule in the tape job properties and may be not the same day when the 
tape job runs. For example, you can schedule the tape job on Saturday, and set the virtual full on 
Thursday. The tape job will start on Saturday and select the data blocks needed to synthesize the 
restore point presenting the VMs state on Thursday. 

To create a virtual full backup, the tape job performs the following operations: 

1. On the day the tape job runs, it creates a VSB file and stores it on the backup repository, next 
to restore points in the backup chain. 

2. According to the VSB file pointers, the tape job detects what backup chain and what data 
blocks on disk are required to synthesize a full backup, and writes these blocks to tape as a 
full backup file (.vbk). 

3. At the end of the tape job session, the VSB file is removed from the backup repository. 

The data blocks are selected according to the following schemes: 

 If the source backup chain consists of a full backup and a number of subsequent increments 
(as normally happens in a forever incremental backup chain), the virtual full backup is 
synthesized. 

For example: 

– The backup job created a full backup on Sunday and an increment on each day 
afterward. 

– The virtual full is scheduled on Thursday and the tape job is scheduled on Saturday. 

On Saturday, the tape job selects the full backup created on Sunday and increment backups 
from Monday to Thursday and synthesizes a virtual full backup on tape. 
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 If there are no backup files within several days, the last available backup is used to synthesize 
a virtual full backup. 

For example: 

– The backup job created a full backup on Sunday, an increment on Monday and 
Tuesday, and no backups on the three following days. 

– The virtual full is scheduled on Thursday and the tape job is scheduled on Saturday. 

On Saturday, the tape job selects the full and the two subsequent increments and synthesizes 
a virtual full backup on tape. 
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 If some VMs in the source job have corrupted backups, the last valid backups for these VMs 
are used. 

Note: 

 

If the source backup chain contains a full backup that was created on the virtual full day (for 
example, an active full backup created manually), the tape job will copy it and will not create a virtual 
full. 
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Tape Parallel Processing 
If your tape library has multiple drives, you can use drives simultaneously for writing data to tape. This 
option is useful if you have a lot of tape jobs running at the same time or you have a lot of data that 
must be written to tape in a limited backup window. 

Tape parallel processing is enabled on the Options step of the Media Pool wizard. You can set this 
option for media pools that are targets for backup to tape and file to tape jobs. In the media pool 
settings, you can set the maximum number of drives that the media pool can use simultaneously. 

Note: 

 

You cannot enable parallel processing for GFS media pools. 

To process the tape data parallely, you can split the data across drives in 2 ways:  

 Parallel processing for tape jobs 

 Parallel processing for source chains of one (or more) tape jobs 

Processing Tape Jobs Simultaneously 
When you process tape jobs parallely, the media pool assigns a drive to each running tape job. The 
media pool can use the predefined maximum number of drives and process the equal number of tape 
jobs simultaneously. For example, if you set 3 drives as the maximum, you can process up to 3 tape 
jobs at the same time. If you have more jobs running at the same time, they are queued. When one of 
the jobs finishes and releases its drive, the first queued job takes the drive. 

For example:  

 You set the maximum number of drives to 3. 

 4 tape jobs start at the same time. 

The tape jobs start, and 3 of them occupy 3 drives to write data to tape. The Tape job D is queued and 
waits. When one of the jobs finishes and releases its drive, the Tape job D takes the drive and starts 
writing data. 
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Processing Backup Chains Simultaneously 
When you select processing backup chains paralelly, the media pool processes jobs that are added to 
the tape job as sources. If the source jobs produce per-VM backups, the media pool splits the tape jobs 
into per-VM backup chains. For more information about per-VM backup files, see Storage 
Compatibility Settings. 

For example:  

 You set the maximum number of drives to 3. 

 Tape job A that has 4 sources starts. 

Tape job A starts, and occupies 3 drives to process 3 source jobs. The fourth source job is queued and 
waits. When one of the drives is released, the fourth source takes the drive and starts writing data.  

If another tape job starts, it will be queued and wait until Tape job A finishes. 

 

If a tape job has only 1 source, it is processed as 1 source. 

For example: 

 You set the maximum number of drives to 3. 

 Tape job A has 1 source; Tape job B has 3 sources. The jobs starts at the same time. 

Tape job A occupies 1 drive. Tape job B occupies 2 other available drives and processes 2 sources. The 
first drive that is released, including Drive 1, will be used by third source of the Tape job B. 
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Note: 

 

If the media pool is configured to fail over to another library in case all tape drives are busy, only tape 
jobs can use drives of the next library. You cannot split source backup chains within one job across 
libraries. For more information about library failover, see Tape Library Failover. 
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Media Sets Created with Parallel Processing 

With parallel processing, a separate media set is opened per each drive used. 

 Note: 

 

The media pool must have an available tape for each drive. 

The media sets are opened according to media set options configured for the media pool: 

 Do not create, always continue using current media set option 

 Create new media set for every backup session option 

 Daily at option 

You can edit the media pool settings at any time, and increase or reduce the maximum number of 
drives: 

 If you reduce the number or drives, the media pool will use fewer drives for the next writing 
session. The media set(s) that become excessive will be closed. 

 If you increase the number of drives, the media pool will open new media set(s) per each 
added drive. Further, the media pool will use these media sets according to rules described 
above. 

Do not Create, Always Continue Using Current Media Set 
When the media pool is set to the Do not create, always continue using current media set option, a 
media set is opened per each drive during the first tape session. The next time a tape job starts, it 
chooses a tape that has most free space, and appends data to it. 

For example, you set the maximum number of drives to 3. The tape jobs that are first to run start 3 
media sets. The following tape sessions continue these 3 media sets appending data to them. 
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Create New Media Set for Every Backup Session 
When the media pool is set to the Create new media set for every backup session option, a media 
set is opened per each drive for every writing session. When the jobs run the next time, they open a 
number of media sets anew. 

Each media set uses a free tape. Note that this configuration is the most tape-consumptive. 

 

Daily at 
When the media pool is set to Daily at option, a number of media sets (per each drive) is opened on 
the scheduled day. If tape jobs run twice or more before the scheduled day, they continue these 
media sets — in this case, the jobs use tapes that have most free space first. 
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Backup to Tape Jobs 
To back up data to tape, you need to create and run tape jobs. A special backup to tape job is 
particularly intended on archiving Veeam backups that were produced by Veeam backup jobs. 

Note that to back up files, you need to configure file to tape job. For more information, see File to Tape 
Jobs. 

When a backup to tape job runs, it does not create new backups: it locates already existing backups 
(produced by backup and backup copy jobs) and copies them to tape. 

To one tape job, you can link an unlimited number of source jobs. The source jobs can be of different 
type and platform. 

Important! 

 

The tape job looks only for the Veeam backups that are produced by backup jobs running on your 
console. Other files will be skipped. 

Backup Jobs as Source to Tape Jobs 
When you add a backup job to a tape job, the tape job scans the backup repositories and picks the 
restore points that were produced by these backup jobs. 

As a source, you can add backup jobs that use any backup method. If the source job produces forever 
forward incremental backup chain, the tape job will automatically create a virtual full backup once a 
week. You can customize the virtual full schedule in the tape job settings. For more information, see 
Virtual Full Backup. Note that the source backup chain must contain 2 or more restore points. 

In case you change the configuration of the source backup jobs, the tape job is updated automatically: 
it adds new VMs to the list of VMs to archive or stops archiving VMs that were removed from backup 
jobs. 
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Backup Copy Jobs as Source to Tape Jobs 
Backup copy jobs can be a source for tape jobs, too. In this case, the tape job copies the full backup file 
once. After that, it copies only the new increments. Note that the source backup chain must contain 4 
or more restore points. 

In this basic scenario, the backup copy chain on tape will look as a forever forward incremental chain. 
To make it more convenient for tapes, you can schedule virtual full in the tape job. The virtual full 
creates a synthetic full backup on tape regularly (for example, once a week) and splits the chain into 
short series of tapes which is more convenient for restore. For more information, see Virtual Full 
Backup. 

The last restore point of the backup copy job stays active until the next restore point is created. The 
tape job does not copy such active points, because they may be updated. For this reason, the backup 
chain on tape will be always one restore point shorter than on disk. 
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Backup Repositories as Source to Tape Jobs 
The backup to tape job can monitor the whole backup repositories and archive new Veeam backup 
files as soon as they appear on disk. The tape job archives only Veeam backups that were created by 
jobs created on this Veeam backup server. 

When you add a repository as source to tape job, the tape job starts constantly scanning the selected 
repository (or repositories) and add the newly created backup files to the tape archive. 

The tape job monitors the selected repository in a background mode. You can set explicit backup 
windows for the tape job. In this case, the tape job will start on the set time and archive all new restore 
points that were created in period since the last job run. 

If you create or remove backup jobs that use this repository, or if you change the configuration of such 
backup jobs, you do not need to reconfigure the tape job that archives the repository. 
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Endpoint Backup Jobs as Source to Tape Jobs 
You can also archive Endpoint backups to tape. For more information on Endpoint backups, see 
http://helpcenter.veeam.com/endpoint/10/index.html?integration_tape.html 

 

  

http://helpcenter.veeam.com/endpoint/10/index.html?integration_tape.html
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Mixed Source Jobs 
In one tape job, you can mix different types of jobs and different platforms. You can add the following 
jobs as source: 

 VMware backup jobs 

 Hyper-V backup jobs 

 VMware backup copy jobs 

 Hyper-V backup copy jobs 

 Endpoint backup jobs 
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Linked Jobs 
You can also link a tape job to a backup job. Veeam Backup & Replication allows you to configure your 
tape device as a secondary destination for a backup job. In this case Veeam Backup & Replication will 
wait for the backup job to create a new backup file and then copy it to tape. 
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How Backup to Tape Works 

When Veeam Backup & Replication executes a backup to tape job (started manually or on schedule), it 
performs the following operations: 

1. The backup to tape job addresses the Backup Catalog in the Veeam Backup & Replication 
database to detect backups that match the job criteria. 

2. The files are queued for archiving. 

3. Veeam Backup & Replication connects to the Data Movers and starts the data transfer 
process. 

4. The source Data Mover retrieves data from the backup repository and target Data Mover 
sends data to tape. 

5. The tape job addresses the media pool that is set for this job as target. The media pool allots 
tapes for writing data according to the following configuration options: 

 Tapes consumption 

 Media sets 

 Tape retention. 

6. While tape recording is performed, Veeam Backup service updates data in the Backup Catalog 
and Tape Catalog in Veeam Backup database. The Veeam Backup console displays refreshed 
information about backups archived to tape and shows job statistics. 
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GFS Tape Jobs 
The GFS tape job creates yearly archive for the source VMs by the GFS scheme. The GFS archive 
includes one yearly backup and a number of weekly, monthly and quarterly backups. 

To create a GFS archive on tape, you need to create a GFS media pool and target a backup to tape job 
to it. Technically, a GFS job is a variant of backup to tape job. When you select a GFS media pool as 
target, the job schedule automatically changes to the GFS mode. 

As a source, you can use any backup job with any backup method: forever forward incremental, 
forward incremental or reversed incremental.  

The GFS job starts periodically and writes to tape a full backup. Depending on the schedule, the 
backup is stored as weekly, monthly, quarterly or yearly. To distinguish between these periods, the 
GFS media pool has 4 pre-defined media sets: weekly, monthly, quarterly and yearly. The job runs on 
days that are set in the job schedule for each period, for example: 

 Every Sunday for the weekly backup 

 Every 1st Sunday of each month for the monthly backup 

 Every 1st Sunday of each quarter for the quarterly backup 

 On 1st Sunday in January for the yearly backup. 

For each media set, you can set the overwrite protection period. For example, the weekly backups 
must be stored for 4 weeks, and the first can be deleted after the job creates the monthly backup. The 
yearly backup must be stored for a year until it is replaced by the next yearly backup. You can set the 
retention that complies with your organization's backup storage policy and meets your storage 
capacity. 

If the schedule for backup periods overlap, only the backup for the media set with the longest 
retention will be archived. For example, if "the first Sunday of January" is the date for the monthly, the 
quarterly and the yearly backup, only the yearly backup will be stored, and the monthly and the 
quarterly backups will be skipped. 

You can manually create a restore point for any backup period at any time with the Active full option. 
Veeam will copy or synthesize the most recent full backup possible for the selected period. 

Note the following:  

 If the source job creates more than one full backup in 24 hours, the tape job will copy only the 
first one. 

 If the restore point is available but locked, the GFS job will wait for this restore point to 
become available for up to 7 days. 

 If you stop the tape job manually, it will start again at 00:00 of the next scheduled day. 

 If there is a technical problem, for example, the tape library is offline, or the backup server is 
down, the GFS job will not run. When the problem is fixed, the GFS job will archive two most 
recent missed full backups for each media set. 

 If the GFS tape job was disabled manually for some period, it will skip all backups for this 
period after it is resumed. 
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How GFS Job Works 

When Veeam Backup & Replication executes a GFS job, it performs the following operations: 

1. At 00:00 of the day set in the GFS job schedule the GFS job starts and checks periodically if 
the source job created a backup: 

• If the source job creates a full backup, the GFS job copies it.  

• If the source job creates an incremental backup, the GFS job synthesizes a virtual 
full backup. 

• If no backup appears in 24 hours, the GFS job looks for the most recent restore 
point available. If it is a full backup, the GFS job copies it. If it is an increment, the 
GFS job uses it to synthesize a virtual full backup. 

2. The GFS job connects to the Data Movers and copies the data. The source Data Mover 
retrieves data from the backup repository and the target Data Mover sends data to tape. 

3. The target GFS media pool allots tapes according to rules of the corresponding media set. 

4. While tape recording is performed, Veeam Backup service updates data in the Backup Catalog 
and Tape Catalog in Veeam Backup database. The Veeam Backup console displays refreshed 
information about backups archived to tape and shows job statistics. 
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File to Tape Jobs 
File to tape job allows you to back up to tape any Microsoft Windows or Linux files. 

To back up Veeam backup files, you can use backup to tape jobs that are specially intended for this 
and offer more possibilities. However, you can archive backups as files using file to tape job. 

The file to tape job compares the source files to the files stored in tape archive and copies the changes 
to tape. You can create both full and incremental backups of files on tape. 
Veeam Backup & Replication supports file backup from any server which has been added as a 
managed server to the Veeam Backup console (that is, Windows or Linux server, including physical 
boxes). You can also archive files residing on NAS devices. 

When planning file to tape jobs, consider that the job performance depends more on the number of 
files to back up then on the amount of data. For example, writing a large number of small files with 
overall size of 10GB with one job will take more time than writing one 10GB file. If your job contain an 
extra large number of files (like millions of files) with one job, the job performance will be affected 
significantly. To improve performance, consider creating several file to tape jobs. 

Note: 

 

If the file to tape job fails to complete in 3 weeks, it is terminated by timeout. 

How File to Tape Works 

When Veeam Backup & Replication executes a file to tape job (started manually or on schedule), it 
performs the following operations: 

1. The file to tape job detects files that match the job criteria. 

2. The files are queued for archiving. The following scenarios are used: 

 If it is a first job run or a scheduled full backup, all selected files are queued for 
archiving. 

 If it is an incremental backup run, Veeam Backup & Replication addresses the Tape 
Catalog in the Veeam Backup & Replication database to detect if any data has been 
modified since the latest backup. Detected changes are queued for archiving. 

3. Veeam Backup & Replication connects to the Data Movers and starts the data transfer 
process. 

4. The source Data Mover retrieves data from the source servers and target Data Mover sends 
data to tape. 

5. The tape job addresses the media pool that is set for this job as target. The media pool allots 
tapes for writing data according to the following configuration options: 

 Tapes consumption 

 Media sets 

 Tape retention 
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6. While tape recording is performed, Veeam Backup service updates data in the Tape Catalog in 
Veeam Backup database. The Veeam Backup console displays refreshed information about 
files archived to tape and shows job statistics. 
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VM Restore 
You need to choose a VM and a desired restore point. If the tapes are online in your tape device, 
Veeam Backup & Replication will get the needed data automatically. If the tapes are offline, 
Veeam Backup & Replication will list the names of the required tapes.For VM backups stored on tape, 
you can choose between the following options for restore: 

 Restoring VM backups to repository or disk. This option allows you to copy particular VM 
backups from tape in case you need them on disk, or also for VM guest OS files restore. You 
can also restore full backups or even backup chains to a repository or any location of your 
choice. The restored backup is registered in the Veeam Backup & Replication console so that 
you can work with it and use it for any restore scenario later on. You can choose any restore 
point available on tape, and Veeam Backup & Replication will select the relevant files needed 
to restore the VM to the selected point-in-time state. 

 Restoring VMs to virtual infrastructure. The process of restoring VM from tape delivers all 
possibilities of a VM from disk restore including selecting a restore point, choosing target 
location, changing VM configuration settings and so on. The VM restore process consists of 
two stages which are copying the relevant archive to a temporary location such as a 
repository or a folder on disk followed by the standard VM restore. For more information, see 
Performing Full VM Restore. 

How Restoring VM from Tape Works 

When Veeam Backup & Replication restores a VM that is archived to tape, it performs the following 
operations:  

1. Veeam Backup & Replication checks the Backup Catalog in the Veeam Backup & Replication 
database to discover the tapes containing the needed backup files. If the tapes are offline, 
Veeam Backup & Replication prompts the user to insert the required tapes. 

2. Veeam Backup & Replication connects to the Data Mover service deployed on a tape server. 

3. The Data Mover copies the relevant backup files from the tapes to a staging repository. 

4. The VM is restored to disk by the regular VM restore procedure. 

5. Veeam Backup & Replication updates the Backup Catalog and Tape Catalog in the Veeam 
Backup database and deletes the backup files from the staging repository. 
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File Restore 
You can restore files and folders that were previously archived with file to tape jobs. Restoring 
capabilities allows you to restore files to their original location or another server, preserving 
ownership and access permissions. The file restore process allows you to restore files to any restore 
point available on tape.  

How Restoring Files from Tape Works 

When Veeam Backup & Replication restores files archived to tape, it performs the following 
operations: 

1. Veeam Backup & Replication checks the Tape Catalog in the Veeam Backup & Replication 
database to discover the tapes containing the needed restore point of the files. If the tapes 
are offline, Veeam Backup & Replication prompts the user to insert the required tapes. 

2. Veeam Backup & Replication connects to the Data Mover service deployed on a tape server. 

3. The Data Mover copies the relevant files from the tapes to a chosen target location, same or 
new one. 

4. Veeam Backup & Replication updates the Tape Catalog in the Veeam Backup database. 
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Veeam Cloud Connect 
If you want to store your data in the cloud, you can connect to the SP and write VM backups to cloud 
repositories or create VM replicas on cloud hosts. For more information about Veeam Cloud Connect, 
see Veeam Cloud Connect Guide at https://helpcenter.veeam.com/backup/cloud/.  

  

https://helpcenter.veeam.com/backup/cloud/
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Snapshot Hunter 
The Snapshot Hunter is a Veeam technology used to detect and remove orphaned snapshots that may 
remain after backup or replication job sessions.  

The Snapshot Hunter addresses the problem of “phantom” snapshots. Under some circumstances, 
VMware vSphere can report a successful removal of a snapshot but the snapshot actually remains on 
the datastore. 

Phantom snapshots can take substantial space on the datastore or impact VM performance. They can 
even cause the production VMs to stop if the datastore runs out of free space. 

To solve the problem of phantom snapshots, Veeam Backup & Replication starts the Snapshot Hunter 
during each backup or replication job session. The Snapshot Hunter looks for snapshot files not 
registered in vSphere. If there are no orphaned files, the Snapshot Hunter stops. If orphaned snapshot 
files are detected, the Snapshot Hunter removes them in the background mode.  

The Snapshot Hunter runs in jobs that use VMware VM snapshots: 

 Backup jobs: regular backup and backup from storage snapshots 

 Replication jobs (the source VM snapshot): regular replication, replication from storage 
snapshots 

 VeeamZIP 
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How Snapshot Hunter Works 
A temporary snapshot of the VM is taken and then removed during every backup or replication job 
session. To remove the snapshot, Veeam Backup & Replication triggers the VMware snapshot 
consolidation mechanism that includes two steps: 

1. VMware vSphere removes the snapshot from the VM snapshots list.  

2. VMware vSphere consolidates the data written to the delta file with the VM disks.  

The problem occurs when the snapshot was removed successfully but the consolidation failed. This 
may happen, for example, if the files appear to be locked when VMware vSphere attempts to 
consolidate the snapshot files. In this case, the files remain on datastore. 

The Snapshot Hunter is started as a separate process scheduled within every job session. The 
discovery of the phantom snapshots does not affect the job: if the phantom snapshots are discovered, 
the Veeam backup service schedules the snapshot consolidation, and the job runs in normal way. 

Veeam Backup & Replication checks the datastore to discover orphaned snapshot files. To consolidate 
these files with the VM disks, Veeam Backup & Replication calls a consolidation algorithm. The 
algorithm consists of three steps, each representing a VMware method. 

1. VMware Consolidate method 
As a first attempt, Veeam Backup & Replication calls the VMware Snapshot Consolidate 
method. This method is the same mechanism that VMware vSphere uses for VMs with the 
Needs Consolidation status. 

2. Hard consolidation without quiesce 
If the first attempt fails, Veeam Backup & Replication creates a new snapshot and calls the 
VMware Delete all snapshots method. As a result, all VM snapshots and associated files are 
deleted. The snapshot is taken without quiescing the VM. 

3. Hard consolidation with quiesce 
If the snapshot deletion still fails, Veeam Backup & Replication implies another VMware 
method that creates a quiesced snapshot and then removes all VM snapshots. 

Note: 

 

Hard consolidation without quiesce and hard consolidation with quiesce are performed only if the 
VM does not have any user snapshots. In case there are one or more user snapshots, these steps will 
not be performed. 

The 3-steps consolidation procedure is launched up to 4 times with a 4-hour interval. 

In case all four attempts fail, Veeam Backup & Replication sends an e-mail notification informing that 
the user needs to manually troubleshoot the problem. Note that you need to have the global email 
notifications option enabled. For more information, see Specifying Email Notification Settings. 

The Snapshot Hunter considers the backup window set for the job. If any of the attempts does not fit 
the backup window, Veeam Backup & Replication will not perform the consolidation and send the e-
mail notification. 

You can view information on the Snapshot Hunter sessions on the History > System view in your 
Veeam Backup & Replication console.  

In case no consolidation attempt could fit the backup window, the warning appears in the job 
statistics. 
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Update Notification 
Veeam Backup & Replication automatically notifies you about updates that must or can be installed to 
enhance your work experience with the product. Update notifications eliminate the risk of using out-
of-date components in the backup infrastructure or missing critical updates that can have a negative 
impact on data protection and disaster recovery tasks. 

Veeam Backup & Replication notifies about Veeam Backup & Replication updates: new patches and 
product versions. 

If you do not want to get notified about available updates, you can disable update notification in 
Veeam Backup & Replication. However, it is recommended that you leave update notifications 
enabled not to miss critical updates and patches. 

How Update Notification Works 
To check for updates, Veeam Backup & Replication uses a special XML file on the Veeam Update 
Notification Server (dev.veeam.com). The XML file contains information about the most up-to-date 
product version and patches. 

Veeam Backup & Replication downloads an XML file from the Veeam Update Notification Server once 
a week. It also collects information about the installed product. The collected information is compared 
with the information in the downloaded file. If new product versions, patches and updates are 
available, Veeam Backup & Replication informs you about them. 

Note: 

 

Make sure that the backup server is connected to the Internet and update notification is enabled in 
Veeam Backup & Replication options. In the opposite case, update notification will not function.  
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PLANNING AND PREPARATION 
This section covers the list of system requirements to the VMware vSphere environment and backup 
infrastructure components. It also provides information about required permissions, ports used by 
Veeam Backup & Replication and naming conventions. 

Platform Support 
Veeam Backup & Replication provides support for the following versions of the VMware vSphere 
platform. 

Virtual Infrastructure 

Specification Requirement 

Platform 
 vSphere 6.0 
 vSphere 5.x 
 vSphere 4.1 

Hypervisor 

 ESXi 6.0 
 ESXi 5.x 
 ESX(i) 4.1 

Free ESXi is not supported. Veeam Backup & Replication leverages vSphere and 
vStorage APIs that are disabled by VMware in free ESXi. 

Management 
Server 
(optional) 

 vCenter Server 6.0 (optional) 
 vCenter Server 5.x (optional) 
 vCenter Server 4.1 (optional) 

VMs 

Specification Requirement 

Virtual 
Hardware 

 All types and versions of virtual hardware are supported, including 62TB 
VMDK. 

 Virtual machines with disks engaged in SCSI bus sharing are not supported, 
because VMware does not support snapshotting such VMs. 

 RDM virtual disks in physical mode, Independent disks, and disks connected 
via in-guest iSCSI initiator are not supported, and are skipped from 
processing automatically. Network shares and mount points targeted to 3rd 
party storage devices are also skipped as these volumes/disks are not visible 
in the VM configuration file. 

OS  All operating systems supported by VMware. 
 Application-aware processing for Microsoft Windows 2003 and later. 

Software 

 VMware Tools (optional). VMware Tools are required for the following 
operations: application-aware processing, file-level restore from Microsoft 
Windows guest OS and SureBackup testing functions. 

 All latest OS service packs and patches (required for application-aware 
processing) 

vCloud Director 

Specification Requirement 

vCloud Director vCloud Director 5.1, 5.5, 5.6, 8.0 (optional) 
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File-Level Restore 

OS Supported File Systems 

Microsoft 
Windows 

 FAT, FAT32 
 NTFS 
 ReFS (ReFS is supported only if Veeam Backup & Replication is installed on 

Microsoft Windows Server 2012 or Microsoft Windows Server 2012 R2). 

Linux 

 ext2, ext3, ext4 
 ReiserFS 
 JFS 
 XFS 
 Btrfs 

BSD UFS, UFS2 

Mac HFS, HFS+ (volumes up to 2 TB) 

Novell OES 

File-level restore is supported for Novell Open Enterprise Server (Novell OES). Novell 
NetWare is not supported (Veeam Backup & Replication may fail to detect NSS 
volumes).  

Restore of NSS file/folder permissions is not supported. 

Solaris  UFS 
 ZFS (except any pool versions of Oracle Solaris) 

The multi-OS wizard works not only with basic disks, but also Linux LVM (Logical Volume Manager) 
and ZFS pools. 
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System Requirements 
Make sure that servers that you plan to use as backup infrastructure components meet system 
requirements listed below. 

Limitations and Recommendations 
Coexistence with Mission-Critical Production Servers 

It is not recommended that you install Veeam Backup & Replication and its components on mission-
critical machines in the production environment such as VMware vCenter Server, Domain Controller, 
Microsoft Exchange Server and so on. If possible, install Veeam Backup & Replication and its 
components on dedicated machines. Backup infrastructure component roles can be co-installed. 

Microsoft Windows Server Core 

You cannot install Veeam Backup & Replication and Veeam Backup Enterprise Manager on a machine 
running Microsoft Windows Server Core. However, you can assign roles of a backup proxy, backup 
repository, WAN accelerator, Veeam Cloud Connect infrastructure components and tape infrastructure 
components to machines running Microsoft Windows Server Core. 

Domain Member 

The machine on which you plan to install Veeam Backup & Replication does not necessarily need to be 
a domain member. However, if you plan to restore Microsoft Exchange items from the Veeam Backup 
Enterprise Manager UI, you must install Veeam Backup Enterprise Manager on the domain member 
server from the Microsoft Active Directory forest in which Microsoft Exchange mailboxes are located. 

All-in-One Installations 

For all-in-one installations, you can subtract 2 GB of memory resources from each role. These 2 GB are 
allotted to the OS itself, assuming each component is installed on the dedicated server. 
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Backup Server 

Specification Requirement 

Hardware 

CPU: x86-64 processor. 

Memory: 4 GB RAM plus 500 MB RAM for each concurrent job. 

Disk Space: 2 GB for product installation and 4.5 GB for Microsoft .NET 
Framework 4.5.2 installation. 10 GB per 100 VM for guest file system catalog 
folder (persistent data). Additional free disk space for Instant VM Recovery 
cache folder (non-persistent data, at least 10 GB recommended). 

Network: 1 Gbps or faster for on-site backup and replication, and 1 Mbps or 
faster for off-site backup and replication. High latency and reasonably unstable 
WAN links are supported. 

OS 

Only 64-bit version of the following operating systems are supported: 

 Microsoft Windows Server 2012 R2 
 Microsoft Windows Server 2012 
 Microsoft Windows Server 2008 R2 SP1 
 Microsoft Windows Server 2008 SP2 
 Microsoft Windows 10 
 Microsoft Windows 8.x 
 Microsoft Windows 7 SP1 

Software 

During setup, the setup performs system configuration check to determine if all 
prerequisite software is available on the machine where you plan to install 
Veeam Backup & Replication. If some of the required software components are 
missing, the setup wizard will offer you to install missing software 
automatically. This refers to: 

 Microsoft .NET Framework 4.5.2 
 Microsoft Windows Installer 4.5 
 Microsoft SQL Server Management Objects 
 Microsoft SQL Server System CLR Types 
 Microsoft Visual C++ 2010 Service Pack 1 redistributable package 

The following software must be installed manually: 

 Microsoft PowerShell 2.0 (required for PowerShell snap-in). 
 Firefox, Google Chrome, Microsoft Edge or Microsoft Internet 

Explorer 10.0 or later. 

SQL Database 

Local or remote installation of the following versions of Microsoft SQL Server 
(both Full and Express Editions are supported): 

 Microsoft SQL Server 2014 
 Microsoft SQL Server 2012 (Microsoft SQL Server 2012 Express 

Edition is included in the setup) 
 Microsoft SQL Server 2008 R2 
 Microsoft SQL Server 2008 
 Microsoft SQL Server 2005 
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Important! 

 

1. If you plan to back up VMs running Microsoft Windows Server 2012 R2 and Data 
Deduplication is enabled for some VM volumes, it is recommended that you deploy the 
Veeam Backup & Replication console and mount server on a machine running Microsoft 
Windows Server 2012 R2 with Data Deduplication feature enabled. Otherwise, some types 
of restore operations for these VMs (such as Microsoft Windows File Level Recovery) may 
fail. 

2. Due to its limitations, Microsoft SQL Server Express Edition can only be used for evaluation 
purposes or in case of a small-scale production environment. For environments with a lot 
of VMs, it is necessary to install a fully functional commercial version of Microsoft SQL 
Server. 

Veeam Backup & Replication Console 

Specification Requirement 

Hardware 

CPU: x86-64 processor. 

Memory: 2 GB RAM 

Disk Space: 500 MB for product installation and 4.5 GB for Microsoft .NET 
Framework 4.5.2 installation. 

Network: 1 Mbps connection to the backup server. High latency and low 
bandwidth impact user interface responsiveness. 

OS 

Only 64-bit version of the following operating systems are supported: 

 Microsoft Windows Server 2012 R2 
 Microsoft Windows Server 2012 
 Microsoft Windows Server 2008 R2 SP1 
 Microsoft Windows Server 2008 SP2 
 Microsoft Windows 10 
 Microsoft Windows 8.x 
 Microsoft Windows 7 SP1 

Software 

 Microsoft .NET Framework 4.5.2 (included in the setup) 
 Windows Installer 4.5 (included in the setup) 
 Microsoft PowerShell 2.0 or later (optional) 
 Firefox, Google Chrome, Microsoft Edge or Microsoft Internet 

Explorer 10.0 or later 
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Backup Proxy Server 

Specification Requirement 

Hardware 

CPU: modern x86 processor (minimum 2 cores or vCPUs). Using multi-core 
processors improves data processing performance, and allows for more tasks to 
be processed concurrently by proxy. 

Memory: 2 GB RAM plus 200MB for each concurrent task. Using faster memory 
(DDR3) improves data processing performance. 

Disk Space: 300 MB. 

Network: 1 Gbps or faster for on-site backup and replication, and 1 Mbps or 
faster for off-site backup and replication. High latency and reasonably unstable 
WAN links are supported. 

OS 

Both 32-bit and 64-bit versions of the following operating systems are 
supported: 

 Microsoft Windows Server 2012 R2 
 Microsoft Windows Server 2012 
 Microsoft Windows Server 2008 R2 SP1 
 Microsoft Windows Server 2008 SP2 
 Microsoft Windows 10 
 Microsoft Windows 8.x 
 Microsoft Windows 7 SP1 
 Microsoft Windows Vista SP2 

Software 
For VMware vSphere 5.5/6.0 backup proxy server on Microsoft Windows Server 
2008 or earlier: Microsoft Visual C++ 2008 SP1 Redistributable Package (x64). 
Installation package can be downloaded from http://vee.am/runtime. 

Important! 

 

To protect VMs running on ESXi 5.5 and newer, you must deploy backup proxies on machines 
running a 64-bit version of Microsoft Windows. VDDK 5.5 and newer does not support 32-bit versions 
of Microsoft Windows. 

 

  

http://vee.am/runtime
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Backup Repository Server 

Specification Requirement 

Hardware 

CPU: x86 processor (x86-64 recommended). 

Memory: 4 GB RAM, plus up to 2 GB RAM (32-bit OS) or up to 4 GB RAM (64-bit 
OS) for each concurrent job depending on backup chain’s length and backup 
files sizes. 

Network: 1 Gbps or faster for on-site backup and replication, and 1 Mbps or 
faster for off-site backup and replication. High latency and reasonably unstable 
WAN links are supported. 

OS 

Both 32-bit and 64-bit (recommended) versions of the following operating 
systems are supported: 

 Microsoft Windows Server 2012 R2 
 Microsoft Windows Server 2012 
 Microsoft Windows Server 2008 R2 SP1 
 Microsoft Windows Server 2008 SP2 
 Microsoft Windows 10 
 Microsoft Windows 8.x 
 Microsoft Windows 7 SP1 
 Microsoft Windows Vista SP2 
 Linux (bash shell, SSH and Perl are required) Please check the full list 

of required Perl modules here: www.veeam.com/kb2007. 

WAN Accelerator 

Specification Requirement 

Hardware 

CPU: x86-64 processor. Using multi-core processors improves data processing 
performance, and is highly recommended on WAN links faster than 10 Mbps. 

Memory: 8 GB RAM. Using faster memory (DDR3/DDR4) improves data 
processing performance. 

Disk Space: Disk space requirements depend on the WAN Accelerator role. For 
more information, see WAN Accelerator Sizing. 

Network: 1 Gbps or faster for on-site backup and replication, and 1 Mbps or 
faster for off-site backup and replication. High latency and reasonably unstable 
WAN links are supported. 

OS 

Only 64-bit version of the following operating systems are supported: 

 Microsoft Windows Server 2012 R2 
 Microsoft Windows Server 2012 
 Microsoft Windows Server 2008 R2 SP1 
 Microsoft Windows Server 2008 SP2 
 Microsoft Windows 10 
 Microsoft Windows 8.x 
 Microsoft Windows 7 SP1 
 Microsoft Windows Vista SP2 

 

Note: 

 

Global cache is not leveraged by Source WAN Accelerators, and so does not need to be allocated and 
populated on WAN Accelerators used only as source ones. 

 

 

http://www.veeam.com/kb2007


 

413   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Backup Target 
Backup can be performed to the following disk-based storage: 

 Local (internal) storage of the backup repository server. 

 Direct Attached Storage (DAS) connected to the backup repository server, including external 
USB/eSATA drives and raw device mapping (RDM) volumes. 

 Storage Area Network (SAN). Backup repository server must be connected into the SAN fabric 
via hardware or virtual HBA, or software iSCSI initiator, and the corresponding volumes must 
be mounted in the guest operating system of the backup repository server. 

 Network Attached Storage (NAS) able to represent itself as SMB (CIFS) share (direct 
operation), or NFS share (must be mounted on a Linux backup repository server). 

 EMC DataDomain (DD OS version 5.4, 5.5 or 5.6) with DDBoost license. Both Ethernet and 
Fibre Channel (FC) connectivity is supported. 

 ExaGrid (firmware version 4.7 or later). 

 HPE StoreOnce (firmware version 3.13.1 or later) with Catalyst license. Both Ethernet and Fibre 
Channel (FC) connectivity is supported. 

Storage Integration 
Backup from Storage Snapshots and Veeam Explorer for Storage Snapshots is supported for the 
following storage devices: 

EMC VNX and VNX2 

 NFS, Fibre Channel (FC) or iSCSI connectivity 

EMC VNXe 

 NFS, Fibre Channel (FC) or iSCSI connectivity 

Veeam Backup & Replication does not support EMC VNXe Gen 1 OS (2.x.x). EMC VNXe Gen 2 OS (3.x.x) 
is supported. 

HPE 3PAR StoreServ 

 Fibre Channel (FC) or iSCSI connectivity 

 3PAR OS 3.1.2 or later 

HPE StoreVirtual (LeftHand / P4000 series) and StoreVirtual VSA 

 iSCSI connectivity only 

 SAN/iQ version 9.5 or later 

NetApp FAS, FlexArray (V-Series), Edge VSA and IBM N Series (NetApp FAS OEM) 

 NFS, Fibre Channel (FC) or iSCSI connectivity 

 Data ONTAP version 8.1, 8.2 or 8.3 

 7-mode or cluster-mode 

Veeam Backup & Replication does not support SVM DR (Storage Virtual Machine Disaster Recovery) 
and Load-Sharing Mirrors on SVM Root Volumes. 
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Tape 

Specification Requirement 

Hardware  

LTO3 or later tape libraries (including VTL) and standalone drives are supported. 
Tape device must be directly attached to the backup server, to a tape server via 
SAS, FC or iSCSI interface. Note that VMware does not support connecting tape 
libraries to ESXi 5.x for VM pass-through. 

Software  

 We recommend that you install device-specific, vendor-supplied 
OEM driver for Windows are installed. Devices without such drivers 
installed will appear in Windows Device Manager as Unknown or 
Generic and require enabling native SCSI commands mode. 

 If multiple driver installation modes are available for your tape 
device, use the one that allows for multiple open handles from a 
host to a drive to exist at the same time. For example, if your tape 
vendor provides “exclusive” and “non-exclusive” drivers, you should 
install the “non-exclusive” one. 

 No other backup server must be interacting with the tape device. 

Tape Server 

Specification Requirement 

Hardware 

CPU: x86 processor (x86-64 recommended). 

Memory: 2 GB RAM plus 200MB for each concurrent task. 

Disk Space: 300 MB. 

Network: 1 Gbps or faster. 

OS 

Both 32-bit and 64-bit (recommended) versions of the following operating 
systems are supported: 

 Microsoft Windows Server 2012 R2 
 Microsoft Windows Server 2012 
 Microsoft Windows Server 2008 R2 SP1 
 Microsoft Windows Server 2008 SP2 
 Microsoft Windows 10 
 Microsoft Windows 8.x 
 Microsoft Windows 7 SP1 
 Microsoft Windows Vista SP2 

 

  

https://www.vmware.com/support/vsphere5/doc/vsphere-esx-vcenter-server-50-release-notes.html
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Veeam Backup Enterprise Manager Server 

Specification Requirement 

Hardware 

Processor: x86-64 processor. 

Memory: 4 GB RAM. 

Disk Space: 2 GB for product installation plus sufficient disk space to store guest 
file system catalog from connected backup servers (according to data retention 
policy). 

Network: 1 Mbps or faster connection to backup servers. 

OS 

Only 64-bit version of the following operating systems is supported: 

 Microsoft Windows Server 2012 R2 
 Microsoft Windows Server 2012 
 Microsoft Windows Server 2008 R2 SP1 
 Microsoft Windows Server 2008 SP2 
 Microsoft Windows 10 
 Microsoft Windows 8.x 
 Microsoft Windows 7 SP1 

Server Software 
 Microsoft Internet Information Services 7.0 or later 
 Microsoft .NET Framework 4.5.2 (included in the setup) 
 Microsoft Windows Installer 4.5 (included in the setup) 

Client Software 
 Firefox, Google Chrome, Microsoft Edge or Microsoft Internet 

Explorer 10.0 or later 
 Microsoft Excel 2003 or later (to view Excel reports) 

SQL Database 

Local or remote installation of the following versions of Microsoft SQL Server 
(both Full and Express Editions are supported): 

 Microsoft SQL Server 2014 
 Microsoft SQL Server 2012 (Microsoft SQL Server 2012 Express 

Edition is included in the setup) 
 Microsoft SQL Server 2008 R2 
 Microsoft SQL Server 2008 
 Microsoft SQL Server 2005 

 

Important! 

 

It is recommended that you install the same product version on the Veeam Backup Enterprise 
Manager server and backup servers. If you use different versions of Veeam Backup Enterprise 
Manager and Veeam Backup & Replication, you may not be able to leverage all features in Veeam 
Backup Enterprise Manager. 
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Veeam Backup Search Server 

Specification Requirement 

Hardware Refer to corresponding Microsoft Search Server version system requirements 

OS Refer to corresponding Microsoft Search Server version system requirements 

Software  Microsoft Search Server 2008 (including Express Edition). 
 Microsoft Search Server 2010 (including Express Edition). 

Veeam Explorer for Microsoft Active Directory 

Specification Requirement 

Microsoft Active 
Directory Domain 
Controllers 

 Microsoft Windows Server 2012 R2 
 Microsoft Windows Server 2012 
 Microsoft Windows Server 2008 R2 
 Microsoft Windows Server 2008 
 Microsoft Windows Server 2003 SP2 

Minimum supported domain and forest functional level is Windows 2003. 

Note: Database files created by domain controller running on Microsoft 
Windows Server 2012 or Microsoft Windows Server 2012 R2 can be open only if 
Veeam Explorer for Microsoft Active Directory is installed on the machine with 
the same OS or Microsoft Windows 8.x OS.  

Veeam Explorer for Microsoft Exchange 

Specification Requirement 

Microsoft Exchange 
 Microsoft Exchange 2016 
 Microsoft Exchange 2013 
 Microsoft Exchange 2010 SP1 

Software Microsoft Outlook 2010 or later (64-bit) for PST exports (optional) 

Veeam Explorer for Microsoft SharePoint 

Specification Requirement 

Microsoft SharePoint  Microsoft SharePoint 2013 
 Microsoft SharePoint 2010 

Veeam Explorer for Microsoft SQL 

Specification Requirement 

Microsoft SQL Server 

 Microsoft SQL Server 2014 
 Microsoft SQL Server 2012 
 Microsoft SQL Server 2008 R2 
 Microsoft SQL Server 2008 
 Microsoft SQL Server 2005 SP4 
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Veeam Explorer for Oracle 

Specification Requirement 

Oracle system 

Both 32-bit and 64-bit version of the following operating systems is supported: 

 Microsoft Windows Server 2012 R2 
 Microsoft Windows Server 2012 
 Microsoft Windows Server 2008 R2 
 Microsoft Windows Server 2008 
 Microsoft Windows Server 2003 SP2 
 CentOS 5 or later 
 RedHat 5 or later 
 Oracle Linux 5 or later 
 SUSE Linux Enterprise 12 (Oracle 12 only) 

Oracle databases  Oracle 12 
 Oracle 11 

Configuration  Oracle Automatic Storage Management (optional, requires ASMlib present) 
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Required Permissions 
The accounts used for installing and using Veeam Backup & Replication must have the following 
permissions: 

Account Required Permission 

Setup Account The account used for product installation must have the Local Administrator 
permissions on the target machine. 

Veeam Backup & Replic
ation console 
permissions 

The account used to start the Veeam Backup & Replication console must have 
the Local Administrator permissions on the machine where the console is 
installed. 

To perform file-level restore for Microsoft Windows VMs, the account used to 
start the Veeam Backup & Replication console must have SeBackupPrivilege and 
SeRestorePrivilege privileges. In most environments, these privileges are 
assigned to user accounts added to Local Administrators group. For more 
information, see https://msdn.microsoft.com/en-
us/library/windows/desktop/bb530716(v=vs.85).aspx. 

Veeam Backup Service 
Account 

The account used to run the Veeam Backup Service must be a Local System 
account or must have the Local Administrator permissions on the backup 
server. 

Target/Source Host 
Permissions 

Root permissions on the source ESX(i) host. 

Root or equivalent permissions on the Linux backup repository. 

Write permission on the target folder and share. 

If VMware vCenter Server is used, administrator credentials are required. 

Microsoft SQL Server 

The account used to run Veeam Backup Service requires db_datareader and 
db_datawriter roles as well as permissions to execute stored procedures for the 
configuration database on the Microsoft SQL Server. Alternatively, you can 
assign db_owner role for this database to the service account.  

The account used to run Veeam Backup Enterprise Manager service requires 
db_datareader and db_datawriter roles as well as permissions to execute stored 
procedures for the Veeam Backup Enterprise Manager database on the 
Microsoft SQL Server. Alternatively, you can assign db_owner role for this 
database to the service account. 

Veeam Backup 
Enterprise Manager 

Local Administrator permissions on the Veeam Backup Enterprise Manager 
server to install Veeam Backup Enterprise Manager. 

To be able to work with Veeam Backup Enterprise Manager, users must be 
assigned the Portal Administrator, Restore Operator or Portal User role. 

Veeam Backup Search Local Administrator permissions on the Microsoft Search Server to install 
Veeam Backup Search. 

Veeam Explorer for 
Exchange 

Full access to Microsoft Exchange database and its log files for item recovery. 
The account that you plan to use for recovery must have both read and write 
permissions to all files in the folder with the database.  

Access rights can be provided through impersonation, as described in the 
Configuring Exchange Impersonation article. 

Veeam Explorer for 
SharePoint 

The account used for work with Veeam Explorer for SharePoint requires 
membership in the sysadmin fixed server role on the staging Microsoft SQL 
Server.  
 
 
 

https://msdn.microsoft.com/en-us/library/windows/desktop/bb530716(v=vs.85).aspx
https://msdn.microsoft.com/en-us/library/windows/desktop/bb530716(v=vs.85).aspx
http://msdn.microsoft.com/en-us/library/bb204095.aspx
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Account Required Permission 

The account used for connection with target SharePoint server where 
document item(s)/list will be restored needs the following: 

 If permissions of the restored item are inherited from the parent item 
(list) — Full Control for that list is required. 

 If permissions are not inherited, and restored item will replace an 
existing item — Contribute for the item and Full Control for its 
parent list are required. 

Transaction logs 
backup (Microsoft SQL 
Server) 

The user account that you specify for guest processing of the Microsoft SQL 
Server VM in the backup job must have the sysadmin fixed role assigned on this 
Microsoft SQL Server. This is the recommended setting; however, if you need to 
provide minimal permissions to the account performing the backup operation, 
you can assign the following roles and permissions: 

 SQL Server instance-level roles: dbcreator and public  
 Database-level roles: db_backupoperator, db_denydatareader, public 
 Securables: view any definition, view server state 
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Used Ports 
This section covers typical connection settings for the backup infrastructure components. 

Note: 

 

During installation, Veeam Backup & Replication automatically creates firewall rules for default ports 
to allow communication for the application components.  

Backup Server Connections 
The following table describes network ports that must be opened to ensure proper communication of 
the backup server with other infrastructure components. 

From To Protocol Port Notes 

Backup server 

vCenter Server HTTPS TCP 443 

Default port used for connections to 
vCenter Server.  

If you use vCloud Director, make sure you 
open port 443 on underlying vCenter 
Servers. 

ESX(i) server 

HTTPS TCP 443 
Default port used for connections to ESX(i) 
host.  
Not required if vCenter connection is used. 

TCP 902 Port used for data transfer to ESX(i) host. 

TCP 22 
Port used as a control channel (only for 
jobs that use an ESX target with the 
console agent enabled). 

vCloud 
Director HTTPS TCP 443 Default port used for connections to 

vCloud Director. 

Linux server TCP 22 Port used as a control channel from the 
console to the target Linux host. 

Microsoft 
Windows 
server 

TCP 
UDP 

135, 137 to 
139, 445 

Ports required for deploying 
Veeam Backup & Replication components. 

TCP 6160 Default port used by the Veeam Installer 
Service. 

TCP 6161 
[For Microsoft Windows servers running 
the vPower NFS service] Default port used 
by the Veeam vPower NFS Service. 

TCP 6162 Default port used by the Veeam Backup 
Proxy Service. 

TCP, 
UDP 

111, 2049+, 
1058+ 

[For Microsoft Windows servers running 
the vPower NFS service] Standard NFS 
ports. If ports 2049 and 1058 are occupied, 
the succeeding port numbers will be used. 
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From To Protocol Port Notes 

TCP  

49152-65535  
(for Microsoft 
Windows 
2008 and 
newer) 

Dynamic RPC port range. For more 
information, see 
http://support.microsoft.com/kb/929851/e
n-us. 

Proxy 
appliance 
(multi-OS FLR) 

SSH 22 
Port used as a communication channel 
from the console to the proxy appliance in 
the multi-OS file-level recovery process. 

Shared folder 
CIFS (SMB) 
share 

TCP, UDP 135, 137 to 
139, 445 

Ports required for deploying 
Veeam Backup & Replication components. 

Mount server TCP 9401 Port used for communication with the 
mount server. 

Microsoft SQL 
Server hosting 
Veeam Backup 
& Replication 
configuration 
database 

TCP 1433 

Port used for communication with 
Microsoft SQL Server on which Veeam 
Backup & Replication database is 
deployed. 

DNS server 
with 
forward/revers
e name 
resolution of 
all backup 
servers  

UDP 53 Port used for communication with the DNS 
Server. 

Veeam 
Update 
Notification 
Server 
(dev.veeam.co
m) 

TCP 80 

Default port used to download 
information about available updates from 
the Veeam Update Notification Server over 
the Internet. 

Veeam 
License 
Update Server 
(autolk.veeam.
com) 

TCP 443 Default port used for license auto-update. 

Veeam Backup 
& Replication 
Console 

Backup server TCP 9392 
Port used by the 
Veeam Backup & Replication console to 
connect to the backup server. 

Linux server Backup server TCP 2500 to 5000 

Default range of ports used as transmission 
channels for jobs writing to Linux target. 
For every TCP connection that a job uses, 
one port from this range is assigned. 

http://support.microsoft.com/kb/929851/en-us
http://support.microsoft.com/kb/929851/en-us
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From To Protocol Port Notes 

Microsoft 
Windows 
server 

Backup server TCP 2500 to 5000 

Default range of ports used as transmission 
channels for jobs writing to Microsoft 
Windows target. For every TCP connection 
that a job uses, one port from this range is 
assigned. 

Management 
client PC 
(remote access) 

Backup server TCP 3389 

Default port used by the Remote Desktop 
Services. If you use third-party solutions to 
connect to the backup server, other ports 
may need to be open. 

    

Backup Proxy Connections 
The following table describes network ports that must be opened to ensure proper communication of 
backup proxies with other infrastructure components. 

From To Protocol Port Notes 

Communication with VMware Servers 

Backup 
proxy 

vCenter 
Server HTTPS 443 Default VMware web service port that can 

be customized in vCenter settings. 

ESX(i) server 

TCP 902 VMware data mover port. 

HTTPS 443 
Default VMware web service port that can 
be customized in ESX host settings. Not 
required if vCenter connection is used. 

Communication with Backup Repositories 

Backup 
proxy 

Linux server TCP 22 Port used as a control channel from the 
backup proxy to the target Linux host. 

Microsoft 
Windows 
server 

TCP 

49152-65535  
(for Microsoft 
Windows 
2008 and 
newer) 

Dynamic RPC port range. For more 
information, see 
http://support.microsoft.com/kb/929851/e
n-us. 

Shared folder 
CIFS (SMB) 
share 

TCP 
UDP 

135, 137 to 
139, 445 

Ports used as a transmission channel from 
the backup proxy to the target CIFS (SMB) 
share. 

Gateway 
Microsoft 
Windows 
server 

TCP 
UDP 

135, 137 to 
139, 445 

If a CIFS (SMB) share is used as a backup 
repository and a Microsoft Windows server 
is selected as a gateway server for this CIFS 
share, these ports must be opened on the 
gateway Microsoft Windows server. 

TCP 

49152-65535  
(for Microsoft 
Windows 
2008 and 
newer) 

Dynamic RPC port range. For more 
information, see 
http://support.microsoft.com/kb/929851/e
n-us. 

http://support.microsoft.com/kb/929851/en-us
http://support.microsoft.com/kb/929851/en-us
http://support.microsoft.com/kb/929851/en-us
http://support.microsoft.com/kb/929851/en-us
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From To Protocol Port Notes 

Communication with Backup Proxies 

Backup 
proxy Backup proxy TCP 2500 to 5000 

Default range of ports used as transmission 
channels for replication jobs. For every TCP 
connection that a job uses, one port from 
this range is assigned. 

   

Backup Repository Connections 

From To Protocol Port Notes 

Backup 
proxy 

Linux Server 
performing 
the role of the 
backup 
repository 

TCP 2500 to 5000 

Default range of ports used as transmission 
channels for replication jobs. For every TCP 
connection that a job uses, one port from 
this range is assigned. 

Microsoft 
Windows 
Server 
performing 
the role of the 
backup 
repository 

Backup 
repository Backup proxy TCP 2500 to 5000 

Default range of ports used as transmission 
channels for replication jobs. For every TCP 
connection that a job uses, one port from 
this range is assigned. 

Source 
backup 
repository 

Target backup 
repository TCP 2500 to 5000 

Default range of ports used as transmission 
channels for backup copy jobs. For every 
TCP connection that a job uses, one port 
from this range is assigned.  
Ports 2500 to 5000 are used for backup 
copy jobs that do not utilize WAN 
accelerators. If the backup copy job utilizes 
WAN accelerators, make sure that ports 
specific for WAN accelerators are open. 
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EMC Data Domain System Connections 

From To Protocol Port Notes 

Backup server EMC Data 
Domain 

TCP 111 

Port used to assign a random port for the 
mountd service used by NFS and 
DDBOOST. Mountd service port can be 
statically assigned. 

TCP 2049 
Main port used by NFS. Can be modified 
via the ‘nfs set server-port’ command. 
Command requires SE mode. 

TCP 2052 
Main port used by NFS MOUNTD. Can be 
modified via the 'nfs set mountd-port' 
command in SE mode. 

For more information, see https://community.emc.com/docs/DOC-33258. 

HPE StoreOnce Connection 

From To Protocol Port Notes 

Backup 
server 

HPE 
StoreOnce 

TCP 9387 Default command port used for 
communication with HPE StoreOnce. 

9388 Default data port used for communication 
with HPE StoreOnce. 

 

Microsoft Windows Server Running vPower NFS Service Connections 

From To Protocol Port Notes 

Backup 
server 

Microsoft 
Windows 
server 
running 
vPower NFS 
service 

TCP 
UDP 1058+, 2049+ 

[For Microsoft Windows servers running 
the vPower NFS service] Standard NFS 
ports. If ports 2049 and 1058 are occupied, 
the succeeding port numbers will be used. 

TCP 6160 Default port used by the Veeam Installer 
Service. 

TCP 6161 Default RPC port used by the Veeam 
vPower NFS Service. 

ESX(i) host 

Microsoft 
Windows 
server 
running 
vPower NFS 
service 

TCP 
UDP 111 RPC service port. 

   

  

https://community.emc.com/docs/DOC-33258
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Proxy Appliance (Multi-OS FLR) Connections 

From To Protocol Port Notes 

Backup 
server 

Proxy 
appliance  

TCP 22 

Port used as a communication channel 
from the backup server to the proxy 
appliance in the multi-OS file-level 
recovery process. 

TCP 2500-5000 

Default range of ports used as data 
transmission channels. For every TCP 
connection that a job uses, one port from 
this range is assigned. 

VM guest OS TCP 2500-5000 

Default range of ports used as data 
transmission channels. For every TCP 
connection that a job uses, one port from 
this range is assigned. 

Proxy 
appliance 

VM guest OS 

TCP 22 

Port used as a communication channel 
from the proxy appliance to the Linux 
guest OS during multi-OS file-level 
recovery process. 

TCP 20 [If FTP option is used] Default port used for 
data transfer. 

TCP 2500-5000 

Default range of ports used as data 
transmission channels. For every TCP 
connection that a job uses, one port from 
this range is assigned. 

VM guest OS Proxy 
appliance 

TCP 22 

Port used as a communication channel 
from the proxy appliance to Linux guest 
OS during multi-OS file-level recovery 
process. 

TCP 21 [If FTP option is used} Default port used for 
protocol control messages. 
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SureReplica Recovery Verification Connections 

From To Protocol Port Notes 

Backup 
server 

vCenter 
Server HTTPS TCP 443 Default port used for connections to 

vCenter Server. 

ESX(i) server 

HTTPS TCP 443 
Default port used for connections to ESX(i) 
host.  
Not required if vCenter connection is used. 

TCP 22 
Port used as a control channel (only for 
jobs that use an ESX target with the 
console agent enabled). 

Proxy 
appliance TCP 

443 Port used for communication with the 
proxy appliance in the virtual lab. 

22 Port used for communication with the 
proxy appliance in the virtual lab. 

Internet-
facing proxy 
server 

HTTP 8080 Port used to let VMs in the virtual lab 
access the Internet. 

Applications 
on VMs in the 
virtual lab 

— — 

Application-specific ports to perform port 
probing test. For example, to verify a DC, 
Veeam Backup & Replication probes port 
389 for a response. 
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WAN Accelerator Connections 
The following table describes network ports that must be opened to ensure proper communication 
between WAN accelerators used in backup copy jobs. 

From To Protocol Port Notes 

Communication with Backup Server 

Backup 
server 

WAN 
accelerator  
(source and 
target) 

TCP 6160 Default port used by the Veeam Installer 
Service. 

TCP 6162 Default port used by the Veeam Data 
Mover Service. 

TCP 6164 Controlling port for RPC calls. 

Communication with Backup Repositories 

WAN 
accelerator  
(source and 
target) 

Backup 
repository  
(source and 
target) 

TCP 2500 to 5000 

Default range of ports used by the Veeam 
Data Mover Service for transferring files of 
a small size such as NVRAM, VMX, VMXF, 
GuestIndexData.zip and others. A port 
from the range is selected dynamically. 

Communication Between WAN Accelerators 

WAN 
accelerator 

WAN 
accelerator 

TCP 6164 Controlling port for RPC calls. 

TCP 6165 

Default port used for data transfer 
between WAN accelerators. Ensure this 
port is open in firewall between sites 
where WAN accelerators are deployed. 

Tape Server Connections 

From To Protocol Port Notes 

Backup 
server Tape server TCP 6166 Controlling port for RPC calls. 
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HPE 3PAR StoreServ Storage Connections 

From To Protocol Port Notes 

Backup 
server 

HPE 3PAR 
StoreServ  
storage 
system 

HTTP 8008 Default port used for communication with 
the HPE 3PAR StoreServ storage system 
over HTTP. 

HTTPS 8080 Default port used for communication with 
the HPE 3PAR StoreServ storage system 
over HTTPS. 

SSH 22 Default command port used for 
communication with HPE 3PAR StoreServ 
over SSH. 

Backup 
proxy 

HPE 3PAR 
StoreServ  
storage 
system 

TCP 3260 Default iSCSI target port. 

HPE Lefthand Storage Connections 

From To Protocol Port Notes 

Backup 
server 

HP Lefthand 
storage 
system 

SSH 16022 Default command port used for 
communication with HP Lefthand. 

Backup proxy 
HP Lefthand 
storage 
system 

TCP 3260 Default iSCSI target port. 

NetApp Storage Connections 

From To Protocol Port Notes 

Backup 
server 

NetApp 
storage 
system 

HTTP 80 Default command port used for 
communication with NetApp over HTTP. 

HTTPS 443 Default command port used for 
communication with NetApp over HTTPS. 

Backup 
proxy 

NetApp 
storage 
system 

TCP, UDP 2049, 111 Standard NFS ports. Port 111 is used by the 
port mapper service.  

TCP 3260 Default iSCSI target port. 
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EMC VNX(e) Storage Connections 

From To Protocol Port Notes 

Backup 
server 

VNX File SSH 22 Default command port used for 
communication with VNX File over SSH. 

VNX Block HTTPS 443 Default port used for communication with 
EMC VNX Block. 

VNXe HTTPS 443 Default port used for communication with 
EMC VNXe and sending RESTful API calls. 

Backup 
proxy 

VNX Block 

VNXe 
TCP 3260 Default iSCSI target port. 

VNX File 

VNXe 
TCP, UDP 2049, 111 Standard NFS ports. Port 111 is used by the 

port mapper service.  

   

  



 

430   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

VM Guest OS Connections 
The following table describes network ports that must be opened to ensure proper communication of 
the backup server with the runtime coordination process deployed inside the VM guest OS for 
application-aware processing and indexing. 

From To Protocol Port Notes 

Backup 
server 

Linux VM 
guest OS 

TCP 22 Default SSH port used as a control channel. 

Linux VM 
guest OS 

Backup server TCP 49152-65535 
(for Microsoft 
Windows 2008 
and newer) 

Dynamic port range used for an SSH 
connection to the backup server. 

Backup 
server 

Guest 
interaction 
proxy 

TCP 6190 Port used for communication with the 
guest interaction proxy. 

TCP 6290 Port used as a control channel for 
communication with the guest interaction 
proxy. 

 

Guest 
interaction 
proxy 

 

Microsoft 
Windows VM 
guest OS 

TCP, UDP 135, 137-139, 
445 

Ports required to deploy the runtime 
coordination process on the VM guest OS. 

TCP 49152-65535 
(for Microsoft 
Windows 2008 
and newer) 

Dynamic RPC port range used by the 
runtime process deployed inside the VM 
for guest OS interaction (when working 
over the network, not over VIX API). 

For more information, see 
http://support.microsoft.com/kb/929851/e
n-us. 

TCP 6167 [For Microsoft SQL logs shipping] Port used 
by the runtime process on the VM guest OS 
from which Microsoft SQL logs are 
collected. 

Microsoft 
Windows VM 
guest OS 

Guest 
interaction 
proxy 

TCP  

49152-65535 
(for Microsoft 
Windows 2008 
and newer) 

Dynamic RPC port range used by the 
runtime process deployed inside the VM 
for guest OS interaction (when working 
over the network, not over VIX API). 

For more information, see 
http://support.microsoft.com/kb/929851/e
n-us. 

* If you use default Microsoft Windows firewall settings, you do not need to configure dynamic RPC 
ports: during setup, Veeam Backup & Replication automatically creates a firewall rule for the runtime 
process. If you use firewall settings other than default ones or application-aware processing fails with 
the “RPC function call failed” error, you need to configure dynamic RPC ports.  

  

http://support.microsoft.com/kb/929851/en-us
http://support.microsoft.com/kb/929851/en-us
http://support.microsoft.com/kb/929851/en-us
http://support.microsoft.com/kb/929851/en-us
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Veeam U-AIR Wizards Connections 
The following table describes network ports that must be opened to ensure proper communication of 
U-AIR wizards with other components. 

From To Protocol Port Notes 

U-AIR 
wizards 

Veeam 
Backup 
Enterprise 
Manager 

TCP 9394 

Default port used for communication with 
Veeam Backup Enterprise Manager. Can be 
customized during Veeam Backup 
Enterprise Manager installation. 

Microsoft Active Directory Domain Controller Connections During 
Application Item Restore 
The following table describes network ports that must be opened to ensure proper communication of 
the backup server with the Microsoft Active Directory VM during application-item restore. 

From To Protocol Port Notes 

Backup 
server 

Microsoft  
Active 
Directory VM 
guest OS 

TCP 135 Port required for communication between 
the domain controller and backup server. 

TCP, 
UDP 

389 LDAP connections. 

TCP 636, 3268, 
3269 

LDAP connections. 

TCP 49152-65535 
(for Microsoft 
Windows 
2008 and 
newer) 

Dynamic RPC port range used by the 
runtime coordination process deployed 
inside the VM guest OS for application-
aware processing (when working over the 
network, not over VIX API).* For more 
information, see 
http://support.microsoft.com/kb/929851/e
n-us. 

Microsoft Exchange Server Connections During Application Item Restore 
The following table describes network ports that must be opened to ensure proper communication of 
the Veeam backup erver with the Microsoft Exchange Server system during application-item restore. 

From To Protocol Port Notes 

Backup 
server 

Microsoft 
Exchange 
2003/2007 
CAS Server 

TCP 80, 443 WebDAV connections 

Microsoft 
Exchange 
2010/2013 
CAS Server 

TCP 443 

Microsoft Exchange Web Services 
Connections 

 

 
  

http://support.microsoft.com/kb/929851/en-us
http://support.microsoft.com/kb/929851/en-us
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Microsoft SQL Server Connections During Application Item Restore 
The following table describes network ports that must be opened to ensure proper communication of 
the backup server with the VM guest OS system during application-item restore. 

From To Protocol Port Notes 

Backup 
server 

Microsoft  
SQL VM guest 
OS 

TCP 1433,1434 
and other 

Port used for communication with the 
Microsoft SQL Server installed inside the 
VM. 

Port numbers depends on configuration of 
your Microsoft SQL server. For more 
information, see 
http://msdn.microsoft.com/en-
us/library/cc646023.aspx#BKMK_ssde. 

SMTP Server Connections 
The following table describes network ports that must be opened to ensure proper communication of 
the backup server with the SMTP server. 

From To Protocol Port Notes 

Backup 
server SMTP server TCP 25 

Port used by the SMTP server. 

Port 25 is most commonly used but the 
actual port number depends on 
configuration of your environment. 

 
  

http://msdn.microsoft.com/en-us/library/cc646023.aspx#BKMK_ssde
http://msdn.microsoft.com/en-us/library/cc646023.aspx#BKMK_ssde
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Veeam Backup Enterprise Manager Connections 
The following table describes network ports that must be opened to ensure proper communication of 
Veeam Backup Enterprise Manager with other components. 

From To Protocol Port Notes 

Veeam 
Backup 
Enterprise 
Manager 

Backup server 

TCP 9392 

Default port used by Veeam Backup 
Enterprise Manager for collecting data 
from backup servers. Can be customized 
during Veeam Backup & Replication 
installation. 

TCP 

49152-65535  
(for Microsoft 
Windows 
2008 and 
newer) 

Dynamic RPC port range. For more 
information, see 
http://support.microsoft.com/kb/929851/e
n-us. 

TCP 135 Default RPC port. 

TCP 

9393 

Default port used by the Veeam Guest 
Catalog Service for catalog replication. Can 
be customized during Veeam Backup & 
Replication installation. 

2500 to 2600 Ports used by the Veeam Guest Catalog 
Service for replicating catalog data. 

vCenter 
Server TCP 443 

Default port used for connection to 
vCenter Server and deploying Veeam plug-
in for VMware vSphere Web Client. Can be 
customized in Enterprise Manager.  

Active 
Directory TCP 

As listed at 
http://support
.microsoft.co
m/kb/832017/
en-
us#method1. 

Ports used by Enterprise Manager service 
to communicate to Active Directory; also 
used when performing Self-Service 
Restore.  

Microsoft 
Search Server TCP 9395 

Default port used by the 
Veeam Backup Search Service integration 
component. Can be customized during 
Veeam Backup Search installation. 

Enterprise 
Manager web 
site (IIS 
extension) 

Veeam 
Backup 
Enterprise 
Manager 
service 

TCP 9394 

Default port used by Enterprise Manager 
web site (IIS extension) to communicate 
with Enterprise Manager service. Can be 
customized during Enterprise Manager 
installation. 

TCP 9393 

Default port used to enable file search. Can 
be customized during Enterprise Manager 
installation. 
 
 
 
 
 
 

http://support.microsoft.com/kb/929851/en-us
http://support.microsoft.com/kb/929851/en-us
http://support.microsoft.com/kb/832017/en-us#method1
http://support.microsoft.com/kb/832017/en-us#method1
http://support.microsoft.com/kb/832017/en-us#method1
http://support.microsoft.com/kb/832017/en-us#method1
http://support.microsoft.com/kb/832017/en-us#method1
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Browser 

Enterprise 
Manager web 
site (IIS 
extension) 
 

HTTP 9080 
Default ports used to communicate with 
the website. Can be customized during 
Enterprise Manager installation. HTTPS 9443 

Enterprise 
Manager 
RestAPI 
client 

and/or 

VMware 
vSphere Web 
Client Plug-In 

Enterprise 
Manager 
RESTful API 

HTTP 9399 

Default ports used to communicate with 
Veeam Backup Enterprise Manager Web 
API. Can be customized during Enterprise 
Manager installation. HTTPS 9398 

   

Veeam Explorer for Oracle Connections 

From To Protocol Port Notes 

Veeam 
Explorer  
for Oracle 

Oracle on  
Microsoft 
Windows 
server 

TCP 49152-65535  Recommended dynamic RPC port range 
for Microsoft Windows 2008 and later. For 
more information, refer to 
https://support.microsoft.com/en-
us/kb/832017.  

Oracle on  
Linux server 

TCP 22 Default SSH port used as a control channel. 

TCP 2500 - 5000 Default port range for data transmission. 
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Naming Conventions 
Do not use Microsoft Windows reserved names for names of backup repositories, jobs, tenants and 
other objects created in Veeam Backup & Replication: CON, PRN, AUX, NUL, COM1, COM2, COM3, 
COM4, COM5, COM6, COM7, COM8, COM9, LPT1, LPT2, LPT3, LPT4, LPT5, LPT6, LPT7, LPT8 and LPT9. If 
you use a reserved name, Veeam Backup & Replication may not work as expected. For more 
information, see https://msdn.microsoft.com/en-us/library/aa365247.aspx?f=255&MSPPError=-
2147217396#naming_conventions.  

https://msdn.microsoft.com/en-us/library/aa365247.aspx?f=255&MSPPError=-2147217396#naming_conventions
https://msdn.microsoft.com/en-us/library/aa365247.aspx?f=255&MSPPError=-2147217396#naming_conventions
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DEPLOYMENT 
To start working with Veeam Backup & Replication, you must configure a backup server — install 
Veeam Backup & Replication on a machine that meets the system requirements. You can use the setup 
wizard or install the product in the unattended mode. 

The Veeam Backup & Replication console is automatically installed on the backup server. If you want 
to access Veeam Backup & Replication remotely, you can install the Veeam Backup & Replication 
console on a dedicated machine. 

Installing Veeam Backup & Replication 
Before you install Veeam Backup & Replication, check prerequisites. Then use the Veeam Backup & 
Replication setup wizard to install the product. 

Before You Begin 

Before you install Veeam Backup & Replication, check the following prerequisites: 

 The machine on which you plan to install Veeam Backup & Replication must meet the system 
requirements. For more information, see System Requirements.  

 The user account that you plan to use for installation must have sufficient permissions. For 
more information, see Required Permissions. 

 Backup infrastructure components communicate with each other over specific ports. These 
ports must be open. For more information, see Used Ports. 

 Veeam Backup & Replication requires .NET Framework 4.2.5. If .NET Framework 4.2.5 is not 
installed, the Veeam Backup & Replication setup will install it on the backup server. 

 Veeam Backup & Replication requires Microsoft SQL Server deployed either locally on the 
backup server or remotely. If Microsoft SQL Server is not installed, the 
Veeam Backup & Replication setup will install it on the backup server. 

If Microsoft SQL Server was installed by the previous product version, 
Veeam Backup & Replication will connect to the existing configuration database, upgrade it 
(if necessary) and use it for work. 
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Step 1. Start Setup Wizard 

To start the setup wizard: 

1. Download the latest version of the Veeam Backup & Replication installation image from 
www.veeam.com/downloads.html. 

2. Use disk image emulation software to mount the installation image to the machine where 
you plan to install Veeam Backup & Replication or burn the image file to a blank CD/DVD. If 
you plan to install Veeam Backup & Replication on a VM, use built-in tools of the virtualization 
management software to mount the installation image to the VM.  

To extract the content of the ISO, you can also use the latest versions of utilities that can 
properly extract data from an ISO of large size and can properly work with long file paths. 

3. After you mount the image or insert the disk, Autorun will open a splash screen with 
installation options. If Autorun is not available or disabled, run the Setup.exe file from the 
image or disk.  

4. In the Veeam Backup & Replication section of the splash screen, click Install.  

5. On the Welcome step of the wizard, click Next to start the setup wizard. 

Important! 

 

It is strongly recommended that you install Veeam Backup & Replication using Autorun or the 
Setup.exe file. If you run other installation files from CD/DVD folders, you may miss some 
components that need to be installed, and Veeam Backup & Replication may not work as expected. 

 

  

http://www.veeam.com/downloads.html
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Step 2. Read and Accept License Agreement 

At the License Agreement step of the wizard, you must accept the license agreement for 
Veeam Backup & Replication. If you do not accept the license agreement, you will not be able to pass 
to next step of the setup wizard. 

1. Read the license agreement.  

2. Select the I accept the terms in the license agreement option and click Next.  

 

Step 3. Provide License File 

At the Provide License step of the wizard, you must specify what license for 
Veeam Backup & Replication you want to install. You can install the following types of licenses: 

 Trial license that was sent to you after you downloaded the product 

 Purchased full license 

 No license. In this case, after installation Veeam Backup & Replication will operate in the free 
functionality mode. You can switch to the full functionality mode if you install the license. For 
more information, see Switching to Full and Free Product Modes. 

If a valid license is already installed on the machine, the setup wizard will inform you about it. In this 
case, you can skip the Provide License step and move to the next step of the wizard. 
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To install a license: 

1. Click Browse.  

2. Select a valid license file for Veeam Backup & Replication. 

 

Step 4. Review Components and Select Installation Folder 

At the Program Features step of the wizard, you can check what components the setup wizard will 
install and choose the installation folder. 

The setup wizard installs the following components: 

 Veeam Backup & Replication 

 Veeam Backup Catalog (responsible for indexing VM guest OS files) 

 Veeam Backup & Replication Console 

The setup wizard also installs the following components in the background: 

 Veeam Explorer for Microsoft Active Directory 

 Veeam Explorer for Microsoft Exchange 

 Veeam Explorer for Oracle 

 Veeam Explorer for Microsoft SQL Server 

 Veeam Explorer for Microsoft SharePoint 

 Veeam Backup PowerShell Snap-In 

These components do not require additional licenses. They are integrated with 
Veeam Backup & Replication.  
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To choose the installation folder: 

1. On the right of the Install to field, click Browse. 

2. In the Browse for Folder window, select the installation folder for the product. By default, 
Veeam Backup & Replication uses the C:\Program Files\Veeam\Backup and 
Replication\ folder. 

 

Step 5. Install Missing Software 

At the System Configuration Check step of the wizard, the setup wizard checks if all prerequisite 
software is installed on the machine. If some of required software components are missing, the setup 
wizard will offer you to install the missing components. 

You can install missing components automatically or manually.  

 To install missing components automatically, click Install. The setup wizard will not interrupt 
the installation process and install the missing components in the current session. 

 To install missing components manually: 

1. Click Cancel and exit the setup wizard.  

2. Install and enable the necessary components manually on the machine.  

3. Start the setup wizard again, pass to the System Configuration Check step of the 
wizard and click Re-run to repeat the verification. 

Note: 

 

If all required components are already installed on the machine, the System Configuration Check 
step will be skipped. 
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Step 6. Specify Installation Settings 

At the Default Configuration step of the wizard, you can select to install Veeam Backup & Replication 
with default installation settings or specify custom installation settings.  

By default, the setup wizard installs Veeam Backup & Replication with the following settings: 

 Installation folder: C:\Program Files\Veeam\Backup and Replication. 

 vPower cache folder: C:\ProgramData\Veeam\Backup\NfsDatastore. The vPower cache 
folder stores write cache for Instant VM Recovery. Make sure that you have at least 10 GB of 
free disk space to store the write cache. 

 Guest catalog folder: C:\VBRCatalog. The guest catalog folder stores indexing data for VM 
guest OS files. Indexing data is required for browsing and searching for VM guest OS files 
inside backups and performing 1-click restore. 

 Catalog service port: 9393. The catalog service port is used by the Veeam Guest Catalog 
Service to replicate catalog data from backup servers to Veeam Backup Enterprise Manager. 

 Service account: LOCAL SYSTEM. The service account is the account under which the Veeam 
Backup Service runs.  

 Service port: 9392. The service port is used by Veeam Backup Enterprise Manager to collect 
data from backup servers and by the Veeam Backup & Replication console to connect to the 
backup server. 

 Secure connections port: 9401. The secure connections port is used by the mount server to 
communicate with the backup server. 

 SQL Server: LOCALHOST\VEEAMSQL2012. During installation, Veeam Backup & Replication 
installs a new instance of Microsoft SQL Server 2012 Express Edition locally on the backup 
server. 

 Database name: VeeamBackup. Veeam Backup & Replication deploys the 
Veeam Backup & Replication database on the locally installed instance of Microsoft SQL 
Server 2012 Express Edition. 
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To use default installation settings: 

1. Leave the Let me specify different settings check box not selected.  

2. Click Install. The installation process will begin.  

To use custom installation settings, select the Let me specify different settings check box. The setup 
wizard will include additional steps that will let you configure the installation settings. 

 

Step 7. Specify Service Account Settings 

The Service Account step of the wizard is available if you have selected to configure installation 
settings manually. 

You can select the account under which you want to run the Veeam Backup Service: 

 LOCAL SYSTEM account (recommended, used by default) 

 Another user account 

The user name of the account must be specified in the DOMAIN\USERNAME format.  

The user account must have the following rights and permissions: 

 The account must be a member of the Administrators group on the machine where 
Veeam Backup & Replication is installed. 

 The account must have the database owner rights for the Veeam Backup & Replication 
database. 
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Veeam Backup & Replication automatically grants the Log on as service right to the specified user 
account. 

 

Step 8. Select Microsoft SQL Server 

The SQL Server Instance step of the wizard is available if you have selected to configure installation 
settings manually. 

You can select a Microsoft SQL Server on which you want to deploy the Veeam Backup & Replication 
database and choose the authentication mode. 

1. Select a Microsoft SQL Server: 

 If a Microsoft SQL Server is not installed, select the Install new instance of SQL 
Server option. 

 If a Microsoft SQL Server is already installed, select the Use existing instance 
of SQL Server option. Enter the instance name in the HOSTNAME\INSTANCE 
format. In the Database field, specify a name of the database. 

2. Select an authentication mode to connect to the Microsoft SQL Server instance: Microsoft 
Windows authentication or SQL server authentication. If you select the SQL Server 
authentication, enter credentials for the Microsoft SQL Server account. 
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If the Veeam Backup & Replication database already exists on the Microsoft SQL Server (for example, it 
was created by a previous installation of Veeam Backup & Replication), the setup wizard will notify 
about it. To connect to the detected database, click Yes. If necessary, Veeam Backup & Replication will 
automatically upgrade the database to the latest version. 
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Step 9. Specify Service Ports 

The Port Configuration step of the wizard is available if you have selected to configure installation 
settings manually. 

You can customize port number values that will be used for communication between backup 
infrastructure components: 

 Catalog service port. The catalog service port is used by the Veeam Guest Catalog Service to 
replicate catalog data from backup servers to Veeam Backup Enterprise Manager. By default, 
port 9393 is used. 

 Veeam Backup Service port. The service port is used by Veeam Backup Enterprise Manager to 
collect data from backup servers, and by the Veeam Backup & Replication console to connect 
to the backup server. By default, port 9392 is used. 

 Secure connections port. The secure connections port is used by the mount server to 
communicate with the backup server. By default, port 9401 is used. 
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Step 10. Specify Data Locations 

The Data Locations step of the wizard is available if you have selected to configure installation 
settings manually. 

You can specify where Instant VM Recovery write cache and indexing data must be stored. 

1. In the vPower NFS section, specify a path to the folder where Instant VM Recovery write 
cache must be stored. By default, the folder 
C:\ProgramData\Veeam\Backup\NfsDatastore is used. Make sure that you have at least 
10 GB of free disk space to store the write cache. 

2. In the Guest file system catalog section, specify a path to the folder where index files must 
be stored. By default, the setup wizard creates the VBRCatalog folder on the volume with 
the maximum amount of free space, for example: C:\VBRCatalog. 
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Step 11. Begin Installation 

The Ready to Install step of the wizard is available if you have selected to configure installation 
settings manually. 

You can review the installation settings and start the installation process. 

1. If you want Veeam Backup & Replication to periodically check and notify you about product 
updates, select the Check for updates once the product is installed and periodically check 
box. 

2. Click Install to begin the installation. 

3. Wait for the installation process to complete and click Finish to exit the setup wizard.  
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Step 12. Install Available Patches 

It is recommended that you periodically check for Veeam Backup & Replication patches and updates 
and install them when they are available. Installation of updates and patches lets you make sure that 
you use the latest version of the product and use its functionality to the full. 

You can check for product updates manually or configure Veeam Backup & Replication to 
automatically notify you about available updates and patches. For more information, see Specifying 
Other Notification Settings. 
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Installing Veeam Backup & Replication Console 
To access the backup server remotely, you can install the Veeam Backup & Replication console on a 
dedicated machine. The number of remote connections to one backup server is not limited — you can 
access the same backup server from different remote consoles. You can also use one console to access 
different backup servers. 

The Veeam Backup & Replication console is installed on the backup server by default. You do not need 
to install it manually. 

Before you install the Veeam Backup & Replication console, check prerequisites. Then use the Veeam 
Backup & Replication Console Setup wizard to install the console. 

Before You Begin 

Before you install the Veeam Backup & Replication console, check the following prerequisites: 

 The Veeam Backup & Replication console must be of the same version as 
Veeam Backup & Replication installed on the backup server. 

 The machine on which you plan to install the Veeam Backup & Replication console must meet 
the system requirements. For more information, see System Requirements. 

 The user account that you plan to use for installation must have sufficient permissions. For 
more information, see Required Permissions. 

 Backup infrastructure components communicate with each other over specific ports. These 
ports must be open. For more information, see Used Ports. 

 The Veeam Backup & Replication console requires .NET Framework 4.2.5. If .NET Framework 
4.2.5 is not installed, the Veeam Backup & Replication setup will install it on the machine. 
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Step 1. Start Setup Wizard 

To start the setup wizard: 

1. Download the latest version of the Veeam Backup & Replication installation image from 
www.veeam.com/downloads.html. 

2. Use disk image emulation software to mount the installation image to the machine where 
you plan to install Veeam Backup & Replication or burn the image file to a blank CD/DVD. If 
you plan to install Veeam Backup & Replication on a VM, use built-in tools of the virtualization 
management software to mount the installation image to the VM. 

3. After you mount the image or insert the disk, Autorun will open a splash screen with 
installation options. If Autorun is not available or disabled, run the Setup.exe file from the 
image or disk.  

4. In the Veeam Backup & Replication Console section of the splash screen, click Install.  

5. On the Welcome step of the wizard, click Next to start the setup wizard. 

Important! 

 

It is strongly recommended that you install the Veeam Backup & Replication console using Autorun 
or the Setup.exe file. If you run other installation files from CD/DVD folders, you may miss some 
components that need to be installed, and Veeam Backup & Replication may not work as expected. 

 

  

http://www.veeam.com/downloads.html
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Step 2. Read and Accept License Agreement 

At the License Agreement step of the wizard, you must accept the license agreement for 
Veeam Backup & Replication. If you do not accept the license agreement, you will not be able to pass 
to next step of the setup wizard. 

1. Read the license agreement.  

2. Select the I accept the terms in the license agreement option and click Next.  
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Step 3. Install Missing Software 

At the System Configuration Check step of the wizard, the setup wizard checks if all prerequisite 
software is installed on the machine. If some of required software components are missing, the setup 
wizard will offer you to install the missing components. 

You can install missing components automatically or manually.  

 To install missing components automatically, click Install. The setup wizard will not interrupt 
the installation process and install the missing components in the current session. 

 To install missing components manually: 

1. Click Cancel and exit the setup wizard.  

2. Install and enable the necessary components manually on the machine.  

3. Start the setup wizard again, pass to the System Configuration Check step of the 
wizard and click Re-run to repeat the verification. 
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Step 4. Specify Installation Settings 

At the Default Configuration step of the wizard, you can select to install the 
Veeam Backup & Replication console with default installation settings or specify custom installation 
settings.  

By default, the setup wizard installs the Veeam Backup & Replication console with the following 
settings: installation folder — C:\Program Files\Veeam\Backup and Replication. 

To use default installation settings: 

1. Leave the Let me specify different settings check box not selected.  

2. Click Install. The installation process will begin.  

To use custom installation settings, select the Let me specify different settings check box. The setup 
wizard will include additional steps that will let you configure the installation settings. 
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Step 5. Specify Installation Path 

The Installation Path step of the wizard is available if you have selected to configure installation 
settings manually. 

At the Installation Path step of the wizard, you can choose the installation folder for the 
Veeam Backup & Replication console. 

1. On the right of the Install Veeam Backup & Replication Console to the following folder 
field, click Browse. 

2. In the Browse for Folder window, select the installation folder for the product. By default, 
Veeam Backup & Replication uses the C:\Program Files\Veeam\Backup and 
Replication\ folder. 
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Step 6. Begin Installation 

The Ready to Install step of the wizard is available if you have selected to configure installation 
settings manually. 

At the Ready to Install step of the wizard, you can review the installation settings and start the 
installation process.  

1. Click Install to begin the installation.  

2. Wait for the installation process to complete and click Finish to exit the setup wizard. 
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Installing Veeam Backup & Replication in 
Unattended Mode 
You can install Veeam Backup & Replication in the unattended mode using the command line 
interface. The unattended installation mode does not require user interaction. You can use it to 
automate the installation process in large deployments. 

Installation Order 
Veeam Backup & Replication components must be installed in the strict order. The order depends on 
the type of server that you plan to deploy: backup server or Veeam Backup Enterprise Manager server. 

Backup Server 

If you want to deploy the backup server (server running Veeam Backup & Replication), you must install 
components in the following order: 

1. Veeam Backup Catalog 

2. Veeam Backup & Replication Server 

3. Veeam Explorers:  

 Veeam Explorer for Active Directory 

 Veeam Explorer for Exchange 

 Veeam Explorer for Oracle 

 Veeam Explorer for SharePoint 

 Veeam Explorer for Microsoft SQL 

Veeam Backup & Replication Console 

If you want to deploy the Veeam Backup & Replication console, you must install the following 
components: 

Veeam Backup & Replication Console 

Veeam Backup Enterprise Manager Server 

If you want to deploy the Veeam Backup Enterprise Manager server (server running Veeam Backup 
Enterprise Manager), you must install components in the following order: 

1. Veeam Backup Catalog 

2. Veeam Backup Enterprise Manager 

Veeam Cloud Connect Portal 

If you want to deploy Veeam Cloud Connect Portal, you must install components in the following 
order: 

1. Veeam Backup Enterprise Manager 

2. Veeam Cloud Connect Portal 
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Before You Begin 

Before you start unattended installation, make sure that you have performed the following steps: 

1. [For backup server]. Pre-install the following components on the target machine: 

a. Microsoft SQL Server 2008 or higher (both Full and Express editions are supported) 

b. Microsoft Visual C++ 2010 Service Pack 1 Redistributable Package 

c. Microsoft SQL Server 2012 System CLR Types 

d. Microsoft SQL Server 2012 Management Objects 

2. [For Veeam Backup Enterprise Manager server]. Pre-install the following components on the 
target machine: 

a. Microsoft SQL Server 2008 or higher (both Full and Express editions are supported) 

b. Microsoft Visual C++ 2010 Service Pack 1 Redistributable Package 

c. Microsoft SQL Server 2012 System CLR Types 

d. Microsoft SQL Server 2012 Management Objects 

e. IIS components: Default Document Component, Directory Browsing Component, 
HTTP Errors Component, Static Content Component, Windows Authentication 
Component 

f. Update 4.0.3 for Microsoft .NET Framework 4.0 (see KB 2600211 at 
http://support.microsoft.com/kb/2600211).  

3. Download the Veeam Backup & Replication installation image from the Veeam website. You 
can burn the downloaded image to a CD/DVD or mount the image to the target machine 
using disk image emulation software. 

4. Check the system requirements. For more information, see System Requirements. 

5. Log on to the target machine under the account that has the Local Administrator rights on 
the machine. For more information, see Required Permissions. 

6. Obtain a license file. The license file is required for Veeam Backup Enterprise Manager 
installation and is optional for Veeam Backup & Replication installation. If you do not specify a 
path to the license file during Veeam Backup & Replication installation, 
Veeam Backup & Replication will operate in the free functionality mode. 

http://support.microsoft.com/kb/2600211
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Installation Command-Line Syntax 
You can install the following Veeam Backup & Replication components in the unattended mode: 

 Veeam Backup Catalog 

 Veeam Backup & Replication Server 

 Veeam Backup & Replication Console 

 Veeam Explorer for Microsoft Active Directory 

 Veeam Explorer for Microsoft Exchange 

 Veeam Explorer for Oracle 

 Veeam Explorer for Microsoft SharePoint 

 Veeam Explorer for Microsoft SQL Server 

 Veeam Backup Enterprise Manager 

 Veeam Cloud Connect Portal 

Veeam Backup Catalog 

To install Veeam Backup Catalog, use a command with the following syntax: 

msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" 
[INSTALLDIR="<path_to_installdir 
>"][VM_CATALOGPATH="<path_to_catalog_shared_folder>"][VBRC_SERVICE_USER="<V
eeam_Guest_Catalog_Service_account>"][VBRC_SERVICE_PASSWORD="<Veeam_Guest_C
atalog_Service_account_password>"] 
[VBRC_SERVICE_PORT="<Veeam_Guest_Catalog_Service_port>"] 
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The following command-line options can be used: 

Option Parameter Required Description 

/L *v logfile No 

Creates an installation log file with the verbose 
output.  
Specify a full path to the log file as the parameter 
value. A setup log file created during the 
previous installation is cleared. 

Example: /L*v! 
”C:\ProgramData\Veeam\Setup\Temp\Logs\Catalo
g.txt” 

/q n Yes Sets the user interface level to “no”, which means 
no user interaction is needed during installation. 

/i setup file Yes 

Installs Veeam Backup Catalog. Specify a full path 
to the setup file as the parameter value. 

Example: /i 
“C:\Veeam\VeeamBackupCatalog64.msi” 

INSTALLDIR path No 

Installs the component to the specified location. 
By default, Veeam Backup & Replication uses the 
Backup Catalog subfolder in the 
C:\Program Files\Veeam\Backup and 
Replication\ folder. 

Example: INSTALLDIR="C:\Catalog\". The 
component will be installed to the 
C:\Catalog\Backup Catalog folder. 

VM_CATALOGPATH path No 

Specifies a path to the catalog folder where index 
files must be stored. By default, 
Veeam Backup & Replication uses the 
C:\VBRCatalog folder to store index files. 

Example: VM_CATALOGPATH="C:\Backup\". Index 
files will be stored to the C:\Backup\VBRCatalog 
folder. 

VBRC_SERVICE_ 
USER user No 

Specifies a user account under which the Veeam 
Guest Catalog Service will run. The account must 
have full control NTFS permissions on the 
VBRCatalog folder where index files are stored.  

If you do not specify this parameter, the Veeam 
Guest Catalog Service will run under the Local 
System account. 

Together with the VBRC_SERVICE_USER 
parameter, you must specify the 
VBRC_SERVICE_PASSWORD parameter. 

Example: 
VBRC_SERVICE_USER="BACKUPSERVER\Administra
tor" 

VBRC_SERVICE_ 
PASSWORD password No 

This parameter must be used if you have 
specified the VBRC_SERVICE_USER parameter. 

Specifies a password for the account under which 
the Veeam Guest Catalog Service will run. 

Example: VBRC_SERVICE_PASSWORD="1234" 
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Option Parameter Required Description 

VBRC_SERVICE_ 
PORT port No 

Specifies a TCP port that will be used by the 
Veeam Guest Catalog Service. By default, port 
number 9393 is used. 

Example: VBRC_SERVICE_PORT="9393" 

Example 
Suppose you want to install Veeam Backup Catalog with the following configuration: 

 No user interaction 

 Path to the MSI file: E:\Veeam\VeeamBackupCatalog64.msi 

 Installation folder: default 

 Catalog folder: default 

 Service user account: VEEAM\Administrator 

 Service user account password: 1243 

 TCP communication port: 9391 

The command to install Veeam Backup Catalog with such configuration will have the following 
parameters: 

msiexec.exe /qn /i "E:\Veeam\VeeamBackupCatalog64.msi" 
VBRC_SERVICE_USER="VEEAM\Administrator" VBRC_SERVICE_PASSWORD="1234" 
VBRC_SERVICE_PORT="9391" 

Veeam Backup & Replication Server 

To install the Veeam Backup & Replication server, use a command with the following syntax: 

msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" ACCEPTEULA="YES" 
[INSTALLDIR="<path_to_installdir >"] 
[VBR_LICENSE_FILE="<path_to_license_file>"] 
[VBR_SERVICE_USER="<Veeam_B&R_Service_account>"] 
[VBR_SERVICE_PASSWORD="<Veeam_B&R_Service_account_password>"] 
[VBR_SERVICE_PORT="<Veeam_B&R_Service_port>"] 
[VBR_SECURE_CONNECTIONS_PORT="<SSL_port>"] 
[VBR_SQLSERVER_SERVER="<SQL_server>"] 
[VBR_SQLSERVER_DATABASE="<database_name>"][VBR_SQLSERVER_AUTHENTICATION="0"
] [VBR_SQLSERVER_USERNAME="<SQL_auth_username>"] 
[VBR_SQLSERVER_PASSWORD="<SQL_auth_password>"] 
[PF_AD_NFSDATASTORE="<path_to_vPower_NFS_root_folder 
>"][VBR_CHECK_UPDATES=1] 
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The following command-line options can be used: 

Option Parameter Required Description 

/L *v logfile No 

Creates an installation log file with the 
verbose output. Specify a full path to the log 
file as the parameter value. A setup log file 
created during the previous installation is 
cleared. 

Example: /L*v! 
”C:\ProgramData\Veeam\Setup\Temp\Logs\Ba
ckup.txt” 

/q n Yes 
Sets the user interface level to “no”, which 
means no user interaction is needed during 
installation. 

/i setup file Yes 

Installs the Veeam Backup & Replication 
server. Specify a full path to the setup file as 
the parameter value. 

Example: /i “C:\Veeam\Server.x64.msi” 

ACCEPTEULA boolean Yes Confirms that you accept the license 
agreement of the product. 

INSTALLDIR path No 

Installs the component to the specified 
location. By default, 
Veeam Backup & Replication uses the 
Backup subfolder of the C:\Program 
Files\Veeam\Backup and 
Replication\ folder. 

Example: INSTALLDIR="c:\backup\". The 
component will be installed to the 
C:\backup\Backup folder. 

VBR_LICENSE_FILE license path No 

Specifies a full path to the license file. If this 
parameter is not specified, Veeam Backup 
Free Edition will be installed. 

Example: 
VBR_LICENSE_FILE="C:\Users\Administrator\De
sktop\enterprise - 
veeam_backup_trial_0_30.lic" 

VBR_SERVICE_USER user No 

Specifies the account under which the Veeam 
Backup Service will run. The account must 
have full control NTFS permissions on the 
VBRCatalog folder where index files are 
stored and the Database owner rights for the 
Veeam Backup & Replication database on the 
Microsoft SQL Server where the configuration 
database is deployed.  

If you do not specify this parameter, the 
Veeam Backup Service will run under the 
Local System account. 

Together with the VBR_SERVICE_USER 
parameter, you must specify the 
VBR_SERVICE_PASSWORD parameter. 

Example: 
VBR_SERVICE_USER="BACKUPSERVER\Administ
rator" 
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Option Parameter Required Description 

VBR_SERVICE_ 
PASSWORD password No 

This parameter must be used if you have 
specified the VBR_SERVICE_USER parameter. 

Specifies a password for the account under 
which the Veeam Backup Service will run.  

Example: VBR_SERVICE_PASSWORD="1234" 

VBR_SERVICE_PORT port No 

Specifies a TCP port that will be used by the 
Veeam Backup Service. By default, port 
number 9392 is used. 

Example: VBR_SERVICE_PORT="9395" 

VBR_SECURE_ 
CONNECTIONS_PORT  

port No 

Specifies an SSL port used for communication 
between the mount server and the backup 
server. By default, port 9401 is used. 

Example: 
VBR_SECURE_CONNECTIONS_PORT="9402" 

VBR_SQLSERVER_ 
SERVER 

SQL server\ 
instance 

 

No 

Specifies a Microsoft SQL server and instance 
on which the Veeam Backup & Replication 
database will be deployed. By default, 
Veeam Backup & Replication uses the 
(local)\VEEAMSQL2012 server. 

Example: 
VBR_SQLSERVER_SERVER="BACKUPSERVER\VE
EAMSQL2012_MY" 

VBR_SQLSERVER_DATA
BASE database No 

Specifies a name of the Veeam Backup & 
Replication SQL database to be deployed, by 
default, VeeamBackup. 

Example: 
VBR_SQLSERVER_DATABASE="VeeamBackup" 

VBR_SQLSERVER_ 
AUTHENTICATION  0/1 No 

Specifies if you want to use the SQL Server 
authentication mode to connect to the 
Microsoft SQL Server where the 
Veeam Backup & Replication is deployed. 
Specify 1 to use the SQL Server 
authentication mode. If you do not use this 
parameter, Veeam Backup & Replication will 
connect to the Microsoft SQL Server in the 
Microsoft Windows authentication mode 
(default value, 0). 

Together with this parameter, you must 
specify the following parameters: 
VBR_SQLSERVER_USERNAME and 
VBR_SQLSERVER_PASSWORD. 

Example: 
VBR_SQLSERVER_AUTHENTICATION="1" 
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Option Parameter Required Description 

VBR_SQLSERVER_ 
USERNAME  user No 

This parameter must be used if you have 
specified the 
VBR_SQLSERVER_AUTHENTICATION 
parameter. 

Specifies a LoginID to connect to the 
Microsoft SQL Server in the SQL Server 
authentication mode.  

Example: VBR_SQLSERVER_USERNAME="sa" 

VBR_SQLSERVER_ 
PASSWORD  

password No 

This parameter must be used if you have 
specified the 
VBR_SQLSERVER_AUTHENTICATION 
parameter. 

Specifies a password to connect to the 
Microsoft SQL Server in the SQL Server 
authentication mode.  

Example: VBR_SQLSERVER_PASSWORD="1234" 

PF_AD_NFSDATASTORE path No 

Specifies the vPower NFS root folder to which 
Instant VM Recovery cache will be stored. By 
default, the 
C:\ProgramData\Veeam\Backup\Nfs
Datastore\ folder is used. 

Example: 
PF_AD_NFSDATASTORE="C:\ProgramData\Vee
am\Backup\NfsDatastore2\" 

VBR_CHECK_UPDATES  0 or 1 No 

Specifies if you want 
Veeam Backup & Replication to automatically 
check for new product patches and versions. 
Specify 0 if you do not want to check for 
updates. If you do not use this parameter, 
Veeam Backup & Replication will 
automatically check for updates (default 
value, 1). 

Example: VBR_CHECK_UPDATES="0" 

Example 
Suppose you want to install Veeam Backup & Replication with the following configuration: 

 Installation log location: C:\logs\log1.txt 

 No user interaction 

 Path to the MSI file: E:\Veeam\Server.x64.msi  

 Installation folder: D:\Program Files\Veeam 

 License file location: C:\License\veeam_license.lic 

 Service user account: VEEAM\Administrator 

 Service user account password: 1243 

 Service port: default 

 SSL port: default 

 SQL database and database name: default 

 Path to the vPower NFS folder: D:\vPowerNFS 
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The command to install Veeam Backup & Replication with such configuration will have the following 
parameters: 

msiexec.exe /L*v "C:\logs\log1.txt" /qn /i "E:\Veeam\Server.x64.msi" 
ACCEPTEULA="YES" INSTALLDIR="D:\Program Files\Veeam" 
VBR_LICENSE_FILE="C:\License\veeam_license.lic" 
VBR_SERVICE_USER="VEEAM\Administrator" VBR_SERVICE_PASSWORD="1234" 
PF_AD_NFSDATASTORE="D:\vPowerNFS" 

Veeam Backup & Replication Console 

To install the Veeam Backup & Replication console, use a command with the following syntax: 

msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" ACCEPTEULA="YES" 
[INSTALLDIR="<path_to_installdir >"] 

The following command-line options can be used: 

Option Parameter Required Description 

/L *v logfile No 

Creates an installation log file with the verbose output. 
Specify a full path to the log file as the parameter value. A 
setup log file created during the previous installation is 
cleared. 

Example: /L*v! 
”C:\ProgramData\Veeam\Setup\Temp\Logs\Console.txt” 

/q n Yes Sets the user interface level to “no”, which means no user 
interaction is needed during installation. 

/i setup file Yes 

Installs the Veeam Backup & Replication console. Specify a 
full path to the setup file as the parameter value. 

Example: /i “C:\Veeam\Shell.x64.msi” 

ACCEPTEULA boolean Yes Confirms that you accept the license agreement of the 
product. 

INSTALLDIR path No 

Installs the component to the specified location. By default, 
Veeam Backup & Replication uses the Console subfolder 
of the C:\Program Files\Veeam\Backup and 
Replication\ folder. 

Example: INSTALLDIR="c:\backup\". The component will be 
installed to the C:\backup\Console folder 
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Example 
Suppose you want to install the Veeam Backup & Replication console with the following 
configuration: 

 No user interaction 

 Path to the MSI file: E:\Veeam\Shell.x64.msi 

 Installation folder: C:\Backup 

The command to install the Veeam Backup & Replication console with such configuration will have the 
following parameters: 

msiexec.exe /qn /L*v "C:\logs\log1.txt" /qn /i "E:\Veeam\Shell.x64.msi" 
ACCEPTEULA=yes INSTALLDIR="C:\Backup\" 

Veeam Explorer for Microsoft Active Directory 

Veeam Explorer for Microsoft Active Directory requires the Veeam Backup & Replication console of the 
same version to be installed on the target machine.  

To install Veeam Explorer for Microsoft Active Directory, use a command with the following syntax: 

msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" 

The following command-line options can be used: 

Option Parameter Required Description 

/L *v logfile No 

Creates an installation log file with the verbose output. Specify a 
full path to the log file as the parameter value. A setup log file 
created during the previous installation is cleared. 

Example: /L*v! ”C:\ProgramData\Veeam\Setup\Temp\Logs\VEAD.txt” 

/q n Yes Sets the user interface level to “no”, which means no user 
interaction is needed during installation. 

/i setup file Yes 

Installs Veeam Explorer for Microsoft Active Directory. Specify a full 
path to the setup file as the parameter value. 

Example: /i “C:\Explorers\VeeamExplorerforActiveDirectory.msi” 
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Veeam Explorer for Microsoft Exchange 

Veeam Explorer for Microsoft Exchange requires the Veeam Backup & Replication console of the same 
version to be installed on the target machine.  

To install Veeam Explorer for Microsoft Exchange, use a command with the following syntax: 

msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" 

The following command-line options can be used: 

Option Parameter Required Description 

/L *v logfile No 

Creates an installation log file with the verbose output. Specify a 
full path to the log file as the parameter value. A setup log file 
created during the previous installation is cleared. 

Example: /L*v! ”C:\ProgramData\Veeam\Setup\Temp\Logs\VEX.txt” 

/q n Yes Sets the user interface level to “no”, which means no user 
interaction is needed during installation. 

/i setup file Yes 

Installs Veeam Explorer for Microsoft Exchange. Specify a full path 
to the setup file as the parameter value. 

Example: /i “C:\Explorers\VeeamExplorerforExchange.msi” 

Veeam Explorer for Oracle 

Veeam Explorer for Oracle requires the Veeam Backup & Replication console of the same version to be 
installed on the target machine.  

To install Veeam Explorer for Oracle, use a command with the following syntax: 

msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" 

The following command-line options can be used: 

Option Parameter Required Description 

/L *v logfile No 

Creates an installation log file with the verbose output. Specify a 
full path to the log file as the parameter value. A setup log file 
created during the previous installation is cleared. 

Example: /L*v! ”C:\ProgramData\Veeam\Setup\Temp\Logs\VEO.txt” 

/q n Yes Sets the user interface level to “no”, which means no user 
interaction is needed during installation. 

/i setup file Yes 

Installs Veeam Explorer for Oracle. Specify a full path to the setup 
file as the parameter value. 

Example: /i “C:\Explorers\VeeamExplorerforOracle.msi” 
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Veeam Explorer for Microsoft SharePoint 

Veeam Explorer for Microsoft SharePoint requires the Veeam Backup & Replication console of the 
same version to be installed on the target machine.  

To install Veeam Explorer for Microsoft SharePoint, use a command with the following syntax: 

msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" 

The following command-line options can be used: 

Option Parameter Required Description 

/L *v logfile No 

Creates an installation log file with the verbose output. Specify a 
full path to the log file as the parameter value. A setup log file 
created during the previous installation is cleared. 

Example: /L*v! ”C:\ProgramData\Veeam\Setup\Temp\Logs\VESP.txt” 

/q n Yes 
Sets the user interface level to “no”, which means no user 
interaction is needed during installation. 

/i setup file Yes 

Installs Veeam Explorer for Microsoft SharePoint. Specify a full path 
to the setup file as the parameter value. 

Example: /i “C:\Explorers\VeeamExplorerforSharePoint.msi” 

Veeam Explorer for Microsoft SQL Server 

Veeam Explorer for Microsoft SQL Server requires the Veeam Backup & Replication console of the 
same version to be installed on the target machine.  

To install Veeam Explorer for Microsoft SQL Server, use a command with the following syntax: 

msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" 

The following command-line options can be used: 

Option Parameter Required Description 

/L *v logfile No 

Creates an installation log file with the verbose output. Specify a 
full path to the log file as the parameter value. A setup log file 
created during the previous installation is cleared. 

Example: /L*v! 
”C:\ProgramData\Veeam\Setup\Temp\Logs\VESQL.txt” 

/q n Yes Sets the user interface level to “no”, which means no user 
interaction is needed during installation. 

/i setup file Yes 

Installs Veeam Explorer for Microsoft SQL Server. Specify a full path 
to the setup file as the parameter value. 

Example: /i “C:\Explorers\VeeamExplorerforSQL.msi” 
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Veeam Backup Enterprise Manager 

To install Veeam Backup Enterprise Manager, use a command with the following syntax: 

msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" ACCEPTEULA="YES" 
[INSTALLDIR="<path_to_installdir >"] 
VBREM_LICENSE_FILE="<path_to_license_file>" 
[VBREM_SERVICE_USER="<Veeam_EM_Service_account>"][VBREM_SERVICE_PASSWORD="<
Veeam_EM_Service_account_password>"] 
[VBREM_SERVICE_PORT="<Veeam_EM_Service_port>"] 
[VBREM_SQLSERVER_SERVER="<SQL_server>"] 
[VBREM_SQLSERVER_DATABASE="<database_name>"][VBREM_SQLSERVER_AUTHENTICATION
="0"] [VBREM_SQLSERVER_USERNAME="<SQL_auth_username>"] 
[VBREM_SQLSERVER_PASSWORD="<SQL_auth_password>"] 
[VBREM_TCPPORT="<TCP_port_for_web_site>"] 
[VBREM_SSLPORT="<SSL_port_for_web_site>”]>"] 
[VBREM_THUMBPRINT="<certificate_hash>"] 
[VBREM_RESTAPISVC_PORT="<TCP_port_for_RestApi_service>"] 
[VBREM_RESTAPISVC_SSLPORT="<SSL_port_for_RestApi_service>"] 

The following command-line options can be used: 

Option Parameter Required Description 

/L *v logfile No 

Creates an installation log file with the verbose 
output. Specify a full path to the log file as the 
parameter value. A setup log file created during 
the previous installation is cleared. 

Example: /L*v! 
”C:\ProgramData\Veeam\Setup\Temp\Logs\EM.t
xt” 

/q n Yes 
Sets the user interface level to “no”, which 
means no user interaction is needed during 
installation. 

/i setup file Yes 

Installs Veeam Backup Enterprise Manager. 
Specify a full path to the setup file as the 
parameter value. 

Example: /i 
“C:\Veeam\EnterpriseManager\BackupWeb_x64.
msi” 

ACCEPTEULA boolean Yes Confirms that you accept the license 
agreement of the product. 

INSTALLDIR path No 

Installs the component to the specified 
location. By default, 
Veeam Backup & Replication uses the 
Enterprise Manager sufolder of the 
C:\Program Files\Veeam\ folder. 

Example: INSTALLDIR="c:\Backup\". The 
component will be installed to the 
C:\Backup\Enterprise Manager folder. 

VBREM_LICENSE_FILE license 
path Yes 

Specifies a full path to the license file. 

Example: 
VBREM_LICENSE_FILE="C:\Users\Administrator\D
esktop\enterprise - veeam_backup_trial_0_30.lic" 

VBREM_SERVICE_USER user No Specifies the account under which the Veeam 
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Option Parameter Required Description 

Backup Enterprise Manager Service will run. 
The account must have full control NTFS 
permissions on the VBRCatalog folder where 
index files are stored and the Database owner 
rights for the Veeam Backup Enterprise 
Manager database on the Microsoft SQL Server 
that you plan to use.  

If you do not specify this parameter, the Veeam 
Backup Enterprise Manager Service will run 
under the Local System account. 

Together with the VBREM_SERVICE_USER 
parameter, you must specify the 
VBREM_SERVICE_PASSWORD parameter. 

Example: 
VBRC_SERVICE_USER="BACKUPSERVER\Administ
rator" 

VBREM_SERVICE_ 
PASSWORD password No 

Specifies a password for the account under 
which the Veeam Backup Enterprise Manager 
Service will run.  

Example: VBREM_SERVICE_PASSWORD="1234" 

VBREM_SERVICE_PORT Port No 

Specifies a TCP port that will be used by the 
Veeam Backup Enterprise Manager Service. By 
default, port number 9394 is used. 

Example: VBREM_SERVICE_PORT ="9394" 

VBREM_SQLSERVER_ 
SERVER 

SQL 
server\insta
nce 

 

No 

Specifies a Microsoft SQL Server and instance 
on which the Veeam Backup Enterprise 
Manager database will be deployed. By default, 
Veeam Backup & Replication uses the 
(local)\VEEAMSQL2012 server. 

Example: VBREM_SQLSERVER_SERVER= 
"BACKUPSERVER\VEEAMSQL2012_MY" 

VBREM_SQLSERVER_ 
DATABASE database No 

Specifies a name of the Veeam Backup 
Enterprise Manager database, by default, 
VeeamBackupReporting. 

Example: VBREM_SQLSERVER_DATABASE= 
"VeeamBackupReporting2" 

VBREM_SQLSERVER_ 
AUTHENTICATION 

0/1 No 

Specifies if you want to use the Microsoft SQL 
Server authentication mode to connect to the 
Microsoft SQL Server where the Veeam Backup 
Enterprise Manager is deployed. Specify 1 to 
use the SQL Server authentication mode. If you 
do not use this parameter, Veeam Backup 
Enterprise Manager will connect to the 
Microsoft SQL Server in the Microsoft Windows 
authentication mode (default value, 0). 

Together with this parameter, you must specify 
the following parameters: 
VBREM_SQLSERVER_USERNAME and 
VBREM_SQLSERVER_PASSWORD. 

Example: 
VBREM_SQLSERVER_AUTHENTICATION="1" 
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Option Parameter Required Description 

VBREM_SQLSERVER_ 
USERNAME user No 

This parameter must be used if you have 
specified the 
VBREM_SQLSERVER_AUTHENTICATION 
parameter. 

Specifies a LoginID to connect to the Microsoft 
SQL Server in the SQL Server authentication 
mode.  

Example: VBREM_SQLSERVER_USERNAME="sa" 

VBREM_SQLSERVER_ 
PASSWORD 

password No 

This parameter must be used if you have 
specified the 
VBR_SQLSERVER_AUTHENTICATION parameter. 

Specifies a password to connect to the 
Microsoft SQL Server in the SQL Server 
authentication mode.  

Example: 
VBREM_SQLSERVER_USERNAME="1234" 

VBREM_TCPPORT port No 

Specifies a TCP port that will be used by the 
Veeam Backup Enterprise Manager web site. By 
default, port number 9080 is used. 

Example: VBREM_TCPPORT="9080" 

VBREM_SSLPORT port No 

Specifies an SSL port that will be used by the 
Veeam Backup Enterprise Manager web site. By 
default, port number 9443 is used. 

Example: VBREM_SSLPORT="9443" 

VBREM_THUMBPRINT hash No 

Specifies the certificate to be used by Veeam 
Backup Enterprise Manager Service and Veeam 
RESTful API Service. If this parameter is not 
specified, a new certificate will be generated by 
openssl.exe. 

Example: 
VBREM_THUMBPRINT="0677d0b8f27caccc966b1
5d807b41a101587b488" 

VBREM_RESTAPISVC_ 
PORT port No 

Specifies a TCP port that will be used by the 
Veeam Backup Enterprise Manager RESTful API 
Service. By default, port number 9399 is used. 

Example: VBREM_RESTAPISVC_PORT=”9399” 

VBREM_RESTAPISVC_ 
SSLPORT 

port No 

Specifies an SSL port that will be used by the 
Veeam RESTful API Service. By default, port 
number 9398 is used. 

Example: VBREM_RESTAPISVC_SSLPORT=”9398” 
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Example 
Suppose you want to install Veeam Backup Enterprise Manager with the following settings: 

 Installation log location: C:\logs\log1.txt 

 No user interaction 

 Path to the MSI file: E:\Veeam\EnterpriseManager\BackupWeb_x64.msi  

 Installation folder: D:\Program Files\Veeam 

 License file location: C:\License\veeam_license.lic 

 Service user account: VEEAM\Administrator 

 Service user account password: 1243 

 Service port: default 

 Microsoft SQL Server database: BACKUPSERVER\VEEAMSQL2012_MY  

 Database name: VeeamReporting01 

 TCP and SSL ports: default 

 Certificate: default 

 TCP port for RESTful API: 9396 

 SSL port for RESTful API: 9397 

The command to install Veeam Backup Enterprise Manager with such configuration will have the 
following parameters: 

msiexec.exe /L*v "C:\logs\log1.txt" /qn /i 
"E:\Veeam\EnterpriseManager\BackupWeb_x64.msi" ACCEPTEULA="YES" 
INSTALLDIR="D:\Program Files\Veeam" 
VBREM_LICENSE_FILE="C:\License\veeam_license.lic" 
VBREM_SERVICE_USER="VEEAM\Administrator" VBREM_SERVICE_PASSWORD="1234" 
VBREM_SQLSERVER_SERVER="BACKUPSERVER\VEEAMSQL2012_MY" 
VBREM_SQLSERVER_DATABASE="VeeamReporting01" VBREM_RESTAPISVC_PORT="9396" 

Veeam Cloud Connect Portal 

Veeam Cloud Connect Portal requires Veeam Backup Enterprise Manager of the same version to be 
installed on the target machine. 

To install Veeam Cloud Connect Portal, use a command with the following syntax: 

msiexec.exe [/L*v "<path_to_log>"] /qn /i "<path_to_msi>" ACCEPTEULA="YES" 
[INSTALLDIR="<path_to_installdir >"] VBCP_SSLPORT="<SSL_port"> 
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The following command-line options can be used: 

Option Parameter Required Description 

/L *v logfile No 

Creates an installation log file with the verbose output. 
Specify a full path to the log file as the parameter 
value. A setup log file created during the previous 
installation is cleared. 

Example: /L*v! 
”C:\ProgramData\Veeam\Setup\Temp\Logs\CloudPortal.
txt” 

/q n Yes Sets the user interface level to “no”, which means no 
user interaction is needed during installation. 

/i setup file Yes 

Installs the Veeam Cloud Connect Portal. Specify a full 
path to the setup file as the parameter value. 

Example: /i “C:\Cloud 
portal\BackupCloudPortal_x64.msi” 

ACCEPTEULA boolean Yes Confirms that you accept the license agreement of the 
product. 

INSTALLDIR path No 

Installs the component to the specified location. By 
default, Veeam Backup & Replication uses the 
CloudPortal subfolder of the C:\Program 
Files\Veeam\Backup and Replication\ 
folder. 

Example: INSTALLDIR="c:\backup\". The component will 
be installed to the C:\backup\CloudPortal folder 

VBCP_ 
SSLPORT port No 

Specifies an SSL port that will be used by the Veeam 
Cloud Connect Portal web site. By default, port number 
6443 is used. 

Example: VBREM_SSLPORT="7443" 

Example 
Suppose you want to install Veeam Cloud Connect Portal with the following configuration: 

 No user interaction 

 Path to the MSI file: E:\Cloud portal\BackupCloudPortal_x64.msi 

 Installation folder: C:\Backup 

 SSL port: default 

The command to install Veeam Cloud Connect Portal with such configuration will have the following 
parameters: 

msiexec.exe /qn /L*v "C:\logs\log1.txt" /qn /i "E:\Cloud 
portal\BackupCloudPortal_x64.msi" ACCEPTEULA=yes INSTALLDIR="C:\Backup\" 

  



 

473   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Installing Updates in Unattended Mode 
Veeam Backup & Replication Updates can be installed in the unattended mode.  

To install an Veeam Backup & Replication Update, perform the following steps: 

1. Download the Update installation archive. 

2. Unpack installation files to a temporary folder. 

3. Install the Update on the backup server. 

Steps 2 and 3 can be performed in the unattended mode. 

Important! 

 

The script installing Veeam Backup & Replication Updates must be run with elevated privileges (run 
as Administrator). 

Step 1. Download Update Installation Archive 

1. Download the installation archive for the Veeam Backup & Replication Update from 
https://www.veeam.com/updates.html.  

2. Extract the executable file from the downloaded archive. 

3. Save the extacted file locally on the backup server where you plan to install the update or in a 
network shared folder. 

Step 2. Unpack Installation Files to Temporary Folder 

Unpack installation files from the downloaded archive to a temporary folder on the backup server. 

Use the following command syntax: 

%PatchFullPath% /q /c /t:<path_to_tmp_folder> 

The following command-line options can be used: 

Option Parameter Required Description 

%PatchFullPath% path Yes Specifies a path to the executable file with the 
Veeam Backup & Replication Update. 

/q — Yes Sets the user interface level to “no”, which means no 
user interaction is needed during installation. 

/c — Yes 

If specified with the /t parameter, coordinates the 
process of unpacking installation files to a temporary 
folder. If you do not specify this parameter, installation 
files will be unpacked, and the installation will be 
started in the UI mode. 

/t path Yes 
Specifies a path to a temporary folder on the backup 
server where installation files must be unpacked. 

 

  

https://www.veeam.com/updates.html
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For example: 

You have downloaded the installation archive to the C:\Update folder and want to unpack 
installation files to the C:\Temp folder on the backup server.  

The command to unpack installation files will be the following: 

C:\Update\VeeamPatch.exe /q /c /t:C:\Temp 

Step 3. Install Update 

To install the Veeam Backup & Replication Update on the backup server, use the following command 
syntax: 

%path_to_tmp_folder%\HotFixRunner.exe [silent][noreboot][log 
<log_path>][VBR_AUTO_UPGRADE=1] 

The following command-line options can be used: 

Option Parameter Required Description 

%path_to_tmp_folder 
%\HotFixRunner.exe 

path Yes 

Specifies a path to the temporary folder 
where installation files for the 
Veeam Backup & Replication Update are 
stored. 

silent — Yes 
Sets the user interface level to “no”, which 
means no user interaction is needed during 
installation. 

noreboot — No 
Suppresses reboot if reboot is required 
during the Veeam Backup & Replication 
Update installation. 

log path No 
Specifies a full path to the log file for the 
Veeam Backup & Replication Update 
installation. 

VBR_AUTO_UPGRADE Boolean No 

Starts automatic upgrade for existing 
components in the backup infrastructure. 
Set this parameter to 1 to enable 
components upgrade. 

Automatic components upgrade is 
performed after the Veeam Backup Service 
on the backup server is started. 
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For example: 

You want to install the Veeam Backup & Replication Update with the following options: 

 Path to temporary folder: C:\Temp 

 Silent install: enabled 

 Noreboot: enabled 

 Path to log file: C:\Logs\veeam.log 

 Components auto upgrade: enabled 

The command to install the Veeam Backup & Replication Update will be the following: 

C:\Temp\HotFixRunner.exe silent noreboot log C:\Logs\veeam.log 
VBR_AUTO_UPGRADE=1 

Installation Results 
You can use the last exit code to verify if the installation process has completed successfully. 

 In cmd.exe, use the %ERRORLEVEL% variable to check the last exit code.  

 In Microsoft Windows PowerShell, use the $LastExitCode variable to check the last exit code. 

Veeam Backup & Replication does not provide any confirmation about the results of the automatic 
components upgrade. To check if components have been successfully upgraded, use the 
Veeam Backup & Replication console. 
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Upgrading Veeam Backup & Replication 
Upgrade to version 9.0 is supported for Veeam Backup & Replication 7.0 Update 4 and 8.0. To perform 
upgrade, run the Veeam Backup & Replication setup file. For details on the upgrade procedure, refer 
to Veeam Backup & Replication Release Notes at https://www.veeam.com/documentation-guides-
datasheets.html.  

Before You Upgrade 
When you upgrade the product, the configuration database gets upgraded, too, and becomes 
available for usage with the newly installed version. It is strongly recommended that you perform 
configuration backup of the database before upgrading the product. In this case, you will be able to 
easily go back to a previous version in case of issues with upgrade. For more information, see 
Performing Configuration Backup and Restore. 

After You Upgrade 
When upgrade is complete, it is recommended that you check all existing jobs, backup infrastructure 
components and make changes to the default upgrade configuration if necessary. Consider the 
following: 

 During upgrade to Veeam Backup & Replication 9.0, backup files and VM replicas that were 
created with previous versions are not impacted in any way. 

 The Credentials Manager will be populated with credentials that were used for connecting to 
virtual infrastructure servers, Microsoft Windows servers, Linux servers and credentials used 
for guest processing. 

 New product enhancements are not enabled upon upgrade. This ensures that your existing 
jobs do not change behavior when you upgrade to Veeam Backup & Replication 9.0. 

Unattended Upgrade 
Veeam Backup & Replication does not support product upgrade in the unattended mode. However, 
you can: 

1. Uninstall the previous version of the product.  

2. Install a newer version of the product in the unattended mode. You must connect to the 
configuration database that was used by the previous product version. 

Important! 

 

In Veeam Backup & Replication 9.0 you cannot use machines running Microsoft Windows Server 
2003 and lower as backup infrastructure components. Before you start the upgrade procedure, 
remove such servers from the backup infrastructure. Otherwise the product upgrade will fail. 

  

https://www.veeam.com/documentation-guides-datasheets.html
https://www.veeam.com/documentation-guides-datasheets.html
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Updating Console Automatically 
Each time you connect to the backup server locally or remotely, the console checks for updates. If the 
backup server has a patch or updates installed, the console will be updated automatically. 

 

Mind the following limitations: 

 Upgrade to another Veeam Backup & Replication major product version is not supported. If 
you upgrade Veeam Backup & Replication to another major version, you must upgrade the 
console to the same version manually. 

 Downgrade of the console is not supported. If the console is of a higher version than the 
backup server (for example, if you upgraded the console manually), the connection to the 
server will fail.  

 Automatic upgrade is not supported for Preview, Beta or RTM versions of 
Veeam Backup & Replication.  

If other Veeam Backup & Replication components, such as Veeam Cloud Connect Portal or Veeam 
Backup Enterprise Manager, are installed on the machine where the console runs, these components 
will also be updated. 

  



 

478   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Uninstalling Veeam Backup & Replication 
To uninstall Veeam Backup & Replication: 

1. From the Start menu, select Control Panel > Programs and Features. 

2. In the programs list, right-click Veeam Backup & Replication and select Uninstall. If you 
have Veeam Backup Enterprise Manager installed on this machine, then 
Veeam Backup & Replication will uninstall both components. Wait for the process to 
complete. 

3. If the program list contains additional Veeam Backup & Replication components, for example, 
Veeam Backup & Replication Search Server Integration, right-click the remaining 
component(s) and select Uninstall. 

In a similar manner, you can uninstall the Veeam Backup & Replication console and Veeam Backup 
Enterprise Manager. 

The configuration database used by Veeam Backup & Replication is not removed during the uninstall 
process. All configuration data stored in the database remains as well. 
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Switching to Free and Full Functionality Modes 
Veeam Backup & Replication can operate in two functionality modes: full mode and free mode. 

 When you run Veeam Backup & Replication in the full functionality mode, you get a 
commercial version of the product that provides access to all product functions (the list of 
functions depends on the product edition). 

 When you run Veeam Backup & Replication in the free functionality mode, you get a free 
version of the product that offers limited capabilities. You can back up single VMs (create 
VeeamZIP files), recover VM data from backups, perform file copy operations, migrate VMs, 
restore VM data from storage snapshots, archive files to tape, restore application items with 
Veeam Explorers and perform configuration backup and restore. 

If you have a valid license installed on the backup server, Veeam Backup & Replication operates in the 
full functionality mode. As soon as your license expires, you will be offered to install a new license or 
switch to the free functionality mode. To switch to the free mode, select from the main menu View > 
Free functionality only. 

Mind the following limitations: 

 You cannot switch to the free functionality mode if a valid trial or paid license is installed on 
the backup server. In this case, the View menu item will not be displayed in the main menu. 

 You cannot switch to the free functionality mode if a per-VM license installed on the backup 
server. In this case, you have to purchase a new paid license and replace the expired license 
with this new license. 

To switch back to the full mode, do either of the following: 

 Install a valid license. To do this, from the main menu select Help > License. In the displayed 
window, click Install License and select the license file. 

 From the main menu, select View > Full functionality. If you do not have a valid license 
installed, you will not be able to use the functionality provided by the full mode. 
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Getting to Know User Interface 
The user interface of Veeam Backup & Replication is designed to let you quickly find commands that 
you need and perform necessary data protection and disaster recovery tasks.  
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Main Menu 
The main menu in Veeam Backup & Replication contains commands related to general application 
settings. You can perform the following operations using the main menu: 

 Upgrade backup infrastructure components 

 Start PuTTy 

 Set up user roles 

 Configure network traffic rules 

 Manage credentials 

 Manage passwords 

 Perform configuration backup and restore 

 Specify general application options 

 View Veeam Backup & Replication help, work with licenses and program logs 

 Exit Veeam Backup & Replication 

 

http://www.chiark.greenend.org.uk/~sgtatham/putty/
http://www.veeam.com/documentation-guides-datasheets.html
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Navigation Pane 
The navigation pane, located on the left of the window, provides centralized navigation and enables 
you to easily access Veeam Backup & Replication items organized in views. 

The navigation pane comprises two areas: 

 The upper, or the inventory pane, displays a hierarchy or list of items relevant for a specific 
view.  

The content of the inventory pane is different for different views. For example, in the Backup 
Infrastructure view, the inventory pane displays a list of backup infrastructure components 
— virtualization servers, backup proxies, backup repositories and so on. In the Virtual 
Machines view, the inventory pane displays a list of servers connected to 
Veeam Backup & Replication. 

 The lower pane contains a set of buttons that let you switch between views. 
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Ribbon and Tabs 
Operation commands in Veeam Backup & Replication are organized into logical groups and collected 
under tabs on the ribbon. The ribbon is displayed at the top of the main application window.  

On the ribbon, the following tabs are displayed: 

 The Home tab provides quick access to the most common operations. It lets you configure 
different types of jobs, perform restore and import operations. This tab is always available, no 
matter which view is currently opened. 

 Other tabs contain commands specific for certain items and appear when these items are 
selected. For example, if you open the Backup & Replication view and select a backup job in 
the working area, the Jobs tab containing buttons for operations with jobs will appear on the 
ribbon. If you open the Files view and select a file or folder, the File tab containing buttons 
for operations with files will appear on the ribbon. 

Tip: 

 

Commands for operations with items in Veeam Backup & Replication are also available in the 
shortcut menu. 
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Views 
Veeam Backup & Replication displays its items in views. When you click the button of a specific view in 
the navigation pane, the view content is displayed in the working area of Veeam Backup & Replication. 

Veeam Backup & Replication offers the following views: 

 The Backup & Replication view is intended for work with jobs. It also displays a list of created 
backups and replicas that can be used for various restore operations, and provides statistics 
on recently performed jobs. 

 The Backup Infrastructure view displays a list of backup infrastructure components: servers, 
hosts, backup proxies, backup repositories and WAN accelerators. You can use this view for 
backup infrastructure setup — here you can configure backup infrastructure components 
that will be used for data protection and disaster recovery tasks. 

 The Virtual Machines view displays the inventory of the virtual infrastructure. The inventory 
can be presented from different perspectives: Compute, Storage, VM Folders and VM Tags. 
You can use this view to work with VMs and VM containers. 

 The Storage Infrastructure view displays a list of storage systems, volumes and snapshots. 
You can use this view to restore VM data from storage snapshots. 

 The Tape Infrastructure view displays a hierarchy of tape libraries connected to the tape 
server. You can use this view to archive data to tapes and restore data from tapes. 

 The Cloud Connect Infrastructure view displays components of the Veeam Cloud Connect 
infrastructure. This view can be used by SP to manage SSL certificates, configure cloud 
gateways and create accounts for users who plan to use cloud resources.  

 The Files view displays a file tree of servers connected to Veeam Backup & Replication. You 
can use this view for file copying operations.  

 The History view displays statistics on operations performed with 
Veeam Backup & Replication.  

In some situations, some views may not be displayed. Mind the following: 

1. Right after installation, Veeam Backup & Replication displays only the Backup Infrastructure 
and History views. To display other views, you must add at least one server or virtualization 
host to the backup infrastructure. 

2. To display the Cloud Connect Infrastructure view, you must install a valid license that 
supports the Veeam Cloud Connect functionality. 

3. Right after installation, Veeam Backup & Replication does not save changes that you make to 
the navigation pane or views: for example, if you resize panes, display or hide specific views. 
After you restart the Veeam Backup & Replication console, the main window settings are back 
to default ones. To save these settings, you must add at least one server or virtualization host 
to the backup infrastructure. 

You can hide views that you do not plan to use. For example, if you do not use tapes for data archiving 
in your backup infrastructure, you can hide the Tape Infrastructure view.  
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To hide a view: 

1. Click the arrow icon below the buttons in the navigation pane.  

2. Click the view in the list. 
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Working Area 
The working area of Veeam Backup & Replication displays a list of items relating to a specific view.  

The working area looks different depending on the view that is currently opened. For example, if you 
open the History view, the working area will display a list of job sessions and restore tasks performed 
with Veeam Backup & Replication. If you open the Virtual Machines view, the working area will 
display a list of VMs that reside on servers connected to Veeam Backup & Replication. 
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Veeam Backup & Replication Editions 
Veeam offers different editions of Veeam Backup & Replication based on the level of functionality you 
need from the product. For more information, see https://www.veeam.com/backup-version-standard-
enterprise-editions-comparison.html. 

https://www.veeam.com/backup-version-standard-enterprise-editions-comparison.html
https://www.veeam.com/backup-version-standard-enterprise-editions-comparison.html
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VEEAM BACKUP & REPLICATION LICENSING 
To work with the full product version of Veeam Backup & Replication, you must obtain a trial license 
key or full license key and install it on the backup server. If you do not install the license key, the 
product will run in the free functionality mode. For more information, see Switching to Free and Full 
Functionality Modes.  

Types of Licenses 
Veeam Software offers the following types of paid licenses for Veeam Backup & Replication: 

 Perpetual license — a permanent full license. The perpetual license term is normally 10 
years from the date of license issue. The support and maintenance period included with the 
license is specified in months or years. Typically, one year of basic support and maintenance is 
included with the perpetual license. 

With the perpetual license, Veeam Backup & Replication can be licensed per-socket or per-
VM. 

 Subscription license — a full license that expires at the end of the subscription term. The 
subscription license term is normally 1-3 years from the date of license issue.  

With the subscription license, Veeam Backup & Replication can be licensed per-socket only. 

 Rental license — a full license with the license expiration date set according to the chosen 
rental program (normally 1-12 months from the date of license issue). The rental license can 
be automatically updated upon expiration.  

With the rental license, Veeam Backup & Replication can be licensed per-VM only. 

Important! 

 

Please note that per-VM licenses are provided to Veeam Cloud & Service Provides (VCSPs) only. For 
end-users, Veeam offers per-socket licenses.  

The following terms apply to Veeam Backup & Replication paid licenses: 

License Type Licensing Period Grace Period Licensing 

Perpetual license 10 years n/a Per socket/per VM 

Subscription license 1-3 years 30 days Per socket 

Rental license 1-12 months 60 days Per VM 

In addition to paid licenses, Veeam Backup & Replication offers two types of free licenses: 

 Trial license — a full license that can be used for product evaluation. The trial license is valid 
for 30 days from the moment of product download. 

 NFR license — a full license that can be used for product demonstration, training and 
education. The person to whom the license is provided agrees that the license is not for resell 
or commercial use. 
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Licensed Objects 
Veeam licenses Veeam Backup & Replication in two ways:  

 By the number of CPU sockets on managed hosts VMware vSphere or Microsoft Hyper-V 
servers or hosts. A license is required for every occupied motherboard socket as reported by 
the hypervisor API. 

License is required only for source hosts — hosts on which VMs that you back up or replicate 
reside. Target hosts (for replication and migration jobs) do not need to be licensed. 

 By the number of protected VMs. You must obtain a license for the total number of VMs 
that you plan to back up, replicate, copy or for which you plan to create VeeamZIP files. VMs 
processed with backup copy and tapes jobs are not regarded as protected VMs — these 
types of jobs provide an additional protection level for VMs that are already protected with 
backup jobs.  

Veeam Backup & Replication keeps track of the number of protected VMs. If the number of 
protected VMs exceeds the number of licensed VMs, Veeam Backup & Replication will display 
a warning when you open the product console. 

For more information, see https://www.veeam.com/backup-licensing-faq.html. 

  

https://www.veeam.com/backup-licensing-faq.html
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Automatic Usage Logging 
When license auto update is enabled for Rental licenses (per-VM licensing), 
Veeam Backup & Replication additionally performs automatic usage logging. 

As part of logging, Veeam Backup & Replication collects statistics on the current license usage and 
sends it periodically to the Veeam License Update Server. The report provides information on the 
maximum number of VMs that were managed by Veeam Backup & Replication over the past week 
(high watermark). The process runs in the background mode, once a week at a random time and day. 

The collected data allows our back-end system to automatically approve your monthly usage reports 
as long as they do not deviate from high watermark value significantly. This helps to keep our report 
processing costs low, thus allowing us to maintain low rental prices for our solution. 

 

Grace Period and License Termination 
To ensure a smooth license update and provide sufficient time to install a new license file, 
Veeam Backup & Replication offers a grace period.  

During the grace period, you can perform all types of data protection and disaster recovery 
operations. However, the license status in the License Information window will appear as Expired 
(<number> days of grace period remaining). Veeam Backup & Replication will also display a warning 
message “License key has expired, <number> days of grace period remaining” in properties of jobs that 
are available only in the paid version of Veeam Backup & Replication, for example: backup job, 
replication job, VM copy job and so on.  

The duration of the grace period is defined by the type of license. For more information, see Types of 
Licenses. 

You must update your license before the end of the grace period. If you do not update the license 
until the end of the grace period, the following measures will be taken: 

 [For trial and NFR licenses] Veeam Backup & Replication will switch to the free operational 
mode. 

 [For full licenses] Functionality available in the Enterprise and Enterprise Plus editions of 
Veeam Backup & Replication will not be available; VMs will not be processed by existing jobs 
(jobs will fail with the Error status). However, you will be able to restore VM data from existing 
backups. 
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Obtaining License 
To run Veeam Backup & Replication in the full functionality mode, you must obtain a license and 
install it on the backup server during product installation or after the product is installed. 

Trial License 
You can obtain a trial license for the product when you download the product from the Veeam 
website. The trial license is valid for 30 days from the moment of product download.  

To obtain a trial license: 

1. Log on to the Veeam website at https://login.veeam.com/signin using your Veeam account. If 
you do not have an account, you must register a new account. 

2. At https://www.veeam.com/downloads/, click the Download link next to the product that 
you want to download.  

3. On the product page, click the Download button. 

4. In the License Keys section, click the Trial Key for VMware link to download the license. 

 

Full License 
To obtain a full paid license, visit https://www.veeam.com/buy-veeam-products-pricing.html.  

To renew your maintenance plan, contact Veeam Renewals Team at renewals@veeam.com. 

  

https://login.veeam.com/signin
https://www.veeam.com/downloads/
https://www.veeam.com/buy-veeam-products-pricing.html
mailto:renewals@veeam.com
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Installing License 
When you install Veeam Backup & Replication, you are asked to specify a path to the license file. If you 
do not specify a path to the license file, Veeam Backup & Replication will run in the free functionality 
mode.  

 

You can install or change the license after product installation: 

1. From the main menu, select Help > License. 

2. To install or change the license, click Install License and browse to the LIC file. 
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If backup servers are connected to Veeam Backup Enterprise Manager, Veeam Backup Enterprise 
Manager collects information about all licenses installed on backup servers. When Veeam Backup 
Enterprise Manager replicates databases from backup servers, it also synchronizes license data: checks 
if the license installed on the backup server coincides with the license installed on the Veeam Backup 
Enterprise Manager server. If the licenses do not coincide, the license on the backup server is 
automatically replaced with the license installed on the Veeam Backup Enterprise Manager server.  
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Viewing Licensed Hosts and Revoking License 
When you run a job, Veeam Backup & Replication applies a license to the virtualization host on which 
processed VMs reside (for per-socket licenses) or to processed VMs (for per-VM licenses). You can view 
to which hosts or VMs the license is currently applied. 

To view a list of licensed hosts or VMs: 

1. From the main menu, select Help > License.  

2. In the License Information window, click Licensed Hosts or Licensed VMs.  

When you start Veeam Backup & Replication for the first time, the list is empty. After you run backup 
or replication jobs, the list will include source hosts or VMs that were engaged in the jobs. 

Revoking License from Hosts or VMs 
You can revoke the license from some hosts or VMs and re-apply it to other hosts or VMs. License 
revoking can be helpful, for example, if the licensed host goes out of service or you do not want to 
protect some VMs anymore. 

To revoke a license from the host or VMs: 

1. From the main menu, select Help > License.  

2. In the License Information window, click Licensed Hosts or Licensed VMs.  

3. In the displayed window, select a host or VM and click Revoke. Veeam Backup & Replication 
will revoke the license from the host or VM, and the license will be freed for other hosts or 
VMs in the backup infrastructure. 
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Updating Veeam Backup & Replication License 
You must update your license upon expiry to be able to use all data protection and disaster recovery 
features. There are two methods to update the Veeam Backup & Replication license: 

 Update the license on demand 

 Update the license automatically 
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Updating License on Demand 
You can update the license from the Veeam License Update Server on demand: 

1. Launch Veeam Backup & Replication. 

2. From the main menu, select Help > License. The License Information window will be 
displayed.  

3. At the bottom of the License Information window, click Update Now. 

Veeam Backup & Replication will connect to the Veeam License Update Server, download a 
new license from it (if available), install it on the backup server and display a window with the 
license update result. 

4. Click OK to acknowledge the result. 
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Updating License Automatically 
You can instruct Veeam Backup & Replication to automatically update the license installed on the 
backup server or Veeam Backup Enterprise Manager server. With the automatic update option 
enabled, Veeam Backup & Replication proactively communicates with the Veeam licensing portal to 
obtain and install a new license before the current license expires. Automatic license update removes 
the need to download and install the license manually each time when you purchase the license 
extension. 

Requirements and Limitations for Automatic License Update 
1. Automatic license update is available in all editions of Veeam Backup & Replication operating 

in the full functionality mode. 

2. Only licenses with Support ID can be updated automatically.  

3. Automatic license update is not supported for licenses with merged Support IDs.  

4. If you are managing backup servers with Veeam Backup Enterprise Manager, all license 
management tasks are performed via Veeam Backup Enterprise Manager. Automatic update 
settings in Veeam Backup Enterprise Manager override automatic update settings configured 
in Veeam Backup & Replication. For example, if the automatic update option is enabled in 
Veeam Backup Enterprise Manager but disabled in Veeam Backup & Replication, automatic 
update will be performed anyway. For more information, see Veeam Backup Enterprise 
Manager User Guide 

How Automatic License Update Works 

To update installed licenses automatically, Veeam Backup & Replication performs the following 
actions: 

1. After you enable automatic license update, Veeam Backup & Replication starts sending 
requests to the Veeam License Update Server on the web (autolk.veeam.com) and checks if a 
new license key is available. Requests are sent once a week. Communication with the portal is 
performed over the HTTPS protocol. 

2. Seven days before the expiration date of the current license, Veeam Backup & Replication 
starts sending requests once a day. 

3. When a new license key becomes available on the Veeam license management portal, 
Veeam Backup & Replication automatically downloads it and installs on the backup server or 
Veeam Backup Enterprise Manager server.  
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Automatic Update Retries 
If Veeam Backup & Replication fails to update the license, it displays a notification in the session report 
and sends an email notification to users specified in the global email settings (if global email settings 
are configured on the backup server). You can resolve the issue, while Veeam Backup & Replication 
will keep retrying to update the license. 

Veeam Backup & Replication retries to update the license key in the following way: 

 If a connection to the Veeam license management portal cannot be established, retry takes 
place every 60 min. 

 If a connection can be established but you are receiving the “General license key generation 
error has occurred” message, the retry takes place every 24 hours. 

The retry period ends in one month after the expiration date of the current license. The retry period is 
calculated as the number of days in the month of license expiration. For example, if the license expires 
in January, the retry period will be 31 day; if the license expires in April, the retry period will be 30 
days. 

If the retry period is over but the new license has not been installed, the automatic update feature is 
automatically disabled. 

For more information about error cases, see Appendix. 

 

  

http://helpcenter.veeam.com/backup/em/appendix.html
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Enabling Automatic License Update 

By default, automatic license update is disabled. To enable automatic license update: 

1. From the main menu, select Help > License. 

2. In the License Information window, select the Update license key automatically check 
box. You can click Update now to force immediate license update. 

 

Statistics on the automatic license update process is available under the System node in the History 
view. You can double-click the License key auto-update job to examine session details for the 
scheduled or ad-hoc automatic license update. 
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ADMINISTRATION 
You can perform the following operations to protect your virtual infrastructure and perform disaster 
recovery tasks: 

 Logging on to Veeam Backup & Replication 

 Setting Up Backup Infrastructure 

 Creating Backup Jobs 

 Creating Replication Jobs 

 Creating VM Copy Jobs 

 Managing Jobs 

 Importing Backups 

 Creating VeeamZIP Files 

 Performing Active Full Backup 

 Performing Quick Backup 

 Working with Backup Copy Jobs 

 Migrating VMs 

 Performing Recovery Verification 

 Configuring On-Demand Sandbox 

 Performing Restore 

 Performing Replica Failover and Failback 

 Working with VMware vCloud Director VMs 

 Working with Storage Snapshots 

 Working with Tape Media 

 Working with Veeam Cloud Connect 

 Performing File Copy Operations 

 Specifying General Settings 

 Reporting 

 Assigning Roles to Users 

 Installing Updates 

 Logging 

 Performing Configuration Backup and Restore 

 Working with Veeam Backup & Replication Utilities 
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Logging on to Veeam Backup & Replication 
To log on to Veeam Backup & Replication, you must open the Veeam Backup & Replication console 
and specify connection settings to access the backup server.  

1. To open the Veeam Backup & Replication console, do one of the following: 

 Double-click the console icon on the desktop.  

 From the Microsoft Windows Start menu, select All Programs > Veeam > 
Veeam Backup & Replication Console.  

 Use the Microsoft Windows search to find the Veeam Backup & Replication 
Console program on the computer. 

2. In the Server field, type the name or IP address of the backup server or select it from the list 
of recent connections. By default, the console connects to the backup server installed locally 
— localhost.  

3. In the Port field, enter the port over which you want to connect to the backup server. The 
port number is set at the Port Configuration step of the setup wizard for 
Veeam Backup & Replication. By default, port 9392 is used. 

4. In the Username and Password fields, enter credentials of the user account that you want to 
use to connect to the backup server. The user account must be added to the Local Users 
group on the backup server or a group of domain users who have access to the backup 
server.  

You can also select the Use Windows session authentication check box. In this case, you 
will log on to Veeam Backup & Replication using the account under which you are currently 
logged on to Microsoft Windows. 

5. To create a shortcut for the connection, click Save shortcut. You can create as many 
shortcuts as you need. 
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Setting Up Backup Infrastructure 
Before you can perform data protection and disaster recovery tasks with Veeam Backup & Replication, 
you must plan and set up your backup infrastructure. The backup infrastructure architecture may vary 
depending on your virtual environment and backup strategy. A typical backup infrastructure consists 
of the following components: 

 Backup server 

 Backup proxy(ies) 

 Backup repository(ies) 

 Virtual infrastructure servers: virtualization hosts used as source and target for backup, 
replication and other types of jobs 

 Servers used for various types of restore operations: Microsoft Windows servers, Linux servers 
and so on 

 WAN accelerators 

 Mount servers 

 Guest interaction proxies 

 [optional] Additional Veeam Backup & Replication console(s) 

To set up the backup infrastructure, you must perform the following actions: 

1. [Recommended] Specify credentials. You can specify credentials for accounts that you plan 
to use to connect to backup infrastructure components, VM guest OSes and other objects in 
the backup infrastructure. For more information, see Managing Credentials. 

2. [Recommended] Specify encryption passwords. You can set up passwords that you plan to 
use for data encryption. For more information, see Managing Passwords for Data Encryption. 

3. Add servers. You must connect to the backup server all virtualization hosts and servers that 
you plan to use as backup infrastructure components. These include backup proxies, backup 
repositories, WAN accelerators and so on. 

4. Assign roles of backup infrastructure components. You must assign corresponding roles 
to servers that you plan to use as backup infrastructure components. 

5. Specify network settings. You can set up network throttling rules, manage data transfer 
connections, enable network encryption and specify what networks must be used for data 
protection operations. For more information, see Managing Network Traffic. 

In addition to its primary functions, a newly deployed backup server performs roles of a backup proxy 
and backup repository. For this reason, the backup server is added to the list of backup proxies and 
backup repositories by default. This means that immediately after installation you can connect 
virtualization hosts and Microsoft Windows/Linux servers, configure and run necessary jobs. The 
backup server will be used as the backup server, backup proxy and backup repository at the same 
time.  

Such scenario is acceptable only if you plan to protect a small number of VMs or perform pilot testing. 
For a full-fledged backup infrastructure, you must configure dedicated backup infrastructure 
components: backup proxies, backup repositories and so on. The distributed backup infrastructure 
deployment will be organized around the backup server that will function as the point of control for 
administrative tasks and job processing. Data processing tasks will be offloaded to dedicated backup 
infrastructure components. 
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Managing Credentials 
You can use the Credentials Manager to create and maintain a list of credentials records that you plan 
to use to connect to components in the backup infrastructure.  

The Credentials Manager lets you create the following types of credentials records: 

 Standard account (Microsoft Windows) 

 Linux account (user name and password) 

 Linux private key (Identity/Pubkey) 

Standard Accounts (Microsoft Windows) 

You can create a credentials record for the account that you plan to use to connect to a Microsoft 
Windows sever or VM running Microsoft Windows OS. 

To create a new credentials record for a Microsoft Windows server: 

1. From the main menu, select Manage Credentials. 

2. Click Add > Standard account.  

3. In the Username field, enter a user name for the account that you want to add. You can also 
click Browse to select an existing user account. 

4. In the Password field, enter a password for the account that you want to add. To view the 
entered password, click and hold the eye icon on the right of the field. 

5. In the Description field, enter a description for the created credentials record. As there can 
be a number of similar account names, for example, Administrator, it is recommended that 
you provide a meaningful unique description for the credentials record so that you can 
distinguish it in the list. The description is shown in brackets, following the user name. 
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Linux Accounts (User Name and Password) 

You can create a credentials record for the account that you plan to use to connect to a Linux sever or 
VM running Linux OS. 

To create a new credentials record with a user name and password for a Linux server: 

1. From the main menu, select Manage Credentials. 

2. Click Add > Linux account.  

3. In the Username field, enter a user name for the account that you plan to add. 

4. In the Password field, enter a password for the account that you want to add. To view the 
entered password, click and hold the eye icon on the right of the field. 

5. In the SSH port field, specify the SSH port over which you want to connect to a Linux server. 
By default, port 22 is used. 

6. If you specify data for a non-root account that does not have root permissions on a Linux 
server, you can use the Non-root account section to grant sudo rights to this account.  

a. To provide a non-root user with root account privileges, select the Elevate 
specified account to root check box.  

b. To add the user account to sudoers file, select the Add account to the sudoers file 
automatically check box. In the Root password field, enter the password for the 
root account. 

If you do not enable this option, you will have to manually add the user account to 
the sudoers file. 

7. In the Description field, enter a description for the created credentials record. As there can 
be a number of similar account names, for example, Administrator, it is recommended that 
you provide a meaningful unique description for the credentials record so that you can 
distinguish it in the list. The description is shown in brackets, following the user name. 
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Important! 

 

In the sudoers file, enable the NOPASSWD:ALL option for the user account that you want to elevate to 
root. Otherwise, jobs addressing a Linux server will fail as sudo will request the password.  
You can create a separate user account intended for work with Veeam Backup & Replication on a 
Linux-based VM, grant root privileges to this account and specify settings of this account in the 
Credentials Manager. It is recommended that you avoid additional commands output for this user 
(like messages echoed from within ~/.bashrc or command traces before execution) because they 
may affect Linux VM processing. 
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Linux Private Keys (Identity/Pubkey) 

You can log on to a Linux server using the Identity/Pubkey authentication method. The 
Identity/Pubkey authentication method helps protect against malicious applications like keyloggers, 
strengthens the security level and simplifies launch of automated tasks.  

To use the Identity/Pubkey authentication method, you must generate a pair of keys — a public key 
and private key: 

 Public key is stored on Linux server(s) to which you plan to connect from the backup server. 
The key is kept in a special authorized_keys file containing a list of public keys. 

 Private key is stored on the client machine — backup server. The private key is protected with 
a passphrase. Even if the private key is intercepted, the eavesdropper will have to provide the 
passphrase to unlock the key and use it. 

For authentication on a Linux server, the client must prove that it has the private key matching the 
public key stored on the Linux server. To do this, the client generates a cryptogram using the private 
key and passes this cryptogram to the Linux server. If the client uses the "correct" private key for the 
cryptogram, the Linux server can easily decrypt the cryptogram with a matching public key. 

Veeam Backup & Replication has the following limitations for the Identity/Pubkey authentication 
method: 

 Veeam Backup & Replication does not support keys that are stored as binary data, for 
example, in a file of DER format. 

 Veeam Backup & Replication supports only keys whose passphrase is encrypted with 
algorithms supported by PuTTY: 

– AES (Rijndael): 128-bit, 192-bit and 256-bit CBC or CTR (SSH-2 only) 

– Blowfish: 128-bit CBC 

– Triple-DES: 168-bit CBC 

To add a credentials record using the Identity/Pubkey authentication method: 

1. Generate a pair of keys using a key generation utility, for example, ssh-keygen. 

2. Place the public key on a Linux server. To do this, add the public key to the 
authorized_keys file in the .ssh/ directory in the home directory on the Linux server.  

3. Place the private key in some folder on the backup server or in a network shared folder. 

4. In Veeam Backup & Replication, from the main menu select Manage Credentials. 

5. Click Add > Linux private key. 

6. In the Username field, specify a user name for the created credentials record. 

7. In the Passphrase field, specify a passphrase for the private key on the backup server. To 
view the entered passphrase, click and hold the eye icon on the right of the field. 

8. In the Private key field, enter a path to the private key or click Browse to select a private key. 

9. In the SSH port field, specify a number of the SSH port that you plan to use to connect to a 
Linux server. By default, port 22 is used. 
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10. If you specify data for a non-root account that does not have root permissions on a Linux 
server, you can use the Non-root account section to grant sudo rights to this account.  

a. To provide a non-root user with root account privileges, select the Elevate 
specified account to root check box.  

b. To add the user account to sudoers file, select the Add account to the sudoers file 
automatically check box. In the Root password field, enter the password for the 
root account. 

If you do not enable this option, you will have to manually add the user account to 
the sudoers file. 

11. In the Description field, enter a description for the created credentials record. As there can 
be a number of similar account names, for example, Administrator, it is recommended that 
you supply a meaningful unique description for the credentials record so that you can 
distinguish it in the list. The description is shown in brackets, following the user name. 

Important! 

 

In the sudoers file, enable the NOPASSWD:ALL option for the user account that you want to elevate to 
root. Otherwise, jobs addressing a Linux server will fail as sudo will request the password.  
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Editing and Deleting Credentials Records 

You can edit and delete credentials records that you have created.  

To edit a credentials record: 

1. From the main menu, select Manage Credentials. 

2. Select the credentials record in the list and click Edit. 

3. If the credentials record is already used for any component in the backup infrastructure, 
Veeam Backup & Replication will display a warning. Click Yes to confirm your intention. 

4. Edit settings of the credentials record as required. 

To delete a credentials record: 

1. From the main menu, select Manage Credentials. 

2. Select the credentials record in the list and click Remove. You cannot delete a record that is 
already used for any component in the backup infrastructure.  

Note: 

 

The Credentials Manager contains two system credentials records: a credentials record for the Veeam 
FLR appliance and credentials record for the tenant-side network extension appliance. You cannot 
delete these credentials records. However, you can edit them: change a password and record 
description. 
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Managing Passwords for Data Encryption 
You can use the Password Manager to create and maintain a list of passwords that you plan to use for 
data encryption. Password management can be helpful in the following situations: 

 You want to create new passwords. You can use one password per job or share the same 
password between several jobs on the backup server. 

 You want to edit an existing password, for example, change its hint, or delete a password. 

Tip: 

 

Periodical change of passwords is a security best practice. You can create new passwords as often as 
you need based on your company security needs and regulatory requirements. 

Creating Passwords 

You can use the Password Manager to create one or more passwords. 

To create a new password: 

1. From the main menu, select Manage Passwords. Alternatively, you can use job properties to 
create a new password: 

a. Open the Backup & Replication view. 

b. In the inventory pane, select Jobs.  

c. In the working area, right-click the backup or backup copy job and select Edit. 

d. At the Storage step of the wizard (for backup job) or Target step of the wizard 
(for backup copy job), click Advanced.  

e. Click the Storage tab.  

f. In the Encryption section of the Advanced Setting window, select the Enable 
backup file encryption check box and click the Manage passwords link. 

Veeam Backup & Replication will open the Password Manager. 

2. In the Password Manager, click Add. 

3. In the Description field, specify a hint for the created password. It is recommended that you 
provide a meaningful hint that will help you recall the password. The password hint is 
displayed when you import an encrypted file on the backup server and access this file. 

4. In the Password field, enter a password. To view the entered password, click and hold the eye 
icon on the right of the field. 
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Important! 

 

Always save a copy of the password you create in a secure place. If you lose the password, you will 
not be able to restore it.  
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Editing Passwords 

You can edit passwords you have created using the Password Manager. 

To edit a password: 

1. From the main menu, select Manage passwords. Alternatively, you can use job properties to 
edit the password: 

a. Open the Backup & Replication view. 

b. In the inventory pane, select Jobs.  

c. In the working area, right-click the backup or backup copy job and select Edit. 

d. At the Storage step of the wizard (for backup job) or Target step of the wizard 
(for backup copy job), click Advanced.  

e. Click the Storage tab.  

f. In the Encryption section of the Advanced Setting window, select the Enable 
backup file encryption check box and click the Manage passwords link. 

Veeam Backup & Replication will open the Password Manager. 

2. In the Password Manager, select the password and click Edit. 

3. Edit the password data: hint and password, as required.  
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Deleting Passwords 

You can delete passwords using the Password Manager. 

You cannot remove a password that is currently used by any job on the backup server. To remove 
such password, you first need to delete a reference to this password in the job settings. 

To delete a password: 

1. From the main menu, select Manage passwords. Alternatively, you can use job properties to 
delete passwords: 

a. Open the Backup & Replication view. 

b. In the inventory pane, select Jobs. 

c. In the working area, right-click the backup or backup copy job and select Edit. 

d. At the Storage step of the wizard (for backup job) or Target step of the wizard 
(for backup copy job), click Advanced.  

e. Click the Storage tab.  

f. In the Encryption section of the Advanced Setting window, select the Enable 
backup file encryption check box and click the Manage passwords link. 

Veeam Backup & Replication will open the Password Manager. 

2. In the Password Manager, select the password and click Remove. 
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Managing Servers 
You can add the following types of servers to the backup infrastructure: 

 VMware vSphere Server 

 Microsoft Windows Server 

 Linux Server 

 VMware vCloud Director 

You can add physical machines and VMs to the backup infrastructure and assign different roles to 
them. The table below describes which roles can be assigned to the different types of servers. 

Server Type Source 
Host 

Target 
Host 

Backup 
Proxy 

Backup 
Repository 

VMware vSphere Server  
(standalone ESX(i) host or vCenter 
Server) 

    

Microsoft Windows server     

Linux server     

VMware vCloud Director     
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Adding VMware vSphere Servers 

You must add to the backup infrastructure VMware vSphere servers that you plan to use as source and 
target for backup, replication and other activities.  

You can add vCenter Servers and ESX(i) hosts. If an ESX(i) host is managed by the vCenter Server, it is 
recommended that you add the vCenter Server, not a standalone ESX(i) host. If you move VMs 
between ESX(i) hosts managed by vCenter Server, you will not have to re-configure jobs in 
Veeam Backup & Replication. Veeam Backup & Replication will automatically locate migrated VMs and 
continue processing them as usual.  

To add a VMware vSphere server, use the New VMware Server wizard. 

Step 1. Launch New VMware Server Wizard 

To launch the New VMware Server wizard, do one of the following: 

 Open the Backup Infrastructure view, in the inventory pane select the Managed servers 
node and click Add Server on the ribbon. You can also right-click the Managed servers node 
and select Add server. In the Add Server window, click VMware vSphere. 

 Open the Virtual Machines view, in the inventory pane select the VMware vSphere node 
and click Add Server on the ribbon. You can also right-click the VMware vSphere node and 
select Add server. 

 Open the Virtual Machines or Files view, right-click anywhere in the inventory pane and 
select Add server. In the Add Server window, select VMware vSphere.  
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Step 2. Specify Server Name or Address 

At the Name step of the wizard, specify an address and description for the VMware vSphere server. 

1. Enter a full DNS name or IP address of the vCenter Server or standalone ESX(i) host.  

2. Provide a description for future reference. The default description contains information about 
the user who added the server, date and time when the server was added. 

 

Step 3. Specify Credentials 

At the Credentials step of the wizard, specify credentials and port settings for the VMware vSphere 
server. 

1. From the Credentials list, select credentials for the account that has administrator privileges 
on the VMware vSphere server.  

If you have not set up credentials beforehand, click the Manage accounts link or click Add on 
the right to add the credentials. For more information, see Managing Credentials. 

2. By default, Veeam Backup & Replication uses port 443 to communicate with vCenter Servers 
and ESX(i) hosts. If a connection with the vCenter Sever or ESX(i) host over this port cannot be 
established, you can customize the port number in vCenter Server/ESX(i) host settings and 
specify the new port number in the Port field. 
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3. When you add a vCenter Server or ESX(i) host, Veeam Backup & Replication saves to the 
configuration database a thumbprint of the SSL certificate installed on the vCenter Server or 
ESX(i) host. During every subsequent connection to the server, Veeam Backup & Replication 
uses the saved thumbprint to verify the server identity and avoid the man-in-the-middle 
attack. 

If the certificate installed on the server is not trusted, Veeam Backup & Replication displays a 
warning. 

 If you trust the server, click Connect. 

 If you do not trust the server, click Cancel. Veeam Backup & Replication will display 
an error message, and you will not be able to connect to the server. 
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Note: 

 

If you update the certificate on the server, you must acknowledge the new certificate in the server 
connection settings. To do this, in the Backup Infrastructure view open the server settings, pass 
through the Edit Server wizard and click Trust to acknowledge the key. 

 

Step 4. Specify SSH Settings 

This step is available only if you are adding an ESX host. If you are adding a vCenter Server or ESXi 
host, the wizard will skip this step, and you will pass to the Summary step of the wizard. 

If necessary, you can use an SSH connection for file copying operations. SSH connection settings are 
optional. If you do not want to use SSH, clear the Use service console connection to this server 
check box. In this case, Veeam Backup & Replication will work with the ESX host in the agentless 
mode.  

To use a SSH connection: 

1. Make sure that the Use service console connection to this server check box is selected. 

2. From the Credentials list, select credentials to connect to the service console of the ESX host. 
If you have not set up credentials beforehand, click the Manage accounts link or click Add on 
the right to add the credentials. For more information, see Managing Credentials. 

3. To configure advanced SSH settings, click Advanced. 

a. In the Service console connection section, specify an SSH timeout. By default, the 
SSH timeout is set to 20000 ms. If a task targeted at the ESX host is inactive after the 
specified timeout, Veeam Backup & Replication will automatically terminate the 
task. 

b. In the Data transfer options section, specify connection settings for file copy 
operations. Enter a range of ports that will be used as transmission channels 
between the source host and target host (one port per task). By default, 
Veeam Backup & Replication uses port range 2500-5000. If the virtual environment 
is not large and data traffic will not be significant, you can specify a smaller range of 
ports, for example, 2500-2510 to run 10 concurrent jobs at the same time.  
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c. If the ESX host is deployed outside NAT, in the Preferred TCP connection role 
section select the Run server on this side check box. In the NAT scenario, the 
outside client cannot initiate a connection to the server on the NAT network. As a 
result, services that require initiation of the connection from outside can be 
disrupted. With this option selected, you will be able to overcome this limitation 
and initiate a ‘server-client’ connection — that is, a connection in the direction of 
the ESX host. 
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Step 5. Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of VMware vSphere server adding. 

1. Review details of the VMware vSphere server. 

2. Click Finish to exit the wizard. 
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Adding Microsoft Windows Servers 

You must add to the backup infrastructure Microsoft Windows servers that you plan to use as backup 
infrastructure components and servers that you plan to use for various types of restore operations. 

Before adding a Microsoft Windows server, check prerequisites. Then use the New Windows Server 
wizard to add the server. 

Before You Begin 

Before you add a Microsoft Windows server to the backup infrastructure, check network connection 
settings of this server. 

File and printer sharing must be enabled in network connection settings of the added Microsoft 
Windows server. On every connected Microsoft Windows server, Veeam Backup & Replication deploys 
two components:  

 Veeam Installer Service 

 Veeam Data Mover Service 

If file and printer sharing is not enabled, Veeam Backup & Replication will fail to deploy these 
components. 
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Step 1. Launch New Windows Server Wizard 

To launch the New Windows Server wizard, do one of the following: 

 Open the Backup Infrastructure view, in the inventory pane select the Microsoft Windows 
node and click Add Server on the ribbon. 

 Open the Backup Infrastructure or Files view, in the inventory pane right-click the 
Microsoft Windows node and select Add Server. 

 Open the Virtual Machines or Files view, right-click anywhere in the inventory pane and 
select Add server. In the Add Server window, select Microsoft Windows. 
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Step 2. Specify Server Name or Address 

At the Name step of the wizard, specify an address and description for the Microsoft Windows server. 

1. Enter a full DNS name or IP address of the Microsoft Windows server. 

2. Provide a description for future reference. The default description contains information about 
the user who added the server, date and time when the server was added. 
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Step 3. Specify Credentials 

At the Credentials step of the wizard, specify credentials for the Microsoft Windows server. 

1. From the Credentials list, select credentials for the account that has administrator privileges 
on the Microsoft Windows server. If you have not set up credentials beforehand, click the 
Manage accounts link or click Add on the right to add the credentials. For more information, 
see Managing Credentials. 

Veeam Backup & Replication will use the provided credentials to deploy the following 
components on the added server: 

 Veeam Installer Service 

 Veeam Data Mover Service (Transport) 

 

2. To customize network ports used by Veeam Backup & Replication components, click Ports. By 
default, Veeam Backup & Replication components use the following ports: 

 Veeam Installer Service: port 6160 

 Veeam Data Mover Service (Transport): port 6162 

 Veeam vPower NFS Service: port 6161 

 Veeam WAN Accelerator Service: port 6164 

 Veeam Mount Server: port 6170 

If necessary, adjust port numbers. 

3. In the Data transfer options section of the Network Settings window, specify connection 
settings for file copy operations. Provide a range of ports that will be used as transmission 
channels between the source server and target server (one port per task). By default, 
Veeam Backup & Replication uses port range 2500-5000. If the virtual environment is not 
large and data traffic will not be significant, you can specify a smaller range of ports, for 
example, 2500-2510 to run 10 concurrent jobs at the same time.  
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4. If the Microsoft Windows server is deployed outside NAT, in the Preferred TCP connection 
role section select the Run server on this side check box. In the NAT scenario, the outside 
client cannot initiate a connection to the server on the NAT network. As a result, services that 
require initiation of the connection from outside can be disrupted. With this option selected, 
you will be able to overcome this limitation and initiate a ‘server-client’ connection — that is, 
a connection in the direction of the Microsoft Windows server. 
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Step 4. Review Components 

At the Review step of the wizard, review what Veeam Backup & Replication components are already 
installed on the server and what components will be installed.  

1. Review the components. 

2. Click Next to add the Microsoft Windows server to the backup infrastructure. 
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Step 5. Finish Working with Wizard 

At the Apply step of the wizard, complete the procedure of Microsoft Windows server adding. 

1. Review details of the Microsoft Windows server. 

2. Click Next, then click Finish to exit the wizard. 
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Adding Linux Servers 

You must add to the backup infrastructure Linux servers that you plan to use as backup repositories 
and servers that you plan to use for various types of restore operations. 

To add a Linux server, use the New Linux Server wizard. 

Step 1. Launch New Linux Server Wizard 

To launch the New Linux Server wizard, do one of the following: 

 Open the Backup Infrastructure view. In the inventory pane select the Managed servers 
node and click Add Server on the ribbon. You can also right-click the Managed servers node 
and select Add Server. In the Add Server window, select Linux. 

 Open the Virtual Machines or Files view, right-click anywhere in the inventory pane and 
select Add server. In the Add Server window, select Linux.  
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Step 2. Specify Server Name or Address 

At the Name step of the wizard, specify an address and description for the Linux server. 

1. Enter a full DNS name or IP address of the Linux server. 

2. Provide a description for future reference. The default description contains information about 
the user who added the server, date and time when the server was added. 
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Step 3. Specify Credentials and SSH Settings 

At the SSH Connection step of the wizard, specify credentials for the Linux server. 

1. From the Credentials list, select credentials for the account that has administrator privileges 
on the Linux server. You can select a credentials record that uses the password authentication 
method or credentials record that uses the Identity/Pubkey authentication method.  

If you have not set up credentials beforehand, click the Manage accounts link or click Add on 
the right to add the credentials. For more information, see Managing Credentials. 

 

2. To configure advanced SSH settings, click Advanced. 

a. In the Service console connection section, specify an SSH timeout. By default, the 
SSH timeout is set to 20000 ms. If a task targeted at the Linux server is inactive after 
the specified timeout, Veeam Backup & Replication will automatically terminate the 
task. 

b. In the Data transfer options section of the Network Settings window, specify 
connection settings for file copy operations. Provide a range of ports that will be 
used as transmission channels between the source host and target host (one port 
per task). By default, Veeam Backup & Replication uses port range 2500-5000. If the 
virtual environment is not large and data traffic will not be significant, you can 
specify a smaller range of ports, for example, 2500-2510 to run 10 concurrent jobs 
at the same time.  
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c. If the Linux server is deployed outside NAT, in the Preferred TCP connection role 
section select the Run server on this side check box. In the NAT scenario, the 
outside client cannot initiate a connection to the server on the NAT network. As a 
result, services that require initiation of the connection from outside can be 
disrupted. With this option selected, you will be able to overcome this limitation 
and initiate a ‘server-client’ connection — that is, a connection in the direction of 
the Linux server. 

 

3. When you add a Linux server, Veeam Backup & Replication saves a fingerprint of the Linux 
host SSH key to the configuration database. During every subsequent connection to the 
server, Veeam Backup & Replication uses the saved fingerprint to verify the server identity 
and avoid the man-in-the-middle attack. 

To let you identify the server, Veeam Backup & Replication displays the SSH key fingerprint: 

 If you trust the server and want to connect to it, click Yes.  

 If you do not trust the server, click No. Veeam Backup & Replication will display an 
error message, and you will not be able to connect to the server.  
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Note: 

 

If you update the SSH key on the server, you must acknowledge the new key in the server connection 
settings. To do this, in the Backup Infrastructure view open the server settings, pass through the 
Edit Server wizard and click Trust to acknowledge the new key. 
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Step 4. Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of Linux server adding. 

1. Review details of the Linux server. 

2. Click Next, then click Finish to exit the wizard. 
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Adding VMware vCloud Director 

To work with vApps and VMs managed by VMware vCloud Director, you must add VMware vCloud 
Director to the backup infrastructure. 

After you add VMware vCloud Director to the backup infrastructure, the VMware vCloud Director 
hierarchy is displayed in the Virtual Machines > vCloud Director view in 
Veeam Backup & Replication. You can work with VMs managed by VMware vCloud Director directly 
from the Veeam Backup & Replication console. 

To add the VMware vCloud Director host, use the New VMware vCloud Director wizard. 

Step 1. Launch New VMware vCloud Director Server Wizard 

To launch the New VMware vCloud Director Server wizard, do either of the following: 

 Open the Backup Infrastructure view. In the inventory pane select the Managed servers 
node and click Add Server on the ribbon. You can also right-click the Managed servers node 
and select Add Server. 

 Open the Virtual Machines or Files view, right-click anywhere on the blank area in the 
inventory pane and select Add server.  

In the Add Server window, select VMware vCloud Director. 
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Step 2. Specify Server Name or Address 

At the Name step of the wizard, specify connection settings for the VMware vCloud Director. If the 
VMware vCloud Director infrastructure comprises several cells, you can specify connection settings for 
any cell in the VMware vCloud Director hierarchy. 

1. In the DNS name or IP address field, enter a full DNS name or IP address of the VMware 
vCloud Director server or any cell in the VMware vCloud Director infrastructure. 

2. In the URL field, enter a URL of the VMware vCloud Director server. By default, 
Veeam Backup & Replication uses the following URL: https://<vcdservername>:443, 

where <vcdservername> is the name or IP address of the VMware vCloud Director server 
that you have specified in the field above and 443 is the default port for communication with 
VMware vCloud Director. 

3. In the Description field, provide a description for future reference. The default description 
contains information about the user who added the server, date and time when the server 
was added.  
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Step 3. Specify VMware vCloud Director Credentials 

At the Credentials step of the wizard, specify credentials to connect to the VMware vCloud Director. 

From the Credentials list, select credentials for the account that has system administrator privileges 
on VMware vCloud Director (you cannot use the organization administrator account to add VMware 
vCloud Director). If you have not set up credentials beforehand, click the Manage accounts link at the 
bottom of the list or click Add on the right to add the credentials. For more information, see Managing 
Credentials.  
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Step 4. Specify Credentials for Underlying VMware vCenter Servers 

At the vCenter Servers step of the wizard, specify credentials for every VMware vCenter Server added 
to VMware vCloud Director. If the VMware vCenter Server is already added to the backup 
infrastructure, you do not need to specify credentials for it once again. Veeam Backup & Replication 
will automatically detect the credentials you provided when adding this vCenter Server and use them.  

1. From the vCenter servers list, select a VMware vCenter Server.  

2. Click Account on the right and select credentials to connect to the VMware vCenter Server. 
By default, Veeam Backup & Replication uses the same credentials that you have specified for 
VMware vCloud Director at the previous step of the wizard.  

If you have not set up the credentials beforehand, click the Manage accounts link at the 
bottom of the list or click Add on the right to add the credentials. For more information, see 
Managing Credentials.  

3. Veeam Backup & Replication automatically detects a port used to communicate with the 
VMware vCenter Server. If necessary, you can change the connection port for the VMware 
vCenter Server. Click vCenter on the right and adjust the port number. 

4. When you add a VMware vCenter Server, Veeam Backup & Replication saves a thumbprint of 
the SSL certificate installed on the VMware vCenter Server to the configuration database. 
During every subsequent connection to the server, Veeam Backup & Replication uses the 
saved thumbprint to verify the server identity and avoid the man-in-the-middle attack. 

If the certificate installed on the server is not trusted, Veeam Backup & Replication displays a 
warning. 

 If you trust the server, click Connect. 

 If you do not trust the server, click Cancel. Veeam Backup & Replication will display 
an error message, and you will not be able to connect to the server. 

5. Repeat steps 1-3 for all VMware vCenter Servers added to vCloud Director. 

Note: 

 

After you update the certificate on the server, you must acknowledge the new certificate in the 
server connection settings. To do this, in the Backup Infrastructure view open the server settings, 
pass through the Edit Server wizard and click Trust to acknowledge the key. 
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Step 5. Finish Working with Wizard 

At the Apply step of the wizard, complete the procedure of VMware vCloud Director adding. 

1. Review details of the VMware vCloud Director. 

2. Click Next, then click Finish to exit the wizard. 

If VMware vCenter Servers underlying VMware vCloud Director are already added to the backup 
infrastructure, they will not be added for the second time. Veeam Backup & Replication will create 
associations with the VMware vCenter Servers and display them in the VMware vCloud Director 
hierarchy. 

 



 

538   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Upgrading Server Components 

Every time you launch the Veeam Backup & Replication console, Veeam Backup & Replication 
automatically checks if components installed on managed servers are up to date. If a later version of 
components is available, Veeam Backup & Replication displays the Components Update window and 
prompts you to upgrade components on managed servers. Components upgrade may be necessary, 
for example, after you have upgraded Veeam Backup & Replication. 

You can manually check if components upgrade is required. To do this, select Upgrade from the main 
menu. If components on all managed servers are up to date, the menu item will be disabled. 

To upgrade components on managed servers: 

1. In the Components Update window, select a server and click Details. 
Veeam Backup & Replication will display the current and latest available versions for installed 
components. 

2. In the Components Update window, select check boxes next to servers for which you want 
to upgrade components and click Next. 

 

You can update components on every managed server separately. If components installed on the 
server require upgrade, Veeam Backup & Replication displays a warning icon next to the server.  
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To update components for a managed server: 

1. Open the Backup Infrastructure view. 

2.  In the inventory pane, click Managed servers. 

3. In the working area, select the server and click Upgrade on the ribbon.  

Alternatively, you can open the Infrastructure view, in the inventory pane select Managed 
servers, in the working area right-click the server and select Upgrade. 
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Rescanning Servers 

In some cases, you may need to rescan hosts or servers in the backup infrastructure. The rescan 
operation may be required if you have added or removed new disks and volumes to/from the host or 
server and want to display actual information in Veeam Backup & Replication. During the rescan 
operation, Veeam Backup & Replication retrieves information about disks and volumes that are 
currently connected to a host or server and stores this information to the configuration database. 

Veeam Backup & Replication automatically performs a rescan operation once a day. You can also start 
the rescan operation manually: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select Managed servers. 

3. In the working area, select the server or host and click Rescan on the ribbon. Alternatively, 
you can right-click the server or host and select Rescan. 
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Editing Server Settings 

To edit settings of a server in the backup infrastructure: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select Managed servers. 

3. In the working area, select the server and click Edit Server on the ribbon or right-click the 
server and select Properties.  

4. You will follow the same steps as you have followed when adding the server. Edit server 
settings as required. 
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Removing Servers 

If you do not plan to use some server anymore, you can remove it from the backup infrastructure. 

You cannot remove a server that has any dependencies. For example, you cannot remove a server that 
is referenced by a backup or replication job, performs the role of a backup proxy or backup repository. 
To remove such server, you will need to delete all referencing jobs and roles first. 

When you remove a server that is used as a target host or backup repository, backup files and replica 
files are not removed from disk. You can easily import these files later to Veeam Backup & Replication 
if needed. 

Note: 

 

When you remove VMware vCloud Director from the backup infrastructure, VMware vCenter Servers 
added to vCloud Director are not removed. To remove the VMware vCenter Server, in the inventory 
pane expand the vCenter Servers node, right-click the VMware vCenter Server and select Remove.  

You cannot remove VMware vCenter Servers added to VMware vCloud Director until the VMware 
vCloud Director server is removed from the backup infrastructure. 

To remove a server from the backup infrastructure: 

1. Open the Backup Infrastructure view.  

2. In the inventory pane, select Managed servers.  

3. In the working area, select the server and click Remove Server on the ribbon or right-click 
the server and select Remove. 
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Assigning Roles of Backup Infrastructure Components 
To configure backup infrastructure components, you must assign corresponding roles to servers 
added to the backup infrastructure.  

You can assign the following roles to servers: 

 Backup proxy 

 Backup repository 

– Simple backup repository 

– Scale-out backup repository 

– Backup repository with rotated drives 

 WAN accelerator 

Configuring Backup Proxies 

In the backup infrastructure, the backup proxy acts as a “data mover”. While the backup server 
performs the role of the job manager, the backup proxy is responsible for actual data handling. It 
retrieves VM data from the source datastore, processes and transfers it to target.  

By default, the backup server performs the role of the default backup proxy and is added to the 
backup proxy list right after the product installation. Resources of such local backup proxy may be 
sufficient if you use Veeam Backup & Replication to protect VMs in a small virtual environment or for 
testing purposes.  

For larger VMware vSphere environments, you need to deploy a number of dedicated backup proxies 
to offload VM data processing and transport tasks from the backup server. To configure a backup 
proxy, you must assign the backup proxy role to a Microsoft Windows server added to the backup 
infrastructure. 
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Adding VMware Backup Proxies 

You can configure one or more backup proxies in the backup infrastructure.  

To add a backup proxy, use the New VMware Proxy wizard. 

Step 1. Launch New VMware Proxy Wizard 

To launch the New VMware Proxy wizard, do either of the following: 

 Open the Backup Infrastructure view, in the inventory pane select the Backup Proxies 
node, click Add Proxy on the ribbon and select VMware. 

 Open the Backup Infrastructure view, in the inventory pane right-click the Backup Proxies 
node and select Add VMware Backup Proxy. 

 

Step 2. Choose Microsoft Windows Server 

At the Server step of the wizard, specify server settings for the backup proxy. 

1. From the Choose server list, select a Microsoft Windows server to which you want to assign 
the backup proxy role. If the server is not added to the backup infrastructure yet, you can click 
Add New to open the New Windows Server wizard. For more information, see Adding 
Microsoft Windows Servers.  

2. In the Proxy description field, provide a description for future reference. The default 
description contains information about the user who added the backup proxy, date and time 
when the backup proxy was added. 

3. In the Transport mode field, select a mode that the backup proxy must use for VM data 
transport. By default, Veeam Backup & Replication analyzes the backup proxy configuration, 
defines to which datastores it has access and automatically selects the best transport mode 
depending on the type of connection between the backup proxy and datastores. 

If necessary, you can manually select the data transport mode. Click Choose on the right of 
the Transport mode field and select one of the following modes: Direct storage access, Virtual 
appliance or Network. 

  



 

545   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

4. In the Options section of the Transport Mode window, specify additional options for the 
selected transport mode: 

 [For Direct storage access and Virtual appliance transport modes] If the primary 
transport mode fails during the job session, Veeam Backup & Replication will 
automatically fail over to the Network transport mode. To disable failover, clear the 
Failover to network mode if primary mode fails, or is unavailable check box. 

 [For Network mode] You can choose to transfer VM data over an encrypted SSL 
connection. To do this, select the Enable host to proxy traffic encryption in 
Network mode (NBDSSL) check box. Traffic encryption puts more stress on the 
CPU of an ESX(i) host but ensures secure data transfer. 

5. In the Connected datastores field, specify datastores to which the backup proxy has a direct 
SAN or NFS connection. By default, Veeam Backup & Replication automatically detects all 
datastores that the backup proxy can access. 

You can set up the list of datastores manually if you want the backup proxy to work with 
specific datastores. Click Choose on the right of the Connected datastores field, choose 
Manual selection and add datastores with which the backup proxy must work in the Direct 
storage access mode. 

6. In the Max concurrent tasks field, specify the number of tasks that the backup proxy must 
handle in parallel. If this value is exceeded, the backup proxy will not start a new task until 
one of current tasks finishes. 

The recommended number of concurrent tasks is calculated automatically based on available 
resources. Backup proxies with multi-core CPUs can handle more concurrent tasks. For 
example, for a 4-core CPU, it is recommended that you specify maximum 4 concurrent tasks, 
for an 8-core CPU — 8 concurrent tasks. When defining the number of concurrent tasks, keep 
in mind network traffic throughput in the virtual infrastructure. 

Note: 

 

In some cases, the backup proxy may not be able to use some transport modes due to known 
limitations. For more information, see Transport Modes. 
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Step 3. Configure Traffic Throttling Rules 

At the Traffic Rules step of the wizard, configure throttling rules to limit the outbound traffic rate for 
the backup proxy. Throttling rules can help you manage bandwidth usage and minimize impact of 
data protection and disaster recovery tasks on network performance. For more information, see 
Setting Network Traffic Throttling Rules. 

The list of throttling rules contains only the rules that are applicable to the backup proxy. The rule is 
applied to the backup proxy if the backup proxy IP address falls into the source IP range of the rule.  

To view rule settings: 

1. Select the rule in the list. 

2. Click View on the right of the rule list.  

You can open global throttling settings and modify them directly from the New VMware Proxy 
wizard. To do this, click the Manage network traffic throttling rules link at the bottom of the wizard. 
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Step 4. Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of backup proxy configuration. 

1. Review details of the backup proxy. 

2. Click Finish to exit the wizard. 
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Editing Backup Proxy Settings 

You can edit settings of backup proxies you have configured. 

To edit backup proxy settings: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select the Backup Proxies node. 

3. In the working area, select the backup proxy and click Edit Proxy on the ribbon or right-click 
the backup proxy and select Properties. 

4. Edit backup proxy settings as required. 
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Disabling and Removing Backup Proxies 

You can temporarily disable a backup proxy or remove it from the backup infrastructure.  

Disabling Backup Proxies 

When you disable a backup proxy, Veeam Backup & Replication does not use this backup proxy for 
any jobs configured on the backup server. Backup proxy disabling can be helpful if you instruct 
Veeam Backup & Replication to automatically select backup proxies for jobs and do not want 
Veeam Backup & Replication to use specific backup proxies. 

You can disable all backup proxies, including the default backup proxy installed on the backup server. 
Do not disable all backup proxies at once. Otherwise, Veeam Backup & Replication will not be able to 
perform backup, replication and restore operations that use backup proxies. 

To disable a backup proxy: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select the Backup Proxies node. 

3. In the working area, select the backup proxy and click Disable Proxy on the ribbon or right-
click the backup proxy and select Disable proxy.  

You can enable a disabled backup proxy at any time: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select the Backup Proxies node. 

3. In the working area, select the backup proxy and click Disable Proxy on the ribbon once 
again or right-click the backup proxy and select Disable proxy.  
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Removing Backup Proxies 

You can permanently remove a backup proxy from the backup infrastructure. When you remove a 
backup proxy, Veeam Backup & Replication unassigns the backup proxy role from the server, and this 
server is no longer used as a backup proxy. The actual server remains in the backup infrastructure. 

You can remove all backup proxies, including the default backup proxy installed on the backup server. 
Do not remove all backup proxies at once. Otherwise, Veeam Backup & Replication will not be able to 
perform backup, replication and restore operations that use backup proxies. 

You cannot remove a backup proxy that is explicitly selected in any backup, replication or VM copy 
job. To remove such backup proxy, you first need to delete a reference to this backup proxy in the job 
settings. 

To remove a backup proxy: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select the Backup Proxies node. 

3. In the working area, select the backup proxy and click Remove Proxy on the ribbon or right-
click the backup proxy and select Remove. 
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Configuring Simple Backup Repositories 

Backup repositories are locations for storing backup files, VM copies and auxiliary replica files. You can 
use the following types of simple backup repositories in the backup infrastructure: 

 Microsoft Windows server with a local or directly attached storage 

 Linux server with local, directly attached or mounted NFS storage 

 Shared CIFS (SMB) folder 

 Deduplicating storage appliance: EMC Data Domain, ExaGrid and HPE StoreOnce 

Adding Simple Backup Repositories 

You can configure one or more simple backup repositories in the backup infrastructure. 

Before adding a backup repository, check prerequisites. Then use the New Backup Repository wizard 
to add the backup repository. 

Before You Begin 

Before you configure a backup repository, check the following prerequisites. 

Linux-Based Backup Repositories 

Veeam Backup & Replication uses the SSH protocol to communicate with Linux backup repositories 
and requires the SCP utility on Linux repositories. Make sure that the SSH daemon is properly 
configured and SCP utility is available on the Linux host. 

EMC Data Domain 

 The EMC Data Domain system must run DD OS 5.4 or later. 

 The DD Boost license must be installed on the EMC Data Domain system, DD Boost must be 
enabled and configured. 

 The gateway server that you plan to use for work with EMC Data Domain must be added to 
the backup infrastructure.  

If the EMC Data Domain storage system does not meet these requirements, you can add it as a CIFS 
(SMB) folder. In this case, Veeam Backup & Replication will not use the DD Boost technology to work 
with EMC Data Domain. For more information, see EMC Data Domain. 

ExaGrid 

 The ExaGrid system must run firmware version 4.7 or later. 

 To use ExaGrid as a backup repository, you must configure an ExaGrid share in a proper way 
in ExaGrid Manager. For more information, see www.veeam.com/config_exagrid_ds.pdf. 

HPE StoreOnce 

 The HPE StoreOnce system must run HPE StoreOnce firmware version 3.13.1 or later. 

 The HPE StoreOnce Catalyst license must be installed on the HPE StoreOnce system. 

 You must use a Catalyst store as a backup target. The Catalyst store must be configured to 
work in the Low Bandwidth mode (Primary and Secondary Transfer Policy). 

 The gateway server that you plan to use for work with HPE StoreOnce system must be added 
to the backup infrastructure. 

 The client account that you plan to use to connect to HPE StoreOnce must have access 
permissions on the Catalyst store where backup data will be kept. 

http://www.veeam.com/config_exagrid_ds.pdf
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If the HPE StoreOnce storage system does not meet these requirements, you can add it as a shared 
folder. In this case, Veeam Backup & Replication will perform target-side deduplication. For more 
information, see HPE StoreOnce. 

Note: 

 

If you have added HPE StoreOnce shares and stores as backup repositories in 
Veeam Backup & Replication 8.0, after upgrade to 9.0 these stores and shares will be presented as 
shared folder backup repositories. To use the HPE StoreOnce Catalyst technology, configure a 
Catalyst store on HPE StoreOnce and add it to the backup infrastructure as a backup repository.  

Step 1. Launch New Backup Repository Wizard 

To launch the New Backup Repository wizard, do either of the following: 

 Open the Backup Infrastructure view, in the inventory pane select the Backup Repositories 
node and click Add Repository on the ribbon. 

 Open the Backup Infrastructure view, in the inventory pane right-click the Backup 
Repositories node and select Add Backup Repository. 
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Step 2. Specify Backup Repository Name and Description 

At the Name step of the wizard, specify a name and description for the backup repository. 

1. In the Name field, specify a name for the backup repository. 

2. In the Description field, provide a description for future reference. The default description 
contains information about the user who added the backup repository, date and time when 
the backup repository was added. 

 

Step 3. Choose Type of Backup Repository 

At the Type step of the wizard, select what type of backup repository you want to add. 

 Microsoft Windows server with local or directly attached storage.  

When you add a Microsoft Windows server as a backup repository, 
Veeam Backup & Replication deploys the target Data Mover Service on the Microsoft 
Windows server. The Data Mover Service is responsible for transporting VM data over the 
network. 

A Microsoft Windows backup repository can also act as a Veeam vPower NFS server. To use 
the backup repository as a Veeam vPower NFS server, enable the corresponding option at the 
Mount Server step of the wizard. 

 Linux server with local, directly attached storage or mounted NFS storage.  

When you add a Linux server as a backup repository, Veeam Backup & Replication deploys the 
target Data Mover Service on this Linux server. The Data Mover Service is responsible for 
transporting VM data over the network. 

 Shared folder using CIFS (SMB) protocol.  

When you add a shared folder as a backup repository, Veeam Backup & Replication deploys 
the target Veeam Data Mover Service on the gateway server that has a direct access to the 
shared folder. The Data Mover Service is responsible for transporting VM data over the 
network. At the Share step of the wizard, you can assign a gateway server explicitly or instruct 
Veeam Backup & Replication to select a gateway server automatically. 
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 Deduplicating storage appliance. You can use a deduplicating storage appliance as a target 
for backup. Veeam Backup & Replication supports the following appliance types:  

– EMC Data Domain 

– ExaGrid 

– HPE StoreOnce 
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Step 4. Select Type of Deduplicating Storage Appliance 

The Deduplicating Storage step of the wizard is available if you have selected the Deduplicating 
storage appliance option at the Type step of the wizard. 

Select the type of the deduplicating storage appliance that you want to add: 

 EMC Data Domain 

 ExaGrid 

 HPE StoreOnce 

 

Step 5. Specify Server or Shared Folder Settings 

Options that you can specify at the Server step of the wizard depend on the type of backup repository 
you are adding. 

In this section: 

 Microsoft Windows or Linux Server 

 Shared Folder 

 EMC Data Domain 

 ExaGrid 

 HPE StoreOnce 
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Microsoft Windows or Linux Server 

To configure settings for a Microsoft Windows or Linux server: 

1. From the Repository server list, select a Microsoft Windows or Linux server that you want to 
use as a backup repository. The Repository servers list contains only those servers that are 
added to the backup infrastructure. If the server is not added to the backup infrastructure yet, 
you can click Add New to open the New Windows Server or New Linux Server wizard. For 
more information, see Managing Servers.  

2. Click Populate to see a list of disk storages connected to the server, their capacity and free 
space. 
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Shared Folder 

To configure settings for a shared folder: 

1. In the Shared folder field, specify a UNC path to the shared folder that you want to use as a 
backup repository.  

2. If you must specify user credentials to access the shared folder, select the This share requires 
access credentials check box. From the Credentials list, select a credentials record for a user 
account that has Full Control permissions on the shared folder.  

If you have not set up credentials beforehand, click the Manage accounts link at the bottom 
of the list or click Add on the right to add the credentials. For more information, see 
Managing Credentials.  

3. In the Gateway server section, specify settings for the gateway server: 

 If a network connection between the source datastore and backup repository is 
fast, choose Automatic selection.In this case, Veeam Backup & Replication will 
automatically choose a Microsoft Windows server and use it as a gateway server. 
This can be any Microsoft Windows server added to the backup infrastructure: 
Microsoft Windows server used for file copying operations, backup proxy, backup 
server and so on. 

The gateway server is picked at random and per job session. 
Veeam Backup & Replication may use one gateway server for one job session and 
another gateway server for another job session. 

 If you perform backup and replication over WAN or slow connections, choose The 
following server. From the list below, select a Microsoft Windows server on the 
target site that you want to use as a gateway server. The selected server must have 
a direct access to the shared folder and must be located as close to the shared 
folder as possible. 

In some cases, the automatic selection mechanism may cause problems as 
Veeam Backup & Replication may use different gateway servers for different job sessions. For example, 
during one job session Veeam Backup & Replication may use a 64-bit gateway server to create a 
backup file. If during the next job session Veeam Backup & Replication uses a 32-bit gateway server, 
Veeam Backup & Replication will fail to open the created backup file on the backup repository. To 
overcome this situation, you must explicitly define the gateway server. 
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EMC Data Domain 

To configure settings for EMC Data Domain: 

1. Specify connection settings for EMC Data Domain: 

 If EMC Data Domain works over TCP, in the Type in Data Domain server name 
field enter a full DNS name or IP address of the EMC Data Domain server.  

 If EMC Data Domain works over Fibre Channel, select the Use Fibre Channel (FC) 
connectivity check box. In the Type in Data Domain server name field, enter a 
name of the Data Domain Fibre Channel server. To get the Data Domain Fibre 
Channel server name, in Data Domain System Manager open the Data 
Management > DD Boost > Fibre Channel tab. 

2. In the Credentials field, specify credentials of the user account to connect to the EMC Data 
Domain server or EMC Data Domain Fibre Channel server. If you have not set up credentials 
beforehand, click the Manage accounts link at the bottom of the list or click Add on the right 
to add the credentials. For more information, see Managing Credentials.  

To connect to the EMC Data Domain server, you must use credentials for the DD Boost User. 
To specify the DD Boost User account settings, in Data Domain System Manager, open the 
Data Management > DD Boost Settings tab. 

3. To use in-flight encryption between the backup proxy and EMC Data Domain, select the 
Enable DDBoost encryption check box and choose the encryption level — Medium or High. 
The encryption option works for EMC Data Domain 3.0 and later. 
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4. In the Gateway server section, specify settings for the gateway server: 

 If a network connection between the source datastore and EMC Data Domain 
appliance is fast, choose Automatic selection. In this case, 
Veeam Backup & Replication will automatically select a Microsoft Windows server 
and use it as a gateway server.  

The gateway server is picked at random and per job session. 
Veeam Backup & Replication may use one gateway server for one job session and 
another gateway server for another job session. 

 If you perform backup over WAN or slow connections, choose The following 
server. From the list below, select a Microsoft Windows server on the target site 
that you want to use as a gateway server. The server must have a direct access to 
the EMC Data Domain appliance and must be located as close to the appliance as 
possible.  

In some cases, the automatic selection mechanism may cause problems as 
Veeam Backup & Replication may use different gateway servers for different job sessions. For 
example, during one job session Veeam Backup & Replication may use a 64-bit gateway 
server to create a backup file. If during the next job session Veeam Backup & Replication uses 
a 32-bit gateway server, Veeam Backup & Replication will fail to open the created backup file 
on the backup repository. To overcome this situation, you can explicitly define the gateway 
server. 

Important! 

 

If you connect to EMC Data Domain over Fibre Channel, you must explicitly define the gateway 
server to communicate with EMC Data Domain. The server you select must be added to the backup 
infrastructure and must have access to the EMC Data Domain appliance over Fibre Channel. 
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ExaGrid Deduplicating Appliance 

To configure settings for ExaGrid deduplicating appliance: 

1. From the Repository server list, select an ExaGrid appliance that you want to use as a backup 
repository. The Repository servers list contains only those servers that are added to the 
backup infrastructure. If the server is not added to the backup infrastructure yet, you can click 
Add New to open the New Linux Server wizard. For more information, see Managing 
Servers.  

2. Click Populate to see the appliance capacity and available free space. 

 

HPE StoreOnce Deduplicating Appliance 

To configure settings for HPE StoreOnce: 

1. In the Data Domain Server Name field, enter a full DNS name or IP address of the HPE 
StoreOnce appliance. 

2. If HPE StoreOnce works over Fibre Channel, select the Use Fibre Channel (FC) connectivity 
check box. 

3. In the Credentials field, specify credentials of the client account to connect to the HPE 
StoreOnce appliance. If you have not set up credentials beforehand, click the Manage 
accounts link at the bottom of the list or click Add on the right to add the credentials. For 
more information, see Managing Credentials.  

The client account that you plan to use to connect to HPE StoreOnce must have access 
permissions on a Catalyst store where backup data will be kept. To check the client account 
permissions, in the HPE StoreOnce management console, select the Catalyst store and open 
the Permissions tab for it. 
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4. In the Gateway server section, specify settings for the gateway server: 

 If you want Veeam Backup & Replication to pick the gateway server automatically, 
choose Automatic selection. 

The gateway server is picked at random and per job session. 
Veeam Backup & Replication may use one gateway server for one job session and 
another gateway server for another job session. 

 If you want to define the gateway server explicitly, choose The following server. 
From the list below, select a Microsoft Windows server that you want to use as a 
gateway server. 

For work with HP StoreOnce, Veeam Backup & Replication uses the Catalyst agent 
installed on the gateway proxy. If you want to reduce the load on the network 
between the source and target side, assign the gateway server role to a machine on 
the source side, closer to the backup proxy. 

In some cases, the automatic selection mechanism may cause problems as 
Veeam Backup & Replication may use different gateway servers for different job sessions. For 
example, during one job session Veeam Backup & Replication may use a 64-bit gateway 
server to create a backup file. If during the next job session Veeam Backup & Replication uses 
a 32-bit gateway server, Veeam Backup & Replication will fail to open the created backup file 
on the backup repository. To overcome this situation, you can explicitly define the gateway 
server. 

Important! 

 

If you connect to HPE StoreOnce over Fibre Channel, you must explicitly define the gateway server to 
communicate with HPE StoreOnce appliance. The server you select must be added to the backup 
infrastructure and must have access to the HPE StoreOnce appliance over Fibre Channel. 
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Step 6. Configure Path and Load Control Settings 

At the Repository step of the wizard, specify path and load control repository settings. 

1. In the Location section, specify a path to the folder where backup files must be stored. Click 
Populate to check capacity and available free space in the selected location. 

– For EMC Data Domain, click Browse and select a location from the list of available 
paths. 

– For HPE StoreOnce, select a Catalyst store from the list. 

2. Use the Load control section to limit the number of concurrent tasks and data ingestion rate 
for the backup repository. These settings will help you control the load on the backup 
repository and prevent possible timeouts of storage I/O operations. 

 Select the Limit maximum concurrent tasks check box and specify the maximum 
allowed number of concurrent tasks for the backup repository. If this value is 
exceeded, Veeam Backup & Replication will not start a new task until one of current 
tasks finishes. For more information, see Limiting the Number of Concurrent Tasks.  

 Select the Limit read and write data rates to check box and specify the maximum 
rate to restrict the total speed of reading and writing data to the backup repository 
disk. For more information, see Limiting Combined Data Rate for Backup 
Repositories. 

3. Сlick Advanced to configure additional settings for the backup repository: 

 For storage systems using a fixed block size, select the Align backup file data 
blocks check box. Veeam Backup & Replication will align VM data saved to a 
backup file at a 4 KB block boundary. This option provides better deduplication 
across backup files but can result in greater amount of unused space on the storage 
device and a higher level of fragmentation. 

 When you enable compression for a backup job, Veeam Backup & Replication 
compresses VM data at the source side and then transports it to the target side. 
Writing compressed data to a deduplicating storage appliance results in poor 
deduplication ratios as the number of matching blocks decreases. To overcome this 
situation, select the Decompress backup data blocks before storing check box. If 
data compression is enabled for a job, Veeam Backup & Replication will compress 
VM data on the source side, transport it to the target side, uncompress VM data on 
the target side and write raw VM data to the storage device to achieve a higher 
deduplication ratio. 

 If you plan to use rotated drives for the backup repository, select the This 
repository is backed up by rotated hard drives check box. For more information, 
see Configuring Backup Repositories with Rotated Drives. 

 To create a separate backup file for every VM in the job, select the Use per-VM 
backup files check box. This setting is recommended if you use a deduplicating 
storage appliance as a backup repository. Veeam Backup & Replication will write 
VM data to the backup repository in several streams, which will improve the backup 
job performance. However, in this case Veeam Backup & Replication will not 
deduplicate data between VMs added to the job. For more information, see Per-VM 
Backup Files. 
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Settings for Deduplicating Storage Appliances 

If you use a deduplicating storage appliance as a backup repository, it is recommended that you 
specify the following settings: 

EMC Data Domain 

 The Align backup file data blocks option must not be enabled. 

 The Decompress backup data blocks before storing option is enabled by default. 

 The This repository is backed up by rotated hard drives option is disabled. 

 The Use per-VM backup files option should be enabled*. 

ExaGrid 

 The Align backup file data blocks option must not be enabled. 

 The Decompress backup data blocks before storing option is disabled by default. 

 The This repository is backed up by rotated hard drives option is disabled by default. 

 The Use per-VM backup files option should be enabled*. 

 Limit max concurrent tasks is equal to 1 (recommended, by default) 

HPE StoreOnce 

 The Align backup file data blocks option must not be enabled. 

 The Decompress backup data blocks before storing option is enabled by default. 

 The This repository is backed up by rotated hard drives option is disabled. 

 The Use per-VM backup files option is enabled. 

* If you upgrade to Veeam Backup & Replication 9.0 from previous product versions, this option will be 
disabled to ensure the existing backup repositories works as before. If you want to create per-VM 
backup chains, you can edit the backup repository settings and enable this option. 
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Step 7. Specify Mount Server Settings 

At the Mount Server step of the wizard, specify settings for the mount server that you plan to use for 
file-level and application items restore. 

1. From the Mount Server list, select a server that you want to use as a mount server. The 
mount server is required for file-level and application items restore. During the restore 
process, Veeam Backup & Replication will mount the VM disks from the backup file residing 
on the backup repository to the mount server. As a result, VM data will not have travel over 
the network, which will reduce the load on the network and speed up the restore process. For 
more information, see Mount Server. 

The Mount Server list contains only Microsoft Windows servers that are added to the backup 
infrastructure. If the server is not added to the backup infrastructure yet, select Add server at 
the bottom of the list to open the New Windows Server wizard. For more information, see 
Adding Microsoft Windows Servers. 

2. To make the backup repository accessible by the Veeam vPower NFS Service, select the 
Enable vPower NFS server on the mount server check box. Veeam Backup & Replication 
will enable the vPower NFS Service on the mount server you have selected. 

3. In the Folder field, specify a folder that will be used as a vPower NFS root folder. For more 
information, see Veeam vPower NFS Service. 

Note: 

 

The mount server will be deployed after Veeam Backup & Replication configures the backup 
repository. 
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4. To customize network ports used by the vPower NFS service and mount server, click Ports. By 
default, the vPower NFS service and mount server use the following ports: 

 RPC port: 6161 

 Mount port: 1058 

 vPower NFS port: 2049 

Important! 

 

Do not enable Microsoft Windows NFS services on the machine where you install the Veeam vPower 
NFS service. If Microsoft NFS services and Veeam vPower NFS service are enabled on the same 
machine, both services may fail to work correctly. 
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Step 8. Review Properties and Components 

At the Review step of the wizard, review details of the backup repository and specify importing 
settings. 

1. Review the backup repository settings and list of components that will be installed on the 
backup repository server. 

2. If the backup repository contains backups that were previously created with 
Veeam Backup & Replication, select the Import existing backups automatically check box. 
Veeam Backup & Replication will scan the backup repository to detect existing backup files 
and display them in the Veeam Backup & Replication console under the Imported > Backups 
node.  

3. If the backup repository contains guest file system index files that were previously created by 
Veeam Backup & Replication, select the Import guest file system index check box. Index 
files will be imported with backup files, and you will be able to search for guest OS files inside 
imported backups.  
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Step 9. Finish Working with Wizard 

At the Apply step of the wizard, complete the procedure of backup repository configuration. 

1. Wait for the backup repository to be to the backup infrastructure. The process may take 
several minutes. 

2. Review details for the added backup repository. 

3. Click Finish to exit the wizard. 
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Rescanning Simple Backup Repositories 

You can rescan a backup repository configured in the backup infrastructure. Backup repository rescan 
may be required, for example, if you have archived backups from a backup repository to tape and 
deleted backup files on the backup repository. Or you have copied backups to the backup repository 
manually and want to work with them in Veeam Backup & Replication. 

During the rescan operation, Veeam Backup & Replication gathers information about backups that are 
currently available on the backup repository and updates the list of backups in the configuration 
database.  

To rescan a backup repository: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select the Backup Repositories node. 

3. In the working area, select the backup repository and click Rescan Repository on the ribbon 
or right-click the backup repository and select Rescan repository. 
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Editing Settings of Simple Backup Repositories 

You can edit settings of backup repositories you have added to the backup infrastructure. 

To edit settings of a backup repository: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select the Backup Repositories node. 

3. In the working area, select the backup repository and click Edit Repository on the ribbon or 
right-click the backup repository and select Properties. 

4. Edit the backup repository settings as required. 
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Removing Simple Backup Repositories 

You can permanently remove a backup repository from the backup infrastructure. When you remove a 
backup repository, Veeam Backup & Replication unassigns the backup repository role from the server 
and this server is no longer used as a backup repository. The actual server remains in the backup 
infrastructure. 

Veeam Backup & Replication does not remove backup files and other data stored on the backup 
repository. You can re-connect the backup repository at any time and import backups from this 
backup repository to Veeam Backup & Replication.  

You cannot remove a backup repository that is used by any job. To remove such backup repository, 
you first need to delete a reference to this backup repository in the job settings. 

To remove a backup repository: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select the Backup Repositories node. 

3. In the working area, select the backup repository and click Remove Repository on the ribbon 
or right-click the backup repository and select Remove. 
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Configuring Scale-Out Backup Repositories 

You can configure a scale-out backup repository in the backup infrastructure and use it for storing 
backup data. The scale-out repository is a logical entity — it groups a number of simple backup 
repositories. You can extend the scale-out repository on demand, for example, if you run out of space 
on the scale-out backup repository and want to add storage capacity to it. 

Adding Scale-Out Repositories 

Before adding a scale-out backup repository, check prerequisites. Then use the New Scale-out 
Backup Repository wizard to configure the scale-out backup repository. 

Before You Begin 

Before you add a scale-out backup repository to the backup infrastructure, check the following 
prerequisites: 

Backup repositories that you plan to add as extents to the scale-out backup repository must be added 
to the backup infrastructure. For more information, see Adding Backup Repositories. 

Mind the following limitations: 

 The scale-out backup repository functionality is available only in Enterprise and Enterprise 
Plus editions of Veeam Backup & Replication.  

If you configure a scale-out backup repository and then downgrade to the Standard license, 
you will not be able to run jobs targeted at the scale-out backup repository. However, you will 
be able to perform restore from the scale-out backup repository. 

 You cannot use the scale-out backup repository as a target for the following types of jobs: 

– Configuration backup job 

– Replication jobs 

– VM copy jobs 

– Endpoint backup jobs 

 You cannot add a backup repository as an extent to the scale-out backup repository if any job 
of unsupported type is targeted at this backup repository or if the backup repository contains 
data produced by jobs of unsupported types (for example, replica metadata). To add such 
backup repository as an extent, you must first target unsupported jobs to another backup 
repository and remove the job data from the backup repository.  

 You cannot use a scale-out backup repository as a cloud repository. You cannot add a cloud 
repository as an extent to the scale-out backup repository.  

 If a backup repository is added as an extent to the scale-out backup repository, you cannot 
use it as a regular backup repository. 

 You cannot add a scale-out backup repository as an extent to another scale-out backup 
repository. 

 You cannot add a backup repository as an extent if this backup repository is already added as 
an extent to another scale-out backup repository. 

 You cannot add a backup repository on which some activity is being performed (for example, 
a backup job or restore task) as an extent to the scale-out backup repository. 

 If you use Enterprise Edition of Veeam Backup & Replication, you can create 1 scale-out 
backup repository with 3 extents for this scale-out backup repository. Enterprise Plus Edition 
has no limitations on the number of scale-out backup repositories or extents. 
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Step 1. Launch New Scale-Out Backup Repository Wizard 

To launch the New Scale-out Backup Repository wizard, do either of the following: 

 Open the Backup Infrastructure view, in the inventory pane select Scale-out Repositories 
and click Add Scale-out Repository on the ribbon. 

 Open the Backup Infrastructure view, in the inventory pane right-click Scale-out 
Repositories and select Add Scale-out Backup Repository. 
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Step 2. Specify Scale-Out Backup Repository Name 

At the Name step of the wizard, specify a name and description for the scale-out backup repository. 

1. In the Name field, specify a name for the scale-out backup repository. 

2. In the Description field, provide a description for future reference. The default description 
contains information about the user who added the backup repository, date and time when 
the backup repository was added. 

 

Step 3. Add Backup Repository Extents 

At the Extents step of the wizard, specify which backup repositories you want to add as extents, and 
configure options for the scale-out backup repository. 

1. On the right of the Extents list, click Add. 

2. In the Extents window, select check boxes next to backup repositories that you want to add 
as extents. 

3. Click OK. 

4. At the lower right corner of the Extents list, click Advanced. 
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5. Specify advanced options for the scale-out backup repository: 

a. Select the Use per-VM backup files check box if you want to create a separate 
backup chain for every VM in the job. With this option enabled, during one backup 
job session Veeam Backup & Replication will produce a number of backup files — 
one per every VM, and will write these files to the backup repository in multiple 
streams simultaneously. It is recommended that you enable this option to achieve 
better storage and compute resource utilization, especially if you use as a backup 
repository a deduplicating storage appliance that supports multiple write streams. 

b. To preserve the consistency of backup chains on the scale-out backup repository, 
select the Perform full backup when required extent is offline check box. If an 
extent that contains previous restore points from the current backup chain gets 
offline, the backup chain will be broken. Veeam Backup & Replication will not be 
able to add a new incremental backup file. With this option enabled, 
Veeam Backup & Replication will create a full backup file instead of an incremental 
backup file. If you enable this option, you must make sure that you have enough 
free space on the scale-out backup repository to host a full backup file. 
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If a backup repository that you add as an extent is already used by jobs of supported type or there are 
backups pointing at the backup repository (for example, independent backups created with 
VeeamZIP), Veeam Backup & Replication will offer you to update a link to the backup repository in the 
job properties. Click Yes to update the link and target the job(s) and backups at the scale-out backup 
repository. If you click No, you will not be able to pass to the next steps of the wizard. 

 

Step 4. Specify Backup Placement Policy 

At the Policy step of the wizard, specify how you want to store backup files on extents of the scale-out 
backup repository. 

1. Set the backup file placement policy for the scale-out backup repository: 

 Select Data locality if you want to store backup files that belong to the same 
backup chain together. In this case, a full backup file and subsequent incremental 
backup files will be stored to the same extent of the scale-out backup repository. 
The new backup chain may be stored to the same extent or to another extent 
(unless you use a deduplicating storage appliance as an extent). 

 Select Performance if you want to store full and incremental backup files to 
different extents of the scale-out backup repository. If you set the Performance 
policy, you must make sure that the network connection is fast and reliable so that 
Veeam Backup & Replication can access all backup files from the backup chain. 

For more information, see Backup File Placement. 
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2. If you select the Performance policy, you can restrict which types of backup files can be 
stored on a specific extent. For example, if you have added three extents to the scale-out 
backup repository, you may want to store full backup files on one extent and incremental 
backup files — on the other two extents. 

a. Click Advanced. 

b. In the Backup Placement Settings window, select an extent and click Edit. 

c. Select a check box next to the type of backup files that you want to store on the 
extent: Full backup files or Incremental backup files. By default, 
Veeam Backup & Replication can store both full and incremental backup files on 
the same extent. 
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Step 5. Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of scale-out backup repository 
configuration. 

Wait for the scale-out backup repository to be added to the backup infrastructure. The process may 
take some time. 

1. Review details of the scale-out backup repository. 

2. Click Finish to exit the wizard. 
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Extending Scale-Out Repositories 

You can add a backup repository as an extent to the scale-out backup repository at any time. For 
example, the scale-out backup repository may run low on space, and you will need to add storage 
capacity to it.  

To add a backup repository as an extent to the scale-out backup repository: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, click Scale-out Repositories. 

3. In the working area, select the scale-out repository and click Edit Scale-out Repository on 
the ribbon or right-click the backup repository and select Properties. 

4. Move to the Extents step of the wizard. 

5. Click Add. 

6. In the Extents window, select a check box next to the backup repository that you want to add 
as an extent to the scale-out backup repository. 

 

If a backup repository that you add as an extent is already used by jobs of supported type or 
there are backups pointing at the backup repository (for example, independent backups 
created with VeeamZIP), Veeam Backup & Replication will offer you to update a link to the 
backup repository in the job properties. Click Yes to update the link and target the job(s) and 
backups at the scale-out backup repository. If you click No, you will not be able to pass to the 
next steps of the wizard. 

7. Pass through the next wizard steps and finish working with the wizard. The new extent will be 
added to the scale-out backup repository. 

Note: 

 

After you add a backup repository as an extent to the scale-out backup repository, you will not be 
able to use this backup repository as a simple backup repository. To use such backup repository as 
simple, you will have to remove it from the scale-out backup repository. 
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Removing Extents from Scale-Out Repositories 

You can remove an extent from the scale-out backup repository, for example, if you do not want to 
store backup files on the underlying storage anymore. When you remove an extent, 
Veeam Backup & Replication puts the underlying backup repository to the Maintenance mode and 
unassigns the extent role from it. The backup repository ceases to exist as a part of the scale-out 
backup repository and becomes a simple backup repository. 

If the extent contains backup files, it is strongly recommended that you perform the following actions 
before you remove the extent: 

1. Put the extent to the Maintenance mode. 

2. Evacuate backups from the extent.  

In this case, backup files will be moved to other extents of the scale-out backup repository, and the 
backup chain will remain consistent. If you do not evacuate backups from the extent, the backup 
chain may get broken as some restore points will be missing from it. 

To remove an extent from the scale-out backup repository: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, click Scale-out Repositories. 

3. In the working area, select the scale-out backup repository and click Edit Scale-out 
Repository on the ribbon or right-click the scale-out backup repository and select 
Properties. 

4. Move to the Extents step of the wizard. 

5. In the Extents list, select the extent and click Remove.  

If the extent contains backup files, Veeam Backup & Replication will offer you to evacuate them. To 
evacuate files, click No, close the wizard and evacuate backup files. For more information, see 
Evacuating Backups from Extents. 

If you do not want to evacuate backup files, click Yes and proceed with the wizard.  
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Editing Settings of Scale-Out Backup Repositories 

You can edit settings of the scale-out backup repository, for example, if you want to change the 
backup file placement policy or specify other advanced settings for the backup repository. 

Mind the following: 

 If you enable or disable the Use per-VM backup file option, Veeam Backup & Replication will 
apply new settings after a new full backup file is created. 

 If you enable or disable the Perform full backup when required extent is offline option, 
Veeam Backup & Replication will apply the new settings starting from the next session of the 
job targeted at this scale-out backup repository. 

 If you change the backup file placement policy settings, Veeam Backup & Replication will 
apply the new settings starting from the next session of the job targeted at this scale-out 
backup repository. 

To change the scale-out backup repository settings: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, click Scale-out Repositories. 

3. In the working area, select the scale-out repository and click Edit Scale-out Repository on 
the ribbon or right-click the scale-out backup repository and select Properties. 

4. Follow the steps of the Edit Scale-Out Backup Repository wizard and edit settings as 
required.  
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Removing Scale-Out Backup Repositories 

You can remove the scale-out backup repository at any time. When you remove the scale-out backup 
repository, Veeam Backup & Replication unassigns the extent role from all underlying backup 
repositories, and they become simple backup repositories. Backup files are not removed from backup 
repositories — they remain on disk. 

You cannot remove a scale-out backup repository at which at least one job is currently targeted. First, 
you need to target jobs to another backup repository in the backup infrastructure. 

To remove a scale-out backup repository: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, click Scale-out Repositories. 

3. In the working area, select the scale-out repository and click Remove Repository on the 
ribbon or right-click the backup repository and select Remove. 
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Switching to Maintenance Mode 

You can put an extent of the scale-out backup repository to the Maintenance mode if you need to 
perform service actions on the extent, for example, upgrade it or install a patch on it. You must also 
put the extent to the Maintenance mode before you evacuate backups from this extent. 

To put an extent to the Maintenance mode: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select the scale-out backup repository under Scale-out Repositories. 

3. In the working area, select the extent and click Maintenance Mode on the ribbon or right-
click the extent and select Maintenance mode. 

To bring the extent back to the normal operational mode, select the extent and click Maintenance 
Mode on the ribbon or right-click it and select Maintenance mode once again. 

 

  



 

583   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Evacuating Backups from Extents 

If you want to remove an extent from the scale-out backup repository, you first need to evacuate 
backups from this extent. When you evacuate backups, Veeam Backup & Replication moves backup 
files from the extent to other extents that belong to the same scale-out backup repository.  

You must put the extent to the Maintenance mode before you evacuate backups from it. For more 
information, see Switching to Maintenance Mode. 

To evacuate backup files from the extent: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select the scale-out backup repository under Scale-out Repositories. 

3. In the working area, select the extent and click Evacuate Backups on the ribbon or right-click 
the extent and select Evacuate backups. 

After you evacuate backups, you can proceed to removing the extent from the scale-out backup 
repository. For more information, see Removing Extents from Scale-Out Repositories. 
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Rescanning Scale-Out Repositories 

Veeam Backup & Replication periodically rescans scale-out backup repositories. During the rescan 
process, it gets the following information: 

 State of every extent added to the scale-out backup repository — online or offline 

 Status of Veeam Data Mover Services on extents — up-to-date or outdated 

 Space available on the scale-out backup repository 

The rescan operation is performed automatically by a rescan process that works permanently in the 
background. The process is started every 24 hours. It can be also started when a new task session 
starts, and the Veeam Backup Service requires information about the infrastructure to be refreshed.  

In addition to the automated rescan process, you can manually start rescan of the scale-out backup 
repository. Backup repository rescan may be helpful, for example, if you want to discover backup files 
that were manually relocated from one extent to another one.  

To start the rescan process: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane select Scale-out Repositories.  

3. In the working area, select the scale-out repository and click Rescan Repository on the 
ribbon or right-click the scale-out backup repository and select Rescan repository. 
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Discovering Backups on Scale-Out Backup Repositories 

To discover on which extent of the scale-out backup repository a particular backup file is stored, you 
can examine the job session statistics or check the backup properties. 

To view the job session statistics: 

1. Open the Backup & Replication view.  

2. In the inventory pane, click Backup under Jobs. 

3. In the working area, right-click the job and select Statistics. 

4. In the bottom left pane of the window, click the VM name. In the Action pane, locate the 
message: Moving backups to extent N. 
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To view the backup properties: 

1. Open the Backup & Replication view.  

2. In the inventory pane, select Disk under Backups. 

3. In the working area, right-click the backup and select Properties. 

4. In the Backup Properties window, click the backup file and check the Repository field at the 
top left corner of the window. Veeam Backup & Replication will display on which extent the 
backup file resides.  
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Configuring Backup Repositories with Rotated Drives 

You can configure a backup repository to use rotated drives. This scenario can be helpful if you want 
to store backups on several external hard drives (for example, USB or eSATA) and plan to regularly 
swap these drives between different locations.  

To configure a backup repository with rotated drives: 

1. Attach one of external drives from the set to a Microsoft Windows or Linux server. The server 
must be added to the backup infrastructure. For more information, see Managing Servers. 

You can also attach the external hard drive to the backup server itself. In this case, the VM 
traffic will path through the backup server, which will produce additional workload on it. 

2. Launch the Add New Backup Repository wizard.  

3. At the Server step of the wizard, select the server to which the drive is attached. 

 

4. At the Repository step of the wizard, click Advanced and select the This repository is 
backed up by rotated hard drives check box. 
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5. Configure other settings of the backup repository as required and finish working with the 
wizard.  
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Configuring WAN Accelerators 

To optimize VM traffic going over the WAN during remote jobs, you can configure a pair of WAN 
accelerators in the backup infrastructure.  

WAN accelerators must be configured in the following way: 

 One WAN accelerator is configured on the source side, closer to the source backup repository 
or the source datastore. 

 The other WAN accelerator is configured on the target side, closer to the target backup 
repository or the target datastore. 

Before You Begin 

Before you add a WAN accelerator, check the following prerequisites: 

1. You must assign the WAN accelerator role to a Microsoft Windows server (physical or virtual). 
The WAN accelerator role can be assigned to backup proxies and Microsoft Windows backup 
repositories configured in the backup infrastructure. 

2. You must use 64-bit Microsoft Windows servers as WAN accelerators. 
Veeam Backup & Replication does not support 32-bit versions of Microsoft Windows used as 
WAN accelerators. 

3. WAN acceleration operations are resource-consuming. When assigning the WAN accelerator 
role, mind available CPU and memory resources of the Microsoft Windows server. It is 
recommended that you assign the WAN accelerator role to servers with 8 GB RAM and more. 
Otherwise, the WAN acceleration process may fail. 

Step 1. Launch New WAN Accelerator Wizard  

To launch the New WAN Accelerator wizard, either one of the following: 

 Open the Backup Infrastructure view, in the inventory pane select WAN Accelerators and 
click Add WAN Accelerator on the ribbon. 

 Open the Backup Infrastructure view, in the inventory pane right-click WAN Accelerators 
and select Add WAN Accelerator. 
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Step 2. Choose Server 

At the Server step of the wizard, select a Microsoft Windows server that you plan to use as a WAN 
accelerator and define port and connection settings for this server. 

1. From the Choose server list, select a Microsoft Windows server added to the backup 
infrastructure. If the server is not added to the backup infrastructure yet, you can click Add 
New to open the New Windows Server wizard. For more information, see Adding Microsoft 
Windows Servers. 

2. In the Description field, provide a description for future reference.  

It is recommended that you describe the added WAN accelerator as the source or target one. 
When you create a remote job, this hint will be displayed in brackets next to the WAN 
accelerator name, which will help you choose the necessary WAN accelerator to be used on 
the source or target side. 

3. In the Traffic port field, specify the number of the port over which WAN accelerators must 
communicate with each other. By default, port 6165 is used. 

4. In the Streams field, specify the number of connections that must be used to transmit data 
between WAN accelerators. By default, 5 connections are used. 

This setting applies only to the source WAN accelerator. The greater is the number of streams, 
the more bandwidth resources Veeam Backup & Replication will use. A great number of 
streams engage more CPU and memory resources of the source WAN accelerator. 
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Step 3. Define Cache Location and Size 

At the Cache step of the wizard, define settings for the folder where service files and global cache data 
will be stored. 

1. In the Folder field, specify a path to the folder in which service files (for source and target 
WAN accelerators) and global cache data (for target WAN accelerator) must be stored. When 
selecting a folder on the target WAN accelerator, make sure that there is enough space for 
storing global cache data.  

2. [For target WAN accelerator] In the Cache size field, specify the size for the global cache. The 
global cache size is specified per source WAN accelerator. If you plan to use one target WAN 
accelerator with several source WAN accelerators, the specified amount of space will be 
allocated to every source WAN accelerator and the size of the global cache will increase 
proportionally. For more information, see WAN Accelerator Sizing. 

Important! 

 

Do not nest the global cache folder deep in the file tree. During WAN acceleration operations, 
Veeam Backup & Replication generates service files with long file names. Placing such files to a folder 
of significant depth may cause problems on the NTFS file system. 
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Step 4. Review Components 

Veeam Backup & Replication installs the following components on the server used as a WAN 
accelerator:  

 Veeam Data Mover Service 

 Veeam WAN Accelerator Service 

At the Review step of the wizard, review what components are already installed on the server and 
what components will be installed. 

1. Review the components. 

2. Click Next to install the components on the server. 
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Step 5. Finish Working with Wizard 

At the Apply step of the wizard, complete the procedure of WAN accelerator configuration. 

1. Wait for the WAN accelerator to be added to the backup infrastructure. 

2. Click Next, then click Finish to exit the wizard. 
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Populating Global Cache 

You can populate the global cache on the target WAN accelerator to reduce the amount of data 
transferred over the WAN. It is recommended that you populate the global cache in the following 
situations: 

 Global cache is empty before you start a remote job using WAN accelerators for the first time. 

 Global cache is corrupted and you want to populate it with valid data. In this case, you must 
clear the global cache first and populate it with new data before a remote job starts.  

Important! 

 

Veeam Backup & Replication does not use encrypted backups for global cache population. 

To populate the global cache: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select the WAN Accelerators node. 

3. In the working area, right-click the target WAN accelerator and select Populate cache.  

If the selected WAN accelerator is not assigned as a target WAN accelerator to any remote 
job, Veeam Backup & Replication will display a warning. 

4. In the Source Backup Repositories window, select backup repositories from which OS data 
blocks must be retrieved.  

It is strongly recommended that you select backup repositories on the same site where the 
target WAN accelerator is located. In the opposite case, the traffic will travel between sites, 
which will increase load on the network. 

5. Click OK.  
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Clearing Global Cache 

You can clear the global cache on the target WAN accelerator. It is recommended that you clear the 
global cache in the following situations: 

 Global cache is corrupted. 

 Global cache contains data that is no longer needed. This situation may occur, for example, if 
you have processed VMs running one OS and do not plan to process VMs with such OS in 
future. The global cache will contain data blocks that may be of no use for VMs running other 
OS.  

In such cases, it is recommended that you clear the global cache and populate it anew before you start 
remote jobs processing new types of VMs. 

To clear the global cache: 

1. Open the Backup Infrastructure view.  

2. In the inventory pane, click WAN Accelerators.  

3. In the working area, right-click the target WAN accelerator and select Clear cache.  

Important! 

 

Before you clear the global cache, make sure that you do not have any running jobs that use this 
target WAN accelerator. When the global cache is cleared, Veeam Backup & Replication will restart 
the Veeam WAN Accelerator Service, and running jobs will complete with the Failed status. 
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Removing WAN Accelerators 

You can permanently remove a WAN accelerator from the backup infrastructure. When you remove a 
WAN accelerator, Veeam Backup & Replication unassigns the WAN accelerator role from the server, 
and this server is no longer used as a WAN accelerator. The server itself remains in the backup 
infrastructure. 

To remove a WAN accelerator: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select WAN accelerators. 

3. In the working area, select the WAN accelerator and click Remove WAN Accelerator on the 
ribbon or right-click the WAN accelerator and select Remove. 
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Managing Network Traffic 
You can specify the following network settings to manage network traffic in the backup infrastructure: 

 Setting Network Traffic Throttling Rules 

 Managing Data Transfer Connections 

 Enabling Network Data Encryption 

 Specifying Priority Networks for Data Transfer 

Setting Network Traffic Throttling Rules 

You can define network throttling rules to limit the maximum throughput of traffic going from source 
to target in the backup infrastructure.  

Network traffic throttling rules are created and enforced globally, at the level of the backup server. 
Rules are set not for a single IP address, but for a pair of IP address ranges: on the source side and on 
the target side. If IP addresses of the backup infrastructure components fall into the specified source 
and target IP ranges of the rule, the rule is applied to these components. 

To create a network throttling rule: 

1. From the main menu, select Network Traffic. 

2. In the Global Network Traffic Rules window, click Add. 

3. In the Source IP address range section, specify a range of IP addresses for backup 
infrastructure components on the source side.  

4. In the Target IP address range section, specify a range of IP addresses for backup 
infrastructure components on the target side. 

5. Select the Throttle network traffic check box. 

6. In the Throttle to field, specify the maximum speed that must be used to transfer VM data 
from source to target. 

7. In the Apply throttling section, specify the time interval during which the rule must be 
enforced. You can select to use throttling rules all the time or schedule traffic throttling at 
specific time intervals, for example, during business hours to minimize the impact of data 
protection activities on the production network. 
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If you create several traffic throttling rules for the same range of IP addresses, make sure that time 
intervals when these rules are enforced do not overlap. For example, to manage network traffic during 
business and non-business hours, you can create two network traffic throttling rules: 

 Rule 1 limits the speed to 1 Mbps Monday through Friday from 7 AM to 7 PM. 

 Rule 2 limits the speed to 10 Mbps on weekends and from 7 PM to 7 AM on weekdays. 

In this case, Veeam Backup & Replication will limit the data transfer speed to 1 Mbps during business 
hours, while during non-business hours the speed will be limited to 10 Mbps. 

If several throttling rules use the same target IP address range but have different speed limits, the rule 
with the lowest transfer speed will be used. For example, you have configured two rules: 

 Rule 1 limits the speed to 4 Mbps: source IP range 192.168.0.1 - 192.168.0.30 and target IP 
range 192.168.0.1 - 192.168.0.255 

 Rule 2 limits the speed to 1 Mbps: source IP range 192.168.0.1 - 192.168.0.255 and target IP 
range 192.168.0.1 - 192.168.0.255 

Veeam Backup & Replication will use the lowest transfer speed for backup infrastructure components 
that fall into the source and target IP ranges — that is, a 1 Mbps rule. 

Tip: 

 

You can view which network traffic throttling rules apply to a backup proxy at the Traffic step of the 
backup proxy wizard. 
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Managing Data Transfer Connections 

By default, Veeam Backup & Replication uses multithreaded data transfer for every job session. VM 
data going from source to target is transferred over 5 TCP/IP connections. However, if you schedule 
several jobs to run at the same time, load on the network may be heavy. If the network capacity is not 
sufficient to support multiple data transfer connections, you can disable multithreaded data transfer 
or change the number of TCP/IP connections. 

To change the number of connections: 

1. From the main menu, select Network Traffic.  

2. In the Global Network Traffic Rules window, specify new data transfer settings: 

 To disable multithreaded data transfer, clear the Use multiple upload streams per 
job check box. Veeam Backup & Replication will use only one TCP/IP transfer 
connection for every job session. 

 To change the number of TCP/IP connections, leave the Use multiple upload 
streams per job check selected and specify the necessary number of connections 
in the field on the right. 
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Enabling Network Data Encryption 

You can enable network traffic encryption for data going between the source side and target side. 
Network traffic encryption helps you raise the security level for your data. If encrypted data is 
intercepted in the middle of data transfer, the eavesdropper will not be able to decrypt it and get 
access to it. 

Veeam Backup & Replication encrypts the network traffic according to the 256-bit Advanced 
Encryption Standard (AES). Data transferred between public networks is encrypted by default. If you 
want to enable network data encryption within the same network, you must create a network traffic 
rule for this network and enable the data encryption option for this rule. 

To enable network traffic encryption within the same network: 

1. From the main menu, select Network Traffic.  

2. In the Global Network Traffic Rules window, click Add. 

3. In the Source IP address range section, specify a source range of IP addresses in the network 
for which you want to enable data encryption. 

4. In the Target IP address range section, specify a target range of IP addresses in the same 
network. 

5. Select the Encrypt network traffic check box.  

As a result, data traffic going between backup infrastructure components whose IP addresses fall into 
the source and target IP address ranges will be encrypted. 
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Specifying Priority Networks for Data Transfer 

You can choose networks over which Veeam Backup & Replication must transport VM data when you 
perform data protection and disaster recovery tasks. This option can be helpful if you have a non-
production network and want to route VM data traffic over this network instead of the production 
one. 

To define networks for data transfer, you must create a list of preferred networks. When 
Veeam Backup & Replication needs to transfer VM data, it uses networks from this list. If a connection 
over preferred network(s) cannot be established for some reason, Veeam Backup & Replication will 
automatically fail over to the production network. 

To set a network priority list: 

1. From the main menu, select Network Traffic. 

2. In the Global Network Traffic Rules window, click Networks. 

3. In the Preferred Networks window, select the Prefer the following networks for backup 
and replication traffic check box. 

4. Click Add.  

5. Specify a network address using a CIDR notation or a network mask and click Add. 

6. Repeat steps 4-5 for all networks that you want to add. 
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Creating Backup Jobs 
To back up VMs, you must configure a backup job. The backup job defines how, where and when to 
back up VM data. One job can be used to process one or more VMs. 

You can configure a backup job and start it immediately or save the job and run it later. Jobs can be 
started manually or scheduled to run automatically at specific time. 

Before creating a backup job, check prerequisites. Then use the New Backup Job wizard to configure 
the backup job. 

Before You Begin 

Before you create a backup job, check the following prerequisites: 

 Backup infrastructure components that will take part in the backup process must be added to 
the backup infrastructure and properly configured. These include ESX(i) hosts on which VMs 
are registered, backup proxy and backup repository. 

 The backup repository must have enough free space to store created backup files. To receive 
alerts about low space on the backup repository, configure global notification settings. For 
more information, see Specifying Other Notification Settings. 

 For VM guest OS indexing on Linux-based VMs, a user account with root privileges on the VM 
is required. It is recommended that you create a separate user account for work with 
Veeam Backup & Replication on the Linux-based VM, grant root privileges to this account and 
specify settings of this account at the Guest Processing step of the New Backup Job wizard. 

 If you plan to map a backup job to a backup file that already exists on the backup repository, 
you must perform the rescan operations for this backup repository. Otherwise, 
Veeam Backup & Replication will not be able to recognize backup files on the backup 
repository. For more information, see Rescanning Backup Repositories.  

 If you plan to configure a secondary destination for the backup job, you can create a backup 
copy job or backup to tape job beforehand. The backup copy job or backup to tape job can 
have an empty source, that is, can be not linked to any backup job. For more information, see 
Creating Backup Copy Jobs and Creating Backup to Tape Jobs. 

 If you plan to use pre-job and post-job scripts and/or pre-freeze and post-thaw scripts, you 
must create scripts before you configure the backup job.  

 To back up Microsoft SQL transaction logs with Veeam Backup & Replication, you must make 
sure that the recovery model is set to Full or Bulk-logged recovery model for required 
databases on Microsoft SQL Server VMs. If the recovery model is set to Simple, 
Veeam Backup & Replication will not detect and process transaction logs on Microsoft SQL 
Server VMs.  

 Veeam Backup & Replication excludes from application-aware processing Microsoft SQL 
databases that are mounted to the Microsoft SQL Server using a remote UNC path. If at least 
one file of the database is located on a network shared folder, this database will be backed up 
in the crash-consistent state. Other databases on this server will be backed up in the 
transactionally consistent state. For more information, see https://www.veeam.com/kb1879.  

 By default, system databases (master, model, msdb) are skipped from transaction log 
processing and are not a part of the Veeam Explorer for Microsoft SQL Server restore 
workflow. To recover these databases, you can use file-level restore.  

If you want to exclude other database(s) from the transaction log processing workflow, refer 
to this Veeam Knowledge Base article: https://www.veeam.com/kb2104. (Consider that 
exclusion configured this way will be treated as a global setting.) 

https://www.veeam.com/kb1879
https://www.veeam.com/kb2104
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 To back up Oracle transaction logs with Veeam Backup & Replication, you must make sure 
that ARCHIVELOG is turned on for required databases on Oracle VMs. If ARCHIVELOG is turned 
off, Veeam Backup & Replication will not detect and process transaction logs on Oracle VMs.  

Mind the following limitations: 

 Due to Microsoft limitations, you cannot use Microsoft Azure Active Directory credentials to 
perform guest processing on VMs running Microsoft Windows 10. 

 [For EMC Data Domain backup repository] The length of forward incremental and forever 
forward incremental backup chains that contain one full backup and a set of subsequent 
incremental backups cannot be greater than 60 restore points. To overcome this limitation, 
schedule full backups (active or synthetic) to split the backup chain into shorter series. For 
example, to perform backups at 30-minute intervals, 24 hours a day, you must schedule 
synthetic fulls every day. In this scenario, intervals immediately after midnight may be 
skipped due to the duration of synthetic processing. For more information, see How Synthetic 
Full Backup Works. 

Step 1. Launch the New Backup Job Wizard 

To launch the New Backup Job wizard, do one of the following: 

 On the Home tab, click Backup Job and select VMware. 

 Open the Backup & Replication view. In the inventory pane right-click Jobs and select 
Backup > VMware. 

 Open the Virtual Machines view. In the working area select the VM(s), click Add to Backup 
on the ribbon and select New job or right-click the VM(s) and select Add to backup job > 
New job. Veeam Backup & Replication will start the New Backup Job wizard and add the 
VM(s) to this job. You can add other VMs to the job later on, when you pass through the 
wizard steps. 

 You can quickly add the VM(s) to an already existing job. To do this, open the Virtual 
Machines view, in the working area select the VM(s) and click Add to Backup > name of the 
job on the ribbon or right-click the VM(s) and select Add to backup job > name of the job. 
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Step 2. Specify Job Name and Description 

At the Name step of the wizard, specify a name and description for the backup job. 

1. In the Name field, enter a name for the backup job. 

2. In the Description field, provide a description for future reference. The default description 
contains information about the user who created the job, date and time when the job was 
created. 

 

Step 3. Select VMs to Back Up 

At the Virtual Machines step of the wizard, select VMs and VM containers that you want to back up.  

Jobs with VM containers are dynamic in their nature. If a new VM is added to the container in the 
virtual infrastructure after the backup job is created, Veeam Backup & Replication will automatically 
update the job settings to include the added VM. 

To add VMs to the job: 

1. Click Add. 

2. Use the toolbar at the top right corner of the window to switch between views: Hosts and 
Clusters, VMs and Templates, Datastores and VMs and Tags. Depending on the view you 
select, some objects may not be available. For example, if you switch to the VMs and 
Templates view, no resource pools, hosts or clusters will be displayed in the tree. 

3. Select the VM or VM container in the list and click Add.  
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To quickly find the necessary object, use the search field at the bottom of the Add Objects window. 

1. Click the button to the left of the search field and select the type of object to search for: 
Everything, Folder, Cluster, Host, Resource pool, VirtualApp or Virtual machine.  

2. Enter the object name or a part of it in the search field.  

3. Click the Start search button on the right or press [ENTER]. 

The initial size of VMs and VM containers added to the backup job is displayed in the Size column in 
the list. The total size of objects is displayed in the Total size field. Use the Recalculate button to 
refresh the total size value after you add a new object to the job. 

 

Step 4. Exclude Objects from Backup Job 

After you have added VMs and VM containers to the job, you can specify which objects you want to 
exclude from the backup. You can exclude the following types of objects:  

 VMs from VM containers 

 Specific VM disks 

 VM templates 

Note: 

 

Veeam Backup & Replication automatically excludes VM log files from backup to make the backup 
process faster and reduce the size of the backup file. 
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To exclude VMs from a VM container: 

1. At the Virtual Machines step of the wizard, click Exclusions. 

2. Click the VMs tab.  

3. Click Add. 

4. Use the toolbar at the top right corner of the window to switch between views: Hosts and 
Clusters, VMs and Templates, Datastores and VMs and Tags. Depending on the view you 
select, some objects may not be available. For example, if you select the VMs and Templates 
view, no resource pools, hosts or clusters will be displayed in the tree. 

5. In the displayed tree, select the necessary object and click Add. Use the Show full hierarchy 
check box to display the hierarchy of all VMware Servers added to the backup infrastructure.  

6. Click OK. 
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To exclude VM disks: 

1. At the Virtual Machines step of the wizard, click Exclusions. 

2. Click the Disks tab. 

3. Select the VM in the list and click Edit. If you want to exclude disks of a VM added as part of 
the container, click Add to include the VM in the list as a standalone object. 

4. Choose disks that you want to back up. You can choose to process all disks, 0:0 disks 
(typically, system disks) or add to the list custom IDE, SCSI or SATA disks.  

5. Select the Remove excluded disks from VM configuration check box. 
Veeam Backup & Replication will modify the VMX file of a backed up VM to remove excluded 
disks from the VM configuration. If you restore this VM from the backup file to a location 
where excluded disks are not accessible with the original paths, you will not have to manually 
edit the VM configuration file to be able to power on the VM. 
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To exclude VM templates: 

1. At the Virtual Machines step of the wizard, select a VM container and click Exclusions. 

2. Click the Templates tab. 

3. Clear the Backup VM templates check box.  

4. If you want to include VM templates into the full backup only, leave the Backup VM 
templates check box selected and select the Exclude templates from incremental backup 
check box. 

 

Step 5. Define VM Backup Order 

You can define the order in which the backup job must process VMs. Setting VM order can be helpful, 
for example, if you add some mission-critical VMs to the job and want the job to process them first. 
You can set these VMs first in list to ensure that their processing fits the backup window. 

VMs inside a VM container are processed at random. To ensure that VMs are processed in the defined 
order, you must add them as standalone VMs, not as a part of the VM container. 
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To define the VM backup order: 

1. At the Virtual Machines step of the wizard, select a VM or VM container. 

2. Use the Up and Down buttons on the right to move the VM or VM container up or down in 
the list. 

Note: 

 

If you enable parallel data processing in the global settings of Veeam Backup & Replication, VMs may 
be processed in a different order. For example, if backup infrastructure resources for a VM that is 
higher on the priority list are not available, and resources for a VM that is lower on the list are 
available, Veeam Backup & Replication will start processing the VM that is lower on the list first. 

 

Step 6. Specify Backup Storage Settings 

At the Storage step of the wizard, select backup infrastructure components for the job — backup 
proxy and backup repository, and specify backup storage settings. 

1. Click Choose next to the Backup proxy field to select a backup proxy. 

 If you choose Automatic selection, Veeam Backup & Replication will detect 
backup proxies that have access to the source datastore and automatically assign 
an optimal backup proxy to process VMs in the job. 

Veeam Backup & Replication assigns backup proxies to VMs included in the backup 
job one by one. Before processing a new VM in the VM list, 
Veeam Backup & Replication checks available backup proxies. If more than one 
backup proxy is available, Veeam Backup & Replication analyzes transport modes 
that the backup proxies can use to retrieve VM data and the current workload on 
the backup proxies to select the most appropriate one for VM processing. 

 If you choose Use the selected backup proxy servers specified below, you can 
explicitly select backup proxies that the job must use. It is recommended that you 
select at least two backup proxies to ensure that the backup job starts if one of the 
proxies fails or loses its connectivity to the source datastore. 
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2. From the Backup repository list, select a backup repository where the created backup files 
must be stored. When you select a backup repository, Veeam Backup & Replication 
automatically checks how much free space is available on the backup repository. 

3. You can map the job to a specific backup stored on the backup repository. Backup job 
mapping can be helpful if you have moved backup files to a new backup repository and want 
to point the job to existing backups on this new backup repository. You can also use backup 
job mapping if the configuration database got corrupted and you need to reconfigure 
backup jobs. 

To map the job to a backup, click the Map backup link and select the backup on the backup 
repository. Backups can be easily identified by job names. To find the backup, you can also 
use the search field at the bottom of the window. 

4. In the Retention policy section, specify the number of restore points that you want to store 
on the backup repository. When this number is exceeded, the earliest restore point will be 
removed from the backup chain. The number of restore points doesn’t correspond to the 
number of days to store restore points. For more information, see Retention Policy. 

5. If you want to archive backup files created with the backup job to a secondary destination 
(backup repository or tape), select the Configure secondary destination for this job check 
box. With this option enabled, the New Backup Job wizard will include an additional step — 
Secondary Target. At the Secondary Target step of the wizard, you can link the backup job 
to the backup copy job or backup to tape backup job.  

You can enable this option only if a backup copy job or backup to tape job is already 
configured on the backup server. 
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Step 7. Specify Advanced Backup Settings 

At the Storage step of the wizard, specify advanced settings for the backup job: 

 Backup settings 

 Maintenance settings 

 Storage settings 

 Notification settings 

 vSphere settings 

 Integration settings 

 Script settings 

Tip: 

 

After you specify necessary settings for the backup job, you can save them as default settings. To do 
this, click Save as Default at the bottom left corner of the Advanced Settings window. When you 
create a new backup job, Veeam Backup & Replication will automatically apply the default settings to 
the new job.  

Backup Settings 

To specify settings for a backup chain created with the backup job: 

1. At the Storage step of the wizard, click Advanced. 

2. On the Backup tab, select the backup method that you want to use to create the backup 
chain on the backup repository: 

 To create a reverse incremental backup chain, select Reverse Incremental.  

EMC Data Domain and HPE StoreOnce do not support the reverse incremental 
backup method. Do not select this option for backup jobs targeted at these types 
of backup repositories. 

 To create an incremental backup chain, select Incremental and enable synthetic 
full and/or active full backups (see items 3-4). 

 To create a forever forward incremental backup chain, select Incremental and do 
not enable synthetic full and/or active full backups (see items 3-4). 

For more information, see Backup Methods. 

3. If you choose the incremental backup method, you can select to periodically create synthetic 
full backups and/or active full backups.  

 To create a synthetic full backup, select the Create synthetic full backups 
periodically check box and click Days to schedule synthetic full backups on the 
necessary week days.  

You can additionally choose to transform the previous full backup chain into the 
reverse incremental backup chain. To do this, select the Transform previous full 
backup chains into rollbacks check box. 

 To create full backups regularly, select the Create active full backups periodically 
check box. Use the Monthly on or Weekly on selected days options to define 
scheduling settings. 

Before scheduling periodic full backups, you must make sure that you have enough free 
space on the backup repository. As an alternative, you can create active full backups manually 
when needed. For more information, see Active and Synthetic Full Backups. 
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Note: 

 

If you schedule the active full backup and synthetic full backup with or without the transform task on 
the same day, Veeam Backup & Replication will perform only active full backup. Synthetic full backup 
and transform task will be skipped. 

 

Maintenance Settings 

You can instruct Veeam Backup & Replication to periodically perform maintenance operations — 
service actions that will help make sure that the backup chain remains valid and consistent. 

To specify maintenance settings for the backup job: 

1. At the Storage step of the wizard, click Advanced. 

2. Click the Maintenance tab.  

3. To periodically perform a health check for the latest restore point in the backup chain, in the 
Storage-level corruption guard section select the Perform backup files health check 
check box and specify the time schedule for the health check.  

An automatic health check can help you avoid a situation when a restore point gets 
corrupted, making all further restore points corrupted, too (for forward incremental backup 
chains). If during the health check Veeam Backup & Replication detects corrupted data blocks 
in the latest restore point in the backup chain (or the restore point before the latest one if the 
latest restore point is incomplete), it will start the health check retry and transport valid data 
blocks from the source datastore to the backup repository. The transported data blocks are 
stored to a new backup file or the latest backup file in the backup chain, depending on the 
data corruption scenario. For more information, see Health Check for Backup Files. 

4. Select the Remove deleted VMs data after check box and specify the number of days for 
which you want to keep backup data for deleted VMs. If a VM is no longer available (for 
example, it was deleted or excluded from the job), Veeam Backup & Replication will keep its 
data on the backup repository for the period that you have specified. When this period is 
over, data of the deleted VM will be removed from the backup repository. 
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The retention period for deleted VMs is useful if the job is configured to create active full 
backups or synthetic full backups with subsequent transform, and you want to make sure 
that the full backup does not include redundant data. 

By default, the deleted VM retention period is 14 days. Do not set the deleted VM retention 
period to 1 day or a similar short interval. In the opposite case, the backup job may work not 
as expected and remove VM data that you still require. For more information, see Retention 
Policy for Deleted VMs. 

5. To periodically compact a full backup, select the Defragment and compact full backup file 
check box and specify the schedule for the compact operation. 

During the compact operation, Veeam Backup & Replication creates a new empty file and 
copies to it data blocks from the full backup file. As a result, the full backup file gets 
defragmented and the speed of reading and writing from/to the backup file increases.  

If the full backup file contains data blocks for deleted VMs, Veeam Backup & Replication will 
remove these data blocks. If the full backup file contains data for a VM that has only one 
restore point, and this restore point is older than 2 days, Veeam Backup & Replication will 
perform the take out operation. For more information, see Compact of Full Backup File. 
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Storage Settings 

To specify storage settings for the backup job: 

1. At the Storage step of the wizard, click Advanced. 

2. Click the Storage tab.  

3. By default, Veeam Backup & Replication deduplicates VM data before storing it on the backup 
repository. Data deduplication provides a smaller size of the backup file but may reduce the 
backup job performance. To disable data deduplication, clear the Enable inline data 
deduplication check box.  

If you disable this option, you also change the workflow of incremental backup. If Changed 
Block Tracking is enabled for the job, Veeam Backup & Replication will save all data blocks 
marked by CBT as new to the destination storage without performing an additional check or 
using Veeam’s filtering mechanism. This will result in faster incremental backup. For more 
information, see Changed Block Tracking. 

4. By default, Veeam Backup & Replication checks the NTFS MFT file on VMs with Microsoft 
Windows OS to identify data blocks of the hiberfil.sys file (file used for the hibernate 
mode) and pagefile.sys file (swap file), and excludes these data blocks from processing. 
The swap file is dynamic in nature and changes intensively between backup job sessions, 
even if the VM itself does not change much. Processing of service files reduces the job 
performance and increases the size of incremental backup files.  

If you want to include data blocks of the hiberfil.sys file and pagefile.sys file to the 
backup, clear the Exclude swap file blocks check box. For more information, see Swap Files. 

5. By default, Veeam Backup & Replication does not copy deleted file blocks ("dirty" blocks on 
the VM guest OS) to the target location. This option lets you reduce the size of backup files 
and increase the job performance. If you want to include dirty data blocks to the backup, 
clear the Exclude deleted file blocks check box. 

For more information, see Deleted File Blocks. 

6. From the Compression level list, select a compression level for the backup: None, Dedupe-
friendly, Optimal, High or Extreme. 

7. In the Storage optimization section, select what type of backup target you plan to use: Local 
target (16 TB + backup files), Local target, LAN target or WAN target. Depending on the chosen 
storage type, Veeam Backup & Replication will use data blocks of different size to optimize 
the size of backup files and job performance. 

For more information, see Compression and Deduplication. 

8. To encrypt the content of backup files, select the Enable backup file encryption check box. 
In the Password field, select a password that you want to use for encryption. If you have not 
created the password beforehand, click Add or use the Manage passwords link to specify a 
new password. For more information, see Managing Passwords for Data Encryption. 

If the backup server is not connected to Veeam Backup Enterprise Manager, you will not be 
able to restore data from encrypted backups in case you lose the password. 
Veeam Backup & Replication will display a warning about it. For more information, see 
Decrypting Data Without Password. 

Note: 

 

If you enable encryption for an existing backup job, during the next job session 
Veeam Backup & Replication will create a full backup file. The created full backup file and subsequent 
incremental backup files in the backup chain will be encrypted with the specified password.  
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Notification Settings 

To specify notification settings for the backup job: 

1. At the Storage step of the wizard, click Advanced. 

2. Click the Notifications tab.  

3. Select the Send SNMP notifications for this job check box if you want to receive SNMP traps 
when the job completes successfully.  

SNMP traps will be sent if you specify global SNMP settings in Veeam Backup & Replication 
and configure software on recipient's machine to receive SNMP traps. For more information, 
see Specifying SNMP Settings.  

4. Select the Send email notifications to the following recipients check box if you want to 
receive notifications about the job completion status by email. In the field below, specify 
recipient’s email address. You can enter several addresses separated by a semicolon. 

Email notifications will be sent if you configure global email notification settings in 
Veeam Backup & Replication. For more information, see Configuring Global Email Notification 
Settings. 
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5. You can choose to use global notification settings or specify custom notification settings. 

 To receive a typical notification for the job, select Use global notification 
settings. In this case, Veeam Backup & Replication will apply to the job global 
email notification settings specified for the backup server. For more 
information, see Configuring Global Email Notification Settings. 

 To configure a custom notification for the job, select Use custom notification 
settings specified below check box. You can specify the following notification 
settings: 

i. In the Subject field, specify a notification subject. You can use 
the following variables in the subject: %Time% (completion 
time), %JobName%, %JobResult%, %VmCount% (number of VMs 
in the job) and %Issues% (number of VMs in the job that have 
been processed with the Warning or Failed status). 

ii. Select the Notify on success, Notify on warning and/or Notify 
on error check boxes to receive email notification if the job 
completes successfully, fails or completes with a warning. 

iii. Select the Suppress notifications until the last retry check box 
to receive a notification about the final job status. If you do not 
enable this option, Veeam Backup & Replication will send one 
notification per every job retry. 

6. Select the Set successful backup details to this VM attribute check box to write 
information about successfully performed backup and backup results (backup date and time, 
backup server name and path to the backup file) to a VM attribute. In the field below, enter a 
name of the attribute. If the specified attribute does not exist, Veeam Backup & Replication 
will create it. 

7. Select the Append to the existing attribute's value check box to append information about 
successfully performed backup to an existing value of the attribute. In this case, 
Veeam Backup & Replication will keep values added by the user in the attribute, and will 
overwrite ony the value added by the backup job . If you do not select this option, 
Veeam Backup & Replication will overwrite the existing attribute values (made both by the 
user and backup job). 
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vSphere Settings 

To specify VMware vSphere settings for the backup job: 

1. At the Storage step of the wizard, click Advanced. 

2. Click the vSphere tab.  

3. Select the Enable VMware tools quiescence check box to freeze the file system of processed 
VMs during backup. Depending on the VM version, Veeam Backup & Replication will use the 
VMware FileSystem Sync Driver (vmsync) driver or VMware VSS component in VMware Tools 
for VM snapshot creation. These tools are responsible for quiescing the VM file system and 
bringing the VM to a consistent state suitable for backup. 

For more information, see VMware Tools Quiescence. 

4. In the Changed block tracking section, specify if VMware vSphere CBT must be used for VM 
backup. By default, this option is enabled. If you want to force using CBT even if CBT is 
disabled at the level of the ESX(i) host, select the Enable CBT for all processed VMs 
automatically check box. 

For more information, see Changed Block Tracking. 

Important! 

 

You can use CBT for VMs with virtual hardware version 7 or later. 
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Integration Settings 

On the Integration tab, you can define whether you want to use the Backup from Storage Snapshots 
technology to create the backup. Backup from Storage Snapshots lets you leverage storage snapshots 
for VM data processing. The technology improves RPOs and reduces the impact of backup activities 
on the production environment. 

To specify storage integration settings for the backup job: 

1. At the Storage step of the wizard, click Advanced. 

2. Click the Integration tab.  

3. By default, the Enable backup from storage snapshots option is enabled. If you do not 
want to use Backup from Storage Snapshots, clear this check box. For more information, see 
Performing Backup from Storage Snapshots.  

4. If you add to the job many VMs whose disks are located on the same volume or LUN, select 
the Limit processed VM count per storage snapshot to <N> check box and specify the 
number of VMs for which one storage snapshot must be created. 
Veeam Backup & Replication will divide VMs into several groups and trigger a separate 
storage snapshot for every VM group. As a result, the job performance will increase. 

For more information, see Limitation on Number of VMs per Snapshot. 

5. If Veeam Backup & Replication fails to create a storage snapshot, VMs whose disks are located 
to the storage system will not be processed by the job. To fail over to the regular VM 
processing mode and back up or replicate such VMs in the regular processing mode, select 
the Failover to standard backup check box. 
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6. [For secondary NetApp storage systems] If Veeam Backup & Replication cannot create a 
storage snapshot on NetApp SnapMirror or SnapVault, the job will not back up VMs whose 
disks are located to the storage system. To fail over to Backup from Storage Snapshots on the 
production storage, select the Failover to primary storage snapshot check box. If 
Veeam Backup & Replication fails to create a storage snapshot on NetApp SnapMirror or 
SnapVault, it will trigger the storage snapshot on the primary NetApp storage and use it as a 
source for backup. Note, however, that Backup from Storage Snapshots on the primary 
NetApp storage will put additional load on the production environment. 
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Script Settings 

To specify script settings for the backup job: 

1. At the Storage step of the wizard, click Advanced. 

2. Click the Scripts tab.  

3. If you want to execute custom scripts before and/or after the backup job, select the Run the 
following script before the job and Run the following script after the job check boxes and 
click Browse to choose executable file(s).  

You can select to execute pre- and post-backup actions after a number of backup sessions or 
on specific week days. 

 If you select the Run scripts every <N> backup session option, specify the 
number of the backup job sessions after which the script(s) must be executed.  

 If you select the Run scripts on the selected days only option, click Days and 
specify week days on which the script(s) must be executed. 

Note: 

 

Custom scripts that you define in the advanced job settings relate to the backup job itself, not the 
VM quiescence process. To add pre-freeze and post-thaw scripts for VM image quiescence, use the 
Guest Processing step of the wizard. 

 

  



 

621   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Step 8. Specify Secondary Target 

The Secondary Target step of the wizard is available if you have enabled the Configure secondary 
destination for this job option at the Storage step of the wizard.  

At the Secondary Target step of the wizard, you can link the backup job to a backup to tape or 
backup copy job. As a result, the backup job will be used as a source for the backup to tape or backup 
copy job. The backup file created with the backup job will be automatically archived to tape or copied 
to the secondary backup repository.  

The backup to tape job or backup copy jobs must be configured beforehand. You can create these 
jobs with an empty source. When you link the backup job to these jobs, Veeam Backup & Replication 
will automatically update the linked jobs to define the backup job as a source for these jobs. 

To link jobs: 

1. Click Add. 

2. From the jobs list, select a backup to tape or backup copy job that must be linked to the 
backup job. You can link several jobs to the backup job, for example, one backup to tape job 
and one backup copy job. To quickly find the job, use the search field at the bottom of the 
wizard. 

For more information, see Linking Backup Jobs to Backup Copy Jobs and Linking Backup Jobs to 
Backup to Tape Jobs.  
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Step 9. Specify Guest Processing Settings 

At the Guest Processing step of the wizard, you can enable the following settings for VM guest OS 
processing: 

 Application-aware processing 

 Transaction log handling for Microsoft SQL VMs 

 Transaction log handling for Oracle VM 

 VM guest OS file exclusion 

 Use of pre-freeze and post-thaw scripts 

 VM guest OS file indexing 

To coordinate guest processing activities, Veeam Backup & Replication deploys a runtime process on 
the VM guest OS. The process runs only during guest processing and is stopped immediately after the 
processing is finished (depending on the selected option, during the backup job session or after the 
backup job completes).  

You must specify a user account that will be used to connect to the VM guest OS and deploy the 
runtime process:  

1. From the Guest OS credentials list, select a user account with local administrator privileges 
on the VM guest OS. If you have not set up credentials beforehand, click the Manage 
accounts link or click Add on the right to add credentials. For more information, see 
Managing Credentials. 

2. By default, Veeam Backup & Replication uses the same credentials for all VMs in the job. If 
some VM requires a different user account, click Credentials and enter custom credentials for 
the VM. 

3. If you have added Microsoft Windows VMs to the job, specify which guest interaction proxy 
Veeam Backup & Replication can use to deploy the runtime process on the VM guest OS. On 
the right of the Guest interaction proxy field, click Choose. 

 Leave Automatic selection to let Veeam Backup & Replication automatically 
select the guest interaction proxy.  

 Select Use the selected guest interaction proxy servers only to explicitly 
define which servers will perform the guest interaction proxy role. The list of 
servers contains Microsoft Windows servers added to the backup 
infrastructure. 

To check if Veeam Backup & Replication can communicate with VMs added to the job and deploy the 
runtime process on their guest OSes, click Test Now. Veeam Backup & Replication will use the 
specified credentials to connect to all VMs in the list. 

Note: 

 

The guest interaction proxy functionality is available in the Enterprise and Enterprise Plus Editions of 
Veeam Backup & Replication. 
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User Account for Transaction Log Backup 

If you have added a Microsoft SQL Server VM or Oracle VM to the job, make sure that you specify a 
user account that has enough permissions on the database. 

 If you back up a Microsoft SQL VM and want Veeam Explorer for Microsoft SQL Server to 
automatically identify Microsoft SQL Server databases in the created backup, the user 
account must have the sysadmin privileges on the Microsoft SQL Server.  

 If you back up an Oracle VM, the user account must have SYSDBA privileges on the database. 

You can grant access rights to the VM guest OS and SYSDBA role to one user account and 
specify credentials of this user account in the job settings. If the account that you plan to use 
to connect to the VM guest OS does not have the SYSDBA role (for example, for security 
reasons), you will have to specify another account that has SYSDBA rights on the Oracle tab 
of the VM Processing Settings window. This account will be used to access the Oracle 
database. For more information, see Transaction Log Settings: Oracle. 
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Application-Aware Processing 

If you add to the backup job VMs running VSS-aware applications, you can enable application-aware 
processing to create a transactionally consistent backup. The transactionally consistent backup 
guarantees proper recovery of applications on VMs without data loss. 

To enable application-aware processing: 

1. At the Guest Processing step of the wizard, select the Enable application-aware 
processing check box. 

2. Click Applications. 

3. In the displayed list, select the VM and click Edit. 

To define custom settings for a VM added as a part of a VM container, you must include the 
VM to the list as a standalone object. To do this, click Add and choose the VM whose settings 
you want to customize. Then select the VM in the list and define the necessary settings. 

4. On the General tab, in the Applications section specify the behavior scenario for 
application-aware processing: 

 Select Require successful processing if you want Veeam Backup & Replication 
to stop the backup process if any error occurs during application-aware 
processing. 

 Select Try application processing, but ignore failures if you want to 
continue the backup process even if an error occurs during application-aware 
processing. This option guarantees completion of the backup job. However, 
the resulting backup will not be transactionally consistent but crash consistent. 

 Select Disable application processing if you do not want to enable 
application-aware processing for the VM. 

5. [For Microsoft Exchange, Microsoft SQL and Oracle VMs] In the Transaction logs section, 
specify if Veeam Backup & Replication must process transaction logs or copy-only backups 
must be created. 

a. Select Process transaction logs with this job if you want 
Veeam Backup & Replication to process transaction logs.  

[For Microsoft Exchange VMs] With this option selected, the runtime process 
running on the VM guest OS will wait for backup to complete successfully and then 
trigger truncation of transaction logs. If the backup job fails, the logs will remain 
untouched on the VM guest OS until the next start of the runtime process.  

[For Microsoft SQL Server VMs and Oracle VMs] You will have to specify settings for 
transaction log handling on the SQL and Oracle tabs of the VM Processing 
Settings window. For more information, see Transaction Log Settings: Microsoft 
SQL and Transaction Log Settings: Oracle. 

b. Select Perform copy only if you use another backup tool to perform VM guest 
level backup, and this tool maintains consistency of the database state. 
Veeam Backup & Replication will create a copy-only backup for the selected VM. 
The copy only backup preserves the chain of full/differential backup files and 
transaction logs on the VM. For more information, see 
http://msdn.microsoft.com/en-us/library/ms191495.aspx.  

Important! 

 

If both Microsoft SQL Server and Oracle Server are installed on one VM, and this VM is processed by a 
job with log backup enabled for both applications, Veeam Backup & Replication will back up only 
Oracle transaction logs. Microsoft SQL Server transaction logs will not be processed 

http://msdn.microsoft.com/en-us/library/ms191495.aspx
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Transaction Log Settings: Microsoft SQL Server 

If you back up a Microsoft SQL VM, you can specify how Veeam Backup & Replication must process 
transaction logs on this VM: 

1. At the Guest Processing step of the wizard, select the Enable application-aware 
processing check box. 

2. Click Applications. 

3. In the displayed list, select the Microsoft SQL Server VM and click Edit. 

4. In the Transaction logs section, select Process transaction logs with this job. 

5. In the VM Processing Settings window, click the SQL tab. 

6. Specify how transaction logs must be processed. You can select one of the following options: 

 Select Truncate logs to truncate transaction logs after successful backup. The 
runtime process running on the VM guest OS will wait for the backup to complete 
successfully and then truncate transaction logs. If the job does not manage to back 
up the Microsoft SQL Server VM, the logs will remain untouched on the VM guest 
OS until the next start of the runtime process. 

 Select Do not truncate logs to preserve transaction logs. When the backup job 
completes, Veeam Backup & Replication will not truncate transaction logs on the 
Microsoft SQL Server VM.  

It is recommended that you enable this option for databases that use the Simple 
recovery model. If you enable this option for databases that use the Full or Bulk-
logged recovery model, transaction logs on the VM guest OS may grow large and 
consume all disk space. In this case, the database administrator must take care of 
transaction logs him-/herself. 
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 Select Backup logs periodically to back up transaction logs with 
Veeam Backup & Replication. Veeam Backup & Replication will periodically copy 
transaction logs to the backup repository and store them together with the image-
level backup of the Microsoft SQL Server VM. During the backup job session, 
transaction logs on the VM guest OS will be truncated. 

For more information, see Microsoft SQL Server Logs Backup and Restore. 

If you have selected to back up transaction logs with Veeam Backup & Replication, you must specify 
settings for transaction logs backup: 

1. In the Backup logs every <N> minutes field, specify the frequency for transaction logs 
backup. By default, transaction logs are backed up every 15 minutes. The maximum log 
backup interval is 480 minutes. 

2. In the Retain log backups section, specify retention policy for transaction logs stored on the 
backup repository. 

 Select Until the corresponding image-level backup is deleted to apply the same 
retention policy for image-level backups and transaction log backups. 

 Select Keep only last <N> days of log backups to keep transaction logs for a 
specific number of days. By default, transaction logs are kept for 15 days. If you 
select this option, you must make sure that retention for transaction logs is not 
greater than retention for the image-level backups. For more information, see 
Retention for Transaction Log Backups. 

3. In the Log shipping servers section, click Choose to select what log shipping server you 
want to use to transport transaction logs: 

 Select Automatic selection if you want Veeam Backup & Replication to choose an 
optimal log shipping server automatically. If the optimal shipping server is busy, 
Veeam Backup & Replication will direct the data flow to another shipping server not 
to lose data and to comply with RPO. The process of transaction logs shipment 
does not require a dedicated server — Veeam Backup & Replication can use any 
Microsoft Windows server added to the backup infrastructure. 

 To define a log shipping server explicitly, select Use the specified servers only and 
select check boxes next to servers that you want to use as log shipping servers. The 
server list includes all Microsoft Windows servers added to the backup 
infrastructure.  

Make sure that you select a server that is not engaged in other resource-consuming 
tasks. For example, you may want not to use a server that performs the WAN 
accelerator role as a log shipping server. For load balance and high availability 
purposes, it is recommended that you select at least 2 log shipping servers. 

Important! 

 

Veeam Backup & Replication automatically excludes its configuration database from application-
aware processing during backup. Transaction logs for the configuration database are not backed up. 
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Transaction Log Settings: Oracle 

If you back up an Oracle VM, you can specify how Veeam Backup & Replication must process 
transaction logs on this VM: 

1. At the Guest Processing step of the wizard, select the Enable application-aware 
processing check box. 

2. Click Applications. 

3. In the displayed list, select the Oracle VM and click Edit. 

4. In the Transaction logs section, select Process transaction logs with this job. 

5. In the VM Processing Settings window, click the Oracle tab. 

6. In the Specify Oracle account with SYSDBA privileges section, specify a user account that 
Veeam Backup & Replication will use to connect to the Oracle database. The account must 
have SYSDBA rights on the Oracle database.  

You can select Use guest credentials in the list of user accounts. In this case, 
Veeam Backup & Replication will use the account specified at the Guest Processing step of 
the wizard to access the VM guest OS and connect to the Oracle database.  
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7. In the Archived logs section, specify if Veeam Backup & Replication must truncate 
transaction logs on the Oracle VM: 

 Select Do not truncate archived logs if you want Veeam Backup & Replication to 
preserve archived logs on the VM guest OS. When the backup job completes, the 
runtime process will not truncate transaction logs.  

It is recommended that you select this option for databases for which the 
ARCHIVELOG mode is turned off. If the ARCHIVELOG mode is turned on, transaction 
logs on the VM guest OS may grow large and consume all disk space. In this case, 
the database administrator must take care of transaction logs him-/herself. 

 Select Truncate logs older than <N> hours or Truncate logs over <N> GB if you 
want Veeam Backup & Replication to truncate archived logs that are older than 
<N> hours or larger than <N> GB. The runtime process running on the VM guest OS 
will wait for the backup to complete successfully and then trigger transaction logs 
truncation via Oracle Call Interface (OCI). If the job does not manage to back up the 
Oracle VM, the logs will remain untouched on the VM guest OS until the next start 
of the runtime process. 

8. To back up Oracle transaction logs with Veeam Backup & Replication, select the Backup log 
every <N> minutes check box and specify the frequency for transaction logs backup. By 
default, transaction logs are backed up every 15 minutes. The maximum log backup interval 
is 480 minutes. 

9. In the Retain log backups section, specify retention policy for transaction logs stored on the 
backup repository: 

 Select Until the corresponding image-level backup is deleted to apply the same 
retention policy for image-level backups and transaction log backups.  

 Select Keep only last <n> days to keep transaction logs for a specific number of 
days. By default, transaction logs are kept for 15 days. If you select this option, you 
must make sure that retention for transaction logs is not greater than retention for 
the image-level backups. For more information, see Retention for Transaction Log 
Backups. 
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10. In the Log shipping servers section, click Choose to select what log shipping server you 
want to use to transport transaction logs: 

 Select Automatic selection if you want Veeam Backup & Replication to select an 
optimal log shipping server automatically. The process of transaction logs 
shipment does not require a dedicated server — Veeam Backup & Replication can 
use any Microsoft Windows or Linux server added to the backup infrastructure. 

 Select Use the specified servers only to define a log shipping server explicitly. In 
the Log Shipping Servers window, select check boxes next to servers that you 
want to use as log shipping servers. The server list includes all Microsoft Windows 
servers added to the backup infrastructure.  

Make sure that you select a server that is not engaged in other resource-consuming 
tasks. For example, you may want not to use a server that performs the WAN 
accelerator role as a log shipping server. For load balance and high availability 
purposes, it is recommended that you select at least 2 log shipping servers. 
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VM Guest OS File Exclusion 

If you do not want to back up specific files and folders on the VM guest OS, you can exclude them 
from the backup. 

To define what files and folders must be excluded: 

1. At the Guest Processing step of the wizard, select the Enable application-aware 
processing check box. 

2. Click Applications. 

3. In the displayed list, select the VM and click Edit. 

To define custom settings for a VM added as part of a VM container, you must include the VM 
in the list as a standalone object. To do this, click Add and choose a VM whose settings you 
want to customize. Then select the VM in the list and define the necessary settings. 

4. Click the File Exclusions tab and specify what files must be excluded from the backup: 

 Select Exclude the following files and folders to remove the individual files and 
folders from the backup.  

 Select Include only the following files and folders to leave only the specified files 
and folders in the backup. 

5. Click Add and specify what files and folders you want to include or exclude. To form the list of 
exclusions or inclusions, you can use full paths to files and folders, environmental variables 
and file masks with the asterisk (*) and question mark (?) characters. For more information, 
see VM Guest OS Files. 

6. Click OK. 

7. Repeat steps 5-6 for every file or folder that you want to exclude or include. 
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Pre-Freeze and Post-Thaw Scripts 

If you plan to back up VMs running applications that do not support VSS, you can specify what scripts 
Veeam Backup & Replication must use to quiesce the VM. The pre-freeze script quiesces the VM file 
system and application data to bring the VM to a consistent state before Veeam Backup & Replication 
triggers a VM snapshot. After the VM snapshot is committed, the post-thaw script brings the VM and 
applications to their initial state. 

To specify pre-freeze and post-thaw scripts for the job: 

1. At the Guest Processing step, click Applications. 

2. In the displayed list, select the VM and click Edit. 

3. Click the Scripts tab. 

4. In the Script processing mode section, specify the scenario for scripts execution: 

 Select Require successful script execution if you want 
Veeam Backup & Replication to stop the backup process if the script fails. 

 Select Ignore script execution failures if you want to continue the backup 
process even if script errors occur.  

 Select Disable script execution if you do not want to run scripts for the VM. 

5. In the Windows scripts section, specify paths to pre-freeze and post-thaw scripts for 
Microsoft Windows VMs. Veeam Backup & Replication supports scripts in the EXE, BAT and 
CMD format. 

6. In the Linux scripts section, specify paths to pre-freeze and/or post-thaw scripts for Linux 
VMs. Veeam Backup & Replication supports scripts of the SH file type. 

If you have added to the job a VM container with Microsoft Windows and Linux VMs, you can 
select to execute both Microsoft Windows and Linux scripts for the VM container. When the 
job starts, Veeam Backup & Replication will automatically determine what OS type is installed 
on the VM and use corresponding scripts to quiesce this VM. 
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Tip: 

 

Beside pre-freeze and post-thaw scripts for VM quiescence, you can instruct 
Veeam Backup & Replication to run custom scripts before the job starts and after the job completes. 
For more information, see Script Settings. 

 

  



 

633   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

VM Guest OS File Indexing 

To specify VM guest OS indexing options for a VM: 

1. At the Guest Processing step of the wizard, click Indexing. 

2. Select a VM in the list and click Edit > Windows indexing or Linux indexing. 

3. Specify the indexing scope: 

 Select Disable indexing if you do not want to index guest OS files of the VM. 

 Select Index everything if you want to index all VM guest OS files. 

 Select Index everything except if you want to index all VM guest OS files 
except those defined in the list. By default, system folders are excluded from 
indexing. You can add or delete folders using the Add and Remove buttons on 
the right. You can also use system environment variables to form the list, for 
example: %windir%, %Program Files% and %Temp%.  

To reset the list of folders to its initial state, click Default. 

 Select Index only following folders to define folders that you want to index. 
You can add or delete folders to index using the Add and Remove buttons on 
the right. You can also use system environment variables to form the list, for 
example: %windir%, %Program Files% and %Temp%. 

Note: 

 

For Linux system indexing, Veeam Backup & Replication requires several utilities to be installed on 
the Linux VM: mlocate, gzip and tar. If these utilities are not found, Veeam Backup & Replication will 
prompt you to deploy them on the VM guest OS. 
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Step 10. Define Job Schedule 

At the Schedule step of the wizard, select to run the backup job manually or schedule the job to run 
on a regular basis. 

To specify the job schedule:  

1. Select the Run the job automatically check box. If this check box is not selected, you will 
have to start the job manually to create the VM backup. 

2. Define scheduling settings for the job: 

 To run the job at specific time daily, on defined week days or with specific 
periodicity, select Daily at this time. Use the fields on the right to configure the 
necessary schedule. 

 To run the job once a month on specific days, select Monthly at this time. Use the 
fields on the right to configure the necessary schedule. 

 To run the job repeatedly throughout a day with a specific time interval, select 
Periodically every. In the field on the right, select the necessary time unit: Hours or 
Minutes. Click Schedule and use the time table to define the permitted time 
window for the job. In the Start time within an hour field, specify the exact time 
when the job must start.  

The repeatedly run job are started by the following rules: 

– Veeam Backup & Replication always starts counting defined intervals 
from 12:00 AM. For example, if you configure to run a job with a 4-hour 
interval, the job will start at 12:00 AM, 4:00 AM, 8:00 AM, 12:00 PM, 4:00 
PM and so on. 

– If you define permitted hours for the job, after the denied interval is over, 
Veeam Backup & Replication will immediately start the job and then run 
the job by the defined schedule. 

For example, you have configured a job to run with a 2-hour interval and defined 
permitted hours from 9:00 AM to 5:00 PM. According to the rules above, the job will 
first run at 9:00 AM, when the denied period is over. After that, the job will run at 
10:00 AM, 12:00 PM, 2:00 PM and 4:00 PM. 

 To run the job continuously, select the Periodically every option and choose 
Continuously from the list on the right. A new backup job session will start as soon 
as the previous backup job session finishes. 

 To chain jobs, use the After this job field. In the common practice, jobs start one 
after another: when job A finishes, job B starts and so on. If you want to create a 
chain of jobs, you must define the time schedule for the first job in the chain. For 
the rest of the jobs in the chain, select the After this job option and choose the 
preceding job from the list.  

3. In the Automatic retry section, define whether Veeam Backup & Replication must attempt to 
run the backup job again if the job fails for some reason. During a job retry, 
Veeam Backup & Replication processes failed VMs only. Enter the number of attempts to run 
the job and define time intervals between them. If you select continuous backup, 
Veeam Backup & Replication will retry the job for the defined number of times without any 
time intervals between the job runs. 
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4. In the Backup window section, define the time interval within which the backup job must 
complete. The backup window prevents the job from overlapping with production hours and 
ensures that the job does not provide unwanted overhead on the production environment. 
To set up a backup window for the job: 

a. Select the Terminate job if it exceeds allowed backup window check box and 
click Window.  

b. In the Time Periods section, define the allowed hours and prohibited hours for 
backup. If the job exceeds the allowed window, it will be automatically terminated. 

Note: 

 

The After this job function will only start a job if the first job in the chain is started automatically by 
schedule. If the first job is started manually, jobs chained to it will not be started. 
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Step 11. Finish Working with the Wizard 

At the Summary step of the wizard, complete the procedure of backup job configuration. 

1. Review details of the backup job. 

2. Select the Run the job when I click Finish check box if you want to start the job right after 
you finish working with the wizard.  

3. Click Finish to close the wizard. 
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Creating Replication Jobs 
To create VM replicas, you must configure a replication job. The replication job defines how, where 
and when to replicate VM data. One job can be used to process one VM or more VMs. 

You can configure a job and start it immediately or save the job to start it later. Jobs can be started 
manually or scheduled to run automatically at specific time. 

Before creating a replication job, check prerequisites. Then use the New Replication Job wizard to 
configure a replication job. 

Before You Begin 

Before you create a replication job, check the following prerequisites: 

 Backup infrastructure components that will take part in the replication process must be 
added to the backup infrastructure and properly configured. These include source and target 
ESX(i) hosts, one backup proxy for onsite replication scenario or two backup proxies for offsite 
replication scenario and backup repository for storing replica metadata. 

 The target datastore must have enough free space to store disks of replicated VMs. To receive 
alerts about low space on the target datastore, configure global notification settings. For 
more information, see Specifying Other Notification Settings. 

 If you plan to replicate VMs via WAN accelerators, source and target WAN accelerators must 
be added to the backup infrastructure and properly configured. For more information, see 
Configuring WAN Accelerators.  

 If you plan to replicate VMs via WAN accelerators, it is recommended that you pre-populate 
global cache on the target WAN accelerator before you start the replication job. Global cache 
population helps reduce the amount of traffic transferred over the WAN. For more 
information, see Populating Global Cache.  

 If you plan to replicate VMs from the backup, the backup job that you plan to use as the 
source must be configured beforehand. For more information, see Remote Replica from 
Backup. 

 If you plan to use pre-job and post-job scripts and/or pre-freeze and post-thaw scripts, you 
must create scripts before you configure the replication job. Veeam Backup & Replication 
supports script files in the following formats: EXE, BAT, CMD, JS, VBS, WSF, PS1, SH. 

Mind the following limitations: 

 If you change the size of VM disks on the source VM, Veeam Backup & Replication will delete 
all available restore points on the VM replica during the next replication job session. 

 Due to Microsoft limitations, you cannot use Microsoft Azure Active Directory credentials to 
perform application-aware processing on VMs running Microsoft Windows 10. 

  



 

638   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Step 1. Launch the New Replication Job Wizard 

To run the New Replication Job wizard, do one of the following: 

 On the Home tab, click Replication Job and select VMware. 

 Open the Backup & Replication view, in the inventory pane right-click Jobs and select 
Replication > VMware. 

 Open the Virtual Machines view. In the working area, select the VM(s), click Add to 
Replication on the ribbon and select New job or right-click the VM(s) and select Add to 
replication job > New job. In this case, the VM(s) will be automatically added to the 
replication job. You can add other VMs to the job when passing through the wizard steps. 

 You can quickly include the VM(s) to already existing jobs. To do this, open the Virtual 
Machines view. In the working area, select the VM(s) and click Add to Replication > name of 
the job on the ribbon or right-click VMs and select Add to replication job > name of the job. 
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Step 2. Specify Job Name and Description 

At the Name step of the wizard, specify the job name and description and define advanced settings of 
for the replication job. 

1. In the Name field, enter a name for the replication job. 

2. In the Description field, provide a description for future reference. The default description 
contains information about the user who created a job, date and time when the job was 
created. 

3. If you plan to replicate VMs to a DR site, you can use a number of advanced settings for the 
job: 

 Select the Low connection bandwidth check box to enable the Seeding step in 
the wizard. Replica seeding can be used if you plan to replicate VMs to a remote site 
and want to reduce the amount of traffic sent over the network during the first run 
of the replication job. 

 Select the Separate virtual networks check box to enable the Network step in the 
wizard. If the network in the DR site does not match the production network, you 
can resolve this mismatch by creating a network mapping table. 

 Select the Different IP addressing scheme check box to enable the Re-IP step in 
the wizard. Re-IP possibilities can be used to automate reconfiguration of replica IP 
addresses for Microsoft Windows VMs if IP schemes in the DR and production sites 
do not match. 
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Step 3. Select VMs to Replicate 

At the Virtual Machines step of the wizard, select VMs and VM containers that you want to replicate.  

Jobs with VM containers are dynamic in their nature. If a new VM is added to the container in the 
virtual infrastructure after the replication job is created, Veeam Backup & Replication will automatically 
update the job settings to include the added VM. 

1. Click Add. 

2. Use the toolbar at the top right corner of the window to switch between views: Hosts and 
Clusters, VMs and Templates, Datastores and VMs and Tags. Depending on the view you 
select, some objects may not be available. For example, if you select the VMs and Templates 
view, no resource pools, hosts or clusters will be displayed in the tree. 

3. Select the object and click Add. 

To quickly find the necessary object, you can use the search field at the bottom of the Add Objects 
window. 

1. Click the button to the left of the search field and select the necessary type of object to search 
for: Everything, Folder, Cluster, Host, Resource pool, VirtualApp or Virtual machine.  

2. Enter the object name or a part of it in the search field.  

3. Click the Start search button on the right or press [ENTER]. 

The initial size of VMs and VM containers added to the replication job is displayed in the Size column 
in the list. The total size of objects is displayed in the Total size field. Use the Recalculate button to 
refresh the total size value after you add a new object to the job. 
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Step 4. Specify Data Source 

You can select a data source from which VM data must be read.  

1. At the Virtual Machines step of the wizard, click Source on the right of the VMs list. 

2. In the displayed window, select one of the following options: 

 From production storage. In this case, Veeam Backup & Replication will retrieve 
VM data from datastores connected to the source ESX(i) host. 

 From backup files. In this case, Veeam Backup & Replication will read VM data 
from the backup chain already existing on the backup repository. This option can 
be used in the replica from backup scenario. For more information, see Remote 
Replica from Backup. 

 

Step 5. Exclude Objects from Replication Job 

After you have added VMs and VM containers to the job, you can specify which objects you want to 
exclude from replicas. You can exclude the following types of objects:  

 VMs from VM containers 

 Specific VM disks 

Note: 

 

To make the replication process faster and reduce the size of created replicas, 
Veeam Backup & Replication automatically excludes the following objects from replication: 

 VM log files 
 VM templates from VM containers 
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To exclude VMs from a VM container: 

1. At the Virtual Machines step of the wizard, click Exclusions. 

2. Click the VMs tab.  

3. Click Add. 

4. Use the toolbar at the top right corner of the window to switch between views: Hosts and 
Clusters, VMs and Templates, Datastores and VMs and Tags. Depending on the view you 
select, some objects may not be available. For example, if you select the VMs and Templates 
view, no resource pools, hosts or clusters will be displayed in the tree. 

5. Select the object and click Add. Use the Show full hierarchy check box to display the 
hierarchy of all VMware Servers added to Veeam Backup & Replication.  

6. Click OK. 
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To exclude VM disks: 

1. At the Virtual Machines step of the wizard, click Exclusions. 

2. Click the Disks tab. 

3. Select the VM in the list and click Edit. If you want to exclude disks of a VM added as a part of 
the container, click Add to include the VM in the list as a standalone object. 

4. Choose disks that you want to replicate. You can choose to process all disks, 0:0 disks 
(typically, system disks) or add to the list custom IDE, SCSI or SATA disks.  
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Step 6. Define VM Replication Order 

You can define the order in which the replication job must process VMs. Setting VM order can be 
helpful, for example, if you have added some mission-critical VMs to the job and want the job to 
process them first. You can set these VMs first in list to ensure that their processing fits the backup 
window. 

VMs inside a VM container are processed at random. To ensure that VMs are processed in the defined 
order, you must add them as standalone VMs, not as a part of the VM container. 

To define VM replication order: 

1. At the Virtual Machines step of the wizard, select a VM or VM container. 

2. Use the Up and Down buttons on the right to move the VM or VM container up or down in 
the list. 

Note: 

 

If you enable parallel data processing, VMs may be processed in a different order. For example, if 
backup infrastructure resources for a VM that is higher on the priority list are not available, and 
resources for a VM that is lower on the list are available, Veeam Backup & Replication will start 
processing the VM that is lower on the list first. 
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Step 7. Specify Replica Destination 

At the Destination step of the wizard, select destination for the VM replica(s). 

1. Click Choose next to the Host or cluster field and select an ESX(i) host or cluster where VM 
replica(s) must be registered. Assigning a cluster as a target ensures more sustainable 
replication process. The replication job will be performed until there is at least one available 
host in the cluster. 

2. If all or majority of VM replicas must belong to the same resource pool, click Choose next to 
the Resource pool field and select the target resource pool.  

If you want to place VM replicas to different resource pools: 

a. Click the Pick resource pool for selected replicas link.  

b. In the Choose Resource Pool window, click Add VM on the right and select the 
VMs and click Add.  

c. Select the added VM in the Replica VM resource pool list and click Resource Pool 
at the bottom of the window.  

d. From the list of available resource pools, choose the target resource pool for the 
VM. 

3. If all or majority of VM replicas must be placed in the same folder, click Choose next to the 
VM folder field and choose the target folder  

If you want to place VM replicas to different folders: 

a. Click the Pick VM folder for selected replicas link.  

b. In the Choose Folder window, click Add VM on the right and select the VMs and 
click Add.  

c. Select the added VM in the Replica VM folder list and click VM Folder at the 
bottom of the window. 

d. From the list of available folders, choose the target folder for the VM. 

The VM folder section is disabled if you selected a standalone ESX(i) host as a target for VM 
replicas. 

4. If files for all or majority of VM replicas must be stored on the same datastore, click Choose 
next to the Datastore field and select the target datastore. Veeam Backup & Replication 
displays only those datastores that are accessible by the selected replication target. If you 
have chosen to replicate VMs to a cluster, Veeam Backup & Replication will display only 
shared datastores. 

If you want to place VM replicas to different datastores: 

a. Click the Pick datastore for selected virtual disks link.  

b. In the Choose VM Files Location window, click Add VM on the right and select 
VMs that must be placed on datastores. 

c. Select the added VM in the Files location list and click Datastore at the bottom of 
the window.  

d. From the list of available datastores, select the target datastore. 
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You can choose to store replica configuration files and disk files in different locations. 

a. Add a VM to the Files location list, expand the VM and select the required type of 
files.  

b. At the bottom of the window, click Datastore and choose the destination for the 
selected type of files. 

5. By default, Veeam Backup & Replication saves disks of a VM replica in the thin format. If 
necessary, you can configure the job to change the disk format. For example, if the original 
VM uses thick disks, you can change the format of replica disks to thin provisioned and save 
on disk space required to store VM replica data.  

Disk format change is available only for VMs using virtual hardware version 7 or later.  

To change replica disk format:  

a. Click the Pick datastore for selected virtual disks link.  

b. In the Choose VM Files Location window, click Add VM on the right and select 
VMs whose disk format you want to change and click Add. 

c. Select the added VM and click Disk type at the bottom of the window.  

d. In the Disk Type Settings section, choose the format that will be used to restore 
replica disk files: same as the source disk, thin or thick.  

Tip: 

 

When selecting the necessary object in the virtual infrastructure, you can use the search field at the 
bottom of the corresponding window. Click the button on the left of the field to select the necessary 
type of object, enter an object’s name or a part of it and click the Start search button on the right or 
press [ENTER]. 
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Step 8. Create a Network Map Table 

The Network step of the wizard is available if you have selected the Separate virtual networks 
option at the Name step of the wizard. You can use this step to configure network mapping settings 
for the VM replica(s).  

Network mapping can be helpful if you use different networks in the production site and DR site. In 
this situation, you can configure a table that maps production networks to networks in the DR site. 
During every replication job session, Veeam Backup & Replication will check the network mapping 
table and update the VM replica configuration file to replace the production network with the 
specified network in the DR site. As a result, when you perform failover, the VM replica will be 
connected to the necessary network(s) in the DR site, and you will not have to re-configure network 
settings for the VM replica manually.  

To configure a network mapping table: 

1. Click Add.  

2. Click Browse next to the Source network field and select the production network to which 
VMs added to the job are connected.  

3. Click Browse next to the Target network field and select the network in the DR site to which 
VM replicas must be connected. 

4. Repeat steps 2-3 for all networks to which VM replicas must be connected. 
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Step 9. Configure Re-IP Rules 

The Re-IP step of the wizard is available if you have selected the Different IP addressing scheme 
option at the Name step of the wizard. You can use this step to configure re-IP rules for Microsoft 
Windows VMs. 

Re-IP rules can be helpful if the IP addressing scheme in the production site differs from the 
addressing scheme in the DR site. In this situation, you can configure a number of re-IP rules for the 
replication job. When you perform failover, Veeam Backup & Replication will check if configured re-IP 
rules apply for the VM replica. If a re-IP rule applies to the VM replica, the VM replica will get a new IP 
address according to the new network mask, and you will be able to reach this VM replica in the DR 
site. 

To configure a re-IP rule: 

1. Click Add. 

2. In the Source VM section, describe an IP numbering scheme adopted in the source site. To 
facilitate configuration, Veeam Backup & Replication detects an IP address and subnet mask 
for the backup server and pre-populates values in the Source VM section. 

3. In the Target VM section, describe an IP numbering scheme adopted in the DR site. Specify 
an IP address, subnet mask and default gateway that will be used for VM replicas. If necessary, 
define the DNS and WINS server addresses. 

4. In the Description field, specify a brief outline of the rule or any related comments. 

Note: 

 

You can use the asterisk character (*) to specify a range of IP addresses, for example, 172.16.17.*. 
Do not use 0 to specify a range of IP addresses. In Veeam Backup & Replication, value 172.16.17.0 
means a regular IP address 172.16.17.0, not an IP address range. 
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Step 10. Specify Replication Job Settings 

At the Job Settings step of the wizard, define replication job settings. 

1. From the Repository for replica metadata list, select a backup repository that is located in 
the source site. This backup repository will be used to store metadata for VM replicas — 
checksums of read data blocks required to streamline incremental sessions of the replication 
job. 

2. In the Replica name suffix field, enter a suffix for the name of VM replicas. To register a VM 
replica on the target host, Veeam Backup & Replication appends the specified suffix to the 
name of the source VMs. Files of the VM replica are placed to the VMname_suffix folder on the 
selected datastore. 

3. In the Restore points to keep field, specify the number of restore points that must be 
maintained by the replication job. If this number is exceeded, the earliest restore point will be 
removed.  

Due to VMware restrictions on the number of VM snapshots, the maximum number of restore 
points for VM replicas is limited to 28.  

When you specify the retention policy settings for the replication job, consider available 
space on the target datastore. A great number of restore points (snapshots) may fill the target 
datastore. 

Important! 

 

 You cannot store VM replica metadata on deduplicating storage appliances. During 
replication jobs, Veeam Backup & Replication frequently reads and writes small portions of 
metadata from/to the backup repository. Frequent access to metadata causes low 
performance of deduplicating storage appliances, which may result in low performance of 
replication jobs. 

  You cannot store replica metadata on a scale-out backup repository. 
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Step 11. Specify Advanced Replica Settings 

At the Job settings step of the wizard, you can specify the following settings for the replication job: 

 Traffic settings 

 Notification settings 

 vSphere settings 

 Integration settings 

 Script settings 

Tip: 

 

After you specify necessary settings for the replication job, you can save them as default settings. To 
do this, click Save as Default at the bottom left corner of the Advanced Settings window. When 
you create a new replication job, Veeam Backup & Replication will automatically apply the default 
settings to the new job.  

Traffic Settings 

To specify traffic settings for the replication job: 

1. At the Job Settings step of the wizard, click Advanced. 

2. Click the Traffic tab.  

3. By default, Veeam Backup & Replication checks the NTFS MFT file on VMs with Microsoft 
Windows OS to identify data blocks of the hiberfil.sys file (file used for the hibernate 
mode) and pagefile.sys file (swap file), and excludes these data blocks from processing. 
The swap file is dynamic in nature and changes intensively between replication job sessions, 
even if the VM itself does not change much. Processing of service files reduces the job 
performance and increases the size of incremental data. 

If you want to include data blocks of the hiberfil.sys file and pagefile.sys file to the 
replica, clear the Exclude swap file blocks check box. For more information, see Swap Files. 

4. By default, Veeam Backup & Replication does not copy deleted file blocks ("dirty" blocks on 
the VM guest OS) to the target location. This option lets you reduce the size of the VM replica 
and increase the job performance. If you want to include dirty data blocks to the VM replica, 
clear the Exclude deleted file blocks check box. 

For more information, see Deleted File Blocks. 

5. From the Compression level list, select a compression level for the created VM replica: None, 
Dedupe-friendly, Optimal, High or Extreme. Compression is applicable only if VM data is 
transferred between two backup proxies. If one backup proxy acts as the source and target 
backup proxy, VM data is not compressed at all. 
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6. In the Storage optimization section, select what type of backup target you plan to use: Local 
target (16 TB + backup files), Local target, LAN target or WAN target. Depending on the chosen 
storage type, Veeam Backup & Replication will use data blocks of different size to optimize 
the size of backup files and job performance. 

When selecting the data block size, consider the following aspects: 

 When reading the VM image, Veeam Backup & Replication "splits" the VM image 
into blocks of the selected size. The more data blocks there are, the more time is 
required to process the VM image. 

 Veeam Backup & Replication writes information about every data block to the VM 
replica metadata stored in the backup repository. The more data blocks there are, 
the more metadata is written to the backup repository. 

 During incremental job runs, Veeam Backup & Replication uses CBT to define 
changed data blocks in the VM. The larger is the size of the found changed data 
block, the greater amount of data needs to be transferred to the target site. 

For more information, see Compression and Deduplication. 
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Notification Settings 

To specify notification settings for the replication job: 

1. At the Job Settings step of the wizard, click Advanced. 

2. Click the Notifications tab.  

3. Select the Send SNMP notifications for this job check box if you want to receive SNMP traps 
when the job completes successfully.  

SNMP traps will be sent if you configure global SNMP settings in Veeam Backup & Replication 
and configure software on recipient's machine to receive SNMP traps. For more information, 
see Specifying SNMP Settings.  

4. Select the Send email notifications to the following recipients check box if you want to 
receive notifications by email in case of job failure or success. In the field below, specify a 
recipient’s email address. You can enter several addresses separated by a semicolon. 

Email notifications will be sent if you configure global email notification settings in 
Veeam Backup & Replication. For more information, see Configuring Global Email Notification 
Settings. 

5. You can choose to use global notification settings or specify custom notification settings. 

 To receive a typical notification for the job, select Use global notification 
settings. In this case, Veeam Backup & Replication will apply to the job global 
email notification settings specified for the backup server. For more 
information, see Configuring Global Email Notification Settings. 

 To configure a custom notification for a job, select Use custom notification 
settings specified below. You can specify the following notification settings: 

a. In the Subject field, specify a notification subject. You can use 
the following variables in the subject: %Time% (completion 
time), %JobName%, %JobResult%, %VmCount% (number of VMs 
in the job) and %Issues% (number of VMs in the job that have 
been processed with the Warning or Failed status). 

b. Select the Notify on success, Notify on warning and/or Notify 
on error check boxes to receive email notification if the job 
completes successfully, fails or completes with a warning. 
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c. Select the Suppress notifications until the last retry check box 
to receive a notification about the final job status. If you do not 
enable this option, Veeam Backup & Replication will send one 
notification per every job retry. 
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vSphere Settings 

To specify vSphere settings for the replication job: 

1. At the Job Settings step of the wizard, click Advanced. 

2. Click the vSphere tab.  

3. Select the Enable VMware tools quiescence check box to freeze the file system of processed 
VMs during replication. Depending on the VM version, Veeam Backup & Replication will use 
the VMware FileSystem Sync Driver (vmsync) driver or VMware VSS component in VMware 
Tools for VM snapshot creation. These tools are responsible for quiescing the VM file system 
and bringing the VM to a consistent state suitable for replication. 

4. In the Changed block tracking section, specify if VMware vSphere CBT must be used for 
replication. By default, this option is enabled. If you want to force using CBT even if CBT is 
disabled at the level of the ESX(i) host, select the Enable changed block tracking for all 
processed VMs check box. 

Important! 

 

You can use CBT only for VMs with virtual hardware version 7 or later. 
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Integration Settings 

On the Integration tab, define whether you want to use the Backup from Storage Snapshots 
technology to create a VM replica. Backup from Storage Snapshots lets you leverage storage 
snapshots for VM data processing. The technology improves RPOs and reduces the impact of 
replication activities on the production environment. 

To specify storage integration settings for the replication job: 

1. At the Job Settings step of the wizard, click Advanced. 

2. Click the Integration tab.  

3. By default, the Enable backup from storage snapshots option is enabled. If you do not 
want to use Backup from Storage Snapshots, clear this check box. For more information, see 
Performing Backup from Storage Snapshots.  

4. If you add to the job many VMs whose disks are located on the same volume or LUN, select 
the Limit processed VM count per storage snapshot to check box and specify the number 
of VMs for which one storage snapshot must be created. In a regular job processing course, 
Veeam Backup & Replication creates a VMware snapshot for every VM added to the job and 
then triggers one storage snapshot for all VMs. In some situations, creating VMware 
snapshots for all VMs may require a lot of time. If you limit the number of VMs per storage 
snapshot, Veeam Backup & Replication will divide VMs into several groups, trigger a separate 
storage snapshot for every VM group and read VM data from these snapshots. As a result, the 
job performance will increase. 

For example, you add to the job 30 VMs whose disks are located on the same volume and set 
the Limit processed VM count per storage snapshot to option to 10. 
Veeam Backup & Replication will divide all VMs into 3 groups and create 3 storage snapshots 
from which it will read VM data. 

5. If the backup infrastructure is configured incorrectly, for example, the backup proxy does not 
meet the necessary requirements, Backup from Storage Snapshots will fail and VMs residing 
on the storage systems will not be processed by the job at all. To fail over to the regular VM 
processing mode and process such VMs in any case, select the Failover to standard backup 
check box.  
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Script Settings 

To specify script settings for the replication job: 

1. At the Job Settings step of the wizard, click Advanced. 

2. Click the Scripts tab.  

3. If you want to execute custom scripts before and/or after the replication job, select the Run 
the following script before the job and Run the following script after the job check boxes 
and click Browse to choose executable file(s).  

You can select to execute pre- and post-replication actions after a number of job sessions or 
on specific week days. 

 If you select the Run scripts every... backup session option, specify the number of 
the replication job sessions after which the script(s) must be executed.  

 If you select the Run scripts on selected days only option, click Days and specify 
week days on which the script(s) must be executed. 

Note: 

 

Custom scripts that you define in the advanced job settings relate to the replication job itself, not the 
VM quiescence process. To add pre-freeze and post-thaw scripts for VM image quiescence, use the 
Guest Processing step of the wizard. 
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Step 12. Specify Data Transfer Settings 

At the Data Transfer step of the wizard, select backup infrastructure components that must be used 
for the replication process and choose a path for VM data transfer. 

1.  If you plan to replicate VM data within one site, the same backup proxy can act as the source 
and target backup proxy. For offsite replication, you must deploy at least one backup proxy in 
each site to establish a stable connection for VM data transfer across sites.  

Click Choose next to the Source proxy and Target proxy fields to select backup proxies for 
the job. In the Backup Proxy window, you can choose automatic backup proxy selection or 
assign backup proxies explicitly. 

 If you choose Automatic selection, Veeam Backup & Replication will detect 
backup proxies that have access to the source and target datastores and 
automatically assign optimal backup proxy resources for processing VM data. 

Veeam Backup & Replication assigns resources to VMs included in the replication 
job one by one. Before processing a new VM from the list, 
Veeam Backup & Replication checks available backup proxies. If more than one 
backup proxy is available, Veeam Backup & Replication analyzes transport modes 
that the backup proxies can use and the current workload on the backup proxies to 
select the most appropriate backup proxy for VM processing. 

 If you choose Use the selected backup proxy servers only, you can explicitly 
select backup proxies that the job can use. It is recommended that you select at 
least two backup proxies to ensure that the job will be performed if one of backup 
proxies fails or loses its connectivity to the source datastore. 

2. Select a path for VM data transfer: 

 To transport VM data directly via the backup proxy(ies) to the target datastore, 
select Direct. 

 To transport VM data via WAN accelerators, select Through built-in WAN 
accelerators. From the Source WAN accelerator list, select the WAN 
accelerator configured in the source site. From the Target WAN accelerator 
list, select the WAN accelerator configured in the target site. 
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Step 13. Define Seeding and Mapping Settings 

The Seeding step is available if you have selected the Low connection bandwidth option at the 
Name step of the wizard. You can use this step to configure replica seeding and mapping for the 
replication job. 

If you use replica seeding or mapping, make sure that you select correct backup infrastructure 
components for the job: source-side backup repository for metadata and backup proxies. It is 
recommended that you explicitly assign backup proxies in the production site and DR site. For more 
information, see Step 12. Specify Data Transfer Settings. 

Configuring Replica Seeding 

If you plan to replicate to a remote DR site over the WAN or low-bandwidth network, you can use 
replica seeding. Replica seeding helps reduce the amount of VM data transferred over the network. 

Replica seeding can be used if you have a backup for the replicated VM on the backup repository 
located in the DR site. In this case, you can point the replication copy job to this backup. During the 
first session of the replication job, Veeam Backup & Replication will use this backup file as a "seed". 
Veeam Backup & Replication will restore the VM image from the backup and register the VM replica on 
the target host. After that, Veeam Backup & Replication will synchronize the VM replica with the 
source VM. All subsequent incremental replication runs will be performed in the regular manner. 

Before you start a replication job that uses replica seeding, you must perform a number of preparatory 
tasks: 

1. Create a backup (seed) of the VM that you plan to replicate. To do this, configure a backup job 
that points to an onsite backup repository. Run the job to create a full backup.  

If you have previously created a backup containing all necessary VMs, there is no need to 
configure and run a new backup job.  

For seeding, you can use any existing backup created with Veeam Backup & Replication. The 
backup must include VBK and VBM files. If you have a full backup and a chain of forward 
increments, you can use VIB files together with the VBK and VBM files. In this case, 
Veeam Backup & Replication will restore VMs from the seed to the latest available restore 
point. 

2. Copy the backup from the backup repository in the production site to a backup repository in 
the DR site. If you do not have a backup repository in the DR site, you will need to create one.  

You can move the backup using a file copy job or any other appropriate method, for example, 
copy the backup to a removable storage device, ship the device to the DR site and copy 
backups to the backup repository in the DR site. 

3. After the backup is copied to the backup repository in the DR site, perform rescan of this 
backup repository. Otherwise, Veeam Backup & Replication will not be able to detect the 
copied backup.  

When you complete the preliminary steps, you can configure replica seeding settings for the job.  

1. In the Initial seeding section, select the Get seed from the following backup repository 
check box.  

2. From the list of backup repositories, select the backup repository in the DR site to where the 
seed (the full backup) resides. 
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When you start the replication job, Veeam Backup & Replication will attempt to restore all VMs added 
to the job from the seed that you have specified. If a VM is not found in the seed, the VM will be 
skipped from replication.  

Important! 

 

You cannot use a backup located on the scale-out backup repository as a seed for a replication job. 

 

Configuring Replica Mapping 

If a replica for the VM that you plan to replicate already exists on the target host in the DR site, you can 
use replica mapping. Replica mapping helps reduce the amount of VM data transferred over the 
network.  

To use replica mapping, you must point the replication job to a VM replica on the host in the DR site. 
During the first session of the replication job, Veeam Backup & Replication will calculate the difference 
between the source VM and VM replica and copy necessary data blocks to synchronize the VM replica 
to the latest state of the source VM. All subsequent incremental replication sessions will be performed 
in the regular manner. 

Tip: 

 

If there is no existing VM replica in the DR site, you can restore a VM from the backup and map it to 
the original VM. 

To set up replica mapping: 

1. Select the Map replicas to existing VMs check box.  

2. Click Detect. Veeam Backup & Replication will scan the destination location to detect existing 
VM replicas. If any matches are found, Veeam Backup & Replication will populate the 
mapping table. 

If Veeam Backup & Replication does not find a match, you can map a VM to its VM replica 
manually. To do this, select a production VM from the list, click Edit and choose an existing 
VM replica. To facilitate selection, use the search field at the bottom of the window. 
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To break a mapping association, select the VM in the list and click Remove. 

 

Configuring Replica Seeding and Replica Mapping 

You configure both replica seeding and replica mapping in the same replication job. For example, if a 
job includes 2 VMs, you can use seeding for one VM and map the other VM to an existing VM replica.  

If replica seeding is enabled in the job settings, all VMs in the job must be covered with seeding or 
mapping. If a VM is neither available in the seed, nor mapped to an existing VM replica, it will be 
skipped from processing. And, on the contrary, if the same VM is available in the seed and mapped to 
an existing replica, replication will be performed using replica mapping as mapping has precedence 
over seeding. 

Step 14. Specify Guest Processing Settings 

At the Guest Processing step of the wizard, you can enable the following settings for VM guest OS 
processing: 

 Application-aware processing 

 Transaction log handling for Microsoft SQL Server 

 Transaction log handling for Oracle 

 VM guest OS file exclusion 

 Use of pre-freeze and post-thaw scripts 

To coordinate guest processing activities, Veeam Backup & Replication deploys a runtime process on 
the VM guest OS. The process runs only during guest processing and is stopped immediately after the 
processing is finished (depending on the selected option, during the replication job session or after 
the replication job completes).  
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You must specify a user account that will be used to connect to the VM guest OS and deploy the 
runtime process:  

1. From the Guest OS credentials list, select a user account with local administrator privileges 
on the VM guest OS. If you have not set up credentials beforehand, click the Manage 
accounts link or click Add on the right to add credentials. For more information, see 
Managing Credentials. 

2. By default, Veeam Backup & Replication uses the same credentials for all VMs in the job. If 
some VM requires a different user account, click Credentials and enter custom credentials for 
the VM. 

3. If you have added Microsoft Windows VMs to the job, specify which guest interaction proxy 
Veeam Backup & Replication can use to deploy the runtime process on the VM guest OS. On 
the right of the Guest interaction proxy field, click Choose. 

 Leave Automatic selection to let Veeam Backup & Replication automatically 
select the guest interaction proxy.  

 Select Use the selected guest interaction proxy servers only to explicitly 
define which servers will perform the guest interaction proxy role. The list of 
servers contains Microsoft Windows servers added to the backup 
infrastructure. 

To check if Veeam Backup & Replication can communicate with VMs added to the job and deploy the 
runtime process on their guest OSes, click Test Now. Veeam Backup & Replication will use the 
specified credentials to connect to all VMs in the list. 

Note: 

 

The guest interaction proxy functionality is available in the Enterprise and Enterprise Plus Editions of 
Veeam Backup & Replication. 

 

  



 

662   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Application-Aware Processing 

If you add to the replication job VMs running VSS-aware applications, you can enable application-
aware processing to create transactionally consistent replicas. The transactionally consistent replica 
guarantees proper recovery of applications on VMs without data loss. 

To enable application-aware processing: 

1. Select the Enable application-aware processing check box. 

2. Click Applications. 

3. In the displayed list, select the VM and click Edit.  

To define custom settings for a VM added as a part of the VM container, you must include the 
VM in the list as a standalone object. To do this, click Add and choose a VM whose settings 
you want to customize. Then select the VM in the list and define the necessary settings. 

4. On the General tab, in the Applications section specify the VSS behavior scenario: 

 Select Require successful processing if you want Veeam Backup & Replication 
to stop the replication process if any VSS errors occur. 

 Select Try application processing, but ignore failures if you want to 
continue the replication process even if VSS errors occur. This option is 
recommended to guarantee completion of the job. The created VM replica 
image will not be transactionally consistent but crash consistent. 

 Select Disable application processing if you do not want to enable 
quiescence for the VM at all. 

5. [For Microsoft Exchange, Microsoft SQL and Oracle VMs] In the Transaction logs section, 
specify if Veeam Backup & Replication must process transaction logs or copy-only backups 
must be created. 

a. Select Process transaction logs with this job if you want 
Veeam Backup & Replication to process transaction logs.  

[For Microsoft Exchange VMs] With this option selected, the runtime process 
running on the VM guest OS will wait for replication to complete successfully and 
then trigger truncation of transaction logs. If the replication job fails, the logs will 
remain untouched on the VM guest OS until the next start of the runtime process.  

[For Microsoft SQL Server VMs and Oracle VMs] You will have to specify settings for 
transaction log handling on the SQL and Oracle tabs of the VM Processing 
Settings window. For more information, see Transaction Log Settings: Microsoft 
SQL and Transaction Log Settings: Oracle. 
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b. Select Perform copy only if you use another backup tool to perform VM guest 
level backup or replication, and this tool maintains consistency of the database 
state. Veeam Backup & Replication will create a copy-only replica for the selected 
VM. The copy only replica preserves the chain of full/differential backup files and 
transaction logs on the VM. For more information, see 
http://msdn.microsoft.com/en-us/library/ms191495.aspx.  

 

Transaction Log Settings: Microsoft SQL Server 

If you replicate a Microsoft SQL VM, you can specify how Veeam Backup & Replication must process 
transaction logs: 

1. At the Guest Processing step of the wizard, select the Enable application-aware 
processing check box. 

2. Click Applications. 

3. In the displayed list, select the Microsoft SQL Server VM and click Edit. 

4. In the Transaction logs section, select Process transaction logs with this job. 

5. In the VM Processing Settings window, click the SQL tab. 

  

http://msdn.microsoft.com/en-us/library/ms191495.aspx
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6. Specify how transaction logs must be processed: 

 Select Truncate logs if you want Veeam Backup & Replication to trigger truncation 
of transaction logs only after the job completes successfully. In this case, the 
runtime process will wait for VM replication to complete and then trigger 
truncation of transaction logs. If the replication job fails, the logs will remain 
untouched on the VM guest OS until the next start of the runtime process. 

 Select Do not truncate logs if you do not want Veeam Backup & Replication to 
truncate logs at all. This option is recommended if you are using another backup 
tool to perform VM guest-level backup or replication, and this tool maintains 
consistency of the database state. In such scenario, Veeam Backup & Replication 
will not trigger transaction log truncation. After you fail over to the necessary 
restore point of the VM replica, you will be able to apply transaction logs to get the 
database system to the necessary point in time between replication job sessions. 
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Transaction Log Settings: Oracle 

If you replicate an Oracle VM, you can specify how Veeam Backup & Replication must process 
transaction logs: 

1. At the Guest Processing step of the wizard, select the Enable application-aware 
processing check box. 

2. Click Applications. 

3. In the displayed list, select the Oracle VM and click Edit. 

4. In the Transaction logs section, select Process transaction logs with this job. 

5. In the VM Processing Settings window, click the Oracle tab. 

6. In the Specify Oracle account with SYSDBA privileges section, specify a user account that 
Veeam Backup & Replication will use to connect to the Oracle database. The account must 
have SYSDBA rights on the Oracle database.  

You can select Use guest credentials in the list of user accounts. In this case, 
Veeam Backup & Replication will use the account specified at the Guest Processing step of 
the wizard to access the VM guest OS and connect to the Oracle database.  

7. In the Archived logs section, specify if Veeam Backup & Replication must truncate 
transaction logs on the Oracle VM: 

 Select Do not truncate archived logs if you want Veeam Backup & Replication to 
preserve archived logs on the VM guest OS. When the replication job completes, 
the runtime process will not truncate transaction logs.  

It is recommended that you select this option for databases for which the 
ARCHIVELOG mode is turned off. If the ARCHIVELOG mode is turned on, transaction 
logs on the VM guest OS may grow large and consume all disk space. In this case, 
the database administrator must take care of transaction logs him-/herself. 
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 Select Truncate logs older than <N> hours or Truncate logs over <N> GB if you 
want Veeam Backup & Replication to truncate archived logs that are older than 
<N> hours or larger than <N> GB. The runtime process running on the VM guest OS 
will wait for the replication job to complete successfully and then trigger 
transaction logs truncation via Oracle Call Interface (OCI). If the job does not 
manage to replicate the Oracle VM, the logs will remain untouched on the VM 
guest OS until the next start of the runtime process. 

 

VM Guest OS File Exclusion 

If you do not want to replicate specific files and folders on the VM guest OS, you can exclude them 
from the VM replica. 

To define what files and folders must be excluded: 

1. At the Guest Processing step of the wizard, select the Enable application-aware 
processing check box. 

2. Click Applications. 

3. In the displayed list, select the VM and click Edit. 

To define custom settings for a VM added as part of a VM container, you must include the VM 
in the list as a standalone object. To do this, click Add and choose a VM whose settings you 
want to customize. Then select the VM in the list and define the necessary settings. 

4. Click the File Exclusions tab and specify what files must be excluded from the VM replica: 

 Select Exclude the following files and folders to remove the individual files and 
folders from the VM replica.  

 Select Include only the following files and folders to leave only the specified files 
and folders in the VM replica. 

5. Click Add and specify what files and folders you want to include or exclude. To form the list of 
exclusions or inclusions, you can use full paths to files and folders, environmental variables 
and file masks with the asterisk (*) and question mark (?) characters. For more information, 
see VM Guest OS Files. 
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6. Click OK. 

7. Repeat steps 5-6 for every object that you want to exclude or include. 

 

Pre-Freeze and Post-Thaw Scripts 

If you plan to replicate VMs running applications that do not support VSS, you can instruct 
Veeam Backup & Replication to run custom pre-freeze and post-thaw scripts for these VMs. The pre-
freeze script quiesces the VM file system and application data to bring the VM to a consistent state 
before Veeam Backup & Replication triggers a VM snapshot. After the VM snapshot is committed, the 
post-thaw script brings the VM and applications to their initial state. 

To specify pre-freeze and post-thaw scripts for the job: 

1. At the Guest Processing step, click Applications. 

2. In the displayed list, select the VM and click Edit.  

3. Click the Scripts tab. 

4. In the Script processing mode section, specify the scenario for scripts execution: 

 Select Require successful script execution if you want 
Veeam Backup & Replication to stop the replication process if the script fails. 

 Select Ignore script execution failures if you want to continue the replication 
process even if script errors occur.  

 Select Disable script execution if you do not want to run scripts for the VM. 

5. In the Windows scripts section, specify paths to pre-freeze and post-thaw scripts for 
Microsoft Windows VMs. Veeam Backup & Replication supports scripts in the EXE, BAT and 
CMD format. 
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6. In the Linux scripts section, specify paths to pre-freeze and/or post-thaw scripts for Linux 
VMs. Veeam Backup & Replication supports scripts of the SH file type. 

If you have added to the job a VM container with Microsoft Windows and Linux VMs, you can 
select to execute both Microsoft Windows and Linux scripts for the VM container. When the 
job starts, Veeam Backup & Replication will automatically determine what OS type is installed 
on the VM and apply corresponding scripts to quiesce this VM. 

Tip: 

 

Beside pre-freeze and post-thaw scripts for VM quiescence, you can instruct 
Veeam Backup & Replication to run custom scripts before the job starts and after the job completes. 
For more information, see Advanced Settings. 
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Step 15. Define the Job Schedule 

At the Schedule step of the wizard, select to run the replication job manually or schedule the job to 
run on a regular basis. 

To specify the job schedule:  

1. Select the Run the job automatically check box. If this check box is not selected, you will 
have to start the job manually to perform VM replication. 

2. Define scheduling settings for the job: 

 To run the job at specific time daily, on defined week days or with specific 
periodicity, select Daily at this time. Use the fields on the right to configure the 
necessary schedule. 

 To run the job once a month on specific days, select Monthly at this time. Use the 
fields on the right to configure the necessary schedule. 

 To run the job repeatedly throughout a day with a set time interval, select 
Periodically every. In the field on the right, select the necessary time unit: Hours or 
Minutes. Click Schedule and use the time table to define the permitted time 
window for the job. In the Start time within an hour field, specify the exact time 
when the job must start.  

The repeatedly run job are started by the following rules: 

– Veeam Backup & Replication always starts counting defined intervals 
from 12:00 AM. For example, if you configure to run a job with a 4-hour 
interval, the job will start at 12:00 AM, 4:00 AM, 8:00 AM, 12:00 PM, 4:00 
PM and so on. 

– If you define permitted hours for the job, after the denied interval is over, 
Veeam Backup & Replication will immediately start the job and then run 
the job by the defined schedule. 

For example, you have configured a job to run with a 2-hour interval and defined 
permitted hours from 9:00 AM to 5:00 PM. According to the rules above, the job will 
first run at 9:00 AM, when the denied period is over. After that, the job will run at 
10:00 AM, 12:00 PM, 2:00 PM and 4:00 PM. 

 To run the job continuously, select the Periodically every option and choose 
Continuously from the list on the right. 

 To chain jobs, use the After this job field. In the common practice, jobs start one 
after another: when job A finishes, job B starts and so on. If you want to create a 
chain of jobs, you should define the time schedule for the first job in the chain. For 
the rest of the jobs in the chain, select the After this job option and choose the 
preceding job from the list.  

3. In the Automatic retry section, define whether Veeam Backup & Replication should attempt 
to run the job again if the job fails for some reason. During a job retry, 
Veeam Backup & Replication processes failed VMs only. Enter the number of attempts to run 
the job and define time spans between them. If you select continuous schedule for the job, 
Veeam Backup & Replication will retry the job for the defined number of times without any 
time intervals between the job sessions. 
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4. In the Backup window section, determine a time interval within which the job must be 
completed. The backup window prevents the job from overlapping with production hours 
and ensures it does not provide unwanted overhead on your production environment. To set 
up a backup window for the job: 

a. Select the Terminate job if it exceeds allowed backup window check box and 
click Window.  

b. In the Time Periods section, define the allowed hours and prohibited hours for VM 
replication. If the job exceeds the allowed window, it will be automatically 
terminated. 

Note: 

 

The After this job function will only start a job if the first job in the chain is started automatically by 
schedule. If the first job is started manually, jobs chained to it will not be started. 
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Step 16. Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of replication job configuration. 

1. Review details of the replication job. 

2. Select the Run the job when I click Finish check box if you want to start the job right after 
you finish working with the wizard.  

3. Click Finish to close the wizard. 

 

  



 

672   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Creating VM Copy Jobs 
With VM copy jobs, you can create a fully-functional copy of a VM and store this copy on the backup 
repository or storage device. VM copying may be helpful if you want to move your datacenter to 
another location, archive a VM before decommisioning and so on.  

To create a VM copy, you must configure a VM copy job. One job can be used to process one VM or 
more VMs.  

You can configure a job and start it immediately or save the job to start it later. Jobs can be started 
manually or scheduled to run automatically at specific time. 

Before creating a VM copy job, check prerequisites. Then use the New VM Copy Job wizard to 
configure a VM copy job.  

Before You Begin 

Before you create a VM copy job, check the following prerequisites: 

 Backup infrastructure components that will take part in the VM copying process must be 
added to the backup infrastructure and properly configured. These include the source ESX(i) 
host and server or backup repository on which you plan to store the VM copy. 

 The target storage device must have enough free space to store created VM copies. To 
receive alerts about low space on the storage device, configure global notification settings. 
For more information, see Specifying Other Notification Settings. 

 If you plan to use pre-freeze and/or post-thaw scripts, you must create scripts before you 
configure the VM copy job.  

Mind the following limitations: 

Due to Microsoft limitations, you cannot use Microsoft Azure Active Directory credentials to perform 
application-aware processing on VMs running Microsoft Windows 10. 
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Step 1. Launch VM Copy Job Wizard 

To run the VM Copy Job wizard, do either of the following:  

• On the Home tab, click VM Copy. 

• Open the Backup & Replication view. In the inventory pane, right-click Jobs and select VM 
Copy. 

• Open the Virtual Machines view, in the working area select the VM(s), click Add to VM Copy 
on the ribbon and select New job or right-click the VM(s) area and select Add to VM copy 
job > New job. In this case, the selected VMs will be automatically added to the VM copy job. 
You can add other VMs to the job when passing through the wizard steps. 

 You can quickly add the VM(s) to an already existing job. To do this, open the Virtual 
Machines view, in the working area select the VM(s) and click Add to VM Copy > name of the 
job on the ribbon or right-click the VM(s) and select Add to VM copy job > name of the job. 

 

  



 

674   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Step 2. Specify Job Name and Description 

At the Name step of the wizard, specify a name and description for the VM copy job. 

1. In the Name field, enter a name for the VM copy job. 

2. In the Description field, provide a description for future reference. The default description 
contains information about the user who created a job, date and time when the job was 
created. 

 

Step 3. Select VMs to Copy 

At the Virtual Machines step of the wizard, select VMs and VM containers that you want to copy.  

Jobs with VM containers are dynamic in their nature. If a new VM is added to the container in the 
virtual infrastructure after the VM copy job is created, Veeam Backup & Replication will automatically 
update the job settings to include the added VM. 

1. Click Add. 

2. Use the toolbar at the top right corner of the window to switch between views: Hosts and 
Clusters, VMs and Templates, Datastores and VMs and Tags. Depending on the view you 
select, some objects may not be available. For example, if you select the VMs and Templates 
view, no resource pools, hosts or clusters will be displayed in the tree. 

3. Select the object and click Add.  

To quickly find the necessary object, you can use the search field at the bottom of the Add Objects 
window. 

1. Click the button to the left of the search field and select the necessary type of object to search 
for: Everything, Folder, Cluster, Host, Resource pool, VirtualApp or Virtual machine.  

2. Enter the object name or a part of it in the search field.  

3. Click the Start search button on the right or press [ENTER]. 
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The initial size of VMs and VM containers added to the VM copy job is displayed in the Size column in 
the list. The total size of objects is displayed in the Total size field. Use the Recalculate button to 
refresh the total size value after you add a new object to the job. 

 

Step 4. Exclude Objects from VM Copy Job 

After you have added VMs and VM containers to the job, you can specify which objects you want to 
exclude from the VM copy. You can exclude the following types of objects: 

 VMs from VM containers 

 Specific VM disks 

 VM templates 

Note: 

 

Veeam Backup & Replication automatically excludes VM log files from VM copies to make copying 
process faster and reduce the size of the resulting file. 
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To exclude VMs from a VM container: 

1. At the Virtual Machines step of the wizard, select a VM container added to the job and click 
Exclusions. 

2. Click the VMs tab.  

3. Click Add. 

4. Use the toolbar at the top right corner of the window to switch between views: Hosts and 
Clusters, VMs and Templates, Datastores and VMs and Tags. Depending on the view you 
select, some objects may not be available. For example, if you select the VMs and Templates 
view, no resource pools, hosts or clusters will be displayed in the tree. 

5. In the displayed tree, select the necessary object and click Add. Use the Show full hierarchy 
check box to display the hierarchy of all VMware Servers added to 
Veeam Backup & Replication.  

6. Click OK. 
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To exclude VM disks: 

1. At the Virtual Machines step of the wizard, select a VM or VM container added to the job and 
click Exclusions. 

2. Click the Disks tab. 

3. Select the VM in the list and click Edit. If you want to exclude disks of a VM added as a part of 
the container, click Add to include the VM in the list as a standalone object. 

4. Choose disks that you want to copy. You can choose to process all disks, 0:0 disks (typically, 
the system disks) or add to the list custom IDE, SCSI or SATA disks.  

5. Select the Remove excluded disks from VM configuration check box. 
Veeam Backup & Replication will modify the VMX file of a copied VM to remove excluded 
disks from the VM configuration. If you use the VM copy to register the VM in a location where 
excluded disks are not accessible with the original paths, you will not have to manually edit 
the VM configuration file to be able to power on the VM. 
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To exclude VM templates: 

1. At the Virtual Machines step of the wizard, select a VM or VM container added to the job and 
click Exclusions. 

2. Click the Templates tab. 

3. Clear the Backup VM templates check box.  

4. If you want to include VM templates into the full VM copy only, leave the Backup VM 
templates check box selected and select the Exclude templates from incremental backup 
check box. 

 

Step 5. Specify Copy Destination 

At the Storage step of the wizard, select which backup proxy must be used for VM data transporting 
and specify the destination for the VM copy. 

1. Click Choose next to the Backup proxy field to select a backup proxy. 

 If you choose Automatic selection, Veeam Backup & Replication will detect 
backup proxies that have access to the source datastore and automatically assign 
an optimal backup proxy for processing VM data. 

Veeam Backup & Replication assigns backup proxies to VMs included in the VM 
copy job one by one. Before processing a new VM in the VM list, 
Veeam Backup & Replication checks available backup proxies. If more than one 
backup proxy is available, Veeam Backup & Replication analyzes transport modes 
that the backup proxies can use for data retrieval and the current workload on the 
backup proxies to select the most appropriate one for VM processing. 

 If you choose Use the selected backup proxy servers only, you can explicitly 
select backup proxies that the job must use. It is recommended that you select at 
least two backup proxies to ensure that the VM copy job starts if one of the proxies 
fails or loses its connectivity to the source datastore. 
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2. In the Copy destination section, select a location where the created VM copy must be stored. 

 Select a backup repository from the list if you want to create a VM copy on the 
backup repository configured in the backup infrastructure. When you select a 
backup repository, Veeam Backup & Replication automatically checks how much 
free space is available on it. 

 Select Server if you want to store the VM copy on a disk or storage device attached 
to the server. From the Server list, select a server added to the backup 
infrastructure. In the Path to folder field, specify a folder on the server where the 
created VM copy must be stored.  

Use the Check button to see how much free space is available in the target 
location. 
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Step 6. Specify Guest Processing Settings 

At the Guest Processing step of the wizard, you can enable the following settings for VM guest OS 
processing: 

 Application-aware processing 

 Transaction log handling for Microsoft SQL Server 

 Transaction log handling for Oracle 

 Use of pre-freeze and post-thaw scripts 

To coordinate guest processing activities, Veeam Backup & Replication deploys a runtime process on 
the VM guest OS. The process runs only during guest processing and is stopped immediately after the 
processing is finished (depending on the selected option, during the VM copy job session or after the 
replication job completes).  

You must specify a user account that will be used to connect to the VM guest OS and deploy the 
runtime process:  

1. From the Guest OS credentials list, select a user account with local administrator privileges 
on the VM guest OS. If you have not set up credentials beforehand, click the Manage 
accounts link or click Add on the right to add credentials. For more information, see 
Managing Credentials. 

2. By default, Veeam Backup & Replication uses the same credentials for all VMs in the job. If 
some VM requires a different user account, click Credentials and enter custom credentials for 
the VM. 

3. If you have added Microsoft Windows VMs to the job, specify which guest interaction proxy 
Veeam Backup & Replication can use to deploy the runtime process on the VM guest OS. On 
the right of the Guest interaction proxy field, click Choose. 

 Leave Automatic selection to let Veeam Backup & Replication automatically 
select the guest interaction proxy.  

 Select Use the selected guest interaction proxy servers only to explicitly 
define which servers will perform the guest interaction proxy role. The list of 
servers contains Microsoft Windows servers added to the backup 
infrastructure. 
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To check if Veeam Backup & Replication can communicate with VMs added to the job and deploy the 
runtime process on their guest OSes, click Test Now. Veeam Backup & Replication will use the 
specified credentials to connect to all VMs in the list. 

Note: 

 

The guest interaction proxy functionality is available in the Enterprise and Enterprise Plus Editions of 
Veeam Backup & Replication. 

 

Application-Aware Processing 

If you add to the VM copy job VMs running VSS-aware applications, you can enable application-aware 
processing to create a transactionally consistent VM copy. The transactionally consistent VM copy 
guarantees proper recovery of applications on VMs without data loss. 

To enable application-aware processing: 

1. Select the Enable application-aware processing check box. 

2. Click Applications. 

3. In the displayed list, select the VM and click Edit.  

To define custom settings for a VM added as a part of the VM container, you must include the 
VM in the list as a standalone object. To do this, click Add and choose a VM whose settings 
you want to customize. Then select the VM in the list and define the necessary settings. 
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4. On the General tab, in the Applications section specify the VSS behavior scenario: 

 Select Require successful processing if you want Veeam Backup & Replication 
to stop the VM copy process if any VSS errors occur. 

 Select Try application processing, but ignore failures if you want to 
continue the VM copy process even if VSS errors occur. This option is 
recommended to guarantee completion of the job. The created VM image will 
not be transactionally consistent but crash consistent. 

 Select Disable application processing if you do not want to enable 
quiescence for the VM. 

5. [For Microsoft Exchange, Microsoft SQL and Oracle VMs] In the Transaction logs section, 
specify if Veeam Backup & Replication must process transaction logs or copy-only VM copies 
must be created. 

a. Select Process transaction logs with this job if you want 
Veeam Backup & Replication to process transaction logs.  

[For Microsoft Exchange VMs] With this option selected, the runtime process 
running on the VM guest OS will wait for the VM copy job to complete successfully 
and then trigger truncation of transaction logs. If the VM copy job fails, the logs will 
remain untouched on the VM guest OS until the next start of the runtime process.  

[For Microsoft SQL Server VMs and Oracle VMs] You will have to specify settings for 
transaction log handling on the SQL and Oracle tabs of the VM Processing 
Settings window. For more information, see Transaction Log Settings: Microsoft 
SQL and Transaction Log Settings: Oracle. 

b. Select Perform copy only if you use another backup tool to perform VM guest 
level backup or replication, and this tool maintains consistency of the database 
state. Veeam Backup & Replication will create a copy-only VM image for the 
selected VM(s). The copy-only VM image preserves the chain of full/differential 
backup files and transaction logs on the VM. For more information, see 
http://msdn.microsoft.com/en-us/library/ms191495.aspx.  

 

http://msdn.microsoft.com/en-us/library/ms191495.aspx
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Transaction Log Handling: Microsoft SQL Server 

If you copy a Microsoft SQL VM, you can specify how Veeam Backup & Replication must process 
transaction logs: 

1. At the Guest Processing step of the wizard, select the Enable application-aware 
processing check box. 

2. Click Applications. 

3. In the displayed list, select the Microsoft SQL Server VM and click Edit. 

4. In the Transaction logs section, select Process transaction logs with this job. 

5. In the VM Processing Settings window, click the SQL tab. 

6. Specify how transaction logs must be processed: 

 Select Truncate logs if you want Veeam Backup & Replication to trigger truncation 
of transaction logs only after the job completes successfully. In this case, the 
runtime process will wait for the job to complete and then trigger truncation of 
transaction logs. If the VM copy job fails, the logs will remain untouched on the VM 
guest OS until the next start of the runtime process. 

 Select Do not truncate logs if you do not want Veeam Backup & Replication to 
truncate logs at all. This option is recommended if you are using another backup 
tool to perform VM guest-level backup or replication, and this tool maintains 
consistency of the database state. In such scenario, Veeam Backup & Replication 
will not trigger transaction log truncation. After you fail over to the necessary 
restore point of the VM copy, you will be able to apply transaction logs to get the 
database system to the necessary point in time between VM copy job sessions. 
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Transaction Log Handling: Oracle 

If you copy an Oracle VM, you can specify how Veeam Backup & Replication must process transaction 
logs: 

1. At the Guest Processing step of the wizard, select the Enable application-aware 
processing check box. 

2. Click Applications. 

3. In the displayed list, select the Oracle VM and click Edit. 

4. In the Transaction logs section, select Process transaction logs with this job. 

5. In the VM Processing Settings window, click the Oracle tab. 

6. In the Specify Oracle account with SYSDBA privileges section, specify a user account that 
Veeam Backup & Replication will use to connect to the Oracle database. The account must 
have SYSDBA rights on the Oracle database.  

You can select Use guest credentials in the list of user accounts. In this case, 
Veeam Backup & Replication will use the account specified at the Guest Processing step of 
the wizard to access the VM guest OS and connect to the Oracle database.  

7. In the Archived logs section, specify if Veeam Backup & Replication must truncate 
transaction logs on the Oracle VM: 

 Select Do not truncate archived logs if you want Veeam Backup & Replication to 
preserve archived logs on the VM guest OS. When the Vm copy job completes, the 
runtime process will not truncate transaction logs.  

It is recommended that you select this option for databases for which the 
ARCHIVELOG mode is turned off. If the ARCHIVELOG mode is turned on, transaction 
logs on the VM guest OS may grow large and consume all disk space. In this case, 
the database administrator must take care of transaction logs him-/herself. 
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 Select Truncate logs older than <N> hours or Truncate logs over <N> GB if you 
want Veeam Backup & Replication to truncate archived logs that are older than 
<N> hours or larger than <N> GB. The runtime process running on the VM guest OS 
will wait for the VM copy job to complete successfully and then trigger transaction 
logs truncation via Oracle Call Interface (OCI). If the job does not manage to copy 
the Oracle VM, the logs will remain untouched on the VM guest OS until the next 
start of the runtime process. 
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Pre-Freeze and Post-Thaw Scripts 

If you plan to copy VMs running applications that do not support VSS, you can instruct 
Veeam Backup & Replication to run custom pre-freeze and post-thaw scripts for these VMs. The pre-
freeze script quiesces the VM file system and application data to bring the VM to a consistent state 
before Veeam Backup & Replication triggers a VM snapshot. After the VM snapshot is committed, the 
post-thaw script brings the VM and applications to their initial state. 

To specify pre-freeze and post-thaw scripts for the job: 

1. At the Guest Processing step, click Applications. 

2. In the displayed list, select the VM and click Edit.  

3. Click the Scripts tab. 

4. In the Script processing mode section, specify the scenario for scripts execution: 

 Select Require successful script execution if you want 
Veeam Backup & Replication to stop the VM copy process if the script fails. 

 Select Ignore script execution failures if you want to continue the VM copy 
process even if script errors occur.  

 Select Disable script execution if you do not want to run scripts for the VM. 

5. In the Windows scripts section, specify paths to pre-freeze and post-thaw scripts for 
Microsoft Windows VMs. Veeam Backup & Replication supports scripts in the EXE, BAT and 
CMD format. 

6. In the Linux scripts section, specify paths to pre-freeze and/or post-thaw scripts for Linux 
VMs. Veeam Backup & Replication supports scripts of the SH file type. 

If you have added to the job a VM container with Microsoft Windows and Linux VMs, you can 
select to execute both Microsoft Windows and Linux scripts for the VM container. When the 
job starts, Veeam Backup & Replication will automatically determine what OS type is installed 
on the VM and apply corresponding scripts to quiesce this VM. 
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Tip: 

 

Beside pre-freeze and post-thaw scripts for VM quiescence, you can instruct 
Veeam Backup & Replication to run custom scripts before the job starts and after the job completes. 
For more information, see Advanced Settings. 
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Step 7. Define the Job Schedule 

At the Schedule step of the wizard, select to run the VM copy job manually or schedule the job to run 
on a regular basis. 

To specify the job schedule:  

1. Select the Run the job automatically check box. If this check box is not selected, you will 
have to start the job manually to perform VM replication. 

2. Define scheduling settings for the job: 

 To run the job at specific time daily, on defined week days or with specific 
periodicity, select Daily at this time. Use the fields on the right to configure the 
necessary schedule. 

 To run the job once a month on specific days, select Monthly at this time. Use the 
fields on the right to configure the necessary schedule. 

 To run the job repeatedly throughout a day with a set time interval, select 
Periodically every. In the field on the right, select the necessary time unit: Hours or 
Minutes. Click Schedule and use the time table to define the permitted time 
window for the job. In the Start time within an hour field, specify the exact time 
when the job must start.  

The repeatedly run job are started by the following rules: 

– Veeam Backup & Replication always starts counting defined intervals 
from 12:00 AM. For example, if you configure to run a job with a 4-hour 
interval, the job will start at 12:00 AM, 4:00 AM, 8:00 AM, 12:00 PM, 4:00 
PM and so on. 

– If you define permitted hours for the job, after the denied interval is over, 
Veeam Backup & Replication will immediately start the job and then run 
the job by the defined schedule. 

For example, you have configured a job to run with a 2-hour interval and defined 
permitted hours from 9:00 AM to 5:00 PM. According to the rules above, the job will 
first run at 9:00 AM, when the denied period is over. After that, the job will run at 
10:00 AM, 12:00 PM, 2:00 PM and 4:00 PM. 

 To run the job continuously, select the Periodically every option and choose 
Continuously from the list on the right. 

 To chain jobs, use the After this job field. In the common practice, jobs start one 
after another: when job A finishes, job B starts and so on. If you want to create a 
chain of jobs, you should define the time schedule for the first job in the chain. For 
the rest of the jobs in the chain, select the After this job option and choose the 
preceding job from the list.  

3. In the Automatic retry section, define whether Veeam Backup & Replication must attempt to 
run the job again if the job fails for some reason. During a job retry, 
Veeam Backup & Replication processes failed VMs only. Enter the number of attempts to run 
the job and define time spans between them. If you select continuous schedule for the job, 
Veeam Backup & Replication will retry the job for the defined number of times without any 
time intervals between the job sessions. 
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4. In the Backup window section, determine a time interval within which the job must be 
completed. The backup window prevents the job from overlapping with production hours 
and ensures it does not provide unwanted overhead on your production environment. To set 
up a backup window for the job: 

a. Select the Terminate job if it exceeds allowed backup window check box and 
click Window.  

b. In the Time Periods section, define the allowed hours and prohibited hours for VM 
copying. If the job exceeds the allowed window, it will be automatically terminated. 

Note: 

 

The After this job function will only start a job if the first job in the chain is started automatically by 
schedule. If the first job is started manually, jobs chained to it will not be started. 
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Step 8. Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of VM copy job configuration. 

1. Review details of the VM copy job. 

2. Select the Run the job when I click Finish check box if you want to start the job right after 
you finish working with the wizard.  

3. Click Finish to close the wizard. 
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Managing Jobs 
To view all jobs configured on the backup server, open the Backup & Replication view and select the 
Jobs node in the inventory pane. The list of available jobs is displayed in the working area. You can 
edit job properties, start and stop jobs, restart failed jobs, clone jobs, view job statistics and delete 
unnecessary jobs. 
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Editing Job Settings 
You can edit configured jobs at any moment. For example, you may want to change scheduling 
settings for the job or add some VMs to the job. 

To edit job settings: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Jobs. 

3. In the working area, select the job and click Edit on the ribbon or right-click the job and select 
Edit. 

You will follow the same steps as you have followed when creating the job and can change job 
settings as required. 
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Cloning Jobs 
You can create new jobs by means of job cloning. Job cloning allows you to create an exact copy of 
any job with the same job settings. Configuration information of the created job copy are written to 
the configuration database that stores information of the original job.  

To create multiple jobs with similar settings, you can configure a set of jobs that will be used as ‘job 
templates’. You can then clone these 'job templates' and edit settings of cloned jobs as required. 

The name of the cloned job is formed by the following rule: <job_name_clone1>, where job_name is 
the name of the original job and clone1 is a suffix added to the original job name. If you clone the 
same job again, the number in the name will be incremented, for example, job_name_clone2, 
job_name_clone3 and so on.  

When cloning job, Veeam Backup & Replication can change some job settings so that cloned jobs do 
not hinder original jobs. 

 If the original job is scheduled to run automatically, Veeam Backup & Replication disables the 
cloned job. To enable the cloned job, select it in the job list and click Disable on the ribbon or 
right-click the job and select Disable. 

 If the original job is configured to use a secondary target, the cloned job is created without 
the secondary target settings. 

To clone a job: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Jobs.  

3. In the working area, select the job and click Clone on the ribbon or right-click the job and 
select Clone. 

4. After a job is cloned, you can edit all its settings, including the job name. 

Note: 

 

The job cloning functionality is available only in the Enterprise and Enterprise Plus editions of 
Veeam Backup & Replication. 
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Disabling and Removing Jobs 
You can temporary disable scheduled jobs. The disabled job is not deleted from 
Veeam Backup & Replication, it is simply paused for some period of time and is not run by the 
specified schedule. You can enable a disabled job at any time.  

To disable a job: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Jobs.  

3. In the working area, select the job and click Disable on the ribbon or right-click the job and 
select Disable. 

To enable a disabled job, select it in the list and click Disable on the ribbon once again. 

You can permanently remove a job from Veeam Backup & Replication and from the configuration 
database.  

To remove a job: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Jobs.  

3. In the working area, select the job and click Delete on the ribbon or right-click the job and 
select Delete. 

Note: 

 

If you want to permanently remove a backup copy job, you must first stop the synchronization 
process. To do this, disable the backup job. After the job is disabled, you can delete it. 
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Starting and Stopping Jobs 
You can start job manually, for example, if you want to create an additional restore point for a VM 
backup or replica and do not want to change the job schedule. You can also stop a job, for example, if 
VM processing is about to take long, and you do not want the job to produce workload on the 
production environment during business hours. 

Starting Jobs 
To start a job: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Jobs. 

3. In the working area, select the backup job and click Start on the ribbon or right-click the job 
and select Start. 

Stopping Jobs 
You can stop a job in one of the following ways: 

 Stop job immediately. In this case, Veeam Backup & Replication will produce a new restore 
point only for those VMs that have already been processed by the time you stop the job. 

 Stop job after current VM. In this case, Veeam Backup & Replication will produce a new 
restore point only for those VMs that have already been processed and for VMs that are being 
processed at the moment. 

To stop a job: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Jobs. 

3. In the working area, select the backup job and click Stop on the ribbon or right-click the job 
and select Stop. In the displayed window, click Immediately. 
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To stop the job after the current VM: 

1. Open the Backup & Replication view. 

2. In the inventory pane, click Jobs. 

3. In the working area, right-click the job and select Stop. In the displayed window, click 
Gracefully. 
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Starting and Stopping Transaction Log Backup Jobs 
If you create a backup job and instruct it to ship transaction logs, the backup job comprises 2 jobs:  

1. A parent backup job creating an image-level backup of the VM on which the database runs. 
This job is named as a regular backup job, for example: Daily Job. 

2. A transaction log backup job responsible for shipping transaction logs to the backup 
repository. This job is named by the following pattent: <job_name> SQL Backup, for example, 
Daily Job SQL Backup. 

The transaction log backup job is created automatically by Veeam Backup & Replication if it detects 
that you have added to the backup job at least one Microsoft SQL Server or Oracle VM, enabled 
application-aware processing and instructed Veeam Backup & Replication to back up transaction logs 
periodically.  

Starting Transaction Log Backup Jobs 
A parent backup job is started manually when you click Start on the toolbar, or automatically by 
schedule. The transaction log backup job is initially started when you enable schedule for the parent 
backup job. The transaction log backup works continuously in the background. A new session of the 
transaction log backup job starts every time the parent backup job is launched. 

Stopping Transaction Log Backup Jobs 
You can stop transaction log processing in one of the following ways: 

 Disable transaction log shipping 

 Disable the parent backup job 

If you want the backup job to create image-level backups of the VM but do not want it to ship 
transaction logs anymore, you can disable transaction log backup in the backup job settings. 

To disable transaction log shipping: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Jobs. 

3. In the working area, select the backup job and click Edit on the ribbon or right-click the 
backup job and select Edit. 

4. Pass to the Guest Processing step of the wizard and click Applications. 

5. In the Application-Aware Processing Options window, select the VM and click Edit. 

6. On the SQL or Oracle tab of the VM Processing Settings window, disable transaction log 
backup. 

7. Save the job settings. 

If you do not want to create image-level backups of the VM and back up database transaction logs, 
you can disable scheduling for the parent backup job. Veeam Backup & Replication will instruct the 
transaction log backup job to complete log processing for all VMs added to the parent backup job, 
and will switch the parent backup job to the Not scheduled mode. The parent backup job will no 
longer be started automatically by schedule — you will have to run it manually. 
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To disable scheduling for the parent backup job: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Jobs. 

3. In the working area, right-click the backup job and select Edit. 

4. Pass to the Schedule step of the wizard and clear the Run the job automatically check box. 

Alternatively, you can disable the parent backup job: 

1. Open the Backup & Replication view. 

2. In the inventory pane, click Jobs. 

3. In the working area, click the backup job and click Disable on the ribbon or right-click the job 
and select Disable. 

To re-activate transaction log processing for all VMs in the parent backup job, select the job in the list 
and click Disable on the ribbon once again. 
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Reconfiguring Jobs with Microsoft SQL Server VMs 
In some situations, you may need to reconfigure a backup job that processes a Microsoft SQL Server 
VMs and ships transaction logs. For example, you may want to create a separate backup job to process 
the virtualized database, and delete the VM running the database from the previously created job. 

When you configure a new job, mind the restriction on transaction logs shipping. By default, the new 
backup job that processes the VM will not ship transaction logs if transaction logs for this VM have 
been shipped for the last 7 days by another backup job on the same backup server.  

To overcome this restriction, you can reconfigure the backup jobs.  

Important! 

 

The procedure below is required only if you do not want to delete the initial backup job. 

1. Remove the Microsoft SQL Server VM from the initial backup job.  

As an alternative, you can disable transaction logs shipping in the job properties: in the guest 
processing settings, select the Do not truncate or Perform copy-only option. 

2. In the registry on the backup server, locate the SqlBackupLogsAgeDaysToSkipLogBackup 
registry key and set its value to 0 or delete transaction logs for the Microsoft SQL Server VM 
from the backup repository. 

3. Create a new backup job to process the Microsoft SQL Server VM and enable transaction log 
shipping in the job properties. 

4. It is strongly recommended that you delete the SqlBackupLogsAgeDaysToSkipLogBackup 
registry key in a week. In this case, if the VM is added to several jobs, transaction logs will not 
be shipped to different backup repositories. 
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Managing Backups and Replicas 
You can perform the following operations with created backups and replicas:  

 Viewing properties 

 Removing from configuration 

 Deleting from disks 

 Removing missing restore points 
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Viewing Properties 
You can view summary information about created backups and replicas. The summary information 
provides the following data: 

 For backups: available restore points, date of restore points creation, compression and 
deduplication ratios, data size and backup size. 

 For replicas: available restore points, date of restore points creation, data size and replica 
status. 

To view summary information for backups and replicas: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Backups or Replicas. 

3. In the working area, right-click the backup or replica and select Properties. 
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Removing from Configuration 
You can use the Remove from configuration operation if you want to remove records about backups 
and replicas from the Veeam Backup & Replication console and configuration database. Backup files 
themselves (VBK, VIB, VRB, VBM) remain on the backup repository — you can import these files later to 
the Veeam Backup & Replication console and perform restore operations. Replicated VMs also remain 
on target hosts. If necessary, you can start them manually after the Remove from configuration 
operation is performed. 

Mind the following: 

 [For VM backups] When you remove an encrypted backup from configuration, 
Veeam Backup & Replication removes encryption keys from the configuration database, too. 
If you import such backup on the same backup server or another backup server, you will have 
to specify the password or unlock the backup with Veeam Backup Enterprise Manager. For 
more information, see Importing Encrypted Backups. 

 [For VM replicas] The Remove from configuration operation can be performed only for VM 
replicas in the Ready state. If the VM replica is in the Failover or Failback state, this option will 
be disabled. 

To remove records about VM backups and replicas from the Veeam Backup & Replication console and 
configuration database: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Backups or Replicas. 

3. In the working area, select the backup or replica and click Remove from > Configuration on 
the ribbon. You can also right-click the backup or replica and select Remove from 
configuration. 
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Deleting from Disk 
You can use the Delete from disk operation if you want to delete records about backups and replicas 
from the Veeam Backup & Replication console and database and, additionally, delete backup and 
replica files themselves from the destination storage.  

Mind the following: 

 Do not delete backup and replica files from the destination storage manually. Use the Delete 
from disk option instead. If you delete backup or replica files manually, subsequent backup 
or replication job sessions will fail. 

 [For VM backups] The Delete from disk operation can be performed for the whole backup or 
for separate VMs in the backup. 

 [For VM replicas] The Delete from disk operation can be performed only for VM replicas in 
the Ready state. If the VM replica is in the Failover or Failback state, this option will be 
disabled.  

To delete backup and replica files from disk: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Backups or Replicas. 

3. In the working area, select the backup, separate VM in the backup or VM replica and click 
Remove from > Disk on the ribbon. You can also right-click the backup or VM replica and 
select Delete from disk.  
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Removing Missing Restore Points 
In some cases, one or more restore points in the backup chain may be not accessible. This can happen, 
for example, if the backup repository is put to the maintenance mode (for scale-out backup 
repositories), the backup repository is not available or some backup file is missing in the backup chain. 
Backup chains that contain missing restore points get corrupted — you cannot perform backup or 
restore VM data from the missing restore point, and restore points that depend on the missing restore 
point. 

You can perform two operations with missing restore points: 

 Forget — you can remove records about missing restore points from the configuration 
database. Veeam Backup & Replication will “forget” about missing restore points and will not 
display them in the console. The backup files themselves will remain on disk (if backup files 
are still available). 

 Delete — you can remove records about missing restore points from the configuration 
database and delete backup files from disk (if backup files are still available). 

To remove records about missing restore points from the configuration database: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Disk under Backups. 

3. In the working area, select the backup and click Properties on the ribbon or right-click the 
backup and select Properties. 

4. In the Backup Properties window, right-click the missing restore point and select Forget.  

 To remove only the selected restore point and restore points that depend on it 
(that is, a part of the backup chain starting from this restore point), select This 
and dependent backups. 

 To remove all missing restore points, select All unavailable backups. 
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To remove missing restore points from the configuration database and disk: 

1. Open the Backup & Replication view.  

2. In the inventory pane, click Disk under Backups. 

3. In the working area, select the backup and click Properties on the ribbon or right-click the 
backup and select Properties. 

4. In the Backup Properties window, right-click the missing restore point and select Delete 
from disk.  

 To remove only the selected restore point and restore points that depend on it 
(that is, a part of the backup chain starting from this restore point), select This 
and dependent backups. 

 To remove all missing restore points, select All unavailable backups. 
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Importing Backups 
You may need to import backups to Veeam Backup & Replication in the following situations: 

 The backup server has failed and you have restored it in a new location. You want to restore 
VM data from backups created by the backup server that has failed. 

 You want to restore VM data from backups created on another backup server. 

 You want to restore VM data from backups on the backup repository that is not added to the 
backup infrastructure (for example, if you removed it earlier). 

 You want to restore VM data from VeeamZIP files created on your backup server or another 
backup server. 

The imported backup becomes available in the Veeam Backup & Replication console. You can use any 
restore operation to recover VM data from this backup. 

Before importing a backup, check the following prerequisites: 

 The server from which you plan to import backups must be added to the backup 
infrastructure. Otherwise you will not be able to access backup files. 

 To be able to restore VM data from previous backup restore points, make sure that you have 
all required incremental backup files (forward or reverse) in the same folder where the full 
backup file resides. 
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To import a backup to the Veeam Backup & Replication console: 

1. On the Home tab, click Import Backup. 

2. From the Computer list, select the server on which the backup you want to import is stored. 

3. Click Browse and select the necessary VBM or VBK file. If you select the VBM file, the import 
process will be notably faster. It is recommended that you select the VBK file only if the VBM 
file is not available. 

4. By default, index data of the VM guest OS file system is not imported with the backup to 
speed up the import process. If you want to import index data, select the Import guest file 
system index check box. 

5. Click OK to import the backup. The imported backup will be displayed in the Backup & 
Replication view, under the Backups > Imported node in the inventory pane. Backups are 
imported using the original name of the backup job with the _imported suffix appended. 
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Importing Encrypted Backups 
You can import backups that were encrypted on this backup server or on another backup server.  

To import an encrypted backup file: 

1. On the Home tab, click Import Backup. 

2. From the Computer list, select the host on which the backup you want to import is stored. 

3. Click Browse and select the VBM or VBK file.  

4. Click OK. The encrypted backup will appear under the Backups > Disk (encrypted) node in 
the inventory pane.  

5. In the working area, select the imported backup and click Specify Password on the ribbon or 
right-click the backup and select Specify password. 

6. In the Password field, enter the password for the backup file. 

If you changed the password one or several times while the backup chain was created, you 
must enter passwords in the following manner: 

 If you select a VBM file for import, you must specify the latest password that 
was used to encrypt files in the backup chain. 

 If you select a VBK file for import, you must specify the whole set of passwords 
that were used to encrypt files in the backup chain.  

If you enter correct password(s), Veeam Backup & Replication will decrypt the backup file. The backup 
will be moved under the Backups > Disk (imported) node in the inventory pane.  

Note: 

 

If you use Enterprise or Enterprise Plus Edition of Veeam Backup & Replication and your backup 
servers are connected to Veeam Backup Enterprise Manager, you can recover data from encrypted 
backups even if the password is lost. For more information, see Decrypting Data Without Password. 
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Importing Transaction Logs 
You cannot import transaction log backups without VM backups (as there will be no restore point to 
which the transaction logs can be applied).  

To import a VM backup with transaction log backups, do either of the following: 

 Import a backup metadata file (VBM). In this case, Veeam Backup & Replication will 
automatically import the database backup and log backups.  

 Import a full backup file (VBK). In this case, Veeam Backup & Replication will browse to 
corresponding log backups and import them, too. 
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Importing Backup Files from Scale-Out Backup Repositories 
You cannot import a backup directly from the scale-out backup repository. When you perform backup 
import, you cannot browse through all extent of the scale-out backup repository. 
Veeam Backup & Replication lets you browse only though individual extents. 

To import a backup from the scale-out backup repository, you must place backup files from all extents 
to one staging folder. The staging folder can reside on any server added to the backup infrastructure. 
After that, you can import the backup as usual. 
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Creating VeeamZIP Files 
You can quickly back up running and powered off VMs with VeeamZIP. Creating a VeeamZIP file can 
be helpful if you want create an ad-hoc backup for VMs, archive VMs before decommissioning and so 
on. You can create a VeeamZIP file for one or more VMs. 

To create a VeeamZIP file: 

1. Open the Virtual Machines view. 

2. In the infrastructure tree, select a host or VM container in which the VM(s) that you want to 
back up reside. 

3. In the working area, select the VM(s) and click VeeamZIP > VeeamZIP on the ribbon or right-
click the VM(s) and select VeeamZIP. 

To quickly find the necessary VM(s), type the VM name or a part of it in the search field at the 
top of the working area and click the Start search button on the right or press [ENTER]. 

4. In the Destination section of the VeeamZIP <N> VM window, specify a location in which 
you want to store the VeeamZIP file. 

 To store the VeeamZIP file in a backup repository, select Backup repository and 
choose the necessary backup repository from the list. 

 To store the VeeamZIP file in a local folder on the backup server, select Local or 
shared folder, click Browse on the right and select a folder in which the VeeamZIP 
file must be stored. 

 To store a VeeamZIP file in a shared folder, select Local or shared folder and type 
in the UNC name of the shared folder in the field below. Keep in mind that the UNC 
name always starts with two back slashes (\\). 

If the shared folder requires authentication, select the necessary credentials from 
the Credentials list. If you have not set up credentials beforehand, click the 
Manage accounts link or click Add on the right to add necessary credentials. For 
more information, see Managing Credentials. 

5. Use the Delete this backup automatically list to specify retention settings for the created 
VeeamZIP file. By default, VeeamZIP files are not removed and kept in the specified location 
for an indefinite period of time. 

6. To encrypt the VeeamZIP file, select the Enable backup file encryption check box. From the 
Password list, select a password that you want to use to encrypt the VeeamZIP file. If you 
have not created a password beforehand, click Add or use the Manage passwords link to 
specify a new password. For more information, see Managing Passwords for Data Encryption. 

7. From the Compression level list, select a compression level for the created backup: None, 
Dedupe-friendly, Optimal, High or Extreme. 

8. By default, Veeam Backup & Replication uses VMware Tools quiescence to create a 
transactionally consistent image of VMs. You can disable VM quiescence. To do this, select the 
Disable guest quiescence check box. In this case, Veeam Backup & Replication will create a 
crash-consistent VM backup. 

9. Click OK. The VeeamZIP task will start immediately. Veeam Backup & Replication will create a 
full backup file (VBK) and store it in the specified location. The VM name, date and time of the 
file creation are appended to the file name so you can easily find the necessary VeeamZIP file 
afterwards. 

10. As the job runs, you can track the job performance in the real-time mode. To see the job 
results once it completes, open the History view, expand the Jobs node and click Backup. 
Then double-click the job session in the list. 
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Tip: 

 

Veeam Backup & Replication keeps settings of the latest VeeamZIP task. To quickly create a 
VeeamZIP file with the same settings as the previous one and store it in the same location, right-click 
the necessary VM and select VeeamZIP to. The VeeamZIP task with the same settings as the previous 
task will start immediately. 
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Performing Active Full Backup 
You can create an ad-hoc full backup — active full backup, and add it to the backup chain on the 
backup repository. The active full backup resets the backup chain. All subsequent incremental 
backups use the active full backup as a starting point. The previously used full backup will remain on 
the backup repository until it is removed from the backup chain according to the retention policy. 

To perform active full backup: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Jobs. 

3. In the working area, select the job and click Active Full on the ribbon or right-click the job 
and select Active Full. 
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Performing Quick Backup 
You can create an ad-hoc incremental backup for one or more VMs — quick backup, and add it to the 
backup chain on the backup repository. Quick backup can be helpful if you want to produce an 
additional restore point for one or more VMs in the backup job and do not want to configure a new 
job or modify the existing one.  

Quick backup can be performed for VMs that meet the following requirements: 

1.  A backup job processing the VM exists on the backup server. 

2. A full backup file for the VM exists on the backup repository configured in the backup 
infrastructure. 

To perform quick backup: 

1. Open the Virtual Machines view.  

2. In the infrastructure tree, select a host or VM container in which the VM(s) that you want to 
back up reside. 

3. In the working area, select the VMs and click Quick Backup on the ribbon. You can also right-
click the VM(s) and select Quick Backup. 

Veeam Backup & Replication will trigger a backup job to create a new incremental restore 
point for selected VM(s). Details of a running quick backup task are displayed in the job 
session window. 
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Working with Backup Copy Jobs 
To let you adopt the 3-2-1 backup strategy, Veeam Backup & Replication offers the backup copy job. 
Backup copy jobs allow you to create several instances of the same backup file in different locations, 
onsite or offsite. Copied backup files have the same format as those created by primary backup jobs, 
and you can use any data recovery option for them. 
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Creating Backup Copy Jobs 
To copy a VM backup to a secondary location, you must configure a backup copy job. The backup 
copy job defines how, where and when to copy VM backups. One job can be used to process backups 
of one or more VMs. 

You can configure a job and start it immediately or save the job to start it later. Jobs can be started 
manually or scheduled to run automatically at specific time. 

Before creating a job, check prerequisites. Then use the New Backup Copy Job wizard to configure a 
backup copy job. 

Before You Begin 

Before you create a backup copy job, check the following prerequisites: 

 Backup infrastructure components that will take part in the backup copy process must be 
added to the backup infrastructure and properly configured. These include source and target 
backup repositories between which VM backups must be copied.  

 The target backup repository must have enough free space to store copied VM backups. To 
receive alerts about low space on the backup repository, configure global notification 
settings. For more information, see Specifying Other Notification Settings. 

 If you plan to use pre-job and/or post-job scripts, you must create scripts before you 
configure the backup copy job. 

 [For backup mapping] The backup copy job can be mapped to a backup if the backup chain is 
created with the incremental backup method. You cannot map the backup copy job to a 
backup if the backup chain is created with the reverse incremental backup method or 
contains both incremental and reverse incremental restore points (for example, if the backup 
chain was transformed). 

If you plan to use WAN accelerators for backup copying, check the following prerequisites: 

 Source and target WAN accelerators must be added to the backup infrastructure and properly 
configured. For more information, see Configuring WAN Accelerators. 

 A license for Enterprise Plus Edition for Veeam Backup & Replication must be installed on the 
backup server.  

 It is recommended that you pre-populate the global cache on the target WAN accelerator 
before you start the backup copy job. Global cache population helps reduce the amount of 
traffic transferred over the WAN. For more information, see Populating Global Cache.  
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Step 1. Launch New Backup Copy Job Wizard 

To run the New Backup Copy Job wizard, do one of the following: 

 On the Home tab, click Backup Copy and select the necessary platform: VMware or vCloud. 

 Open the Backup & Replication view, in the inventory pane right-click Jobs and select 
Backup Copy > VMware or vCloud. 

 Open the Backup & Replication view, right-click anywhere in the working area and select 
Backup Copy > VMware or vCloud. 

 

Step 2. Specify Job Name and Description 

At the Job step of the wizard, specify basic settings for the backup copy job.  

1. In the Name field, enter a name for the job.  

2. In the Description field, enter a description for the job. The default description contains 
information about the user who created the job, date and time when the job was created. 

3. The backup copy job runs continuously. The synchronization process starts at specific time 
intervals. During this synchronization interval, Veeam Backup & Replication copies new 
restore points from the source backup repository to the target backup repository.  

In the Copy every field, specify the time interval according to which the synchronization 
process must start. By default, the synchronization interval is set to 1 day. This means that the 
backup copy job will create a new synchronization interval once a day. 
Veeam Backup & Replication will check if new restore points are available on the source 
backup repository. If a new restore point is found, it will be copied to the target backup 
repository within the synchronization interval. For more information, see Synchronization 
Interval.  
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4. If you have selected a daily synchronization interval, specify the start time for it. By default, 
the daily synchronization interval starts at 12:00 AM. 

The defined synchronization interval may not be enough to copy a VM restore point. If such 
situation occurs, Veeam Backup & Replication will display a warning in the job session results. 
In this case, it is recommended that you increase the synchronization interval time. 

 

Step 3. Select VMs to Process 

At the Virtual Machines step of the wizard, select VMs whose restore points you want to copy to the 
target backup repository.  

1. Click Add. 

2. Select the VM(s) that you want to process with the job. You can use the following source to 
browse to VMs: 

 From infrastructure. You can browse the virtual infrastructure to add single VMs 
or VM containers to the job. When a backup copy job runs, 
Veeam Backup & Replication will search for restore points of selected VM(s) on all 
backup repositories in the backup infrastructure. You can limit the search scope by 
selecting only specific backup repositories for the backup copy job. 

 From backups. You can select VMs from backups. When a backup copy job runs, 
Veeam Backup & Replication will search for restore points of selected VM(s) in all 
backups created on the backup server. You can limit the search scope by selecting 
only specific backup repositories for the backup copy job. 

 From jobs. You can select VMs from backup jobs. When a backup copy job runs, 
Veeam Backup & Replication will search for restore points of selected VM(s) in 
backups created for selected jobs. 

  



 

719   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

You can create a backup copy job with an empty source — that is, not add any VMs or jobs at this step 
of the wizard. In this case, you will need to configure a secondary destination for the initial backup job 
and link it to the created backup copy job. When you save the backup job settings, 
Veeam Backup & Replication will automatically update the backup copy job and link it to the initial 
backup job. For more information, see Linking Backup Jobs to Backup Copy Jobs. 
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Step 4. Exclude Objects from the Backup Copy Job 

If you have added VM containers to the list of processed VMs, you can specify which objects you want 
to exclude from the backup copy job. 

1. At the Virtual Machines step of the wizard, select a VM container added to the job and click 
Exclusions. 

2. Click the VMs tab.  

3. Click Add. 

4. Use the toolbar at the top right corner of the window to switch between views. Depending 
on the view you select, some objects may not be available. For example, if you select the VMs 
and Templates view, no resource pools, hosts or clusters will be displayed in the tree. 

5. In the displayed tree, select the necessary object and click Add. Use the Show full hierarchy 
check box to display the hierarchy of all hosts added to Veeam Backup & Replication.  

6. Click OK. 
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Step 5. Select Source Backup Repositories 

By default, Veeam Backup & Replication searches for restore points on all backup repositories 
configured in the backup infrastructure. However, you can select backup repositories in which 
Veeam Backup & Replication must search for restore points of selected VM(s).  

1. At the Virtual Machines step of the wizard, click Source. 

2. Choose backup repositories on which restore points must be searched for. You can select all 
backup repositories configured in the backup infrastructure or define specific backup 
repositories.  

Important! 

 

You can limit the search scope to backup repositories if you have added VMs to the backup copy job 
using the From infrastructure and From backups options. If you have used the From jobs option, 
the Selected backup repositories only option will not be applied, and Veeam Backup & Replication 
will retrieve VM data from the backup repository where the backup created with the source backup 
job resides. 
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Step 6. Define VM Processing Order 

You can define the order in which the backup copy job must process VMs. Setting VM order can be 
helpful, for example, if you have added some mission-critical VMs to the job and want the job to 
process them first. You can set these VMs first in list to ensure that their processing fits the backup 
window. 

VMs inside a VM container are processed at random. To ensure that VMs are processed in the defined 
order, you must add them as standalone VMs, not as part of the VM container. 

To define VM backup order: 

1. At the Virtual Machines step of the wizard, select a VM or VM container added to the job. 

2. Use the Up and Down buttons on the right to move the VM or VM container up or down in 
the list. 

 

Step 7. Define the Backup Copy Target 

At the Target step of the wizard, define the target backup repository for the backup copy job and 
retention policy settings.  

1. From the Backup repository list, select a backup repository in the target site where copied 
backups must be stored. When you select a target backup repository, 
Veeam Backup & Replication automatically checks how much free space is available on it. 
Make sure that you have enough free space to store copied backups. 

2. In the Restore points to keep field, specify the number of restore points that must be 
retained on the target backup repository. When this number is exceeded, 
Veeam Backup & Replication will remove the earliest restore point from the backup chain.  

The maximum number of restore points for the backup copy job is 999. For more information, 
see Simple Retention Policy. 

3. To use the GFS (Grandfather-Father-Son) retention scheme, select the Keep the following 
restore points for archival purposes check box. In the fields below, define the number of 
daily, weekly, monthly, quarterly and yearly full intervals for which backups must be retained. 
Use the Schedule button to define the time schedule by which GFS full backups must be 
created. For more information, see GFS Retention Policy. 
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4. If you do not want Veeam Backup & Replication to synthesize archive backup files on the 
target backup repository, select the Read the entire restore point from source backup 
instead of synthesizing it from increments check box. Veeam Backup & Replication will 
transport data for archive full backups from restore points from the source backup repository 
to the target backup repository over the network. The load on the network will be higher but 
the performance of the target backup repository will increase. For more information, see 
Active Full Method for Archive Backups. 

Important! 

 

You cannot enable GFS retention settings if you use a backup repository with rotated drives as the 
target backup repository.  
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Step 8. Map a Backup File 

If you plan to copy backups over the WAN or slow connections, you can use backup mapping.  

To map a backup copy job to the backup file: 

1. Click the Map backup link.  

2. Point the backup copy job to the backup on the target backup repository. Backups on the 
target backup repository can be easily identified by backup job names. To facilitate search, 
you can use the search field at the bottom of the window. 
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Step 9. Specify Advanced Settings 

At the Target step of the wizard, you can specify the following settings for the backup copy job: 

 Backup settings 

 Storage settings 

 Notification settings 

 Script settings 

Tip: 

 

After you specify necessary settings for the backup copy job, you can save them as default settings. 
To do this, click Save as Default at the bottom left corner of the Advanced Settings window. When 
you create a new backup copy job, Veeam Backup & Replication will automatically apply the default 
settings to the new job.  

Backup Settings 

To specify settings for backup files stored in the target backup repository: 

1. At the Target step of the wizard, click Advanced. 

2. If you want to periodically perform a health check of the most recent restore point in the 
backup chain, select the Perform backup files health check check box and specify the time 
schedule for the health check. By default, the health check is performed on the last Saturday 
of every month.  

An automatic health check allows you to avoid a situation when a restore point gets 
corrupted, making all further increments corrupted, too. If Veeam Backup & Replication 
detects corrupted data blocks in the restore point during the health check, it will transfer 
these data blocks to the target backup repository during the next synchronization interval 
and store them in the newly copied restore point. For more information, see Health Check for 
Copied Backups. 

3. Select the Remove deleted VMs data after <N> days check box and specify the retention 
policy settings for deleted VMs. If a VM is no longer processed by a job for some reason (for 
example, it was excluded from the job, removed from the virtual infrastructure and so on), its 
data may still be kept in backups on the target backup repository. To avoid this situation, you 
can define the number of days for which data for deleted VMs must be retained.  

By default, the deleted VM retention period is 30 days. Do not set the deleted VM retention 
period to 1 day or a similar short interval. In the opposite case, the backup copy job may work 
not as expected and remove VM data that you still require.  

4. To periodically compact a full backup, select the Defragment and compact full backup file 
check box and specify the schedule for the compacting operation. By default, the compact 
operation is performed on the last Sunday of every month.  

The compact option can be enabled only if you have not specified the GFS settings. During 
the compacting operation, Veeam Backup & Replication creates a new empty VBK file and 
copies to it all data blocks from the full backup file. As a result, the full backup file gets 
defragmented, its size reduces and the speed of writing and reading to/from the file 
increases. For more information, see Compacting a Full Backup File. 

Note: 

 

The Remove deleted VMs data after <N> days option applies only to regular backup chains. 
Veeam Backup & Replication does not remove data for deleted VMs from weekly, monthly, quarterly 
and yearly backups.  
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Storage Settings 

To specify compression, deduplication and encryption settings for backup files stored on target 
backup repository: 

1. At the Target step of the wizard, click Advanced. 

2. Click the Storage tab. 

3. By default, Veeam Backup & Replication performs deduplication before storing VM data on 
the target backup repository. Deduplication provides a smaller size of the resulting backup 
file but may reduce the job performance.  

You can disable data deduplication. To do this, clear the Enable inline data deduplication 
check box. 

4. From the Compression level list, choose a compression level to be used: Auto, None, Dedupe-
friendly, Optimal, High or Extreme. The recommended level of compression for backup copy 
jobs is Auto. In this case, Veeam Backup & Replication uses the compression level specified in 
the properties of the source backup job. For more information, see Compression and 
Deduplication.  
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5. To encrypt the backup file created with the backup copy job, select the Enable backup file 
encryption check box. From the Password field, select a password that you want to use to 
encrypt the backup file. If you have not created a password beforehand, click Add or use the 
Manage passwords link to specify a new password. For more information, see Managing 
Passwords for Data Encryption. 

  

Notification Settings 

To specify notification settings for the backup copy job: 

1. At the Target step of the wizard, click Advanced. 

2. Click the Notifications tab.  

3. Select the Send SNMP notifications for this job check box if you want to receive SNMP traps 
when the job completes successfully. SNMP traps will be sent if you specify global SNMP 
settings in Veeam Backup & Replication and configure software on recipient's machine to 
receive SNMP traps. For more information, see Specifying SNMP Settings.  

4. Select the Send email notifications to the following recipients check box if you want to 
receive notifications by email in case of job failure or success. In the field below, specify a 
recipient’s email address. You can enter several addresses separated by a semicolon. 

Veeam Backup & Replication sends a consolidated email notification once for the specified 
synchronization interval. Even if the synchronization process is started several times within 
the interval, for example, due to job retries, only one email notification will be sent.  

Email notifications will be sent if you configure global email notification settings in 
Veeam Backup & Replication. For more information, see Configuring Global Email Notification 
Settings. 

5. You can choose to use global notification settings or specify custom notification settings. 

 To receive a typical notification for the job, select Use global notification 
settings. In this case, Veeam Backup & Replication will apply to the job global 
email notification settings specified for the backup server. For more 
information, see Configuring Global Email Notification Settings. 
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 To configure a custom notification for a job, select Use custom notification 
settings specified below. You can specify the following notification settings: 

d. In the Subject field, specify a notification subject. You can use 
the following variables in the subject: %Time% (completion 
time), %JobName%, %JobResult%, %VmCount% (number of VMs 
in the job) and %Issues% (number of VMs in the job that have 
been processed with the Warning or Failed status). 

e. Select the Notify on success, Notify on warning and/or Notify 
on error check boxes to receive email notification if data 
processing within the synchronization interval completes 
successfully, fails or completes with a warning. 
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Scripts Settings 

To specify script settings for the backup copy job: 

1. At the Target step of the wizard, click Advanced. 

2. Click the Scripts tab.  

3. If you want to execute custom scripts before and/or after the backup copy job, select the Run 
the following script before the job and Run the following script after the job check boxes 
and click Browse to choose executable file(s).  

You can select to execute pre- and post-replication actions after a number of synchronization 
cycles or on specific week days. 

 If you select the Run scripts every... backup session option, specify the number of 
synchronization cycles after which the script(s) must be executed.  

 If you select the Run scripts on selected days only option, click Days and specify 
week days on which the script(s) must be executed. 
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Step 10. Specify Data Path Settings 

By default, during the backup copy job Veeam Backup & Replication transports VM data directly from 
the source backup repository to target backup repository. This type of transport is recommended if 
you plan to copy backup files over high-speed connections.  

If you plan to copy backup files over the WAN or slow connections, it is recommended that you 
configure a pair of WAN accelerators in the backup infrastructure and copy VM backups via these WAN 
accelerators. WAN accelerators perform global data deduplication, eliminate the need to transport 
redundant blocks of data and reduce the load on the WAN. For more information, see WAN 
Acceleration. 

To use WAN acceleration for the backup copy job: 

1. Select the Through built-in WAN accelerators option. 

2. From the Source WAN accelerator list, select a WAN accelerator configured in the source 
site. 

3. From the Target WAN accelerator list, select a WAN accelerator configured in the target site. 

Be extremely careful when assigning WAN accelerators to the backup copy job. If you make a mistake 
and assign the WAN accelerator in the target site to be used as the source WAN accelerator, VM data 
will go in the backward direction and workload on the WAN will increase.  

You cannot assign one source WAN accelerator to several backup copy jobs that you plan to run 
simultaneously. The source WAN accelerator requires a lot of CPU and RAM resources and cannot be 
shared by a number of backup copy jobs. As an alternative, you can create one backup copy job for all 
VMs you plan to process via one source WAN accelerator.  

The target WAN accelerator, however, can be assigned to several backup copy jobs. For more 
information, see Configuring WAN Accelerators.  
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Step 11. Define the Backup Copy Window 

At the Schedule step of the wizard, define the time span in which the backup copy job must not 
transport data between source and target backup repositories. For more information, see Backup 
Copy Window.  

To define a backup window for the backup copy job: 

1. Select the During the following time periods only option. 

2. In the schedule box, select the desired time area. 

3. Use the Enable and Disable options to mark the selected area as allowed or prohibited for 
the backup copy job.  
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Step 12. Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of backup copy job configuration. 

1. Review details of the backup copy job. 

2. Select the Enable the job when I click Finish check box if you want to start the job right after 
you finish working with the wizard.  

3. Click Finish to close the wizard. 
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Linking Backup Jobs to Backup Copy Jobs 
You can link backup jobs to backup copy jobs. This option lets you create a secondary target for the 
backup job and store backups created with the backup job on the secondary backup repository.  

When you link a backup job to the backup copy job, Veeam Backup & Replication automatically 
updates properties of the backup copy job and adds to it the backup job as a source of data. The 
backup copy job starts monitoring the backup job linked to it. During every synchronization interval, 
the backup copy job checks the source backup repository for new restore points. As soon as a backup 
job session is finished and a new restore point appears on the source backup repository, the backup 
copy job automatically copies this restore point to the target backup repository.  

You can point a backup job to an existing backup copy job using the Backup Job wizard. To link jobs: 

1. Open the backup job settings and navigate to the Storage step. Select the Configure 
secondary destination for this job check box.  
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2. At the Secondary Target step of the wizard, click Add and choose a backup copy job to 
which the backup job must be linked. The backup copy job must be already configured on 
the backup server. 
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Starting Synchronization Cycles Manually 
As soon as you create a backup copy job and start it, Veeam Backup & Replication automatically 
enables the job. Backups are copied between backup repositories automatically according to the 
specified synchronization interval. For more information, see Synchronization Intervals. 

You can start the synchronization process manually. Manual start of the synchronization interval can 
be helpful, for example, if a new restore point has already appeared on the source backup repository 
but the previous synchronization interval has not finished yet.  

When you manually start the synchronization process, Veeam Backup & Replication creates a new 
synchronization interval. 

 In case of backup copy jobs with minutely and hourly intervals, the synchronization interval is 
equal to those that are created automatically by the schedule. As a result, the start time of 
backup copy processing shifts forward.  

 In case of backup copy jobs with synchronization intervals equal to one or several days, the 
manual synchronization process always finishes at the start time of the scheduled 
synchronization interval (by default, at 0:00 AM). For example, you have configured a backup 
copy job to copy VM data every 30 day; the synchronization cycle starts at 2:00 AM. The 
manual synchronization cycle is started on May 10 at 1:00 PM. The manual synchronization 
cycle will work from 1:00 PM on May 10 till 2:00 AM on May 11. On May 11 at 2:00 AM 
Veeam Backup & Replication will automatically start a new 30-day synchronization cycle. 

To start a new data synchronization cycle manually: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select the Backup Copy node under Jobs.  

3. In the working area, select the backup copy job and click Sync Now on the ribbon or right-
click the backup copy job and select Sync Now. 
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Creating Active Full Backups 
You can manually create an ad-hoc full backup — active full backup, and add it to the backup chain 
on the target backup repository. Active full backup can be helpful if you want to change backup copy 
job settings, for example, define a new encryption password. Veeam Backup & Replication will apply 
new settings starting from this full backup. 

To create an active full backup manually: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select the Backup Copy node under Jobs.  

3. In the working area, select the backup copy job and click Active Full on the ribbon or right-
click the backup copy job and select Active Full. Veeam Backup & Replication will start a new 
synchronization cycle, copy VM data from the source backup repository and save it in a full 
backup file on the target backup repository. 
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Removing Backups from Target Repositories 
You can remove backups created by backup copy jobs from Veeam Backup & Replication 
configuration or permanently delete backup chains from the target backup repository.  

Removing from Configuration 
When you use the Remove from configuration option, you delete records about backup copies from 
the Veeam Backup & Replication console and configuration database. The backup copy job remains in 
the list of jobs and all backup files remain on the target backup repository. You can easily import 
backups to the Veeam Backup & Replication console for restore operations at any moment. 

To remove from backups:  

1. Open the Backup & Replication view. 

2. In the inventory pane, select Backups.  

3. In the working area, right-click the backup copy and select Remove from configuration. 

4. To remove all weekly, monthly, quarterly and yearly backups created by the job, select the 
Include archived full backups check box and click Yes. 
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Deleting from Disk 
When you use the Delete from disk option, you delete records about backup copies from the 
Veeam Backup & Replication console and configuration database and, additionally, delete backup files 
themselves from the target backup repository. This option can be used for the whole backup copy or 
for some VMs in the backup copy. 

To permanently remove backup copies from the target backup repository: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Backups.  

3. In the working area, right-click the backup copy or a VM in the backup copy and select Delete 
from disk. 

4. To remove all weekly, monthly, quarterly and yearly backups from disk, select the Include 
archived full backups check box and click Yes. 
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Migrating VMs 
You can relocate one or more VMs with quick migration. Quick migration can be used to move VMs 
from one ESX(i) host to another one, move VM disks to another datastore or both. You can perform 
"hot" quick migration for running VMs or "cold" quick migration for VMs that are powered off. 

Quick migration is not job-driven: it cannot be saved as a job or scheduled to run later. 
Veeam Backup & Replication will start relocating VMs immediately after you finish working with the 
Quick Migration wizard. 

Before starting quick migration, check prerequisites. Then use the Quick Migration wizard to migrate 
VMs.  

Before You Begin 

Before you perform quick migration, check the following prerequisites: 

 Backup infrastructure components that will take part in quick migration must be added to the 
backup infrastructure and properly configured. These include the source and target ESX(i) 
hosts. 

 The target datastore must have enough free space to store disks of the migrated VM(s). To 
receive alerts about low space on the target datastore, configure global notification settings. 
For more information, see Specifying Other Notification Settings. 

 If you want use VMware vSphere vMotion to relocate VMs between hosts and/or VMware 
vSphere Storage vMotion to relocate VM disks between datastores, make sure that you have a 
VMware vSphere license covering these features. 
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Step 1. Launch the Quick Migration Wizard 

To run the Quick Migration wizard:  

1. Open the Virtual Machines view 

2. In the infrastructure tree, select a host or VM container in which the VM(s) that you want to 
relocate reside. 

3. In the working area, select the VM and click Quick Migration on the ribbon or right-click the 
VM(s) and select Quick Migration. 

 

Step 2. Select VMs to Relocate 

At the Virtual Machines step of the wizard, select the VM(s) and VM containers that you want to 
relocate.  

1. Click Add. 

2. Use the toolbar at the top right corner of the window to switch between views: Hosts and 
Clusters, VMs and Templates, Datastores and VMs and Tags. Depending on the view you 
select, some objects may not be available. For example, if you select the VMs and Templates 
view, no resource pools, hosts or clusters will be displayed in the tree. 

3. Select the necessary object and click Add.  
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To quickly find the necessary object, you can use the search field at the bottom of the Add Objects 
window. 

1. Click the button to the left of the search field and select the necessary type of object to search 
for: Everything, Folder, Cluster, Host, Resource pool, VirtualApp or Virtual machine.  

2. Enter the object name or a part of it in the search field.  

3. Click the Start search button on the right or press [ENTER]. 

 

Step 3. Specify VM Destination 

At the Destination step of the wizard, select the destination to which the selected VM(s) must be 
relocated. 

1. Click Choose next to the Host or cluster field and select an ESX(i) host or cluster where the 
relocated VM must be registered.  

2. If all or majority of relocated VMs must belong to the same resource pool, click Choose next 
to the Resource pool field and select the target resource pool.  

If you want to place relocated VMs to different resource pools: 

a. Click the Pick resource pool for selected VMs link.  

b. In the Choose Resource Pool window, click Add VM on the right and select the 
VMs.  

c. Select the added VM in the VM resource pool list and click Resource Pool at the 
bottom of the window.  

d. From the list of available resource pools, select the target resource pool. 
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3. If all or majority of relocated VMs must be placed to the same folder, click Choose and select 
the folder. 

If you want to place relocated VMs to different folders: 

a. Click the Pick VM folder for selected VMs link.  

b. In the Choose Folder window, click Add VM on the right and select the VMs.  

c. Select the added VM in the VM folder list and click VM Folder at the bottom of the 
window. 

d. From the list of available folders, select the target folder. 

The VM folder section is disabled if you selected a standalone ESX(i) host as a target for VM 
relocation. 

4. If all or majority of relocated VMs must be stored on the same datastore, click Choose and 
select the datastore. Veeam Backup & Replication displays only those datastores that are 
accessible by the selected ESX(i) host. If you have chosen relocate VMs to a cluster, 
Veeam Backup & Replication will display only shared datastores. 

If you want to place relocated VMs to different datastores: 

a. Click the Pick datastore for selected virtual disks link.  

b. In the Choose VM Files Location window, click Add VM on the right and select the 
VM that must be placed on datastores.  

c. Select the added VM in the Files location list and click Datastore at the bottom of 
the window.  

d. From the list of available datastores, select the target datastore. 

You can choose to store VM configuration files and disk files in different locations. 

a. Add the VM to the Files location list, expand the VM and select the required type 
of files.  

b. Click Datastore at the bottom of the window and choose the destination for the 
selected type of files. 

5. By default, Veeam Backup & Replication saves disks of relocated VMs in the thin format. If 
necessary, you can change the disk format. For example, if the original VM uses thick disks, 
you can change the disk format of the relocated VM to thin provisioned and save on disk 
space required to store VM data.  

Disk format change is available only for VMs using virtual hardware version 7 or later.  
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To change VM disk format:  

a. Click the Pick datastore for selected virtual disks link.  

b. In the Choose VM Files Location window, click Add VM on the right and select the 
VM whose disk format you want to change. 

c. Select the added VM in the list and click Disk type at the bottom of the window.  

d. In the Disk Type Settings section, choose the format that will be used to restore 
VM disk files: same as the source disk, thin or thick.  

 

Step 4. Select Infrastructure Components for Data Transfer 

At the Transfer step of the wizard, assign infrastructure components to relocate the VM(s).  

1. In the Data transfer section, select backup proxies that must be used to transfer VM data 
from source to target. 

If you plan to migrate VMs within one site, the same backup proxy can act as the source 
backup proxy and target backup proxy. For offsite migration, you must deploy at least one 
backup proxy in each site to establish a stable connection across the sites for data transfer.  
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Click Choose next to the Source proxy and Target proxy fields to select backup proxies for 
migration. In the Backup Proxy window, you can choose automatic proxy selection or assign 
proxies explicitly. 

 If you choose Automatic selection, Veeam Backup & Replication will detect 
backup proxies that have access to the source datastore and will automatically 
assign optimal proxy resources for processing VM data. 

Migrated VMs are processed one by one. Before processing a new VM in the VM list, 
Veeam Backup & Replication checks available backup proxies. If more than one 
backup proxy is available, Veeam Backup & Replication analyzes transport modes 
that the backup proxies can use for data retrieval and the current workload on the 
backup proxies to select the most appropriate resource for VM processing. 

 If you choose Use the selected backup proxy servers only, you can explicitly 
select backup proxies that must be used to perform migration. 

2. Select which migration mechanism to use: VMware vMotion or Veeam Quick Migration. 
Veeam Backup & Replication can use VMware vMotion only if your VMware license covers this 
functionality. 

 If you want to use VMware vMotion to relocate the VM(s), leave the Force Veeam 
quick migration check box not selected. Veeam Backup & Replication will attempt 
to use the VMware vMotion mechanism to migrate the selected VM(s). If VMware 
vMotion cannot be used for some reason, for example, if you do not have a VMware 
vSphere license for this functionality, Veeam Backup & Replication will fail over to 
its native migration mechanism. 

 If you do not want to use VMware vMotion, select the Force Veeam quick 
migration check box. Veeam Backup & Replication will use its native migration 
mechanism. 

Important! 

 

If you use a native Veeam mechanism to relocate a VM, Veeam Backup & Replication suspends the 
initial VM on the source ESX(i) host (SmartSwitch) or powers off the initial VM (cold switch) for a short 
period of time during quick migration. For more information, see Quick Migration. 
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Step 5. Finish Working with Wizard 

At the Ready step of the wizard, Veeam Backup & Replication will check if the selected VM(s) can be 
relocated. 

1. Review details of the quick migration task. 

2. By default, when VM migration completes successfully, Veeam Backup & Replication waits for 
a heartbeat signal from the VM on the target host. If the heartbeat is received, the original VM 
on the source host is deleted. If you do not want to delete the original VM on the source host, 
clear the Delete source VM files upon successful migration check box. Note that you 
cannot use this option if you have selected to relocate the VM(s) using VMware vMotion. 

3. Click Finish to close the wizard and start the migration process. 
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Performing Recovery Verification 
You can verify VM backups, VMs whose disks are located on storage snapshots and test VM replicas 
with SureBackup jobs. During recovery verification, Veeam Backup & Replication performs "live" 
verification of VMs: it runs VMs from VM backups, storage snapshots or powers on VM replicas, starts 
applications inside VMs and makes sure that everything is working in a proper way. 
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Verifying Backups, Replicas and VMs from Storage Snapshots 
To verify backups, replicas and VMs from storage snapshots, you must perform the following tasks: 

1. Create an application group 

2. Create a virtual lab 

3. Create and start a SureBackup job 

Before You Begin 

Before you create and start a SureBackup job, check the following prerequisites: 

 A valid license for Enterprise Edition of Veeam Backup & Replication must be installed on the 
backup server. 

 All applications and services on which verified VMs are dependent must be virtualized in your 
environment. 

 The ESX(i) host on which you plan to deploy a virtual lab must have a VMkernel interface. 
Otherwise the vPower NFS datastore will not be mounted on the ESX(i) host. For more 
information, see Veeam vPower NFS Service. 

 If you plan to verify VMs with a ping test, the firewall on tested VMs must allow ping requests. 

 If you plan to verify VMs with a heartbeat test, VMware Tools must be installed in tested VMs. 

 If you plan to use the advanced multi-host networking mode for VM replicas verification, you 
must configure a DVS beforehand. For more information, see Advanced Multi-Host Virtual 
Labs. 

 [For storage snapshots] The storage system must be added to the backup infrastructure. 

Mind the following limitations: 

 Verified VM replicas must be in the Normal state. If a VM replica is in the Failover or Failback 
state, you will not be able to verify it with the SureBackup job. 

 Veeam Backup & Replication does not perform SureBackup verification for backups of vCloud 
Director VMs and backups created with backup copy jobs. You cannot add VMs from such 
backups to application groups or link such backups to SureBackup jobs. 

 The source backup or replication job has a higher priority than the SureBackup job. If the 
source backup or replication job starts when the SureBackup job is running, and this job is 
about to modify the restore point from which the VM is started, Veeam Backup & Replication 
automatically powers off VMs in the virtual lab and completes the SureBackup job. 

  



 

748   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Creating Application Groups 

To create a new application group, use the New Application Group wizard.  

Step 1. Launch New Application Group Wizard 

To launch the New Application Group wizard, do one of the following: 

 Open the Backup Infrastructure view, in the inventory pane select SureBackup. In the 
working area, click Add Application Group > VMware. 

 Open the Backup Infrastructure view, in the inventory pane select Application Groups 
under SureBackup and click Add Group > VMware on the ribbon. 

 Open the Backup Infrastructure view, in the inventory pane right-click Application Groups 
under SureBackup and select Add App Group > VMware. 
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Step 2. Specify Application Group Name and Description 

At the Name step of the wizard, specify a name and description for the application group. 

1. In the Name field, enter a name for the application group. 

2. In the Description field, provide a description for future reference. The default description 
contains information about the user who created the group, date and time when the group 
was created. 

 

Step 3. Add VMs to Application Group 

At the Virtual Machines step of the wizard, add VMs to the created application group. You can add 
VMs from different sources:  

 VM backups 

 VM replicas 

 Storage snapshots 

Veeam Backup & Replication supports mixed application groups. You can add VMs from backups, 
storage snapshots and VM replicas to the same application groups. Keep in mind the following 
limitations: 

 VMs must belong to the same platform — VMware vSphere or Microsoft Hyper-V. 

 VMs must have at least one valid restore point or must reside on a storage snapshot. 

 You cannot add the same VM twice. For example, if you add a VM from the storage snapshot, 
you will not be able to add the same VM from the backup. 
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To add VMs to the application group:  

1. Click Add VM and select From backups, From replicas or From storage snapshots. 

2. In the displayed window, expand the job or storage snapshot, select the VM and click Add. 

3. VMs in the list are specified in the order of their boot priority. To move a VM up and down in 
the list, select it and click Move Up or Move Down. 

 

Step 4. Specify Recovery Verification Options and Tests 

You must specify verification options for every VM in the application group: 

 Select a role that the VM performs 

 Configure startup settings 

 Select tests that must be performed for the VM 

 Specify credentials for running the verification script 

  



 

751   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

To specify recovery verification options: 

1. At the Virtual Machines step of the wizard, select the VM in the list. 

2. Click Edit on the right. 

3. Use the Verification Options window to specify verification options. 

Role Settings 

On the Role tab, select a role that the VM performs. Veeam Backup & Replication offers the following 
predefined roles for VMs: 

 DNS Server 

 Domain Controller 

 Global Catalog 

 Mail Server 

 SQL Server 

 Web Server 

VM roles are described in XML files stored in the %Program Files%\Veeam\Backup and 
Replication\Backup\SbRoles folder on the backup server. You can create your own roles. To do this, you 
must create a new XML file and specify role and test scripts settings in it. For more information, see 
Creating XML files with VM Roles Description. 

After you select a role for the VM, Veeam Backup & Replication will automatically configure startup 
options and assign predefined test scripts for the chosen role. You can use these settings or specify 
custom settings on the Startup Options and Test Scripts tabs. 
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To verify VMs that perform roles other than those specified in the list, you will have to manually 
configure startup options and specify test scripts that must be run for these VMs. 

Important! 

 

If you want to add several domain controllers to the application group, you must assign roles of the 
Domain Controller and/or Global Catalog only to one domain controller in the group. Other domain 
controllers must have no roles. To verify ports for these domain controllers, you need to manually 
configure startup options and select a custom script.  

 

Startup Settings 

To configure VM startup settings: 

1. In the Verification Options window, click the Startup Options tab. 

2. In the Memory section, specify the amount of memory that you want to pre-allocate to the 
VM when this VM starts. The amount of pre-allocated memory is defined in percent. The 
percentage rate is calculated based on the system memory level available for the production 
VM. For example, if 1024 MB of RAM is allocated to the VM in the production environment 
and you specify 80% as a memory rate, 820 MB of RAM will be allocated to the verified VM on 
startup. 

3. In the Startup time section, specify the allowed boot time for the VM and timeout to initialize 
applications on the VM.  

Be careful when specifying the Maximum allowed boot time value. Typically, a VM started 
by the SureBackup job requires more time to boot than a VM started in the production 
environment. If an application is not initialized within the specified interval of time, the 
recovery verification process fails with the timeout error. If such error occurs, you need to 
increase the Maximum allowed boot time value and run the SureBackup job again. 
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4. In the Boot verification section, specify when the VM must be considered to have been 
booted successfully:  

 VM heartbeat is present. If you enable this option, Veeam Backup & Replication 
will perform a heartbeat test for the verified VM. 

 VM responds to ping on any network interface. If you enable this option, 
Veeam Backup & Replication will perform a ping test for the verified VM. 

If you enable both options, Veeam Backup & Replication will require that both tests are 
completed successfully: heartbeat test and ping test. 

Note: 

 

Veeam Backup & Replication performs a heartbeat test only if a VM has VMware Tools are installed. If 
VMware Tools are not installed, the VM will be started but the test will not be performed. VMs 
without VMware Tools can still be used as auxiliary VMs: they can be started to enable proper work of 
other VMs. In this case, you do not need to select any role for such VMs. 

 

Test Script Settings 

When you select a VM role, Veeam Backup & Replication automatically assigns a predefined script that 
must be run to verify applications inside this VM. If you want to verify a VM that has some other role 
not listed on the Role tab: 

1. In the Verification Options window, click the Test Scripts tab. 

2. Click Add.  

3. In the Test Scripts window, select Use the following test script.  

4. In the Name field, specify a name for the script. 
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5. In the Path field, define a path to an executable script file that must be run to verify the VM. 
You can do one of the following: 

 If you have your own custom script, define a path to it in the Path field. 

 If you do not have a custom script, you can use a standard utility by Veeam, 
Veeam.Backup.ConnectionTester.exe, that probes application communication ports. 
The utility is located in the installation folder of Veeam Backup & Replication: 
%Program Files%\Veeam\Backup and 
Replication\Backup\Veeam.Backup.ConnectionTester.exe. Specify this path in the 
Path field. 

6. In the Arguments field, specify an IP address of the verified VM and port that you want to 
probe. You can use the %vm_ip% variable to define the VM IP address or the %vm_fqdn% 
variable to define the VM fully qualified domain name.  

7. Click OK to add the configured test. 

To edit test settings, select the test in the list and click Edit. To delete a test, select the test in the list 
and click Remove. 

Note: 

 

If a VM performs several roles and runs a number of applications, you can add several verification 
scripts to verify work of these applications. It is recommended that you specify the maximum startup 
timeout value and allocate the greatest amount of memory for such VMs. 
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Credentials Settings 

By default, to run the verification script Veeam Backup & Replication uses the account under which the 
Veeam Backup Service is running. If you need to run the script under some other account, you can 
specify credentials for this account in the application group settings. 

1. Click the Credentials tab. 

2. From the Credentials list, select credentials for the account under which you want to run the 
script.  

If you have not set up credentials beforehand, click the Manage accounts link or click Add on 
the right to add the credentials. For more information, see Managing Credentials. 
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Step 5. Review Application Group Settings and Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of application group configuration. 

1. Review details of the application group. 

2. Click Finish to save the application group settings and close the wizard. 
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Creating Virtual Lab 

To create a new virtual lab, use the New Virtual Lab wizard. 

Step 1. Launch New Virtual Lab Wizard 

To launch the New Virtual Lab wizard, do one of the following: 

 Open the Backup Infrastructure view, in the inventory pane select SureBackup. In the 
working area, click Add Virtual Lab > VMware. 

 Open the Backup Infrastructure view, in the inventory pane select Virtual Labs node under 
SureBackup and click Add Virtual Lab > VMware on the ribbon. 

 Open the Backup Infrastructure view, in the inventory pane right-click Virtual Labs under 
SureBackup and select Add Virtual Lab > VMware. 
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Step 2. Specify Virtual Lab Name and Description 

At the Name step of the wizard, specify a name and description for the virtual lab. 

1. In the Name field, enter a name for the virtual lab. 

2. In the Description field, provide a description for future reference. The default description 
contains information about the user who created the virtual lab, date and time when the lab 
was created. 

 

Step 3. Select Host 

At the Host step of the wizard, select an ESX(i) host on which the virtual lab must be created.  

To select an ESX(i) host: 

1. Click Choose.  

2. Select an ESX(i) host on which the new virtual lab must be created. You can select a 
standalone ESX(i) host or an ESX(i) host being part of a cluster or vCenter Server hierarchy. 

3. For every new virtual lab, Veeam Backup & Replication creates a dedicated folder and 
resource pool on the ESX(i) host. By default, the folder and pool have the same name as the 
virtual lab. To change the name of the folder and/or resource pool, click Configure. In the 
Destination Options window, enter the necessary names. 
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Important! 

 

You cannot create resource pools in clusters with disabled DRS. If the destination host is a part of 
such a cluster, the Create a designated resource pool option will be disabled in the Destination 
Options window. For more information, see http://kb.vmware.com/kb/1004098. 
You cannot create folders on standalone ESX(i) hosts or ESX(i) hosts that are managed by the vCenter 
Severs but are added to Veeam Backup & Replication as standalone hosts. To overcome this 
situation, add the corresponding vCenter Server to Veeam Backup & Replication. 

 

Selecting an ESX(i) Host for VM Replicas Verification 

When you select an ESX(i) host for the virtual lab where VM replicas will be verified, mind the location 
of verified VM replicas and VM replicas added to the application group: 

 If verified VM replicas and VM replicas from the application group are located on the same 
ESX(i) host, you must select the ESX(i) host on which these VM replicas are registered. Verified 
VM replicas and VMs from the application group will be started on the selected ESX(i) host. If 
the application group contains VMs added from VM backups or storage snapshots, these VMs 
will also be started on the selected ESX(i) host.  

For this type of virtual lab configuration, you need to choose one of single-host networking 
modes: Basic single-host or Advanced single-host. For more information, see Selecting a 
Networking Mode. 

 If verified VM replicas and/or VM replicas from the application group are located on different 
ESX(i) hosts, you can select any ESX(i) host in your virtual environment. 
Veeam Backup & Replication will create the virtual lab on the selected ESX(i) host. Verified VM 
replicas and VM replicas from the application group will be started on ESX(i) hosts where they 
are registered and connected to the virtual lab with the help of VMware DVS technology.  

  

http://kb.vmware.com/kb/1004098
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The ESX(i) host on which the virtual lab is created must meet the following requirements: 

 The ESX(i) host must be located in the same datacenter where VM replicas are 
registered.  

 The ESX(i) host must have enough CPU and RAM resources. If the application group 
contains VMs that are started from backups or storage snapshots, these VMs will be 
started on the same ESX(i) host where the virtual lab is located, which will require a 
lot of resources. 

 For this type of virtual lab configuration, you must use the Advanced multi-host 
networking mode. For more information, see Selecting a Networking Mode. 

Step 4. Select Datastore 

At the Datastore step of the wizard, select a datastore on which redo logs for verified VMs must be 
placed. Redo logs are auxiliary files used to keep changes that take place when VMs run in the virtual 
lab. As soon as a recovery verification job completes, redo logs are deleted. 

To select a datastore for redo logs: 

1. Click Choose.  

2. Select a datastore from the list. 
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Step 5. Set Up Proxy Appliance 

At the Proxy step of the wizard, configure proxy appliance settings. 

1. Select the Use proxy appliance in this virtual lab check box to enable automatic recovery 
verification of VMs. The proxy appliance acts as a gateway that provides access from the 
backup server to VMs in the virtual lab. If you do not select this check box, during recovery 
verification Veeam Backup & Replication will only start VMs in the virtual lab and perform the 
heartbeat test for VMs. You will have to manually test VMs or perform manual item-level 
restore via the VM console. 

2. By default, the proxy appliance uses the virtual lab name that you have specified at the Name 
step of the wizard. If you want to change a name of the proxy appliance, in the Proxy 
appliance VM settings section click Configure and specify the new name.  

3. In the Production network connection section, click Configure and select a production 
network in which the proxy appliance will be created. Specify an IP address for the proxy 
appliance in the production network and settings of the DNS server to be used. You can 
choose to automatically obtain an IP address for the backup proxy and DNS server settings or 
set them manually. 

Important! 

 

If you assign to the proxy appliance an IP address from the same network where the backup server is 
located, Veeam Backup & Replication will automatically add a new route to the routing table on the 
backup server. If you assign to the proxy appliance an IP address from a different network, you will 
have to manually add a new route to the routing table on the router in the production network. If 
you do not add a new route, tests and application scripts will fail and you will not be able to access 
VMs in isolated networks. 
When Veeam Backup & Replication starts a virtual lab, it verifies if the proxy appliance is available by 
sending a ping request to it. If the corresponding route is not added to the routing table, the 
SureBackup job will fail. 

4. By default, VMs in the virtual lab work in the isolated environment and do not have access to 
the Internet. If you want to let VMs in the virtual lab access the Internet, select the Allow 
proxy appliance to act as internet proxy for virtual machines in this lab check box. In the 
Port field, specify a port for HTTP traffic. By default, port 8080 is used. In the Production 
proxy field, you can optionally specify an IP address or a fully qualified domain name of an 
Internet-facing proxy server that VMs must use to access the Internet. 

5. On every VM that you plan to start in the virtual lab, adjust proxy settings in the Internet 
options. To do this, on the VM open Internet Options > Connections > LAN Settings > 
Proxy server and specify an IP address of the proxy appliance on the isolated network and 
port number. 
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Note: 

 

When you allow the proxy appliance to act as an Internet proxy, you enable the HTTP(S) Internet 
access for VMs in the virtual lab. The proxy appliance does not proxy other protocols (such as ICMP 
protocol used for ping tests) for VMs in the virtual lab. 

 

Step 6. Select Networking Mode 

At the Networking step of the wizard, select the type of network settings configuration. The virtual 
lab configuration depends on objects that you plan to verify in the virtual lab: 

 Backups 

 Replicas 

 VMs from storage snapshots 

Selecting Networking Mode for Verifying Backups 

Veeam Backup & Replication offers two networking modes for the virtual lab in which VMs from 
backups can be verified: 

 Basic single-host. This networking mode is recommended if all VMs that you plan to verify, 
VMs from the application group and the backup server are located in the same production 
network. In this case, Veeam Backup & Replication will automatically define all networking 
settings for the virtual lab. 

 Advanced single-host. This networking mode is recommended if VMs that you plan to verify 
and/or VMs from the application group are located in different networks. In this case, you will 
have to manually define settings for isolated networks in the virtual lab.  

If you select the Advanced single-host option, the New Virtual Lab wizard will include additional 
steps for customizing network settings. 
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Note: 

 

You can also verify VM backups in Advanced Multi-Host virtual labs with DVS. This scenario can be 
helpful if you want to test VM backups and replicas in the same virtual lab or want to add verified VM 
backups and replicas to the same SureBackup job. 
For more information, see Advanced Multi-Host Virtual Labs. 

 

Selecting Networking Mode for Verifying Replicas 

Veeam Backup & Replication offers three networking modes for the virtual lab in which VM replicas are 
verified: 

 Basic single-host. This type of networking is recommended if VM replicas that you plan to 
verify are located on the same ESX(i) host and are connected to the same production 
network. The backup server must also be located in this network. In this case, 
Veeam Backup & Replication will automatically define all networking settings for the virtual 
lab. 

 Advanced single-host. This type of networking is recommended if VM replicas that you plan 
to verify are located on the same ESX(i) host but connected to different networks. In this case, 
you will have to manually define settings for isolated networks in the virtual lab.  

 Advanced multi-host. This type of networking is recommended if VM replicas that you plan 
to verify are located on the different ESX(i) hosts. For multi-host configuration of the virtual 
lab, Veeam Backup & Replication uses VMware DVS technology.  

If you select the Advanced multi-host option, click Choose and select the necessary DVS in 
your virtual environment. Note that Veeam Backup & Replication does not configure a DVS 
automatically: you must configure it beforehand. 
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If the Advanced single-host or Advanced multi-host option is selected, the New Virtual Lab wizard 
will include additional steps for customizing network settings. 

Important! 

 

For every isolated network in the virtual lab, Veeam Backup & Replication adds a new port group to 
the DVS. If you use a production DVS, you must isolate port groups created with 
Veeam Backup & Replication from the production environment. For more information, see Isolated 
Networks on DVS. 

 

Selecting Network Mode for Verifying VMs on Storage Snapshots 

For verifying VMs from storage snapshots, you can select any networking mode. 
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Step 7. Create Isolated Networks 

The Isolated Networks step of the wizard is available if you have selected the advanced networking 
option at the Networking step of the wizard. 

At the Isolated Networks step of the wizard, you must configure isolated networks to which verified 
VMs and VMs from the application group will be connected and map these networks to production 
networks where original VMs are located. 

To add a network: 

1. Click Add. 

2. From the Production network list, select a production network in which a VM from the 
application group or verified VM resides.  

3. In the Isolated network field, specify a name for the isolated network that must be mapped 
to the selected production network.  

4. In the VLAN ID field, enter an identifier for the created network. In the advanced multi-host 
virtual lab, VLAN IDs help ensure that the created network is isolated from the production 
environment. Alternatively, you can manually connect the DVS that you plan to use to the 
isolated network. For more information, see Advanced Multi-Host Virtual Lab. 

Note: 

 

You can map several production networks to the same isolated network. The production networks 
that you plan to map must have the same network masks and pools of IP addresses. 
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Step 8. Specify Network Settings 

The Network Settings step of the wizard is available if you have selected the advanced networking 
option at the Networking step of the wizard. 

At the Network Settings step of the wizard, you must specify settings for every created isolated 
network and define how production networks map to isolated networks in the virtual lab. 

Communication between production networks and isolated networks is carried out through vNIC 
adapters on the proxy appliance. A new vNIC adapter must be added for every isolated network. 

To add a vNIC adapter for an isolated network: 

1. At the Network Settings step of the wizard, click Add. 

2. Select a network to which the vNIC adapter must be connected. Specify an IP address that the 
proxy appliance must have in the isolated network and subnet mask for this isolated network. 
Typically, the IP address set for the proxy appliance coincides with the IP address of the 
gateway in the corresponding production network.  

3. After you specify the IP address, Veeam Backup & Replication will automatically configure a 
masquerade IP address for accessing VMs in the virtual lab from the production network. You 
can change the masquerade network IP address if necessary. 

4. Select the Enable DHCP service on this interface check box and specify settings of a 
virtualized DNS server if necessary. 

5. Click OK. 

6. To enable communication between isolated networks, select the Route network traffic 
between vNICs check box. Make sure that the IP address of the proxy appliance in the 
isolated network matches the IP address of the gateway in the production network. 

Important! 

 

Network addresses specified for different vNIC adapters must belong to different networks. For 
example, if the first network adapter has address 192.168.0.1 and the network mask is 255.255.255.0, 
and the second one — 192.168.0.2 and the network mask is 255.255.255.0, such configuration will 
not work. In this situation, you need to assign to the second adapter an IP address from a different 
network, for example, 172.16.0.1. 
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Step 9. Specify Static IP Mapping Rules 

The Static Mapping step of the wizard is available if you have selected the advanced networking 
option at the Networking step of the wizard. 

At the Static Mapping step of the wizard, you can specify static IP address mapping rules to make 
VMs in the virtual lab accessible from any machine in the production network. 

To add a new rule: 

1. Select the Define static IP address mapping check box. 

2. Click Add. 

3. In the IP Address Mapping window, specify settings of a new rule: 

a. In the Isolated IP field, specify an IP address of the VM in the production network. 

b. In the Access IP field, specify an IP address in the production network that you 
want to use to access the VM in the virtual lab. You must use an IP address that is 
not allocated to any machine yet. 

For example, a DNS server that you plan to start in the virtual lab has IP address 172.16.1.2 in the 
production network. To set static mapping for the DNS server: 

1. In the Isolated IP field, you must define its production IP address — 172.16.1.2.  

2. In the Access IP field, you must define any free IP address from the production network, for 
example, 172.16.1.48.  

After a virtual lab is created and VMs are started in the virtual lab, you will be able to access the DNS 
server in the virtual lab from the production environment by IP address 172.16.1.48. 
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Step 10. Apply Parameters 

At the Ready to Apply step of the wizard, complete the procedure of virtual lab configuration.  

1. Review details of the virtual lab. 

2. Click Next to create the virtual lab. 

3. At the last step of the wizard, click Finish to exit the wizard. 
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Connecting to Existing Virtual Lab 

You can connect an existing virtual lab and use this virtual lab for recovery verification. For example, 
you can connect to a virtual lab that has been created on another backup server. 

To connect to a virtual lab: 

1. Open the Backup Infrastructure view.  

2. In the inventory pane, select Virtual Labs under SureBackup and click Connect Virtual Lab 
> VMware on the ribbon or right-click Virtual Labs and select Connect Virtual Lab > 
VMware. 

3. Select the virtual lab and click Connect. To quickly find a virtual lab, use the search field at the 
bottom of the Select Virtual Lab window: enter a virtual lab name or a part of it in the field 
below and press [ENTER]. 
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Editing and Deleting Virtual Labs 

You can edit settings of a virtual lab or delete the virtual lab. 

Always use Veeam Backup & Replication to modify or delete a virtual lab. If you edit virtual lab settings 
or delete any of its components from outside, for example, via vSphere Client, the lab will be 
corrupted and its component such as the created vSwitch, resource pool will remain in the virtual 
infrastructure. 

Editing Virtual Labs 

To edit settings of a virtual lab: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select Virtual Labs under SureBackup. 

3. In the working area, select a virtual lab and click Edit Virtual Lab on the ribbon or right-click 
the virtual lab and select Properties. 

4. Edit virtual lab settings as required. 

Removing Virtual Labs 

To remove a virtual lab: 

1. Open the Backup Infrastructure view. 

2. In the inventory pane, select Virtual Labs under SureBackup. 

3. In the working area, select a virtual lab and click Remove Virtual Lab on the ribbon or right-
click the virtual lab and select Delete. 

4. If you want to remove virtual lab object from the virtual infrastructure, in the displayed 
window select the Remove virtual lab objects from host check box. If you do not enable 
this option, Veeam Backup & Replication will simply disconnect the virtual lab from the 
backup server. You will be able to connect to this virtual lab later. 
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Creating SureBackup Job 

To create a new SureBackup job, use the New SureBackup Job wizard. 

Step 1. Launch New Sure Backup Job Wizard 

To launch the New SureBackup Job wizard, do either of the following: 

 Open the Backup Infrastructure view, in the inventory pane select SureBackup. In the 
working area, click Add SureBackup Job > VMware. 

 Open the Backup & Replication view. On the Home tab, click SureBackup Job > VMware 
on the ribbon. Note that the SureBackup Job button becomes available only after you create 
or connect a virtual lab. 

 Open the Backup & Replication view. In the inventory pane, right-click SureBackup under 
Jobs and select SureBackup > VMware.  

You can use this method if you already have at least one SureBackup job. If there are no 
SureBackup jobs, the SureBackup node will not be displayed in the inventory pane. In this 
case, you can right-click Jobs in the inventory pane and select SureBackup > VMware. 
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Step 2. Specify Job Name and Description 

At the Name step of the wizard, specify a name and description for the SureBackup job. 

1. In the Name field, enter a name for the SureBackup job. 

2. In the Description field, provide a description for future reference. The default description 
contains information about the user who created the job, date and time when the job was 
created. 
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Step 3. Select Virtual Lab 

At the Virtual Lab step of the wizard, select a virtual lab that you want to use for recovery verification. 

1. From the Virtual Lab list, select a virtual lab. The list contains all virtual labs that are created 
or connected to the backup server. 

2. In the Virtual lab info section, review information about the selected virtual lab. 

 

Step 4. Select Application Group 

At the Application Group step of the wizard, select an application group that you want to use for 
recovery verification.  

You can select an application group or skip this step. If the application group is not selected, you must 
link at least one backup or replication job to the SureBackup job at the Backup Jobs step of the wizard. 
In this case, when the SureBackup job starts, Veeam Backup & Replication will only run VMs from the 
linked job in the virtual lab and verify these VMs. 
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To select an application group: 

1. From the Application group list, select an application group. The list contains all application 
groups that are created on the backup server.  

2. In the Application group info list, refer to the Source Status column to make sure that 
backups and replicas for VMs in the application group are created. 

3. To leave VMs from the application group running after the SureBackup job finishes, select the 
Keep the application group running after the job completes check box. With this option 
enabled, the lab will not be powered off when the SureBackup job completes, and you will be 
able to perform application item-level restore (U-AIR) and manually test VMs started in the 
virtual lab. 

 

Step 5. Link Backup or Replication Job 

At the Linked Jobs step of the wizard, select backup or replication jobs with VMs that you want to 
verify with the SureBackup job.  

You can link a backup or replication job to the SureBackup job or skip this step. If you do not link a 
backup or replication job, Veeam Backup & Replication will only start VMs from the application group 
in the virtual lab and verify them. You have an option not to link a backup or replication job to the 
SureBackup job only if you have selected an application group at the Application Group step of the 
wizard. 
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To link a backup or replication job to the SureBackup job: 

1. Select the Link jobs check box.  

2. Click Add.  

3. In the Select Jobs window, select backup and/or replication job(s). 

4. In the Process simultaneously up to … VMs field, specify the maximum number of VMs that 
can be started at the same time. For example, if you select to start 3 VMs at the same time, 
Veeam Backup & Replication will create 3 streams — 1 stream per every verified VM. When 
one VM has been tested and powered off, the next VM will be started in the available stream. 
After all VMs are verified, VMs from the application group will be powered off or will be left 
running (if the Keep the application group running after the job completes option has 
been enabled at the Application Group step of the wizard). 

To remove a backup or replication job from the list, select it and click Remove. 

 

Step 6. Specify Recovery Verification Options and Tests 

You must specify verification options for every VM from the jobs linked to the SureBackup job: 

 Select a role that a VM performs 

 Configure startup settings 

 Select tests that must be performed for the VM 

 Specify credentials for running the verification script 
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If all VMs in the linked job perform the same role, you can specify startup options and test settings for 
the whole job in bulk. If VMs have different roles, you can granularly specify startup options and test 
settings for every VM in the job. 

 To specify startup options and select tests for the whole job, select a job in the list and click 
Edit on the right. 

 To specify startup options and select tests for every VM in the job separately, select a job in 
the list and click Advanced on the right. Click Add; in the Add Objects window select a VM. 
Select the added VM in the list, click Edit and specify settings as described below. 

Important! 

 

If you specify startup options and tests individually for every VM, Veeam Backup & Replication will 
apply these options and tests only. Options and tests specified at the level of the SureBackup job will 
be ignored for this VM. 

Role Settings 

On the Role tab, select the role that the VM performs. Veeam Backup & Replication offers the 
following predefined roles for VMs: 

 DNS Server 

 Domain Controller 

 Global Catalog 

 Mail Server 

 SQL Server 

 Web Server 

VM roles are described in XML files stored in the %Program Files%\Veeam\Backup and 
Replication\Backup\SbRoles folder. You can add your own roles. To do this, you need to create a new 
XML file and specify role and test scripts settings in it. For more information, see Creating XML files 
with VM Roles Description. 

After you select the necessary role, Veeam Backup & Replication will automatically configure startup 
options and assign predefined test scripts for the chosen role. You can use these settings or specify 
custom settings on the Startup Options and Test Scripts tabs. 
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To verify VMs that perform roles other than those specified in the list, you will have to manually 
configure startup options and specify test scripts that must be run for these VMs. 

 

Startup Settings 

To configure VM startup settings: 

1. In the Verification Options window, click the Startup Options tab. 

2. In the Memory section, specify the amount of memory that you want to pre-allocate to the 
VM when this VM starts. The amount of pre-allocated memory is defined in percent. The 
percentage rate is calculated based on the system memory level available for the production 
VM. For example, if 1024 MB of RAM is allocated to the VM in the production environment 
and you specify 80% as a memory rate, 820 MB of RAM will be allocated to the verified VM on 
startup. 

3. In the Startup time section, specify the allowed boot time for the VM and timeout to initialize 
applications on the VM.  

Be careful when specifying the Maximum allowed boot time value. Typically, a VM started 
by a SureBackup job requires more time to boot than a VM started in the production 
environment. If an application fails to be initialized within the specified interval of time, the 
recovery verification process fails with the timeout error. If such error occurs, you need to 
increase the Maximum allowed boot time value and run the SureBackup job again. 

4. In the Boot verification section, specify when the VM must be considered to have been 
booted successfully:  

 VM heartbeat is present. If you enable this option, Veeam Backup & Replication 
will perform a heartbeat test for the verified VM. 

 VM responds to ping on any network interface. If you enable this option, 
Veeam Backup & Replication will perform a ping test for the verified VM. 

If you enable both options, Veeam Backup & Replication will require that both tests are 
completed successfully: heartbeat test and ping test. 
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Note: 

 

Veeam Backup & Replication performs a heartbeat test only if a VM has VMware Tools are installed. If 
VMware Tools are not installed, the VM will be started but the test will not be performed.  

 

Test Script Settings 

When you select a VM role, Veeam Backup & Replication automatically assigns a predefined script that 
must be run to verify applications inside the VM. If you want to verify a VM that has some other role 
not listed on the Role tab, do the following: 

1. In the Verification Options window, click the Test Scripts tab. 

2. Click Add.  

3. In the Test Scripts window, select Use the following test script.  

4. In the Name field, specify a name for the script. 

5. In the Path field, define a path to an executable script file that must be run to verify the VM. 
You can do one of the following: 

 If you have your own custom script, define a path to it in the Path field. 

 If you do not have a custom script, you can use Veeam’s standard utility, 
Veeam.Backup.ConnectionTester.exe, that probes application communication ports. 
The utility is located in the installation folder of Veeam Backup & Replication: 
%Program Files%\Veeam\Backup and 
Replication\Backup\Veeam.Backup.ConnectionTester.exe. Specify this path in the 
Path field. 

6. In the Arguments field, specify an IP address of the verified VM and the port that you want to 
probe. You can use the %vm_ip% variable to define the VM IP address or the %vm_fqdn% 
variable to define the VM fully qualified domain name.  

7. Click OK to add the configured test. 
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To edit test settings, select the test in the list and click Edit. To delete a test, select it in the list and click 
Remove. 

Note: 

 

If a VM performs several roles and runs a number of applications, you can add several verification 
scripts to verify work of these applications. It is recommended that you specify the maximum startup 
timeout value and allocate the greatest amount of memory for such VMs. 
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Credentials Settings 

By default, to run the verification script Veeam Backup & Replication uses the account under which the 
Veeam Backup Service is running. If you need to run the script under some other account, you can 
specify credentials for this account in the SureBackup job settings. 

1. Click the Credentials tab. 

2. From the Credentials list, select credentials for the account under which you want to run the 
script.  

If you have not set up credentials beforehand, click the Manage accounts link or click Add on 
the right to add the credentials. For more information, see Managing Credentials. 

 

Step 7. Specify Additional Job Settings 

On the Settings step of the wizard, specify additional settings for the SureBackup job: 

1. If you want to receive SNMP traps, select the Send SNMP trap check box.  

SNMP traps will be sent only if you configure global SNMP settings in 
Veeam Backup & Replication and on recipient’s computer. For more information, see 
Specifying SNMP Settings. 

2. If you want to receive notifications by email, select the Send email notifications to the 
following recipients check box. In the field below, specify recipient’s email address. You can 
enter several addresses separated by a semicolon.  

Email notifications will be sent only if you configure global email notification settings in 
Veeam Backup & Replication. For more information, see Specifying Email Notification 
Settings. 

3. [For VM backups only] If you want to validate the backup file with a CRC check and make sure 
that the file is not corrupted, select the Validate entire virtual disk contents check box. You 
can optionally exclude VMs being a part of the application group from this test. To do this, 
select the Skip validation for application group VMs check box. For more information, see 
Recovery Verification Tests. 
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Note: 

 

If you enable the Keep the application group running after the job completes option at the 
Application Group step of the wizard, the Skip validation for application group VMs option will 
be automatically enabled. 

 

Step 8. Specify Job Schedule 

At the Schedule step of the wizard, select to manually run the SureBackup job or schedule the job at 
specific time, for example, after the corresponding backup or replication job completes. 

1. To specify the job schedule, select the Run the job automatically check box. If this check box 
is not selected, you will have to manually start the job to perform recovery verification. 

2. Choose the necessary schedule option for the job: 

 Daily at to start the job at specific time every day, on week days or on specific days. 

 Monthly at to start the job once a month on the specified day. 

 After this job to chain the job. Typically, a SureBackup job should run after the 
linked backup or replication job completes. In this case, the SureBackup job will 
verify the VM backup or VM replica created by the source backup or replication job.  

To create a chain of jobs, you must define the time schedule for the first job in the 
chain. For the rest of the jobs in the chain, at the Schedule step of the wizard, 
select the After this job option and choose the preceding job from the list. 

3. In some cases, the linked backup or replication job may not complete until the SureBackup 
job starts. If Veeam Backup & Replication finds out that the linked job is still running, the 
SureBackup job will fail to start. To overcome this situation, select the If some linked backup 
jobs are still running, wait up to <N> minutes check box and specify the necessary time 
period in the field on the right. If the linked job is still running, Veeam Backup & Replication 
will wait for the defined period of time and check the linked job after this period elapses. 

 If the linked job is finished within the specified period, the SureBackup job will start.  

 If the linked job is still running, the SureBackup job will not start. 
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Note: 

 

The After this job function will only start a job if the first job in the chain is started automatically by 
schedule. If the first job is started manually, jobs chained to it will not be started. 
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Step 9. Review Job Summary and Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of SureBackup job configuration.  

1. Review details of the SureBackup job. 

2. If you want to start the job right after you finish working with the wizard, select the Run the 
job when I click Finish check box. 

3. Click Finish to save the job settings and close the wizard. 
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Starting and Stopping SureBackup Job 
You can instruct the SureBackup job to verify the latest restore point of a VM backup or VM replica or 
select a specific restore point to which the VM from the backup or VM replica must be started. 

To start a VM from the latest restore point: 

1. Open the Backup & Replication view. 

2. In the inventory pane, click SureBackup under Jobs. 

3. In the working area, select the SureBackup job and click Start on the ribbon. You can also 
right-click the SureBackup job and select Start. Veeam Backup & Replication will start VMs in 
the application group and verified VMs from the latest restore point and perform necessary 
tests for them. 

To start VMs from a specific point in time: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select SureBackup under Jobs. 

3. In the working area, select the SureBackup job and click Start to on the ribbon. You can also 
right-click the SureBackup job and select Start to.  

4. In the Restore Point window, select an approximate date of the restore point creation. 
Veeam Backup & Replication will pick the most recent restore point prior to the selected day 
and start VMs from the application group and verified VMs from this restore point. 
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To stop a running SureBackup job session: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select SureBackup under Jobs. 

3. In the working area, select the SureBackup job and click Stop on the ribbon. You can also 
right-click the SureBackup job and select Stop.  
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Viewing Recovery Verification Job Statistics 
You can monitor how tests for verified VMs are performed and see their results while a recovery 
verification job is running.  

To see the status of VM tests: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select SureBackup under Jobs. 

3. In the working area, right-click a recovery verification job and select Statistics. You can also 
double-click the job in the list.  

The job session window displays statistics for all VMs that are started during the SureBackup job: VMs 
from the application group in the specified order and VMs from linked job(s). For your convenience, 
these VMs are marked with different icons. 

After the verified VM is powered on, its name is displayed as a hyperlink. You can click the link to open 
the VM console to see what is happening inside the VM or perform manual testing. 

If some VM fails to be verified automatically, you can start it manually when this VM is powered off. To 
start a VM, right-click the VM in the list and select Start. If the application group has already been 
powered off by that time, it will be started again. After that, you can open the VM console and perform 
verification and testing manually. 



 

787   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Creating SureBackup Session Reports 
You can generate HTML reports with statistics on the SureBackup job. A report contains detailed data 
on job sessions: job status, start and end time, details of the session performance, status of verified 
VMs and test results. You can generate a report for the whole SureBackup job or a specific job 
session/sessions. 

The SureBackup job report contains data on all sessions initiated for a specific job. To generate a 
SureBackup job report: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Jobs. 

3. In the working area, select the SureBackup job and click Report on the ribbon. You can also 
right-click the SureBackup job and select Report. 

The session report contains data on a single job session. To generate a session report: 

1. Open the History view. 

2.  In the inventory pane, select Jobs. 

3. In the working area, select the session and click Report on the ribbon. You can also right-click 
the session and select Report. 
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Creating XML Files with VM Roles Description 
VM roles that you can assign to verified VMs and VMs from the application group are described in XML 
files. These XML files are stored in the %Program Files%\Veeam\Backup and 
Replication\Backup\SbRoles folder on the backup server. 

To add a new role, you must create a new XML file and save it to the SbRoles subfolder on the backup 
server. Do not save the XML file on the machine where the Veeam Backup & Replication console is 
installed — this will not affect the list of roles in Veeam Backup & Replication. 

XML files describing VM roles have the following structure: 

 
<SbRoleOptions> 
 <Role> 
  <SbRole> 
   <Id>4CDC7CC4-A906-4de2-979B-E5F74C44832F</Id>  
   <Name>Web Server</Name>  
  </SbRole> 
 </Role> 
 <Options> 
  <SbVerificationOptions> 
   <ActualMemoryPercent>100</ActualMemoryPercent>  
   <MaxBootTimeoutSec>300</MaxBootTimeoutSec>  
   <AppInitDelaySec>120</AppInitDelaySec>  
   <TestScripts> 
    <TestScripts> 
     <TestScript> 
      <Name>Web Server</Name>  
      <Type>Predefined</Type>  
      <TestScriptFilePath>Veeam.Backup.ConnectionTester.exe</TestScriptFilePath>  
      <Arguments>%vm_ip% 80</Arguments>  
     </TestScript> 
    </TestScripts> 
   </TestScripts> 
   <HeartbeatEnabled>True</HeartbeatEnabled>  
   <PingEnabled>True</PingEnabled>  
  </SbVerificationOptions> 
 </Options> 
</SbRoleOptions> 

 

The XML file with the role description contains the following tags and parameters: 

Tag Required/ 
Optional 

Description 

<SbRoleOptions> Required Encapsulates the VM role file. 

<Role> Required  Parent tag for a role assigned to a VM. <SbRole>, <Id> and 
<Name> are children of this tag.  

<SbRole> Required Encapsulates basic information for a VM role: ID and name. 

<Id> Required Unique identifier of a VM role.  

<Name> Required 
Name of a VM role. The VM role name is displayed in the roles list 
on the Role tab. 

<Options> Required 

Parent tag for startup and test script options to be used for the 
defined role. <SbVerificationOptions>, <ActualMemoryPercent>, 
<MaxBootTimeoutSec>, <AppInitDelaySec>, <TestScripts>, 
<Name>, <Type>, <TestScriptFilePath>, <Arguments>, 
<HeartbeatEnabled>, <PingEnabled> are children of this tag. 
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Tag Required/ 
Optional 

Description 

<SbVerificationOptions
> Required Encapsulates options data for a VM role. 

<ActualMemoryPercen
t> Optional Percent of the original memory level that must be pre-allocated 

to a verified VM on the system boot. 

<MaxBootTimeoutSec> Optional Maximum allowed time to boot a VM. 

<AppInitDelaySec> Optional Maximum allowed time to initialize applications inside the VM. 

<TestScripts> Optional Encapsulates test script data for a VM role. 

<Name> Optional Name of a VM role. The VM role name is displayed on the Test 
Scripts tab. 

<Type> Optional Type of the test script: Predefined or Custom. 

<TestScriptFilePath> Optional Path to an executable file of the test script to be performed. The 
path can be absolute or relative. 

<Arguments> Optional 

Arguments to be passed to the script. You can use two variables: 

 %vm_ip% – IP address of a verified VM  
 %vm_fqdn% – a fully qualified domain name of a 

verified VM 

<HeartbeatEnabled> Required Must a heartbeat test be enabled for this VM role: True or False. 

<PingEnabled> Required Must a ping test be enabled for this VM role: True or False. 
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Configuring On-Demand Sandbox 
You can configure the On-Demand Sandbox — an isolated environment where you can start VMs 
from backups, VM replicas and VMs from storage snapshots. On-Demand Sandbox can be used 
troubleshooting VMs, testing software and patches, training and so on. 

To configure the On-Demand Sandbox: 

1. Configure a virtual lab in which you plan to start VMs. For more information, see Creating 
Virtual Lab. 

2. Configure an application group. The application group must contain all VMs that you plan to 
start in the On-Demand Sandbox and all VMs on which these VMs are dependent. For more 
information, see Creating Application Group. 

3. Configure a SureBackup job: 

a. At the Virtual Lab step of the wizard, select the configured virtual lab. 

b. At the Application Group step of the wizard, select the configured application 
group. 

c. Select the Keep the application group running after the job completes check 
box. 

d. Configure other job settings as required and save the job. 

 

To start VMs in the On-Demand Sandbox, run the SureBackup job: 

1. Open the Backup & Replication view. 

1. In the inventory pane, select SureBackup. 

2. In the working area, right-click the SureBackup job and select Start or Start to. 

Veeam Backup & Replication will start the virtual lab and power on VMs from the application group in 
the virtual lab. You will be able to connect to VMs and perform tests for them. 
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Performing Restore 
If VM data gets accidentally corrupted or lost, you can use one of the following disaster recovery 
options to restore VM data from VM backups. 
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Performing Instant VM Recovery 
With Instant VM Recovery, you can immediately start a VM from a backup file stored on the backup 
repository. Instant VM Recovery accelerates the restore process, allows you to improve RTOs and 
decrease downtime of production VMs. 

Before starting Instant VM Recovery, check prerequisites. Then use the Instant VM Recovery wizard 
to recover the necessary VM. 

Before You Begin 

Before you perform Instant VM Recovery, check the following prerequisites: 

 You can restore a VM from a backup that has at least one successfully created restore point. 

 You must have at least 10 GB of free disk space on the vPower NFS datastore to store redo 
logs for the restored VM. By default, the redo logs are written to the 
C:\ProgramData\Veeam\Backup\NfsDatastore folder on the vPower NFS server. 

 If you are recovering a VM to the production network, make sure that the original VM is 
powered off to avoid conflicts. 

 On non-Microsoft Windows SMB3 storages, for example, Tintri, Veeam Backup & Replication 
may display the "Failed to disable integrity bit on disk N" warning during VM restore. You can 
ignore this warning for non-Microsoft Windows SMB3 storages. 

Step 1. Launch Instant VM Recovery Wizard 

To launch the Instant VM Recovery wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from backup section, 
select Instant VM recovery. 

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, select the VM you want to restore and click Instant VM 
Recovery on the ribbon. 

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, right-click the VM you want to restore and select Instant 
VM recovery. 
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Step 2. Select VMs 

At the Virtual Machine step of the wizard, select the VM that you want to recover: 

1. In the VM to recover list, expand the backup job. 

2. Select the VM. 

To quickly find a VM, you can use the search field at the bottom of the window. 

1. Enter a VM name or a part of it in the search field. 

2. Click the Start search button on the right or press [ENTER]. 

 

  



 

794   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Step 3. Select Restore Point 

At the Restore Point step of the wizard, select the restore point for the VM. 
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Step 4. Select Recovery Mode 

At the Recovery Mode of the wizard, choose the necessary restore mode: 

 Select Restore to the original location if you want to restore the VM with its initial settings 
and to its original location. If this option is selected, you will pass directly to the Reason step 
of the wizard. 

 Select Restore to a new location, or with different settings if you want to restore the VM to 
a different location and/or with different settings (such as VM location, network settings, 
format of restored virtual disks and so on). If this option is selected, the Instant Recovery 
wizard will include additional steps for customizing VM settings. 
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Step 5. Select Destination for the Restored VM 

The Destination step of the wizard is available if you have chosen to change the location and settings 
of the restored VM.  

Select a destination for the restored VM: 

1. In the Host field, specify a host on which the VM must run.  

2. In the VM folder field, specify a folder to which the restored VM must be placed. 

3. In the Restored VM name field, enter a name under which the VM must be restored and 
registered. By default, the restored VM has the name of the original VM. If you are restoring 
the VM to the same ESX(i) host or the same datacenter where the original VM is registered 
and the original VM still resides there, it is recommended that you change the VM name to 
avoid conflicts. 

4. In the Resource pool list, select a resource pool to which the VM must be placed. 

 

Step 6. Select Destination for Virtual Disk Updates 

The Datastore step of the wizard is available if you have chosen to change the location and settings of 
the restored VM.  

At the Datastore step of the wizard, you can select where redo logs must be written when the VM is 
running from the backup. By default, redo logs are stored directly on the backup server. However, you 
can store redo logs on any datastore in the virtual environment. Redirecting redo logs improves 
recovery performance but makes Storage vMotion not possible for ESX(i) 4.x and earlier. 
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To redirect redo logs: 

1. Select the Redirect virtual disk updates check box. 

2. Choose the datastore. 

 

Step 7. Specify Restore Reason 

At the Restore Reason step of the wizard, enter a reason for performing Instant VM Recovery for the 
VM. The information you provide will be saved in the session history and you can reference it later. 
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Step 8. Verify Instant VM Recovery Settings 

At the Ready to Apply step of the wizard, specify additional settings for Instant VM Recovery: 

1. If you are recovering a production VM that has failed and want to restore it with initial 
network settings, select the Connect VM to network check box. If you are recovering a VM 
for testing disaster recovery while the initial VM is still running, leave this check box not 
selected. Before you power on such VM, you will have to manually change VM network 
settings: disconnect the VM from the production network and connect it to an isolated non-
production network to avoid conflicts. 

2. To start a VM immediately after recovery, select the Power on VM automatically check box. 
If you are recovering the VM to the production network, make sure that the initial VM is 
powered off to avoid conflicts. 

3. Check settings you have specified for Instant VM Recovery and click Next. 
Veeam Backup & Replication will recover the VM on the selected ESX(i) host. 

 

Step 9. Finalize Instant VM Recovery 

All VMs restored with Instant VM Recovery are displayed in the Backup & Replication view, under the 
Instant Recovery node.  

To check the progress of Instant VM Recovery and view session details: 

1. Open the Backup & Replication view. 

2. In the inventory pane, click the Instant Recovery node. 

3. In the working area, right-click the VM and select Properties.  

Alternatively, you can open the History view, select the Instant Recovery node under Restore in the 
inventory pane and double-click the instant VM restore session.  

After the VM has been successfully recovered, you can finalize Instant VM Recovery in one of two 
ways:  

 Migrate the recovered VM to the production environment 

 Unpublish the recovered VM 
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Migrating Recovered VM 

To migrate the recovered VM to the production environment: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select the Instant Recovery node. 

3. In the working area, right-click the VM and select Migrate to production. 
Veeam Backup & Replication will launch the Quick Migration wizard.  

During migration, Veeam Backup & Replication will restore the VM from the backup file and 
additionally move all changes that were made while the VM was running from the backup in 
the Instant Recovery mode. 

Removing Recovered VM 

To remove the recovered VM:  

1. Open the Backup & Replication view. 

2. In the inventory pane, select the Instant Recovery node. 

3. In the working area, right-click the VM and select Stop publishing. 

Tip: 

 

After the VM has been published from the backup, you can open the VM console directly from 
Veeam Backup & Replication. To do this, in the working area right-click the VM and select Open VM 
Console. 
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Performing Full VM Restore 
If a VM has failed, you can recover it from the backup with full VM restore. You can restore one or more 
VMs at once, to the original location or new location. 

The full VM restore operation recovers an entire VM from the backup file and registers the VM on the 
target host. Full VM recovery takes more time than Instant VM Recovery as you have to extract the VM 
image from the backup to the production storage. However, you do not need to take any additional 
steps to finalize full VM restore: full VM restore actually recovers a failed VM on the production storage 
and provides full disk I/O performance. 

Before restoring a VM from the backup, check prerequisites. Then use the Full VM Restore wizard to 
restore the necessary VM. 

Before You Begin 

Before you restore a VM from, check the following prerequisites: 

 You can restore a VM from a backup that has at least one successfully created restore point. 

 When you restore a VM to its initial location and the original VM is still running, 
Veeam Backup & Replication will power off the original VM and delete it from the 
infrastructure. 

 On non-Microsoft Windows SMB3 storages, for example, Tintri, Veeam Backup & Replication 
may display the "Failed to disable integrity bit on disk N" warning during VM restore. You can 
ignore this warning for non-Microsoft Windows SMB3 storages. 

 You can restore a VM with Virtual Hardware version 4 to any ESX(i) host. VMs with Virtual 
Hardware version 7 can be restored to ESX(i) 4.x hosts or later. VMs with Virtual Hardware 
version 8 can be restored to ESX(i) 5.x hosts or later. 
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Step 1. Launch Restore Wizard 

To launch the Full VM Restore wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from backup section, 
select Entire VM (including registration). 

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, select the VM(s) you want to restore and click Entire VM 
on the ribbon. 

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, right-click the VM(s) you want to restore and select 
Restore entire VM. 

 Double-click the VBK or VBM file (for example, in Microsoft Windows Explorer). In the 
displayed window, select the VM and click Restore > Entire VM.  

You can use this option if you perform restore on the backup server. You cannot use this 
option if you perform restore via the Veeam Backup & Replication console. 

 

Step 2. Select VMs 

At the Virtual Machines step of the wizard, select one or more VMs that you want to restore.  

To select VM(s): 

1. Click Add VM.  

2. Select where to browse for VMs: 

 From infrastructure — browse the virtual environment and select VMs or VM 
containers to restore. If you choose a VM container, Veeam Backup & Replication 
will expand it to a plain VM list. 

When you add a VM to the list, Veeam Backup & Replication displays information 
about the most recent restore point in the Restore point column. If no restore 
point is available for the added VM, Veeam Backup & Replication will display a 
warning next to this VM. 

 From backup — browse existing backups and select VMs under backup jobs. 
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To quickly find VMs, you can use the search field at the top of the wizard. 

1. Enter a VM name or a part of it in the search field. Veeam Backup & Replication will display 
possible matches.  

2. If the VM is not in the list, click the Show more link to browse the virtual infrastructure. 

 

Step 3. Select Restore Point 

You can select the restore point for the VM(s) that you want to restore. 

By default, Veeam Backup & Replication uses the latest valid restore point. However, you can restore 
the VM to an earlier state. If you have chosen to restore several VMs, you can select the necessary 
restore point for every VM in the list. 
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To select a restore point for a VM: 

1. In the Virtual machines to restore list, select the VM. 

2. Click Point on the right.  

3. In the Restore Points window, select a restore point from which you want to restore the VM. 

 

Step 4. Select Restore Mode 

At the Restore Mode step of the wizard, choose the necessary restore mode and backup proxy for VM 
data transport: 

1. Choose a restore mode: 

 Select Restore to original location if you want to restore VMs with their initial 
settings and to their original location. If this option is selected, you will immediately 
pass to the Reason step of the wizard. 

 Select Restore to a new location, or with different settings if you want to restore 
VMs to a different location and/or with different settings (such as VM location, 
network settings, format of restored virtual disks and so on). If this option is 
selected, the Full VM Restore wizard will include additional steps for customizing 
VMs settings. 

2. Select the Restore VM tags check box if you want to restore tags that were assigned to the 
original VM, and assign them to the restored VM. Veeam Backup & Replication will restore the 
VM with original tags if the following conditions are met: 

 The VM is restored to its original location. 

 The original VM tag is still available on the source VMware vCenter Server. 

3. [For VM restore to the original location] Select the Quick rollback check box if you want to 
perform incremental restore for the VM. Veeam Backup & Replication will query CBT to get 
data blocks that are necessary to revert the VM to an earlier point in time, and will restore 
only these data blocks from the backup. Quick restore significantly reduces the restore time 
and has little impact on the production environment. 
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It is recommended that you enable this option if you restore a VM after a problem that 
occurred at the level of the VM guest OS: for example, there has been an application error or a 
user has accidentally deleted a file on the VM guest OS. Do not enable this option if the 
problem has occurred at the VM hardware level, storage level or due to a power loss. 

4. Click the Pick proxy to use link to select backup proxies over which VM data must be 
transported to the source datastore. You can assign backup proxies explicitly or instruct 
Veeam Backup & Replication to automatically select backup proxies. 

 If you choose Automatic selection, Veeam Backup & Replication will detect 
backup proxies that are connected to the source datastore and will automatically 
assign optimal proxy resources for processing VM data. 

During the restore process, VMs are processed simultaneously. 
Veeam Backup & Replication checks available backup proxies. If more than one 
backup proxy is available, Veeam Backup & Replication analyzes transport modes 
that the backup proxies can use for writing data to target, current workload on 
these backup proxies, and selects the most appropriate resources for VMs 
processing.  

 If you choose Use the selected backup proxy servers only, you can explicitly 
select backup proxies that will be used for restore. It is recommended that you 
select at least two proxies to ensure that VMs are recovered should one of backup 
proxies fail or lose its connectivity to the source datastore during restore. 
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Restoring Storage Profiles 

If the backed up VM was associated with the storage profile, in the restore to original location 
scenario, Veeam Backup & Replication will associate the restored VM with this storage profile.  

When you click Next, Veeam Backup & Replication will check storage profiles in the virtual 
environment and compare this information with the information about the storage profile in the 
backup file. If the original storage profile has been changed or deleted, Veeam Backup & Replication 
will display a warning. You can select one of the following options: 

 Current — the restored VM will be associated with the profile with which the original VM in 
the production environment is currently associated. 

 Default — the restored VM will be associated with the profile that is set as default for the 
target datastore. 

 Stored — the restored VM will be associated with the profile that was assigned to the original 
VM at the moment of backup, and whose information is stored in the backup file. 

 For more information, see Storage Profile Restore. 

 

Step 5. Select Destination Host 

The Host step of the wizard is available if you have chosen to change the location and settings for the 
restored VM.  

To specify a destination host: 

1. Select a VM in the list and click Host. To apply changes in bulk, select several VMs in the list 
and click Host. 

2. Choose a host or cluster where the selected VM must be registered. 
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To facilitate selection, you can use the search field at the bottom of the Select Host window:  

1. Click the button on the left of the field to select the necessary type of object that should be 
searched for: Cluster or Host. 

2. Enter an object’s name or a part of it and click the Start search button on the right or press 
[ENTER]. 

 

Step 6. Select Destination Resource Pool 

The Resource Pool step of the wizard is available if you have chosen to change the location and 
settings for the restored VM.  

To specify a destination resource pool: 

1. Select a VM in the list and click Pool. To apply changes in bulk, select several VMs in the list 
and click Pool. 

2. Select a resource pool to which the VM(s) must be placed. 

3. If necessary, select a vApp in which the VM(s) must be included. 
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To facilitate selection, you can use the search field at the bottom of the Select Resource Pool 
window:  

1. Enter a resource pool name or a part of it in the search field.  

2. Click the Start search button on the right or press [ENTER].  

 

Step 7. Select Destination Datastore 

The Datastore step of the wizard is available if you have chosen to change the location and settings 
for the restored VM.  

You can place an entire VM to a particular datastore or choose to store configuration files and disk files 
of the restored VM in different locations. 

To specify a destination datastore: 

1. Select a VM in the list and click Datastore. To apply changes in bulk, select several VMs in the 
list and click Datastore. 

2. Point to a datastore where VM files must be stored. 

If configuration and disk files of the VM must be placed to different datastores: 

1. Expand the VM in the list. 

2. Select the necessary file type and click Datastore.  

3. Select a datastore where the selected objects must be stored. To facilitate selection, you can 
use the search field at the bottom of the Select Datastore window: enter a datastore name 
or a part of it in the search field and click the Start search button on the right or press 
[ENTER]. 
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By default, Veeam Backup & Replication preserves the format of restored VM disks. If disks of the 
original VM are provisioned as thick, Veeam Backup & Replication will restore the VM from the backup 
with thick disks. If necessary, you can change the disk format of a restored VM.  

1. Expand a VM in the list 

2. Select the disk and click Disk Type.  

3. In the Disk Type Settings section, choose the format that will be used to restore virtual disks 
of the VM: same as the source disk, thin or thick. 

Note: 

 

Disk format change is supported only for VMs with Virtual Hardware version 7 or later. 

 

Step 8. Select Destination Folder and Change VM Names 

The Folder step of the wizard is available if you have chosen to change the location and settings for 
the restored VM. 

To specify a destination VM folder: 

1. Select a VM in the list and click Folder.  

2. Choose a folder to which the VM will be placed. To facilitate selection, use the search field at 
the bottom of the window: enter a folder name or a part of it and click the Start search 
button on the right or press [ENTER]. 

Note: 

 

If you restore a VM to a standalone ESX(i) host not managed by vCenter Server, you cannot select a 
destination folder: this option will be disabled. 

By default, Veeam Backup & Replication restores a VM with its original name. However, you can 
change the name of the restored VM. For example, if you restore a VM to its original location, you may 
need to change its name to avoid potential problems. 

  



 

809   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

To change the VM name: 

1. Select a VM in the list and click Name.  

2. In the Change Name section, enter a new name explicitly or specify a change name rule by 
adding a prefix and/or suffix to the original VM name.  

You can change the VM name directly in the list:  

1. Select a VM in the list. 

2. Click the New Name field 

3. Enter the name to be assigned to the restored VM. 

 

Step 9. Specify Network Mapping 

The Network step of the wizard is available if you have chosen to change the location and settings for 
the restored VM. 

If you plan to restore a VM to a new location, for example, another site with a different set of networks, 
you can map source site networks to target site networks. Veeam Backup & Replication will use the 
network mapping table to update configuration files of the VM on the fly, during the restore process. 

To change networks to which the restored VM will be connected: 

1. Select a VM in the list and click Network. To apply changes in bulk, select several VMs in the 
list and click Network. 

If a VM is connected to multiple networks, expand the VM, select the network to map and 
click Network. The Select Network section displays all networks to which the destination 
host or cluster is connected.  

2. From the list of available networks, choose a network to which the VM must have access upon 
restore. To facilitate selection, use the search field at the bottom of the window: enter a 
network name or a part of it and click the Start search button on the right or press [ENTER]. 
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If you do not want to connect the restored VM to any virtual network, select the VM in the list and click 
Disconnected. 

 

Step 10. Specify Restore Reason 

At the Reason step of the wizard, enter a reason for restoring the selected VMs. The information you 
provide will be saved in the session history and you can reference it later. 

Tip: 

 

If you do not want to display the Reason step of the wizard in future, select the Do not show me 
this page again check box. 
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Step 11. Verify Restore Settings 

At the Summary step of the wizard, specify additional settings for VM restore: 

1. If you want to start the restored VM on the target host, select the Power on VM after 
restoring check box. 

2. Check the specified settings and click Finish. Veeam Backup & Replication will restore 
selected VMs in the specified destination. 
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Restoring VM Files 
You can restore specific VM files from the backup: VMDK, VMX and others. VM file restore can be 
helpful, for example, if one or several VM files have been deleted or corrupted and you need to replace 
them on the production storage. Veeam Backup & Replication lets you restore the necessary VM file 
directly from the image-level backup, without prior de-staging of the VM image from the backup file. 

Before restoring VM files from the backup, check prerequisites. Then use the Restore wizard to restore 
VM file(s).  

Before You Begin 

Before you restore VM files, check the following prerequisites: 

 You can restore VM files from a backup that has at least one successfully created restore 
point. 

 The server on which you plan to save restored VM files must be added to the backup 
infrastructure. 

Step 1. Launch Restore Wizard 

To launch the Restore wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from backup section, 
select VM files (VMDK, VMX). 

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, click the VM whose file(s) you want to restore and click 
VM Files > VM Files on the ribbon. 

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, right-click the VM whose file(s) you want to restore and 
select Restore VM files. 

 Double-click the VBK or VBM file (for example, in Microsoft Windows Explorer). In the 
displayed window, select the VM and click Restore > VM files.  

You can use this option if you perform restore on the backup server. You cannot use this 
option if you perform restore via the Veeam Backup & Replication console. 
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Step 2. Select VM 

At the Virtual Machine step of the wizard, select the VM whose file(s) you want to restore: 

1. In the Virtual machine list, expand the necessary backup. 

2. Select the VM. 

To quickly find a VM, you can use the search field at the bottom of the window. 

1. Enter a VM name or a part of it in the search field. 

2. Click the Start search button on the right or press [ENTER]. 

 

Step 3. Select Restore Point 

At the Restore Point step of the wizard, select the restore point from which you want to restore the 
VM file(s). 
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Step 4. Select VM Files and Destination 

At the Restore Destination step of the wizard, select the VM files you want to restore and destination 
where the restored files must be stored.  

1. From the Destination list, select where to store VM files: to an ESX(i) host, on the backup 
server or on a Microsoft Windows server added to the backup infrastructure. 

2. Use the Host Summary button to view information on available storage resources. In the 
Server Properties section, click Populate to load the list of storage locations, their capacity 
and available space. 

3. In the Path to folder section, specify a path to the folder on the selected host where files 
must be restored. To create a dedicated folder for restored files, click Make New Folder at the 
bottom of the window. 

4. In the VM files to restore section, select check boxes next to files that you want to restore. By 
default, all VM files are selected. 
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Step 5. Specify Restore Reason 

At the Restore Reason step of the wizard, enter a reason for restoring VM file(s). The information you 
provide will be saved in the session history and you can reference it later. 

 

Step 6. Finish Working with Wizard 

At the last step of the wizard, click Finish to start VM files restore. 
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Restoring VM Hard Disks 
You can restore virtual hard disks of a VM from the backup. The restored disks can be attached to the 
original VM (for example, if you need to replace a corrupted disk) or mapped to any other VM in the 
virtual infrastructure.  

Before restoring VM hard disks from the backup, check prerequisites. Then use the Hard Disk Restore 
wizard to restore the necessary VM disks. 

Before You Begin 

Before you restore VM disks, check the following prerequisites: 

 You can restore VM disks from a backup that has at least one successfully created restore 
point. 

 During the VM hard disk restore, Veeam Backup & Replication turns off the target VM to 
reconfigure its settings and attach restored disks. It is recommended that you stop all 
activities on the target VM for the restore period. 

 You cannot mount restored disks to a VM that has one or more snapshots. 

 On non-Microsoft Windows SMB3 storages, for example, Tintri, Veeam Backup & Replication 
may display the "Failed to disable integrity bit on disk N" warning during VM restore. You can 
ignore this warning for non-Microsoft Windows SMB3 storages. 
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Step 1. Launch Hard Disk Restore Wizard 

To launch the Hard Disk Restore wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from backup section, 
select VM hard disks. 

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, select the VM whose disks you want to restore and click 
VM Files > Virtual Disk on the ribbon. 

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup job, right-click the VM whose disks you want to restore 
and select Restore VM hard disk. 

 Double-click the VBK or VBM file (for example, in Microsoft Windows Explorer). In the 
displayed window, select the VM and click Restore > VM hard disk.  

You can use this option if you perform restore on the backup server. You cannot use this 
option if you perform restore via the Veeam Backup & Replication console. 

 

Step 2. Select VM 

At the Virtual Machine step of the wizard, select the VM whose disk(s) you want to restore: 

1. In the Virtual machine list, expand the necessary backup. 

2. Select the VM. 
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To quickly find a VM, you can use the search field at the bottom of the window. 

1. Enter a VM name or a part of it in the search field. 

2. Click the Start search button on the right or press [ENTER]. 

 
Step 3. Select Restore Point 

At the Restore Point step of the wizard, select the restore point from which you want to restore the 
VM disk(s). 

 



 

819   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Step 4. Select Virtual Hard Disks to Restore 

At the Disk Mapping step, select virtual hard disks to restore, choose a VM to which the disks must be 
attached and define additional restore settings. 

1. By default, Veeam Backup & Replication maps restored disks to the original VM. If the original 
VM was relocated or if you want to attach disks to another VM, you need to select the target 
VM manually. Click Browse and select the necessary VM from the virtual environment. 

To facilitate selection, you can use the search field at the bottom of the window: click the 
button on the left of the field to select the necessary type of object that must be searched for, 
enter a VM name or a part of it and click the Start search button on the right or press 
[ENTER]. 

2. Select check boxes next to virtual hard disks that you want to restore.  

3. To define virtual disk properties, select a disk in the list and click Change. In the Virtual Disk 
Properties section, pick a datastore where the restored hard disk must be placed. 

Note: 

 

If you use storage profiles in the virtual environment, Veeam Backup & Replication will display 
information about storage profiles in the Select Datastore window. You can select a datastore 
associated with the necessary storage profile. 

4. In the Virtual Disk Properties section, select a virtual device node.  

 If you want to replace an existing virtual disk, select an occupied virtual node. 

 If you want to attach the restored disk to the VM as a new drive, select a node that 
is not occupied yet. 

5. Veeam Backup & Replication preserves the format of the restored virtual hard disks. To 
change disk format, select the required option from the Restore disks list – same as on the 
original VM, force thin or force thick. Disk format change is supported only for VMs with 
Virtual Hardware version 7 or later. 

6. [For hard disk restore to the original location and with original format] Select the Quick 
rollback check box if you want to use incremental restore for the VM disk. 
Veeam Backup & Replication will query CBT to get data blocks that are necessary to revert the 
VM disk to an earlier point in time, and will restore only these data blocks from the backup. 
Quick rollback significantly reduces the restore time and has little impact on the production 
environment. 
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It is recommended that you enable this option if you restore a VM disk after a problem that 
occurred at the level of the VM guest OS: for example, there has been an application error or a 
user has accidentally deleted a file on the VM guest OS. Do not enable this option if the 
problem has occurred at the VM hardware level, storage level or due to a power loss. 
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Step 5. Specify Restore Reason 

At the Restore Reason step of the wizard, enter a reason for restoring VM disk(s). The information you 
provide will be saved in the session history and you can reference it later. 

 

Step 6. Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of VM disk(s) restore. 

1. Review details for the restore task. 

2. To start a VM immediately after the restore process, select the Power on VM after restoring 
check box. 

3. Click the Pick proxy to use link to select backup proxies over which VM data must be 
transported to the target datastore. You can assign backup proxies explicitly or instruct 
Veeam Backup & Replication to automatically select backup proxies. 

 If you choose Automatic selection, Veeam Backup & Replication will detect 
backup proxies that have access to the source datastore and will automatically 
assign optimal proxy resources for processing VM data. 

During the restore process, VM hard disks are processed simultaneously. 
Veeam Backup & Replication checks available backup proxies. If more than one 
backup proxy is available, Veeam Backup & Replication analyzes transport modes 
that the backup proxies can use for writing data to target, current workload on 
these backup proxies, and selects the most appropriate resources for VM hard disk 
processing.  

 If you choose Use the selected backup proxy servers only, you can explicitly 
select backup proxies that must be used for restore. It is recommended that you 
select at least two backup proxies to ensure that VM hard disks are recovered if one 
of backup proxies fails or loses its connectivity to the target datastore during 
restore. 
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4. Click Finish to start VM disk(s) restore. 
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Restoring VM Guest OS Files (Microsoft Windows) 
You can restore individual Microsoft Windows guest OS files from the backup or replica of a Microsoft 
Windows VM. 

Before restoring VM guest OS files, check prerequisites. Then use the Restore wizard to restore the 
necessary VM guest OS files and folders. 

Before You Begin 

Before you restore VM guest OS files, check the following prerequisites: 

 You can restore VM guest OS files from a backup or replica that has at least one successfully 
created restore point. 

 You cannot restore VM guest OS files from a running replica or if the replication job with the 
necessary VM is being performed. 

 You cannot restore files from a backup created in the reverse incremental mode if the backup 
job is being performed. If the backup is created in the incremental backup mode and the 
backup job is being performed, you can restore files from any available restore point. 

 If you plan to restore files from a VM running Microsoft Windows ReFS, for the restore process 
you must use Veeam Backup & Replication components running the following OSes: 

– [For VM file system browsing and file copy to another location] The Veeam Backup 
& Replication console must be installed on a machine running Microsoft Windows 
Server 2012 or Microsoft Windows Server 2012 R2. 

– [For restore to the original location] The Veeam Backup & Replication console and 
mount server asociated with the backup repository where backup files reside must 
be installed on a machine running Microsoft Windows Server 2012 or Microsoft 
Windows Server 2012 R2. 

 If you plan to restore VM guest OS files to their initial location, VMware Tools must be 
installed on the target VM. 

 If you plan to restore files from a VM running Microsoft Windows Server 2012 R2 and Data 
Deduplication is enabled for some VM volumes, for the restore process you must use 
Veeam Backup & Replication components running the following OSes: 

– [For copy to another location operations] The Veeam Backup & Replication console 
must be installed on a machine running Microsoft Windows Server 2012 or 
Microsoft Windows Server 2012 R2. Data Deduplication must be enabled on this 
machine. 

– [For restore to the original location] The Veeam Backup & Replication console and 
mount server asociated with the backup repository where backup files reside must 
be installed on a machine running Microsoft Windows Server 2012 or Microsoft 
Windows Server 2012 R2. Data Deduplication must be enabled on the mount 
server. 
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Step 1. Launch Restore Wizard 

To launch the Restore wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from backup or Restore 
from replica section, select Guest files (Windows). 

 Open the Backup & Replication view, in the inventory pane select Backups or Replicas. In 
the working area, expand the necessary backup or select the necessary replica, select the VM 
whose guest OS files you want to restore and click Guest Files > Microsoft Windows on the 
ribbon. 

 Open the Backup & Replication view, in the inventory pane select Backups or Replicas. In 
the working area, expand the backup or select a replica, right-click the VM whose guest OS 
files you want to restore and select Restore guest files > Microsoft Windows. 

 Double-click the VBK or VBM file (for example, in Microsoft Windows Explorer). In the 
displayed window, select the VM and click Restore > Guest files (Windows).  

You can use this option if you perform restore on the backup server. You cannot use this 
option if you perform restore via the Veeam Backup & Replication console. 

 

Step 2. Select VM 

At the Virtual Machine step of the wizard, select the VM whose guest OS files you want to restore: 

1. In the Virtual machine list, expand the necessary backup. 

2. Select the VM. 
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To quickly find a VM, you can use the search field at the bottom of the window. 

1. Enter a VM name or a part of it in the search field. 

2. Click the Start search button on the right or press [ENTER]. 

 

Step 3. Select Restore Point 

At the Restore Point step of the wizard, select the restore point from which you want to restore VM 
guest OS files. 
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Step 4. Specify Restore Reason 

At the Restore Reason step of the wizard, enter a reason for restoring VM guest OS files. The 
information you provide will be saved in the session history and you can reference it later. 

Tip: 

 

If you do not want to display the Restore Reason step of the wizard in future, select the Do not 
show me this page again check box. 
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Step 5. Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of VM guest OS files restore. 

1. Review details of the restore task. 

2. Click Finish to start restoring VM guest OS files from the backup or replica. 

 

Step 6. Save Restored Files 

When the restore process is complete, Veeam Backup & Replication opens the Veeam Backup browser 
with the file system tree of the restored VM. Note that names of the restored VM hard disks may differ 
from the original ones. 

You can perform the following operations with VM guest OS files in the Veeam Backup browser:  

 Restore files and folders to the original location 

 Save files and folders to a folder on the backup server or network shared folder 

 Launch Veeam Explorers for application item restore 

 Open files in Microsoft Windows Explorer 

After you finish restoring files, you can close the Veeam Backup browser. 
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Restoring Files to Original Location 

To restore files or folders to their original location, right-click the necessary file or folder in the file 
system tree or in the details pane on the right and select one of the following commands: 

 To overwrite the original file on the VM guest OS with the file restored from the backup, 
select Restore > Overwrite. 

 To save the file restored from the backup next to the original file, select Restore > Keep. 
Veeam Backup & Replication will add the RESTORED- prefix to the original file name and store 
the restored file in the same folder where the original file resides. 

Important! 

 

Restore to the initial location may fail for the following reasons: 

 VMware Tools are not installed on the target VM. 
 You have excluded the system disk from the VM backup. 

To restore guest OS files in such situation, you can use 1-click file-level restore or copy files to the 
selected folder and then move them to their initial location.  
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Saving Files to a New Location 

To save restored files or folders on the local machine or in a network shared folder: 

1. Right-click the necessary file or folder in the file system tree or in the details pane on the right 
and select Copy To. 

2. Choose to preserve their original NTFS permissions or not: 

 Select the Preserve permissions and ownership check box to keep the original 
ownership and security permissions for restored objects. 
Veeam Backup & Replication will copy selected files and folders along with 
associated Access Control Lists, preserving granular access settings. 

 Leave the Preserve permissions and ownership check box not selected if you do 
not want to preserve the original ownership and access settings for restored 
objects. Veeam Backup & Replication will change security settings: the user who 
launched the Veeam Backup & Replication console will be set as the owner of the 
restored object, while access permissions will be inherited from the folder to which 
the restored object is copied. 

3. If prompted, in the Credentials window specify settings of the user account to access the 
destination location.  
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Launching Veeam Explorers 

If you are restoring VM guest OS files of the virtualized Microsoft Active Directory Server, Microsoft 
Exchange Server, Microsoft SharePoint Server or Microsoft SQL Server or Oracle, you can launch a 
Veeam Explorer for the necessary application directly from the Veeam Backup browser. 

 To start Veeam Explorer for Microsoft Active Directory, browse to the Microsoft Active 
Directory database file (DIT) in the Veeam Backup browser, select it and click Active 
Directory Items on the Home tab or simply double-click the DIT file. 

 To start Veeam Explorer for Microsoft Exchange, browse to the Microsoft Exchange database 
file (EDB) in the Veeam Backup browser, select it and click Exchange Items on the Home tab 
or double-click the EDB file. 

 To start Veeam Explorer for Microsoft SharePoint, browse to the Microsoft SharePoint content 
database (MDF) in the Veeam Backup browser, select it and click SharePoint Items on the 
Home tab or double-click the MDF file. 

 To start Veeam Explorer for Microsoft SQL Server, browse to the Microsoft SQL Server 
database file in the Veeam Backup browser, select it and click SQL Server Databases on the 
Home tab or double-click the Microsoft SQL Server database file. For more information about 
default locations of Microsoft SQL Server database files, see http://technet.microsoft.com/en-
us/library/ms143547.aspx. 

Working with Windows Explorer 

You can use Microsoft Windows Explorer to work with restored files and folders.  

1. Click Explore on the ribbon in the Veeam Backup browser or right-click the necessary folder 
and select Explore.  

2. Veeam Backup & Replication will launch Microsoft Windows Explorer. Browse to the necessary 
VM guest OS files. 

You can also start Microsoft Windows Explorer from the Start menu of Microsoft Windows and browse 
to the necessary VM guest OS files. VM disks are mounted under the 
C:\veeamflr\<vmname>\<volume n> folder of the machine where the Veeam Backup & Replication 
console is installed. 

It is recommended that you use the Veeam Backup browser instead of Microsoft Windows Explorer for 
file-level restore. Use of the Veeam Backup browser has the following advantages: 

1. You can browse the VM guest OS file system ignoring the file system ACL settings. 

2. You can preserve permissions and ownership during file-level restore. 

If you open the VM file system via the Microsoft Windows Explorer, these capabilities will not be 
available. 

For more information, see SeBackupPrivilege and SeRestorePrivilege at https://msdn.microsoft.com/en-
us/library/windows/desktop/bb530716(v=vs.85).aspx. 

  

http://technet.microsoft.com/en-us/library/ms143547.aspx
http://technet.microsoft.com/en-us/library/ms143547.aspx
https://msdn.microsoft.com/en-us/library/windows/desktop/bb530716(v=vs.85).aspx
https://msdn.microsoft.com/en-us/library/windows/desktop/bb530716(v=vs.85).aspx
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Closing Veeam Backup Browser 

You can browse to VM guest OS files only while the Veeam Backup browser is open. After the Veeam 
Backup browser is closed, Veeam Backup & Replication unmounts VM disks from the machine where 
the Veeam Backup & Replication console is installed and mount server (if you have restored VM guest 
OS files to the original location). 

It is recommended that you close the Veeam Backup browser after you have finished restoring VM 
guest OS files. When the Veeam Backup browser is open, the backup file whose VM guest OS file 
system is displayed in the browser is locked on the backup repository. As a result, some scheduled 
operations that use this backup file may fail. 

Veeam Backup & Replication checks if there is any activity in the Veeam Backup browser with an 
interval of 5 minutes. If the user or Veeam Backup & Replication components and services do not 
perform any actions for 30 minutes, Veeam Backup & Replication displays a warning that the Veeam 
Backup browser is to be closed in 5 minutes.  

After the warning is displayed, you can perform one of the following actions: 

 You can close the Veeam Backup browser manually. 

 You can click Cancel to postpone the close operation. In this case, the Veeam Backup browser 
will remain open for 5 minutes. After this period expires, Veeam Backup & Replication will 
display the warning again. 

 You can perform no action at all. In this case, the Veeam Backup browser will be automatically 
closed in 5 minutes. 
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Restoring VM Guest OS Files (Multi-OS) 
With the multi-OS restore wizard, you can restore VM guest OS files from 15 file systems such as Linux, 
Unix, BSD, MacOS and many others. 

Before restoring VM guest OS files, check prerequisites. Then use the File Level Restore wizard to 
restore the necessary VM guest OS files and folders. 

Before You Begin 

Before you restore VM guest OS files, check the following prerequisites: 

 You can restore VM guest OS files from a backup or replica that has at least one successfully 
created restore point. 

 You cannot restore files from a backup created in the reverse incremental mode if the backup 
job is being performed. If the backup is created in the incremental backup mode and the 
backup job is being performed, you can restore files from any available restore point. 

 If you plan to restore VM guest OS files to their initial location, VMware Tools must be 
installed on the target VM. 

 Veeam Backup & Replication must have access to the guest OS of the target VM to deploy a 
coordination process. The coordination process performs a number of administrative actions 
on the target VM guest OS, for example, collects information about mount points. 

 [For Linux/Unix-based target VM] Veeam Backup & Replication uses the SSH protocol to 
communicate with the target Linux/Unix VM and requires the SCP utility on the target VM. 
Make sure that the SSH daemon is properly configured and SCP utility is available on the 
target VM. 

 Veeam Backup & Replication can restore ACL for recovered VM guest OS files. To let 
Veeam Backup & Replication detect the target Linux system architecture and kernel version, 
the following utilities must be present in the minimal configuration of the system: arch and 
uname. 

Mind the following limitations: 

 You cannot restore files directly to the original location from backups of BSD, Mac and Solaris 
VMs. You also cannot restore files directly to the original location from NSS filesystems. Use 
the Copy to option instead. 

 The multi-OS file-level restore wizard does not support restore of deduplicated volumes (for 
example, Microsoft Windows volumes with Data Deduplication enabled). 

Step 1. Launch Veeam File Level Restore Wizard 

To launch the Restore wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from backup section, 
select Guest files (other OS). 

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, select the VM whose guest OS files you want to restore 
and click Guest Files > Linux and other on the ribbon. 

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, right-click the VM whose guest OS files you want to 
restore and select Restore guest files > Linux and other. 

 Double-click the VBK or VBM file (for example, in Microsoft Windows Explorer). In the 
displayed window, select the VM and click Restore > Guest files (other OS).  

You can use this option if you perform restore on the backup server. You cannot use this 
option if you perform restore via the Veeam Backup & Replication console. 
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The welcome screen of the wizard will be displayed. If you do not want to see the welcome screen in 
future, select the Don't show this step again check box at the bottom of the screen. 

 

Step 2. Select VM 

At the Virtual Machine step of the wizard, select the VM whose guest OS files you want to restore: 

1. In the Virtual machine list, expand the necessary backup. 

2. Select the VM. 

To quickly find a VM, you can use the search field at the bottom of the window. 

1. Enter a VM name or a part of it in the search field. 

2. Click the Start search button on the right or press [ENTER]. 
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Step 3. Select Restore Point 

At the Restore Point step of the wizard, select the restore point from which you want to restore VM 
guest OS files. 

 

Step 4. Specify Restore Reason 

At the Restore Reason step of the wizard, enter a reason for restoring VM guest OS files. The 
information you provide will be saved in the session history and you can reference it later. 
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Step 5. Specify Location for Proxy Appliance 

At the Ready step of the wizard, select an ESX(i) host on which you want to place the proxy appliance. 
When the restore process starts, Veeam Backup & Replication will register the proxy appliance on the 
ESX(i) host and mount disks of the restored VM to this proxy appliance. The file system tree of the 
restored VM will be displayed in the file browser. After you restore necessary files and finish working 
with the file browser, the VM disks will be unmounted from the proxy appliance, and the proxy 
appliance will be deleted from the ESX(i) host.  

To locate the appliance: 

1. Click Customize at the bottom of the window. 

2. In the FLR Appliance Configuration window, select an ESX(i) host on which the proxy 
appliance must be registered.  

3. In the Resource pool field, specify a resource pool to which the proxy appliance must be 
placed. 

4. In the Network section, specify an IP address and other network settings for the proxy 
appliance. The proxy appliance must be placed in the same network where the backup server 
resides. 

5. To enable FTP access to the restored file system, select the Enable FTP server on appliance 
check box. As a result, users will be able to access the proxy appliance via FTP, browse the file 
system of the restored VM and download necessary files on their own. 

6. If you are performing restore of a VM with the Novell Storage Services file system, select the 
Restore Novell Storage Services file system check box. Veeam Backup & Replication will 
deploy a specific proxy appliance that supports the Novell Storage Services file system. 

7. Click OK.  

Important! 

 

When choosing an ESX(i) host for the proxy appliance used for file-level restore from the Novell 
Storage Services file system, make sure that it allows running VMs with 64-bit guest OS'es. 
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Step 6. Finish Working with Wizard 

At the last step of the wizard, click Finish to start restoring VM guest OS files. The file-level restore 
appliance may take about 10-40 seconds to boot. 

 

Step 7. Save Restored Files 

When the restore process is complete, Veeam Backup & Replication opens the Veeam Backup browser 
displaying the file system tree of the restored VM.  

You can restore files and folders to their original location, new location or access files on FTP. 

Note: 

 

You can browse the VM guest OS files and access restored files on the FTP only while the Veeam 
Backup browser with the restored files is open. After the Veeam Backup browser is closed, the VM 
disks will be unmounted from the proxy appliance, and the proxy appliance will be deleted from the 
ESX(i) host. 

Restoring Files to Original Location 

To restore files and folders to the original location, right–click the necessary file or folder in the file 
system tree or in the details pane on the right and select one of the following commands: 

 To overwrite the original file on the VM guest OS with the file restored from the backup, 
select Restore > Overwrite. 

 To save the file restored from the backup next to the original file, select Restore > Keep. 
Veeam Backup & Replication will add the RESTORED- prefix to the original file name and store 
the restored file in the same folder where the original file resides. 

To restore files to the original location, Veeam Backup & Replication uses the account for VM guest OS 
access specified in the backup job settings. If this account does not have sufficient rights to access the 
target VM, you will be prompted to enter credentials. In the Credentials window, specify a user 
account to access the destination location (server or shared folder).  
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Saving Files to New Location 

To save files and folders to a new location: 

1. Right–click the necessary file or folder and select Copy to. 

2. In the Select Destination window, select the destination server (local or remote) from the list 
or provide a path to the shared folder. 

 If you are recovering files to a Linux server, you can select the destination server 
from the list or add a destination server ad-hoc. To do this, scroll down the list of 
servers and choose Specify a different host at the end of the list. Follow the steps 
of the wizard to add a Linux server that will be used as a destination host.  

The server you add ad-hoc will not appear in the list of managed hosts in 
Veeam Backup & Replication: its purpose is to host the files that you recover. It will 
only remain visible in the Veeam Backup browser until all currently active file-level 
restore sessions are completed.  

 If you are recovering files to a shared folder, specify a path to the destination folder.  

3. If you want to preserve original permissions and ownership for recovered files, select the 
Preserve permissions and ownership check box. 

4. If prompted, in the Credentials window specify settings of the user account to access the 
destination location.  

Important! 

 

To restore original permissions and ownership settings, the account you have specified should have 
privileges to change the owner on the selected server or shared folder.  
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Accessing Files over FTP 

If you have chosen to enable FTP server on the FLR appliance, the restored file system will also be 
available over FTP at ftp://<FLR_appliance_IP_address>. Other users in the same network can access 
the FLR appliance to restore the files they need. 
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Restoring Data from Encrypted Backups 
When you restore data from an encrypted backup, Veeam Backup & Replication performs data 
decryption automatically in the background or requires you to specify a password. 

 If encryption keys required to unlock the backup file are available in the configuration 
database, you do not need to specify the password. Veeam Backup & Replication uses keys 
from the database to unlock the backup file. Data decryption is performed in the background, 
and data restore from the encrypted backup does not differ from that from an unencrypted 
one. 

Automatic backup file decryption is performed if the following conditions are met: 

1. You encrypt and decrypt the backup file on the same backup server that uses the 
same configuration database. 

2. The backup is not removed from the Veeam Backup & Replication console. 

 If encryption keys are not available in the configuration database, you can restore data from 
the encrypted backup with the following methods: 

– You can provide a password or a set of passwords to unlock an encrypted file. 
For more information, see Decrypting Data with Password. 

– You can use Veeam Backup Enterprise Manager to unlock an encrypted file 
without a password. For more information, see Decrypting Data Without 
Password. 

Decrypting Data with Password 

To unlock an encrypted file, you must specify a password. The password must be the same as the 
password that was used to encrypt the backup file. 

To decrypt a backup file: 

1. Import an encrypted backup file to the Veeam Backup & Replication console. After the import, 
the encrypted backup will appear under the Backups > Disk (encrypted) node in the 
inventory pane.  

2. In the inventory pane, select Disk (encrypted).  

3. In the working area, select the imported backup and click Specify Password on the ribbon or 
right-click the backup and select Specify password. 

4. In the Description field of the Specify Password window, Veeam Backup & Replication 
displays a hint for the password that was used to encrypt the backup file. Use the hint to 
recall the password. 

5. In the Password field, enter the password for the backup file.  

If you changed the password one or several times while the backup chain was created, you must enter 
passwords in the following manner: 

 If you select a metadata file (VBM) for import, you must specify the latest password that was 
used to encrypt files in the backup chain. 

 If you select a full backup file (VBK) for import, you must specify the whole set of passwords 
that were used to encrypt files in the backup chain.  

If you enter correct password(s), Veeam Backup & Replication will decrypt the backup file. The backup 
will be moved under the Backups > Disk (imported) node in the inventory pane. You can perform 
restore operations with the backup file in a regular manner.  



 

840   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Note: 

 

If you use Enterprise or Enterprise Plus Edition of Veeam Backup & Replication and the backup 
servers are connected to Veeam Backup Enterprise Manager, you can recover data from an 
encrypted backup even if the password is lost. For more information, see Decrypting Data Without 
Password. 

 

Decrypting Data Without Password 

If you have lost or forgotten a password, you can unlock an encrypted file with the help of Veeam 
Backup Enterprise Manager.  

You can restore data without a password only if your backup infrastructure meets the following 
conditions: 

1. You use Enterprise or Enterprise Plus Edition of Veeam Backup & Replication. 

2. The backup server on which you encrypted data is connected to Veeam Backup Enterprise 
Manager.  

3. The backup server on which you generate a request for data decryption is connected to 
Veeam Backup Enterprise Manager. 

Important! 

 

Backup servers that you use for data decryption must be connected to the same instance of Veeam 
Backup Enterprise Manager. If you connect a backup server to several instances of Veeam Backup 
Enterprise Manager, this may cause unexpected behavior, and the decryption process may fail. 

The restore process is accomplished with the help of two wizards that run on two servers:  

1. The Encryption Key Restore wizard on the backup server. 

2. The Password Recovery wizard on the Veeam Backup Enterprise Manager server. 

To restore encrypted data without a password: 

1. Create a request for data restore 

2. Process the request in Veeam Backup Enterprise Manager 

3. Complete the key restore process 
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Step 1. Create Request for Data Restore 

This procedure is performed by the Veeam Backup Administrator on the backup server. 

1. Import encrypted backup to the Veeam Backup & Replication console.  

2. Select the imported backup and click Specify Password on the ribbon or right-click the 
backup and select Specify password.  

3. In the Specify Password window, click the I have lost the password link. 

 

4.  Veeam Backup & Replication will launch the Encryption Key Restore wizard. At the Request 
step of the wizard, review the generated request for data recovery. Use buttons at the bottom 
of the wizard to copy the request to the Clipboard or save the request to a text file. 

5. Send the copied request by email or pass it in any other way to the Veeam Backup Enterprise 
Manager Administrator. 

Tip: 

 

You can close the Encryption Key Restore wizard on the backup server and start it anew when you 
receive a response from the Veeam Backup Enterprise Manager Administrator.  
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Step 2. Process Request in Veeam Backup Enterprise Manager 

This procedure is performed by the Veeam Backup Enterprise Manager Administrator on the Veeam 
Backup Enterprise Manager server. 

1. Copy the obtained request to the Clipboard.  

2. In Veeam Backup Enterprise Manager, go to the Configuration > Key Management section.  

3. Click Password Recovery at the top of the section to open the Password Recovery wizard. 

4. Paste the request that you have received from the Veeam Backup Administrator. You can use 
the [CTRL+V] key combination or click Paste at the bottom of the wizard. 

 

5. Follow the next steps of the wizard. At the Response step of the wizard, copy the text 
displayed in the wizard to the Clipboard.  

6. Send the copied response by email or pass it in any other way to the Veeam Backup 
Administrator working on the backup server. 
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Step 3. Complete Key Restore Process 

This procedure is performed by the Veeam Backup Administrator on the backup server. 

1. In Veeam Backup & Replication, get back to the Encryption Key Restore wizard.  

2. Enter the copied response to the text window at the Response step of the Encryption Key 
Restore wizard. 

3. Follow the next steps of the wizard. At the last step, click Finish. Veeam Backup & Replication 
will retrieve the decrypted storage keys from the response, apply them to the encrypted file 
and unlock the file content. 
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Working with Veeam Explorers 
You can use Veeam Explorers to restore application items directly from VM backups and replicas. 

Using Veeam Explorer for Microsoft Active Directory 

You can use Veeam Explorer for Microsoft Active Directory to restore Microsoft Active Directory 
objects from any successfully created backup or replica of a virtualized Microsoft Active Directory 
Server. The backup or replica must be created with application-aware processing enabled and the 
corresponding options turned on.  

To launch Veeam Explorer for Microsoft Active Directory from Veeam Backup & Replication: 

1. Open the Backup & Replication view.  

2. In the inventory pane, select the Backups or Replicas node. 

3. In the working area, select the necessary backup or replica. 

4. Click Application Items > Microsoft Active Directory on the ribbon or right-click the 
necessary backup or replica and select Restore application items > Microsoft Active 
Directory items. 

5. Veeam Backup & Replication will open the Microsoft Active Directory Object Restore 
wizard. You can use this wizard to automatically extract the Microsoft Active Directory 
database from the backup or replica and open it in Veeam Explorer for Microsoft Active 
Directory. 

Detailed information about preparing your applications for item-level recovery and using with Veeam 
Explorer for Microsoft Active Directory is provided in the Veeam Explorer for Microsoft Active Directory 
help. To open the help, do one of the following: 

 Open Veeam Explorer for Microsoft Active Directory and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Microsoft 
Active Directory. 

 Use the following link: https://helpcenter.veeam.com/backup/explorers/.  

 

https://helpcenter.veeam.com/backup/explorers/
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Using Veeam Explorer for Microsoft Exchange 

You can use Veeam Explorer for Microsoft Exchange to restore Microsoft Exchange items from any 
successfully created backup or replica of a virtualized Microsoft Exchange Server. The backup or 
replica must be created with application-aware processing enabled and the corresponding options 
turned on. 

To launch Veeam Explorer for Microsoft Exchange from Veeam Backup & Replication: 

1. Open the Backup & Replication view.  

2. In the inventory pane, select the Backups or Replicas node. 

3. In the working area, select the necessary backup or replica. 

4. Click Application Items > Microsoft Exchange on the ribbon or right-click the necessary 
backup or replica and select Restore application items > Microsoft Exchange items. 

5. Veeam Backup & Replication will open the Microsoft Exchange Item Level Restore wizard. 
You can use this wizard to automatically extract the Microsoft Exchange database from the 
backup or replica and open it in Veeam Explorer for Microsoft Exchange. 

Detailed information about preparing your applications for item-level recovery and using with Veeam 
Explorer for Microsoft Exchange is provided in the Veeam Explorer for Microsoft Exchange help. To 
open the help, do one of the following: 

 Open Veeam Explorer for Microsoft Exchange and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Microsoft 
Exchange. 

 Use the following link: https://helpcenter.veeam.com/backup/explorers/.  

 

  

https://helpcenter.veeam.com/backup/explorers/
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Using Veeam Explorer for Microsoft SharePoint 

You can use Veeam Explorer for Microsoft SharePoint to restore Microsoft SharePoint items from any 
successfully created backup or replica of a virtualized Microsoft SharePoint Server. The backup or 
replica must be created with application-aware processing enabled and the corresponding options 
turned on.  

To launch Veeam Explorer for Microsoft SharePoint from Veeam Backup & Replication: 

1. Open the Backup & Replication view.  

2. In the inventory pane, select the Backups or Replicas node. 

3. In the working area, select the necessary backup or replica. 

4. Click Application Items > Microsoft SharePoint on the ribbon or right-click the necessary 
backup or replica and select Restore application items > Restore Microsoft SharePoint 
items. 

5. Veeam Backup & Replication will open the Microsoft SharePoint Item Restore wizard. You 
can use this wizard to automatically extract the Microsoft SharePoint content database from 
the backup or replica and open it in Veeam Explorer for Microsoft SharePoint. 

Detailed information about preparing your applications for item-level recovery and using with Veeam 
Explorer for Microsoft SharePoint is provided in the Veeam Explorer for Microsoft SharePoint help. To 
open the help, do one of the following: 

 Open Veeam Explorer for Microsoft SharePoint and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Microsoft 
SharePoint. 

 Use the following link: https://helpcenter.veeam.com/backup/explorers/.  

 

https://helpcenter.veeam.com/backup/explorers/
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Using Veeam Explorer for Microsoft SQL Server 

You can use Veeam Explorer for Microsoft SQL to restore databases from any successfully created 
backup or replica of a virtualized Microsoft SQL Server. The backup or replica must be created with 
application-aware processing enabled and the corresponding options turned on.  

To launch Veeam Explorer for Microsoft SQL from Veeam Backup & Replication: 

1. Open the Backup & Replication view.  

2. In the inventory pane, select the Backups or Replicas node. 

3. In the working area, select the necessary backup or replica. 

4. Click Application Items > Microsoft SQL Server on the ribbon or right-click the necessary 
backup or replica and select Restore application items > Restore Microsoft SQL items. 

5. Veeam Backup & Replication will open the Microsoft SQL Server Database Restore wizard. 
You can use this wizard to automatically extract the Microsoft SQL database from the backup 
or replica and open it in Veeam Explorer for Microsoft SQL. 

Detailed information about preparing your applications for item-level recovery and using with Veeam 
Explorer for Microsoft SQL is provided in the Veeam Explorer for Microsoft SQL help. To open the help, 
do one of the following: 

 Open Veeam Explorer for Microsoft SQL Server and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Microsoft SQL. 

 Use the following link: https://helpcenter.veeam.com/backup/explorers/.  

 

  

https://helpcenter.veeam.com/backup/explorers/


 

848   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Using Veeam Explorer for Oracle 

You can use Veeam Explorer for Oracle to restore databases from any successfully created backup or 
replica of a virtualized Oracle system. The backup or replica must be created with application-aware 
processing enabled and the corresponding options turned on.  

To launch Veeam Explorer for Oracle from Veeam Backup & Replication: 

1. Open the Backup & Replication view.  

2. In the inventory pane, select the Backups or Replicas node. 

3. In the working area, select the necessary backup or replica. 

4. Click Application Items > Oracle on the ribbon or right-click the necessary backup or replica 
and select Restore application items > Oracle database. 

5. Veeam Backup & Replication will open the Oracle Database Restore wizard. You can use this 
wizard to automatically extract the Oracle database from the backup or replica and open it in 
Veeam Explorer for Oracle. 

Detailed information about preparing your applications for item-level recovery and using with Veeam 
Explorer for Oracle is provided in the Veeam Explorer for Oracle help. To open the help, do one of the 
following: 

 Open Veeam Explorer for Oracle and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Oracle. 

 Use the following link: https://helpcenter.veeam.com/backup/explorers/.  

 

  

https://helpcenter.veeam.com/backup/explorers/
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Performing Replica Failover and Failback 
With the replica failover and failback possibilities, you can recover corrupted VMs in case of software 
or hardware malfunction. 

The following operations can be performed as part of the failover and failback workflow: 
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Performing Failover 
If a VM becomes unavailable or fails in case of a disaster, you can fail over to a VM replica and quickly 
restore services in the production environment. When you perform failover, the VM replica takes over 
the role of the original VM. As a result, you have your VM up and running within a couple of minutes, 
and your users can access services and applications they need with minimal disruption.  

Before performing failover, check prerequisites. Then use the VMware Failover wizard to fail over the 
VM replica. 

Before You Begin 

Before you fail over to a VM replica, check the following prerequisites: 

 The failover operation can be performed for VMs that have been successfully replicated at 
least once. 

 VM replica(s) must be in the Ready state. 

Step 1. Launch Failover Wizard 

To launch the Failover wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from replica section, 
select Failover to replica. 

 Open the Backup & Replication view, in the inventory pane select Replicas. In the working 
area, select the necessary replica and click Failover Now on the ribbon. 

 Open the Backup & Replication view, in the inventory pane select Replicas. In the working 
area, right-click the necessary replica and select Failover Now. 
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Step 2. Select VMs 

At the Virtual Machines step of the wizard, select one or more VMs for which you want to perform 
failover. You can perform failover for separate VMs and whole VM containers. 

To select VMs and VM containers: 

1. Click Add VM.  

2. Select where to browse for VMs and VM containers: 

 From infrastructure — browse the virtual environment and select VMs or VM 
containers. If you choose a VM container, Veeam Backup & Replication will expand 
it to a plain VM list. 

 From replicas — browse existing replicas and select VMs or VM containers under 
replication jobs.  

To quickly find VMs or VM containers, you can use the search field at the top of the wizard. 

1. Enter a VM or VM container name or a part of it in the search field. 
Veeam Backup & Replication will display possible matches.  

2. If the VM or VM container is not in the list, click the Show more link to browse the virtual 
infrastructure. 

Note: 

 

Make sure that VMs you select from the virtual environment have been successfully replicated at 
least once.  
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Step 3. Select Restore Point 

By default, Veeam Backup & Replication uses the latest valid restore point of the VM replica. However, 
you can fail over to an earlier state of the VM. If you have chosen to perform failover for several VMs, 
you can select the necessary restore point for every VM in the list. 

To select a restore point for a VM: 

1. In the Virtual machines to failover list, select a VM. 

2. Click Point on the right.  

3. In the Restore Points window, select a restore point that must be used. 
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Step 4. Specify Failover Reason 

At the Reason step of the wizard, enter a reason for failing over to the VM replica(s). The information 
you provide will be saved in the session history and you can reference it later. 

Tip: 

 

If you do not want to display the Reason step of the wizard in future, select the Do not show me 
this page again check box. 
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Step 5. Review Summary and Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of failover. 

1. Review details of the failover task. 

2. Click Finish to start the failover process. 

When the failover process is complete, the VM replica(s) will be started on the target host(s). 
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Performing Permanent Failover 
With permanent failover, you can finalize failover to a VM replica. As a result of permanent failover, the 
VM replica on the target host ceases to exist as a replica and takes on the role of the original VM. 

To perform permanent failover, do either of the following: 

 Open the Backup & Replication view, in the inventory pane select Replicas. In the working 
area, select the necessary replica and click Permanent Failover on the ribbon. 

 Open the Backup & Replication view, in the inventory pane select Replicas. In the working 
area, right-click the necessary replica and select Permanent Failover. 

In the displayed window, click Yes to confirm the operation. 

To protect the VM replica from corruption after performing a permanent failover, 
Veeam Backup & Replication removes the VM replica from the Replicas list. Additionally, 
Veeam Backup & Replication reconfigures the replication job and adds the original VM to the list of 
exclusions. When the replication job that processes the original VM starts, the VM will be skipped from 
processing, and no data will be written to the working VM replica. 
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Undoing Failover 
With the undo failover operation, you can power off running VM replicas on target hosts and roll back 
to initial state of VM replicas. 

To undo failover, do either of the following: 

 Open the Backup & Replication view, in the inventory pane select Replicas. In the working 
area, select the necessary replica and click Undo Failover on the ribbon. 

 Open the Backup & Replication view, in the inventory pane select Replicas. In the working 
area, right-click the necessary replica and select Undo Failover. 

In the displayed window, click Yes to confirm the operation. 
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Performing Failover by Failover Plan 
You can preset scenarios for one-click failover for a group of dependent VMs. The failover plan is 
created in advance and used to perform failover of the group of VMs in case of original VMs are out of 
service for any reason. 

Creating Failover Plans 

If you have a number of VMs running dependent applications, you need to failover them one by one, 
as a group. To do this automatically, you can prepare a failover plan.  

Before creating a failover plan, check prerequisites. Then use the New Failover Plan wizard to create a 
failover plan. 

Before You Begin 

Before you create a failover plan, check the following prerequisites: 

 VMs that you plan to include in the failover plan must be successfully replicated at least once. 

 VM replicas must be in the Ready state. 

 If you plan to use pre-failover and/or post-failover scripts for the failover plan, you must 
create scripts before you configure the failover plan. 
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Step 1. Launch New Failover Plan Wizard 

To launch the New Failover Plan wizard, do one of the following: 

 On the Home tab, click Failover Plan and select VMware. 

 Open the Backup & Replication view, in the inventory pane select Replicas. In the working 
area select one or more VMs, click Add to Failover Plan > New Failover Plan on the ribbon 
or right-click one or more VMs and select Add to failover plan > New Failover Plan.  

In this case, the VMs will be automatically added to the failover plan. You can add other VMs 
to the failover plan when passing through the wizard steps. 

 Open the Virtual Machines view, in the working area select one or more VMs, click Add to 
Failover Plan > New Failover Plan on the ribbon or right-click one or more VMs and select 
Add to failover plan > New Failover Plan. 

In this case, the selected VMs will be automatically added to the failover plan. You can add 
other VMs to the failover plan when passing through the wizard steps. 
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Step 2. Specify Failover Plan Name and Description 

At the General step of the wizard, specify a name and description for the failover plan and define 
script settings for the plan if necessary. 

1. In the Name field, enter a name for the failover plan. 

2. In the Description field, provide a description for future reference. The default description 
contains information about the user who created the failover plan, date and time when the 
plan was created. 

3. If you want to execute custom scripts before and/or after the failover plan, select the Pre-
failover script and Post-failover script check boxes and click Browse to choose executable 
file(s). Veeam Backup & Replication supports script files in the following formats: EXE, BAT, 
CMD, JS, VBS, WSF, PS1, SH. For example, you may want stop some applications on 
production VMs before the failover plan starts or send an email to backup administrators after 
the failover plan finishes. 
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Step 3. Select VMs  

At the Virtual Machines step of the wizard, select VMs that you want to add to the failover plan. You 
can add separate VMs and whole VM containers. 

To add VMs and VM containers: 

1. Click Add VM.  

2. Select where to browse for VMs and VM containers: 

 From infrastructure — browse the virtual environment and select VMs or VM 
containers. If you choose a VM container, Veeam Backup & Replication will expand 
it to a plain VM list. 

To quickly find VMs or VM containers, you can use the search field at the bottom of 
the Add Object window. Enter a VM or VM container name or a part of it in the 
search field and click Start search or press [ENTER].  

 From replicas — browse existing replication jobs and select all VMs or specific VMs 
from replication jobs.  

To quickly find VMs, you can use the search field at the bottom of the Select 
Replica window. Enter a VM name or a part of it in the search field and click Start 
search or press [ENTER].  

Note: 

 

Make sure that VMs you select from the virtual environment have been successfully replicated at 
least once.  
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Step 4. Define VM Failover Order 

The VM replicas in the failover plan are started in the order they appear in the VM list. If some VMs 
provide environment for other dependent VMs, make sure that they are started first. 

To set VM start order: 

1. Select the VM in the list 

2. Move the VM up or down the list using the Up and Down buttons on the right.  

 

Step 5. Set Time Delay 

After you have set the order for VMs in the failover plan, you need to set a time delay for VMs. The 
delay time defines for how long Veeam Backup & Replication must wait before starting the failover 
operation for the next VM in the list. You can use time delays to make sure that some VMs are already 
running at the moment dependent VMs start.  

Time delays can be specified for all VMs in the list except the last one. If you do not specify time delays, 
VMs will be started simultaneously. 

For example, you have added 2 VMs to the failover plan and set a time delay to 60 seconds for the first 
VM in the list. Veeam Backup & Replication will perform failover in the following manner: 
Veeam Backup & Replication will start the failover operation for the first VM in the list, then wait for 60 
seconds and start the failover operation for the second VM in the list. 
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To set the time delay for a VM: 

1. Select it and click Set Delay on the right or double-click the VM in the list. 

2. Enter the time interval that you consider sufficient for this VM to boot. 

 

Step 6. Review Summary and Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of the failover plan configuration. 

1. Review details for the configured failover plan. 

2. Click Finish to create the failover plan. 
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Running Failover Plans 

With a failover plan, you can fail over the VMs to their replicas at any time. You can fail over to the 
most recent VM state or select the necessary restore point for VMs in the failover plan. 

To fail over to the VM replicas latest restore point: 

1. Open the Backup & Replication view. 

2. Expand the Replicas node.  

3. Select Failover Plans.  

4. In the working area, right-click the failover plan and select Start. 

To fail over to a certain restore point: 

1. Open the Backup & Replication view. 

2. Expand the Replicas node.  

3. Select Failover Plans.  

4. In the working area, right-click the failover plan and select Start to.  

5. In the displayed dialog box, select the backup date and time. Veeam Backup & Replication 
will find the closest restore point prior to the entered value for each VM and fail over to it. 

 

  



 

864   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Undoing Failover by Failover Plans 

You can undo failover for all VMs added to the failover plan at once. When you undo failover, you 
switch the workload back to original VMs and discard all changes that were made to VM replicas 
during failover. 

To undo failover by a failover plan: 

1. Open the Backup & Replication view. 

2. Expand the Replicas node.  

3. Select Failover Plans. 

4. In the working area, right-click the failover plan and select Undo. 

5. In the displayed dialog box, click Yes to confirm the operation. 
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Performing Planned Failover 
Planned failover is the operation of switching from a running VM to its replica. Planned failover is 
performed to transfer the workload to the replica in advance in case the original VM is scheduled to go 
offline for some time. 

Before performing planned failover, check prerequisites. Then use the Planned Failover wizard to 
perform planned failover. 

Before You Begin 

Before you perform planned failover, check the following prerequisites: 

 VMs for which you plan to perform planned failover must be successfully replicated at least 
once. 

 VM replicas must be in the Ready state. 

Step 1. Launch Planned Failover Wizard 

To launch the Planned Failover wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from replica section, 
select Planned failover. 

 Open the Backup & Replication view, expand the Replicas node. In the working area, select 
one or more VMs and click Planned Failover on the ribbon. You can also right-click one or 
more VMs and select Planned Failover. 

 Open the Virtual Machines view, in the working right-click one or more VMs area and select 
Restore > Planned Failover.  

In this case, the selected VMs will be automatically included into the planned failover task. 
You can add other VMs to the task when passing through the wizard steps. 
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Step 2. Select VMs 

At the Virtual Machines step of the wizard, select one or more VMs for which you want to perform 
failover. You can perform failover for separate VMs and whole VM containers. 

To select VMs and VM containers: 

1. Click Add VM.  

2. Select where to browse for VMs and VM containers: 

 From infrastructure — browse the virtual environment and select VMs or VM 
containers. If you choose a VM container, Veeam Backup & Replication will expand 
it to a plain VM list. 

To quickly find VMs or VM containers, you can use the search field at the bottom of 
the Add Object window. Enter a VM or VM container name or a part of it in the 
search field and click Start search or press [ENTER].  

 From replicas — browse existing replication jobs and select all VMs or specific VMs 
from replication jobs.  

To quickly find VMs, you can use the search field at the bottom of the Backup 
Browser window. Enter a VM name or a part of it in the search field and click Start 
search or press [ENTER].  

You can also use the search field at the top of the wizard: 

1. Enter a VM name or a part of it in the search field. Veeam Backup & Replication will 
display possible matches.  

2. If the VM is not in the list, click the Show more link to browse existing VM replicas. 
Veeam Backup & Replication will open the Backup Browser window, and you can 
select the necessary VM replica there. 

Note: 

 

Make sure that VMs you select from the virtual environment have been successfully replicated at 
least once.  

 



 

867   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Step 3. Specify Failover Reason 

At the Reason step of the wizard, enter a reason for failing over to the VM replica(s). The information 
you provide will be saved in the session history and you can reference it later. 

Tip: 

 

If you do not want to display the Reason step of the wizard in future, select the Do not show me 
this page again check box. 
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Step 4. Review Summary and Finish Working with Wizard 

At the Summary step of the wizard, complete the procedure of planned failover. 

1. Review details of the failover task. 

2. Click Finish to start the failover process. 

Once planned failover is complete, the VM replica(s) will be started on the target host(s). 

 

 



 

869   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Performing Failback 
With the Failback option, you can switch from a VM replica back to the original VM or restore a VM 
from a VM replica in a new location.  

Before starting failback, check prerequisites. Then use the Failback wizard to switch back to the 
original VM.  

Before You Begin 

Before you perform failback, check the following prerequisites: 

 VMs for which you plan to perform failback must be successfully replicated at least once. 

 VM replicas must be in the Failover state. 

 On non-Microsoft Windows SMB3 storages, for example, Tintri, Veeam Backup & Replication 
may display the "Failed to disable integrity bit on disk N" warning during VM restore. You can 
ignore this warning for non-Microsoft Windows SMB3 storages. 

Step 1. Launch Failback Wizard 

To launch the Failback wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from replica section, 
select Failback to production. 

 Open the Backup & Replication view, in the inventory pane select Replicas. In the working 
area, select the necessary replica and click Failback to Production on the ribbon. 

 Open the Backup & Replication view, in the inventory pane select Replicas. In the working 
area, right-click the necessary replica and select Failback to production. 

 

  



 

870   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Step 2. Select VM Replicas to Fail Back 

At the Replica step of the wizard, select one or more VM replicas from which you want to fail back.  

1. Click Populate to display all existing replicas in the Failover state.  

2. Leave check boxes selected for those VM replicas from which you want to fail back. 

 

Step 3. Select Failback Destination 

At the Destination step of the wizard, select the failback destination and backup proxies for VM data 
transport during failback. 

1. Veeam Backup & Replication supports three possible failback destination variants. Note that 
the Failback wizard displays a different set of steps for every failback variant. 

 Select Failback to the original VM if you want to fail back to the original VM 
residing on the source host. Veeam Backup & Replication will restore the original 
VM to the current state of its replica.  

If this option is selected, you will pass to the Summary step of the wizard. 

 Select Failback to the original VM restored in a different location if you have 
recovered the original VM from a backup in a new location, and you want to switch 
to it from the replica. In this case, Veeam Backup & Replication will synchronize the 
recovered VM with the current state of the replica.  

If this option is selected, you will pass to the Target VM step of the wizard. 

 Select Failback to the specified location if you want to restore the original VM 
from a replica – in a new location and/or with different settings (such as VM 
location, network settings, virtual disk and configuration files path and so on).  

If this option is selected, you will need to complete all further steps of the wizard. 

If you fail back to the original VM or the original VM is restored in a new location, only 
differences between the existing virtual disks and their state will be transferred to the original 
VM. Veeam Backup & Replication will not transfer replica configuration changes such as a 
different IP address or network settings (if replica re-IP and network mapping were applied), 
new hardware or virtual disks added while the replica was in the Failover state. 
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If you choose to perform advanced failback, the entire VM replica, including its configuration 
and virtual disks content, will be restored in the selected location. 

2. Select the Restore VM tags check box if you want to restore tags that were assigned to the 
original VM, and assign them to the restored VM. Veeam Backup & Replication will restore the 
VM with original tags if the following conditions are met: 

 The VM is restored to its original location. 

 The original VM tag is still available on the source VMware vCenter Server. 

3. Click the Pick backup proxies for data transfer link to select backup proxies for data 
transfer during failback. In the offsite replication scenario, you must select one backup proxy 
in the production site and one proxy in the DR site. In the onsite replication scenario, you can 
use the same backup proxy as a source and target one. 

4. In the Choose backup Proxy section, click Choose to assign a backup proxy. You can assign 
backup proxies explicitly or instruct Veeam Backup & Replication to select backup proxies 
automatically. 

 If you choose Automatic selection, Veeam Backup & Replication will detect 
backup proxies that are connected to the source datastore and will automatically 
assign optimal proxy resources for processing VM data. 

VMs selected for failback are processed one by one. Before processing a new VM in 
the VM list, Veeam Backup & Replication checks available backup proxies. If more 
than one backup proxy is available, Veeam Backup & Replication analyzes transport 
modes that the backup proxies can use, the current workload on the backup 
proxies to select the most appropriate resource for VM processing. 

 If you choose Use the selected backup proxy servers only, you can explicitly 
define backup proxies that must be used for data transfer. It is recommended that 
you select at least two backup proxies to ensure that failover is performed should 
one of backup proxies fail or lose its connectivity to the source or target datastore. 

 

  



 

872   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Restoring Storage Profiles 

If the replicated VM was associated with the storage profile, in the failback to original location 
scenario, Veeam Backup & Replication will associate the restored VM with this storage profile. 

When you click Next, Veeam Backup & Replication will check storage profiles in the virtual 
environment and compare this information with the information about the replica storage profile. If 
the original storage profile has been changed or deleted, Veeam Backup & Replication will display a 
warning. You can select one of the following options: 

 Current — the restored VM will be associated with the profile with which the original VM in 
the production environment is currently associated. 

 Default — the restored VM will be associated with the profile that is set as default for the 
target datastore. 

 Stored — the restored VM will be associated with the profile that was assigned to the original 
VM at the moment of replication. 

 For more information, see Storage Profile Restore. 
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Step 4. Select Destination Host 

The Host step of the wizard is only available if you have chosen to perform advanced failback.  

To specify a destination host: 

1. Select one or more VMs in the list and click Host.  

2. Choose a host or cluster where the VMs must be registered. 

To facilitate selection, you can use the search field at the bottom of the window. 

1. Click the button on the left of the field to select the necessary type of object that should be 
searched for: Cluster or Host. 

2. Enter an object’s name or a part of it and click the Start search button on the right or press 
[ENTER]. 

 

Step 5. Select Destination Resource Pool 

The Resource Pool step of the wizard is only available if you have chosen to perform advanced 
failback.  

To specify a destination resource pool: 

1. Select one or more VMs in the list and click Pool.  

2. Choose a resource pool to which the selected VMs will belong. 

3. If necessary, you can also select a vApp to which the restored VM will be included. 
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To facilitate selection, you can use the search field at the bottom of the window. Enter a resource pool 
name or a part of it and click the Start search button on the right or press [ENTER].  

 

Step 6. Select Destination Datastore 

The Datastore step of the wizard is only available if you have chosen to perform advanced failback.  

When restoring a VM from a replica, you can place an entire VM to a particular datastore or choose to 
store configuration files and disk files of a restored VM in different locations. 

To specify a destination datastore: 

1. Select one or more VMs in the list and click Datastore.  

2. If configuration and disk files of a VM should be placed to different datastores, expand the VM 
in the list, select the necessary file type and click Datastore. From the virtual environment, 
choose a datastore to which the selected objects will be stored. To facilitate selection, use the 
search field at the bottom of the window: enter a datastore name or a part of it and click the 
Start search button on the right or press [ENTER]. 

3. By default, Veeam Backup & Replication preserves the format of restored VM disks, so that if 
disks of the VM replica were provisioned as thick, Veeam Backup & Replication will restore the 
VM with thick disks. If necessary, you can change the disk format of a restored VM. To do so, 
expand a VM in the list, select the necessary disk and click Disk Type. In the Disk Type 
Settings section, choose the format that will be used to restore virtual disks of the VM: same 
as the source disk, thin or thick. 
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Note: 

 

Disk format change is supported only for VMs with Virtual Hardware version 7 or later. 

 

Step 7. Select Destination Folder 

The VM Folder step of the wizard is only available if you have chosen to perform advanced failback.  

To specify a destination VM folder: 

1. Select one or more VMs in the list and click Folder.  

2. Choose a folder to which the selected VMs must be placed.  

To facilitate selection, you can use the search field at the bottom of the window: enter a folder name 
or a part of it and click the Start search button on the right or press [ENTER]. 
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Note: 

 

If you fail back to a VM on a standalone ESX(i) host not managed by vCenter Server, you cannot select 
a destination folder: this option will be disabled. 

 

Step 8. Select Destination Network 

The Network step of the wizard is only available if you have chosen to perform advanced failback.  

If you plan to fail back to VMs in a new location (for example, another site with a different set of 
networks), you can map DR site networks to production site networks. Veeam Backup & Replication 
will use the network mapping table to update configuration files of VMs on the fly, during the failback 
process. 

To change networks to which restored VMs will be connected: 

1. Select one or more VMs in the list and click Network.  

2. If a VM is connected to multiple networks, expand the VM, select the network to map and 
click Network.  

3. The Select Network section displays all networks to which the destination host or cluster is 
connected. From the list of available networks, choose a network to which the original VMs 
should have access upon failback. To facilitate selection, use the search field at the bottom of 
the window: enter a network name or a part of it and click the Start search button on the 
right or press [ENTER]. 
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To prevent the original VM from accessing any network upon failback, select the VM or its network 
connections in the list and click Disconnected. 
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Step 9. Map VM Replica to Restored VM 

The Target VM step of the wizard is only available if you have chosen to fail back to the original VM 
restored in a different location.  

You can define how VM replicas map to VMs restored from backup. 

To create a mapping association: 

1. Select a replica in the list and click Edit.  

2. Select the restored VM from the virtual infrastructure. To facilitate selection, use the search 
field at the bottom of the Add Objects window: click the button to the left of the field and 
select the necessary type of object to search for: Everything, Folder, Cluster, Host, Resource 
pool, VirtualApp or Virtual machine, enter an object’s name or a part of it and click the Start 
search button on the right or press [ENTER]. 
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Step 10. Review Summary and Finish Working with Wizard 

At the Summary step of the wizard, specify additional settings for failback: 

1. If you want to start the VM on the destination host after failback is complete, select the 
Power on VM after restoring check box. 

2. Check the specified settings and click Finish. Veeam Backup & Replication will restore the 
original VMs to the state of corresponding VM replicas. 

 



 

880   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Committing Failback 
The Commit failback operation finalizes failback from the VM replica to the original VM. 

To commit failback, do one of the following: 

 On the Home tab, click Restore. In the Restore from replica section, select Commit 
failback. 

 Open the Backup & Replication view, in the inventory pane select Replicas. In the working 
area, select the necessary replica and click Commit Failback on the ribbon. 

 Open the Backup & Replication view, in the inventory pane select Replicas. In the working 
area, right-click the necessary replica and select Commit Failback. 

In the displayed window, click Yes to confirm the operation. 

Depending on the location to which the VM is failed back, Veeam Backup & Replication performs the 
following finalizing operations after failback is committed: 

 If the VM replica is failed back to a new location, Veeam Backup & Replication additionally 
reconfigures the replication job and adds the former original VM to the list of exclusions. The 
VM restored in the new location takes the role of the original VM, and is included into the 
replication job instead of the excluded VM. When the replication job starts, 
Veeam Backup & Replication will exclude the former original VM from processing, and will 
replicate the newly restored VM instead. 

 If the VM replica is failed back to the original location, the replication job is not reconfigured. 
When the replication job starts, Veeam Backup & Replication will process the original VM in 
the normal mode. 
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Undoing Failback 
The Undo failback option allows you to switch from the original VM back to the VM replica and roll 
back the replica to the failover state. 

To undo failback, do one of the following: 

 Open the Backup & Replication view and select the Replicas node. In the working area, 
select the necessary replica and click Undo Failback on the ribbon. 

 Open the Backup & Replication view and select the Replicas node. In the working area, 
right-click the necessary replica and select Undo Failback. 

In the displayed dialog box, click Yes to confirm the operation. 
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Working with VMware vCloud Director VMs 
You can perform backup and restore operations for VMs managed by VMware vCloud Director. 
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Viewing VMware vCloud Director VMs 
After you add the VMware vCloud Director server to the backup infrastructure, you can view the 
VMware vCloud Director hierarchy in Veeam Backup & Replication and work with VMs managed with 
VMware vCloud Director.  

To open the VMware vCloud Director hierarchy:  

1. Open the Virtual Machines view.  

2. Click the View tab on the ribbon.  

3. On the View tab, click vCloud View.  

The hierarchy of the VMware vCloud Director server will become available in the inventory pane. VMs 
managed by VMware vCloud Director will be displayed in the working area. You can work with these 
VMs just as if you work with VMs managed by VMware vCenter Servers or registered on ESX(i) hosts 
added to the backup infrastructure. 
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Performing Backup of VMware vCloud Director VMs 
The vCD backup is practically the same as a regular VM backup. The vCD backup job aggregates main 
settings for the backup task and defines when, what, how and where to back up vCD VMs.  

You can perform the vCD backup job for single VMs and for VM containers: 

 vApp 

 Organization vDC  

 Organization 

 VMware vCloud Director instance 

Just like a regular backup job, the vCD backup job can be scheduled or run manually. To create a vCD 
backup job, do one of the following:  

 On the Home tab, click Backup Job and select vCloud. 

 Open the Backup & Replication view, in the inventory pane right-click Jobs and select 
Backup > vCloud. 

 Open the Virtual Machines view, click the View tab and click vCloud View on the ribbon. In 
the inventory pane expand the vCloud Director hierarchy, in the working area select one or 
more VMs, click Add to Backup on the ribbon and select New job. Alternatively, you can 
right-click one or several VMs and select Add to backup job > New job. In this case, the 
selected VMs will be automatically added to the new vCD backup job. You can add other VMs 
to the job when passing through the wizard steps. 

You can quickly include VMs to already existing vCD backup jobs. To do this, in the Virtual Machines 
view, in the working area right-click necessary VMs and select Add to backup job > name of the job. 

The New vCD Backup Job wizard offers the same options as a New Backup Job wizard. For more 
information, see Creating Backup Jobs.  
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Important! 

 

If you run a vCD backup job for the vApp, the job is considered to finish with the Success status and 
the complete restore point for the vApp is created only if all VMs in the vApp are successfully backed 
up. If any VM in the job fails, the restore point for the vApp will be in the incomplete status, and you 
will not be able to restore the whole vApp from such restore point.  

However, you will be able to perform restore to the original vApp for VMs that were partially or 
successfully backed up and whose data is available in the incomplete restore point. 
Veeam Backup & Replication will restore all data that is available for such VMs in the backup. 
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Creating VeeamZIP Files for VMware vCloud Director VMs 
You can create a VeeamZIP file for one or more vCD VMs. 

When Veeam Backup & Replication creates a VeeamZIP file for a vCD VM, it backs up a VM as separate 
object. Veeam Backup & Replication does not capture metadata of the vApp to which the VM belongs. 
When you restore a vCD VM from the VeeamZIP file, Veeam Backup & Replication registers the VM on 
the underlying ESX(i) host and does not register the VM in VMware vCloud Director. 

The process of VeeamZIP files creation for vCD VMs does not differ from that for regular VMware VMs. 
For more information, see Creating VeeamZIP Files. 



 

887   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Performing Restore from vCD Backups 
Veeam Backup & Replication offers a number of options for restoring VM data from vCD backups. You 
can perform the following operations:  

 Restore a VM with Instant VM Recovery into vCloud vApp 

 Restore a VM with Instant VM Recovery into vSphere infrastructure 

 Restore a vCloud vApp 

 Restore a VM into vCloud vApp 

 Restore an entire VM into the vSphere infrastructure 

 Restore VM hard disks 

 Restore VM files (VMX, VMDK and other) 

 Restore VM guest OS files 

Performing Instant VM Recovery for VMs 

Veeam Backup & Replication provides two options for Instant VM Recovery of vCD VMs: 

 You can instantly recover a VM to a vApp in VMware vCloud Director. 

 You can instantly recover a VM to the virtual infrastructure. In this case, the VM will be 
restored at the level of the underlying VMware vCenter Server, and the Instant VM Recovery 
process will be the same as for regular VMware VMs. 

When you instantly recover a VM to VMware vCloud Director, Veeam Backup & Replication uses the 
vPower NFS datastore, just as with other VMware VMs. To import the VM to the vApp, 
Veeam Backup & Replication needs to associate the vPower NFS datastore with some storage policy. 
To do this, Veeam Backup & Replication creates for the underlying VMware vCenter Server an auxiliary 
storage policy — Veeam-InstantVMRecovery, and displays it in VMware vCloud Director.  

The created storage policy is added to the Provider vDC and Organization vCD hosting the vApp to 
which the VM is restored. When the vPower NFS datastore is mounted to the ESX(i) host, the vPower 
NFS datastore is associated with the Veeam-InstantVMRecovery storage policy. After that, the VM is 
instantly restored in a regular manner and imported to the selected vApp. 

When an Instant VM Recovery session is finished, the storage policy is not deleted from the Provider 
vDC, it remains on VMware vCenter Server. This helps speed up all subsequent Instant VM Recovery 
operations. However, the storage policy is deleted from the Organization vDC as Organization vDC 
settings can be accessed only by Organization administrators.  

Restoring VMs with Instant VM Recovery into vCloud vApp 

With Instant VM Recovery, you can immediately start a VM from a backup file stored on the backup 
repository. Instant VM Recovery accelerates the restore process, allows you to improve RTOs and 
decrease downtime of production VMs. 

Before starting Instant VM Recovery, check prerequisites. Then use the vCloud Instant VM Recovery 
wizard to recover the necessary VM. 
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Before You Begin 

Before you perform Instant VM Recovery, check the following prerequisites: 

 You can perform Instant VM Recovery for a VM that has been successfully backed up at least 
once. 

 You must have at least 10 GB of free disk space on the vPower NFS datastore to store redo 
logs for the restored VM. By default, the redo logs are written to the 
C:\ProgramData\Veeam\Backup\NfsDatastore folder on the vPower NFS server. 

 If you are recovering a VM to the production network, make sure that the initial VM is 
powered off to avoid conflicts. 

Step 1. Launch vCloud Instant VM Recovery Wizard 

To launch the vCloud Instant VM Recovery wizard, do one of the following: 

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, select the VM you want to restore and click Instant VM 
Recovery > Into vCloud vApp on the ribbon.  

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, right-click the VM you want to restore and select Instant 
VM recovery > Into vCloud vApp.  

 Open the Virtual Machines view. On the View tab, click vCloud View. In the inventory pane, 
expand the vCloud Director hierarchy. In the working area, right-click the VM you want to 
restore and select Restore > Instant VM recovery > Into vCloud vApp. 
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Step 2. Select Restore Point  

At the Restore Point step of the wizard, select the restore point for the vCD VM. 

By default, Veeam Backup & Replication uses the latest valid restore point to recover a vCD VM. If you 
want to restore a VM to an earlier state, select the necessary restore point from the list. 
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Step 3. Select Restore Mode 

At the Restore Mode of the wizard, choose the necessary restore mode: 

 Select Restore to the original location if you want to restore the vCD VM with its initial 
settings and to its original location. If this option is selected, you will pass directly to the 
Reason step of the wizard. 

 Select Restore to a new location, or with different settings if you want to restore the vCD 
VM to a different location and/or with different settings (such as vApp, VM name, network 
settings and so on). If this option is selected, the Instant Recovery wizard will include 
additional steps for customizing VM settings. 

 

Step 4. Select Destination for Restored VM 

The Destination step of the wizard is available if you have chosen to change the location and settings 
of the restored VM.  

Select a destination and specify a name for the restored VM: 

1. In the vApp field, specify a vApp to which the VM must be restored. By default, 
Veeam Backup & Replication restores the VM to its initial vApp. 

2. In the Restored VM name field, enter a name under which the VM must be restored and 
registered. By default, Veeam Backup & Replication uses the original name of the VM. If you 
are restoring the VM to the same vApp where the original VM is registered and the original 
VM still resides there, it is recommended that you change the VM name to avoid conflicts. 

Note: 

 

Veeam Backup & Replication checks the lease term for the vApp to which the VM is restored. In case 
the lease period has expired, the lease will be automatically updated. 
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Step 5. Select Destination for Virtual Disk Updates 

The Datastore step of the wizard is available if you have chosen to change the location and settings of 
the restored VM.  

Select the location for holding the VM disk changes when the VM is restored. By default, disk changes 
are stored directly on the vPower NFS server. However, you can store disk changes on any datastore in 
your virtual environment. Redirecting disk changes improves recovery performance but makes 
Storage vMotion not possible for ESX 4.x and earlier. 
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To select a datastore: 

1. Select the Redirect virtual disk updates check box 

2. From the Datastore list, choose the necessary datastore. You can select only a datastore that 
is available in the Organization vCD hosting the vApp to which the VM is restored. 

 

Step 6. Select Destination Network 

The Network step of the wizard is available if you have chosen to change the location and settings of 
the restored VM.  

To select networks to which restored VMs must be connected: 

1. Select a VM in the list and click Network.  

2. The Select Network window displays all networks that are configured for the destination 
vApp. From the list of available networks, choose a network to which selected VM should 
have access upon restore. 

To facilitate selection, use the search field at the bottom of the window: enter a network 
name or a part of it and click the Start search button on the right or press [ENTER]. 

3. To prevent the restored VM from accessing any network, select it in the list and click 
Disconnect. 

Veeam Backup & Replication maps the network settings you define and network settings of the initial 
VM. If necessary, Veeam Backup & Replication makes changes to the network settings of the recovered 
VM. For example, if the initial VM was connected to the network using the static IP mode and you have 
selected to connect a recovered VM to a network using the dynamic IP mode, 
Veeam Backup & Replication will change the network settings to the dynamic mode.  
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Step 7. Specify Restore Reason 

At the Reason step of the wizard, enter a reason for performing Instant VM Recovery of the VM. The 
information you provide will be saved in the session history and you can reference it later. 

Tip: 

 

If you do not want to display the Reason step of the wizard in future, select the Do not show me 
this page again check box. 
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Step 8. Verify Instant VM Recovery Settings 

At the Summary step of the wizard, specify additional settings for Instant VM Recovery: 

1. If you want to start the recovered VM, select the Power on VM automatically check box. 

2. Check the specified settings of Instant VM Recovery and click Finish. 
Veeam Backup & Replication will recover the selected VM in the specified destination. 

 

Step 9. Finalize Instant VM Recovery 

All VMs restored with Instant VM Recovery are displayed in the Backup & Replication view, under the 
Instant Recovery node.  

To check the progress of Instant VM Recovery and view session details: 

1. Open the Backup & Replication view. 

2. In the inventory pane, click the Instant Recovery node. 

3. Right-click the VM in the working area and select Properties.  

Alternatively, you can open the History view, select the Instant Recovery node under Restore in the 
inventory pane and double-click the necessary instant VM restore session.  

After the VM has been successfully recovered, you can finalize Instant VM Recovery in one of two 
ways: 

 Migrate the recovered VM to production 

 Unpublish the recovered VM 
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To migrate the restored VM to production: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select the Instant Recovery node. 

3. In the working area, right-click the VM and select Migrate to production. As a result, the 
Quick Migration wizard will be launched. During migration, Veeam Backup & Replication will 
restore a VM instance from the backup file and then additionally move the changes that were 
made while the VM was running in the Instant Recovery mode. For more information, see 
Migrating VMs.  

Note: 

 

Quick Migration will be performed using VMware vMotion technology.  

To remove the recovered VM:  

1. Open the Backup & Replication view. 

2. In the inventory pane, select the Instant Recovery node. 

3. In the working area, right-click the VM and select Stop publishing. 
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Restoring VMs with Instant VM Recovery into vSphere infrastructure 

To launch the Instant Recovery wizard, do one of the following: 

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, select the VM you want to restore and click Instant VM 
Recovery > Into vSphere infrastructure on the ribbon.  

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, right-click the VM you want to restore and select Instant 
recovery > Into vSphere infrastructure.  

 Open the Virtual Machines view. On the View tab, click vCloud Director View. In the 
inventory pane, expand the vCloud Director hierarchy. In the working area, right-click the VM 
you want to restore and select Restore > Instant VM Recovery > Into vSphere 
infrastructure. 

The process of Instant VM Recovery for vCD VMs does not differ from the regular Instant VM Recovery 
process. For more information, see Performing Instant VM Recovery. 
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Restoring vCloud vApps 

You can restore the whole vApp from the backup to VMware vCloud Director. 

vApps can be restored to their Organization vDC or to any other Organization vDC. You can restore 
the vApp that already exists, for example, in case the initial vApp is corrupted or you want to revert to 
an earlier state of the vApp, or the vApp that no longer exists, for example, if it was deleted by mistake. 
If you restore a vApp that already exists, the vApp is overwritten with that from the vCD backup.  

To restore a vApp to vCloud Director, use the vCloud Full VM Restore wizard. 

Step 1. Launch Full vApp Restore Wizard 

To launch the Full vApp Restore wizard, do one of the following: 

 On the Home tab, click Restore and select vCloud. At the Restore Type step of the wizard, 
select the object you would like to restore: vApp.  

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, select the vApp and click Restore vCloud vApp on the 
ribbon.  

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, right-click the vApp and select Restore vCloud vApp. 

 

Step 2. Select vApp to Restore 

At the Objects to Restore step of the wizard, select the vApp you want to restore.  

To add a vApp, click Add vApp and select where to browse for vApps: 

 From infrastructure — browse the vCloud Director hierarchy and select a vApp to restore. 
Note that the vApp you select from the vCloud Director hierarchy must be successfully 
backed up at least once. 

 From backup — browse existing backups and select the vApp under backup jobs.  

To facilitate selection, use the search field at the bottom of the Select VMs window: enter an object’s 
name or a part of it in the search field and click the Start search button on the right or press [ENTER].  
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You can also use the search field at the top of the window to add vApps:  

1. Enter a vApp name or a part of it in the search field. Veeam Backup & Replication will search 
existing backups for the specified vApps and display matching results. 

2. To add the vApp to the list, double-click it in the list of search results.  

3. If the necessary vApp is not found, click the Show more link to browse existing backups and 
choose the necessary vApp. 

 To remove a vApp from the list, select it and click Remove on the right. 
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Step 3. Select Restore Point  

You can select the restore point for the vApp. 

By default, Veeam Backup & Replication uses the latest valid restore point to recover the vApp. 
However, you can restore the vApp to an earlier state.  

To select a restore point for the vApp: 

1. Select the vApp in the list and click Point on the right.  

2. In the Restore Points window, select a restore point that must be used to recover the vApp. 

  

Step 4. Select Restore Mode 

At the Restore Mode step of the wizard, choose the necessary restore mode and backup proxy for VM 
data transport: 

1. Choose a restore mode: 

 Select Restore to original location if you want to restore the vApp with its initial 
settings and to its original location. If this option is selected, you will immediately 
pass to the Summary step of the wizard. 

 Select Restore to a new location, or with different settings if you want to restore 
the vApp to a different location and/or with different settings (such as Organization 
vDC, network settings, fast provisioning settings and so on). If this option is 
selected, the vCloud Full VM Restore wizard will include additional steps for 
customizing vApp settings. 

2. [For vApp restore to the original location] Select the Quick rollback check box if you want to 
use incremental restore for the vApp. Veeam Backup & Replication will query CBT to get data 
blocks that are necessary to revert the vApp to an earlier point in time, and will restore only 
these data blocks from the backup. Quick rollback significantly reduces the restore time and 
has little impact on the production environment. 
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It is recommended that you enable this option if you restore VMs in the vApp after a problem 
that occurred at the level of the VM guest OS: for example, there has been an application 
error or a user has accidentally deleted a file on the VM guest OS. Do not enable this option if 
the problem has occurred at the VM hardware level, storage level or due to a power loss. 

3. Click the Pick proxy to use link to select backup proxies over which vApp data must be 
transported to the source datastore. You can assign backup proxies explicitly or instruct 
Veeam Backup & Replication to automatically select backup proxies. 

 If you choose Automatic selection, Veeam Backup & Replication will detect 
backup proxies that are connected to the source datastore and will automatically 
assign optimal proxy resources for processing vApp data. 

During the restore process, VMs in the vApp are processed simultaneously. 
Veeam Backup & Replication checks available backup proxies. If more than one 
backup proxy is available, Veeam Backup & Replication analyzes transport modes 
that the backup proxies can use for writing data to target, current workload on 
these backup proxies, and selects the most appropriate resources for VMs 
processing.  

 If you choose Use the selected backup proxy serves only, you can explicitly select 
backup proxies that will be used for restore. It is recommended that you select at 
least two proxies to ensure that VMs are recovered should one of backup proxies 
fail or lose its connectivity to the source datastore during restore. 
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Step 5. Select vApp Location 

The vApp step of the wizard is available if you have chosen to change the location and settings of the 
restored vApp.  

By default, Veeam Backup & Replication restores the vApp to its initial location with its initial name.  

To restore the vApp to a different location:  

1. Select the App in the list and click vDC.  

2. From the vCloud Director hierarchy, choose an Organization vDC where the selected vApp 
must be registered.  

To facilitate selection, use the search field at the bottom of the window: enter an object’s 
name or a part of it and click the Start search button on the right or press [ENTER].  

To change the vApp name: 

1. Select the vApp in the list and click Name.  

2. In the Change Name window, enter a new name explicitly or specify a change name rule by 
adding a prefix and/or suffix to the initial vApp name.  

3. You can also change the vApp name directly in the list: select a vApp, click the New Name 
field and enter the name to be assigned to the recovered vApp. 
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Step 6. Select Destination Network 

The vApp Network step of the wizard is available if you have chosen to change the location and 
settings of the restored vApp. 

To select networks to which the restored vApp must connected: 

1. Select the vApp in the list and click Network.  

2. The Select Network window displays all networks that are configured for the destination 
Organization vDC. From the list of available networks, choose a network to which selected 
vApp must have access upon restore.  

To facilitate selection, use the search field at the bottom of the window: enter a network 
name or a part of it and click the Start search button on the right or press [ENTER]. 

To prevent the restored vApp from accessing any network, select it in the list and click Disconnect. 

Note: 

 

When Veeam Backup & Replication backs up a vApp, along with vApp networks data it saves 
information about organization networks to which the vApp is connected. If you restore the vApp to 
the initial vDC organization and do not change the organization network settings, 
Veeam Backup & Replication attempts to connect the vApp to all source organization networks to 
which the vApp was connected at the moment of backup. If one or several source organization 
networks are not detected, for example, if they have been changed or removed by the time of 
restore, Veeam Backup & Replication will not be able to restore the vApp to its initial organization. In 
this case, you will need to change the network settings for the restored vApp: map the vApp to other 
organization network(s) or disconnect it from organization network(s) at all. 
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Step 7. Select Template to Link 

The Fast Provisioning step of the wizard is available if you have chosen to change settings of the 
restored vApp, for example, its name or location. 

To select a VM template: 

1. Select a VM in the list and click Set Template.  

2. From the vCloud Director hierarchy, choose a template to which the VMs from the restored 
vApp must be linked.  

To facilitate selection, use the search field at the bottom of the window: enter a VM template 
name or a part of it and click the Start search button on the right or press [ENTER]. 

If you want to disable fast provisioning for the VM and restore it as a regular VM, select the VM in the 
list and click Disable.  

 

Step 8. Select Storage Policy and Datastores 

The Datastores step of the wizard is available if you have chosen to change settings of the restored 
vApp, for example, its name or location. 

To select a storage policy for the vApp: 

1. Select the vApp in the list and click Policy.  

2. In the displayed window, select the necessary policy for the vApp. 
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If you have selected to disable fast provisioning at the previous step of the wizard, you must select a 
datastore on which the disks of restored VMs will be placed. To do this: 

1. Select VM or vApp in the list and click Datastore.  

2. In the displayed window, select the datastore on which the disks of the VM must be placed. 
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Step 9. Specify Restore Reason 

At the Reason step of the wizard, enter a reason for restoring the selected vApp. The information you 
provide will be saved in the session history and you can reference it later. 

Tip: 

 

If you do not want to display the Reason step of the wizard in future, select the Do not show me 
this page again check box. 
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Step 10. Verify Recovery Settings and Finish Working with Wizard 

At the Summary step of the wizard, specify additional settings for vApp restore: 

1. If you want to start VMs in the restored vApp, select the Power on VM after restoring check 
box. 

2. Check the settings for vApp restore and click Finish. Veeam Backup & Replication will recover 
the vApp in the specified destination. 

Note: 

 

Veeam Backup & Replication checks the lease term for the restored vApp. If the lease period has 
expired, the lease will be automatically updated. 
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Restoring VMs into vCloud vApp 

You can restore one or several VMs from vCD backups back to VMware vCloud Director. 

The vCD VM can be restored to its initial location or to any other location. You can restore a VM that 
already exists, for example, if the initial VM is corrupted or you want to revert to an earlier state of the 
VM, or a VM that no longer exists, for example, if the VM was deleted by mistake. If you restore a VM 
that already exists, the initial VM is overwritten with that from the vCD backup.  

When restoring VMs to the vCloud Director hierarchy, make sure that you select the Restore into 
vCloud vApp option. If you select the Restore into vSphere infrastructure option, the VM will be 
restored at the level of the underlying vCenter Server. To get a fully functional VM managed by vCloud 
Director, you will need to manually import the restored VM to the vCloud Director hierarchy. 

To restore a VM to the vCloud Director hierarchy, use the vCloud Full VM Restore wizard. 

Step 1. Launch vCloud Full VM Restore Wizard 

To launch the vCloud Full VM Restore wizard, do one of the following: 

 On the Home tab, click Restore and select vCloud. At the Object Type step, select the object 
you would like to restore: VM.  

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup job, select the VM you want to restore and click Entire VM 
> Into vCloud vApp on the ribbon.  

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup job, right-click the VM you want to restore and select 
Restore entire VM > Into vCloud vApp.  

 Open the Virtual Machines view. On the View tab, click vCloud Director View. In the 
inventory pane, expand the vCloud Director hierarchy. In the working area, right-click the VM 
you want to restore and select Restore > Restore VM into vCloud vApp. 
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Step 2. Select VM(s) to Restore 

At the Objects to Restore step of the wizard, select one or several VMs to restore. 

To add a VM, click Add VM and select where to browse for VMs: 

 From infrastructure — browse the vCloud Director hierarchy and select VMs to restore. Note 
that the VM you select from the vCloud Director hierarchy must be successfully backed up at 
least once. 

 From backup — browse existing backups and select VMs under backup jobs.  

To facilitate selection, use the search field at the bottom of the Select VMs window: enter an object’s 
name or a part of it and click the Start search button on the right or press [ENTER].  

To add VMs to the list, you can also use the search field at the top of the window:  

1. Enter a VM name or a part of it in the search field and Veeam Backup & Replication will search 
existing backups for the specified VM and display matching results. 

2. To add the VM to the list, double-click it in the list of search results.  

3. If the necessary VM is not found, click the Show more link to browse existing backups and 
choose the necessary VM. 

 To remove a VM from the list, select it and click Remove on the right. 
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Step 3. Select Restore Point  

You can select the restore point for the VM. 

By default, Veeam Backup & Replication uses the latest valid restore point to recover a VM. However, 
you can restore a VM to an earlier state. If you have chosen to restore multiple VMs, you can select a 
different restore point for every VM specifically. 

To select a restore point for a VM: 

1. Select a VM in the list and click Point on the right.  

2. In the Restore Points window, select the restore point that must be used to recover the VM. 

  

Step 4. Select Restore Mode 

At the Restore Mode step of the wizard, choose the necessary restore mode and backup proxy for VM 
data transport: 

1. Choose a restore mode: 

 Select Restore to original location if you want to restore the VM(s) with initial 
settings and to the original location. If this option is selected, you will immediately 
pass to the Summary step of the wizard. 

 Select Restore to a new location, or with different settings if you want to restore 
the VM(s) to a different location and/or with different settings (such as VM location, 
network settings, fast provisioning settings and so on). If this option is selected, the 
vCloud Full VM Restore wizard will include additional steps for customizing VM 
settings. 

2. [For VM restore to the original location] Select the Quick rollback check box if you want to 
use incremental restore for the VM(s). Veeam Backup & Replication will use CBT to get data 
blocks that are necessary to revert the VM(s) to an earlier point in time, and will restore only 
these data blocks from the backup. Quick rollback significantly reduces the restore time and 
has little impact on the production environment. 
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It is recommended that you enable this option if you restore the VM(s) after a problem that 
occurred at the level of the VM guest OS: for example, there has been an application error or a 
user has accidentally deleted a file on the VM guest OS. Do not enable this option if the 
problem has occurred at the VM hardware level, storage level or due to a power loss. 

3. Click the Pick proxy to use link to select backup proxies over which VM data must be 
transported to the source datastore. You can assign backup proxies explicitly or instruct 
Veeam Backup & Replication to automatically select backup proxies. 

 If you choose Automatic selection, Veeam Backup & Replication will detect 
backup proxies that are connected to the source datastore and will automatically 
assign optimal proxy resources for processing VM data. 

During the restore process, VMs are processed simultaneously. 
Veeam Backup & Replication checks available backup proxies. If more than one 
backup proxy is available, Veeam Backup & Replication analyzes transport modes 
that the backup proxies can use for writing data to target, current workload on 
these backup proxies, and selects the most appropriate resources for VMs 
processing.  

 If you choose Use the selected backup proxy servers only, you can explicitly 
select backup proxies that will be used for restore. It is recommended that you 
select at least two proxies to ensure that VMs are recovered should one of backup 
proxies fail or lose its connectivity to the source datastore during restore. 
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Step 5. Select VM Location 

The Location step of the wizard is available if you have chosen to change the location and settings for 
the restored VM(s). 

By default, Veeam Backup & Replication restores the VM to its initial location. To restore the VM a 
different location:  

1. Select the VM in the list and click vApp.  

2. From the vCloud Director hierarchy, choose a vApp in which the restored VM must be 
registered. 

To facilitate selection, use the search field at the bottom of the window: enter the vApp name 
or a part of it and click the Start search button on the right or press [ENTER]. 

To change the VM name: 

1. Select a VM in the list and click Name.  

2. In the Change Name window, enter a new name explicitly or specify a change name rule by 
adding a prefix and/or suffix to the initial VM name.  

3. You can also change VM names directly in the list: select a VM, click the New Name field and 
enter the name to be assigned to the recovered VM.  

Important! 

 

If you are restoring a linked clone VM to a different location, make sure that fast provisioning is 
enabled at the level of the target Organization vDC. Otherwise Veeam Backup & Replication will 
restore the VM as a regular VM. 
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Step 6. Select Destination Network 

The VM Network step of the wizard is available if you have chosen to change the location and 
settings of the restored VM(s). 

To select networks to which the restored VM must be connected: 

1. Select a VM in the list and click Networks.  

2. The Select Network window displays all networks that are configured for the destination 
vApp. From the list of available networks, choose a network to which the restored VM must 
have access upon restore.  

To facilitate selection, use the search field at the bottom of the window: enter a network 
name or a part of it and click the Start search button on the right or press [ENTER]. 

To prevent the restored VM from accessing any network, select it in the list and click Disconnected. 

 

Step 7. Select Template to Link 

The Fast Provisioning step of the wizard is available if you have chosen to change the settings of the 
restored VM(s).  

To select a VM template: 

1. Select a VM in the list and click Set Template.  

2. From the VMware vCloud Director hierarchy, choose a template to which the restored VM 
must be linked.  

To facilitate selection, use the search field at the bottom of the window: enter a VM template 
name or a part of it and click the Start search button on the right or press [ENTER]. 
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If you want to disable fast provisioning for the VM and restore it as a regular VM, select the VM in the 
list and click Disable.  

 

Step 8. Select Storage Policy and Datastores 

The Datastores step of the wizard is available if you have chosen to change the settings of the 
restored VM(s). 

To select a storage policy for the restored VM: 

1. Select a VM in the list and click Policy.  

2. In the displayed window, select the necessary policy for the VM. 
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If you have selected to disable fast provisioning at the previous step of the wizard, you must select a 
datastore on which disks of the restored VM will be placed. 

1. Select a VM in the list and click Datastore.  

2. In the displayed window, select the datastore on which the VM disks must be located. 
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Step 9. Specify Restore Reason 

At the Reason step of the wizard, enter a reason for restoring the selected VM(s). The information you 
provide will be saved in the session history and you can reference it later. 

Tip: 

 

If you do not want to display the Reason step of the wizard in future, select the Do not show me 
this page again check box. 
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Step 10. Verify Recovery Settings and Finish Working with Wizard 

At the Summary step of the wizard, specify additional settings for VM(s) restore: 

1. If you want to start the restored VM(s), select the Power on VM after restoring check box. 

2. Check the settings for VM(s) restore and click Finish. Veeam Backup & Replication will recover 
the VM(s) in the specified destination. 

Note: 

 

Veeam Backup & Replication checks the lease term for the restored VM(s). In case the lease period 
has expired, the lease will be automatically updated. 
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Restoring Entire VMs into vSphere Infrastructure 

You can restore vCD VMs from the backup to the VMware vSphere infrastructure.  

During restore, Veeam Backup & Replication neglects the vApp metadata saved to the backup file and 
performs a regular full VM restore process. The VM is restored to the VMware vCenter Server or ESX(i) 
host and is not registered in VMware vCloud Director. vCloud-specific features such as fast 
provisioning are not supported for such type of restore.  

To launch the Full VM Restore wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from backup section, 
select Entire VM (including registration). 

 Open the Backup & Replication view, in the inventory pane select Backups. In the working 
area, expand the necessary backup, select the VM(s) you want to restore and click Entire VM 
> Into vSphere infrastructure on the ribbon. 

 Open the Virtual Machines view. In the inventory pane, expand the VMware vCloud Director 
hierarchy and select the VMware vCenter Server. In the working area, right-click the VM you 
want to restore and select Restore entire VM > Into vSphere infrastructure. 

Full VM restore of vCD VMs does not differ from full VM restore of regular VMware VMs. For more 
information, see Performing Full VM Restore. 

 

Restoring VM Files 

The process of VM files restore for vCD VMs does not differ from that for regular VMware VMs. For 
more information, see Restoring VM Files. 

Restoring VM Hard Disks 

The process of VM hard disks restore for vCD VMs does not differ from that for regular VMware VMs. 
For more information, see Restoring VM Hard Disks. 
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Restoring VM Guest OS Files 

The process of VM hard disks restore for vCD VMs does not differ from that for regular VMware VMs. 
For more information, see Restoring VM Guest Files and Multi-OS File Level Restore. 
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Working with Storage Snapshots 
You can use capabilities of storage systems that host VM disks to build your data protection and 
disaster recovery strategy. Veeam Backup & Replication complements image-level backups of VMware 
VMs with storage snapshots and offers the following technologies: 

 Backup from Storage Snapshots: you can create backups of VMs using storage snapshots. 

 Veeam Explorer for Storage Snapshots: you can restore VM data from storage snapshots. 

Veeam Backup & Replication supports the following storage systems:  

 EMC VNX and VNXe 

 NetApp 

 HPE 3PAR StoreServ 

 HPE StoreVirtual P4000 series and HPE StoreVirtual VSA 
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Setting Up Backup Infrastructure for Storage Snapshots 
Before you start working with storage systems in Veeam Backup & Replication, you must properly 
configure the backup infrastructure. You must perform the following actions: 

1. Configure a backup proxy. The backup proxy is required for storage systems rescan and 
Backup from Storage Snapshots.  

2. Add VMware vSphere server. You must add to the backup infrastructure VMware vCenter 
Server or ESX(i) hosts with VMs whose disks are located on storage volumes. 

3. [For HPE 3PAR StoreServ] Enable HPE 3PAR Web Services API server. 
Veeam Backup & Replication uses the HPE 3PAR Web Services API server to work with the HPE 
StoreServ storage system. 

4. Add the storage system. You must add to Veeam Backup & Replication a storage system on 
which VM disks are hosted. 

Note: 

 

You can work with storage systems in the Storage Infrastructure view of 
Veeam Backup & Replication. Right after the installation, the Storage Infrastructure view is not 
displayed in the Veeam Backup & Replication console. To display it, you must add at least one 
VMware vCenter Server or ESX(i) host to the backup infrastructure. 

Step 1. Configure Backup Proxy 

For some operations with storage snapshots, Veeam Backup & Replication requires a backup proxy 
configured in a specific way. The backup proxy is used for two purposes: 

 Rescan of VMFS on storage volumes 

 Backup from storage snapshot 

When Veeam Backup & Replication performs rescan and backup operations, it needs to read the 
content on the storage volumes and snapshots. To do this, Veeam Backup & Replication uses a backup 
proxy as a helper. Storage volumes and snapshots are mounted as new volumes to the backup proxy. 
As a result, Veeam Backup & Replication can access mounted volumes and snapshots via the backup 
proxy and read VM data on them.  

To enable storage rescan and Backup from Storage Snapshots, you must configure a backup proxy in 
the backup infrastructure. The backup proxy must meet the requirements listed below. 

General 

The role of a backup proxy must be assigned to a Microsoft Windows machine. This can be a 
dedicated machine or backup server performing the role of the default backup proxy. 

iSCSI Protocol 

1. The backup proxy must have a Microsoft iSCSI Software initiator enabled. 

2. iSCSI traffic between the backup proxy and storage system must be allowed. 

Note: 

 

For storage rescan, Veeam Backup & Replication uses its own initiator; for this reason a Microsoft 
iSCSI Software initiator may not be enabled. For Backup from Storage Snapshots, however, the 
Microsoft iSCSI Software initiator must be enabled.  
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Fibre Channel Protocol 

1. The backup proxy must have a Fibre channel adapter installed and must have access to the 
storage via the Fibre Channel fabric. 

2. To let Veeam Backup & Replication present snapshots of LUNs to the backup proxy, you must 
register the backup proxy with a WWN ID on the storage system. 

3. Fibre Channel devices must be properly installed and shown in Device Manager on the 
backup proxy. The WWN ID of the backup proxy must be properly zoned on the Fibre 
Channel switch.  

NFS Protocol 

NFS traffic between the backup proxy and storage system must be allowed. 

Step 2. Add VMware vSphere Server 

Before you add a storage system and start using storage snapshots for backup and restore, you must 
add VMware vCenter Server or ESX(i) host to the backup infrastructure. The server to be added is the 
VMware vCenter Server or ESX(i) host with VMs whose disks are located on the storage system. For 
more information, see Adding VMware Servers. 

It is strongly recommended that you add VMware vCenter Server or ESX(i) host to the backup 
infrastructure before you add the storage system. When you add a storage system, 
Veeam Backup & Replication performs the storage system rescan. As a part of this process, 
Veeam Backup & Replication maps storage volumes to VMware datastores. This helps 
Veeam Backup & Replication understand what VMs host their disks on storage volumes. 

If you add the storage system to Veeam Backup & Replication and do not add VMware vCenter Server 
or ESX(i) host, you will be able to perform only restore from storage snapshots. You will not be able to 
perform Backup from Storage Snapshots. 

Tip: 

 

If you have first added the storage system to the backup infrastructure, and then added VMware 
vCenter Server or ESX(i) host, perform storage rescan to map storage volumes to VMware datastores. 
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Step 3. Enable HPE 3PAR Web Services API Server 

This step must be performed if you plan to work with the HPE 3PAR StoreServ storage system. 

Veeam Backup & Replication uses the HPE 3PAR Web Services API server to communicate with the HPE 
3PAR StoreServ storage system. When you add the HPE 3PAR StoreServ storage to the backup 
infrastructure, Veeam Backup & Replication attempts to enable the server automatically. If 
Veeam Backup & Replication fails to enable the server automatically (for example, if it does not have 
enough privileges to do this), you need to enable the server manually. 

Important! 

 

The HPE 3PAR Web Services API is a part of the HPE 3PAR OS starting from version 3.1.2. 
Veeam Backup & Replication does not support earlier versions of HPE 3PAR OS. 

To check if the HPE 3PAR Web Services API server is enabled and enable it if needed: 

1. Log on to the Processor with administrator privileges: 

#ssh <administrator account>@<SP IP Address> 

2. View the current state of the Web Services API Server: 

#showwsapi 
-- -State- -HTTP_State- 
HTTP_Port -HTTPS_State- HTTPS_Port -Version- 
Enabled  Active Enabled    8008 
Enabled    8080     1.1 

3. If the Web Services API Server is disabled, start it: 

#startwsapi 

4. If the HTTP or HTTPS state is disabled, enable one of them: 

#setwsapi -http enable 

or 

#setwsapi -https enable 
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Step 4. Add Storage System 

To start using storage snapshots for backup and restore, you must add the storage system to the 
backup infrastructure.  

After you add the storage system, the storage system topology appears in the Storage Infrastructure 
view. Storage snapshots also appear under the Storage snapshots node in the inventory pane of the 
Backup & Replication view. 

When you add the storage system, Veeam Backup & Replication automatically rescans it. As a part of 
rescan, Veeam Backup & Replication performs the following operations: 

1. Veeam Backup & Replication retrieves the information about the storage system topology. 

2. Veeam Backup & Replication retrieves information about VMware datastores from VMware 
vCenter Server and matches storage volumes to these VMware datastores. Matching helps 
Veeam Backup & Replication understand what VMs host their disks on storage volumes. 
Additionally, it helps Veeam Backup & Replication get the information about VMs on storage 
snapshots: Veeam Backup & Replication assumes that disks of VMs located on storage 
volumes are also located on storage snapshots. 

3. Veeam Backup & Replication rescans storage snapshots. As a result of snapshot rescan, 
Veeam Backup & Replication determines exactly what VMs are located on storage snapshots. 
If for some reason Veeam Backup & Replication fails to rescan all storage snapshots, it rescans 
the last storage snapshot in the hierarchy and propagates the retrieved information to all 
other storage snapshots. 

You can add the following storage systems to the backup infrastructure: 

 EMC VNX/VNXe 

 HPE StoreVirtual 

 HPE 3PAR StoreServ 

 NetApp 

Adding EMC VNX/VNXe 

Before you add the EMC VNX(e) storage to the backup infrastructure, check prerequisites. Then use 
the New VNX(e) Storage wizard to add the storage system. 

Before You Begin 

Before adding the EMC VNX(e) storage to the backup infrastructure, check the following prerequisites: 

[For EMC VNX Block] To take LUN snapshots, Veeam Backup & Replication uses the VNX snapshot 
technology. Make sure that you have a license that covers the VNX snapshot technology. The 
SnapView snapshot technology is not supported. 

  



 

924   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Step 1. Launch New VNXe Storage Wizard 

To launch the New EMC VNX(e) Host wizard, do one of the following: 

 Open the Storage Infrastructure view. In the working area, click Add Storage. In the 
displayed window, click EMC VNX(e). 

 Open the Storage Infrastructure view, in the inventory pane right-click the Storage 
Infrastructure node and select Add Storage. In the displayed window, click EMC VNX(e). 

 Open the Storage Infrastructure view, in the inventory pane right-click the VNX(e) node 
and select Add Storage.  
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Step 2. Select Storage Type 

At the Storage Type step of the wizard, select the type of the EMC VNX(e) storage. 

 Select EMC VNX (block) to add an EMC VNX block storage working over Fibre Channel and 
iSCSI. 

 Select EMC VNX (file) to add an EMC VNX file storage working over NFS. 

 Select EMC VNXe to add an EMC VNXe storage working over Fibre Channel, iSCSI or NFS. 
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Step 3. Specify Storage Name or Address 

At the Name step of the wizard, specify the name and description for the EMC VNX(e) storage system. 

1. In the DNS name or IP address field, specify a DNS name or IP address of the EMC VNX(e) 
storage system. 

2. In the Description field, provide a description for future reference. The default description 
contains information about the user who added the storage system, date and time when the 
storage system was added. 

 

Step 4. Specify Credentials 

At the Credentials step of the wizard, specify credentials for the user account with administrator 
privileges on the EMC VNX(e) storage system.  

1. From the Credentials list, select credentials to connect to the EMC VNX(e) storage system. If 
you have not set up credentials beforehand, click the Manage accounts link or click Add on 
the right of the Credentials field to add the credentials. For more information, see Managing 
Credentials. 

2. [For EMC VNX block storage] Select the scope to which the user account whose credentials 
you provide belongs: 

 Select Global if the user account can administrate all VNX systems in the domain. 

 Select Local if the user account can administrate only a single VNX system in the 
domain. 

 Select LDAP if the user account can administrate all VNX systems that use the LDAP 
server for authentication. 

3. [For EMC VNX file storage] When you add the storage system, Veeam Backup & Replication 
saves a fingerprint of the SSH key of the management server to the configuration database. 
During every subsequent connection to the server, Veeam Backup & Replication uses the 
saved fingerprint to verify the server identity and avoid the man-in-the-middle attack. 

To let you identify the server, Veeam Backup & Replication displays the SSH key fingerprint: 
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 If you trust the server and want to connect to it, click Yes.  

 If you do not trust the server, click No. Veeam Backup & Replication will display an 
error message, and you will not be able to connect to the server.  

If you update the SSH key on the server, you must acknowledge the new key in the server connection 
settings. To do this, in the Storage Infrastructure view open the server settings, pass through the 
Edit Storage wizard and click Trust to acknowledge the new key. 

 

Step 5. Finish Working with Wizard 

At the Summary step of the wizard, you can choose what EMC VNX(e) volumes you want to rescan. 

When you add the EMC VNX(e) storage system, Veeam Backup & Replication performs the storage 
system rescan. It scans storage volumes, locates VMs on these volumes, retrieves information about 
datastores from VMware vSphere servers and matches storage volumes to these datastores. 

The EMC VNX(e) hierarchy can be very extensive, and the rescan process can take much time. To 
minimize the rescan time, you can instruct Veeam Backup & Replication to rescan only specific 
volumes. 

To rescan specific volumes: 

1. At the Summary step of the wizard, click Choose volumes to scan.  

2. In the Choose Volumes window, select which volumes you want to rescan: 

 To exclude volumes from rescan, select All volumes except, click Add and select 
volumes from the list. 

 To rescan only specific volumes, select Only these volumes, click Add and select 
volumes from the list. 

If you leave the Automatic detection option selected, Veeam Backup & Replication will 
rescan all volumes in the EMC VNX(e) hierarchy. 

3. Click OK. 

4. Click Finish. 
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Veeam Backup & Replication will add the EMC VNX(e) storage system and start the rescan process. The 
rescan details are displayed in the System window. You can close this window and review the rescan 
details later in the History view of Veeam Backup & Replication. 

Important! 

 

If you plan to process VMs with Backup from Storage Snapshots, you must rescan volumes on which 
disks of these VMs are located. 
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Adding HPE StoreVirtual Storage 

To add the HPE StoreVirtual storage to the backup infrastructure, use the New HP StoreVirtual 
Storage wizard. 

Step 1. Launch New HP StoreVirtual Storage Wizard 

To launch the New HP StoreVirtual Storage wizard, do one of the following: 

 Open the Storage Infrastructure view. In the working area, click Add Storage. In the 
displayed window, click HP StoreVirtual. 

 Open the Storage Infrastructure view, in the inventory pane right-click the Storage 
Infrastructure node and select Add Storage. In the displayed window, click HP 
StoreVirtual. 

 Open the Storage Infrastructure view, in the inventory pane right-click the HP StoreVirtual 
node and select Add Storage. You can also right-click anywhere in the working area and 
select Add Storage. 
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Step 2. Specify Storage Name or Address 

At the Name step of the wizard, specify the storage address and description. 

1. On the right of the Management server DNS name or IP address field, click Browse and 
select the HPE storage management group. 

You can also type a DNS name or IP address of the HPE storage management server or 
storage cluster in the Management server DNS name or IP address field. 

2. In the Description field, provide a description for future reference. The default description 
contains information about the user who added the HPE management group, date and time 
when the HPE management group was added. 

 

Step 3. Specify Credentials 

At the Credentials step of the wizard, specify credentials for the user account with administrator 
privileges on the HPE management group.  

1. From the Credentials list, select credentials to connect to the HPE management group. If you 
have not set up credentials beforehand, click the Manage accounts link or click Add on the 
right of the Credentials field to add the credentials. For more information, see Managing 
Credentials. 

The user name and password values are case-sensitive. 

2. When you add the storage system, Veeam Backup & Replication saves a fingerprint of the SSH 
key of the management server to the Veeam Backup & Replication database. During every 
subsequent connection to the server, Veeam Backup & Replication uses the saved fingerprint 
to verify the server identity and avoid the man-in-the-middle attack. 

To let you identify the server, Veeam Backup & Replication displays the SSH key fingerprint: 

 If you trust the server and want to connect to it, click Yes.  

 If you do not trust the server, click No. Veeam Backup & Replication will display an 
error message, and you will not be able to connect to the server.  
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If you update the SSH key on the server, you must acknowledge the new key in the server connection 
settings. To do this, in the Storage Infrastructure view open the server properties, pass through the 
Edit Server wizard and click Trust to acknowledge the new key. 

 

Step 4. Finish Working with Wizard 

At the Summary step of the wizard, you can choose what HPE StoreVirtual volumes you want to 
rescan. 

When you add the HPE StoreVirtual storage system, Veeam Backup & Replication performs the storage 
system rescan. It scans storage volumes, locates VMs on these volumes, retrieves information about 
datastores from VMware vSphere servers and matches storage volumes to these datastores. 

The HPE StoreVirtual hierarchy can be very extensive, and the rescan process can take much time. To 
minimize the rescan time, you can instruct Veeam Backup & Replication to rescan only specific 
volumes. 

To rescan specific volumes: 

1. At the Summary step of the wizard, click Choose volumes to scan.  

2. In the Choose Volumes window, select which volumes you want to rescan: 

 To exclude volumes from rescan, select All volumes except, click Add and select 
volumes from the list. 

 To rescan only specific volumes, select Only these volumes, click Add and select 
volumes from the list. 

If you leave the Automatic detection option selected, Veeam Backup & Replication will 
rescan all volumes in the HPE StoreVirtual hierarchy. 

3. Click OK. 

4. Click Finish. 

Veeam Backup & Replication will add the HPE StoreVirtual storage system and start the rescan process. 
The rescan details are displayed in the System window. You can close this window and review the 
rescan details later in the History view of Veeam Backup & Replication. 
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Important! 

 

If you plan to process VMs with Backup from Storage Snapshots, you must rescan volumes on which 
disks of these VMs are located. 

 

Adding HP 3PAR StoreServ Storage 

Before you add the HP 3PAR StoreServ storage to the backup infrastructure, check prerequisites. Then 
use the New HP 3PAR StoreServ Storage wizard to add the storage system. 

Before You Begin 

Before adding the HPE 3PAR StoreServ storage to the backup infrastructure, check the following 
prerequisites: 

1. A properly configured backup proxy must be added to the backup infrastructure. The backup 
proxy is required for storage system rescan. 

2. The HPE 3PAR Web Services API server must be enabled. 

3. The license for the HPE 3PAR StoreServ storage system must support HPE 3PAR Virtual Copy. 

  



 

933   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Step 1. Launch New HP 3PAR StoreServ Storage Wizard 

To launch the New HP 3PAR StoreServ Storage wizard, do one of the following: 

 Open the Storage Infrastructure view. In the working area, click Add Storage. In the 
displayed window, click HP 3PAR StoreServ. 

 Open the Storage Infrastructure view, in the inventory pane right-click the Storage 
Infrastructure node and select Add Storage. In the displayed window, click HP 3PAR 
StoreServ. 

 Open the Storage Infrastructure view, in the inventory pane right-click the HP 3PAR 
StoreServ node and select Add Storage. You can also right-click anywhere in the working 
area and select Add Storage. 
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Step 2. Specify HP 3PAR Web Services API Address 

Veeam Backup & Replication works with the HPE 3PAR StoreServ storage system via the HPE 3PAR 
Web Services API. The HPE 3PAR Web Services API delivers a programming interface for performing 
storage management tasks with HPE 3PAR StoreServ storage systems.  

At the Name step of the wizard, provide information about the HPE 3PAR Web Services API. 

1. In the DNS name or IP address field, enter a full DNS name or IP address of the HPE 3PAR 
Web Services API Server. 

2. In the URL field, enter a URL of the HPE 3PAR Web Services API. By default, 
Veeam Backup & Replication uses the following URL: https://< websapiserver>:8080, where 
<websapiserver> is the name or IP address of the HPE 3PAR Web Services API Server that you 
have specified in the field above. 

3. In the Description field, provide a description for future reference. The default description 
contains information about the user who added the server, date and time when the server 
was added. 
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Step 3. Specify Credentials 

At the Credentials step of the wizard, specify credentials for the user account with administrator 
privileges on the HPE 3PAR Web Services API Server.  

1. From the Credentials list, select credentials to connect to the HPE 3PAR Web Services API 
Server. If you have not set up credentials beforehand, click the Manage accounts link or click 
Add on the right of the Credentials field to add the necessary credentials. For more 
information, see Managing Credentials. 

Note: 

 

The user account must have the ‘edit’ user role on the HPE 3PAR Web Services API Server. 

2. When you add the storage system, Veeam Backup & Replication saves a fingerprint of the SSH 
key of the HPE 3PAR Web Services API Server to the Veeam Backup & Replication database. 
During every subsequent connection to the server, Veeam Backup & Replication uses the 
saved fingerprint to verify the server identity and avoid the man-in-the-middle attack. 

To let you identify the server, Veeam Backup & Replication displays the SSH key fingerprint: 

 If you trust the server and want to connect to it, click Yes.  

 If you do not trust the server, click No. Veeam Backup & Replication will display an 
error message, and you will not be able to connect to the server.  

If you update the SSH key on the server, you must acknowledge the new key in the server connection 
settings. To do this, in the Storage Infrastructure view open the server properties, pass through the 
Edit Server wizard and click Trust to acknowledge the new key. 
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Step 4. Finish Working with Wizard 

At the Summary step of the wizard, you can choose what HPE 3PAR volumes you want to rescan. 

When you add the HPE 3PAR storage system, Veeam Backup & Replication performs the storage 
system rescan. It scans storage volumes, locates VMs on these volumes, retrieves information about 
datastores from VMware vSphere servers and matches storage volumes to these datastores.  

The HPE 3PAR hierarchy can be very extensive, and the rescan process can take much time. To 
minimize the rescan time, you can instruct Veeam Backup & Replication to rescan only specific 
volumes. 

To rescan specific volumes: 

1. At the Summary step of the wizard, click Choose volumes to scan.  

2. In the Choose Volumes window, select which volumes you want to rescan: 

 To exclude volumes from rescan, select All volumes except, click Add and select 
volumes from the list. 

 To rescan only specific volumes, select Only these volumes, click Add and select 
volumes from the list. 

If you leave the Automatic detection option selected, Veeam Backup & Replication will 
rescan all volumes in the HPE 3PAR hierarchy. 

3. Click OK. 

4. Click Finish. 

Veeam Backup & Replication will add the HPE 3PAR storage system and start the rescan process. The 
rescan details are displayed in the System window. You can close this window and review the rescan 
details later in the History view of Veeam Backup & Replication. 

Important! 

 

If you plan to process VMs with Backup from Storage Snapshots, you must select to rescan volumes 
on which disks of these VMs are located 
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Adding NetApp Storage System 

To add NetApp storage to the backup infrastructure, use the New NetApp Storage wizard. 

Step 1. Launch New NetApp Storage Wizard 

To launch the New NetApp Storage wizard, do one of the following: 

 Open the Storage Infrastructure view. In the working area, click Add Storage. In the 
displayed window, click NetApp. 

 Open the Storage Infrastructure view, in the inventory pane select the NetApp node and 
click Add Storage on the ribbon. 

 Open the Storage Infrastructure view, in the inventory pane right-click the NetApp node 
and select Add Storage. You can also right-click anywhere in the working area and select 
Add Storage. 
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Step 2. Specify NetApp Server Name or Address 

At the Name step of the wizard, specify the name and description for the NetApp storage system. 

1. In the Management server DNS name or IP address field, specify a DNS name or IP address 
of the NetApp storage system. 

You can also browse for NetApp storage systems that exist in your environment: 

a. On the right of the Management server DNS name or IP address field, click 
Browse.  

b. In the NetApp Storage System Discovery window, enter an IP address of the 
NetApp storage system or IP address of the subnet where the storage is located 
and click Discover. Veeam Backup & Replication will search the whole subnet for 
storage systems. For example, if you enter 172.16.1.12 as an IP address, 
Veeam Backup & Replication will search storage systems in subnet 172.16.1.* and 
display the list of storage systems found in this subnet. 

c. In the list below, select the NetApp storage system you want to add. 

2. In the Description field, provide a description for future reference. The default description 
contains information about the user who added the NetApp storage system, date and time 
when the storage system was added. 
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Step 3. Specify Credentials and Protocol Type 

At the Credentials step of the wizard, specify credentials for the user account to connect to the 
NetApp storage system, and select the transport protocol. 

1. From the Credentials list, select credentials to connect to the NetApp storage system. If you 
have not set up credentials beforehand, click the Manage accounts link or click Add on the 
right of the Credentials filed to add the credentials. For more information, see Managing 
Credentials. 

The account you select must have administrative privileges on the NetApp storage system. 

2. From the Protocol list, select the type of protocol over which you want to communicate with 
the NetApp storage system: HTTP or HTTPs.  

The default transport protocol is HTTPs. However, you can configure the NetApp storage 
system to communicate with Veeam Backup & Replication over the HTTP protocol if needed. 

3. The default port for communication with the NetApp storage system is 443. If necessary, you 
can customize the port number in the NetApp storage system settings and specify the new 
port number in the Port field.  
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Step 4. Finish Working with Wizard 

At the Summary step of the wizard, you can choose what NetApp volumes you want to rescan. 

When you add the NetApp storage system, Veeam Backup & Replication performs the storage system 
rescan. It scans storage volumes and LUNs, locates VMs on these volumes and shares, retrieves 
information about datastores from VMware vSphere servers and matches volumes and LUNs to these 
datastores.  

The NetApp hierarchy can be very extensive, and the rescan process can take much time. To minimize 
the rescan time, you can instruct Veeam Backup & Replication to rescan only specific volumes. 

To rescan specific volumes: 

1. At the Summary step of the wizard, click Choose volumes to scan.  

2. In the Choose Volumes window, select which volumes you want to rescan: 

 To exclude volumes from rescan, select All volumes except, click Add and select 
volumes from the list. 

 To rescan only specific volumes, select Only these volumes, click Add and select 
volumes from the list. 

If you leave the Automatic detection option selected, Veeam Backup & Replication will 
rescan all volumes in the NetApp hierarchy. 

3. Click OK. 

4. Click Finish. 
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Veeam Backup & Replication will add the NetApp storage system and start the rescan process. The 
rescan details are displayed in the System window. You can close this window and review the rescan 
details later in the History view of Veeam Backup & Replication. 

Important! 

 

 If you plan to process VMs with Backup from Storage Snapshots, you must select to rescan 
volumes on which disks of these VMs are located. 

 If you plan to create backup jobs that will trigger NetApp snapshots on NetApp 
SnapMirror or SnapVault, you must select to rescan target volumes on SnapMirror or 
SnapVault. 
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Using Storage Snapshots 
After you have added the storage system to the backup infrastructure, you can perform the following 
operations: 

 Re-Scanning Storage Systems 

 Creating and Deleting Snapshots 

 Configuring Backup from Storage Snapshots 

 Configuring Backup from NetApp SnapMirror and SnapVault 

 Restoring VM Data from Storage Snapshots 

 Scheduling Snapshot Creation (NetApp) 

Re-Scanning Storage Systems 

You can rescan the storage system added to the backup infrastructure. Storage rescan may be 
required, for example, if you create or delete volume snapshots on the storage system. Storage rescan 
will help you discover these changes and update the storage system hierarchy in the 
Veeam Backup & Replication console. 

Storage system rescan can be performed automatically or manually.  

 Automatic storage rescan: Veeam Backup & Replication uses the following processes to 
rescan the storage system: 

– Storage Monitor runs in the background. This process detects new snapshots and 
volumes and performs their rescan with a time interval of 10 minutes. 

– Storage Discovery is started every 7 days. This process performs rescan of the whole 
storage system or selected volumes (if you limited the rescan scope when you 
added the storage system to Veeam Backup & Replication). 

 Manual storage rescan: if necessary, you can start Storage Discovery process manually. 
Storage discovery can be performed against any node in the storage system hierarchy: 
storage system itself, specific volume and so on. 

Before you begin storage discovery, make sure that you have a properly configured backup proxy in 
your backup infrastructure. Otherwise, Veeam Backup & Replication will not be able to match storage 
volumes to VMware datastores and locate VMs on these storage volumes. 

To perform storage discovery: 

1. Open the Storage Infrastructure view.  

2. In the inventory pane, expand the tree of the storage system. 

3. Select a node in the storage system hierarchy: storage system, volume and so on.  

4. Click Rescan on the ribbon or right-click the node in the hierarchy and select Rescan 
Storage. 
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Important! 

 

If you chose to rescan only specific volumes when you added the storage system, the rescan 
operation for the storage system will discover only these selected volumes. To change the storage 
discovery scope, open the storage settings and select the necessary volumes at the Summary step of 
the wizard. For details, see Adding Storage System. 
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Choosing Volumes to Rescan 
The storage system hierarchy can be very extensive, and the rescan process can take much time. To 
minimize the rescan time, you can instruct Veeam Backup & Replication to rescan only specific 
volumes. 

To rescan specific volumes: 

1. Open the Storage Infrastructure view. 

2. In the inventory pane, select the storage system type. 

3. In the working area, right-click the root node of the storage system and click Choose 
volumes. 

4. In the Choose Volumes window, select which volumes you want to rescan: 

 To exclude volumes from rescan, select All volumes except, click Add and select 
volumes from the list. 

 To rescan only specific volumes, select Only these volumes, click Add and select 
volumes from the list. 

If you leave the Automatic detection option selected, Veeam Backup & Replication will 
rescan all volumes in the storage system hierarchy. 

5. Click OK. 

6. Click Finish. 
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Creating and Deleting Snapshots 

You can create and delete storage snapshots in Veeam Backup & Replication. The create/delete 
snapshot operations do not differ from the create/delete snapshot operations that you perform in the 
management console of the storage system. 

To create a volume snapshot: 

1. Open the Storage Infrastructure view. 

2. In the inventory pane, expand the tree of the storage system.  

3. Right-click the necessary volume and select Create Snapshot. 

4. In the New Storage Snapshot window, specify a name for the created snapshot and provide 
a description for the snapshot (if this option is available). 

5. [For HPE StoreVirtual] To quiesce VMs on the volume, select the Create application-
managed snapshot check box. The storage system will trigger a command to the vCenter 
Server to quiesce VMs on the volume with VMware Tools. This will bring VM data to a 
consistent state before the snapshot is taken. If this option is not selected, 
Veeam Backup & Replication will create a point-in-time snapshot. 

Note: 

 

To create application-managed snapshots for the HPE StoreVirtual storage system, make sure that 
Application Aware Snapshot Manager is properly installed and configured. If the Application Aware 
Snapshot Manager is not installed, Veeam Backup & Replication will report an error, and the 
snapshot will not be created. For more information, see the HPE P4000 Application-Aware Snapshot 
Manager Deployment Guide at http://h10032.www1.hp.com/ctg/Manual/c03037557.pdf.  

To delete a volume snapshot: 

1. Open the Storage Infrastructure view.  

2. In the inventory pane, expand a tree of the storage system. 

3. Right-click the necessary snapshot and select Delete Snapshot. 

 

http://h10032.www1.hp.com/ctg/Manual/c03037557.pdf
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Configuring Backup from Storage Snapshots 

You can configure backup and replication jobs to perform Backup from Storage Snapshots. Backup 
from Storage Snapshots leverages storage snapshots for backup and replication. Instead of reading 
data from VMware VM snapshots, Veeam Backup & Replication reads data from storage snapshots, 
which speeds up backup and replication operations and improves RPOs. 

Before you perform Backup from Storage Snapshots, check the following prerequisites: 

 A license for Veeam Backup & Replication Enterprise Plus edition must be installed on the 
backup server.  

 The backup infrastructure must be configured in a proper way: 

– A properly configured backup proxy must be added to the backup infrastructure. 
For more information, see Step 1. Configure Backup Proxy. 

– The vCenter Server/ESX(i) host with VMs whose disks are located on the storage 
system must be added to Veeam Backup & Replication. 

– The storage system must be added to Veeam Backup & Replication. 

 [For NetApp and EMC VNX(e) storage systems working over NFS] VMs that you plan to back 
up or replicate must not have VMware snapshots. VMs with VMware snapshots will be 
skipped from Backup from Storage Snapshots.  

 [For NetApp and EMC VNX(e) storage systems working over NFS] If you enable the Enable 
VMware tools quiescence option in the job settings, Veeam Backup & Replication will not 
use Backup from Storage Snapshots to process running Microsoft Windows VMs that have 
VMware Tools installed. 

 You must check limitations for Backup from Storage Snapshots. For more information, see 
Backup from Storage Snapshots. 
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To back up from storage snapshots: 

1. In the backup or replication job settings, select a backup proxy that will be used for data 
transport. You can assign the backup proxy explicitly or choose the automatic mode of 
backup proxy selection. 

 

2. In advanced settings of the job, make sure that the Enable backup from storage snapshots 
check box is selected. By default, this option is enabled for all newly created jobs. 

3. If you add to the job many VMs whose disks are located on the same volume or LUN, select 
the Limit processed VM count per storage snapshot to <N> check box and specify the 
number of VMs for which one storage snapshot must be created. 
Veeam Backup & Replication will divide VMs into several groups and trigger a separate 
storage snapshot for every VM group. As a result, the job performance will increase. 

For more information, see Limitation on Number of VMs per Snapshot. 
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4. If Veeam Backup & Replication fails to create a storage snapshot, VMs whose disks are located 
to the storage system will not be processed by the job. To fail over to the regular VM 
processing mode and back up or replicate such VMs in the regular processing mode, select 
the Failover to standard backup check box. 
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Configuring Backup from NetApp SnapMirror and SnapVault 

You can configure a backup job to perform Backup from Storage Snapshots on secondary NetApp 
arrays — NetApp SnapMirror or SnapVault. 

Before you perform Backup from Storage Snapshots, check the following prerequisites: 

 NetApp SnapMirror or SnapVault must be configured for the primary NetApp storage array 
where VMs that you plan to back up reside. 

 A license for storage snapshot export must be installed on NetApp SnapMirror or SnapVault. 
For more information, see Required Licenses for NetApp. 

 [For NetApp storage systems working over NFS] VMs that you plan to back up must not have 
VMware snapshots. VMs with VMware snapshots will be skipped from processing. 

 [For NetApp storage systems working over NFS] If you enable the Enable VMware tools 
quiescence option in the job settings, Veeam Backup & Replication will not use Backup from 
Storage Snapshots to process running Microsoft Windows VMs that have VMware Tools 
installed. 

 A license for Veeam Backup & Replication Enterprise Plus edition must be installed on the 
backup server.  

 The backup infrastructure must be configured in a proper way: 

– A properly configured backup proxy must be added to the backup 
infrastructure. The backup proxy must have access to the backup server and 
secondary storage array — NetApp SnapMirror or SnapVault. For more 
information, see Configuring Backup Proxy. 

– The vCenter Server/ESX(i) host with VMs whose disks are located on the 
storage system must be added to Veeam Backup & Replication. 

– The primary NetApp storage and NetApp SnapMirror/SnapVault must be 
added to Veeam Backup & Replication. 

 You must check limitations for Backup from Storage Snapshots. For more information, see 
Backup from Storage Snapshots.  
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To back up VMs from snapshots on NetApp SnapMirror and SnapVault: 

1. In the backup job settings, select a backup proxy that will be used for data transport. You can 
assign the backup proxy explicitly or choose the automatic mode of backup proxy selection. 

 

2. In advanced settings of the job, make sure that the Enable backup from storage snapshots 
check box is selected. By default, this option is enabled for all newly created jobs. 

3. If you add to the job many VMs whose disks are located on the same volume or LUN, select 
the Limit processed VM count per storage snapshot to <N> check box and specify the 
number of VMs for which one storage snapshot must be created. 
Veeam Backup & Replication will divide VMs into several groups and trigger a separate 
storage snapshot for every VM group. As a result, the job performance will increase. 

For more information, see Limitation on Number of VMs per Snapshot. 

4. If Veeam Backup & Replication fails to create a storage snapshot, VMs whose disks are located 
to the storage system will not be processed by the job. To fail over to the regular VM 
processing mode and back up such VMs in the regular processing mode, select the Failover 
to standard backup check box. 

5. If Veeam Backup & Replication cannot create a storage snapshot on NetApp SnapMirror or 
SnapVault, the job will not back up VMs whose disks are located to the storage system. To fail 
over to Backup from Storage Snapshots on the production storage, select the Failover to 
primary storage snapshot check box. If Veeam Backup & Replication fails to create a storage 
snapshot on NetApp SnapMirror or SnapVault, it will trigger the storage snapshot on the 
primary NetApp storage and use it as a source for backup. Note, however, that Backup from 
Storage Snapshots on the primary NetApp storage will put additional load on the production 
environment. 
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6. At the Storage step of the wizard, from the Backup repository list select a backup repository 
where you want to store backup files. 

7. In the Retention policy section, specify the number of backup restore points that you want 
to keep. 

8. Select the Configure secondary destinations for this job check box. 

 

9. At the Secondary Target step of the wizard, click Add and select NetApp SnapMirror or 
NetApp SnapVault. 
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10. In the Number of snapshot copies to retain field, specify the number of storage snapshots 
that you want to maintain in the snapshot chain on the secondary storage. When this number 
is exceeded, Veeam Backup & Replication will trigger NetApp to remove an earlier snapshot 
from the chain. 

11. Select the Use as the data source check box. 

 

12. Specify other backup job settings as required. 

13. Click Next, then click Finish to save the job settings. 
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Restoring VM Data from Storage Snapshots 

If VM data gets lost or corrupted, you can restore it from storage snapshots. 

The restore process is similar to restore from image-level backups of VMs. Veeam Backup & Replication 
offers the following restore options for storage snapshots: 

 Performing Instant VM Recovery 

 Restoring VM guest OS files (Microsoft Windows) 

 Restoring VM guest OS files (Linux, Unix and other) 

 Restoring application items 

Performing Instant VM Recovery 

You can instantly recover a VM from the storage snapshot without prior de-staging and intermediate 
restores. Instant VM Recovery accelerates the VM restore, improves RTOs and decreases downtime of 
production VMs. 

Before performing Instant VM Recovery, check prerequisites. Then use the Instant Recovery wizard to 
restore a VM from the storage snapshot. 

Before You Begin 

Before you perform Instant VM Recovery, check the following prerequisites: 

 If you are recovering a VM to the production network, make sure that the initial VM is 
powered off to avoid conflicts. 

 The storage system must be added to the backup infrastructure. 

 [For storage systems working over Fibre Channel] To let Veeam Backup & Replication present 
snapshots of LUNs to the ESX(i) host, you must register the ESX(i) host with a WWN ID on the 
storage system. 

 [For NetApp storage systems] Depending on the storage type, you may need to install 
additional licenses on the storage system. For more information, see Required Licenses for 
NetApp. 

 You must check limitations for Veeam Explorer for Storage Snapshots. For more information, 
see Veeam Explorer for Storage Snapshots. 

Step 1. Launch Instant Recovery Wizard 

To launch the Instant Recovery wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from backup section, 
select Instant VM recovery. 

 Open the Storage Infrastructure view. In the inventory pane, expand the storage system 
tree and select the necessary volume snapshot. In the working area, select the VM that you 
want to restore and click Instant VM Recovery on the ribbon. You can also right-click the VM 
and select Instant VM recovery. In this case, you will pass immediately to step 4. 

 Open the Backup & Replication view, in the inventory pane select Storage snapshots. In 
the working area, expand the necessary volume, select the VM that you want to restore and 
click Instant VM Recovery on the ribbon. You can also right-click the VM and select Instant 
VM recovery. In this case, you will pass immediately to step 3. 
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To quickly find the necessary VM, you can use the search field at the top of the window. Enter the VM 
name or a part of it and click the Start search button on the right or press [ENTER]. 

 

Step 2. Select VM 

At the Virtual Machine step of the wizard, select a VM that you want to restore: 

1. In the VM to recover list, expand the necessary volume snapshot.  

2. Select the VM. 

To quickly find the necessary VM, you can use the search field at the bottom of the window. Enter the 
VM name or a part of it and click the Start search button on the right or press [ENTER]. 
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Step 3. Select Restore Point 

At the Restore Point step of the wizard, select the restore point for the VM. Every volume snapshot 
acts as an independent restore point. 
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Step 4. Select Recovery Mode 

At the Recovery Mode step of the wizard, choose the necessary restore mode: 

 Select Restore to the original location if you want to restore the VM with its initial settings 
and to its original location. If this option is selected, you will pass directly to the Restore 
Reason step of the wizard. 

 Select Restore to a new location, or with different settings if you want to restore the VM to 
a different location and/or with different settings. If this option is selected, the Instant 
Recovery wizard will include additional steps for customizing VM settings. 

 

Step 5. Select Destination for Recovered VM 

The Destination step of the wizard is available if you have chosen to change the location and settings 
of the restored VM.  

Select a destination for the recovered VM: 

1. In the Host field, specify a host on which the VM must run. Veeam Backup & Replication will 
create a clone/virtual copy of the storage snapshot, mount it to the selected ESX(i) host and 
start the VM on this ESX(i) host. 

2. In the VM folder field, select a folder to which the restored VM must be placed. 

3. In the Restored VM name field, enter a name under which the restored VM must be 
registered. By default, Veeam Backup & Replication uses the original name of the VM. If you 
are restoring the VM to the same ESX(i) host or the same datacenter where the original VM is 
registered and the original VM still resides there, it is recommended that you change the VM 
name to avoid conflicts. 
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4. In the Resource pool list, select a resource pool to which the restored VM must be placed. 

 

Step 6. Specify Restore Reason 

At the Restore Reason step of the wizard, enter the reason for performing Instant VM Recovery. The 
information you provide will be saved in the session history and you can view it later. 
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Step 7. Verify Instant VM Recovery Settings 

At the Ready to Apply step of the wizard, specify additional settings for Instant VM Recovery: 

1. If you are recovering a production VM that has failed and want to restore it with initial 
network settings, select the Connect VM to network check box. If you are recovering a VM 
for testing disaster recovery and the original VM is still running, leave this check box not 
selected. Before you power on a VM, you will have to manually change VM network 
configuration: disconnect it from the production network and connect it to an isolated non-
production network to avoid conflicts. 

2. To start the VM immediately after recovery, select the Power on VM automatically check 
box. If you are recovering the VM to the production network, make sure that the initial VM is 
powered off to avoid conflicts. 

3. Check the settings for Instant VM Recovery and click Next. Veeam Backup & Replication will 
restore the VM on the selected ESX(i) host. 

 

Step 8. Finalize Instant VM Recovery 

All currently running Instant VM Recovery sessions are displayed in the Backup & Replication view, 
under the Restore > Instant Recovery node. 

To check the progress of the Instant VM Recovery session and view session details: 

1. Open the Backup & Replication view. 

2. Select the Instant Recovery node.  

3. Right-click the necessary session in the working area and select Properties. You can also 
double-click the necessary session in the list. 

After the VM has been successfully restored, you can finalize Instant VM Recovery in two ways:  

 Migrate the recovered VM to production 

 Unpublish the recovered VM 
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To migrate the recovered VM to production: 

1. Open the Backup & Replication view. 

2. Select the Instant Recovery node.  

3. Right-click the necessary Instant VM Recovery session in the working area and select Migrate 
to production. Veeam Backup & Replication will launch the Quick Migration wizard. During 
migration, Veeam Backup & Replication will restore the VM from the storage snapshot and 
then additionally move changes that were made while the VM was running in the Instant 
Recovery mode. 

To unpublish the restored VM: 

1. Open the Backup & Replication view. 

2. Select the Instant Recovery node.  

3. Right-click the necessary session in the working area and select Stop publishing.  

You can also unpublish the VM using the History view: 

1. Open the History view.  

2. Select the Restore > Instant VM recovery node. 

3. In the working area, right-click the necessary session and select Stop session. 
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Restoring VM Guest OS Files (Microsoft Windows) 

You can restore individual Microsoft Windows guest OS files from the storage snapshot. 
Veeam Backup & Replication supports file-level restore for the following Microsoft Windows file 
systems:  

 FAT 

 NTFS 

 ReFS 

When you perform guest OS file restore, you must select an ESX(i) host in your virtual environment. 
Veeam Backup & Replication creates a clone/virtual copy of the storage snapshot on which the VM 
disks reside and mounts the clone/virtual copy to the selected ESX(i) host as a new LUN/volume. 

After that, Veeam Backup & Replication accesses the configuration file of the VM (VMX) on the 
mounted clone/virtual copy and uses this configuration file to register a temporary VM on the 
selected ESX(i) host. Disks of the restored VM are mounted to this temporary VM. After disks are 
mounted, you can copy necessary VM guest OS files and folders to their initial location, local machine 
drive or save them in a network shared folder. 

Before you start file-level restore, check prerequisites. Then use the File Level Restore wizard to 
restore necessary files and folders. 

Before You Begin 

Before you restore VM guest OS files from storage snapshots, check the following prerequisites: 

 The storage system must be added to the backup infrastructure. 

 [For storage systems working over Fibre Channel] To let Veeam Backup & Replication present 
snapshots of LUNs to the ESX(i) host, you must register the ESX(i) host with a WWN ID on the 
storage system. 

 [For NetApp storage systems] Depending on the storage type, you may need to install 
additional licenses on the storage system. For more information, see Required Licenses for 
NetApp. 

 If you plan to restore VM guest OS files to their initial location, VMware Tools must be 
installed on the target VM. 

 If you plan to restore files from a VM running Microsoft Windows ReFS, for the restore process 
you must use Veeam Backup & Replication components running the following OSes: 

– [For VM file system browsing and file copy to another location] The 
Veeam Backup & Replication console must be installed on a machine running 
Microsoft Windows Server 2012 or Microsoft Windows Server 2012 R2.  

– [For restore to the original location] The Veeam Backup & Replication console and 
mount server asociated with the backup repository where backup files reside must 
be installed on a machine running Microsoft Windows Server 2012 or Microsoft 
Windows Server 2012 R2. 
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 If you plan to restore files from a VM running Microsoft Windows Server 2012 R2 and Data 
Deduplication is enabled for some VM volumes, for the restore process you must use 
Veeam Backup & Replication components running the following OSes: 

– [For copy to another location operations] The Veeam Backup & Replication console 
must be installed on a machine running Microsoft Windows Server 2012 or 
Microsoft Windows Server 2012 R2. Data Deduplication must be enabled on this 
machine. 

– [For restore to the original location] The Veeam Backup & Replication console and 
mount server asociated with the backup repository where backup files reside must 
be installed on a machine running Microsoft Windows Server 2012 or Microsoft 
Windows Server 2012 R2. Data Deduplication must be enabled on the mount 
server. 

 You must check limitations for Veeam Explorer for Storage Snapshots. For more information, 
see Veeam Explorer for Storage Snapshots. 

Step 1. Launch File Level Restore Wizard 

To launch the File Level Restore wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from backup section, 
select Guest files (Windows). 

 Open the Storage Infrastructure view. In the inventory pane, select the necessary volume 
snapshot. In the working area, select the VM whose guest OS files you want to restore and 
click Guest Files > Microsoft Windows on the ribbon. You can also right-click the VM and 
select Restore guest files > Microsoft Windows. In this case, you will pass immediately to 
step 4. 

 Open the Backup & Replication view. In the inventory pane, select Storage snapshots. In 
the working area, expand the necessary volume, select the VM whose guest OS files you want 
to restore and click Guest Files > Microsoft Windows on the ribbon. You can also right-click 
the VM and select Restore guest files > Microsoft Windows. In this case, you will pass 
immediately to step 3. 
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To quickly find the necessary VM, you can use the search field at the top of the window. Enter the VM 
name or a part of it and click the Start search button on the right or press [ENTER]. 

 

Step 2. Select VM 

At the Virtual Machine step of the wizard, select a VM whose guest OS files you want to restore: 

1. In the VM to recover list, expand the necessary volume snapshot.  

2. Select the VM. 

To quickly find the necessary VM, you can use the search field at the bottom of the window. Enter the 
VM name or a part of it and click the Start search button on the right or press [ENTER]. 
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Step 3. Select Restore Point 

At the Restore Point step of the wizard, select the restore point for the VM. Every snapshot of a 
volume acts as an independent restore point. 

 

Step 4. Select ESX(i) Host for Snapshot Mounting 

At the Location step of the wizard, select an ESX(i) host to which the clone/virtual copy of the storage 
snapshot will be mounted. On the selected ESX(i) host, Veeam Backup & Replication will create a 
temporary VM and mount disks of the restored VM to this temporary VM.  

To specify destination for the snapshot clone/virtual copy and temporary VM: 

1. At the Location step of the wizard, click Customize. 

2. Click Choose next to the Host field and select an ESX(i) host to which the snapshot 
clone/virtual copy must be mounted and on which the temporary VM must be created. 

3. Click Choose next to the Resource pool field and select a resource pool to which the 
temporary VM must be placed. 

4. Click Choose next to the VM folder field and select a folder to which the temporary VM must 
be placed. 

5. Click OK. 
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Step 5. Specify Restore Reason 

At the Reason step of the wizard, enter the reason for performing VM guest OS files restore. The 
information you provide will be saved in the session history and you can view it later. 

Tip: 

 

If you do not want to display the Reason step of the wizard in future, select the Do not show me 
this page again check box. 
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Step 6. Save Restored Files 

At the Summary step of the wizard, click Finish to start the VM guest OS files restore process. 

Once the restore process is complete, Veeam Backup & Replication will open the Veeam Backup 
browser displaying the file system tree of the restored VM. Note that names of the restored VM hard 
disks may differ from the original ones. 

You can perform the following operations with VM guest OS files in the Veeam Backup browser:  

 Restore files and folders to the original location 

 Save files and folders to a folder on the backup server or in network shared folder 

 Launch Veeam Explorers for application item restore 

 Open files in Microsoft Windows Explorer 

After the restore process is complete, close the Veeam Backup browser. 

Restoring Files to Original Location 
To restore files or folders to their initial location, right-click a file or folder in the Veeam Backup 
browser and select one of the following commands: 

 To overwrite the original file on the VM guest OS with the file restored from the backup, 
select Restore > Overwrite. 

 To save the file restored from the backup next to the original file, select Restore > Keep. 
Veeam Backup & Replication will add the RESTORED- prefix to the original file name and save 
the restored file in the same location where the original file resides. 
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Saving Files to New Location 
To save restored files or folders to a folder on the backup server or in a network shared folder, right-
click a file or folder in the Veeam Backup browser and select Copy To and select a location to which 
the file or folder must be copied. 

When restoring file objects, you can choose to preserve their original NTFS permissions: 

 Select the Preserve permissions and ownership check box to keep the original ownership 
and security permissions for restored objects. Veeam Backup & Replication will copy files and 
folders with associated Access Control Lists and preserve granular access settings. 

 Leave the Preserve permissions and ownership check box not selected if you do not want 
to preserve the original ownership and access settings for restored objects. 
Veeam Backup & Replication will change security settings: the user who launched the 
Veeam Backup & Replication console will be set as the owner of restored objects. Access 
permissions will be inherited from the folder to which restored objects are copied. 
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Launching Veeam Explorers 
If you are restoring VM guest OS files of the virtualized Microsoft Active Directory Server, Microsoft 
Exchange Server, Microsoft SharePoint Server, Microsoft SQL Server or Oracle, you can launch a Veeam 
Explorer for the necessary application directly from the Veeam Backup browser. 

 To start Veeam Explorer for Active Directory, browse to the Microsoft Active Directory 
database file (DIT) in the Veeam Backup browser, select it and click Application Items > 
Active Directory Items on the Home tab or double-click the DIT file. 

 To start Veeam Explorer for Exchange, browse to the Microsoft Exchange database file (EDB) 
in the Veeam Backup browser, select it and click Application Items > Exchange Items on the 
Home tab or double-click the EDB file. 

 To start Veeam Explorer for SharePoint, browse to the Microsoft SharePoint content database 
(MDF) in the Veeam Backup browser, select it and click Application Items > SharePoint 
Items on the Home tab or double-click the MDF file. 

 To start Veeam Explorer for Microsoft SQL, browse to the Microsoft SQL database file in the 
Veeam Backup browser, select it and click Application Items > SQL Server Databases on the 
Home tab or double-click the Microsoft SQL database file. For more information, see 
http://technet.microsoft.com/en-us/library/ms143547.aspx. 

Working with Windows Explorer 
You can use Microsoft Windows Explorer to work with restored files and folders.  

To open Microsoft Windows Explorer: 

1. Click Explore on the ribbon in the Veeam Backup browser or right-click the necessary folder 
and select Explore.  

2. Veeam Backup & Replication will launch Microsoft Windows Explorer. Browse to the necessary 
VM guest OS files. 

You can also start Microsoft Windows Explorer from the Start menu of Microsoft Windows and browse 
to the necessary VM guest OS files. VM disks are mounted under the 
C:\veeamflr\<vmname>\<volume n> folder on the backup server. 

  

http://technet.microsoft.com/en-us/library/ms143547.aspx
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Closing Veeam Backup Browser 
You can browse restored files and folders only while the Veeam Backup browser is open. After the 
Veeam Backup browser is closed, Veeam Backup & Replication unmounts the VM disks from the 
temporary VM. 

It is recommended that you close the Veeam Backup browser after you have finished restoring files 
and folders. In the opposite case, the backup file(s) from which you restore VM guest OS files may 
remain locked and operations using the file(s) may fail. 

Veeam Backup & Replication checks if there is any activity in the Veeam Backup browser every 5 
minutes. If the user or Veeam Backup & Replication components and services have not performed any 
actions for 30 minutes, Veeam Backup & Replication displays a warning notifying that the Veeam 
Backup browser will be closed within 5 minutes.  

After the warning is displayed, you can perform one of the following actions: 

 You can close the Veeam Backup browser manually. 

 You can click Cancel to postpone the close operation. In this case, the Veeam Backup browser 
will remain open for 5 minutes. After this period expires, Veeam Backup & Replication will 
display the warning again. 

 You can perform no action. In this case, the Veeam backup browser will be automatically 
closed in 5 minutes. 
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Restoring VM Guest OS Files (Linux, Unix and Other) 

You can restore VM guest OS files from the storage snapshot. Veeam Backup & Replication supports 
guest-file restore for the most commonly used file systems on Linux, Solaris, BSD, Unix and Novell OES. 

When you perform VM guest OS file restore, you must select an ESX(i) host in your virtual 
environment. Veeam Backup & Replication creates a clone/virtual copy of the storage snapshot on 
which the VM disks reside and mounts the clone/virtual copy to the selected ESX(i) host as a new 
LUN/volume.  

To the mounted clone/virtual copy, Veeam Backup & Replication copies an ISO of the proxy appliance, 
a helper VM. The proxy appliance is rather small — around 42 MB; it requires 1024 MB RAM and takes 
only 10 seconds to boot. Veeam Backup & Replication automatically starts the proxy appliance on the 
ESX(i) host and mounts disks of the restored VM to the proxy appliance as virtual hard drives. VMDK 
files are mounted directly from storage snapshots. After disks are mounted, you can copy necessary 
VM guest OS files and folders to their initial location, local machine drive or save them in a network 
shared folder. 

Before you start file-level restore, check prerequisites. Then use the File Level Restore wizard to 
restore the necessary files and folders. 

Before You Begin 

Before you restore VM guest OS files from storage snapshots, check the following prerequisites: 

 If you plan to restore VM guest OS files to their initial location, VMware Tools must be 
installed on the target VM. 

 Veeam Backup & Replication will be able to restore ACL for recovered VM guest OS files. To let 
Veeam Backup & Replication detect the target Linux system architecture and kernel version, 
the following utilities must be installed on the VM OS: arch and uname. 

 Veeam Backup & Replication must have access to the guest OS of the target VM to deploy a 
coordination process. The coordination process performs a number of administrative actions 
on the target VM guest OS, for example, collects information about mount points. 

 [For Linux/Unix-based target VM] Veeam Backup & Replication uses the SSH protocol to 
communicate with the target Linux/Unix VM and requires the SCP utility on the target VM. 
Make sure that the SSH daemon is properly configured and SCP utility is available on the 
target VM. 

 The storage system must be added to Veeam Backup & Replication. 

 [For storage systems working over Fibre Channel] To let Veeam Backup & Replication present 
snapshots of LUNs to the ESX(i) host, you must register the ESX(i) host with a WWN ID on the 
storage system. 

 [For NetApp storage systems] Depending on the storage type, you may need to install 
additional licenses on the storage system. For more information, see Required Licenses for 
NetApp. 

 You must check limitations for Veeam Explorer for Storage Snapshots. For more information, 
see Veeam Explorer for Storage Snapshots. 
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Step 1. Launch File Level Restore Wizard 

To launch the File Level Restore wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from backup section, 
select Guest files (other OS). 

 Open the Storage Infrastructure view. In the inventory pane, select the necessary volume 
snapshot. In the working area, select the VM whose guest OS files you want to restore and 
click Guest Files > Linux and other on the ribbon. You can also right-click the VM and select 
Restore guest files > Linux and other. In this case, you will pass immediately to step 4. 

 Open the Backup & Replication view. In the inventory pane, select Storage snapshots. In 
the working area, expand the necessary volume, select the VM whose guest OS files you want 
to restore and click Guest Files > Linux and other on the ribbon. You can also right-click the 
VM and select Restore guest files > Linux and other. In this case, you will pass immediately 
to step 3. 

To quickly find the necessary VM, you can use the search field at the top of the window. Enter the VM 
name or a part of it and click the Start search button on the right or press [ENTER]. 
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Step 2. Select Virtual Machine 

At the Virtual Machine step of the wizard, select a VM whose guest OS files you want to restore: 

1. In the VM to recover list, expand the necessary volume snapshot.  

2. Select the VM. 

To quickly find the necessary VM, you can use the search field at the bottom of the window. Enter the 
VM name or a part of it and click the Start search button on the right or press [ENTER]. 

 

Step 3. Select Restore Point 

At the Restore Point step of the wizard, select the necessary restore point for the VM. Every snapshot 
of a volume acts as an independent restore point. 
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Step 4. Select Location for Proxy Appliance 

At the Ready to Apply step of the wizard, select an ESX(i) host to which the clone/virtual copy of the 
storage snapshot will be mounted. On the selected ESX(i) host, Veeam Backup & Replication will also 
place a proxy appliance and mount disks of the restored VM to this proxy appliance. 

To specify destination for the snapshot clone/virtual copy and proxy appliance: 

1. Click the Customize link at the bottom of the window. 

2. In the FLR Appliance Configuration window, select an ESX(i) host to which the snapshot 
clone must be mounted and on which the proxy appliance must be registered.  

3. In the Resource pool field, specify a resource pool to which the proxy appliance must be 
placed. 

4. In the Network section, specify an IP address and other network settings for the proxy 
appliance. The proxy appliance must be placed in the same network where the backup server 
resides. 

5. To enable FTP access to the restored file system, select the Enable FTP server on appliance 
check box. As a result, your users will be able to access the proxy appliance via FTP, browse 
the file system of the restored VM and download necessary files on their own. 

6. If you are performing restore of a VM with the Novell Storage Services file system, select the 
Restore from Novell Storage Services (NSS) file system check box. In this case, 
Veeam Backup & Replication will deploy a specific proxy appliance that supports the Novell 
Storage Services file system.  

7. Click OK.  

Important! 

 

When choosing an ESX(i) host for the proxy appliance used for file-level restore from the Novell 
Storage Services file system, make sure that it allows running VMs with 64-bit guest OS'es. 
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Step 5. Start Restore Process 

At the Ready to Apply step of the wizard, click Next to start the restore process. The file-level restore 
appliance may take about 10-20 seconds to boot. 

 

Step 6. Save Restored Files 

When the restore process is complete, Veeam Backup & Replication opens the Veeam Backup browser 
displaying the file system tree of the restored VM.  

You can restore files and folders to their original location, new location or access files on FTP. 

Note: 

 

You can browse to the VM guest OS files and access restored files on the FTP only while the Veeam 
Backup browser with the restored files is open. After the Veeam Backup browser is closed, the VM 
disks will be unmounted from the proxy appliance. The proxy appliance will be deleted and the 
storage snapshot will be unmounted from the ESX(i) host (unless this storage snapshot is used by 
other restore operations). 

Restoring Files to Original Location 
To restore files and folders to the original location, right-click a file or folder in the Veeam Backup 
browser and select one of the following commands: 

 To overwrite the original file on the VM guest OS with the file restored from the backup, 
select Restore > Overwrite. 

 To save the file restored from the backup next to the original file, select Restore > Keep. 
Veeam Backup & Replication will add the RESTORED- prefix to the original file name and save 
the restored file in the same location where the original file resides. 

To restore files to the original location, Veeam Backup & Replication uses the account for VM guest OS 
access specified in the backup job settings. If this account does not have sufficient rights to access the 
target VM, you will be prompted to enter credentials. In the Credentials window, specify a user 
account to access the destination location (server or shared folder). You can use the account under 
which you are currently logged on or a different account. 
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Saving Files to New Location 
To save files and folders to a new location: 

1. Right-click the necessary file or folder and select Copy to. 

2. In the Select Destination window, select a destination server (local or remote) from the list or 
provide a path to the shared folder. 

 If you are recovering files to a Linux server, you can select the destination server 
from the list or add a destination server ad-hoc. To do this, scroll down the list of 
servers and choose Specify a different host at the end of the list. Follow the steps 
of the wizard to add a Linux server that will be used as a destination host.  

The server you add ad-hoc will not appear in the list of managed hosts in 
Veeam Backup & Replication: its purpose is to host the files that you recover. It will 
only remain visible in the Veeam Backup browser until all currently active file-level 
restore sessions are completed.  

 If you are recovering files to a shared folder, specify a path to the destination folder.  

3. If you want to preserve original permissions and ownership for recovered files, select the 
Preserve permissions and ownership check box. 

4. After you click Restore, if prompted, in the Credentials window specify the user account to 
access the destination location (server or shared folder). You can use the account under 
which you are currently logged on or a different account. 

Important! 

 

To restore original permissions and ownership settings of restored files and folders, the account you 
have specified must have privileges to change the owner on the selected server or in the shared 
folder.  

 

Accessing Files over FTP 
If you have chosen to enable FTP server on the FLR appliance, the restored file system will also be 
available over FTP at ftp://<FLR_appliance_IP_address>. Other users in the same network can access 
the FLR appliance and restore files they need. 
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Restoring Application Items 

You can use Veeam Explorers to restore application items directly from storage snapshots. 

Before You Begin 

Before you restore application items from storage snapshots, check the following prerequisites: 

 The storage system must be added to the backup infrastructure. 

 [For storage systems working over Fibre Channel] To let Veeam Backup & Replication present 
snapshots of LUNs to the ESX(i) host, you must register the ESX(i) host with a WWN ID on the 
storage system. 

 [For NetApp storage systems] Depending on the storage type, you may need to install 
additional licenses on the storage system. For more information, see Required Licenses for 
NetApp. 

 You must check limitations for Veeam Explorer for Storage Snapshots. For more information, 
see Veeam Explorer for Storage Snapshots. 

Restoring Application Items from Microsoft Active Directory 

Veeam Backup & Replication integrates with Veeam Explorer for Microsoft Active Directory — a tool 
that lets you browse Microsoft Active Directory databases in VM disks located on storage snapshots 
and restore Microsoft Active Directory items (objects and containers) and their attributes back into the 
production Microsoft Active Directory database.  

Before you can start working with Veeam Explorer for Microsoft Active Directory, you need to extract 
the Microsoft Active Directory database from the storage snapshot. You can do it in two ways: 

 You can use the Microsoft Active Directory Object Restore wizard. In this case, 
Veeam Backup & Replication will automatically extract the Microsoft Active Directory 
database from the storage snapshot and open it in Veeam Explorer for Microsoft Active 
Directory. For more information, see Using the Microsoft Active Directory Object Restore 
Wizard.  

 You can perform VM guest OS files recovery for the virtualized Microsoft Active Directory 
server, manually locate the Microsoft Active Directory database and open it in Veeam 
Explorer for Microsoft Active Directory. For more information, see Opening Microsoft Active 
Directory Database Manually.  

Using the Microsoft Active Directory Object Restore Wizard 

When you run the Microsoft Active Directory Object Restore wizard, Veeam Backup & Replication 
automatically extracts the Microsoft Active Directory database from the storage snapshot and opens it 
in Veeam Explorer for Microsoft Active Directory.  

As part of this procedure, Veeam Backup & Replication performs the following actions: 

1. Veeam Backup & Replication creates a clone/virtual copy of the storage snapshot and mounts 
the clone/virtual copy to the ESX(i) host. 

2. Veeam Backup & Replication accesses the configuration file of the virtualized Microsoft Active 
Directory server (VMX) on the snapshot clone/virtual copy and uses this configuration file to 
register a temporary VM on the ESX(i) host.  

3. Veeam Backup & Replication mounts disks of the restored Microsoft Active Directory server to 
the temporary VM. 

4. Veeam Backup & Replication locates the Microsoft Active Directory database and opens it in 
Veeam Explorer for Microsoft Active Directory.  
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Step 1. Launch Microsoft Active Directory Object Restore Wizard 
To launch the Microsoft Active Directory Restore wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from backup section, 
select Application items and click Next. At the Select Application step of the wizard, select 
Microsoft Active Directory. 

 Open the Storage Infrastructure view. In the inventory pane, select the necessary volume 
snapshot. In the working area, select a VM running Microsoft Active Directory and click 
Application Items > Microsoft Active Directory on the ribbon. You can also right-click the 
VM and select Restore application items > Microsoft Active Directory objects. In this case, 
you will pass immediately to step 4. 

 Open the Backup & Replication view. In the inventory pane select Storage snapshots. In 
the working area, expand the necessary volume, select a VM running Microsoft Active 
Directory and click Application Items > Microsoft Active Directory on the ribbon. You can 
also right-click the VM and select Restore application items > Microsoft Active Directory 
objects. In this case, you will pass immediately to step 3. 

To quickly find the necessary VM, you can use the search field at the top of the window. Enter the VM 
name or a part of it and click the Start search button on the right or press [ENTER]. 

 

Step 2. Select VM 
At the Virtual Machine step of the wizard, Veeam Backup & Replication displays all Microsoft Active 
Directory VMs with disks on storage volumes. Select the necessary VM from the list. If the VM is not 
displayed automatically, select the Show all VMs check box. Veeam Backup & Replication will display 
all VMs with disks on storage volumes. 

To quickly find the necessary VM, you can use the search field at the bottom of the window. Enter the 
VM name or a part of it and click the Start search button on the right or press [ENTER]. 
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Step 3. Select Restore Point 
At the Restore Point step of the wizard, select the necessary restore point for the VM. Every snapshot 
of a volume acts as an independent restore point. 
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Step 4. Select ESX(i) Host for Snapshot Mounting 
At the Location step of the wizard, select an ESX(i) host to which the clone/virtual copy of the storage 
snapshot must be mounted. On the selected ESX(i) host, Veeam Backup & Replication will create a 
temporary VM and mount the disks of the virtualized Microsoft Active Directory to this temporary VM. 

To specify destination for the snapshot clone/virtual copy and temporary VM: 

1. At the Location step of the wizard, click Customize. 

2. Click Choose next to the Host field and select an ESX(i) host to which the snapshot 
clone/virtual copy must be mounted and on which the temporary VM must be created. 

3. Click Choose next to the Resource pool field and select a resource pool to which the 
temporary VM must be placed. 

4. Click Choose next to the Folder field and select a folder to which the temporary VM must be 
placed. 

5. Click OK. 
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Step 5. Specify Restore Reason 
At the Reason step of the wizard, enter a reason for restoring a database from the Microsoft Active 
Directory if necessary. The information you provide will be saved in the session history and you can 
view it later. 

Tip: 

 

If you do not want to display the Reason step of the wizard in future, select the Do not show me 
this page again check box. 
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Step 6. Open the Database in Veeam Explorer for Microsoft Active Directory 
At the Summary step of the wizard, click Finish to start the restore process.  

Veeam Backup & Replication will automatically locate the Microsoft Active Directory database and 
open it in Veeam Explorer for Microsoft Active Directory. You can browse the database and restore 
items you need.  

Detailed information about Veeam Explorer for Microsoft Active Directory is provided in the Veeam 
Explorer for Microsoft Active Directory help. To open the help, do one of the following: 

 Open Veeam Explorer for Microsoft Active Directory and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Microsoft 
Active Directory. 
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Opening Microsoft Active Directory Database Manually 

You can restore the Microsoft Active Directory database from the storage snapshot with file-level 
restore and open it manually in Veeam Explorer for Microsoft Active DIrectory. 

1. Perform VM guest OS files restore for the virtualized Microsoft Active Directory server. For 
more information, see Restoring VM Guest OS Files (Microsoft Windows). 

2. In the Veeam Backup browser, locate the Microsoft Active Directory database file (NTDS.dit) 
and double-click it or select the NTDS.dit file and click Application Items > Active Directory 
Items on the ribbon.  

3. Veeam Backup & Replication will open the database in Veeam Explorer for Microsoft Active 
Directory. After that, you can browse the database and restore Microsoft Active Directory 
objects. 

Detailed information about Veeam Explorer for Microsoft Active Directory is provided in the Veeam 
Explorer for Microsoft Active Directory help. To open the help, do one of the following: 

 Open Veeam Explorer for Microsoft Active Directory and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Microsoft 
Active Directory. 
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Restoring Application Items from Microsoft Exchange 

Veeam Backup & Replication integrates with Veeam Explorer for Microsoft Exchange — a tool that lets 
you browse Microsoft Exchange mailbox stores in VM disks located on storage snapshots and restore 
Microsoft Exchange items you need. 

Before you can start working with Veeam Explorer for Microsoft Exchange, you need to extract the 
Microsoft Exchange database (EDB file) from the storage snapshot. You can do it in two ways: 

 You can use the Microsoft Exchange Item Level Restore wizard. In this case, 
Veeam Backup & Replication will automatically extract the Microsoft Exchange database from 
the storage snapshot and open it in Veeam Explorer for Microsoft Exchange. For more 
information, see Using the Microsoft Exchange Item Level Restore Wizard. 

 You can perform VM guest OS files recovery for the virtualized Microsoft Exchange server, 
manually locate the restored Microsoft Exchange database and open it in Veeam Explorer for 
Microsoft Exchange. For more information, see Opening EDB File Manually.  

Using the Microsoft Exchange Item Level Restore Wizard 

When you run the Microsoft Exchange Item Level Restore wizard, Veeam Backup & Replication 
automatically extracts the Microsoft Exchange database (EDB file) from the storage snapshot and 
opens it in Veeam Explorer for Microsoft Exchange.  

As part of this procedure, Veeam Backup & Replication performs the following steps: 

1. Veeam Backup & Replication creates a clone/virtual copy of the storage snapshot and mounts 
the clone/virtual copy to the ESX(i) host. 

2. Veeam Backup & Replication accesses the configuration file of the virtualized Microsoft 
Exchange server (VMX) on the snapshot clone/virtual copy and uses this configuration file to 
register a temporary VM on the ESX(i) host.  

3. Veeam Backup & Replication mounts disks of the restored Microsoft Exchange server to the 
temporary VM. 

4. Veeam Backup & Replication scans the Microsoft Exchange Event log to locate the EDB file 
and the ese.dll file on the mounted disks. The ese.dll file is required for configuring 
Veeam Explorer for Exchange. 

5. After the EDB file is successfully located, Veeam Backup & Replication opens it in Veeam 
Explorer for Exchange, and you can browse it to find necessary items.  
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Step 1. Launch Microsoft Exchange Item Level Restore Wizard 
To launch the Microsoft Exchange Item Level Restore wizard, do one of the following:  

 On the Home tab, click Restore and select VMware. In the Restore from backup section, 
select Application items and click Next. At the Select Application step of the wizard, select 
Microsoft Exchange. 

 Open the Storage Infrastructure view. In the inventory pane, select the necessary volume 
snapshot. In the working area, select a VM running Microsoft Exchange and click Application 
Items > Microsoft Exchange on the ribbon. You can also right-click the VM and select 
Restore application items > Microsoft Exchange mailbox items. In this case, you will pass 
immediately to step 4. 

 Open the Backup & Replication view. In the inventory pane, select Storage snapshots. In 
the working area, expand the necessary volume, select a VM running Microsoft Exchange and 
click Application Items > Microsoft Exchange on the ribbon. You can also right-click the VM 
and select Restore application items > Microsoft Exchange mailbox items. In this case, 
you will pass immediately to step 3. 

To quickly find the necessary VM, you can use the search field at the top of the window. Enter the VM 
name or a part of it and click the Start search button on the right or press [ENTER]. 
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Step 2. Select VM 
At the Virtual Machine step of the wizard, Veeam Backup & Replication displays all Microsoft 
Exchange VMs with disks on storage volumes. Select the necessary VM in the list. If the VM is not 
displayed automatically, select the Show all VMs check box. Veeam Backup & Replication will display 
all VMs with disks on storage volumes. 

To quickly find the necessary VM, you can use the search field at the bottom of the window. Enter the 
VM name or a part of it and click the Start search button on the right or press [ENTER]. 
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Step 3. Select Restore Point 
At the Restore Point step of the wizard, select the necessary restore point for the VM. Every snapshot 
of a volume acts as an independent restore point. 
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Step 4. Select ESX(i) Host for Snapshot Mounting 
At the Location step of the wizard, select an ESX(i) host to which the clone/virtual copy of the storage 
snapshot will be mounted. On the selected ESX(i) host, Veeam Backup & Replication will create a 
temporary VM and mount the disks of the virtualized Microsoft Exchange server to this temporary VM. 

To specify destination for the snapshot clone/virtual copy and temporary VM: 

1. At the Location step of the wizard, click Customize. 

2. Click Choose next to the Host field and select an ESX(i) host to which the snapshot clone 
must be mounted and on which the temporary VM must be created. 

3. Click Choose next to the Resource pool field and select a resource pool to which the 
temporary VM must be placed. 

4. Click Choose next to the Folder field and select a folder to which the temporary VM must be 
placed. 

5. Click OK.  
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Step 5. Specify Restore Reason 
At the Reason step of the wizard, enter the reason for restoring data from Microsoft Exchange if 
necessary. The information you provide will be saved in the session history and you can view it later. 

Tip: 

 

If you do not want to display the Reason step of the wizard in future, select the Do not show me 
this page again check box. 
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Step 6. Open EDB File in Veeam Explorer for Exchange 
At the Summary step of the wizard, click Finish to start the restore process.  

Veeam Backup & Replication will automatically locate the Microsoft Exchange database and open it in 
Veeam Explorer for Microsoft Exchange. You can browse the database and restore items you need.  

Detailed information about Veeam Explorer for Microsoft Exchange is provided in the Veeam Explorer 
for Microsoft Exchange help. To open the help, do one of the following: 

 Open Veeam Explorer for Microsoft Exchange and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Microsoft 
Exchange. 
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Opening EDB File Manually 

If Veeam Backup & Replication fails to locate the Microsoft Exchange database on the restored VM for 
some reason, you can restore it with file-level restore and open it manually. 

1. Perform VM guest OS files restore for the virtualized Microsoft Exchange server. For more 
information, see Restoring VM Guest OS Files (Microsoft Windows). 

2. In the Veeam Backup browser, locate the EDB file and double-click it or select the EDB file and 
click Application Items > Exchange Items on the ribbon.  

3. Veeam Backup & Replication will open the selected database in Veeam Explorer for Microsoft 
Exchange. After that, you can browse the database and restore items you need.  

Detailed information about Veeam Explorer for Microsoft Exchange is provided in the Veeam Explorer 
for Microsoft Exchange help. To open the help, do one of the following: 

 Open Veeam Explorer for Microsoft Exchange and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Microsoft 
Exchange. 
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Restoring Application Items from Microsoft SharePoint 

Veeam Backup & Replication integrates with Veeam Explorer for Microsoft SharePoint — a tool that 
lets you browse Microsoft SharePoint content databases in VM disks located on storage snapshots and 
restore documents, items and document libraries you need. 

Before you can start working with Veeam Explorer for Microsoft SharePoint, you need to extract the 
Microsoft SharePoint content database (MDF file) from the storage snapshot. To do this, you can 
perform VM guest OS files recovery for the virtualized Microsoft SharePoint server, manually locate the 
content database and open it in Veeam Explorer for Microsoft SharePoint. For more information, see 
Opening Content Database Manually.  
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Opening Content Database Manually 

You can restore the Microsoft SharePoint content database from the storage snapshot with file-level 
restore and open it manually. 

1. Perform VM guest OS files restore for the virtualized Microsoft SharePoint server. For more 
information, see Restoring VM Guest OS Files (Microsoft Windows). 

2. In the Veeam Backup browser, locate the MDF file and double-click it or select the file and 
click Application Items > SharePoint Items on the ribbon.  

3. Veeam Backup & Replication will attach the content database to the Microsoft SQL Server on 
which the Veeam Backup & Replication database is deployed and open the database in 
Veeam Explorer for Microsoft SharePoint. After that, you can browse the database and restore 
items you need.  

Detailed information about Veeam Explorer for Microsoft SharePoint is provided in the Veeam 
Explorer for Microsoft SharePoint help. To open the help, do one of the following: 

 Open Veeam Explorer for Microsoft SharePoint and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Microsoft 
SharePoint. 
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Restoring Databases from Microsoft SQL 

Veeam Backup & Replication integrates with Veeam Explorer for Microsoft SQL — a tool that lets you 
browse Microsoft SQL databases in VM disks located on storage snapshots and restore Microsoft SQL 
databases. 

Before you can start working with Veeam Explorer for Microsoft SQL, you need to extract the Microsoft 
SQL database from the storage snapshot. You can do it in two ways: 

 You can use the Microsoft SQL Server Database Restore wizard. In this case, 
Veeam Backup & Replication will automatically extract the Microsoft SQL database from the 
storage snapshot and open it in Veeam Explorer for Microsoft SQL. For more information, see 
Using the Microsoft SQL Server Database Restore Wizard.  

 You can perform VM guest OS files recovery for the virtualized Microsoft SQL server, manually 
locate the restored Microsoft SQL database and open it in Veeam Explorer for Microsoft SQL. 
For more information, see Opening Microsoft SQL Server Database Manually.  

Using the Microsoft SQL Server Database Restore Wizard 

When you run the Microsoft SQL Server Database Restore wizard, Veeam Backup & Replication 
automatically extracts the Microsoft SQL database from the storage snapshot and opens it in Veeam 
Explorer for Microsoft SQL.  

As part of this procedure, Veeam Backup & Replication performs the following actions: 

1. Veeam Backup & Replication creates a clone/virtual copy of the storage snapshot and mounts 
the clone/virtual copy to the ESX(i) host. 

2. Veeam Backup & Replication accesses the configuration file of the virtualized Microsoft SQL 
server (VMX) on the snapshot clone/virtual copy and uses this configuration file to register a 
temporary VM on the ESX(i) host.  

3. Veeam Backup & Replication mounts disks of the restored Microsoft SQL server to the 
temporary VM. 

4. Veeam Backup & Replication locates the Microsoft SQL database and attaches the content 
database to a staging Microsoft SQL Server. As a staging server, Veeam Backup & Replication 
uses the Microsoft SQL Server on which the Veeam Backup & Replication database is 
deployed. 

5. Veeam Backup & Replication opens the restored database in Veeam Explorer for Microsoft 
SQL.  

  



 

993   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Step 1. Launch Microsoft SQL Server Database Restore Wizard 
To launch the Microsoft SQL Server Database Restore wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from backup section, 
select Application items and click Next. At the Select Application step of the wizard, select 
Microsoft SQL Server. 

 Open the Storage Infrastructure view. In the inventory pane, select the necessary volume 
snapshot. In the working area, select a VM running Microsoft SQL Server and click 
Application Items > Microsoft SQL Server on the ribbon. You can also right-click the VM 
and select Restore application items > Microsoft SQL Server databases. In this case, you 
will pass immediately to step 4. 

 Open the Backup & Replication view. In the inventory pane, select Storage snapshots. In 
the working area, expand the necessary volume, select a VM running Microsoft SQL Server 
and click Application Items > Microsoft SQL Server on the ribbon. You can also right-click 
the VM and select Restore application items > Microsoft SQL Server databases. In this 
case, you will pass immediately to step 3. 

To quickly find the necessary VM, you can use the search field at the top of the window. Enter the VM 
name or a part of it and click the Start search button on the right or press [ENTER]. 
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Step 2. Select VM 
At the Virtual Machine step of the wizard, Veeam Backup & Replication displays all Microsoft SQL 
Server VMs with disks on storage volumes. Select the necessary VM in the list. If the necessary VM is 
not displayed automatically, select the Show all VMs check box. Veeam Backup & Replication will 
display all VMs with disks on storage volumes. 

To quickly find the necessary VM, you can use the search field at the bottom of the window. Enter the 
VM name or a part of it and click the Start search button on the right or press [ENTER]. 
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Step 3. Select Restore Point 
At the Restore Point step of the wizard, select the necessary restore point for the VM. Every snapshot 
of a volume acts as an independent restore point. 
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Step 4. Select ESX(i) Host for Snapshot Mounting 
At the Location step of the wizard, select an ESX(i) host to which the clone/virtual copy of the storage 
snapshot must be mounted. On the selected ESX(i) host, Veeam Backup & Replication will create a 
temporary VM and mount the disks of the virtualized Microsoft SQL Server to this temporary VM. 

To specify destination for the snapshot clone/virtual copy and temporary VM: 

1. At the Location step of the wizard, click Customize. 

2. Click Choose next to the Host field and select an ESX(i) host to which the snapshot 
clone/virtual copy must be mounted and on which the temporary VM must be created. 

3. Click Choose next to the Resource pool field and select a resource pool to which the 
temporary VM must be placed. 

4. Click Choose next to the Folder field and select a folder to which the temporary VM must be 
placed. 

5. Click OK. 
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Step 5. Specify Restore Reason 
At the Reason step of the wizard, enter the reason for restoring a database from the Microsoft SQL 
Server if necessary. The information you provide will be saved in the session history and you can view 
it later. 

Tip: 

 

If you do not want to display the Reason step of the wizard in future, select the Do not show me 
this page again check box. 
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Step 6. Open the Database in Veeam Explorer for Microsoft SQL 
At the Summary step of the wizard, click Finish to start the restore process.  

Veeam Backup & Replication will automatically locate the Microsoft SQL database and attach the 
content database to the staging Microsoft SQL Server. After that, Veeam Backup & Replication will 
open the Veeam Explorer for Microsoft SQL and add the restored database to it. 

Detailed information about Veeam Explorer for Microsoft SQL is provided in the Veeam Explorer for 
Microsoft SQL help. To open the help, do one of the following: 

 Open Veeam Explorer for Microsoft SQL Server and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Microsoft SQL. 
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Opening Microsoft SQL Server Database Manually 

You can restore the Microsoft SQL Server database from the storage snapshot with file-level restore 
and open it manually. 

1. Perform VM guest OS files restore for the virtualized Microsoft SQL server. For more 
information, see Restoring VM Guest OS Files (Microsoft Windows). 

2. In the Veeam Backup browser, locate the MDF file and double-click it or select the file and 
click Application Items > SQL Server Databases on the ribbon.  

3. Veeam Backup & Replication will attach the restored database to the Microsoft SQL Server on 
which the Veeam Backup & Replication database is deployed and open the selected database 
in Veeam Explorer for Microsoft SQL. After that, you can restore the database to the necessary 
Microsoft SQL Server.  

Detailed information about Veeam Explorer for Microsoft SQL is provided in the Veeam Explorer for 
Microsoft SQL help. To open the help, do one of the following: 

 Open Veeam Explorer for Microsoft SQL Server and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Microsoft SQL. 
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Restoring Databases from Oracle 

Veeam Backup & Replication integrates with Veeam Explorer for Oracle — a tool that lets you browse 
Oracle databases in VM disks located on storage snapshots and restore Oracle databases. 

Before you can start working with Veeam Explorer for Oracle, you need to extract the Oracle database 
from the storage snapshot. You can do it in two ways: 

 You can use the Oracle Database Restore wizard. In this case, Veeam Backup & Replication 
will automatically extract the Oracle database from the storage snapshot and open it in 
Veeam Explorer for Oracle. For more information, see Using the Oracle Database Restore 
Wizard.  

 You can perform VM guest OS files recovery for the virtualized Oracle server, manually locate 
the restored Oracle database and open it in Veeam Explorer for Oracle. For more information, 
see Opening Oracle Database Manually.  

Using the Oracle Restore Wizard 

When you run the Oracle Database Restore wizard, Veeam Backup & Replication automatically 
extracts the Oracle database from the storage snapshot and opens it in Veeam Explorer for Oracle.  

As part of this procedure, Veeam Backup & Replication performs the following actions: 

1. Veeam Backup & Replication creates a clone/virtual copy of the storage snapshot and mounts 
the clone/virtual copy to the ESX(i) host. 

2. Veeam Backup & Replication accesses the configuration file of the virtualized Oracle server 
(VMX) on the snapshot clone/virtual copy and uses this configuration file to register a 
temporary VM on the ESX(i) host.  

3. Veeam Backup & Replication mounts disks of the restored Oracle server to the temporary VM. 

4. Veeam Backup & Replication locates the Oracle database and attaches the database to a 
staging Oracle server.  

5. Veeam Backup & Replication opens the restored database in Veeam Explorer for Oracle.  
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Step 1. Launch Oracle Database Restore Wizard 
To launch the Oracle Database Restore wizard, do one of the following: 

 On the Home tab, click Restore and select VMware. In the Restore from backup section, 
select Application items and click Next. At the Select Application step of the wizard, select 
Oracle Database. 

 Open the Storage Infrastructure view. In the inventory pane, select the necessary volume 
snapshot. In the working area, select a VM running Oracle and click Application Items > 
Oracle on the ribbon. You can also right-click the VM and select Restore application items > 
Oracle databases. In this case, you will pass immediately to step 4. 

 Open the Backup & Replication view. In the inventory pane, select Storage snapshots. In 
the working area, expand the necessary volume, select a VM running Oracle and click 
Application Items > Oracle on the ribbon. You can also right-click the VM and select Restore 
application items > Oracle databases. In this case, you will pass immediately to step 3. 

To quickly find the necessary VM, you can use the search field at the top of the window. Enter the VM 
name or a part of it and click the Start search button on the right or press [ENTER]. 
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Step 2. Select VM 
At the Virtual Machine step of the wizard, Veeam Backup & Replication displays all Oracle VMs with 
disks on storage volumes. Select the necessary VM in the list. If the necessary VM is not displayed 
automatically, select the Show all VMs check box. Veeam Backup & Replication will display all VMs 
with disks on storage volumes. 

To quickly find the necessary VM, you can use the search field at the bottom of the window. Enter the 
VM name or a part of it and click the Start search button on the right or press [ENTER]. 
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Step 3. Select Restore Point 
At the Restore Point step of the wizard, select the necessary restore point for the VM. Every snapshot 
of a volume acts as an independent restore point. 
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Step 4. Select ESX(i) Host for Snapshot Mounting 
At the Location step of the wizard, select an ESX(i) host to which the clone/virtual copy of the storage 
snapshot must be mounted. On the selected ESX(i) host, Veeam Backup & Replication will create a 
temporary VM and mount the disks of the virtualized Oracle VM to this temporary VM. 

To specify destination for the snapshot clone/virtual copy and temporary VM: 

1. At the Location step of the wizard, click Customize. 

2. Click Choose next to the Host field and select an ESX(i) host to which the snapshot 
clone/virtual copy must be mounted and on which the temporary VM must be created. 

3. Click Choose next to the Resource pool field and select a resource pool to which the 
temporary VM must be placed. 

4. Click Choose next to the Folder field and select a folder to which the temporary VM must be 
placed. 

5. Click OK. 
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Step 5. Specify Restore Reason 
At the Reason step of the wizard, enter the reason for restoring a database from the Oracle VM if 
necessary. The information you provide will be saved in the session history and you can view it later. 

Tip: 

 

If you do not want to display the Reason step of the wizard in future, select the Do not show me 
this page again check box. 
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Step 6. Open the Database in Veeam Explorer for Oracle 
At the Summary step of the wizard, click Finish to start the restore process.  

Veeam Backup & Replication will automatically locate the Oracle database and attach the content 
database to the staging server. After that, Veeam Backup & Replication will open the Veeam Explorer 
for Oracle and add the restored database to it. 

Detailed information about Veeam Explorer for Oracle is provided in the Veeam Explorer for Oracle 
help. To open the help, do one of the following: 

 Open Veeam Explorer for Oracle and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Oracle. 
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Opening Oracle Database Manually 

You can restore the Oracle database from the storage snapshot with file-level restore and open it 
manually. 

1. Perform VM guest OS files restore for the virtualized Oracle server. For more information, see 
Restoring VM Guest OS Files (Microsoft Windows). 

2. In the Veeam Backup browser, locate the database file and double-click it or select the file 
and click Application Items > Oracle databases on the ribbon.  

3. Veeam Backup & Replication will attach the restored database to the staging server and open 
the selected database in Veeam Explorer for Oracle. After that, you can restore the database 
to the necessary Oracle server.  

Detailed information about Veeam Explorer for Oracle is provided in the Veeam Explorer for Oracle 
help. To open the help, do one of the following: 

 Open Veeam Explorer for Oracle and press [F1]. 

 Select Help > Help or Online Help from the main menu of Veeam Explorer for Oracle. 

 

  



 

1008   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Scheduling Snapshot Creation (NetApp) 

You can configure a backup job to create NetApp storage snapshots automatically by schedule. 
During a backup job session, Veeam Backup & Replication will trigger NetApp to create a storage 
snapshot on the necessary NetApp storage system:  

 Primary NetApp storage array 

 Secondary NetApp storage array — NetApp SnapMirror or SnapVault 

Automatic snapshot creation lets you complement backups created with Veeam Backup & Replication 
with snapshots created on the NetApp storage system, and reduce administration overhead. 

To create storage snapshots with Veeam Backup & Replication, you must configure a backup job and 
define a destination for snapshot creation in the job settings. Veeam Backup & Replication lets you 
configure the following types of job: 

 Storage snapshots only: the backup job that creates only storage snapshots on the primary 
NetApp storage array and, optionally, storage snapshots on NetApp SnapMirror and/or 
SnapVault.  

 Storage snapshots in the secondary destination: the backup job that creates a VM backup in 
the primary location (backup repository) and triggers a storage snapshot in the secondary 
location — primary NetApp storage array, NetApp SnapMirror and/or NetApp SnapVault. 

Configuring Storage Snapshots Only Jobs 

The Storage Snapshot Only backup job creates NetApp storage snapshots on the primary NetApp 
storage array and, optionally, on NetApp SnapMirror and/or SnapVault.  

The Storage Snapshot Only job is similar to scheduling automatic storage snapshot creation via the 
NetApp management console. When the backup job runs, Veeam Backup & Replication does not 
create Veeam backup files on the backup repository. It only triggers storage snapshots by schedule 
defined in the backup job settings.  

Depending on the backup job settings, the created snapshot can be application-consistent or crash-
consistent. 

To configure a Storage Snapshot Only backup job: 

1. Open the Backup & Replication view. 

2. Click Backup Job > VMware or vCloud on the ribbon. Veeam Backup & Replication will 
launch the New Backup Job wizard. 

3. At the Name step of the wizard, specify a name and description for the created backup job. 

4. At the Virtual Machines step of the wizard, click Add and select VMs whose disks are located 
on the primary NetApp storage array. 

5. At the Storage step of the wizard, select NetApp SnapShot from the Backup repository list.  

6. In the Retention policy section, specify the number of storage snapshots that you want to 
maintain on the primary NetApp storage array. When this number is exceeded, 
Veeam Backup & Replication will trigger NetApp to remove an earlier snapshot from the 
snapshot chain. 

Note: 

 

The number of snapshots in the snapshot chain on the primary NetApp storage cannot fewer than 2. 
Even if you set the Number of snapshot copies to retain value to 1, Veeam Backup & Replication 
will maintain 2 snapshots in the snapshot chain. 
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7. If you want to additionally create storage snapshots on NetApp SnapVault and/or SnapMirror, 
select the Configure secondary destinations for this job check box. 

 

8. If you have enabled a secondary destination for the job, at the Secondary Target step of the 
wizard, click Add > NetApp SnapMirror and/or NetApp > SnapVault to add the secondary 
location.  

9. [For NetApp SnapVault] In the Number of snapshot copies to retain field, specify the 
number of storage snapshots that you want to maintain in the snapshot chain. When this 
number is exceeded, Veeam Backup & Replication will trigger NetApp to remove an earlier 
snapshot from the chain. 

This option is not applicable to NetApp SnapMirror. On NetApp SnapMirror, 
Veeam Backup & Replication maintains the same number of storage snapshots as on the 
primary NetApp storage system. 

If you use SnapMirror relationships between QTrees, you can define different retention policy 
settings for the primary NetApp storage system and NetApp SnapMirror. For example, you 
can configure the backup job to maintain 14 snapshots on the primary NetApp storage 
system and 10 snapshots of QTree directories on NetApp SnapMirror.  
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10. To create an application-consistent storage snapshot, you can enable VMware Tools 
quiescence or application-aware processing. If you do not enable either of these options, 
Veeam Backup & Replication will produce a crash-consistent storage snapshot. 

 To enable VMware Tools quiescence, in the advanced settings of the backup job 
select the Enable VMware Tools quiescence check box. Depending on the VM 
version, Veeam Backup & Replication will use the VMware FileSystem Sync Driver 
(vmsync) driver or VMware VSS component in VMware Tools to create VMware 
snapshots for VMs whose disks are located on the NetApp storage system. After 
VMware snapshots are created, Veeam Backup & Replication will trigger a NetApp 
storage snapshot. For more information, see VMware Tools Quiescence. 
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 To enable application-aware processing, at the Guest Processing step of the 
wizard select the Enable application-aware processing check box and specify the 
necessary settings for application-aware image processing.  

During the backup job session, Veeam Backup & Replication will quiesce 
applications running inside VMs using application-aware processing. After 
applications inside the VM are quiesced, Veeam Backup & Replication will trigger a 
NetApp storage snapshot. For more information, see Application-Aware 
Processing. 

 

11. At the Schedule step of the wizard, select the Run the job automatically check box and 
specify the schedule by which storage snapshots must be created. For more information, see 
Define the Job Schedule. 

12. Click Next, then click Finish to create the job. 
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Configuring Jobs Creating Snapshots in Secondary Destination 

You can configure a backup job to create a storage snapshot in the secondary destination: on the 
primary NetApp storage array, NetApp SnapMirror and/or SnapVault.  

When you run a backup job that creates a storage snapshot in the secondary destination, 
Veeam Backup & Replication produces a backup file on the backup repository in a regular manner. In 
addition to it, Veeam Backup & Replication triggers a NetApp storage snapshot in the specified 
location. Depending on the backup job settings, the created storage snapshot can be application-
consistent or crash-consistent. 

To create a backup job that creates a storage snapshot in the secondary destination: 

1. Open the Backup & Replication view. 

2. Click Backup Job > VMware or vCloud on the ribbon. Veeam Backup & Replication will 
launch the New Backup Job wizard. 

3. At the Name step of the wizard, specify a name and description for the created backup job. 

4. At the Virtual Machines step of the wizard, select VMs whose disks are located on the 
primary NetApp storage array. 

5. At the Storage step of the wizard, from the Backup repository list select a backup repository 
where you want to store backup files.  

6. In the Retention policy section, specify the number of backup restore points that you want 
to keep. 

7. Select the Configure secondary destinations for this job check box.  

 

8. At the Secondary Target step of the wizard, click Add > NetApp SnapShot, Add > NetApp 
SnapMirror and/or NetApp > SnapVault to add the secondary location for the backup job.  

9. [For primary NetApp storage system and NetApp SnapVault] In the Number of snapshot 
copies to retain field, specify the number of storage snapshots that you want to maintain in 
the snapshot chain on the secondary storage. When this number is exceeded, 
Veeam Backup & Replication will trigger NetApp to remove an earlier snapshot from the 
chain. 



 

1013   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

This option is not applicable to NetApp SnapMirror. On NetApp SnapMirror, 
Veeam Backup & Replication maintains the same number of storage snapshots as on the 
primary NetApp storage system. 

Note: 

 

The number of snapshots in the snapshot chain on the primary NetApp storage cannot fewer than 2. 
Even if you set the Number of snapshot copies to retain value to 1, Veeam Backup & Replication 
will maintain 2 snapshots in the snapshot chain. 

If you use SnapMirror relationships between QTrees, you can define different retention policy 
settings for the primary NetApp storage system and NetApp SnapMirror. For example, you 
can configure the backup job to maintain 14 snapshots on the primary NetApp storage 
system and 10 snapshots of QTree directories on NetApp SnapMirror.  

 

10. Specify other backup job settings as required. 

11. Click Next, then click Finish to save the job settings. 
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Working with Tape Media 
Veeam provides native support for backing up your data to tape. Tape backups is an easy and high-
reliable storing scheme protecting your backups from disaster or occasional loss. 

To start backing up data to tape, you need to deploy the tape backup infrastructure and configure 
Veeam Backup & Replication to meet your secondary destination storage policies. 

To back up data to tape, you need to create a tape job that can run manually or on schedule. To 
restore data from tape, you need to insert the tapes containing the needed data and start the restore 
process that runs fully automated. 

With Veeam Backup & Replication, you can perform the following operations: 

 Archiving VM backups to tape: the backup to tape job is specially designed to select the 
Veeam backup files and archive them to tape. Veeam Backup & Replication allows you to 
archive incremental or full backups, or both, and also to schedule a synthetic full backup that 
is created specially for tape archives. You can archive backups that are produced by certain 
backup to disk jobs, or set the tape job to monitor backup repositories and archive newly 
added backups. Select an appropriate data source in the tape job to enable these options. 

 Linking tape jobs to backup jobs: to make the VM archiving more convenient, you can link the 
tape job to a regular backup job. In this case, Veeam Backup & Replication will set the tape 
device as a secondary destination for the backup job and start the linked tape job after it. The 
tape job will select the newly created backup files and copy them to tape. 

 Archive files with user data: Veeam Backup & Replication allows you to archive any files with 
no limitation to file format. To archive files, you need to create a dedicated file to tape job 
that is able to archive full and incremental backups of user files. As a data source, you can 
select any Microsoft Windows server, Linux server or shared folder that is accessible by the 
Veeam backup server. 

 Restore VMs that was archived to tape into your virtual infrastructure. The restore capabilities 
provides all options available for regular VM restore such as choosing restore point or 
restoring to another location with possibility to re-configure the restored VM in the latter 
case. 

 Copy tape backups to disk and use, for example, for the following tasks: 

– Keep some VM backups on disk, for example, to have them at hand; you can copy 
backups for particular VMs or whole backup chains. 

– Perform guest OS files restore. Restoring VM backups to disk allows you to restore a 
VM in some allocated folder and perform file-level restore from its disks. 

 Restore files: the Files from Tape Restore wizard allows you to navigate through the tape 
archive selecting the files you need and restore them to original location or any other disk or 
folder in your backup infrastructure. 

 Import data from tapes that were recorded not on your Veeam backup server: when you run 
the importing procedure for such tapes, Veeam Backup & Replication scans the data that is 
written to them and adds information about them to the Veeam backup database. After that 
the data becomes available for restore. 
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Getting Started with Tapes 
To start working with tapes in Veeam Backup & Replication, you need to complete the following steps: 

1. Connect the tape device to a tape server. 

2. Add the tape server to Veeam Backup & Replication. 

3. Load tapes to the tape device (if not yet loaded) and run the importing procedure for them. 

4. Create one or more custom media pool or GFS media pool that will be used as targets for 
tape jobs. 

5. Configure one or more media vaults to conveniently organize offline tapes. 

6. Configure and run files to tape jobs. 

7. Configure and run backup to tape or files to tape jobs. 

8. Restore VMs to infrastructure or to repository, or restore files from tape. 
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Deploying Tape Devices 
To add the tape devices to Veeam Backup & Replication, you need to perform the following steps: 

1. Connect the tape devices to the machine that will act as the tape server. You can choose 
between the following options: 

 Deploy a dedicated Microsoft Windows server, physical or virtual, accessible by 
Veeam Backup & Replication. 

 Use the Veeam backup server as the tape server. 

2. Add this machine to Veeam Backup & Replication as a tape server. 

If you connect tape devices to the Veeam backup server, you also need to go through the 
adding procedure. 

Connecting Tape Devices 

To deploy a tape device, you must perform the following steps: 

1. Connect the tape device to the machine that will perform the role of the tape server. You can 
connect the tape device in two ways: 

 Directly over Fibre Channel (FC), Serial Attached SCSI (SAS), SCSI 

 Remotely with iSCSI (you can use Microsoft iSCSI initiator to establish the 
connection). 

2. Install an appropriate device driver on the tape server. 

If multiple driver installation modes are supported for your storage device, make sure the 
driver is installed in the mode that allows for multiple open handles from a host to a drive to 
exist at the same time. 

For example, if installing a driver for IBM System Storage TS3100 Tape Library or TS3200 Tape 
Library, you should use the install_nonexclusive.exe installer as described in the product 
Readme. 
Please refer to your storage system manufacturer recommendations on choosing the 
appropriate setup option. 

3. If the medium changer driver is not available, check that the tape device uses native SCSI 
commands. 

Open the Tape Infrastructure view, expand the Libraries node and select the needed 
library. Click Properties on the ribbon. You can also right-click the necessary library in the 
working area and select Properties. Select the Use native SCSI commands instead of 
Windows driver check box. 
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Important! 

 

Only media changers can use SCSI commands. Tape drives must use native OEM drivers. 

After you connected the tape device to the selected server, you need to add this server to 
Veeam Backup & Replication as a tape server. Veeam Backup & Replication will automatically scan 
attached tape devices and display all discovered tape libraries and tape drives under the Libraries 
node in the Tape Infrastructure view. Afterward, the auto-discovery process will be performed 
periodically every 3 minutes. 

To each tape server you can connect a number of tape devices that will appear as list under the 
Libraries node in the Tape Infrastructure view. 

Veeam Backup & Replication allows deploying a number of tape servers. However, if you have a 
number of Veeam backup servers, you cannot connect one tape server to several Veeam backup 
servers simultaneously. 

Tip: 

 

If you have a number of Veeam backup servers, you can easily reconnect a tape server to another 
Veeam backup server without reconfiguring the tape device: Veeam backup server will recognize the 
library settings automatically. Note that when you reconnect the tape server, the tape jobs will not 
run with another Veeam backup server unless you copy the configuration. 
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Reconnecting Tape Devices to Tape Server  

If you have the tape devices connected directly, you can reconfigure your tape infrastructure and start 
using a dedicated tape server. In this case, all tape device settings will remain unchanged. 

To reconnect the tape device, you must perform the following steps: 

1. Choose a machine that will act as the tape server. The tape server must be a dedicated 
Microsoft Windows server, physical or virtual, accessible by Veeam Backup & Replication. 

2. Reconnect the tape device to the machine that will perform the role of the tape server. You 
can connect the tape device directly over Fibre Channel (FC), Serial Attached SCSI (SAS), SCSI) 
or remotely with iSCSI (you can use Microsoft iSCSI initiator to establish the connection). 

3. Add the server as the tape server to Veeam Backup & Replication: the connected tape device 
will be discovered automatically. 

Working with Tape Servers 

Tape servers are network appliances that are used to connect tape libraries to the Veeam backup 
server.  

To be able to connect a tape device to Veeam Backup & Replication, you need to deploy a tape server 
and add it to Veeam backup console. 

Adding Tape Servers 

When you have deployed a tape server and connected the tape device to it, you need to add the tape 
server to the Veeam backup server. To do so, you must assign the role of the tape server to a Windows 
server that is already added to the list of managed servers. 

To add a tape server, follow the next steps: 

Step 1. Launch the New Tape Server Wizard 

To launch the wizard, do one of the following: 

 Open the Tape Infrastructure view and click Add Tape Server on the ribbon. 

 Open the Tape Infrastructure view, right-click the Tape Infrastructure node and select Add 
Tape Server. 
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Step 2. Choose a Server 

At the Server step of the wizard, select a physical or virtual server to which the tape devices are 
connected and that you want to add as the tape server. 

1. From the Choose server list, select the server that you want to add as the tape server. 

 If the devices are connected to the Veeam backup server, choose This server. The 
tape server role will be assigned to you backup server. 

 If the devices are connected to a separated server, enter the server name or IP 
address. The tape server must run Microsoft Windows. If the server is not added to 
Veeam Backup & Replication yet, you can click Add New to open the New 
Windows Server wizard. 

2. In the Description field, provide a description for future reference. 
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Step 3. Configure Traffic Throttling Rules 

At the Traffic step of the wizard, configure throttling rules to limit the outbound traffic rate for the 
tape server. Throttling rules will help you manage bandwidth usage and minimize the impact of tape 
jobs on network performance. For more information, see Setting Network Traffic Throttling Rules.  

The list of throttling rules contains only those rules that are applicable to the tape server you are 
adding. The rule is applied to the tape server if its IP address falls under the source IP range of the rule. 
To view the rule settings, select it in the list and click the View button on the right. 

You can also open global throttling settings and modify them directly from the wizard by clicking 
Manage network traffic throttling rules at the bottom of the window. 
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Step 4. Review Components 

At the Review step of the wizard, Veeam Backup & Replication will display the list of components 
required for work of the tape server: 

 Veeam Transport 

 Veeam Tape service 

If any of them is missing, Veeam Backup & Replication will automatically install them on the selected 
server. 
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Step 5. Assess Results 

At the Apply step of the wizard, Veeam Backup & Replication will add the tape server to the backup 
infrastructure in the real time mode.  

If Veeam Backup & Replication detects an unknown media changer, the message will appear in the 
Message area. 
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Step 6. Finish Working with the Wizard 

At the Summary step of the wizard, finalize the procedure of the tape server configuration. 

1. Review details of the added tape server. 

2. To inventory tape libraries connected to the tape server, select the Start tape libraries 
inventory when I click Finish check box. Veeam Backup & Replication will start the inventory 
process when you finish working with the wizard. 

If you do not enable this option, you will have to inventory tape libraries manually. For more 
information, see Inventorying Tapes. 

 

Modifying Tape Servers 

To edit settings of an added tape server: 

1. Open the Tape Infrastructure view. 

2. Select the Servers node in the inventory pane. 

3. Select the necessary server in the working area and click Edit Tape Server on the ribbon. You 
can also right-click the necessary server in working area and select Properties. 

4. Then edit the tape server settings as required. 
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Rescanning Tape Servers 

In order to update the list of managed tape devices, Veeam Backup & Replication automatically 
rescans the tape servers every 3 minutes. You can perform manual rescan of a tape server, for 
example, if you want to implement the changes made to the tape infrastructure immediately. 

To rescan a tape server:  

1. Open the Tape Infrastructure view. 

2. To rescan all tape servers, right-click the Servers node and select Rescan. 

3. To rescan a particular tape server, select the Servers node in the inventory pane. Select the 
necessary server in the working area and click Rescan on the ribbon. You can also right-click 
the necessary server in working area and select Rescan. 

Updating Tape Servers 

Every time you launch Veeam Backup & Replication, it automatically checks if the components 
installed on managed servers are up to date. You will be unable to work with tape libraries that are 
connected to the outdated servers. 

If there is a later version of a component available (usually, if you have upgraded 
Veeam Backup & Replication), the Components Update window will be displayed, prompting you to 
update components on managed tape servers. 

You can also open the Components Update window by doing one of the following: 

 Open the main menu and select Upgrade from the main menu. 

 Open the Tape Infrastructure view, select the Servers node and click Upgrade on the 
ribbon. 

 Open the Tape Infrastructure view, right-click the necessary tape server in the working area 
and select Upgrade. 

If components on all managed servers are up to date, the Upgrade item will be disabled. 

The Components Update section lists tape servers that have outdated components deployed. To see 
the current and the latest available versions for deployed components, select a server in the list and 
click Details. Select check boxes next to servers for which you want to upgrade components and click 
Next. 



 

1025   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

 

Removing Tape Server 

To remove a tape server: 

1. Open the Tape Infrastructure view. 

2. Select the Servers node in the inventory pane. 

3. Select the tape server in the working area and click Remove Tape Server on the ribbon. You 
can also right-click the necessary tape server in the working area and select Remove. 

When you remove a tape server, Veeam Backup & Replication unassigns the tape server role from it, so 
it is no longer used as a tape server. The actual server remains connected to 
Veeam Backup & Replication. 

Important! 

 

You cannot remove a tape server if any of tape jobs is running at the moment. Before you remove 
the tape server, stop all tape jobs. 
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Working with Media Pools 
All tape media are divided into media pools — logical groups of tapes. There are two types of media 
pools in Veeam Backup & Replication: predefined media pools and custom media pools. 

Predefined media pools are Free, Unrecognized, Imported and Retired service pools created by 
Veeam Backup & Replication. They cannot be modified or removed. 

Custom media pools serve as targets for backup to tape and files to tape jobs. They provide tapes for 
writing new data and organize storing of the archived data according to the rules configured for them. 

To be able to configure backup to tape and files to tape jobs, you need to first create custom media 
pools. 

Creating Custom Media Pools 

To create a custom media pool, use the New Media Pool wizard. This section will guide you through 
all steps of the wizard and provide explanation on available options. 

Step 1. Launch the New Media Pool Wizard 

To run the New Media Pool wizard, do either of the following: 

 Open the Tape Infrastructure view and click Add Media Pool on the ribbon. 

 Open the Tape Infrastructure view, right-click the Media Pools node and choose Add 
Media Pool. 

Tip: 

 

You can also launch the New Media Pool wizard when configuring tape jobs (that is, directly from 
the New Backup To Tape Job wizard and New File To Tape Job wizard. For more details, see 
Creating Backup to Tape Jobs and Creating File to Tape Jobs. 

  



 

1027   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Step 2. Specify Media Pool Name 

At the Name step of the wizard, define basic description for the new media pool.  

1. In the Name field, enter a name for the created media pool. 

2. In the Description field, enter a description of the new media pool. The default description 
contains information about the user who created the media pool, date and time when the 
media pool was created. 

 

Step 3. Add Tapes to Media Pool 

At the Tapes step of the wizard, you can configure global media pool settings and allocate tapes for 
the pool. 

1. In the Tape library field, select the library from which the tapes will be allocated for the 
media pool. The list contains the tape libraries managed by this Veeam backup server. This 
field is disabled if multiple libraries are managed by this media pool. 

2. To add multiple libraries to the media pool, click Manage. In the Manage Libraries window, 
click Add and select libraries that you want to add. Use Up and Down buttons to position the 
libraries in order they must fail over. The first library will be the primary. You can select any 
tape devices that are managed by this Veeam backup server even if they are connected to 
different tape servers. 

Select the events on which the media pool must fail over to the next library: 

 Library is offline. 

 No media available. 

 All tape drives are busy. 

Note: 

 

To enable failover, ensure the following: 

 Select at least one failover event. 
 Add two or more tape libraries to failover list. 
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3. To allocate specific tapes from the library, click the Add in the Tapes field and select tapes 
that should be added to the media pool. Allocated tapes will be reserved for the created 
media pool; other custom media pools will not be able to use these tapes. The capacity and 
free space on the allocated tapes will be displayed in the bottom right corner. 

4. To make the media pool replenishable, select the Add tapes from Free media pool 
automatically when more tapes are required check box.  

With this option enabled, additional tapes will be allocated from the Free media pool when 
needed. That is, when a backup to tape or files to tape job uses all available tapes from this 
media pool, Veeam Backup & Replication will automatically add the required number of tapes 
from the Free media pool to let the job complete. If the option is disabled, the job will pause 
and prompt the backup administrator to add new tapes to the media pool. 
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Step 4. Specify Media Set Options 

For each media pool, specify how new media sets are created. A media set is consequent data stream 
that can span several tapes (for example, a weekly backup stored on tapes). At the Media Set step of 
the wizard, specify how this data stream will be organized.  

1. In the Media set name field, define the pattern according to which created media set(s) will 
be named. The default variables are #%id% (the number of the media set) and %date% (the 
date of creation of the media set).  

You can additionally use the following variables:  

 %time% — the time of creation of the media set 

 %day% — the day in month on which the media set is created 

 %dayofweek% — the day of week on which the media set is created 

 %month% — the month of creation of the media set 

 %year% — the year of creation of the media set 

 %job% — the name of job for which the media set is created 

2. In the Automatically create new media set section, specify conditions for creating new 
media sets on tapes allocated to the media pool. The following options are available: 

 Do not create, always continue using current media set. If this option is 
selected, each subsequent backup session will write its backup set to the 
existing media set: it will append backup content to the content that was 
written to tape with a previous backup session. If, however, a backup set is 
started with a new tape, Veeam Backup & Replication will create a new media 
set for it. 

 Create new media set for every backup session. If this option is selected, a 
new media set will be created for each new backup session. Each backup 
session will write its backup set starting with a new tape. 

 Daily at. If this option is selected, you can specify day and time when new 
media sets should be created. For example, if at the end of the week you send 
weekly media sets to offsite storage, you can schedule creation of new media 
sets at the beginning of each week. 
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Step 5. Specify Retention Settings 

At the Retention step of the wizard, specify overwrite rules for cases when all tapes allocated to the 
media pool are full (and there are no more free tapes available). You can select one of the following 
options: 

• Do not protect data (cyclically overwrite tapes as required). If this option is selected, tapes 
allocated to the pool will be overwritten, starting with the tape that stores the oldest archive.  

• Protect data for (time interval). If this option is selected, archives on tapes will be preserved 
for the specified period. When this period is over, data will be overwritten, starting with the 
tape that stores the oldest archive. This setting must accord with the retention policy 
specified for the backup chain that you plan to archive to tape. For details, see Data 
Retention. 

• Never overwrite data. If this option is selected, data on tapes will not be overwritten. If there 
is not enough tape capacity for the archiving job to complete, Veeam Backup & Replication 
will pause the job and prompt the backup administrator to add new tapes to the media pool. 

Note: 

 

You cannot set the retention period if you have configured the media set to Do not create, always 
continue using current media set option. Tapes written in such media sets are never overwritten. 

In the Offline media tracking section, you can set automatic moving tapes to a media vault when 
they are brought offline. To enable this option: 

1. Select Move all offline tapes from this media pool into the following media vault check 
box. 

2. From the Vault list, select the media vault where you want to automatically move the tapes.  

If the vault is not added yet, click Add New to open the New Media Vault wizard. 
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Step 6. Add Optional Media Pool Settings 

At the Options step of the wizard, you can enable parallel processing and encryption. 

1. Select the Enable parallel processing for jobs using this media pool check box if you want 
to process multiple tape jobs simultaneously. Set the maximum number of drives that the 
media pool can use in parallel. 

If your source repository is set to per-VM backup files, you can process multiple source VM 
backup chains within the tape job simultaneously. Select the Enable parallel processing of 
backup chains within a single job check box to split the source VM chains across multiple 
drives. 

2. To enable encryption, select the Use encryption check box. This option allows you to encrypt 
the content of files or backups archived to tapes in the media pool. 

From the Password field, select a password you want to use to encrypt backups or files 
archived to tape. You can also click Add or use the Manage passwords link to add a 
password. For more information, see Tape Jobs Encryption. 

If you select an encrypted backup job as a source for the backup to tape job and enable 
encryption in the properties of the media pool, the content of the resulting backup file 
archived to tape will be encrypted twice. To decrypt such backup file, you will need to specify 
two passwords: 

 Password for the backup to tape job  

 Password for the initial backup job  
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Step 7. Finish Working with the Wizard 

Review the media pool settings and click Finish to complete the wizard.  

A new media pool will be available under the Tape Infrastructure > Media Pools node in the Tape 
Infrastructure view. 
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Creating GFS Media Pools 

To create a GFS media pool, use the New GFS Media Pool wizard. This section will guide you through 
all steps of the wizard and provide explanation on available options. 

Step 1. Launch the New GFS Media Pool Wizard 

To run the New GFS Media Pool wizard, do either of the following:  

• Open the Tape Infrastructure view and click Add GFS Media Pool on the ribbon.  

• Open the Tape Infrastructure view, right-click the Media Pools node and choose Add GFS 
Media Pool. 

Tip: 

 

You can also launch the New GFS Media Pool wizard when configuring backup to tape jobs (that is, 
directly from the New Backup To Tape Job wizard. For details, see Creating Backup to Tape Jobs. 

Step 2. Specify Media Pool Name 

At the Name step of the wizard, define basic description for the new GFS media pool.  

1. In the Name field, enter a name for the created media pool. 

2. In the Description field, enter a description of the new media pool. The default description 
contains information about the user who created the media pool, date and time when the 
media pool was created. 
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Step 3. Add Tapes to Media Pool 

At the Tapes step of the wizard, you can select tape libraries and allocate tapes for the pool. 

1. In the Tape library field, select the library from which the tapes will be allocated for the media 
pool. The list contains the tape libraries managed by this Veeam backup server. This field is 
disabled if multiple libraries are managed by this media pool. 

2. To add multiple libraries to the media pool, click Manage. In the Manage Libraries window, 
click Add and select libraries that you want to add to the media pool. Use Up and Down 
buttons to position the libraries in order they must fail over. The first library will be the 
primary. You can select any tape devices that are managed by this Veeam backup server even 
if they are connected to different tape servers. 

Select the events on which the media pool must fail over to the next library: 

 Library is offline. 

 No media available. 

 All tape drives are busy. 

Note: 

 

To enable failover, ensure the following: 

 Select at least one failover event. 
 Add two or more tape libraries to failover list. 

 

3. To allocate specific tapes from the library, click the Add in the Tapes field and select tapes 
that should be added to the media pool. Allocated tapes will be reserved for the created 
media pool; other custom media pools will not be able to use these tapes. The capacity and 
free space on the allocated tapes will be displayed in the bottom right corner. 

4. To make the media pool replenishable, select the Add tapes from Free media pool 
automatically when more tapes are required check box. 

With this option enabled, additional tapes will be allocated from the Free media pool when 
needed. That is, when a backup to tape or files to tape job uses all available tapes from this 
media pool, Veeam Backup & Replication will automatically add the required number of tapes 
from the Free media pool to let the job complete. If the option is disabled, the job will pause 
and prompt the backup administrator to add new tapes to the media pool. 
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Step 4. Specify Media Set Options 

In the GFS media pool, a separate media set is created for each backup cycle: weekly, monthly, 
quarterly and yearly.  

For each media set, you can set the data retention period. The retention period indicates for how long 
the data is protected from overwriting. 

Note: 

 

If you want to disable any media set(s), set their retention period to 0 (zero). No backups will be 
stored to the media set with zero retention period. 

Click Advanced to configure the advanced media set options. 
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Step 5. Specify Advanced Media Set Options 

You can granularly configure rules for each media set. 

At the GFS Media Set step of the wizard, click Advanced. Select the Weekly tab to configure the 
weekly media set. 

1. In the Weekly media set field, you can allocate tapes to this media set. To a media set, you 
can allocate only tapes that are added to the media pool. Note that if you select to add 
particular tapes to a media set, you cannot configure automatic replenishment: the media set 
will always span the added tapes. 

Click Add and select tapes that should be added to the media set. 

2. In the Media set suffix field, define the pattern according to which created media set will be 
named. 

3. Select the Add tapes from media pool automatically check box to allow the media set to 
take a tape from the media pool when required. 

4. Select Append backup files to incomplete tapes if you want to write the next backup set to 
the tape where the previous backup set was written. Otherwise, Veeam will use a new tape 
for each backup set. 

5. You can set automatic moving tapes to a media vault when they are brought offline. To 
enable this option: 

• Select Move all offline tapes from this media pool into the following media 
vault check box. 

• From the list of vaults, select the media vault where you want to automatically 
move the tapes. 

• If the vault is not added yet, click Add New to open the New Media Vault wizard. 

The monthly, quarterly and yearly backup cycles use the same settings as the weekly backup cycle. 
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Step 6. Add Optional Media Pool Settings 

At the Options step of the wizard, you can enable encryption. 

Select the Use encryption check box. This option allows you to encrypt the content of files or backups 
archived to tapes in the media pool. 

From the Password field, select a password you want to use to encrypt backups or files archived to 
tape. You can also click Add or use the Manage passwords link to add a password. For more 
information, see Tape Jobs Encryption. 

If you select an encrypted backup job as a source for the backup to tape job and enable encryption in 
the properties of the media pool, the content of the backup file on tape will be encrypted twice. To 
decrypt such backup file, you will need to specify two passwords:  

• Password for the backup to tape job  

• Password for the initial backup job 
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Step 7. Finish Working with the Wizard 

Review the media pool settings and click Finish to complete the wizard. 

A new media pool will be available under the Tape Infrastructure > Media Pools node in the Tape 
Infrastructure view. 
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Modifying Media Pools 

If necessary, you can modify settings of a media pool. Note that you can only change custom media 
pools; predefined media pools cannot be modified. 

To modify media pool settings: 

1. Open the Tape Infrastructure view. 

2. Right-click the necessary media pool and choose Properties. Alternatively, select a media 
pool and click Edit Media Pool on the ribbon. 

3. Go through the Edit Media Pool wizard to change the necessary settings. 

4. Apply changes. 

Removing Media Pools 

If you no longer need a media pool, you can remove it: 

1. Open the Tape Infrastructure view. 

2. Right-click the necessary media pool and choose Remove Media Pool from the shortcut 
menu. Alternatively, select a media pool and click Remove Media Pool on the ribbon. 

3. In the displayed dialog box, click OK to confirm deletion. 

When you delete a media pool, its tapes are moved to the Imported media pool. Note that unlike 
other move operations, the data is not erased. You can use the tapes in the Imported media pool for 
restore operations. 

Mind the following limitations: 

• You can only remove custom media pools; predefined media pools cannot be removed.  

• You cannot remove a media pool that is used in a backup to tape or files to tape job. To be 
able to remove such a pool, first point corresponding jobs to other custom media pools. 
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Working with Tape Libraries 
All tape libraries managed by Veeam Backup & Replication are shown as a list of devices under the 
Libraries node in the Tape Infrastructure view. All connected devices are discovered automatically 
during the rescan procedure. When you add a new tape device to the tape server, it appears in your 
console after rescan. 

To view properties of a tape library, open the Tape Infrastructure view, expand the Libraries node 
and select the needed library. Click Properties on the ribbon. You can also right-click the necessary 
library in the working area and select Properties. 

Select the Use native SCSI commands instead of Windows driver check box if your library is an 
unknown media changer. For more information about unknown media changers, see Supported 
Devices. 

 

Rescanning Tape Libraries 

You can rescan a selected to update its network status. 

To rescan a tape library: 

1. Open the Tape Infrastructure view. 

2. Select the Libraries node in the inventory pane. Select a necessary library in the working area 
and click Rescan Library on the ribbon. You can also right-click the necessary library in the 
working area and select Rescan. 

  



 

1041   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Renaming Tape Libraries 

The Veeam backup console shows the list of all tape devices as a list of libraries. By default, the 
connected libraries are shown with their production model names. For clearer visibility, you can 
rename them. 

To rename a tape library: 

1. Open the Tape Infrastructure view. 

2. Select the Libraries node in the inventory pane. Select a necessary library in the working area 
and click Rename Library on the ribbon. You can also right-click the necessary library in the 
working area and select Rename. 

Removing Tape Libraries 

If you want to stop using a tape device, you can remove it from your Veeam backup console. 

Mind the following limitations: 

 Only the libraries in the offline status can be removed. To remove a tape library, you need to 
physically disconnect it from the tape server first. Otherwise, the tape library will be 
discovered during the next rescan and reappear in the Libraries list. Alternatively, you can 
remove the tape server to which the tape library is connected. 

 You cannot remove the library that is used in a media pool. Remove the library from all media 
pools first. 

To remove a tape library: 

1. Disconnect the tape library or the tape server. 

2. Open the Tape Infrastructure view. 

3. Select the Libraries node in the inventory pane. Select a necessary library in the working area 
and click Remove Library on the ribbon. You can also right-click the necessary library in the 
working area and select Remove Library. 

4. In the displayed dialog box, click OK to confirm deletion. 

Tip: 

 

If you remove the tape server, the tape devices remain connected to it. You can connect the tape 
server back to your console. In this case, Veeam Backup & Replication will recognize all tape devices 
that were previously added to it with tapes and media pools (in case they remain in the Veeam 
database). 

You can also connect the tape server to another Veeam backup server. Veeam Backup & Replication 
will recognize the tape devices automatically, however you will need to create the media pools 
anew. 
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Working with Drives 
Drives of each connected library or standalone tape device are displayed in the Tape Infrastructure 
view under the Libraries > LibraryName node > Drives. 

To view the drives properties, select Drives under the needed library. View the list and a short 
description of the drives in the working area. To view detailed information on a drive or to change its 
settings, click Properties on the ribbon. You can also right-click the necessary drive in the working 
area and select Properties. 

To set block size for the drive manually, select a value from the Block size list in the drive properties. 

 Note: 

 

Veeam Backup & Replication uses uniform block size. Drive that is set manually to a particular block 
size may fail to read tape that was written with another block size. For more information on tape 
block size, see Supported Devices and Configuration. 

To disable a drive, clear the Enabled option in the drive properties. To set the drive into working 
mode again, select the Enable option. You can disable a drive, for example, for maintenance. When 
you disable a drive, the library does not use this drive for read/write operations. If the library has 
multiple drives, other drives will be used for the read/write operations. 
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Working with Tapes 
All tapes managed by Veeam Backup & Replication belong to one of media pools. Generally, the new 
tapes are in the Free media pool. Tapes that were written in some custom media pools stay tied to 
their media pools. 

If you offload tapes from you tape device, their status changes to Offline, but they stay visible in the 
console. 

Tape media in Veeam Backup & Replication are displayed in the Tape Infrastructure view, either 
under the Media Pools or under the Libraries > LibraryName node > Media > Online/Offline. You 
can work with both online and offline tapes:  

 Tapes that are currently loaded to the tape device are available under the Online node. 

 Tapes that have been unloaded from the tape device are shown under the Offline node. 

 

All tapes are grouped to predefined and custom media pools available under the Tape Infrastructure 
> Media Pools node.  
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Veeam Backup & Replication can use only online tapes for backup to tape and files to tape jobs.  
If you work with a standalone tape drive and all its tapes are offline, Veeam Backup & Replication will 
display a message informing that you need to insert a tape into the drive. At the same time, 
Veeam Backup & Replication will hint what tape has been recently used for archiving.  
You can insert any tape into the tape drive: 

 If the tape you have inserted is registered in the Veeam backup database and the current 
media set can still be used, Veeam Backup & Replication will continue writing to this media 
set and append the new content to the content recently written on the tape.  

 If the tape you have inserted is not registered in the Veeam backup database, it will be 
processed as follows: 

– A new empty tape will be placed to the Free media pool and used for writing data. 

– A tape containing any data written on another Veeam backup server or with 
another tape backup solution will be placed to the Unrecognized media pool. You 
need to perform catalogization for such tapes. 

Importing Tapes 

When you need to load free tapes, or if you need to restore data from tapes, you need to load these 
tapes into your tape device and import them. Importing is recognizing tapes that are loaded into your 
tape device. 

When you load tapes into the mail slot, they are not visible in the Veeam backup console. To start 
using tapes, you need to introduce them to the Veeam Backup & Replication by running the importing 
procedure. The importing procedure conveys the tapes from the mail slot to the library working slots, 
scans them and sends information about them to Veeam backup database. After importing, 
Veeam Backup & Replication can use the tapes to read or write data. 

Importing must be performed manually each time you load tapes into your tape device. 

To import a tape: 

1. Open the Tape Infrastructure view. 

2. Select the tape library node under the Libraries node and click Import Tapes on the ribbon.  
Alternatively, you can right-click the tape library node and select Import Tapes from the 
shortcut menu. 

Importing runs differently for tapes that are registered in the local Veeam backup database and those 
that are not. Choose an appropriate procedure for the following tapes: 

 Importing empty tapes 

 Importing tapes written on this backup server 

 Importing tapes written on another Veeam server 
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Importing Empty Tapes 

To import new tapes, follow the next steps: 

1. Insert the tapes into the tape device.  

2. Open the Tape Infrastructure view, expand the Libraries node and select the library to 
which you have loaded the tapes. Click Import Tapes on the ribbon. You can also right-click 
the necessary library in the working area and select Import Tapes. 

3. The tapes will appear in the Unrecognized media pool. 

4. Right-click the tapes and select Inventory tape. 

5. The tapes will be moved to the Free media pool. 

Tapes can be used for automatic or manual replenishment of custom media pools. They can be further 
used to replenish custom media pools: 

 Automatically, if the media pools are configured for automatic replenishment. 

 Manually by moving tapes from the Free media pool to particular custom media pools. 

If you want to refill the free tape resources in your tape device, you can overwrite tapes containing 
outdated Veeam archives. For more information, see Importing Tapes Written on This Backup Server. 

Tip: 

 

To understand which of the tapes can be overwritten, you can check their expiration date. In the 
Tape Infrastructure view, open the Media Pools node and select the media pool that you want to 
replenish. Check the Expires in field in theworking area. You can sort the tapes by the expiration 
date and get the list of tapes that can be reused. 

Importing Tapes Written on This Backup Server 

 If the tapes that you want to import were written on the same Veeam backup server, the Veeam 
backup database has information about them. 

 When you import tapes written on a tape library with a barcode reader and information 
about these tapes is available in the Veeam Backup & Replication database, 
Veeam Backup & Replication immediately recognizes these tapes after importing. You will be 
able to view data written to these tapes and run restore procedures. 

 When you import tapes written on a tape library without a barcode reader, you need to 
additionally inventory these tapes to be able to work with them. 
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To import tapes without barcode labels: 

1. Insert the tapes into the tape device. 

2. Open the Tape Infrastructure view, expand the Libraries node and select the library to 
which you have loaded the tapes. Click Import Tapes on the ribbon. You can also right-click 
the necessary library in the working area and select Import Tapes. 

3. The tapes will appear in the Unrecognized media pool. 

4. Right-click the tapes you need and select Inventory Tape. 

5. The tapes will be moved to the media pools in which they were originally written.  

You can view the data written on these tapes and run restore procedures. 

Note that if the tapes have expired, they will be overwritten by tape rotation scheme set for this media 
pool. 

Importing Tapes Written on Another Veeam Server 

Veeam Backup & Replication supports restoring data from tapes that were recorded on another 
Veeam backup server. To read data from such tapes, Veeam Backup & Replication must first scan the 
tapes and store the information about them to the Veeam backup database. 

To import tapes, follow the next steps: 

1. Insert the tapes into the tape device. 

2. Open the Tape Infrastructure view, expand the Libraries node and select the library to 
which you have loaded the tapes. Click Import Tapes on the ribbon. You can also right-click 
the necessary library in the working area and select Import Tapes. 

3. The tapes will appear in the Unrecognized media pool. 

4. Right-click the tapes you want to import and select Catalog Tape. 

5. The tapes will be moved to the Imported media pool. The Imported media pool will be 
created automatically. When the tapes are imported, you can view and restore data written to 
them. 
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Inventorying Tapes 

When you load new tapes in your tape device for the first time, these tapes are presented to 
Veeam Backup & Replication as Unrecognized. To identify unrecognized tapes, you need to run tape 
inventory job against them. 

Tape inventory job is a relatively fast process of reading metadata written on tape with the aim of 
detecting name of the media set and the sequence number for the tape. Tape inventory jobs helps 
Veeam Backup & Replication identify empty tapes and detect non-empty tapes belonging to specific 
media set. 

You can perform tape inventory for a whole tape library or run the job against selected tapes only.  

To start tape inventory for a whole tape library: 

1. Open the Tape Infrastructure view. 

2. Expand the Libraries node and select the library you want to inventory.  

3. Click Inventory Library on the ribbon. Alternatively, you can right-click the tape library and 
select Inventory Library from the shortcut menu. Veeam Backup & Replication will perform 
inventory for all online tapes in the library. 

To start tape inventory for selected tapes:  

1. Open the Tape Infrastructure view. 

2. Navigate to the list of tapes either under the Media Pools or under the Libraries > 
LibraryName node > Media. 

3. Select the necessary tapes in the list and click Inventory on the ribbon. Alternatively, you can 
right-click the selected tapes and choose Inventory Tape. 

The inventory log will display job session results. To access the inventory session details, you can open 
the History view and locate the necessary session under the Jobs > Tape node. 
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As a result of inventory, Veeam Backup & Replication places tapes in predefined pools: 

 Empty tapes are moved to the Free pool. You can use these tapes for archiving backups and 
files 

 Tapes that contain data written on another Veeam backup server remain in the 
Unrecognized pool. Veeam Backup & Replication displays the detected media set name and 
sequence number for these tapes. If you want to restore data from a specific media set, you 
need to run the tape catalog job for all tapes in this media set.  

After the tapes are inventoried, you can decide on further steps: for example, you can mark 
unrecognized tapes as free if you do not need archived content, or allocate tapes from the Free pool 
to a custom pool. 

Cataloging Tapes 

Cataloging tapes is required for tapes that contain some data but are not registered in the Veeam 
database. For example, cataloging is required for tapes that were written on another Veeam backup 
server. After the cataloging procedure, you can restore data from the tapes. 

When a catalog job is performed, Veeam Backup & Replication first performs tape inventory, reads the 
information about backup contents on tape from the on tape catalog information, scans tape 
contents and updates the database with details of new detected backup sets. 

You can perform tape catalog job for a whole tape library or for selected tapes.  

To catalog a whole tape library:  

1. Open the Tape Infrastructure view. 

2. Open the Tape Infrastructure view, expand the Libraries node and select the library you 
want to catalog. Click Catalog Library on the ribbon. Alternatively, you can right-click the 
tape library and select Catalog Library. 

To catalog selected tapes: 

1. Open the Tape Infrastructure view. 

2. Navigate to the list of tapes either under the Media Pools or under the Libraries > 
LibraryName node > Media. 

3. Select the necessary tapes in the list and click Catalog on the ribbon. Alternatively, you can 
right-click the selected tapes and choose Catalog Tape. 

The catalog log will display job session results. To access the catalog session details, you can open the 
History view and locate the necessary session under the Jobs > Tape node. 
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Rescanning of tapes during the catalog job may take a lot of time. To speed up the catalogization 
process, you might do one of the following: 

 First, run inventory job to identify tape media sets and decide which tapes should be 
included in catalogization process. Run the catalog job only against tapes in the necessary 
media set. 

 If you work with a tape library, you can run the catalog job against the whole media set at 
once. 

 If you work with a standalone drive, start catalogization from the last tape in the media set (as 
this tape usually stores on tape catalog information). 
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Viewing Tape Properties 

You can view properties of each tape registered in Veeam database. The tapes may be online or 
offline. The Properties window shows location, capacity, name and other properties of the selected 
tape. 

The capacity of the tape is identified by the tape device where the tape is located. You can also view 
the capacity of a tape in your tape device console (or in the Microsoft Windows Device Manager for 
tapes that are in drives). 

The name of the tape is generated automatically during tape importing. If your tape device supports 
barcodes, Veeam Backup & Replication will use the barcodes to identify the tapes and display the 
barcode as the Name property of the tape. If a tape does not have a barcode, 
Veeam Backup & Replication will automatically create the tape name using the pattern 'Tape N'.  

If necessary, you can change the name of a tape: 

1. Open the Tape Infrastructure view. 

2. Navigate to the list of tapes either under the Media Pools or under the Libraries > 
LibraryName node > Media > Online/Offline. 

3. Select the tape you want to rename and click Properties on the ribbon. Alternatively, you can 
right-click the tape and choose Properties. 

4. Change tape name and description as required. 

5. Click OK to save changes. 

Note: 

 

If you manage several tape libraries on the same Veeam backup server and use barcodes to identify 
tapes in these libraries, make sure that all barcodes are unique. If some tapes have identical 
barcodes, Veeam Backup & Replication may fail to manage them correctly. 
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Viewing Data on Tapes 

To view data contents that is currently stored on tape: 

1. Open the Tape Infrastructure view. 

2. Navigate to the list of tapes either under the Media Pools or under the Libraries > 
LibraryName node > Media > Online. 

3. Select the necessary tape and click Properties on the ribbon. Alternatively, you can right-click 
the tape and choose Properties. 

4. Open the Files tab.  

 

Removing Tapes from Catalog 

If you do not want to store information about a tape and contents on this tape in 
Veeam Backup & Replication database, you can remove the tape from the catalog. Removing from 
catalog can be performed for offline tapes. For example, you can perform removal from catalog if a 
physical tape no longer exists, and the tape should no longer be displayed among media in the 
Veeam Backup & Replication console.  

You can remove only tapes that are offline.  

To remove one or more tapes from the catalog: 

1. Open the Tape Infrastructure view. 

2. Navigate to the list of tapes either under the Media Pools or under the Libraries > 
LibraryName node > Media > Offline. 

3. Select offline tapes you want to remove from the catalog and click Remove from Catalog on 
the ribbon. Alternatively, you can right-click selected tapes and choose Remove from 
Catalog from the shortcut menu. 

4. In the opened dialog box, click Yes to confirm removal. 
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Important! 

 

You cannot remove protected tapes from the catalog. To remove such tapes, you need to switch the 
protection off first. 

Moving Tapes to a Custom Media Pool 

Veeam Backup & Replication allows you to move tapes between custom pools. You can also move 
tapes from any pool to the Free media pool. 

Important! 

 

When you move a tape to any media pool, Veeam Backup & Replication marks this tape as free. 

To move tapes from one custom media pool to another: 

1. Open the Tape Infrastructure view. 

2. Navigate to the list of tapes either under the Media Pools or under the Libraries > 
LibraryName node > Media > Online. 

3. Select tapes you want to move and click Move to on the ribbon. Choose the target media 
pool from the list.  
Alternatively, you can right-click selected tapes and choose Move to Media Pool. Next, 
choose the target media pool from the list. 

Note: 

 

You cannot move tapes that are protected. To move such tapes, you need to switch the protection 
off first. 

Erasing Tapes 

If you do not need contents stored on tape, you can erase tapes. Veeam Backup & Replication 
supports two options for erasing data: 

 Short erase (fast) — use this option to speed up the erase process. The short erase operation 
does not physically erase data written on the tape. It simply loads the tape to the drive and 
wipes the tape header. Note that short erase is not supported by some tape devices. 

 Long erase (slow) – use this option to clear all data written to tape. The long erase operation 
loads the tape to the drive, rewinds the tape and physically erases all data written to the tape. 

To erase tapes: 

1. Open the Tape Infrastructure view. 

2. Navigate to the list of tapes either under the Media Pools or under the Libraries > 
LibraryName node > Media > Online. 

3. Select tapes you want to erase and click Erase on the ribbon. Choose the type of erase and 
click OK.  
Alternatively, you can right-click selected tapes and choose Erase Tape. Next, choose how 
the tape should be erased and click OK. 

Important! 

 

You cannot erase protected tapes. To erase such tapes, you need to switch the protection off first. 
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Marking Tapes as Free 

Instead of erasing tapes, you can mark tapes as free. During this operation, 
Veeam Backup & Replication deletes from backup and tape catalogs information about backup 
contents stored on tape. Data written to tape remains intact. 

To mark tapes as free: 

1. Open the Tape Infrastructure view. 

2. Navigate to the list of tapes either under the Media Pools or under the Libraries > 
LibraryName node > Media > Online. 

3. Select tapes you want to mark as free and click Mark as Free on the ribbon. 
Alternatively, you can right-click selected tapes and choose Mark as Free from the shortcut 
menu. 

4. In the displayed dialog box, click Yes. 

After a tape is marked as free, Veeam Backup & Replication removes from the catalog information 
about contents on this tape.  

Important! 

 

You cannot mark protected tapes as free. To mark such tapes as free, you need to switch the 
protection off first. 

Protecting Tapes 

If you have a number of tapes for which you need to change the retention to 'never overwrite', you 
can protect them. Protection option sets lifelong retention period for the selected tapes overriding 
the retention settings of the media pool. 

You can set protection for both online or offline tapes that contain data. 

If the tapes are protected, they cannot be erased or marked as free by Veeam Backup & Replication or 
manually. To erase such tape, you need to switch the protection off first. 

The protection can be switched off at any time. The retention settings will be changed to the value set 
for the media pool. 

To enable protection: 

1. Open the Tape Infrastructure view. 

2. Navigate to the list of tapes either under the Media Pools or under the Libraries > 
LibraryName node > Media > Online. 

3. Select tapes you want to protect and click Protect on the ribbon. 
Alternatively, you can right-click selected tapes and choose Protect from the shortcut menu. 

Important! 

 

You cannot protect free tapes, that is, tapes that do not have any data written on them. 
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Ejecting Tapes 

Ejecting moves the tape that is currently in drive to a library slot. The tape stays in the library and is 
online. Ejecting prevents tapes, for example, from being occasionally overwritten. 

You can select a tape to eject, or select a drive and eject the tape from it. Eject command is enabled 
only for tapes that are in drives or for drives with loaded tapes.  

To eject a tape from a drive: 

1. Open the Tape Infrastructure view. 

2. Navigate to the list of tapes either under the Media Pools or under the Libraries > 
LibraryName node > Media > Online. 

3. Select a tape located in drive that you want to eject and click Eject on the ribbon. 
Alternatively, you can right-click selected tape and choose Eject Tape. 

To eject a tape from a drive: 

1. Open the Tape Infrastructure view. 

2. Navigate to the Libraries > LibraryName node > Drives. 

3. Select a drive from where you want to eject the tape and click Eject Tape on the ribbon. 
Alternatively, you can right-click selected tape and choose Eject. 

Tip: 

 

You can also instruct a tape job to eject tape from drive after the job completes. To do so, navigate to 
the Options step of backup to tape job or file to tape job and select the Eject media once the job 
finishes check box. 

Exporting Tapes 

If you want to offload tapes, you need to export them first. Exporting moves the tape from the 
standard slot in the tape library to the I/E slot (or Mail slot). When they are in the I/E slot, you can take 
them from the library and, for example, carry to a storing location. 

To export a tape to an I/E slot: 

1. Open the Tape Infrastructure view. 

2. Navigate to the list of tapes either under the Media Pools or under the Libraries > 
LibraryName node > Media > Online. 

3. Select a tape you want to export and click Export on the ribbon. 
Alternatively, you can right-click selected tape and choose Export Tape from the shortcut 
menu. 

Note: 

 

Export is available only for the devices that support corresponding operations and include I/E slot. 
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Tapes Availability and Write-Protection 

Before archiving data to tape media, Veeam Backup & Replication detects available tapes in the target 
media pool. Unavailable tapes are filtered out and are not used for writing data. A tape may be 
unavailable for one of the following reasons: 

 The tape cannot be used according to the retention policy set for the media pool. 

 The tape is offline. 

 The tape has the write-protect switch set. 

If your tape is write-protected and you want to write data to this tape, you must eject the tape from 
the drive and drag the write protection switch off. After you insert the tape back to the drive, you must 
inventory the tape to mark it as writable in the Veeam Backup & Replication database. 
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Working with Vaults 
Tape vaults are logical locations storing information about tapes that have been moved offline. You 
can use vaults to facilitate managing tapes that are offline. 

Vaults store information about original location of tapes, such as library and media pool, data written 
to tapes and retention terms for it. 

Vaults are not limited to any original location of tapes: you can place tapes from different libraries and 
media pools to one media vault. 

To start working with vaults, you need to create one or more of them. Vaults are usually created to 
store information about tapes that are transported offsite, and you can indicate the name of the 
remote site in the vault properties. 

Vaults are virtual container, and do not require any physical resources. 

Note: 

 

You can work with tape vaults if Veeam Backup & Replication Enterprise license or higher is installed 
on the Veeam backup server. 
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Creating Media Vaults 

Created media vaults are shown under the Vaults node. If you have no vaults created, the Vaults 
node will not be shown. 

To create a new media vault, use the New Media Vault wizard. This section will guide you through all 
steps of the wizard and provide explanation on available options. 

To add a media vault, follow the next steps: 

Step 1. Launch the New Media Vault Wizard 

To run the New Media Vault wizard, do either of the following: 

 Open the Tape Infrastructure view and select the Tape Infrastructure node. Click Add 
Media Vault on the ribbon. 

 Open the Tape Infrastructure view, right-click the Tape Infrastructure node and choose 
Add Media Vault. 

Tip: 

 

You can also launch the New Media Vault wizard when configuring media pools (that is, directly 
from the New Media Pool or New GFS Media Pool wizard. For more details, see Creating Custom 
Media Pools or Creating GFS Media Pools. 

Step 2. Specify Media Vault Name 

At the Name step of the wizard, you should define basic description for the new media vault.  

1. In the Name field, enter a name for the created media vault.  

2. In the Description field, enter a description of the new media vault. The default description 
contains information about the user who created the media pool, date and time when the 
media pool was created. 

3. If you want to set overwrite protection ta all tapes in this media vault, select the Protect all 
tapes moved to this media vault automatically check box. For more information, see Tape 
Protection. 
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Step 3. Finish Working with the Wizard 

Review the media vault settings and click Finish to complete the wizard. 
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Modifying Media Vaults 

To modify media vault settings: 

1. Open the Tape Infrastructure view. 

2. Right-click the necessary media vault and choose Properties. Alternatively, select a media 
vault and click Edit Vault on the ribbon. 

3. Go through the Edit Media Vault wizard to change the necessary settings. 

4. Apply changes. 

Removing Media Vaults 

If you no longer need a media vault, you can remove it. Mind the following limitation: 

 You cannot remove a media vault that contains tapes. To be able to remove such vault, first 
move tapes from this vault to other media vaults or remove them from the vault. When you 
remove a tape from the vault, you can see it in its media pool or under Media > Offline node. 

 You cannot remove a media vault that has a reference to any media pool. To be able to 
remove such media vault, first edit settings of the corresponding media pool and remove a 
reference to this media vault. 

To remove a media vault: 

1. Open the Tape Infrastructure view. 

2. Select a media vault and click Remove Vault on the ribbon. Alternatively, you can right-click 
the necessary media vault in the working area and choose Remove Vault. 

3. In the displayed dialog box, click OK to confirm deletion. 
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Moving Tapes to Vault 

Recorded tapes can be moved to a vault. In the vault, you can view tape information, including data 
written to tape and data retention settings. 

If the tapes are placed to a vault, you can still view them under the Offline node or in the media pool.  

You can move the tapes manually or instruct the relevant media pool to place the tapes to a vault 
automatically. 

Moving Tapes to Vault Manually 

You can move only tapes that contain data and that are offline. To move the tapes manually: 

1. Open the Tape Infrastructure view and navigate to the list of tapes either under the Media 
Pools or under the Libraries > LibraryName node > Media > Offline. 

2. In the working area, right-click the tapes you want to move and select Move to Vault. Choose 
the vault you need. 

Automatic Vaulting for Custom Media Pools 

To set the automatic placing of tapes to a vault, you need to configure the media pool where the 
target tapes are recorded. To set the custom media pool configuration: 

1. Open the Tape Infrastructure view and select the Media Pools node. 

2. Select the media pool you want to customize. 

3. Click Edit Media Pool on the ribbon. Alternatively, you can right-click the media pool and 
select Properties. 

4. Go to the Retention step of the Edit Media Pool wizard: in the Offline media tracking field, 
select Move all offline tapes from this media pool into the following media vault. Select 
the needed vault from the drop-down list. 

Note that moving tapes to a vault automatically will not be available if you select Do not protect data 
(cyclically overwrite tapes as required) option as a data retention policy. 
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Tip: 

 

If you have not previously created a media vault, you can click the Add New button and create a new 
media vault without closing the job wizard. For more details, see Creating Media Vaults. 

Automatic Vaulting for GFS Media Pools 

Vaulting of GFS tapes is set for media sets individually. To change a media set configuration: 

1. Open the Tape Infrastructure view and select the Media Pools node. 

2. Select the GFS media pool you want to customize. 

3. Click Edit Media Pool on the ribbon. Alternatively, you can right-click the media pool and 
select Properties. 

4. Go to the GFS Media Set step of the Edit Media Pool wizard and click Advanced. Select a 
tab with the needed media set and select Move all offline tapes into the following media 
vault. Select the needed vault from the drop-down list. 

 

Tip: 

 

If you have not previously created a media vault, you can click the Add New button and create a new 
media vault without closing the job wizard. For more details, see Creating Media Vaults. 
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Managing Tapes in Vault 

When you have tapes placed to vaults, you can move them to another vault or remove from vault. 
When you remove tapes from a vault, they are still available in the Offline list or in their media pool. 

To move tapes to another vault: 

1. Open the Tape Infrastructure view and select the Vaults node. Select the vault where the 
needed tapes are stored.  

2. In the working area, right-click the tapes you want to move and select Move to Vault. Select 
the target vault. 

To remove tape from vault: 

1. Open the Tape Infrastructure view and select the Vaults node. Select the vault you need.  

2. In the working area, right-click the tapes you want to remove and select Remove from Vault.  

The tapes are removed from vault automatically in the following situations:  

 A tape comes online. It will re-appear in the vault when it goes offline if it was not erased or 
overwritten. 

 A tape is removed from catalog. 

 A tape is marked as free. 
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Creating Backup to Tape Jobs 
To archive backups to tape, you should create a backup to tape job using the New Backup To Tape 
Job wizard. This section will guide you through all steps of the wizard and provide explanation on 
available options. 

With this wizard, you can create a backup to tape job or a GFS job. 

To create a backup to tape job, follow the next steps: 

Before You Begin 

Before you configure a backup to tape job, complete the following prerequisites: 

 You must have Veeam Backup & Replication Enterprise license or higher is installed on the 
Veeam backup server. 

 You must pre-configure backup job(s) that produce the backup for archiving. 

 The source backup jobs must have at least 2 restore points on disk. 

 The source backup copy job must have at least 3 restore points on disk. 

 You must configure one or more custom media pool with the necessary media set and 
retention settings. 

 You must load tapes to the tape device and configure the target media pool so that it has 
access to them. If the media pool has no available tape, the tape job will wait for 72 hours and 
then terminate. 

Mind the following limitations: 

 The backup to tape job processes only VBK (full backups) and VIB files (forward incremental 
backups).  

 Reverse incremental backups (VRB) are skipped from processing. If you back up to tape a 
reverse incremental chain, the tape job will always copy the full backup. 

 Microsoft SQL Server log files (VLB) are skipped from processing. 

Step 1. Launch the New Backup To Tape Job Wizard 

To run the New Backup to Tape Job wizard, do either of the following: 

 On the Home tab, click Tape Job and select Backups. 

 Open the Backup & Replication view, right-click the Jobs node and select Tape Job > 
Backups to Tape. 
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Step 2. Specify Job Name and Description 

At the Name step of the wizard, you should define basic settings for the created backup to tape job. 

1. In the Name field, enter a name for the created job. 

2. In the Description field, enter a description of the created job. The default description 
contains information about the user who created the job, date and time when the job was 
created. 

 

Step 3. Choose Backups to Archive 

At the Backup Files step of the wizard, select backups that you want to archive to tape with the 
created job.  

Click Add and select the necessary backups. You can choose backups from the following sources: 

 Backup jobs. You can select backups from available backup jobs. When a backup to tape job 
is run, Veeam Backup & Replication will search and archive restore points from the backups 
created by the selected backup jobs. If you choose to link to a backup job, Veeam Backup & 
Replication will update the secondary target settings for the backup job.  
In the same backup to tape job, you can combine backup jobs for different platforms 
(VMware vSphere, vCloud Director, Microsoft Hyper-V and Endpoint) . 

 A backup copy job can be a source for the tape job as well. The tape job copies the full 
backup produced by the backup copy job once, and then only the new increments. Note that 
the tape job cannot process the last (active) increment until the next one is produced. 

 Backup repositories. Using this option, you can select whole backup repositories. When a 
backup to tape job is run, Veeam Backup & Replication will search and archive restore points 
from all backups stored in the chosen backup repositories. 

If you choose to archive data from backup repositories, the backup to tape job will process 
only the backups that were created with backup jobs configured on this Veeam backup 
server. Imported backups and configuration backups will be skipped from processing. 
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Tip: 

 

This step is optional. You can create a backup to tape job without source. You can add the source 
later, or you can link this job to a backup job. For more information, see Linking Backup Jobs to 
Backup to Tape Jobs. 

 

The total size of full backups added to the backup to tape job is displayed in the Full field. The total 
size of incremental backups added to the backup to tape job is displayed in the Incremental field. 

To remove a backup from the list, select it and click Remove on the right. 

Selecting Backup Chains to Archive 

On the first run, the tape job can copy all restore points or only the latest backup chain. This option is 
useful if the the source backup job or the source backup repository has several backup chains. The 
backup chain here means a full backup file plus a set of incremental backup files following it. 

To select what backup files you want to archive: 

1. Click Add and select Backup jobs or Backup repositories. 

2. Select the necessary backup job or repository you want to add to the tape job. 

3. Veeam Backup & Replication will display a warning informing about backup chain options. 
Click Latest to archive only the latest backup chain to tape. This options lets you have only 
the latest restore points written to tape and use less tape for data archiving. Click All to 
archive all available backup files. 
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This option selects what backup chain will be copied on the first run of the job. You can instruct the 
job to copy only the latest backup chain on every tape job run. This option is available in the advanced 
settings of the job. For more information, see Advanced Settings. 

 

Step 4. Choose Media Pool for Full Backups 

At the Full Backup step of the wizard, choose media pool for full backups and configure virtual full 
schedule for forever incremental backup chains. 

1. From the Media pool for full backups list, choose a media pool that will be used for 
archiving full backup files. You can select GFS media pool or non-GFS media pool. 

Tip: 

 

If you have not previously created a media pool with the required settings, you can click the Add 
New button and create a new media pool or a GFS media pool without closing the job wizard. For 
more details, see Creating Custom Media Pools or Creating GFS Media Pools. 
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2. You can configure schedule for virtual full backup. This option is available only for non-GFS 
media pools.  

If the source job produces a forever incremental backup chain or is a backup copy job, 
Veeam Backup & Replication will periodically create a virtual full backup. You can configure 
the full backup schedule at this step of the wizard. The virtual full cannot be switched off; 
however, it is disabled automatically if the source job periodically creates active full or 
synthetic full backups. 

The virtual full does not depend on the job settings for incremental backups. If you enable 
the virtual full for the job, it will be created in any case, no matter whether you enable or do 
not enable incremental backups. 

To configure virtual full schedule, click Schedule and select the necessary scheduling options. 
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Step 5. Choose Media Pool for Incremental Backups 

This step is available only if you selected a non-GFS media pool as target for full backups. 

At the Incremental Backup step of the wizard, enable or disable incremental backups processing and 
choose media pool that will be used for archiving incremental backups. This step is available only for 
simple (non-GFS) media pools. 

If you want the job to copy the incremental backups, select the Archive incremental backups to 
tape check box. If this option is disabled, the backup to tape job will archive only VBK files and will 
skip VIB files from processing. 

From the Media pool for incremental backups list, choose a media pool that will be used for 
archiving incremental backup files. 

Veeam Backup & Replication allows you to choose different media pools for full backups and 
incremental backups. This can be required if you use different media set or retention settings for 
archiving full backups and increments. 

Tip: 

 

If you have not previously created a media pool with the required settings, you can click the Add 
New button and create a new media pool without closing the job wizard. For more details, see 
Creating Custom Media Pools. 
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Step 6. Specify Archiving Options 

At the Options step of the wizard, specify archiving and media automation options. The options are 
different for GFS and non-GFS tape jobs: 

 Options for Backup to Tape Job 

 Options for GFS Job 

Options for Backup to Tape Job 

This step of the wizard is available if you selected a simple media pool at the Full Backup step of the 
wizard. 

1. Select the Eject media upon job completion check box if the tape should be automatically 
ejected from the tape drive and placed into a slot when the job finishes. 

This option does not prevent the tape job from appending data to this tape. If not configured 
otherwise in media pool settings, this tape will be placed into a drive on the next tape job 
run. 

2. Select the Export current media set upon job completion check box if the tapes belonging 
to the media set should be placed to Import/Export (Mail) slot for further export (for example, 
for export to a remote office). If you want to export tapes on specific days only (for example, 
every Saturday, when a backup to tape job completes), click Days and schedule export on the 
necessary days. 

Click Advanced to configure the advanced job options. 
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Options for GFS Job 

This step of the wizard is available if you selected a GFS media pool at the Full Backup step of the 
wizard. 

1. Select the Eject media upon job completion check box the tape should be automatically 
ejected from the tape drive and placed into a slot when the job finishes. 

This option does not prevent the tape job from appending data to this tape. If not configured 
otherwise in media pool settings, this tape will be placed into a drive on the next tape job 
run. 

2. Select the Export the following media sets upon job completion check box if you want to 
export certain media sets (for example, to a remote office). The tapes belonging to the 
selected media sets will be placed to Import/Export (Mail) slot after the media set is complete. 

Click Media sets and select the media sets that you want to export. 

Click Advanced to configure the advanced job options. 
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Step 7. Specify Advanced Job Settings 

You can specify the following advanced settings for the backup to tape job: 

 Notifications Settings  

 Advanced Settings 

Tip: 

 

After you specify necessary settings for the backup to tape job, you can save them as default 
settings. To do this, click Save as Default at the bottom left corner of the Advanced Settings 
window. When you create a new backup to tape job, Veeam Backup & Replication will automatically 
apply default settings to the new job.  

Notifications Settings 

At the Notifications tab, you can specify notification settings for the backup to tape job. 

At the Options step of the wizard, click Advanced. Then select the Notifications tab. 

1. Select the Send email notifications to the following recipients check box if you want to 
receive notifications by email in case of job failure or success. In the field below, specify a 
recipient’s email address. You can enter several addresses separated by a semicolon. 

Email notifications will be sent if you configure general email notification settings in 
Veeam Backup & Replication. For more information, see Specifying Email Notification 
Settings.  

2. You can choose to use global notification settings or specify custom notification settings. 

 To receive a typical notification for the job, select Use global notification 
settings. In this case, Veeam Backup & Replication will apply to the job global 
email notification settings specified for the Veeam backup server. For more 
information, see Specifying Email Notification Settings.  

 To configure a custom notification for a job, select Use custom notification 
settings specified below. You can specify the following notification settings: 
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iv. In the Subject field, specify a notification subject. You can use 
the following variables in the subject: %Time% (completion 
time), %JobName%, %JobResult%, %VmCount% (the number of 
VMs in the job) and %Issues% (the number of VMs in the job that 
have been processed with the Warning or Failed status). 

v. Select the Notify on success, Notify on warning and/or Notify 
on error check boxes to receive email notification if the job 
completes successfully, fails or completes with a warning. 

vi. Select the Notify when waiting for tape check box to receive a 
notification when the tape job cannot start because there are no 
available tapes. 
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Advanced Settings 

At the Advanced tab, you can select what backups from the backup chain to copy, enable hardware 
compression or specify custom scripts that you want to run before and/or after the backup to tape 
job. 

At the Options step of the wizard, click Advanced. Select the Advanced tab.  

1. [Not available for GFS jobs] Select the Process latest full backup chain only check box if you 
want to copy only the last backup chain with each tape job run. The source backup chain 
consists of a full backup (active or synthetic) and subsequent increments. If you disable this 
option, the tape job will back up all restore points that are not on tape. 

2. Disable the Use hardware compression when available check box. 

3. Select the Run the following script before the job and/or Run the following script after 
the job check boxes and click Browse to choose executable file(s). 

You can select to execute pre- and post-job actions after a number of job sessions or on 
specific week days. 

 If you select the Run every... backup session option, specify the number of the job 
sessions after which the script(s) must be executed. 

 If you select the Run on selected days only option, click Days and specify week 
days on which the script(s) must be executed. 
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Step 8. Define the Job Schedule 

At the Schedule step of the wizard, you can define a schedule for the job to run on a regular basis. The 
schedule settings are different for GFS and non-GFS tape jobs: 

 Schedule for Backup to Tape Job 

 Schedule for GFS Job 

Schedule for Backup to Tape Job 

This step of the wizard is available if you selected a simple media pool at the Full Backup step of the 
wizard. 

To specify the job schedule, select the Run the job automatically check box. If this check box is not 
selected, the job is supposed to be started manually. 

You can define the following scheduling settings for the job: 

 You can choose to run the job at specific time on defined week days, monthly and with 
specific periodicity. 

 You can schedule the backup to tape job when a corresponding backup job completes. To do 
so, select the After this job option and choose the preceding backup job from the list.  

 You can schedule the tape job to periodically check the jobs that you have selected as source 
for new backups and archive new backups to target media. To do so, select the As new 
backup files appear option. If this option is selected, the backup to tape job will constantly 
remain in the Idle state, monitoring for new backups to appear. As soon as new backups are 
created, the job will start archiving these backup to tape.  
If necessary, you can define the time interval during which the backup to tape job must not 
archive data. These can be hours when backup repositories are busy with other tasks (backup 
jobs writing to repositories or backup copy jobs reading from repositories). To define 
prohibited time for the backup to tape job, click the Schedule button and define the time 
when the job is allowed and prohibited to run. 

If you have scheduled the job to run at the specific time daily or monthly, consider configuring wait 
timeout value. Select the If some linked backup jobs are still running, wait for up to … minutes 
check box and specify the new timeout. When a backup to tape job starts, 
Veeam Backup & Replication checks the status of the linked backup jobs. If a linked backup job is still 
writing data to the source repository, the backup to tape job will wait for the specified time interval.  

If the timeout is disabled, the backup to tape job will terminate without waiting for the backup job to 
complete. 

The timeout option is unavailable if you schedule the backup to tape job to run after a backup job or if 
you schedule the backup to tape job to start when new backups appear. 

Note: 

 

The After this job function will only start a job if the first job in the chain is started automatically by 
schedule. If the first job is started manually, jobs chained to it will not be started. 



 

1075   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

 

Schedule for GFS Job 

This step of the wizard is available if you selected a GFS media pool at the Full Backup step of the 
wizard. 

Click Schedule to select days for each media set. The GFS job starts at 00:00 on the selected day. 

Tip: 

 

After you specify necessary schedule settings, you can save them as default. To do this, click Save as 
Default at the bottom left corner of the Archival Schedule window. When you create a new GFS 
job, Veeam Backup & Replication will automatically apply default settings to the new job schedule. 

 



 

1076   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Step 9. Finish Working with the Wizard 

After you have specified schedule settings, click Create. Select the Run the job when I click Finish 
check box if you want to start archiving backups to tape job right after you complete working with the 
wizard. Click Finish to close the wizard. 
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View Backups on Tape 

After the backup to tape job completes, you can view the created archive on tape: 

1. Open the Backup & Replication view. 

2. Expand the Backups > Tape node and locate the backup archive under the name of a 
corresponding job. You can use these archives for full VM recovery. 
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Linking Backup Jobs to Backup to Tape Jobs 
Veeam Backup & Replication provides two options for linking backup jobs to backup to tape jobs: 

• If you already have backup jobs configured, you can choose the necessary jobs in the Backup 
to Tape Job Wizard. For details, see Creating Backup to Tape Jobs. 

• Alternatively, you can point a backup job to an existing backup to tape job using the Backup 
Job wizard. 

To point a backup job to an existing backup to tape job, perform the following steps:  

1. Open the backup job settings and navigate to the Storage step. Select the Configure 
secondary destination for this job check box.  
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2. At the Secondary Target step, click Add and choose a backup to tape job to which the 
backup job should be linked. 

 

3. Save settings. Veeam Backup & Replication will automatically update backup files settings of 
the chosen backup to tape job. 
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Creating File to Tape Jobs 
To write files to tape, you should create a file to tape job using the New File To Tape Job wizard. This 
section will guide you through all steps of the wizard and provide explanation on available options. 

To create a file to tape job, follow the next steps: 

Step 1. Launch the New File To Tape Job Wizard 

To run the New File to Tape Job wizard, do either of the following: 

 On the Home tab, click Tape Job and select Files. 

 Open the Backup & Replication view, right-click the Jobs node and select Tape Job > Files 
to Tape. 

Alternatively, you can: 

 Open the Files view, browse to the necessary files, select the files and choose Add to Tape 
Job > New job from the ribbon menu. 

 Open the Files view, browse to the required files, right-click the necessary files and choose 
Add to Tape Job > New job. 

Step 2. Specify Job Name and Description 

At the Name step of the wizard, you should define basic settings for the created files to tape job.  

1. In the Name field, enter a name for the created job.  

2. In the Description field, enter a description of the created job. The default description 
contains information about the user who created the job, date and time when the job was 
created. 
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Step 3. Choose Files and Folders to Archive 

At the Files and Folders step of the wizard, select files and folders that you want to back up.  

From the Server list, choose a machine on which the necessary files or folders reside. Click Add and 
browse to the file or folder that you want to back up. The selected item will be added to the list. To 
remove a file or folder from the list, select it and click Remove. 

 

If you include a folder to the job, all of the folder contents will be archived. If necessary, you can 
choose only specific files from the included folder. To do so, select a folder in the list and click Edit. In 
the File Masks window, specify names of files in the folder that should be archived. You can use exact 
file names of create name masks (for example, *.evt or *.pdf). Separate file names and masks with 
semicolons.  
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Step 4. Choose Media Pool for Full Backup 

At the Full Backup step of the wizard, choose a media pool that will be used for archiving full backups 
of the selected files and create a schedule for full file backups. 

1. From the Media pool for full backups list, choose a media pool that will be used for full file 
backups. 

2. To schedule periodic creation of full file backups, select the Run the full backup 
automatically check box and specify the schedule according to which the job will create full 
file backups. If this option is disabled, you will need to start the job manually to create full 
backups of files. 

Tip: 

 

If you have not previously created a media pool with the required settings, you can click the Add 
New button and create a new media pool without closing the job wizard. For more details, see 
Creating Custom Media Pools. 

 

Step 5. Specify Media Pool for Increments 

At the Incremental Backup step of the wizard, choose a media pool that will be used for archiving 
incremental backups of the selected files and create a schedule for incremental file backups. 

1. From the Media pool for incremental backup list, choose a media pool that will be used for 
incremental file backups. 

2. To schedule periodic creation of incremental file backups, select the Run incremental 
backup automatically check box and specify the schedule according to which the job will 
create incremental file backups. If this option is disabled, you will need to start the job 
manually to create incremental backups of files. 

Tip: 

 

If you have not previously created a media pool with the required settings, you can click the Add 
New button and create a new media pool without closing the job wizard. For more details, see 
Creating Custom Media Pools. 
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Step 6. Specify Archiving Options 

At the Options step of the wizard, specify archiving and media automation options: 

1. Select the Use Microsoft volume shadow copy (VSS) check box to enable backup of files 
with the help if Microsoft shadow volume copies. This option enables backup of files locked 
by application and provides file-level quiescence. This possibility can only be applied for files 
from servers running under Windows Server 2003 or later Windows-family OSs. 

2. Select the Eject media upon job completion check box if the tape should be automatically 
ejected from the tape drive and placed into a slot when the job finishes. 

3. Select the Export current media set upon job completion check box if the tapes belonging 
to the media set should be placed to Import/Export (Mail) slot for further export (for example, 
for export to a remote office). If you want to export tapes on specific days only (for example, 
every Saturday, when a backup to tape job completes), click Days and schedule export on the 
necessary days). 
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Step 7. Specify Advanced Job Settings 

You can specify the following advanced settings for the files to tape job: 

 Notifications Settings  

 Advanced Settings 

Tip: 

 

After you specify necessary settings for the files to tape job, you can save them as default settings. To 
do this, click Save as Default at the bottom left corner of the Advanced Settings window. When 
you create a new files to tape job, Veeam Backup & Replication will automatically apply default 
settings to the new job.  

Notifications Settings 

At the Notifications tab, you can specify notification settings for the files to tape job. 

At the Options step of the wizard, click Advanced. Select the Notifications tab. 

1. Select the Send email notifications to the following recipients check box if you want to 
receive notifications by email in case of job failure or success. In the field below, specify a 
recipient’s email address. You can enter several addresses separated by a semicolon. 

Email notifications will be sent if you configure general email notification settings in 
Veeam Backup & Replication. For more information, see Specifying Email Notification 
Settings.  

2. You can choose to use global notification settings or specify custom notification settings. 

 To receive a typical notification for the job, select Use global notification 
settings. In this case, Veeam Backup & Replication will apply to the job global 
email notification settings specified for the Veeam backup server. For more 
information, see Specifying Email Notification Settings.  

 To configure a custom notification for a job, select Use custom notification 
settings. You can specify the following notification settings: 
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vii. In the Subject field, specify a notification subject. You can use 
the following variables in the subject: %Time% (completion 
time), %JobName%, %JobResult%, %VmCount% (the number of 
VMs in the job) and %Issues% (the number of VMs in the job that 
have been processed with the Warning or Failed status). 

viii. Select the Notify on success, Notify on warning and/or Notify 
on error check boxes to receive email notification if the job 
completes successfully, fails or completes with a warning. 

ix. Select the Suppress notifications until the last retry check box 
to receive a notification about the final job status. If you do not 
select this option, Veeam Backup & Replication will send one 
notification per every job retry. 
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Advanced Settings 

At the Advanced tab, you can enable hardware compression or specify custom scripts that you want 
to run before and/or after the files to tape job. 

At the Options step of the wizard, click Advanced. Select the Advanced tab. 

1. Select the Use hardware compression if available check box if the tape drive should 
compress data before writing it to tape. 

Important! 

 

Enable the hardware compression only if your tape library provides support for hardware 
compression. 

2. Select the Run the following script before the job and/or Run the following script after 
the job check boxes and click Browse to choose executable file(s). You can select to execute 
pre- and post-job actions after a number of job sessions or on specific week days. 

 If you select the Run every... backup session option, specify the number of the job 
sessions after which the script(s) must be executed.  

 If you select the Run on selected days only option, click Days and specify week 
days on which the script(s) must be executed. 

 

  



 

1087   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Step 8. Finish Working with the Wizard 

After you have specified schedule settings, click Create. Select the Run the job when I click Finish 
check box if you want to start archiving files to tape job right after you complete working with the 
wizard. Click Finish to close the wizard. 
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View Files on Tape 

After the files to tape job completes, you can view the created archive on tape: 

1. Open the Files view and press F5 to refresh it. 

2. Expand the Tape node and locate the files archive. Veeam Backup & Replication preserves the 
source hierarchy of folders for archived files. You can use the created archive for file recovery. 
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Restoring VMs from Tape to Virtual Infrastructure 
Veeam Backup & Replication allows you to recover full VMs from archives on tape. The process of full 
VM restore from tape includes two stages: 

1. First, Veeam Backup & Replication restores a backup file to a staging location (a backup 
repository or a folder). 

2. Next, Veeam Backup & Replication restores the VM into the virtual infrastructure. After the VM 
is restored, the backup is deleted from the staging location. 

To restore full VMs from tape to virtual infrastructure, use the Full VM Restore wizard. This section will 
guide you through all steps of the wizard and provide explanation on available options. 

To restore files from tape, follow the next steps: 

Step 1. Launch the Full VM Restore Wizard 

To run the Full VM Restore wizard, do one of the following: 

 Open the Backup & Replication view, expand the Backups > Tape node. Select the 
necessary VMs in backup and click Restore Entire VM on the ribbon. 

 Open the Backup & Replication view, expand the Backups > Tape node. Right-click the 
necessary VMs in backup and choose Restore entire VM. 

Step 2. Choose Virtual Machines to Restore 

At the Virtual Machines step of the wizard, review VMs that should be restored. To add one or more 
VMs to the list, click Add VM and select where to browse for the machines: 

 From infrastructure — browse the virtual environment and select VMs to restore. If you 
choose a VM container, Veeam Backup & Replication will expand it to a plain VM list. To 
quickly find a VM, use the search field at the top of the list: enter the VM name or a part of it 
and click the search button on the right or press [ENTER].  
Make sure that VMs you select from the virtual environment have been successfully archived 
to tape at least once. 

 From backup — browse existing backups and select VMs under backup to tape jobs. To 
quickly find VMs, use the search field at the bottom of the Select Objects window: enter a VM 
name or a part of it and click the Start search button on the right or press [ENTER]. 

To remove a VM, select it in the list and click Remove on the right. 



 

1090   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

 

Step 3. Select a Restore Point 

By default, Veeam Backup & Replication will restore VMs to their latest state archived to tape. 
However, if you want to restore a VM to an earlier state, select a VM in the list and click Point on the 
right. In the Restore Points section, select a restore point that should be used for full VM recovery. 

If you have chosen to restore multiple VMs, you can select a different restore point for every VM 
specifically. 
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Step 4. Choose Backup Repository 

Because tape does not support random access, Veeam Backup & Replication restores VM backups 
from tape to a staging area (backup repository or another location) and after that performs full VM 
recovery from disk. 

From the Backup repository list, select the repository that should be used as a temporary storage 
(staging area) for VM backup before the VM is restored to the virtual infrastructure.  

You can also select a target folder on any server connected to Veeam Backup & Replication. To do so, 
choose the Select folder option from the Backup repository list and choose the location to which 
backups should be restored before full VM recovery. 

 

Step 5. Specify Restore Mode and Other Recovery Options 

Go through the remaining steps of the Full VM Restore wizard. The procedure is identical to full VM 
recovery. For more details, refer to Performing Full VM Restore. 
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Restoring Backups from Tape 
Veeam Backup & Replication allows you to restore backups from tape to a repository or a folder on 
disk. To restore backups from tape, use the Restore Backup from Tape to Repository wizard. This 
section will guide you through all steps of the wizard and provide explanation on available options. 

To restore files from tape, follow the next steps: 

Step 1. Launch the Files Restore Backup from Tape to Repository Wizard 

To run the Restore Backup from Tape to Repository wizard, on the Home tab, click Restore and 
choose Tape > Restore Backups. 

Alternatively, you can: 

 Open the Backup & Replication view, expand the Backups > Tape node. Select the 
necessary VMs in backup and click Restore backup to Repository on the ribbon. 

 Open the Backup & Replication view, expand the Backups > Tape node. Right-click the 
necessary VMs in backup and choose Restore backup from tape to repository. 

Step 2. Choose VMs to Restore 

At the Source step of the wizard, select one or more VMs for which backup files should be restored. If 
you have chosen VMs to restore from archives on tape, the list of objects to restore will be populated 
with selected VMs. 

To add one or more VMs to the list, click Add VM and select where to browse for the machines: 

 From vSphere Infrastructure — browse the virtual environment and select VMs to restore. If 
you choose a VM container, Veeam Backup & Replication will expand it to a plain VM list. To 
quickly find a VM, use the search field at the top of the list: enter the VM name or a part of it 
and click the search button on the right or press [ENTER].  
Make sure that VMs you select from the virtual environment have been successfully archived 
to tape at least once. 

 From backups — browse existing backups on tape and select VMs under backup to tape 
jobs. To quickly find VMs, use the search field at the bottom of the Select Objects window: 
enter a VM name or a part of it and click the Start search button on the right or press 
[ENTER]. 

To remove a VM, select it in the list and click Remove on the right. 
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Step 3. Select a Restore Point 

By default, Veeam Backup & Replication will restore backup with the latest state of the archived VM. 
However, if you want to restore a backup for the VM to an earlier state, select a VM in the list and click 
Point on the right. In the Restore Points section, select a restore point that should be used to restore 
VM backup. 

Note: 

 

If you choose a full backup point in the list, Veeam Backup & Replication will restore only this full 
backup. If you choose an increment, Veeam Backup & Replication will restore a chain consisting of a 
full backup and forward increments, necessary to restore VMs to the required point-in-time. 

If you have chosen to restore multiple VMs, you can select a different restore point for every VM 
specifically. 
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Step 4. Choose Backup Destination 

At the Destination step of the wizard, select where the backup files for the selected VMs should be 
restored: 

 To restore VM backup files to a repository, select the Backup repository option and choose 
the necessary repository from the list. 

 To restore VM backup files to the Veeam backup server, shared folder or to any other machine 
connected to Veeam backup server, select the Server option. Choose the necessary server 
from the list and specify path to the target folder in the Path to folder field. 
 
If you choose to restore files to a shared folder, make sure that the account under which 
Veeam Backup Service runs has write permissions to the target folder. If the account does not 
have sufficient permissions, Veeam Backup & Replication will prompt you to enter credentials 
for the account that can be used for writing to the target folder. 
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Step 5. Finish Working with the Wizard 

Review the settings and click Finish to restore selected VM backups. 
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Viewing Restored Files 

After backups are restored from tape, they are displayed as imported backups in the Backup & 
Replication view > Backups > Imported. You can use the restored to disk backup for regular data 
recovery, including full VM recovery, recovery of VM files, guest OS files recovery and other. 
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Restoring Files from Tape 
To restore files backed up to tape, use the Files from Tape Restore wizard. This section will guide you 
through all steps of the wizard and provide explanation on available options. 

Note: 

 

The Files from Tape Restore wizard allows you to restore regular files and folders archived to tape. 
You cannot restore VM guest OS files using this wizard. To restore VM guest OS files, you can restore 
a backup from tape to the backup repository and perform VM guest OS files restore for this backup 
after that. For more information, see Restoring Backups from Tape. 

To restore files from tape, follow the next steps: 

Step 1. Launch the Files from Tape Wizard 

To run the Files from Tape wizard, open the Home tab and click Restore on the ribbon. Choose Tape 
> Restore Files. 

Alternatively, you can: 

 Open the Files view, expand the Tape node and browse to the necessary files on tape. Select 
the files and click Restore Files from Tape on the ribbon. 

 Open the Files view, expand the Tapes node and browse to the necessary files on tape. 
Select the files and choose Restore files from tape. 

Step 2. Choose Files to Restore 

At the Objects to Restore step, choose files and folders that you want to restore.  

Click Add and browse to the file or folder that should be restored. The selected item will be added to 
the list. To quickly find file or folder, use the search field at the top of the list: enter an object name or a 
part of it and click the search button on the right or press [ENTER]. 

If you have chosen files to restore in the Files view, the list of objects to restore will be populated with 
selected files.  

To remove a file or folder from the list, select it and click Remove.  
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By default, Veeam Backup & Replication will restore the latest version of files available on tape. If you 
want to restore files from another restore point, select the necessary file and click Backup Set. In the 
list of available backup sets, select the necessary archiving session and click OK. 

Note: 

 

When you restore an entire folder from tape, Veeam Backup & Replication restores all files that have 
ever existed in the folder and been archived to tape. To restore files in the folder, 
Veeam Backup & Replication scans the selected backup set and backup sets that were created 
previously. If a file is not found in the selected backup set, Veeam Backup & Replication will restore 
the most recent version of the file from a backup set preceding the selected backup set. 

 

Step 3. Specify Restore Destination 

At the Destination step of the wizard, specify destination where the archived files will be restored. 
You can use one of the following options: 

 Original location. Use this option to restore a file to the location where the original file 
resides (or resided). This type of restore is only possible if the original machine is connected 
to Veeam Backup & Replication and powered on.  

 This server. Use this option if you want to restore the file to the Veeam backup server, shared 
folder or to any other machine connected to Veeam backup server. From the server list, 
choose a machine to which files should be restored and specify path to the target folder.  
 
If you choose to restore files to a shared folder, make sure that the account under which 
Veeam Backup Service runs has write permissions to the target folder. If the account does not 
have sufficient permissions, Veeam Backup & Replication will prompt you to enter credentials 
for the account that can be used for writing to the target folder. 

When restoring files to a location other than original, Veeam Backup & Replication preserves the folder 
hierarchy. To restore files to the specified target folder without keeping the folder structure, clear the 
Preserve folder hierarchy check box. 
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Step 4. Specify Restore Options 

At the Options step of the wizard, specify overwrite options in case the file already exists in the target 
folder: 

 Leave the existing file. Select this option if you do not want to overwrite the existing file 
with the restored one. 

 Overwrite the existing file if older than the backed up file. Select this option if you want to 
overwrite the existing file only if it is older than the restored file. 

 Always overwrite the existing file. Select this option if you want to overwrite the existing 
file with the restored file in all cases. 

Select the Restore file and folder security check box if you want the restored files to keep their 
original ownership and security permissions. In the opposite case, Veeam Backup & Replication will 
change security settings: the user account under which the Veeam Backup Service runs will be set as 
the owner of the restored objects, while access permissions will be inherited from the target folder to 
which the objects are restored. 
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Step 5. Finish Working with the Wizard 

Review the settings and click Finish to restore selected files and folders. 
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Restoring Encrypted Data from Tapes 
When you restore data from encrypted tapes, Veeam Backup & Replication performs data decryption 
automatically in the background or requires you to provide a password. 

 If encryption keys required to unlock the tape are available in the 
Veeam Backup & Replication database, you do not need to enter the password to decrypt the 
tape. Veeam Backup & Replication uses keys from the database to unlock the encrypted tape. 
Data decryption is performed in the background and data restore from encrypted tapes does 
not differ from that from an unencrypted ones. 

Automatic tape decryption is performed if the following conditions are met: 

1. You encrypt and decrypt tapes on the same Veeam backup server.  

2. The tape is loaded to the tape library and information about this tape is available in 
the catalog. 

3. The password specified in the settings of the media pool to which the tape belongs 
is the same as the password that was used for tape encryption. 

 If encryption keys are not available in the Veeam Backup & Replication database, you can 
restore data from encrypted tapes with the following methods: 

– You can provide a password or a set of passwords to unlock the encrypted 
tape. For more information, see Decrypting Tapes with Password. 

– You can use Veeam Backup Enterprise Manager to unlock the encrypted tape 
without a password. For more information, see Decrypting Data Without 
Password. 

Decrypting Tapes with Password 

When you restore encrypted files or backups from tape, you need to specify a password that was used 
to encrypt data archived to tape.  

To unlock encrypted tapes: 

1. Insert encrypted tapes into the tape library.  

2. Catalog the tapes so that Veeam Backup & Replication can read data archived on tape. After 
you perform catalogization, encrypted tapes will be displayed under the Media > Encrypted 
node in the corresponding tape library. On the cataloged tape, Veeam Backup & Replication 
displays the key icon to mark it as encrypted. 

3. In the inventory pane, select the Encrypted node under Media node.  

4. In the working area, select the imported tape and click Specify password on the ribbon or 
right-click the tape and select Specify password. 

5. In the Description field of the Specify Password window, Veeam Backup & Replication 
displays a hint for the password that was used to encrypt the tape. Use the hint to recall the 
password. 

6. In the Password field, enter the password for the tape.  

7. If the imported tape is a part of a backup set but is not the last tape in this set, perform 
catalogization once again.  
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When Veeam Backup & Replication creates a backup set, it writes catalog data to the last tape 
in this set.  

 If the imported group of tapes contains the last tape in the backup set, 
Veeam Backup & Replication retrieves catalog data from the last tape during the 
initial catalogization process (see point 2 of this procedure). 

 If the imported group of tapes does not contain the last tape in the backup set, 
Veeam Backup & Replication needs to additionally catalog files on imported tapes. 

If you enter a correct password, Veeam Backup & Replication will decrypt the tape media. The tape will 
be moved under the corresponding media pool in the inventory pane. You can perform restore 
operations for data archived to tape as usual.  

If you import a backup file from tape and the backup file was encrypted twice, with the initial backup 
job and with the backup to tape job, you must sequentially specify two passwords: 

1. Password that was used to encrypt tapes in the media pool. 

2. Password for the primary backup job. 

After you enter the first password, backups from the tape will be moved under the Backup > 
Encrypted node in the inventory pane. You must then enter the second password to decrypt the 
backup and get access to its content. 

Note: 

 

If you use Enterprise or Enterprise Plus Edition of Veeam Backup & Replication and your Veeam 
backup servers are connected to Veeam Backup Enterprise Manager, you can recover data from 
encrypted tapes even if the password is lost. For more information, see Decrypting Data Without 
Password. 
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Decrypting Tapes Without Password 

If you have lost or forgotten a password, you can unlock encrypted tapes with the help of Veeam 
Backup Enterprise Manager.  

You can restore data from tapes without a password only if your backup infrastructure meets the 
following conditions: 

1. You use Enterprise or Enterprise Plus Edition of Veeam Backup & Replication. 

2. Veeam backup server on which you encrypted tapes is added to Veeam Backup Enterprise 
Manager.  

3. Veeam backup server on which you generate a request for data decryption is added to 
Veeam Backup Enterprise Manager. 

The restore process is accomplished with the help of two wizards that run on two servers:  

1. The Encryption Key Restore wizard on the Veeam backup server. 

2. The Password Recovery wizard on the Veeam Backup Enterprise Manager server. 

To restore encrypted data from tapes without a password: 

1. Create a request for data restore. 

2. Process the request in Veeam Backup Enterprise Manager. 

3. Complete the key restore process. 

Step 1. Create Request for Data Restore 

This procedure is performed by the Veeam Backup Administrator on the Veeam backup server. 

1. Import encrypted tapes to the Veeam backup server. 

2. Select the imported tape and click Specify Password on the ribbon or right-click the tape 
and select Specify password. 

3. In the Specify Password window, click the I have lost the password link. 
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4. Veeam Backup & Replication will launch the Encryption Key Restore wizard. At the Request 
step of the wizard, review the generated request for data recovery. Use buttons at the bottom 
of the wizard to copy the request to the Clipboard or save the request to a text file. 

5. Send the copied request by email or pass it in any other way to the Veeam Backup Enterprise 
Manager Administrator. 

Tip: 

 

You can close the Encryption Key Restore wizard on the Veeam backup server and start it anew 
when you receive a response from the Veeam Backup Enterprise Manager Administrator.  
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Step 2. Process Request in Veeam Backup Enterprise Manager 

This procedure is performed by the Veeam Backup Enterprise Manager Administrator on the Veeam 
Backup Enterprise Manager server. 

1. Copy the obtained request to the Clipboard.  

2. In Veeam Backup Enterprise Manager, go to the Configuration > Key Management section.  

3. Click Password Recovery at the top of the section to open the Password Recovery wizard. 

4. Paste the request that you have received from the Veeam Backup Administrator. You can use 
the [CTRL+V] key combination or click Paste at the bottom of the wizard. 

 

5. Follow the next steps of the wizard. At the Response step, copy the text displayed in the 
wizard to the Clipboard.  

6. Send the copied response by email or pass it in any other way to the Veeam Backup 
Administrator working on the Veeam backup server. 
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Step 3. Complete Key Restore Process 

This procedure is performed by the Veeam Backup Administrator on the Veeam backup server. 

1. In Veeam Backup & Replication, get back to the Encryption Key Restore wizard.  

2. Enter the copied response to the text window at the Response step of the Encryption Key 
Restore wizard. 

3. Follow the next steps of the wizard. At the last step, click Finish. Veeam Backup & Replication 
will retrieve the decrypted storage keys from the response, apply them to the encrypted tape 
and unlock the tape content. 
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Performing File Copy Operations 
You can perform file copying operations in Veeam Backup & Replication.  

File copying can be helpful, for example, if you need to copy ISO files, VM files and VM templates 
between hosts, Microsoft Windows and Linux servers in the backup infrastructure. 
Veeam Backup & Replication ensures data security by using a one-time password and works over 6 
times faster than SCP. 

You can copy files and folders manually or configure file copy jobs and start them manually or 
schedule them to run automatically. 
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Copying Files and Folders Manually 
You can manually copy and move files and folders between the following objects in the backup 
infrastructure: 

 Virtualization hosts 

 Microsoft Windows servers 

 Linux hosts 

 Deduplicating storage appliances used as backup repositories 

Before you begin the copying operation, make sure that the source and target hosts or servers are 
added to the backup infrastructure. 

To copy files and folders: 

1. Open the Files view. 

2. In the inventory pane, expand the file tree of the source server or host. 

3. Right-click files and folders that you want to copy and select Copy.  

4. In the inventory pane, expand the file tree of the target server or host. 

5. Right-click a destination folder and select Paste. 

You can also use a drag-n-drop operation to copy files and folders between the source and target 
hosts or servers. 
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Creating File Copy Jobs 
To schedule a copying process for files and folders, you must configure a file copy job. You can run the 
file copy job immediately after its creation, schedule or save the job.  

Before you configure a file copy job, check prerequisites. Then use the New File Copy Job wizard to 
create a job. 

Before You Begin 

Before you configure a file copy job, check the following prerequisites: 

Backup infrastructure components that will take part in the file copying process must be added to the 
backup infrastructure and properly configured. These include a source and target host or server 
between which files and folders will be copied. 

Step 1. Launch New File Copy Job Wizard 

To launch the New File Copy Job wizard, do either of the following: 

 On the Home tab, click File Copy. 

 Open the Files view, in the working area right-click the necessary files and folders and select 
Add to File Copy Job > New job. Veeam Backup & Replication will start the New File Copy 
Job wizard and add selected files and folders to this job. You can add other files and folders 
to the job later on, when you pass through the wizard steps. 

You can add files and folders to already existing jobs. To do this, open the Files view, in the working 
area right-click necessary objects and select Add to file copy job > name of the job. 
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Step 2. Specify Job Name and Description 

At the Name step of the wizard, enter the name and description of the created job.  

1. In the Name field, enter a name for the file copy job. 

2. In the Description field, provide a description for future reference. The default description 
contains information about the user who created a job, date and time when the job was 
created. 

 

Step 3. Select Files and Folders to Be Copied 

At the Source step of the wizard, select files and folders that you want to copy.  

You can use the following sources for the file copy job: 

 Virtualization hosts 

 Microsoft Windows servers 

 Linux hosts 

You cannot use dedulicating storage appliances, shared folder backup repositories and shared folders 
as a source for the file copy job.  

To select files and folders that you want to copy: 

1. From the Host list, choose a host or server on which files or folders that you want to copy 
reside.  

2. Click Add and select files or folders that must be copied. The selected items will be added to 
the list.  
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To remove a file or folder from the list, select it and click Remove. 
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Step 4. Select Destination for Copying 

At the Destination step of the wizard, select a destination to which files or folders must be copied.  

1. From the Server list, select the target host or server. 

2. Click Details on the right of the Server field to view or edit server properties. 

3. Click Browse next to the Path to folder field and select a folder where copied items must be 
stored. To create a dedicated folder for copied files or folders, use the New Folder button at 
the bottom of the Select Folder window. 

 

Step 5. Define the Job Schedule 

At the Schedule step of the wizard, you can select to run the file copy job manually or schedule the 
job to run on a regular basis. 

To specify the job schedule:  

1. Select the Run the job automatically check box. If this check box is not selected, you will 
have to start the job manually to copy files or folders. 

2. Define scheduling settings for the job: 

 To run the job at specific time daily, on defined week days or with specific 
periodicity, select Daily at this time. Use the fields on the right to configure the 
necessary schedule. 

 To run the job once a month on specific days, select Monthly at this time. Use the 
fields on the right to configure the necessary schedule. 

 To run the job repeatedly throughout a day with a set time interval, select 
Periodically every. In the field on the right, select the necessary time unit: Hours or 
Minutes. Click Schedule and use the time table to define the permitted time 
window for the job. In the Start time within an hour field, specify the exact time 
when the job must start.  
The repeatedly run job are started by the following rules: 
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– Veeam Backup & Replication always starts counting defined intervals 
from 12:00 AM. For example, if you configure to run a job with a 4-hour 
interval, the job will start at 12:00 AM, 4:00 AM, 8:00 AM, 12:00 PM, 4:00 
PM and so on. 

– If you define permitted hours for the job, after the denied interval is over, 
Veeam Backup & Replication will immediately start the job and then run 
the job by the defined schedule. 

For example, you have configured a job to run with a 2-hour interval and defined 
permitted hours from 9:00 AM to 5:00 PM. According to the rules above, the job will 
first run at 9:00 AM, when the denied period is over. After that, the job will run at 
10:00 AM, 12:00 PM, 2:00 PM and 4:00 PM. 

 To run the job continuously, select the Periodically every option and choose 
Continuously from the list on the right. 

 To chain jobs, use the After this job field. In the common practice, jobs start one 
after another: when job A finishes, job B starts and so on. If you want to create a 
chain of jobs, you should define the time schedule for the first job in the chain. For 
the rest of the jobs in the chain, at the Schedule step of the wizard, select the After 
this job option and choose the preceding job from the list.  
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Step 6. Finish Working with the Wizard 

At the Summary step of the wizard, complete the procedure of file copy job configuration. 

1. Review details for the created file copy job. 

2. Select the Run the job when I click Finish check box if you want to start the job right after 
you finish working with the wizard.  

3. Click Finish to close the wizard. 
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Managing Folders 
You can create, rename and delete folders in the Files view of Veeam Backup & Replication.  

To create a folder: 

1. Open the Files view. 

2. In the inventory pane, expand the file tree of the necessary server or host. 

3. In the working area, right-click anywhere on the blank area and select New Folder. 

To rename a folder: 

1. Open the Files view. 

2. In the inventory pane, expand the file tree of the necessary server or host. 

3. In the working area, select the folder and click Rename on the ribbon or right-click the folder 
and select Rename.  

4. Enter a new name for the folder and press [ENTER]. 

To remove a folder: 

1. Open the Files view. 

2. In the inventory pane, expand the file tree of the necessary server or host. 

3. In the working area, select the folder and click Delete on the ribbon or right-click the folder 
and select Delete. 
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Editing and Deleting Files 
You can edit files and delete them in the Files view of Veeam Backup & Replication. For example, you 
may want to edit a configuration file of the VM (VMX) or need to delete from the storage files of 
unused VMs. 

To edit a file: 

1. Open the Files view. 

2. In the inventory pane, expand the file tree of the necessary server or host. 

3. In the working area, select the file and click Edit on the ribbon or right-click the folder and 
select Edit. 

4. Veeam Backup & Replication will open the selected file in the editor. Edit the file as required 
and click Save on the file editor toolbar or press [CTRL+S]. 

To delete a file: 

1. Open the Files view. 

2. In the inventory pane, expand the file tree of the necessary server or host. 

3. In the working area, select the file and click Delete on the ribbon or right-click the folder and 
select Delete. 

Note: 

 

To delete a folder on VSAN, you must remove a real folder, not a symbolic link to this folder. The real 
folder is named with GUID, for example, c07a2953-8096-5b20-a11a-002590c5857c, while the symbolic 
link contains the folder name, for example, srv02_vm. If you delete the folder symbolic link, the delete 
operation will fail, and the folder will not be removed.  
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Specifying General Settings 
You can set up general settings for Veeam Backup & Replication. General settings are applied to all 
jobs, backup infrastructure components and other objects managed by the backup server. 
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Specifying Data Processing Settings 
You can select the data processing mode for VMs and VM disks in jobs (parallel or sequential) and 
specify task throttling options. 

Note: 

 

The Enable storage latency control option is supported in Veeam Backup & Replication Enterprise 
and Enterprise Plus Editions. The Set custom thresholds on individual datastores option is 
supported in Veeam Backup & Replication Enterprise Plus Edition only. 

To specify data processing settings: 

1. From the main menu, select Options. 

2. Click the I/O Control tab. 

3. By default, Veeam Backup & Replication uses the parallel data processing mode for VMs and 
VM disks. To disable parallel processing, clear the Enable parallel processing check box. In 
this case, Veeam Backup & Replication will process VMs and VM disks sequentially, one by 
one. 

4. To control the I/O load on the production storage, select the Enable storage latency control 
check box and specify two thresholds: 

a. In the Stop assigning new tasks to datastore at field, specify the I/O latency 
limit at which Veeam Backup & Replication must not assign new tasks targeted 
at the datastore. 

b. In the Throttle I/O of existing tasks at field, specify the I/O latency limit at 
which Veeam Backup & Replication must decrease the speed of data retrieval 
or writing to/from the datastore. When the I/O latency for this datastore 
reaches this value, the Veeam Data Mover Service working with this datastore 
will slow down data retrieval or writing. 

The value in the Stop assigning new tasks to datastore at field cannot be greater than the 
value in the Throttle I/O of existing tasks at field.  

 

  



 

1119   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

You can set the I/O latency limit for every storage in the virtual infrastructure separately. 

To set the I/O latency limit for every storage separately: 

1. From the main menu, select Options. 

2. Click the I/O Control tab. 

3. Click Configure.  

4. Click Add > Datastore, select the necessary datastore and click OK to add it to the storage 
list. 

5. Select the added datastore(s) in the list and click Edit. 

6. Specify the I/O thresholds for the datastore(s) as described above. 
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Specifying Email Notification Settings 
You can receive email notifications with results on jobs performed on the backup server.  

To receive email notifications, you must perform the following tasks: 

1. Configure global email notification settings in Veeam Backup & Replication. 

2. Configure job notification settings. 

Tip: 

 

To receive email notification about all jobs performed on the backup server in one email, configure 
email notification settings in Veeam Backup Enterprise Manager. 

Configuring Global Email Notification Settings 

To configure global email notification settings: 

1. From the main menu, select Options.  

2. Open the E-mail Settings tab. 

3. Select the Enable email notifications check box. 

4. In the SMTP server field, enter a full DNS name or IP address of the SMTP server that will be 
used for sending email notifications. 

5. Click the Advanced button to specify user credentials and connection options:  

a. Specify the port number and connection timeout for the SMTP server.  

b. To use a secure SSL connection for email operations, select the Connect using SSL 
check box. 

c. If you need to connect to the SMTP server using a specific account, select the This 
SMTP server requires authentication check box and select the necessary 
credentials from the Log on as list. If you have not set up credentials beforehand, 
click the Manage accounts link or click Add on the right to add credentials. For 
more information, see Managing Credentials. 

6. In the From field, specify an email from which email notifications must be sent. 

7. In the To field, specify the recipient address(es). Use a semicolon to separate multiple 
addresses. Recipient(s) specified in this field will receive notification about every job 
managed by the backup server. You can leave the field empty if required. 

For every particular job, you can specify additional recipients. For more information, see 
Configuring Job Notification Settings. 

8. In the Subject field, specify a subject for the sent message. You can use the following 
variables in the subject:  

a. %Time% — completion time 

b. %JobName% 

c. %JobResult% 

d. %VmCount% — number of VMs in the job 

e. %Issues% — number of VMs in the job that have been processed with the Warning 
or Failed status 

9. Select the Notify on success, Notify on warning and/or Notify on failure check boxes to 
receive email notification if a job is run successfully, not successfully or with a warning. 
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10. Select the Suppress notifications until the last retry check box to receive a notification 
about the final job status. If you do not enable this option, Veeam Backup & Replication will 
send one notification per every job retry. 

11. Veeam Backup & Replication allows sending a test email to check if all settings have been 
configured correctly. To send a test email, click Test Message. 

 

  



 

1122   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Configuring Job Notification Settings 

To configure job notification settings: 

1. Open advanced settings of the job. 

2. On the Notifications tab, select the Send email notifications to the following recipients 
check box. 

3. In the field below, enter an email address to which a notification must be sent. You can enter 
several email addresses separated with a semicolon. 

Make sure that you specify the necessary email address once: either in the To field in general 
notification settings or in the job notification settings. If you specify the email twice, 
Veeam Backup & Replication will send two identical notifications to this email address when 
the job completes. 

4. You can choose to use global notification settings for the job or specify custom notification 
settings. 

 To receive a typical notification for the job, select Use global notification 
settings. In this case, Veeam Backup & Replication will apply to the job global 
email notification settings specified for the backup server. For more 
information, see Configuring Global Email Notification Settings. 

 To configure a custom notification for the job, select Use custom notification 
settings and specify notification settings as required. 
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Specifying SNMP Settings 
You can receive SNMP traps with results on jobs performed on the backup server. You can use SNMP 
traps to feed data to other monitoring systems such as CA Unicenter, BMC Patrol, IBM Tivoli or HPE 
OpenView. SNMP traps can be sent to 5 different destinations.  

To receive SNMP traps, you must perform the following tasks: 

1. Configure global SNMP settings. 

2. Configure SNMP service properties. 

3. Configure SNMP settings for jobs. 

Configuring Global SNMP Settings 

To configure global SNMP settings: 

1. Select Options from the main menu. 

2. Click the SNMP Settings tab. 

3. In the Receiver field, specify an IP address of the SNMP recipient. 

4. In the field on the right, enter the port number to be used. 

5. In the Community String field, enter the community identifier. 
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Configuring SNMP Service Properties 

To configure SNMP service properties on recipients’ computers: 

1. Install a standard Microsoft SNMP agent from the Microsoft Windows distribution on the 
computer. 

2. From the Start menu, select Control Panel > Administrative Tools > Services. 

3. Double-click SNMP Service to open the SNMP Service Properties window. 

4. Click the Traps tab. 

5. Add the public string to the Community name list and name of the necessary host to the 
Trap destinations list. 

6. Click the Security tab. 

7. Make sure the Send authentication trap check box is selected. 

8. Add a public string to the Accepted community names list. 

9. Select the Accept SNMP packets from any hosts check box. 

10. Click OK to save changes. 
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Configuring SNMP Settings for Jobs 

To receive SNMP traps with results of a specific job: 

1. Open advanced settings of the job. 

2. On the Notifications tab, select the Send SNMP notifications for this job check box. 
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Specifying Other Notification Settings 
You can configure Veeam Backup & Replication to automatically notify you about the following 
events: 

 Low disk space 

 Support contract expiration 

 New product versions, available updates and patches 

Low Disk Space Notification 
When you run a job, Veeam Backup & Replication checks disk space on the target backup repository 
and production storage. If the disk space is below a specific value, Veeam Backup & Replication will 
display a warning message in the job session details.  

To specify the disk space threshold: 

1. From the main menu, select Options. 

2. Click the Notifications tab. 

3. In the Backup storage and Production datastores sections, select the Warn me when free 
disk space is below ... percent/GB options and specify a desired disk space threshold. 
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Support Contract Expiration Notification 
By default, Veeam Backup & Replication informs email recipients specified in global notification 
settings about the support expiration date in every email notification. Veeam Backup & Replication 
starts sending such notifications 14 days before the expiration date. Expiration information is also 
shown on the splash screen and on the License Information window (to display the License 
Information window, select Help > License from the main menu). 

To stop receiving notifications about support contract expiration: 

1. From the main menu, select Options. 

2. Click the Notifications tab. 

3. Clear the Enable notifications about support contract expiration check box. 
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New Product Versions 
You can configure Veeam Backup & Replication to automatically check for new product versions and 
patches available on the Veeam website. 

To enable new product versions and update notifications: 

1. From the main menu, select Options. 

2. Click the Notifications tab. 

3. Select the Check for product and hypervisor updates periodically check box. 

Important! 

 

Make sure that the backup server is connected to the Internet. In the opposite case, you will not be 
able to receive notifications about updates and patches.  
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Specifying Session History Settings 
You can specify session history settings for jobs performed on the backup server. 

1. From the main menu, select Options. 

2. Click the History tab. 

3. In the Sessions section, specify the number of sessions to display in the Sessions list of the 
History view. 

4. In the Session history retention section, specify the number of weeks for which 
Veeam Backup & Replication must keep session information in the configuration database. 
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Reporting 
When you run a job, Veeam Backup & Replication saves the jobs statistics and operation data to the 
configuration database. You can view realtime statistics for any performed job and generate reports 
with statistics data for any job or separate job session. 
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Viewing Real-Time Statistics 
To view real-time statistics for a job, do one of the following: 

 Open the Backup & Replication view, in the inventory pane select Jobs, Last 24 hours or 
Running. In the working area, double-click the job. 

 Open the Backup & Replication view, in the inventory pane select Jobs, Last 24 hours or 
Running. In the working area, right-click the job and select Statistics. 

The real-time statistics provides detailed data on job sessions: job progress, duration, processing rate, 
performance bottlenecks, amount of processed data, read and transferred data and details of the 
session performance, for example, warnings and errors that have occurred in the process of operation. 

In addition to overall job statistics, the real-time statistics provides information on each object 
processed with the job. To view the processing progress for a specific object, select it in the list on the 
left. 

Tip: 

 

You can collapse and expand the real-time statistics window using the Hide Details and Show 
Details button at the bottom left corner of the window. 
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Statistics Counters 
Veeam Backup & Replication displays jobs statistics for the following counters: 

 The Job progress bar shows percentage of the job completion. 

 The Summary box shows general information about the job: 

– Duration — time from the job start till the current moment or job end. 

– Processing rate — average speed of VM data processing. This counter is a 
ratio between the amount of data that has actually been read and time it took 
to transfer data to the target. 

– Bottleneck — bottleneck in the data transmission process. To learn about job 
bottlenecks, see Detecting Performance Bottlenecks.  

 The Data box shows information about processed VM data: 

– Processed — total size of all VM disks processed by the job. 

– Read — amount of data read from the datastore by the source-side Data 
Mover Service prior to applying compression and deduplication. For 
incremental job runs, the value of this counter is typically lower than the value 
of the Processed counter. Veeam Backup & Replication reads only data blocks 
that have changed since the last job session, processes and copies these data 
blocks to the target. 

– Transferred — amount of data transferred from the source-side Data Mover 
Service to the target-side Data Mover Service after applying compression and 
deduplication. This counter does not directly indicate the size of the resulting 
file(s). Depending on the backup infrastructure and job settings, 
Veeam Backup & Replication can perform additional activities with data: 
deduplicate data, decompress data prior to writing the file to disk and so on. 
The activities can impact the size of the resulting file. 

 The Status box shows information about the job results. This box informs how many tasks 
have completed with the Success, Warning and Error statuses (1 task per 1 VM). 

 The pane at the lower left corner shows a list of objects included in the job.  

 The pane at the lower right corner shows a list of operations performed during the job. To see 
a list of operations for a specific object included in the job, click the object in the pane on the 
left. To see a list of operations for the whole job, click anywhere on the blank area in the left 
pane. 

  



 

1133   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Colored Graph 
To visualize the data transfer process, Veeam Backup & Replication displays a colored graph in the 
real-time statistics window: 

 The green area defines the amount of data read from source. 

 The brown area defines the amount of data transported to target. 

 The horizontal line defines the current data processing speed. 

If the job session is still being performed, you can click the graph to view data rate for the last 5 
minutes or the whole processing period. If the job session has already ended, the graph will display 
information for the whole processing period only. 

The colored graph is displayed only for the currently running job session or the latest job session. If 
you open real-time statistics for past sessions other than the latest one, the colored graph will not be 
displayed. 
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Viewing Job Session Results 
You can view detailed statistics on every job session.  

To view statistics for a selected job session, do either of the following: 

 Open the History view. In the inventory pane select Jobs. In the working area, double-click 
the necessary job session. 

 Open the History view. In the inventory pane select Jobs. In the working area, right-click the 
necessary job session and select Statistics. 

To switch between past job sessions, use left and right arrow keys on the keyboard. 
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Viewing Job and Job Session Reports 
You can generate reports with details about job and job session performance. 

Job Report 
The job report contains data on all sessions initiated for a specific job. To generate a job report: 

1. Open the Backup & Replication view. 

2. In the inventory pane, select Jobs. 

3. In the working area, select the necessary job and click Report on the ribbon. You can also 
right-click the job and select Report. 

The session report contains data on a single job session: 

 Cumulative session statistics: session duration details, details of the session performance, 
amount of read, processed and transferred data, backup size, compression and deduplication 
ratios. 

 Detailed statistics for every VM processed within the session: processing duration details, 
backup data size, amount of read and transferred data, list of warnings and errors (if any). 

Session Report 
To generate a session report: 

1. Open the History view. 

2. In the inventory pane, select Jobs. 

3. In the working area, select the necessary session and clock Report on the ribbon. You can 
also right-click the necessary session and select Report. 
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Assigning Roles to Users 
You can assign one of the following roles to users or groups of users who plan to work with 
Veeam Backup & Replication: 

 Veeam Restore Operator 

 Veeam Backup Viewer 

 Veeam Backup Operator 

 Veeam Backup Administrator 

A role assigned to the user defines the user activity scope: what operations in 
Veeam Backup & Replication the user can perform. Role security settings affect the following 
operations: 

 Starting and stopping jobs 

 Performing restore operations 

Users having different roles can perform a different set of operations: 

Role Operations 

Veeam Restore Operator Can perform restore operations using existing backups and replicas. 

Veeam Backup Viewer 
Has the “read-only” access to Veeam Backup & Replication. Can view 
existing jobs and review the job session details. 

Veeam Backup Operator Can start and stop existing jobs. 

Veeam Backup 
Administrator 

Can perform all administrative activities in Veeam Backup & Replication. 

You can assign several roles to one user. For example, if the user should be able to start jobs and 
perform restore operations, you can assign the Veeam Backup Operator and Veeam Restore 
Operator roles to this user. 

To assign a role to the user or user group: 

1. From the main menu, select Users and Roles. 

2. Click Add. 

3. In the User or group field, enter a name of a user or user group in the DOMAIN\USERNAME 
format. 

4. From the Role list, select the necessary role to be assigned. 
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Important! 

 

The user account under which the Veeam Backup Service runs must be assigned the Veeam Backup 
Administrator role. By default, during installation the Veeam Backup Administrator role is assigned to 
users in the Local Administrators group. If you change the default settings, make sure that you assign 
the Veeam Backup Administrator role to the necessary user account. 

If the Veeam Backup Service is started under the LocalSystem account, you do not need to assign any 
roles to this account.  
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Installing Updates 
Veeam Backup & Replication uses update notifications to inform you about new versions of 
Veeam Backup & Replication, new product patches. 

When a new version of Veeam Backup & Replication or a new product patch becomes available on the 
website, Veeam Backup & Replication displays an icon in the system tray. An icon is displayed once a 
week. 

To install a product update, double-click the Veeam Backup & Replication icon in the system tray. 
Veeam Backup & Replication will open a webpage with the update description and links to the 
installation archive of the new product version or new patch. 
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Logging 
Veeam Backup & Replication provides detailed logging of performed activities, initiated jobs, Veeam 
Data Mover Service work and so on.  

On the backup server, log files are stored in the following folder: 
%allusersprofile%\Veeam\Backup. 

Veeam Backup & Replication keeps a separate log file for each of its components: Veeam Shell, Veeam 
Backup Service, Veeam Guest Catalog Service, Veeam vPower NFS Service, Veeam Installer, Veeam 
Data Mover Service and performed jobs. 

In addition to logs stored on the backup server, log files are also stored on all servers added to the 
backup infrastructure: 

 On Linux servers and ESX(i) hosts, logs are stored in the following directory: 
/var/log/VeeamBackup/ or /tmp/VeeamBackup 

 On Microsoft Windows servers, logs are stored in the following directory: 
%allusersprofile%\Veeam\Backup 

You can collect log files from the backup server and servers managed by Veeam Backup & Replication 
using the Export Logs wizard. 

Note: 

 

If you export logs from the Veeam Backup & Replication console, the exported logs will be copied to 
the machine where the console is installed. The log archive will also contain logs from the console 
machine. 



 

1140   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Exporting Logs 
You can use log files to submit a support ticket. It is recommended that you send all log files when 
submitting a support ticket to ensure that overall and comprehensive information is provided to the 
Veeam Support Team. 

To aggregate all log files in the same location, use the Export Logs wizard. To launch the wizard, from 
the main menu select Help > Support Information.  

Step 1. Select Virtual Infrastructure Scope 

At the Scope step of the wizard, define the scope for logs export. You can export logs for the following 
objects: 

 Specific jobs on the backup server 

 Specific VMs in the virtual environment 

 Specific components in the backup infrastructure 
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Step 2. Specify Time Interval 

At the Date Range step of the wizard, define the time interval for which logs must be collected. You 
can select one of the following options: 

 Collect logs for the last N days 

 Collect logs for a specific period of time 

 Collect all available logs 
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Step 3. Specify Destination Folder 

At the Location step of the wizard, specify the destination folder to which the logs will be exported.  

In the Path to folder field, specify a path to an archive with log files that will be created. By default, 
the archive is placed to the C:\temp\logs folder on the backup server. 

 

Step 4. Review Results 

At the Export step of the wizard, Veeam Backup & Replication will collect specified logs and create a 
log archive. Wait for the export process to complete, review the results and click the Open folder link 
to browse to exported log files and log package. 
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Performing Configuration Backup and Restore 
You can back up and restore the configuration database that Veeam Backup & Replication uses. 

During configuration backup, Veeam Backup & Replication exports data from the configuration 
database and saves it to a backup file on the backup repository. If the backup server fails for some 
reason, you can re-install the backup server and quickly restore its configuration from the 
configuration backup. You can also use configuration backups to apply the configuration of one 
backup server to another backup server in the backup infrastructure.  

It is recommended that you regularly perform configuration backup for every backup server in the 
backup infrastructure. Periodic configuration backups reduce the risk of data loss and minimize the 
administrative overhead if any problem with backup servers occurs. 
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Creating Configuration Backups 
When you perform configuration backup, Veeam Backup & Replication retrieves data for the backup 
server from the configuration database, writes this data into a set of XML files and archives these XML 
files to a backup file of the BCO format.  

Veeam Backup & Replication exports information about the following objects: 

 Backup infrastructure components and objects: hosts, servers, backup proxies, 
repositories, WAN accelerators and jobs, global settings configured on the backup server and 
so on. 

 Backups: backups, replicas and backup copies created on the backup server. 

 Sessions: job sessions performed on the backup server. 

 Tapes: tape libraries connected to the backup server. 

Configuration backup is job-driven. You can schedule it to run regularly or start it manually. You can 
choose the backup repository in which the configuration backup must be stored and specify the 
necessary retention settings.  

Backup Repository Target 
By default, Veeam Backup & Replication is configured to create a configuration backup daily. The 
resulting configuration backup file is stored in the \VeeamConfigBackup\%BackupServer% folder 
on the default backup repository. However, for security’s sake, it is recommended that you store 
configuration backups on the backup repository other than the default one or any other storage.If the 
backup server fails, its configuration data will remain, and you will be able to recover the failed backup 
server. 

When you configure a new backup repository, Veeam Backup & Replication offers you to change the 
configuration backup file location from the default backup repository to the new backup repository. 
Click Yes, and Veeam Backup & Replication will automatically change the backup target in the 
configuration backup job settings and will use this target in future.  

Configuration backups that were created before the target change will remain on the default backup 
repository. You can manually copy them to the new backup repository to have all restore points of the 
configuration backup in one place. 

Important! 

 

You cannot store configuration backups on scale-out backup repositories. 
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Scheduling Configuration Backups 

You can instruct Veeam Backup & Replication to perform configuration backup automatically by 
schedule. 

Important! 

 

If you plan to migrate configuration data to the database used by another backup server, stop all 
running jobs and disable scheduled jobs before creating the configuration backup. In the opposite 
case, job sessions may be failing after configuration restore. For more information, see Migrating 
Configuration Database. 

To schedule a configuration backup: 

1. From the main menu, select Configuration Backup. 

2. Make sure that the Enable configuration backup to the following repository check box is 
selected. 

3. From the Backup repository list, choose a backup repository on which the configuration 
backup must be stored. 

4. In the Restore points to keep field, specify the number of restore points that you want to 
maintain on the backup repository. 

5. Click Schedule next to the Perform backup on field and specify the time schedule according 
to which the configuration backup must be created.  

6. To create an encrypted backup, select the Encrypt configuration backup check box. From 
the Password field, select a password you want to use for encryption. If you have not created 
a password beforehand, click Add or use the Manage passwords link to specify a new 
password. For more information, see Creating Encrypted Configuration Backups.  

7. To receive email notifications and SNMP traps with the configuration backup job results, 
configure global notification settings in Veeam Backup & Replication. For more information, 
see Configuring Global Email Notification Settings and Specifying SNMP Settings. 

 



 

1146   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Running Configuration Backups Manually 

You can create a configuration backup manually when you need it, for example, if you want to capture 
a state of the configuration database at a specific point in time. 

Important! 

 

If you plan to migrate configuration data to the database used by another backup server, stop all 
running jobs and disable scheduled jobs before creating the configuration backup. In the opposite 
case, job sessions may be failing after configuration restore. For more information, see Migrating 
Configuration Database. 

To create a configuration backup manually: 

1. From the main menu, select Configuration Backup. 

2. Make sure that the Enable configuration backup to the following repository check box is 
selected. 

3. From the Backup repository list, choose a backup repository on which the configuration 
backup must be stored. 

4. In the Restore points to keep field, specify the number of restore points that you want to 
maintain on the backup repository. 

5. To create an encrypted backup, select the Encrypt configuration backup check box. From 
the Password field, select a password you want to use for encryption. If you have not created 
a password beforehand, click Add or use the Manage passwords link to specify a new 
password. For more information, see Creating Encrypted Configuration Backups.  

6. To receive email notifications and SNMP traps with the configuration backup job results, 
configure global notification settings in Veeam Backup & Replication. For more information, 
see Configuring Global Email Notification Settings and Specifying SNMP Settings. 

7. Click Backup now. 

 Veeam Backup & Replication will back up the configuration database and store a new restore point to 
the selected backup repository. 

 



 

1147   | Veeam Backup & Replication | User Guide for VMware vSphere | REV 3 

Creating Encrypted Configuration Backups 

Veeam Backup & Replication requires that you encrypt the configuration backup if you have created at 
least one password in the Password Manager on the backup server. 

When you encrypt jobs or tapes with passwords, Veeam Backup & Replication creates a set of keys that 
are employed in the encryption process. Some encryption keys, for example, storage keys and 
metakeys, are stored in the configuration database. If a configuration backup was non-encrypted, data 
from it could be freely restored on any backup server. Encryption keys saved to the configuration 
database and the content of encrypted files might become accessible for unintended audience. 

If the Password Manager contains at least one password and you do not enable encryption for the 
configuration backup, Veeam Backup & Replication disables configuration backup. To enable the 
configuration backup, you must enable encryption in the configuration backup job settings. 

 

After you enable the encryption option, Veeam Backup & Replication will create encrypted 
configuration backups. Beside encryption keys, the created backups capture credential records 
specified in the Credentials Manager. When you restore data from such backup, you will not have to 
enter passwords for credentials records again (unless the passwords for credentials records have 
changed by the time of restore). 
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To encrypt the configuration backup: 

1. From the main menu, select Configuration Backup. 

2. Select the Encrypt configuration backup check box.  

3. From the Password field, select a password you want to use for encryption. If you have not 
created a password beforehand, click Add or use the Manage passwords link to specify a 
new password. For more information, see Managing Passwords for Data Encryption.  
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Restoring Configuration Data 
To restore data from the configuration backup, you can use one of two methods: data restore and 
data migration. 

Data restore can be helpful in the following situations: 

 The configuration database got corrupted and you want to recover data from the 
configuration backup. 

 The Microsoft SQL Server on which the configuration database resides got corrupted, and you 
want to deploy the configuration database on a new Microsoft SQL Server, and restore data 
from the configuration backup to it. 

 You want to roll back the configuration database to a specific point in time. 

 You want to restore data to a new configuration database on the same Microsoft SQL server, 
for example, for testing purposes. 

Data migration can be helpful if you need to move the backup server and configuration database to 
another location, for example, offsite. In this case, you can configure a backup server, deploy a 
Microsoft SQL Server in the target location and then restore data from the configuration backup to a 
database on this server. As a result, you will get a "replica" of the backup server without additional 
adjustments and fine-tuning. 

It is recommended that you use Veeam Backup & Replication tools to create configuration backups 
and migrate the configuration database. If you use other tools, for example, native Microsoft SQL 
Server tools, after migration some information such as secure configuration data may be not 
accessible. 

Restoring Configuration Database 

You can restore a configuration backup on the same backup server where the backup was created or 
on another backup server. 

Before you start the restore process, check prerequisites. Then use the Veeam Backup & Replication 
Configuration Restore wizard to restore the configuration database. 

Before You Begin 

Before you start the restore process, check the following prerequisites: 

1. Stop all jobs that are currently running. During restore of configuration, 
Veeam Backup & Replication temporary stops the Veeam Backup Service and jobs. 

2. Check the version of the backup server. On the backup server running 
Veeam Backup & Replication 9.0, you can restore configuration backups created with the 
following product versions: 7.0 Update 4, 8.0 and 9.0. 
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Step 1. Launch the Configuration Database Restore Wizard 

To launch the Veeam Backup and Replication Configuration Restore wizard, do either one of the 
following: 

 From the main menu, select Configuration Backup. In the Restore section, click Restore.  

 In Microsoft Windows Explorer, open the folder where configuration backups are stored (by 
default, Backup\VeeamConfigBackup\<BackupServerName> on the volume with most 
disk space on the backup server) and double-click the necessary configuration backup file. 

 

Step 2. Select Restore Mode 

At the Restore Mode step of the wizard, choose a restore mode that you want to use. 

 Select Restore if you want to restore data from the configuration backup to the database 
used by the initial backup server. 

In the Restore mode, Veeam Backup & Replication retrieves configuration data from the 
backup and stores it to the target database. After that, Veeam Backup & Replication performs 
additional rescan of VM replicas, backup repositories and tape libraries connected to the 
backup server. Rescan helps synchronize potential changes between the backup 
infrastructure and restored database that took place from the moment when the 
configuration backup was created till the present time. As a result, the target configuration 
database will contain information about restore points that were created after the 
configuration backup was taken, and this information is displayed in the 
Veeam Backup & Replication console. 
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 Select Migrate if you want to restore data from the configuration backup to the database 
used by another backup server.  

In the Migrate mode, Veeam Backup & Replication retrieves configuration data from the 
backup and stores it to the target database. No rescan operation is performed.  
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Step 3. Select Configuration Backup 

At the Configuration Backup step of the wizard, select a configuration backup from which you want 
to restore data. 

1. From the Backup repository list, select a server or backup repository on which the 
configuration backup file is located. 

2. Click Browse next to the Backup file field and select the backup file. 

If you select to restore configuration data from a backup on a remote backup repository, during 
restore Veeam Backup & Replication will first copy the backup file to a temporary folder on the backup 
server. After you finish the restore process and close the wizard, Veeam Backup & Replication will 
automatically delete the configuration file from the temporary folder. 
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Step 4. Review Configuration Backup Parameters 

At the Backup Contents step of the wizard, Veeam Backup & Replication will analyze the content of 
the selected backup file and display the following settings: 

 Backup file settings: settings of the configuration backup file itself. 

 Product settings: version of Veeam Backup & Replication installed on the initial backup 
server and configuration database version. 

 List of catalogs: catalogs storing backup configuration data. 

Review the displayed settings and click Next. 

 

Step 5. Specify Password 

The Password step of the wizard is available if you have enabled the encryption option in the 
configuration backup properties. 

Enter the password to decrypt configuration backup data: 

1. Check the password hint to recall the password.  

1. In the Password field, enter the password to decrypt the configuration backup file. 

 If you have forgotten or lost the password, click the I forgot the password link. For more information, 
see Decrypting Data Without Password. 
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Note: 

 

If the backup server is not connected to Veeam Backup Enterprise Manager and does not have the 
Enterprise or Enterprise Plus license installed, you will not see the I forgot the password link and will 
not be able to restore configuration data without a password. 

 

Step 6. Specify Target Database 

At the Target Database step of the wizard, specify a target Microsoft SQL server and database to 
which configuration data must be restored. 

1. In the Database name field, specify a name of the database to which configuration data 
must be restored. By default, Veeam Backup & Replication uses the name of the initial 
database.  

If you specify a name of the database that does not exist, Veeam Backup & Replication will 
create it on the Microsoft SQL Server. 

2. From the Server name list, select a Microsoft SQL server on which the database is deployed 
or must be deployed. In the list of Microsoft SQL Servers Veeam Backup & Replication displays 
all servers from the network where the backup server resides. To update the list of servers, 
click Refresh on the right.  
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3. In the Authentication section, select the authentication mode to connect to the Microsoft 
SQL Server instance: Windows Authentication or SQL Server Authentication. If you select 
the Microsoft SQL Server authentication mode, specify the user name and password of the 
account that you want to use. To view the entered password, click and hold the eye icon on 
the right of the field. 

 

Step 7. Specify Restore Options 

At the Restore Options step of the wizard, specify additional restore options. 

1. In the Restore section, select what data you want to restore from the configuration backup. 
Veeam Backup & Replication always restores configuration data for backup infrastructure 
components, jobs and global settings specified at the level of the backup server. You can 
additionally restore the following data: 

 Backup and replica catalog: data about all backups and replicas registered on the 
backup server and information about tapes to which backups were written and 
location of these tapes. 

 Session history: data about all sessions performed on the backup server. 

2. If you plan to use PowerShell on the restored backup server, select the Enable required 
PowerShell policy for SCVMM check box. During restore, Veeam Backup & Replication will 
enable the PowerShell execution policy and you will not have to enable it manually 
afterwards. Enabling this option is identical to running the ‘Set-ExecutionPolicy RemoteSigned' 
command on the backup server. 

3. If you are restoring configuration data to the same database, select the Backup existing 
database before configuration restore check box. This option will help you protect the 
current database from accidental errors during the restore process. During restore, 
Veeam Backup & Replication will first back up the current database using the native tools of 
Microsoft SQL Server. After that, Veeam Backup & Replication will purge the current database 
and import data from the configuration backup to it. In such scenario, if an error occurs 
during the restore process, you will be able to restore the current database from the Microsoft 
SQL backup using Microsoft SQL Management Studio or SQL scripts. 
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The created Microsoft SQL database backup is named by the following pattern: 
VeeamBackup<DatabaseName><date>.bak and stored to the default Microsoft SQL backups 
location, for example: %Program Files%\Microsoft SQL 
Server\MSSQL11.MSSQLSERVER\MSSQL\Backup\. 

4. Click Restore. Veeam Backup & Replication will stop currently running jobs and 
Veeam Backup & Replication services and will restore the database to the specified location. 
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Step 8. Review Restore Settings 

At the Restore step of the wizard, Veeam Backup & Replication will display the progress on the restore 
process. Wait for the restore process to complete and click Next. 

 

If you have chosen to restore data in the Migrate mode and the configuration backup file does not 
meet the Migrate mode requirements, Veeam Backup & Replication will display a warning and offer 
you to switch to the Restore mode. The Restore mode requires more time but guarantees that 
information about all new restore points will be available in the restored database. 

 To switch to the Restore mode, in the warning window click Yes. 

 To carry on data restore in the Migrate mode, in the warning window click No. 

 To stop the restore process, in the warning window click Cancel. 

For more information, see Migrating Configuration Database. 
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Step 9. Finalize Restore Process 

After the restore process has finished, you may need to perform the following actions to finalize the 
configuration database restore: 

1. Specify credentials for backup infrastructure objects. 

2. Perform components upgrade. 

Specifying Credentials 

The Credentials step of the wizard is available if you have enabled encryption for configuration 
backup. 

Veeam Backup & Replication displays a list of credentials records that existed on the backup server at 
the time when the configuration backup was created. If by the time of restore passwords for 
credentials records have changed, you can specify new values for these records. 

To specify new passwords: 

1. Select a credentials record in the list and click Edit.  

2. Enter the necessary password.  

3. Repeat the procedure for all credentials records in the list. 
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Performing Components Upgrade 

After the restore process is complete, Veeam Backup & Replication will check if services on backup 
infrastructure components must be upgraded and display a list of outdated components. 

To upgrade backup infrastructure components, select check boxes next to the necessary components 
and click Next. If some component fails to upgrade, you can get back to a previous step of the wizard 
and repeat the procedure or close the wizard and upgrade the components manually. For more 
information, see Upgrading Server Components.  

Step 10. Synchronize Backups and Tape Libraries 

After the configuration database is restored, Veeam Backup & Replication can perform a 
synchronization operation for backups and replicas created on the backup server and tape libraries 
connected to the backup server. 

The synchronization operation for backups and replicas is performed in the following situations: 

1. You are restoring a database from the backup created with Veeam Backup & Replication 7.0 
in the Restore mode. 

2. You are restoring a database from the backup created with Veeam Backup & Replication 8.0 
in the Restore mode and you have selected to restore data from the Backup and replica 
catalog. 

The synchronization operation for tape libraries is performed in the following situations: 

1. You are restoring a database from the backup created with Veeam Backup & Replication 7.0 
in the Restore mode. 

2. You are restoring a database from the backup created with Veeam Backup & Replication 8.0 
in the Restore mode and you have selected to restore data from the Backup and replica 
catalog. 

Wait for the synchronization operation to complete. 

Note: 

 

Veeam Backup & Replication has a set of limitations for restoring tape data from configuration 
backups created with Veeam Backup & Replication 7.0. For more information, see 
https://veeam.com/kb1935. 

  

https://veeam.com/kb1935
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Step 11. Finish Working with Wizard 

At the Summary step of the wizard, finalize the process of configuration data restore. 

1. Review the restore process results. 

2. If you want to start Veeam Backup & Replication after you finish working with the wizard, 
select the Launch the Backup & Replication user interface check box. 

3. Click Finish to exit the wizard. 

Note: 

 

If you restore data from the configuration backup in the Restore mode, all jobs on the backup server 
will be disabled after the restore process is complete. You need to enable them manually.  
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Migrating Configuration Database 

To migrate configuration data to a database used by another backup server, perform the following 
steps: 

1. Before you create the configuration backup, stop all running jobs and disable all scheduled 
jobs on the backup server from which you migrate configuration data. 

Do not start and/or enable any jobs. If you start a job before migration is completed, 
Veeam Backup & Replication will produce a new restore point in the chain and update the 
chain metadata. The created configuration backup will not contain information about this 
new restore point. When you migrate data from the configuration backup to the database 
and start the job again, Veeam Backup & Replication will fail to synchronize the chain 
metadata with data in the database. As a result, the job will fail. 

2. Launch the Configuration Database Restore wizard. At the Restore Mode step of the 
wizard, select Migrate. 

3. Follow the next steps of the wizard and specify other configuration migration settings as 
described in Restoring Configuration Database. 

Before starting configuration data restore in the Migrate mode, Veeam Backup & Replication performs 
an additional check. If you have selected to use the Migrate mode and the configuration backup does 
not meet the requirements, Veeam Backup & Replication will offer you to switch to the Restore mode. 
In the Restore mode, Veeam Backup & Replication will perform additional rescan of VM replicas, 
backup repositories and tape libraries connected to the backup server. The database will be updated 
to include information about new restore points, and subsequent job sessions will be working in a 
proper way.  
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Working with Veeam Backup & Replication Utilities 
You can use the following Veeam Backup & Replication utilities to perform advanced administration 
tasks in your backup infrastructure: 

 Extract.exe utility 

 Veeam.Backup.DBConfig.exe utility 
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Working with Extract Utility 
Veeam Backup & Replication comes with an extract utility that can be used to recover VMs from a full 
backup file (VBK). The extract utility does not require any interaction with Veeam Backup & Replication 
and can be used as an independent tool on Linux and Microsoft Windows machines. 

The extract utility can be helpful, for example, if it is written to the tape next to full backup files. In this 
case, you get a possibility to recover VMs from backups at any moment of time even if backups are 
removed from Veeam Backup & Replication or Veeam Backup & Replication is uninstalled at all.  

Important! 

 

The extract utility always restores a VM from the full backup file. You cannot use the extract utility to 

restore a VM from incremental backup files. 

The extract utility can be utilized via two interfaces: 

 Graphic user interface 

 Command-line interface working in the interactive or regular mode 

The extract utility is located in the installation folder of Veeam Backup & Replication, by default: 
%PROGRAMFILES%\Veeam\Backup and Replication\Backup. The folder contains three files for the 
extract utility: 

 Veeam.Backup.Extractor.exe — utility working via the graphic user interface (can be used on 
Microsoft Windows machines only) 

 extract.exe — utility working via the command-line interface, a version for Microsoft Windows 

 extract — utility working via the command-line interface, a version for Linux 

Using the Extract Utility via GUI 

To start the extract utility via GUI: 

1. Run the Veeam.Backup.Extractor.exe file from the installation folder of 
Veeam Backup & Replication. The extract utility will be started. 

2. In the VBK file field, specify a path to the full backup file from which you want to restore 
VM(s). 

3. If the backup file is encrypted, the extract utility will require you to provide a password to 
unlock the backup file. Enter the password that was used for backup file encryption. 

4. In the Extract folder field, specify a path to the destination folder to which the VM files must 
be extracted. 

5. From the Virtual machines list, select the VM(s) that must be extracted. 

6. Click Extract. The VM files will be extracted to the specified folder.  
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Important! 

 

The extract utility working via the GUI has the following limitations: 

 The extract utility can be started on Microsoft Windows machines only. 
 If you plan to start the extract utility on the machine other than the backup server, make 

sure that you copy the Veeam.Backup.Extractor.exe file together with the 
extract.exe file from the product installation folder and store these files to the same 
folder on the destination machine. In the opposite case, the extract utility will fail to start.  
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Using the Extract Utility in Interactive Mode 

To start the extract utility in the interactive mode, run the extract.exe file from the product 
installation folder(in case of a Linux machine, run the extract file). 

You will have to sequentially enter the following arguments: 

1. Path to the full backup file from which the VM must be restored. After you enter the path, the 
restore utility will display a list of all VMs included in the backup and their description. 

2. Name of the VM you want to restore. If there is more than one VM with the specified name in 
the backup, you will be asked to specify the host on which the backed up VM resides. If you 
want to restore all VMs from the backup, press [ENTER]. 

3. If the backup was encrypted, password that was used to encrypt the backup file. 

4. Output directory to which VMs must be restored. If you want to restore VM(s) to the current 
directory, press [ENTER]. 

5. Operation confirmation. Press [Y] on the keyboard to restore a VM to the directory you 
selected. If you want to abort the operation, press [ENTER]. 
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Using the Extract Utility from Command Line 

If you run the extract utility from the command line, you can perform the following actions: 

 Run the extract utility in the interactive mode 

 Display help information for the utility usage 

 Display the list of all VMs in the backup file 

 Getting encryption status of a backup file 

 Restore all or selected VMs from the backup 

Running the Extract Utility in Interactive Mode 

This command runs the extract utility in the interactive mode. 

Syntax 

extract.exe -password backupkey [pathtovbk] 

Parameters 

Parameter Description Required/Opti
onal 

password Password for the encrypted backup file. 
Required for 
encrypted 
backup files 

pathtovbk  Path to the backup file from which VM(s) must be restored. Optional  
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Displaying Help Information for Utility Usage 

This command prints all variants of the extract utility usage along with required and optional 
parameters. 

Syntax 

extract.exe -help 

Displaying List of VMs in Backup 

This command displays the list of all VMs in the backup file from which you want to perform restore. 

Syntax 

extract.exe -dir [-vm vmname] [-host hostname] -password backupkey 
pathtovbk 

Parameters 

Parameter Description Required/Optional 

vm  Name of the VM that you want to restore. Use this 
parameter to filter VMs in the backup. Optional 

host  

Name of the host on which the initial VM resides. This 
parameter should be specified if the vm parameter is used. 
Use this parameter to filter VMs that have the same name 
but reside on different hosts. 

Optional 

password Password for the encrypted backup file. Required for encrypted 
backup files 

pathtovbk  Path to the backup file from which the VM should be 
restored. Required 

Getting Encryption Status of Backup File 

This command gets the encryption status of the backup file: encrypted or not encrypted. 

Syntax 

extract.exe –getEncryptionStatus pathtovbk 

Parameters 

Parameter Description Required/Opti
onal 

pathtovbk  Path to the backup file from which the VM must be restored. Required  
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Restoring VMs from Backup 

This command restores files for all VMs or for the selected VM(s) from the backup file.  

Syntax 

extract.exe -restore [-vm vmname] [-host hostname] -password backupkey 
pathtovbk [outputdir] 

Parameters 

Parameter Description Required/Opti
onal 

vm  
Name of a VM that you want to restore. Use this parameter to filter VMs 
in the backup. If you want to restore all VMs from the backup file, do 
not specify this parameter. 

Optional 

host  

Name of the host on which the initial VM resides. This parameter 
should be specified if the vm parameter is used.  
Use this parameter to filter VMs that have the same name but reside on 
different hosts. 

Optional 

pathtovbk  Path to the backup file from which the VM should be restored. Required 

password Password for the encrypted backup file. 
Required for 
encrypted 
backup files 

outputdir  
Path to the directory to which the VM files should be restored. If this 
parameter is not specified, the VM will be restored to the current 
directory. 

Optional 
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Working with Veeam.Backup.DBConfig.exe Utility 
Veeam Backup & Replication comes with the Veeam.Backup.DBConfig.exe utility that allows you to 
manage connection settings for Veeam Backup & Replication and/or Veeam Backup Enterprise 
Manager configuration database. Using this utility, you can: 

 Connect to a different database on the same or another Microsoft SQL Server instance. If you 
specify a database that does not exist yet, it will be created on the selected server.  

 Change authentication method for database connection. Possible methods are Microsoft 
Windows authentication and Microsoft SQL server authentication. 

Note: 

 

The Veeam.Backup.DBConfig.exe utility supports only connection to configuration databases of 
version 8.0 and 9.0.  

 

Using Veeam.Backup.DBConfig.exe Utility 

You can launch the Veeam.Backup.DBConfig.exe utility from the Start menu by clicking 
Configuration Database Connection Settings. Alternatively, you can use the 
Veeam.Backup.DBConfig.exe file located in the installation folder of Veeam Backup & Replication 
(by default, %PROGRAMFILES%\Veeam\Backup and Replication\Backup.)  

To run the utility, you must have administrative rights on the local machine, as long as the utility 
makes changes to the registry. If prompted at the launch, choose Run as administrator. 

To manage connection settings for Veeam Backup & Replication and/or Veeam Backup Enterprise 
Manager configuration database, use the launched Veeam Backup & Replication Configuration 
Database Connection Settings wizard. 
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Step 1. Select Product 

At the Product step of the wizard, select the database whose settings you want to configure.  

The utility detects what server is installed on the local machine (backup server, Veeam Backup 
Enterprise Manager server or both) and displays available products for your choice. If Veeam Backup 
Enterprise Manager is not installed on the local machine, you will only have an opportunity to change 
Veeam Backup & Replication database settings (therefore, the Product step of the wizard will be 
skipped).  

 

Step 2. Specify Connection Settings 

At the Connection Settings step of the wizard, provide the connection settings for the selected 
database. 

1. Specify the Microsoft SQL Server\instance and database name to which you want the 
Veeam Backup & Replication installation to connect. Both local and remote Microsoft SQL 
server instances are supported. Microsoft SQL server instances available on the network are 
shown in the Server name list. If necessary, click Refresh to get the latest information. 

If a database with the specified name does not exist on the selected Microsoft SQL Server 
(instance), it will be created anew. 

2. Select the authentication method that will be used for database connection: 

 If you plan to use the Microsoft Windows authentication, consider that the 
current service account will be used (that is, the account under which the 
Veeam Backup service is running).  

 If you plan to use the Microsoft SQL authentication, provide a login name and 
password. To view the entered password, click and hold the eye icon on the 
right of the Password field. 
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Step 3. Apply Connection Settings 

Before proceeding, the utility validates the specified settings to make sure that the user account has 
enough privileges to access the database. 

 If you have selected the Microsoft Windows authentication method, the utility will check the 
privileges of the current user account (that is, the account under which the utility is running) 
to connect to specified Microsoft SQL server.  

 If you have selected the Microsoft SQL authentication method, the utility will check the 
privileges of the account you have specified.  

To ensure that these accounts (as well as the account under which the Veeam Backup service is 
running) have sufficient privileges for database access, you can contact your database administrator. 
Refer to the list of system requirements for Veeam Backup & Replication for detailed information 
about required permission. 

For the new settings to be applied, the utility needs to stop Veeam Backup & Replication services and 
jobs that are currently running. Before proceeding to the Apply step, you must confirm the operation. 
For example, if you are configuring Veeam Backup & Replication database settings, the following 
prompt will be displayed. 
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Confirm the operation by clicking Yes and wait for the services to be stopped. Then database 
connection settings will be applied, and you can view the operation progress in the log.  

Wait for the operation to complete and click Next to proceed to the Summary step of the wizard. 
Previously stopped services will be started again at this moment. 
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Step 4. Finish Working with Wizard  

At the Summary step of the wizard, view the information about the changes in database connection 
settings. If you were configuring Veeam Backup & Replication database settings and you want the 
Veeam backup management console to be open automatically after you finish working with the 
wizard, select the Start the product automatically check box. 

Note: 

 

The Start the product automatically option is not available for Veeam Backup Enterprise Manager. 
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